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1 Using help

Help tabs and buttons
Use the tabs and buttons in the Help window to navigate through the
help system.

Tabs at the bottom of the left pane

Contents

Displays the Table of Contents

 Index

Displays the index (a list of key words).

 Search Results

Displays the topics that were found the last time that you
searched.

Buttons above the left pane

 Print Topics

Choose Print selected topic to print this particular topic or Print
selected topic and all subtopics to print the entire chapter.

 Collapse All

Collapses all expanded topics in the left pane.

 Refresh/Show Current Topic

Highlights the current topic in the Table of Contents in the left
pane. This is useful after you follow links to new topics.

 Maximize and  Minimize

Maximize expands the pane to fill the entire window. Minimize
returns a maximized pane to its previous size. You can also
double-click the title of the pane to switch between the
expanded and minimized pane sizes.

Buttons above the right pane

 Go Back

Displays the previous page, in the same way as Web browsers.



 Go Forward

Displays the next page, in the same way as Web browsers.
Available only after you use Go Back.

 Home

Displays the main page of the help system.

 Show in Table of Contents

Highlights the current topic in the Table of Contents in the left
pane. This is useful after you follow links to new topics.

 Bookmark Document

Saves the topic as a bookmark or "favorite" in the Web browser.
Available only in certain Web browsers.

 Print Page

Prints the current topic (not the contents of the entire window).

 Maximize and  Minimize

Maximize expands the pane to fill the entire window. Minimize
returns a maximized pane to its previous size. You can also
double-click the title of the pane to switch between the
expanded and minimized pane sizes.
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2 Getting started

What is Prinergy Workshop?
Prinergy enables you to create and edit jobs, refine input files into
pages, assign pages to page sets and impositions, proof pages and
impositions, output to film or plate, monitor job activity and status, and
archive job files.

Prinergy product family

Prinergy is the name of the product family that includes:

● Prinergy Connect
● Prinergy Powerpack
● Kodak Prinergy Direct
● Prinergy Evo

Products are defined by the features they offer, and product features
are controlled by licensing. The Prinergy Administrator license
determines the number of concurrent users allowed in a Prinergy
system. You may add features to your Prinergy product by purchasing
license keys for specific features.

Components of Prinergy

Prinergy consists of several software components:

● Administrator enables you to configure and manage your Prinergy
system.

Administrator runs on the Prinergy server.

For information about Administrator, see the Prinergy administration
documentation.

● Prinergy Workshop is the component that you use on a daily basis.
It enables you to create jobs, assign pages to page sets and
imposition plans, monitor job activity and status, and start
processing on elements.

Prinergy Workshop is client software that runs on both Apple
Macintosh and Microsoft Windows operating systems. It can be
distributed throughout your facility, creating a teamwork
environment where prepress managers, customer service



representatives, prepress, and plateroom operators can initiate
work or obtain current production status.

● Prinergy Dashboard software shows status and progress of
Prinergy jobs in a graphical, consolidated view. Dashboard is
designed for customer service representatives, prepress managers,
and production planners. Job status is updated continuously, so the
current status of Prinergy jobs is always available. Dashboard lets
you search for jobs and create job lists based on your criteria, so
that you can view only the jobs that you're interested in.

This guide provides detailed information about using Prinergy
Workshop. For a basic overview of Prinergy Workshop and the
Prinergy system see the Prinergy Connect Quick Start Guide.

Prinergy Workshop visually groups all of the information pertaining to
a job, including source files, imposition plans, status, history, and other
data.

See also:
Adobe software components on page 10
Job Finder window on page 16
Job Manager window on page 32
Starting processes on page 171

Starting Prinergy Workshop
Note: This procedure assumes that Prinergy Workshop is already installed. For
information on installing Prinergy Workshop, contact your system administrator.

1. On your client desktop, double-click the Workshop  icon.

The Connect to Server dialog box appears.

2. If your system has more than one server, in the Server list, select
the primary server.

If the Server list does not display the server that you want, the
server may be in a different Windows subnet (Windows) or Apple
zone (Macintosh). In that case, select Other. In the Enter Host
Name dialog box, type the IP address or name of the server and
then click OK.

3. Compare the number in the Workshop Version field with the
number in the Server Version field. If the numbers are different,
update Prinergy Workshop now.

4. In the User name box, type your user name.

5. In the Password box, type your password.

If you do not know your user name or password, contact your
system administrator.
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6. If your system includes Prinergy Business Link software, and you
may want to change the current user without having to restart
Prinergy Workshop, select Enable User Switching.

7. Click Login.

Prinergy Workshop starts and the Job Finder appears.

See also:
Switching users on page 1099

Connect to Server dialog box

User name

Enter the user name associated with your Prinergy Workshop
account.

Password

Enter the password associated with your Workshop account.

Enable User Switching

Select this check box if you want to be able to change the
current user identity without having to restart Prinergy
Workshop.

This check box is available only if you use Kodak Prinergy
Business Link software.

Server

The name of the primary Prinergy server.

Prinergy Workshop Version

Displays the version of Workshop installed on your computer. If
this version differs from the server version, update Prinergy
Workshop.

Note: On Mac OS X and Windows computers, you cannot log in to
Workshop unless the Workshop version and the server version are the
same.

Server Version

Displays the version of Prinergy installed on the primary
Prinergy server. If this version differs from the server version,
update Prinergy Workshop.
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Note: On Mac OS X and Windows computers, you cannot log in to
Prinergy Workshop unless the Prinergy Workshop version and the server
version are the same.

Connection Information

Click  to expand this area, which enables you to select a server
and update the version of Workshop if necessary.

Updating Workshop on the client
You can automatically update Workshop with the Prinergy Installer
Wizard when you start the Workshop software. This provides you with
updates for existing features. If you want to install new software (for
example, Prinergy PDF Edit, Prinergy Digital Submit, or Prinergy Digital
Direct), you must run the Prinergy Installer Wizard from the share.

Requirements:

● Quit other software, such as Prinergy VPS or Kodak Preps.
● On computers running Mac OS X, you must have an administrator

password to update Workshop. For more information, contact your
system administrator.

Perform this procedure on all workstations after the servers and render
stations have been upgraded.

1. To start Workshop, type your user name and password, and click
Login.
If the number beside Workshop Version is different than the
number beside Server Version, the Workshop updating process is
triggered automatically. If the two numbers are the same,
Workshop starts normally.

2. In the Synchronize Workshop dialog box, click Yes.

If you click No, you cannot log on to Workshop.

3. On a computer running Mac OS X, perform the following actions:

a. In the Prinergy Workshop dialog box, click the lock icon.
b. In the Authenticate dialog box, in the Password box, type the

administrator password.
c. Click OK.

4. Follow the instructions in the wizard to update the software.
The system installs the latest version of Workshop.

5. When the installation is complete, click Done.
Workshop starts automatically.
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Starting Dashboard
Dashboard is available on any computer with a web browser, whether
Prinergy is installed on that computer or not.

1. In a web browser, go to http://<prinergy-server-name>/
Dashboard, where <prinergy-server-name> is the name of the
Prinergy primary server that you want to view.

2. Enter your user name and password.

3. If a message indicates that you need a newer version of the Adobe 
Flash Player software, follow the prompts to download and install
the correct version of Adobe Flash Player.

Next: In Dashboard, click the Help link at the upper right corner of the
Dashboard window to display the Dashboard Help, or right-click an
item to display context-sensitive help for that item. In addition, many
menu items have tool tips that display information.

How do I start processing jobs?
To process jobs, you use Prinergy Workshop to apply process
templates to jobs or elements of a job.

Process templates and workflow templates control all processes, such
as refine and output. Process templates contain instructions for a
single process, while workflow templates link two or three process
templates together.

Process templates save time and reduce errors by allowing you to store
your preferred settings in a file. Instead of entering the various settings
and options each time, you start the saved process template in a
variety of ways, and the system automatically applies those settings.

If process templates are not already set up, you need to create them
using the Process Template Editor.

See also:
Process Template Editor on page 188

Remote access to Workshop and a Prinergy server
There are two methods for controlling a Prinergy server and running
Workshop from a location other than where the Prinergy system is
installed:

● Use Windows Terminal Services (WTS) to open a remote desktop
● Run Workshop locally and connect to a remote Prinergy server

Starting Dashboard 7



Using WTS to open a remote desktop

You can control Prinergy servers remotely using WTS. WTS is factory-
installed on each Prinergy server (primary, secondary, and render
station) and is normally used for remote servicing of the Prinergy
system.

Because it is running at all times, WTS can be useful for remotely
administering a server, without the need for a site visit. You can also
use WTS via Prinergy Administrator and Workshop job control to
create jobs, add inputs, edit process templates, and so on. WTS does
not work well for design work or evaluation. For example, attempting to
open PDF pages over a WTS link results in very poor screen-drawing
performance.

Note: Microsoft licensing limitations allow you to make only two WTS
administrative connections at a time to a single server. You can add more remote
WTS licenses, but Kodak supports only two licenses.

Connecting to the server

To access a server running WTS, client software must be installed. The
Microsoft Remote Desktop Connection software works well for this
purpose.

If you are using the Mac OS or a version of Windows that does not
include Remote Desktop Connection software, you can download the
software from the Microsoft web site.

Running Workshop locally and connecting to a remote
Prinergy server

Using a suitable remote access connection, you can run Workshop
directly from your remote location:

1. Install Workshop on your Windows-based or Macintoch computer.

See the Prinergy user documentation for installation instructions.
2. Start your remote connection.

See your operating system documentation for instructions.
3. Start Workshop.

If you have trouble connecting to the Prinergy server, try pinging the
remote Prinergy server.

Remote access connection setup

No matter which method you use, you require a TCP/IP network
connection from your computer to the network where the Prinergy
primary server resides. There are many ways to accomplish this; three
of the more popular ones are described here. Consult the user
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documentation for the product or method you want to use. If you
already use one of these methods, no further setup is required.

● Dial-up link
● Virtual Private Network (VPN)
● Opening a firewall port

Note: Do not set up any of these methods directly on a Kodak workflow server.
Kodak workflow server modems are specially configured for support purposes-
and are not intended for general remote control use. Always set up any remote
access method on a non-Kodak server and use the local network to access it.

Performance improves with available bandwidth (the faster, the
better). It is possible for remote Windows-based and Macintosh client
computers to achieve performance that equals the performance of on-
site computers.

Virtual Private Network (VPN)

A VPN uses a tunneling protocol to create a virtual, encrypted link over
another medium, usually the Internet, to connect two networks.
Instructions for setting up a Windows VPN are available at http://
support.microsoft.com/kb/305550

Opening a firewall port

This method is useful only for accessing a Prinergy server via WTS.
Inbound connections on port 3389 can be allowed at the firewall,
enabling WTS access directly over the Internet.

This is the least desirable of the methods listed, because of potential
security risks. With careful application of firewall rules, this method
can be made reasonably secure. However, it is better to spend the time
and effort to configure a VPN server for a more secure and flexible
service.

Note: Running Prinergy Workshop remotely (without WTS) over a firewall is not
supported and is impossible to do securely. Prinergy Workshop is designed to run
on a LAN, with no firewall between it and the primary server. Using Prinergy
Workshop locally requires a direct, non-firewall connection to the remote LAN.

See also:
Pinging a remote Prinergy server on page 12

Prinergy Direct
Prinergy Direct software serves these two specific situations:

● Flat-based workflow where Prinergy Direct accepts imposed flats
created in Preps or other software.

● Hub-and-spoke setup where Prinergy Direct imports jobs that were
exported from Kodak Prinergy Connect.
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In both situations, Prinergy Direct is used only to create imposition
proofs and make plates.

Since Prinergy Direct is targeted to specific situations, some features
are visible but unavailable. Here is a summary of the unique
restrictions in Prinergy Direct:

● You can import only by using a hot folder that is associated with an
Import process template. You cannot use the Import Job or Import
Job (Incremental) menu items to start an Import process template.

● You can add and refine files only by using a hot folder linked to a
Refine process template. You cannot manually add input files, select
them, or start a Refine process template on them. In the Refine
process template, the CEPS, PDF Preflight, Trap, and Thumbnail
sections are unavailable.

● You cannot work with pages, page sets, or impositions. The Pages
view, Imposition Plans view, and the Loose Page Proof process
templates are not available.

● You can manage the colors of a job only via the Color Separations
dialog box. You cannot do color mapping and management via the
Color Mapping and Color Output dialog boxes.

● The workflow templates are available only using a hot folder.
● You cannot export jobs.

The Imposition Proof process templates and the Final Output process
templates function similarly to the way they do in other Prinergy
products.

Adobe software components
Prinergy includes new versions of software components from Adobe
Systems Incorporated with this release. When you perform minor
updates or major upgrades, check the readme.txt file to identify the
latest Adobe software components that are installed.

Software component Description

Adobe PDF Print Engine RIP Adobe PDF Print Engine RIP rasterizes documents. Halftone screening
patterns are defined by Kodak components.

Adobe PDF Print Engine is the preferred RIP.

Version: 2.5

CPSI RIP CPSI RIP rasterizes documents. Halftone screening patterns are defined by
Kodak components.

Version: 3018.101-04
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Software component Description

Flattener The flattener converts documents from PDF to the Adobe PostScript
language.

Version: 3018.101-04

Normalizer The normalize function converts documents from the PostScript language to
PDF files.

Version: 9.0

PDF Library Prinergy uses the PDF Library to read, modify, and write PDF documents.

Version: 10

Adobe Illustrator software Prinergy 5.2 and later support Illustrator CS3, CS4, and CS5 for use with the
PDF File Editor.

Adobe Acrobat software Prinergy supports Acrobat software versions 8, 9, and X. It is your
responsibility to acquire and install the number of Acrobat licenses needed
for client workstations. Install the Acrobat software on each Mac or
Windows workstation before installing Workshop, to ensure that the Kodak
plug-ins for Adobe Acrobat software are in the correct folders.

Note: The Kodak Prinergy Powerpack software is bundled with one Acrobat
software license.

Prinergy includes several Kodak plug-ins for Acrobat, as well as Adobe 
Distiller job options. These plug-ins and job options are automatically
installed when you install Prinergy Workshop. Kodak plug-ins for earlier
versions of Acrobat are not removed during a Prinergy Workshop upgrade,
but they will not be updated or supported in the future.

Note: The Floating License Manager (FLIM), which allows a particular
number of users to share the same license, controls the number of
concurrent users. Some plug-ins do not require a license.

Take these precautions

Ensure that the version of the RIP used to proof and approve content is
the same version that is used to make final output.

Proofs and plates—When upgrading to a version of Prinergy where the
RIP components have been upgraded, be careful when plating jobs that
were proofed with the old RIP. Because the RIPs are different, an
interpretation difference may occur between proof and plate. Ideally,
jobs should be plated with the same version of Prinergy that was used
to generate the proofs. Hub and spoke configurations should
coordinate when performing upgrades to ensure that they are using the
same RIP.

Reprints—To reprint jobs that were printed using an older RIP, rerun
proofs using the new RIP. This ensures that there are no unforeseen
differences between the original press run and the reprint.

Adobe PDF Print Engine—Prinergy includes Adobe PDF Print Engine,
the PDF RIP from Adobe Systems Inc.

Adobe software components 11



Because Adobe PDF Print Engine is a PDF RIP, files remain in PDF
throughout processing. The RIP does not consume PostScript objects,
and it does not flatten PDF files to PostScript before processing, like
CPSI RIP does.

Adobe PDF Print Engine provides the following advantages over CPSI
RIP:

● Adobe PDF Print Engine accurately handles files with native
transparency without flattening. If a file exposes a problem in the
flattener or in CPSI RIP, Adobe PDF Print Engine can handle the file
correctly.

● Adobe PDF Print Engine’s rendering of fonts is more like Adobe
Acrobat’s rendering of fonts.

● Adobe PDF Print Engine correctly renders text that is located below
transparent images. Occasionally, when low-resolution proofs are
rendered by CPSI RIP, the text appears fatter due to the flattening
that occurs in CPSI. Because Adobe PDF Print Engine does not
flatten, it does not have this problem.

Adobe PDF Print Engine has the following disadvantages:

● Adobe PDF Print Engine cannot process PDF files containing
embedded PostScript objects, including pages that were processed
with PostScript bypass or with OPI bypass features of Prinergy.

● In some cases, Adobe PDF Print Engine processes copydot data and
separated pages more slowly than CPSI RIP.

Quitting Prinergy Workshop
Perform one of these actions:

○ On a Windows-based client: In Job Finder, from the File menu,
select Quit.

○ On a Macintosh client: In Job Finder or Job Manager, from the
Workshop menu, select Quit Workshop.

Any open Prinergy Workshop windows close.

Pinging a remote Prinergy server
If Workshop cannot connect to the primary server even after you enter
the IP address manually, use the ping utility to determine whether the
IP address is accessible.

When you log in, in the Connect to Prinergy Server dialog box, in the
Primary host box, you may need to manually enter the IP address of the
primary server. The network broadcast that Workshop normally uses
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to find a primary server does not often work well across a routed
connection.

1. Open the command prompt window.

2. At the command prompt, type: ping <primary server IP
address>
For example: ping 2.159.12.141.

Your computer will send several packets of data to the specified IP
address.

3. At the bottom of the command prompt, check the Ping statistics.

If the packets of data were sent and received successfully, the IP
address you specified is accessible.

If the packets of data were not sent and received successfully, the IP
address is not accessible. In this case, your connection is not set up
properly. Contact your IT department for assistance.

Locating translated documents
Some of the documents that this user guide refers to have been
translated into other languages.

For a list of translated documents for this product:

1. Log on to the Kodak eCentral Internet portal at https://
partnerplace.kodak.com/.

2. Select Support & Services > Self-Support > Product
Documentation.

3. In the Choose a product list, select the product, and click Go.

You will see a complete list of available documents for this product,
including titles that have been translated.

Locating translated documents 13
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3 Job Finder

About the Job Finder window
Job Finder is the first window that appears when you start Prinergy
Workshop.

You must create a job for every publication that you want to print and
then add to the job the content files that make up that publication.

Job Finder is where you:

● Find jobs and pre-jobs
● Create new jobs and pre-jobs
● Manage existing jobs and pre-jobs
● Set job status and other attributes
● Create and manage groups to organize your jobs

Inside Job Finder are columns that provide information about each job,
such as when the job was created, where the job is stored, job status,
and so on. You can display and hide columns. The columns affect Job
Finder speed.

Job Finder consists of two views: Jobs and Pre-Jobs.

In either view, jobs and pre-jobs are organized by group. Grouping jobs
makes them easier to find and manage. We recommend that you store
jobs and pre-jobs in separate groups to help you distinguish between
them.



Changing views in Job Finder
Change between the Jobs view and the Pre-Jobs view of Job Finder.

Perform one of these actions:

○ Click Jobs or Pre-Jobs at the top of Job Finder.
○ From the View menu, select Jobs or Pre-Jobs.

Job Finder window

Views

Jobs

Lists all of the jobs in your system.

Pre-Jobs

Lists all of the pre-jobs in your system

Columns

Name

The name of the job, pre-job, or group. This column cannot be
hidden.

Job Alias

The alias of jobs in your system. For systems where the job
name is a number, the job alias provides the meaningful job
name. Job Alias corresponds to Job Description in Kodak InSite
Prepress Portal. If you change the job alias in Prinergy, the job
description in InSite Prepress Portal is changed.

Kind

Indicates whether the item is a job, pre-job, or group.

Job Status

The status of the job. When a job is created, its status is set to
In Prepress.

You can change a job's status in the Edit Job Attributes dialog
box. The following statuses are available:

● Created
● In Prepress
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● On Press
● Shipped
● Completed
● Ready for Final Output
● Completed Final Output

If the job is enabled for Web access through Prepress Portal,
the following additional statuses are available:

● In Cart
● Pending Order Approval
● Order Requested
● Order Accepted
● Order Rejected

Select Enable Press Side Proofing if the workflow includes the
Kodak PressProof software.

Job Home

The full path name for the job folder location.

Created

The date and time when you created the job or pre-job.

Job Code

A job code that you specify. The job code can be anything that
is meaningful to you or to your customer.

The job code is:

● Available to an imposition job ticket
● Available as a variable mark on the job's output
● Exported with a job
● Included in CIP3 files when Prinergy generates CIP3 files

during final output

The job code also appears in Prepress Portal, if the job is
enabled for Web access through Prepress Portal. If you change
the job code in Prinergy, the job code in PrePress Portal is
changed.

Proof Due

The date and time that the proofs for the job are due. This
information is set in the Edit Job Attributes dialog box.
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Final Output Due

The date and time that the final output for the job is due. This
information is set in the Edit Job Attributes dialog box.

Web Access Customer

The name of the customer for whom you have enabled web
access. This information is set in the Edit Job Attributes dialog
box.

Online

Indicates whether a job is fully or partially Offline or Online.

Offline indicates that no files in the job's job folder exist on the
job home server. Files from outside the job folder may still be
online. When you fully purge a job, its status is Offline since
purging removes all files in the job folder from the job home
server.

Online indicates that at least one file for the job is on the job
home server.

If this column is blank, the status of the job is not known.

Max Layers

The maximum number of pages that you can assign to one page
position. This information is set in the Edit Job Attributes dialog
box and only applies to legacy versioning jobs.

Pages Approved

The number of approved pages, over the total number of pages
in the job.

Errors/Warnings

Displays the most important error or warning status from the
most recent processes in the Processes pane of Job Manager.

Full Surfaces

The number of surfaces for which all positions have pages
assigned, over the total number of surfaces in the job.

Final Output Count

The number of separations you have output using a final output
process template, over the total number of separations in the
job.
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Last Final Output

Date and time the last separation was output using a final
output process template.

Last Archived

The date and time that someone last archived the job.

Archive Status

The quantity of files in the job that you have archived at any
time. Possible statuses are:

● None: The job has not been archived.
● Some: Some but not all files in the job were archived. This

can occur when you:

○ Archive only selected files, not the whole job
○ Archive the job, and then add one or more files to the job,

for example, by adding input or processing an input file
that had not been processed before the archive

○ Change one or more of the archived files, for example by
processing it again

● All: The job was archived and no changes have been made to
any files in the job.

Stale Archive Status

The quantity (All Some, or None) of files in the job that have
changed since the last archive.

Custom Fields

You can create custom fields for jobs or for elements within a
job, so that you can track unique information about the job or
element. Custom fields let you determine the type of
information that you view about a job or job element.

Custom Fields appear in Job Finder when you create custom
fields using the Custom Fields Manager dialog box and select
them in the Visible Columns dialog box.

Menus in Job Finder

Workshop menu in Job Finder
Note: This menu is available only when running Prinergy Workshop on a
Macintosh client.

Menus in Job Finder 19



About Prinergy Workshop

Displays information about Prinergy Workshop, including the
version number, a list of licensed features, and the server name.

Preferences

Use to view and modify Prinergy Workshop preferences. When
you select this menu item, the Workshop Preferences dialog
box appears.

Note: On a Windows client, this menu item appears under the Edit menu.
On a Macintosh client, it appears under the Workshop menu.

Quit / Quit Prinergy Workshop

Quits Prinergy Workshop. Any open Prinergy Workshop
windows are closed.

File menu in Job Finder
Note: Some menu items are available only in the Jobs view or the Pre-Jobs view.

New Job / New Pre-Job

Use to create a new job or pre-job. When this menu item is
selected, the Create New Job or Create New Pre-Job dialog box
appears.

Open / Open Job / Open Pre-Job / Open Jobs in Group

This menu item appears as Open Job or Open Pre-Job when a
job or pre-job is selected. Use this menu item to open the
selected job or pre-job.

This menu item appears as Open Jobs in Group when a group is
selected. Use this menu item to open all of the jobs in the
selected group, including all of the jobs in any sub groups.

This menu item appears as Open when a group is selected that
does not contain any jobs, or when no job or group is selected.
When you select Open, the Open Job dialog box appears,
prompting you to select a job to open.

Import Job

After you select a job or pre-job this menu item displays the
Import Job dialog box where you can select an exported job
(<filename>.zip) and import it into the selected job or pre-job.
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Export Job

After you select a job or pre-job, this menu item display the
Choose Process Template dialog box where you select an
export process template and export the selected job or pre-job.

New Group

Use to create a new group.

Change Group

Use to move the selected job or pre-job to another group, or to
move the selected group to another group.

Move to Pre-Job / Job

Use to change the selected job to a pre-job or the selected pre-
job to a job. Once changed, the job will move to the Pre-Jobs
tab, or the pre-job will move to the Jobs tab.

Note: Changing a pre-job to a job might stop Insite upload processing
from working on that job, depending on how Insite is configured.

Move Job from Remote Server

Use to move the selected job from the server to a different
server. When this menu item is selected, the Move Job from
Remote Server dialog box appears.

Rename / Rename Job / Rename Pre-Job / Rename Group

Use to rename the selected job, pre-job, or group.

Copy / Copy Job / Copy Pre-Job

Use to copy the selected job, pre-job, or group. When this menu
item is selected, the Copy Job dialog box appears.

Delete / Destroy Entire Job / Destroy Entire Pre-Job / Delete Group

Use to destroy the selected job or pre-job, or to delete the
selected group. When this menu item is selected, the Destroy
Job dialog box appears.

Get Info

Use to display information about the selected job or pre-job.
When this menu item is selected, the Job Info dialog box
appears.

Quit / Quit Prinergy Workshop

Quits Prinergy Workshop. Any open Prinergy Workshop
windows are closed.
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Edit menu in Job Finder
Note: Some menu items are available only in the Jobs view or the Pre-Jobs view.

Cut, Copy, and Paste (unavailable)

Set Job to Completed

Use to set the status of the selected job to Completed.

Setting a job's status to Completed deactivates the job.

Set Job to In Prepress

Use to set the status of the selected job to In Prepress.

Edit Job Attributes / Edit Pre-Job Attributes

Use to view and modify the attributes of the selected job or pre-
job. When this menu item is selected, the Edit Job Attributes
dialog box appears.

Find Job / Find Pre-Job

Use to locate a job or pre-job.

Preferences

Use to view and modify Prinergy Workshop preferences. When
you select this menu item, the Workshop Preferences dialog
box appears.

Note: On a Windows client, this menu item appears under the Edit menu.
On a Macintosh client, it appears under the Workshop menu.

Enable Rule Set in Selected Jobs

Select this menu item to enable a rule set for the selected jobs.

This menu item opens the Enable Rule Set in Selected Jobs
dialog box where you navigate through the rule set groups,
select the rule set that you want to enable, and then click the
Enable in <n> Jobs button. The <n> indicates the number of
jobs you selected in Job Finder.

View menu in Job Finder
Note: Some menu items are available only in the Jobs view or the Pre-Jobs view.

Refresh

Updates the contents of the current window.
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Jobs

When in the Pre-Jobs view use this menu item to switch to the
Jobs view.

Pre-Jobs

When in the Jobs view use this menu item to switch to the Pre-
Jobs view.

Visible Columns

Use to display and hide columns in the current window or pane.
When you select this menu item, the Visible Columns dialog
box appears. From there, you select the columns that you want
to display, and clear the columns that you want to hide.

The columns that can be displayed vary from window to
window.

Process menu in Job Finder

<process category> > <process type> > <process group> >
<process template>

The name of each process template that applies to selected
elements is available on the Process menu.

Click this item to start process on the selected elements using
this process template.

Workflow > <workflow type> > <workflow group> > <workflow
template>

Each workflow template that applies to selected elements is
available on the Process menu.

Click this item to start process on the selected elements using
this workflow template.

Manual Start Rules > <rules context> > <rules group> > <rule set>

Expands to display the rule sets that:

● Apply to the currently selected elements
● Are triggered by Manual Trigger events
● Are enabled

The first submenus under Manual Start Rules are:

● All Jobs: Select this to see system rule sets.
● Job <job name>: Select this to see the job rule sets enabled

for the job that you are in.
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After you select the first submenu, navigate through the rule set
groups and select the rule set that you want to trigger.

Tools menu in Job Finder

Change User

Displays the Connect to Server dialog box where you can log in
as another user without quitting Prinergy Workshop.

This menu item appears only if you have Kodak Prinergy
Business Link software connected to the Prinergy system.

Job Finder

Opens Job Finder.

If you are already in Job Finder, this menu item is unavailable.

Destroy History Entries

In the History view, select one or more history entries and then
use Destroy History Entries to delete the selected entries.

Process Template Editor

Launches Process Template Editor, where you can create and
modify process templates.

Automated Page Assignment Editor

Starts the Automated Page Assignment Editor, which you use
to create and check APA files.

Queue Manager

Launches Queue Manager, where you can view the Job Ticket
Processors (JTPs) and process types.

Media Manager

Launches Media Manager, where you can manage your archive
tapes and disk volumes.

System History

Launches System History, which displays the detailed history of
all the activity occurring outside of job context (such as jobs
and groups that were created or destroyed), as well as job
archive, purge, and retrieve history.

Smart Hot Folder Manager

Launches the Smart Hot Folder Manager dialog box, where you
can add, edit and delete smart hot folders.
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Configure Imposition Application

Displays the Configure Imposition Applications dialog box,
where you can identify the location of imposition software that
you want to integrate with Prinergy Workshop.

Start Imposition Application

Displays the Start Imposition Application dialog box, where you
choose which imposition software to start. You create this list
of imposition applications with the Configure Imposition
Application tool from the Tools menu. If an application requires
a license and is licensed, it appears in bold.

Color Editor

Launches Color Editor, where you can create color recipes for
all jobs.

Color Space Editor

Launches Color Space Editor, where you can create and edit
color spaces.

Font Converter

Launches Font Converter, where you can convert font files into
PFA (Printer Font ASCII) format, which Prinergy requires to
correctly process fonts.

Preflight Profile Manager

Launches Preflight Profile Manager, where you can, during the
refine process, evaluate PDFs to detect problems that may
affect processing in a publishing or prepress workflow.

Plate Remake

Opens the Plate Remake dialog box, where you can enter the
identification number of a plate to quickly remake the plate
using the same process template settings and output device
that were used to make the original plate. For more information,
see Remaking plates on page 626.

Digital Print Administration Console

Launches the Digital Print Administrator, where you can add
and configure a digital print application that Prinergy can launch
to print PDFs.

Rule Set Manager

Opens the Rule Set Manager, where you can create and edit
rule sets. The Rule Set Manager also lets you organize rule sets
into groups.
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Activate Rule Set in Selected Jobs

Opens the Select Rule Set dialog box, where you can activate
rule sets for one or more jobs.

Help menu in Job Finder

Online help

Starts your Web browser and displays the Prinergy online help.

On <current window or view>

Starts your Web browser and displays the Prinergy Workshop
user guide, open to the topic for the currently selected window
or view.

Quick Start Guide

Starts Adobe Acrobat and displays a PDF file of the Prinergy
Connect Quick Start Guide

eCentral Online Support

Starts your Web browser and displays the eCentral portal at 
https://ecentral.kodak.com/.

Visit graphics.kodak.com

Starts your Web browser and displays the Kodak Web site at 
http://graphics.kodak.com/default.htm.

About Prinergy Workshop

Displays information about Prinergy Workshop, including the
version number, a list of licensed features, and the Prinergy
server name.

Note: This menu item appears on the Help menu only when you are
running Prinergy Workshop on a Windows-based client computer. On a
Macintosh client computer, the menu item About Workshop appears on
the Workshop menu.

Keyboard shortcuts in Job Finder

Macintosh
Keyboard
Shortcut

Windows
Keyboard
Shortcut

Description

 + Delete Ctrl + Delete Destroys the selected job or pre-job, or deletes the selected group

 + I Ctrl + I Displays the Job Info dialog box for the selected job or pre-job
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Macintosh
Keyboard
Shortcut

Windows
Keyboard
Shortcut

Description

 + N Ctrl + N Displays the Create New Job dialog box (in the Jobs view) or the Create
New Pre-Job dialog box (in the Pre-Jobs view)

 + O Ctrl + O Opens the selected job or pre-job

 + Q Ctrl + Q Quits Prinergy Workshop

 + R Ctrl + R Refreshes the selected view

 + 1 Ctrl + 1 Displays the Jobs view

 + 2 Ctrl + 2 Displays the Pre-Jobs view

See also:
Create New Job / Pre-Job dialog box on page 86
Job Info dialog box on page 103
Choose process template dialog box on page 174
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4 Job Manager

About the Job Manager window
Job Manager is where you do most of your work on a job.

For example, you add input files, import imposition plans, assign pages
to page sets and imposition plans, and start processing.

The Job Manager window appears when you create a new job or pre-
job or open an existing job or pre-job from Job Finder.

The window title displays the:

● Login ID of the user currently logged in to Prinergy Workshop
● Name of the job
● Name of the server where the job is

Every job or pre-job that you open appears in its own Job Manager
window. You can open multiple Job Manager windows to work on more
than one job at the same time.

About user and job favorites
The Job and User tabs of the Process Templates pane display favorites,
meaning process templates that you want to access quickly or
frequently.

You start processes with the process templates on both the Job and
User tabs in the same way that you start processes on the Global tab.

Job favorites

Job favorites are the process templates on the Job tab and are specific
to each job. Any process templates that you add to it will be available
each time anyone opens the job on any computer.

Use this tab to store process templates any users may need for this job.
To add process templates to the Job tab, see Managing process
templates on the job and user tab, or you can select the Add Process
Template to Job Favorites check box in the Start Process dialog box.

Job favorites are one of the settings you can save in a template job. You
can create a template job and add process templates to its Job tab.
Then you can create new jobs based on this template job and



automatically copy the contents of the Job tab from the template job to
the new jobs.

User favorites

User favorites are the process templates on the User tab and are
specific to your user account. Any process templates that you add to it
will be available each time you open any job.

Use this tab to store process templates you need for several jobs. To
add process templates to the User tab, see Managing process
templates on the job and user tab.

Changing views in Job Manager

Perform one of these actions:

○ At the top of Job Manager, click the appropriate button: Pages,
Signatures, Separations, Storage, or History.

○ From the View menu, select the appropriate menu item: Pages,
Signatures, Separations, Storage, or History.

○ Use a keyboard shortcut.

Selecting items in Job Manager
You can select items in several ways in Job Manager:

To select Do this

All items in a pane Click in a pane. On the Edit menu, click Select All. (The
name of the menu item varies depending on the active
pane.)

Items in a series In List view, click the first item you want to select, hold
down the Shift key, and click the last item. In Thumbnail
view, create a box, or marquee, around the items you want
to select.

Items that are not
in a series

Hold down the Ctrl key (or the  key on a Macintosh), and
click the items you want to select. (This applies to both
List view and Thumbnail view.)

Only even or odd
pages

Select the page positions. On the Edit menu, select Keep
Even Pages Selected or Keep Odd Pages Selected.

Note: In Pages view, this applies only to the Page Sets
pane, not to the Pages pane. In Signatures view, this
applies to the Imposition Plans pane.
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To select Do this

An entire
imposition plan

In the Signatures or Separations view, select the name of
the imposition plan.

In the Storage view, select the file.

An entire page set In Pages view, select the name of the page set in the Page
Sets pane.

Expanding and collapsing items in the Process
Templates pane

To Expand or
Collapse

Do This

One item Click the + or - icon next to the item.

All items Right-click anywhere in the Process Templates pane, and
select Expand All or Collapse All.

Tip: You can also select the Process Templates pane. From
the View menu, select Expand All or Collapse All.

Getting information about an element

1. In Job Manager, select one or more elements, such as an input file.

2. Perform one of the following actions:

● From the File menu, select Get Info.
● Right-click the selection, and select Get Info.

3. Review the Get Info dialog box for the selected elements.

4. Click Close.

Managing process templates on the job and user tab

1. From the Job menu, select Manage Job/User Favorites.

Tip: You can also right-click anywhere in the Job or User tab of the Process
Templates pane, and select Manage Job/User Favorites.

2. In the Manage Job/User Favorites dialog box, click the Job or User
tab.
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3. Perform any of the following actions:

To Do This

Add a process
template

Double-click the process template.

Delete a process
template

Double-click the process template that you want
to remove.

Change the order of
process templates

Select a process template, and click Move Up or
Move Down.

Add a separator Click Add Separator.

Move a separator Select the separator, and click Move Up or Move
Down.

4. Click OK.

Tip: You can also add a process template to the Job tab by selecting the Add
Process Template to Job Favorites check box in the Start Process dialog box.

Job Manager window

Main pane

Pages view (with Page Sets, Pages , and Input Files panes)

Signatures view (with Imposition Plans, Pages , and Input Files
panes)

Separations view

Storage view

History view

 Job

The job button enables you to treat the whole job as if it were
an element. You can start certain processes (archiving, purging,
retrieving, and exporting) for the whole job without selecting
the job files individually, and without exiting Job Manager. You
can also locate the Jobs folder in the file browser, and get job
information by opening the folder named after the job.

Right-click the job button to display the available menu items.

Right-hand panes

Process Templates pane
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Processes pane

See also:
Pages view on page 33
Signatures view on page 39
Separations view on page 46
Storage view on page 48
History view on page 51

Pages view
The Pages view of Job Manager displays information about input files,
pages (input files that have been processed), and page sets.

Use this view to perform the following tasks:

● Add input files to a job
● Refine input files
● Add page sets
● Import imposition plans
● Assign pages to page sets
● Make loose page output

This view is similar to the Signatures view except that you see a job in
reader order rather than as a layout.

Panes in Pages view

The Pages view has three panes, each with its own buttons and
columns.

The Page Sets pane displays page sets for the job.

● A page set is similar to the idea of a "run list." When you import an
imposition plan into the job or create a page set, the page set
appears in this pane. A page set can also be created independently
of an imposition.

● When you assign pages to positions in the page set, the assignment
information also appears in this pane.

● You can also proof pages from this pane.

The Pages pane displays information about refined PDF page files. In
this pane, you can work with individual PDF files to perform the
following tasks:

● View a soft proof in Acrobat
● Output loose page output
● Manage page position assignments
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The Input Files pane displays the unprocessed input files that you add
to the job. You work in this pane when refining input files. Files in this
pane appear in list view only. After you process your input files, you
may want to collapse the Input Files pane to reduce the space that it
occupies.

Description of Pages view

Note: The columns that you see depend on which columns are set to be displayed
or hidden.

Page Sets pane

 Group by Page Set

Switch this button on to group pages by page set, or off to
group all pages together.

This button is available only in list view. In thumbnail view,
Group by Page Set is always enabled.

Page Position

The page position number is a combination of the page set
prefix and the position number (both user-definable).

You define the prefix when you create a page set or add an
imposition plan to a job.

A value appears only if the page has been assigned to a page
position on a page set.

Page

The file name of the page that is assigned to the page position

Assignment Count

Displays the number of pages assigned to the page position

Layered Page Number

Applies to the Layered PDF Versioning feature, which is
currently under development. For more information, contact
your sales representative.

Run List

If an imposition was imported from Preps, this column displays
the run list as defined in Preps. The run list shows the order in
which each page appears in the product.

Product/Part

If an imposition was imported from Preps, this column displays
the product name, part name, and part page number. For
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example, Brochure (A) BW Text 15 means that the
product is Brochure (A), the part is BW Text, and the page
position is 15.

<custom field> (more than one may be visible)

Any custom fields that were created for this job element with
the Show in Workshop check box selected

Pages pane

 Group by Assignment

Switch this button on to sort pages into two groups—assigned
or not assigned to a page position in a page set. Switch this
button off to group all pages, assigned and unassigned,
together.

Group by Assignment can be enabled or disabled only when in
list view. In thumbnail view, Group by Assignment is always
enabled.

If both Group by Assignment and Group by Input File are
enabled, sorting is first by assignment and then by input file.

 Group by Input File

Switch this button on to sort pages according to the input files
from which they were created. Switch this button off to group
all pages together, regardless of input file.

This button can be enabled only when in list view.

If both Group by Assignment and Group by Input File are
enabled, sort is first by assignment and then by input file.

Page

The file name of the page that is assigned to the page position

Page Position

The page position number is a combination of the page set
prefix and the position number (both user-definable).

You define the prefix when you create a page set or add an
imposition plan to a job.

A value appears only if the page has been assigned to a page
position on a page set.
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Surface

The name of the surface and signature to which the page is
assigned. For example, if the page is assigned to the front
surface of Signature 1, the Surface column displays A Front 1.

This column is available only in the Pages pane of the
Signatures view.

Input File

The name of the input file from which the page was created

Date Refined

The date and time that the page was created

Page File Location

The path to the page file

Size

The size of the file.

The file size is listed in KB if the file is less than 1 MB, or in MB if
the file is 1 MB or more.

If it is not a PDF file, the value is N/A.

Preflight Report

Indicates whether a PDF Preflight report has been generated for
the PDF page, or whether it is not available.

Ordinal Number

The page number in a multi-page file that this page represents

Versioned Page Status

This is part of Layered PDF Versioning. For information about it,
see the Prinergy Layered PDF Versioning User Guide.

Page Colors

The process and spot colors in the page

Composite

Indicates whether the page is composite.

A composite file is not divided into color separations.

Customer Approval

The approval status of the page. These are the possible
approval statuses:
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● Approval not Required
● Approval Requested
● Approval in Progress
● Waiting for Correction
● Approved
● Rejected

Media Size

The width and height of the media box of the PDF file.

The unit of measure is specified in the Workshop Preferences
dialog box.

Trim Size

The horizontal and vertical measurements to which the page
will be cut. The trim size is determined by the page position to
which the page is assigned.

If the file is not a PDF file, the value is N/A.

The unit of measure is specified in the Workshop Preferences
dialog box.

Offset

The horizontal and vertical adjustments made to the page from
the lower-left corner.

This column appears in the Signatures pane and the Pages
pane.

If the page is not centered, the value is the same in both panes.

If the page is centered, the value in the Signatures pane is the
difference between the Media Size and the Trim Size.

The unit of measure is specified in the Workshop Preferences
dialog box.

Scale (%)

The horizontal and vertical scale measurement of the page, as a
percentage of the page's original size.

If the file is not a PDF file, the scale appears as N/A.

Orientation (°)

The number of degrees that the page is rotated.

Select from 0, 90 CW (clockwise), 180, and 90 CCW (counter-
clockwise).
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If the file is not a PDF file, the orientation appears as N/A.

<process template>

The name of the process template group that was used to
process the file and the processing status.

This column automatically appears in these panes:

● Input Files pane when an input file is processed
● Pages pane when a page is processed
● Imposition Plans pane when a surface is processed

This is known as a dynamic column. More than one dynamic
column may appear if more than one process template is used.

<custom field> (more than one may be visible)

Any custom fields that were created for this job element with
the Show in Workshop check box selected

Input Files pane

Primary File

The name of the input file

# Files

The number of input files in the row

Size

The size of the file.

The file size is listed in KB if the file is less than 1 MB, or in MB if
the file is 1 MB or more.

If it is not a PDF file, the value is N/A.

Modified

The date and time that the file was last modified

Created

The date and time that the file was created

Kind

The file type—for example, Layered PDF, PostScript or PDF

Location

The path to the file

38 Chapter 4—Job Manager



<process template>

The name of the process template group that was used to
process the file and the processing status.

This column automatically appears in these panes:

● Input Files pane when an input file is processed
● Pages pane when a page is processed
● Imposition Plans pane when a surface is processed

This is known as a dynamic column. More than one dynamic
column may appear if more than one process template is used.

 Job

The job button enables you to treat the whole job as if it were
an element. You can start certain processes (archiving, purging,
retrieving, and exporting) for the whole job without selecting
the job files individually, and without exiting Job Manager. You
can also locate the Jobs folder in the file browser, and get job
information by opening the folder named after the job.

Right-click the job button to display the available menu items.

Signatures view
The Signatures view of Job Manager displays information about input
files, pages (input files that have been processed), and imposition
plans.

Use this view to:

● Assign pages to page positions of imposition plans
● Proof impositions

This view is similar to the Pages view, except that you can see a job as
a layout rather than in reader order.

Panes in Signatures view

The Signatures view has three panes, each with their own buttons and
columns.

The Imposition Plans pane displays information about the imposition
plans (signatures and surfaces) for the job.
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● When you create an imposition plan or import one into a job, the
imposition plan displays in this pane.

● When you assign pages to page positions of the imposition plan the
page assignment information also appears in this pane.

● In thumbnail view imposition plans appear hierarchically with their
corresponding signatures. Surfaces appear below each signature.

The Pages pane displays information about refined PDF page files. In
this pane, you can work with individual PDFs to:

● Soft-proof with Adobe Acrobat
● Output loose page output
● Manage page position assignments

The Input Files pane displays the unprocessed input files that you add
to the job. You work in this pane when refining input files. Files in this
pane display in list view only. After you process your input files, you
may want to collapse the Input Files pane to reduce the space that it
occupies.

Description of Signatures view

Note: The columns you see depend on the columns you display or hide.

Imposition Plans pane

Name

The name of the element.

For a page, the name is in the form of <input file
name>.<page #>.p.

Page

When the hierarchy is opened to display individual positions,
this column displays the file name that is assigned to each
position.

On the rows that contain information other than positions, this
column indicates the number of positions in the surface that
have files assigned to them—for example, 4 of 4 Assigned.

Assignment Count

Displays the number of pages assigned to the page position

Workstyle

The workstyle as specified by the imposition plan—for example,
Sheetwise.

40 Chapter 4—Job Manager



Page Set

The name of the page set to which the imposition plan is linked.

Web Growth Profile Name

Any web growth profile associated with the signature, sheet, or
surface.

A web growth profile is an XML file used to digitally
compensate for press distortion.

Web Growth Profile Path

The location of any web growth profile associated with the
signature, sheet, or surface.

Note: If a web growth profile is specified in Job Manager, this overrides
any web growth profile that is defined for the process template.

Center Page

Indicates whether the page is centered.

Offset

The horizontal and vertical adjustments made to the page from
the lower-left corner.

This column appears in the Signatures pane and the Pages
pane.

If the page is not centered, the value is the same in both panes.

If the page is centered, the value in the Signatures pane is the
difference between the Media Size and the Trim Size.

The unit of measure is specified in the Workshop Preferences
dialog box.

Trim Size

The horizontal and vertical measurements to which the page
will be cut. The trim size is determined by the page position to
which the page is assigned.

If the file is not a PDF file, the value is N/A.

The unit of measure is specified in the Workshop Preferences
dialog box.

<process template>

The name of the process template group that was used to
process the file and the processing status.

This column automatically appears in these panes:
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● Input Files pane when an input file is processed
● Pages pane when a page is processed
● Imposition Plans pane when a surface is processed

This is known as a dynamic column. More than one dynamic
column may appear if more than one process template is used.

<custom field> (more than one may be visible)

Any custom fields that were created for this job element with
the Show in Workshop check box selected

Pages pane

 Group by Assignment

Switch this button on to sort pages into two groups—assigned
or not assigned to a page position in a page set. Switch this
button off to group all pages, assigned and unassigned,
together.

Group by Assignment can be enabled or disabled only when in
list view. In thumbnail view, Group by Assignment is always
enabled.

If both Group by Assignment and Group by Input File are
enabled, sorting is first by assignment and then by input file.

 Group by Input File

Switch this button on to sort pages according to the input files
from which they were created. Switch this button off to group
all pages together, regardless of input file.

This button can be enabled only when in list view.

If both Group by Assignment and Group by Input File are
enabled, sort is first by assignment and then by input file.

Page

When the hierarchy is opened to display individual positions,
this column displays the file name that is assigned to each
position.

On the rows that contain information other than positions, this
column indicates the number of positions in the surface that
have files assigned to them—for example, 4 of 4 Assigned.

Page Position

The page position number is a combination of the page set
prefix and the position number (both user-definable).
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You define the prefix when you create a page set or add an
imposition plan to a job.

A value appears only if the page has been assigned to a page
position on a page set.

Surface

The name of the surface and signature to which the page is
assigned. For example, if the page is assigned to the front
surface of Signature 1, the Surface column displays A Front 1.

This column is available only in the Pages pane of the
Signatures view.

Input File

The name of the input file from which the page was created

Date Refined

The date and time that the page was created

Page File Location

The path to the page file

Size

The size of the file.

The file size is listed in KB if the file is less than 1 MB, or in MB if
the file is 1 MB or more.

If it is not a PDF file, the value is N/A.

Preflight Report

Indicates whether a PDF Preflight report has been generated for
the PDF page, or whether it is not available.

Ordinal Number

The page number in a multi-page file that this page represents

Page Colors

The process and spot colors in the page

Composite

Indicates whether the page is composite.

A composite file is not divided into color separations.
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Customer Approval

The approval status of the page. These are the possible
approval statuses:

● Approval not Required
● Approval Requested
● Approval in Progress
● Waiting for Correction
● Approved
● Rejected

Media Size

The width and height of the media box of the PDF file.

The unit of measure is specified in the Workshop Preferences
dialog box.

Trim Size

The horizontal and vertical measurements to which the page
will be cut. The trim size is determined by the page position to
which the page is assigned.

If the file is not a PDF file, the value is N/A.

The unit of measure is specified in the Workshop Preferences
dialog box.

Offset

The horizontal and vertical adjustments made to the page from
the lower-left corner.

This column appears in the Signatures pane and the Pages
pane.

If the page is not centered, the value is the same in both panes.

If the page is centered, the value in the Signatures pane is the
difference between the Media Size and the Trim Size.

The unit of measure is specified in the Workshop Preferences
dialog box.

Scale (%)

The horizontal and vertical scale measurement of the page, as a
percentage of the page's original size.

If the file is not a PDF file, the scale appears as N/A.
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Orientation (°)

The number of degrees that the page is rotated.

Select from 0, 90 CW (clockwise), 180, and 90 CCW (counter-
clockwise).

If the file is not a PDF file, the orientation appears as N/A.

<process template>

The name of the process template group that was used to
process the file and the processing status.

This column automatically appears in these panes:

● Input Files pane when an input file is processed
● Pages pane when a page is processed
● Imposition Plans pane when a surface is processed

This is known as a dynamic column. More than one dynamic
column may appear if more than one process template is used.

<custom field> (more than one may be visible)

Any custom fields that were created for this job element with
the Show in Workshop check box selected

Input Files pane

Primary File

The name of the input file

# Files

The number of input files in the row

Size

The size of the file.

The file size is listed in KB if the file is less than 1 MB, or in MB if
the file is 1 MB or more.

If it is not a PDF file, the value is N/A.

Modified

The date and time that the file was last modified

Created

The date and time that the file was created.

Kind

The file type—for example, Layered PDF, PostScript or PDF
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Location

The path to the file

<process template>

The name of the process template group that was used to
process the file and the processing status.

This column automatically appears in these panes:

● Input Files pane when an input file is processed
● Pages pane when a page is processed
● Imposition Plans pane when a surface is processed

This is known as a dynamic column. More than one dynamic
column may appear if more than one process template is used.

 Job

The job button enables you to treat the whole job as if it were
an element. You can start certain processes (archiving, purging,
retrieving, and exporting) for the whole job without selecting
the job files individually, and without exiting Job Manager. You
can also locate the Jobs folder in the file browser, and get job
information by opening the folder named after the job.

Right-click the job button to display the available menu items.

Separations view
The Separations view of Job Manager displays information about the
individual separations of a surface.

This view has only one pane. Files in this view display in list view only.

Description of Separations view

Note: The columns you see depend on the columns you display or hide.

Name

The name of the element.

For a page, the name is in the form of <input file
name>.<page #>.p.

Page Assignments

Indicates the number of page positions in the signature or
surface that have pages assigned to them—for example, 4 of 4
Assigned.
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Workstyle

The workstyle as specified by the imposition plan—for example,
Sheetwise.

Page Set

The name of the page set to which the imposition plan is linked.

Common

Labels a separation in a versioning job as Base, Common,
Unique, or Not Identified.

● Base identifies the separations in the first imposition plan
you imported into the job.

● Common identifies the separations you use in each of the
versioning impositions. These are the separations that stay
the same for each version. Common separations are
duplicates of the base separations. For this reason, common
separations are grayed-out, indicating you don't need to
output them, because you will output the base separations.

● Unique identifies the separations for which you have more
than one version-that is, the separations that differ for each
version.

● Not Identified indicates the Common column is
unpopulated. To populate the column, from the Job menu,
select Identify Common Separations.

Note: When outputting separations for a versioning job, you output the
bold separations (the base and unique separations); you don't output the
grayed-out separations (the common separations).

Web Growth Profile Name

Displays the name of the web growth profile, if one is selected.

Web Growth Profile Path

Displays the path to the web growth profile, if one is selected.

Content

Displays the kind of content a separation contains:

● Has Page Content indicates the separation contains page
information.

● Mark Content Only indicates the separation has marks only.
● Empty indicates the separation has no page information and

no marks.
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<process template>

The name of the process template group that was used to
process the file and the processing status.

This column automatically appears in these panes:

● Input Files pane when an input file is processed
● Pages pane when a page is processed
● Imposition Plans pane when a surface is processed

This is known as a dynamic column. More than one dynamic
column may appear if more than one process template is used.

<custom field> (more than one may be visible)

Any custom fields that were created for this job element with
the Show in Workshop check box selected

 Job

The job button enables you to treat the whole job as if it were
an element. You can start certain processes (archiving, purging,
retrieving, and exporting) for the whole job without selecting
the job files individually, and without exiting Job Manager. You
can also locate the Jobs folder in the file browser, and get job
information by opening the folder named after the job.

Right-click the job button to display the available menu items.

Storage view
The Storage view of Job Manager lists all of the input files, pages,
imposition plans and miscellaneous files that are part of the job.

Use this view to check the location and archive status of job files.

This view has only one pane. Files in this view display in list view only.

Description of Storage view

Note: The columns you see depend on the columns you display or hide.

 Group by Online Status

Switch this button on to sort files by archive state. Possible
states are:

● Missing
● Offline
● Online and Currently Archived
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● Online and Never Archived
● Online and Previously Archived

Switch this button off to group all files together, regardless of
archive state.

If both Group by Online Status and Group by File Kind are
enabled, files are sorted first by online status. Then within each
online status grouping, files are sorted by file kind.

 Group by File Kind

Switch this button on to sort files by file kind. Possible file kinds
are:

● Imposition Plan Files
● Input Files
● Miscellaneous Files
● Page Files

Switch this button off to group all files together, regardless of
file kind.

If both Group by Online Status and Group by File Kind are
enabled, files are sorted first by online status. Then within each
online status grouping, files are sorted by file kind.

Primary File

The name of the element.

# Files

The number of files associated with the primary file.

Size

The size of the file.

The file size is listed in KB if the file is less than 1 MB, or in MB if
the file is 1 MB or more.

If it is not a PDF file, the value is N/A.

Modified

The date and time that the file was last modified

Created

The date and time that the file was created

Description

The file type and how it is used in Prinergy. For example, PDF
Input File, PostScript Input File, PDF Page, or Imposition Plan.
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Last Archived

The date and time that someone last archived the job.

Location

The path to the file

Archive State

The archive state of the file. Possible states are:

● Online and Never Archived: The file has never been
archived, purged, or retrieved.

● Online and Currently Archived: The file has been archived,
but has not been purged or retrieved.

● Offline: The file has been purged. (It also had to be archived
before the purge, or the purging would not occur.)

● Online and Previously Archived: The file has been changed
since it was archived, and has not been archived since it was
changed.

● Missing: The file is not on the file system, and it has not
been archived. It also has not been purged because purging
deletes files only if they have been archived. Therefore, an
action other than purging deleted the file.

A job's Stale Archive Status is connected to the Archive State
of its files.

● If the Archive State of all files in a job is Online and Never
Archived or Online and Currently Archived, the job's Stale
Archive Status is None Stale.

● If the Archive State of some files is Online and Previously
Archived, the job's Stale Archive Status is Some Stale.

 Job

The job button enables you to treat the whole job as if it were
an element. You can start certain processes (archiving, purging,
retrieving, and exporting) for the whole job without selecting
the job files individually, and without exiting Job Manager. You
can also locate the Jobs folder in the file browser, and get job
information by opening the folder named after the job.

Right-click the job button to display the available menu items.
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History view
The History view of Job Manager displays the detailed history of all the
activity for a particular job. For each job, the History view displays:

● A description of each action taken on the job. (You can expand each
description to display additional details, and double-click each
additional detail to display more information and copy the text.)

● Individual messages for each action. (The same messages appear in
the Process Info dialog box when the process is active.)

● The date and time the action was taken
● The severity of the message

If the History view gets cluttered, you can destroy the messages if you
have permission to do so.

Description of History view

Note: The columns you see depend on the columns you display or hide.

 Group by category

Switch this button on to sort history messages by action or
process type. For example actions relating to adding or
removing input files are grouped under File Management.
Actions relating to assignments are grouped under Assignment.

Switch this button off to group all history messages together,
regardless of action or process type.

Description

A short description of the action taken. For each action, the
description includes a number at the end of the text indicating
the number of detail items listed for that action. You can
expand an action to view its details.

User Name

The logon name of the user who initiated the action.

Time

The date and time that the action or process was initiated.

Severity

Indicates whether the message is for information only, or is an
error or warning.
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 Information Message

Indicates that the action or process was completed
successfully.

 Warning Message

Indicates that the action or process reported a problem, but
carried on to completion.

 Error Message

Indicates that the action or process failed.

 Job

The job button enables you to treat the whole job as if it were
an element. You can start certain processes (archiving, purging,
retrieving, and exporting) for the whole job without selecting
the job files individually, and without exiting Job Manager. You
can also locate the Jobs folder in the file browser, and get job
information by opening the folder named after the job.

Right-click the job button to display the available menu items.

Process Templates pane
The Process Templates pane is visible in every view of Job Manager.
This pane lists the process templates that you use to start processing
on jobs and elements. It also lists the digital devices that you can
submit digital jobs to.

From this pane, you can create, open, modify, rename, and delete
process templates. You can also submit jobs to digital devices, by
dragging and dropping elements onto digital devices.

This pane also lists workflow templates and automation rules. Both
workflow templates and automation rules help to automate and
sequence multiple processes. See the Rules-Based Automation guide.

This pane displays the process templates and automation rules,
organized into three tabs:

● Global-lists all of the process templates in the system
● Job-lists the process templates that you want to access quickly

whenever you are working on a particular job
● User-lists the process templates that you want to access quickly

whenever you log in to Prinergy Workshop on any job.

See also:
About workflow templates on page 937
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Processes pane
While each process runs, the Active tab displays the following:

● Icons indicating the status of the process.
● A description of the process in the following format:

server :
process
template group

:
process
template

:
number of
elements

type of
elements

For example, Atreus:Templates:Refine:10 Input
Files
If you changed the name of the process template in the Start
Process dialog box, the Processes pane displays the revised name.

● A progress bar indicating the overall progress of the process. (The
same progress bar appears in the Process Info dialog box for the
active process.) Once the process is completed or stopped, the
progress bar disappears.

Get Info dialog box
Note: Jobs and rule sets have specific Get Info dialog boxes.

Name

The name of the element.

For a page, the name is in the form of <input file
name>.<page #>.p.

Type

The type of element for which information is being displayed for
example, Input File, Page, Page Set, or Signature .

Details

The information in the Details area is specific to each type of
element. Click  to expand this collapsible section to view more
details.

Input Files

Created

The date and time that the file was created

Kind

The file type—for example, Layered PDF, PostScript or PDF
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Location

The path to the file

Modified

The date and time that the file was last modified

Size

The size of the file.

The file size is listed in KB if the file is less than 1 MB, or in MB if
the file is 1 MB or more.

If it is not a PDF file, the value is N/A.

Pages

ByPass Refine

Indicates whether the page was processed using a bypass refine
process template.

Color Setup

The Kodak ColorFlow color setup assigned to the page during
refine.

If no color setup was assigned, the value is N/A.

Composite

Indicates whether the page is composite.

A composite file is not divided into color separations.

Customer Approval

The approval status of the page. These are the possible
approval statuses:

● Approval not Required
● Approval Requested
● Approval in Progress
● Waiting for Correction
● Approved
● Rejected

Customer Kodak Approval Comment

Any comment that was added when the approval status of the
page was set.
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Date Refined

The date and time that the page was created

Input File

The name of the input file from which the page was created

Offset

The horizontal and vertical adjustments made to the page from
the lower-left corner.

This column appears in the Signatures pane and the Pages
pane.

If the page is not centered, the value is the same in both panes.

If the page is centered, the value in the Signatures pane is the
difference between the Media Size and the Trim Size.

The unit of measure is specified in the Workshop Preferences
dialog box.

Ordinal Number

The page number in a multi-page file that this page represents

Orientation (°)

The number of degrees that the page is rotated.

Select from 0, 90 CW (clockwise), 180, and 90 CCW (counter-
clockwise).

If the file is not a PDF file, the orientation appears as N/A.

Page

The file name of the page that is assigned to the page position

Page Colors

The process and spot colors in the page

Page File Location

The path to the page file

Page Open for Edit

Whether the page is currently open for editing. If Yes, the user
who has the page open is also listed.

Page Position

The page position number is a combination of the page set
prefix and the position number (both user-definable).
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You define the prefix when you create a page set or add an
imposition plan to a job.

A value appears only if the page has been assigned to a page
position on a page set.

Scale (%)

The horizontal and vertical scale measurement of the page, as a
percentage of the page's original size.

If the file is not a PDF file, the scale appears as N/A.

Size

The size of the file.

The file size is listed in KB if the file is less than 1 MB, or in MB if
the file is 1 MB or more.

If it is not a PDF file, the value is N/A.

Media Size

The width and height of the media box of the PDF file.

The unit of measure is specified in the Workshop Preferences
dialog box.

Trim Size

The horizontal and vertical measurements to which the page
will be cut. The trim size is determined by the page position to
which the page is assigned.

If the file is not a PDF file, the value is N/A.

The unit of measure is specified in the Workshop Preferences
dialog box.

Page Sets

Assigned Positions

The number of page positions to which pages are assigned out
of the total number of available page positions—for example, 1
of 8.

Page Set Prefix

The prefix assigned to the page positions of the page set.
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Imposition Plans

Assigned Page Positions

The number of page positions to which pages are assigned out
of the total number of available page positions—for example, 1
of 8.

Job Ticket Version

The software that created the imposition plan.

Page Set

The name of the page set to which the imposition plan is linked.

Signatures

The total number of signatures in the imposition plan.

Signatures

Page

The number of page positions to which pages are assigned out
of the total number of available page positions—for example, 16
of 16.

Web Growth Profile Name

Any web growth profile associated with the signature, sheet, or
surface.

A web growth profile is an XML file used to digitally
compensate for press distortion.

Web Growth Profile Path

The location of any web growth profile associated with the
signature, sheet, or surface.

Note: If a web growth profile is specified in Job Manager, this overrides
any web growth profile that is defined for the process template.

Workstyle

The workstyle as specified by the imposition plan—for example,
Sheetwise.
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Surfaces

Assigned Page Positions

The number of page positions to which pages are assigned out
of the total number of available page positions—for example, 1
of 8.

Separations

Separations have no displayable attributes.

Custom Fields

The information in the Custom Fields area is used for tracking
information on the job or element. Click  to expand this collapsible
section to view more details.

You can edit your custom fields in the right-hand column or can use
the Custom Fields Manager dialog box to create custom fields for a job
or elements in a job.

Processing Info

Expand this collapsible section to view history messages for any
processing performed on the selected element.

Manage Job/User Favorites dialog box

list

Displays the process templates that you can add to the Job or
User tab.

Add

Select a process template in the list and click Add to add the
process template to the Job or User tab of the Process
Templates pane.

Tip: You can also double-click a process template in the list to add it to
the Job or User tab.

Add Separator

Click to add a horizontal line to the list of process templates on
the Job or User tab. The separator appears below the selected
process template. If no process template is selected, the
separator appears at the bottom of the list of process
templates.
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Remove

Select a process template or a separator on the Job or User tab
and click Remove to remove the process template or separator
from the tab.

Tip: You can also double-click a process template or separator to remove
it.

Job Favorites

Lists the process templates that are listed on the Job tab of the
Process Templates pane whenever you open the job.

To add a process template to the Job tab select the process
template in the list on the left of the dialog box and click Add.
Or, double-click the process template to add it to the Job tab
automatically.

User Favorites

Lists the process templates that are listed on the User tab of the
Process Templates pane whenever you log in to Prinergy
Workshop with the same user name and password.

To add a process template to the User tab select the process
template in the list on the left of the dialog box and click Add.
Or, double-click the process template to add it to the User tab
automatically.

Move Up

Select a process template or separator on the Job or User tab
and click Move Up to move the selection up the list.

The process templates and separators appear on the Job and
User tabs of the Process Templates pane in the order that you
set in the Manage Job/User Favorites dialog box.

Move Down

Select a process template or separator on the Job or User tab
and click Move Down to move the selection down the list.

The process templates and separators appear on the Job and
User tabs of the Process Templates pane in the order that you
set in the Manage Job/User Favorites dialog box.
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Workshop menu in Job Manager
Note: This menu is available only when running Prinergy Workshop on a
Macintosh client.

About Prinergy Workshop

Displays information about Prinergy Workshop, including the
version number, a list of licensed features, and the server name.

Preferences

Use to view and modify Prinergy Workshop preferences. When
you select this menu item, the Workshop Preferences dialog
box appears.

Note: On a Windows client, this menu item appears under the Edit menu.
On a Macintosh client, it appears under the Workshop menu.

Quit / Quit Prinergy Workshop

Quits Prinergy Workshop. Any open Prinergy Workshop
windows are closed.

File menu in Job Manager
Note: Some menu items are available only in specific views or when specific
elements are selected.

New

Use to create a new job. When you select this menu item, the
Create New Job dialog box appears.

Open

Use to open an existing job. When you select this menu item,
the Open Job dialog box appears.

Import Job (Incremental)

Displays the Import Job dialog box which lets you import a
previously exported partial job into a job or a pre-job.

Export Job (Incremental)

Select signatures and then use this menu item to export them
as a partial job.

Export Job

Displays the Choose Process Template dialog box, which lets
you select a process template and export the job that is open in
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Job Manager. The system places the exported file in the
location specified by the process template you selected while
exporting the job.

Close Window

Closes the current window, but does not quit Prinergy
Workshop.

Add Input Files

Use to add non-CT/LW input files to the job. When you select
this menu item, the Add Input Files dialog box appears.

Add Page Set

Select this menu item to create a page set for the job. When
you select this menu item, the Add Page Set dialog box appears.

Import Imposition

Use this menu item to import an imposition plan into the job.

Import Versioning Imposition

Use this to import an imposition plan with versioning and add it
to your job.

Create New Imposition

Displays the New Imposition dialog box where you select an
imposition application to launch from within Prinergy to create
a new imposition.

This menu item is available only if you have configured
imposition software to work with Prinergy Workshop.

Remove/Delete

Use to remove or delete the selected elements. When you
select this menu item, you may be prompted to confirm that
you want to remove or delete the selected elements (if the
Show Confirmation Dialogs for All Deletes option is enabled in
the Prinergy Workshop Preferences dialog box).

The Remove/Delete menu item varies depending on the type of
elements selected:

● Remove File-Removes the selected files from the Storage
view

● Remove Input-Removes the selected input files from the
Input Files pane

● Remove Imposition-Removes the selected imposition plans
from the Signature and Separations views
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● Delete Page-Deletes the selected pages from the Pages
pane

● Delete Page Set-Deletes the selected page sets from the
Page Sets pane of Job Manager

● Delete Process-Deletes the selected processes from the
Completed tab of the Processes pane

Destroy Imposition

Use to permanently delete the selected imposition plan and its
associated input files, pages, and page sets from the system.

Important: Once you destroy it, you cannot retrieve it or its associated
files. If you want to retain the associated files, use the Remove
Imposition menu item instead.

Open File With

Enables you to open files in another application without leaving
Prinergy Workshop. You can open input files, processed pages,
and assigned pages.

In Job Manager select the file and choose an item from the
Open File With sub-menu:

● (default application) to open the file with the same
application your operating system uses when you double-
click this type of file in Windows Explorer or Macintosh
Finder.

● <Application> to open the file using the selected application.
To add an application to the list select Edit List and
configure the Configure Applications dialog box.

● Edit List to edit the sub-menu list. In the Configure
Applications dialog box, browse to any application on your
computer. Select the executable file (.exe) and click OK. The
selected application will subsequently appear in the Open
File With sub-menu list.

Open Job Folder in File Browser

Launches Microsoft Internet Explorer or Macintosh Finder and
displays the job folder.

Publish to PDF File

Select a page, and then select this menu item to create a low-
resolution or high-resolution PDF file of the page.
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Open VPS Files

Select a page, surface, signature, or separation that you want to
view (anywhere that a VPS file has been created) and select the
Open VPS Files menu item to display the VPS file.

Get Info

Use to display details about the selected elements. When you
select this menu item, the Get Info dialog box appears.

Edit menu in Job Manager
Note: Some menu items are available only in specific views or when specific
elements are selected.

Cut, Copy, and Paste (not available)

Select All

Select an element in a Job Manager pane and then use the
Select All to select all of the elements in the pane.

For example select an input file in the Input Files pane, and then
use Select All Files to select all of the input files in the pane.

The name of Select All changes depending on the elements
with which you are working.

Keep Even Pages Selected

After selecting multiple page positions, use this menu item to
keep only the even-numbered positions selected. This applies to
the Page Sets pane of the Pages view and the Imposition Plans
pane of the Signatures view.

Keep Odd Pages Selected

After selecting multiple page positions, use this menu item to
keep only the odd-numbered positions selected. This applies to
the Page Sets pane of Pages view and the Imposition Plans pane
of Signatures view.

Assign Page to Position

Use to assign the selected pages to positions in a page set.
When you select this menu item, the Assign Page to Page Set
Position dialog box appears.

Edit Imposition

Select an imposition and then click this menu item to launch
imposition software and edit the imposition.
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This menu item is available only if you have configured
imposition software to work with Prinergy Workshop.

Unassign

Use to unassign the selected pages from their page positions in
a page set or imposition plan.

Reorder Page Assignments

In the Pages or Signatures view, select a layered page
assignment, then use this menu item to display the Reorder
Page Assignments dialog box. Use this dialog box to change the
order of the layered pages for the page assignment.

This menu item applies only when you are working with a
versioned imposition plan.

Copy Page Assignments

In the Pages view, use this menu item to copy page positions
with assigned pages from one page set to another.

Set Page Geometry

In the Pages or Signatures view, select a page or page set, then
use this menu item to display the Set Page Geometry dialog
box.

Customer Approval

Use to manually set the approval status for a selected page.
Available approval statuses are:

● Approval not Required
● Approval Requested
● Approval in Progress
● Waiting for Correction
● Approve
● Reject

When you select the approval status, a dialog box appears
where you can type a comment about the approval change.

Approval is not required before further processing; it simply
helps you to monitor your job's progress.

Edit Job Attributes / Edit Pre-Job Attributes

Use to view and modify the attributes of the selected job or pre-
job. When this menu item is selected, the Edit Job Attributes
dialog box appears.
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Set Initial Separations

Select one or more surfaces or an entire signature, and then use
this menu item to reset the separations in the selection to the
page colors defined in the pages assigned to the page set.

Use this command after you import an imposition plan into a
job with an existing page set or after you create color mappings
you no longer want.

Color Separations

Select a signature, then use this menu item to display the Color
Separations dialog box where you set up color mapping for the
selected signature.

Color Printing Order

Select a signature, then use this menu item to display the Print
Order dialog box where you specify the order in which you want
the color separations to be printed, for example, CMYK or
KCMY.

Set Web Growth Profile

Select a signature, sheet, or surface, then use this menu item to
display the Set Web Growth Profile dialog box, where you
select a web growth profile for the press on which the signature,
sheet, or surface will run.

Clear Web Growth Profile

Select a signature, surface, or sheet, and then use this menu
item to disassociate a web growth profile file from the
signature, surface, or sheet.

When you clear or set a web growth profile to an entity, it
includes the levels below. For example, setting a web growth
profile to a signature will include all sheets and surfaces below.
Clearing a web growth profile from a sheet will include all
surfaces below.

Center Page

In the Imposition Plans pane of the Signatures view, select one
or more pages. Then select this menu item to center the media
or trim box of the selected pages to the center of the imposition
trim box.

Use Page Offsets

In the Imposition Plans pane of the Signatures view, select one
or more pages, then select this menu item to return previously
centered pages to their original page offsets.
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Preferences

Use to view and modify Prinergy Workshop preferences. When
you select this menu item, the Workshop Preferences dialog
box appears.

Note: On a Windows client, this menu item appears under the Edit menu.
On a Macintosh client, it appears under the Workshop menu.

View menu in Job Manager
Note: Some menu items are available only in specific Job Manager views or when
specific elements are selected.

Refresh

Updates the contents of the current window.

as Thumbnails

Displays the contents of pane as thumbnails, which are low-
resolution sample images.

as List

Displays the contents pane in a list. In this case, each item is
represented by a line of descriptive text.

Expand All

Expands all items in the selected view or pane.

Collapse All

Collapses all items in the selected view or pane.

Pages

Displays the Pages view of Job Manager.

Signatures

Displays the Signatures view of Job Manager.

Separations

Displays the Separations view of Job Manager.

Storage

Displays the Storage view of Job Manager.

History

Displays the History view of Job Manager.
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Visible Columns

Use to display and hide columns in the current window or pane.
When you select this menu item, the Visible Columns dialog
box appears. From there, you select the columns that you want
to display, and clear the columns that you want to hide.

The columns that can be displayed vary from window to
window.

Job menu in Job Manager
Note: Some menu items are available only in specific views or when specific
elements are selected.

Destroy

Use to destroy the open job. When you select this menu item,
the Destroy Job dialog box appears.

Important: When you destroy a job, Prinergy permanently removes the
files and all information about the files from the system. Only destroy a
job when you are sure that you will never need it again.

Notes

Use to create notes for the job, or to edit or delete existing job
notes. When you select this menu item, the Job Notes dialog
box appears.

Manage Job/User Favorites

Use to add process templates to and remove process templates
from the Job and User tabs of the Process Templates pane.
When you select this menu item, the Manage Job/User
Favorites dialog box appears.

Manage Hot Folders

Use to create hot folders for the job, or to edit or delete existing
hot folders. When you select this menu item, the Manage Hot
Folders dialog box appears.

Image Search Path

Use to add or delete an image search path for the job. When
you select this menu item, the Image Search Paths dialog box
appears.

Font Search Path

Use to add or delete an font search path for the job. When you
select this menu item, the Font Search Paths dialog box
appears.
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Change Signature ID Code Template

Use to edit the signature ID code settings for the job. When you
select this menu item, the Signature ID Code Editor dialog box
appears.

Identify Common Separations

Select a signature, then click this to identify which separations
from the signature are common to all signatures as opposed to
which separations are versions.

Preflight Report Viewer

Displays the PDF Preflight report for the selected PDF.

Submit for Digital Printing

Select one or more pages or signatures, then select this menu
item. In the Submit to Digital Printing dialog box, you then
select a digital print application.

Use Submit for Digital Printing when you want to control and
print digital output using a digital print application such as XDS
Plus for Xerox FreeFlow Print Submission.

See also:
Editing signature ID codes on page 714

Process menu in Job Manager
Note: Some menu items are available only in specific Job Manager views or when
specific elements are selected.

<process category> > <process type> > <process group> >
<process template>

The name of each process template that applies to selected
elements is available on the Process menu.

Click this item to start process on the selected elements using
this process template.

Workflow > <workflow type> > <workflow group> > <workflow
template>

Each workflow template that applies to selected elements is
available on the Process menu.

Click this item to start process on the selected elements using
this workflow template.
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Manual Start Rules > <rules context> > <rules group> > <rule set>

Expands to display the rule sets that:

● Apply to the currently selected elements
● Are triggered by Manual Trigger events
● Are enabled

The first submenus under Manual Start Rules are:

● All Jobs: Select this to see system rule sets.
● Job <job name>: Select this to see the job rule sets enabled

for the job that you are in.

After you select the first submenu, navigate through the rule set
groups and select the rule set that you want to trigger.

Process Tools

Use this menu item to access further menu items specific to the
selected element. The menu item varies depending on the type
of element selected in Job Manager:

If you select The menu is And the menu contains

Process template or
workflow template in the
Process Templates pane

Process Template
Tools

Edit, Rename, and Delete

Process template group in
the Process Templates pane

Process Template
Group Tools

New or New Process Template (to create a new
process template of the same type as the
selected process template group).

Rule set in the Process
Templates pane

Process Template
Tools

View Rule Set, Get Info, Disable, Open Copy,
Rule Set Manager, and Stop All Processing

Active process in the
Processes pane

Processing Tools Pause, Resume, Stop and Create Process
Report

Completed process in the
Processes pane

Processing Tools Create Process Report (to create a detailed
report on the selected process to send to your
service representative).

Approve

After generating a proof select the proofed item and then select
this menu item to set the proof's Approval Status to Approved.

This displays an approved icon  in the dynamic column that
appeared after the proofing process.

Unlike Customer Approval status, proof approvals are not
visible in Prepress Portal.

Proof approvals do not affect other processing that you can do
in Prinergy Workshop.
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Reject

After generating a proof select the proofed item and then select
this menu item to set the proof's Approval Status to Rejected.

This displays a rejected icon  in the dynamic column that
appeared after the proofing process.

Unlike Customer Approval status, proof approvals are not
visible in Prepress Portal.

Proof approvals do not affect other processing that you can do
in Prinergy Workshop.

Clear

If a proof's approval status has been set to Approved or
Rejected, select the proofed item and then select this menu
item to clear the approval status.

This causes the approved icon  or rejected icon  to no longer
appear in the dynamic column for the proofing process.

Unlike Customer Approval status, proof approvals are not
visible in Prepress Portal.

Proof approvals do not affect other processing that you can do
in Prinergy Workshop.

Tools menu in Job Manager

Change User

Displays the Connect to Server dialog box where you can log in
as another user without quitting Prinergy Workshop.

This menu item appears only if you have Kodak Prinergy
Business Link software connected to the Prinergy system.

Job Finder

Opens Job Finder.

If you are already in Job Finder, this menu item is unavailable.

Destroy History Entries

In the History view, select one or more history entries and then
use Destroy History Entries to delete the selected entries.

Process Template Editor

Launches Process Template Editor, where you can create and
modify process templates.
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Automated Page Assignment Editor

Starts the Automated Page Assignment Editor, which you use
to create and check APA files.

Queue Manager

Launches Queue Manager, where you can view the Job Ticket
Processors (JTPs) and process types.

Media Manager

Launches Media Manager, where you can manage your archive
tapes and disk volumes.

System History

Launches System History, which displays the detailed history of
all the activity occurring outside of job context (such as jobs
and groups that were created or destroyed), as well as job
archive, purge, and retrieve history.

Smart Hot Folder Manager

Launches the Smart Hot Folder Manager dialog box, where you
can add, edit and delete smart hot folders.

Configure Imposition Application

Displays the Configure Imposition Applications dialog box,
where you can identify the location of imposition software that
you want to integrate with Prinergy Workshop.

Start Imposition Application

Displays the Start Imposition Application dialog box, where you
choose which imposition software to start. You create this list
of imposition applications with the Configure Imposition
Application tool from the Tools menu. If an application requires
a license and is licensed, it appears in bold.

Color Editor

Launches Color Editor, where you can create color recipes for
all jobs.

Color Space Editor

Launches Color Space Editor, where you can create and edit
color spaces.
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Font Converter

Launches Font Converter, where you can convert font files into
PFA (Printer Font ASCII) format, which Prinergy requires to
correctly process fonts.

Preflight Profile Manager

Launches Preflight Profile Manager, where you can, during the
refine process, evaluate PDFs to detect problems that may
affect processing in a publishing or prepress workflow.

Plate Remake

Opens the Plate Remake dialog box, where you can enter the
identification number of a plate to quickly remake the plate
using the same process template settings and output device
that were used to make the original plate. For more information,
see Remaking plates on page 626.

Digital Print Administration Console

Launches the Digital Print Administrator, where you can add
and configure a digital print application that Prinergy can launch
to print PDFs.

Rule Set Manager

Opens the Rule Set Manager, where you can create and edit
rule sets. The Rule Set Manager also lets you organize rule sets
into groups.

Activate Rule Set in Selected Jobs

Opens the Select Rule Set dialog box, where you can activate
rule sets for one or more jobs.

Help menu in Job Manager

Online help

Starts your Web browser and displays the Prinergy online help.

On <current window or view>

Starts your Web browser and displays the Prinergy Workshop
user guide, open to the topic for the currently selected window
or view.

Quick Start Guide

Starts Adobe Acrobat and displays a PDF file of the Prinergy
Connect Quick Start Guide
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eCentral Online Support

Starts your Web browser and displays the eCentral portal at 
https://ecentral.kodak.com/.

Visit graphics.kodak.com

Starts your Web browser and displays the Kodak Web site at 
http://graphics.kodak.com/default.htm.

About Prinergy Workshop

Displays information about Prinergy Workshop, including the
version number, a list of licensed features, and the Prinergy
server name.

Note: This menu item appears on the Help menu only when you are
running Prinergy Workshop on a Windows-based client computer. On a
Macintosh client computer, the menu item About Workshop appears on
the Workshop menu.

Keyboard shortcuts in Job Manager

Macintosh
Keyboard
Shortcut

Windows
Keyboard
Shortcut

Description

 + Delete Ctrl + Delete Deletes or removes the selected element

 + A Ctrl + A Selects all elements in the selected window or pane

 + D Ctrl + D Displays the Color Separations dialog box

 + E Ctrl + E Displays the Choose Process Template dialog box

 + F Ctrl + F Displays the Font Search Paths dialog box

 + G Ctrl + G Displays the Image Search Paths dialog box

 + I Ctrl + I Displays the Get Info dialog box for the selected element

 + K Ctrl + K Displays the Add Page Set dialog box

 + L Ctrl + L Displays the Import Imposition dialog box

 + M Ctrl + M Lets you set Page Geometry

 + N Ctrl + N Displays the Create New Job dialog box

 + O Ctrl + O Displays the Open Job dialog box

 + Q Ctrl + Q Quits Prinergy Workshop

 + R Ctrl + R Refreshes the current window

 + T Ctrl + T Displays the Add Input Files dialog box

 + W Ctrl + W Closes Job Manager

 + Y Ctrl + Y Displays the Assign Page to Page Set Position dialog box
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Macintosh
Keyboard
Shortcut

Windows
Keyboard
Shortcut

Description

 + 1 Ctrl + 1 Displays the Pages view of Job Manager

 + 2 Ctrl +2 Displays the Signaturesview of Job Manager

 + 3 Ctrl + 3 Displays the Separations view of Job Manager

 + 4 Ctrl + 4 Displays the Storage view of Job Manager

 + 5 Ctrl + 5 Displays the History view of Job Manager

 + Shift + V Ctrl + Shift + V Opens VPS

See also:
Pages view on page 33
Signatures view on page 39
Separations view on page 46
Storage view on page 48
History view on page 51
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5 Workflow

A typical workflow
Your workflow can follow this typical workflow.

1. Create a job.

When you create a job in Prinergy, you set up a virtual directory
structure (electronic filing system). You organize jobs in groups.

2. Add input files.

You add input files to a job to tell Prinergy which files to work with
and where they are located.

3. Refine input files.

You refine input files by selecting an input file and then applying a
refine process template to it. The refine process creates a stable,
PDF digital master of each page in the input file. The refine process
can perform any or all of the following functions:

● Preflight files
● Optimize images
● Convert CT/LW or TIFF/IT
● Resolve OPI comments
● Embed fonts
● Recombine separated files
● Check for low-resolution images and missing fonts
● Fine-tune copydot content
● Manage colors to achieve consistency between the color

proofing device and the press
● Trap files
● Generate thumbnails
● Impose pages

These options are controlled by the settings in the refine process
template.

4. Manage page sets and impositions.

PDF pages are assigned to page positions on one or more page sets.
You can create page sets before making imposition decisions or
have page sets automatically created when you add imposition
plans to a job.



In Prinergy Workshop, you can view and edit the PDF pages with
Acrobat, and make last-minute layout changes using the integrated
imposition software.

5. Output proofs.
You can output both individual PDF pages and imposition plans to
proofing devices or to various soft-proof file formats (Virtual
Proofing System or TIFF files). Proofing is governed by parameters
set in the selected output process template.

6. Output plates or film.
Select the whole imposition, individual signatures, surfaces, or
separations to send for final output. Parameters are set in the
selected output process template.

7. Archive.

Whole jobs or individual files can be archived, including
miscellaneous files that are placed in the job folder. Once a job is
archived, you can purge the entire job or some of its files from the
hard disk, freeing up disk space for other uses. An archived job can
be retrieved as a whole job or as individual files. Archiving is
controlled through parameters set in the selected archive process
template.

Destroying a job deletes all traces of it from the system, leaving no
possibility for retrieval. Destroying is different than purging a job
because purged jobs can be retrieved from an archive.

Diagram: workflow

Workflows in Prinergy Direct
Prinergy Direct software has two main workflows: one using imposed
flats and one using a hub-and-spoke setup with other Prinergy
systems.
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To create jobs in Prinergy Direct, you can start with imposed flats or
exported jobs.

Imposed flats

Prinergy Direct can accept imposed flats from other software such as
Preps, Kodak Pandora, or Adobe InDesign.

To accept the files, you must set up a job with an add-and-process hot
folder linked to a refine process template. When you drop the flats into
the hot folder, Prinergy Direct refines the files into PDF flats.

Hub-and-spoke

You can use Prinergy Direct in a hub-and-spoke setup where the hub is
a Prinergy Connect or Prinergy Powerpack system and the spoke is
Prinergy Direct.

How you accept the export depends on whether the other Prinergy
system exports an entire job or a partial job:

● To accept an entire job, you set up a pre-job with an add-and-
process hot folder linked to an ImportAll process template. When
you drop the export into the hot folder, Prinergy Direct creates a
new job.

● To accept a partial job, you take an existing job and set up an add-
and-process hot folder linked to an ImportIncremental process
template. When you drop the export into the hot folder, Prinergy
Direct adds the imported files to the job.

Hub-and-spoke workflow with partial jobs
Your workflow can follow a hub-and-spoke setup where you export a
partial job from one Prinergy system and import it into another
Prinergy system.

Prerequisite: The .zip file was exported from Prinergy using an
ExportIncremental process template. (If you have a complete job, see
Hub-and-Spoke Workflow with Jobs instead.)

1. Create a job or open an existing job.

2. Add a hot folder and associate it with an ImportIncremental
process template.

3. Drop the export file into the hot folder.

Prinergy adds the export to the existing job. If the imported
signature name matches an existing signature name, Prinergy adds
01 to the imported signature.
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4. Open the job.

Prinergy displays flats as signatures in Separations view.

5. Manage colors separations (optional).

6. Proof the imposition by running an imposition output process
template.

7. Make plates by running a final output process template.

See also:
Hub-and-spoke workflow with jobs on page 78
Creating jobs and pre-jobs on page 85
Opening jobs and pre-jobs on page 99
Generating imposition outputs on page 489
Generating final output on page 543
Color Separations dialog box on page 801
Import process template (jobs) on page 870
Adding files to a hot folder on page 907
Creating hot folders on page 908

Hub-and-spoke workflow with jobs
Your workflow can follow a hub-and-spoke setup where you export an
entire job from one Prinergy system and import it into another Prinergy
system.

Prerequisite: The .zip file was exported from Prinergy using an
ExportAll process template. (If you have a partial job, see Hub-and-
Spoke Workflow with Partial Jobs instead.)

1. Create a pre-job.

2. Add a hot folder and associate it with an ImportAll process
template.

3. Drop the export file into the hot folder.

Prinergy creates a new job named after the .zip filename.

4. Open the job.

Prinergy displays flats as signatures in Separations view.

5. Manage colors separations (optional).

6. Proof the imposition by running an imposition output process
template.

78 Chapter 5—Workflow



7. Make plates by running a final output process template.

See also:
Hub-and-spoke workflow with partial jobs on page 77
Creating jobs and pre-jobs on page 85
Opening jobs and pre-jobs on page 99
Generating imposition outputs on page 489
Generating final output on page 543
Color Separations dialog box on page 801
Import process template (jobs) on page 870
Adding files to a hot folder on page 907
Creating hot folders on page 908

Flat-based workflow
Your workflow can start with an imposed flat (PS, PDF, EPS) created in
Preps, Pandora, InDesign, or other software.

Note: The flat-based workflow fails if the AutoFlatRefining and AutoFlatOutput
process templates have been deleted from the Prinergy system.

1. Create a job.

2. Add a hot folder and associate it with a refine process template.

3. In the refine process template, ensure Treat Input Files as Flat is
selected in the Impose section.

4. Drop the file into the hot folder.

Prinergy refines the files into PDF flats and then displays flats as
signatures in Separations view.

5. Manage colors separations (optional).

6. Proof the imposition by running an imposition output process
template.

7. Make plates by running a final output process template.

See also:
Creating jobs and pre-jobs on page 85
Refine process template on page 201
Generating imposition outputs on page 489
Generating final output on page 543
Color Separations dialog box on page 801
Adding files to a hot folder on page 907
Creating hot folders on page 908
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Page creator workflow
If you prepare files but do not make film or plates at your site,
coordinate workflow details with your printer.

Handing files to the printer site

In order that your workflow outputs files as intended, it is important to
do the following:

● Coordinate with your printer site to perform tests with reasonably
complex sample files.

● Communicate with your printer site that when they input the
Prinergy pages, they should not perform additional processing on
the pages. Otherwise, another proof cycle may be required.

Accordingly, if the printer site uses Prinergy, they should refine with
as few settings as possible (Refine-no options, Optimize-no
options), to ensure they don't inadvertently change the file from the
publisher's intention. (For example, refining with Set Black to
Overprint or Set Colors to Knockout selected in the ColorConvert
section of the refine process template can change the appearance
of traps.)

As a 'page creator,' you refine and deliver files (usually pages; not flats)
to a printer, who has specific output requirements based on his
operation.

See also:
About supported output formats on page 620
Creating PDF/X output on page 754
Creating PDF 1.3 output from complex transparency files on page 759
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6 Jobs

Creating jobs

Job creation
A job is a publication that you want to print. To work on a publication,
you must create a job for it in Job Finder.

When you create a job, you must choose the server and volume where
it will be stored. Once a job is created, you cannot move it to any other
volume. To move a job or pre-job to another volume or server, you must
export or copy it.

You can create jobs and pre-jobs inside or outside of a group. To create
them inside a group, create the group first, or create the group when
you create the jobs or pre-jobs.

Once you create a job or pre-job:

● A Job Manager window appears for the job.
● Database entries are created for tracking the job.
● A new folder is created specifically for the job.

Options

When you create a new job or pre-job, the following options are
available:

● Template Job

You can copy settings from a job that you have set up as a template
job. Settings in the template job, such as hot folders and image
search paths, are copied to the new job.

● Job Attributes

You can set the job attributes when you create a job—for example,
due dates and job codes. You also set the job attributes to enable
ColorFlow for the job and to select a default color setup for the job.

● Import Job



You can import a previously exported Prinergy job. You can choose
the import process template with which to import the job.

See also:
Pre-jobs on page 82
Job, group, and file naming requirements and best practices
on page 83
Template jobs on page 83
Job folders on page 84
About copying jobs on page 112
Using ColorFlow software on page 831

Pre-jobs

A pre-job is similar to a job but is used when you want to store
elements that are used in more than one job.

Pre-jobs are useful in these ways:

● To automatically create jobs by dropping exported jobs into pre-job
hot folders

You create a pre-job with hot folder that is linked to an import
process template. When you drop exported jobs (with a .zip
extension) into the hot folder for the pre-job, Prinergy automatically
creates a job. The job is at the root of the server on which the pre-
job exists, and has the same name as the exported job.

● As a place to collect elements that are used in many jobs, such as
logos

When you want to use these elements in a job, you point the image
paths from the job to the pre-job folders where the items are stored.

For example, if you produce a magazine for the same customer
every month, you may want to reuse an image search path. To do
this, create the pre-job, and then set the image search path to a
folder containing the customer's logo and other frequently used
images. Then when you create a new job for the customer, copy the
image search path from the pre-job. The new job can then access
the same images.

● By customers using Prepress Portal to upload files

For more information see your Prepress Portal documentation.

We suggest that you create a pre-job on each of your job servers, so
you can make use of the pre-job feature on each of your servers.
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Job, group, and file naming requirements and best practices

The name of a job or pre-job must:

● Be 31 characters or less.
● Be unique:

A job and pre-job cannot have the same name.

Two jobs cannot have the same name, even if they are in different
groups.

● Not include the following special characters: / : ' \ " ? * <
> |.

● Not include Windows-reserved device names for the name of a file,
such as CON, PRN, AUX, NUL, COM1, COM2, COM3,
COM4, COM5, COM6, COM7, COM8, COM9, LPT1, LPT2,
LPT3, LPT4, LPT5, LPT6, LPT7, LPT8, and LPT9.

Note: Prinergy will not show an error if you use these device names.

The name of a group must:

● Be 31 characters or less.
● Be unique.
● Not include the following special characters: / : ' \ " ? * <

> |.

Note: While Prinergy will not show an error if you create group names with
these characters, you will not be able to archive jobs to disk from such groups.

The name of files used in Prinergy (input files, impositions) should:

● Not include the following special characters: / : ' \ " ? * <
> |.

Not include Windows-reserved device names for the name of a file,
such as CON, PRN, AUX, NUL, COM1, COM2, COM3,
COM4, COM5, COM6, COM7, COM8, COM9, LPT1, LPT2,
LPT3, LPT4, LPT5, LPT6, LPT7, LPT8, and LPT9.

● Not include characters that could interfere with the operation of
APA, such as # $ , .. + - * %

Template jobs

A template job is a job that contains settings that you want to reuse in
other jobs. Any existing job or pre-job can act as a template job.

For example you may expect to create the same hot folders to add
input files or import imposition plans to each of your jobs. Rather than
re-creating the same hot folders each time you create a new job, you
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can set up hot folders for one job and use it as a template for other
jobs. This job becomes the template job.

When you create future jobs, you use the Template Job option and
select the template job. The job folder of the new job automatically
contains the copied hot folders.

The purpose of template jobs is to reduce repetitive tasks and save you
time. You set up a template job once, then base multiple new jobs on it.

When creating a new job based on a template job, you can select
which parts of the template job to include—for example, image search
paths, job favories, and active rule sets.

See also:
Select Template Job dialog box on page 88

Job folders

When you create a new job, Prinergy creates a new folder on the
volume that you selected when creating the job.

The new folder—called a job folder—has the same name that you gave
the job. For example, if you created a job called Magazine on Server1,
volume J_Drive, the new job folder would be \Server1\J_Drive
\JOBS\Magazine.

The job folder is where you:

● Access hot folders that you create for the job.
● Access custom folders—called user defined folders—for storing

input files and images. The user defined folders are set up in
Prinergy Administrator. For example, you may set up a Source
folder for a job's source files.

● Locate .VPS files to proof
● Download and upload files to and from customers with Prepress

Portal

Note: The job button ( ) in Job Manager enables easy access to the job folder.
Right-click the job button and select Open Job Folder in File Browser.

Subfolders in the job folder

All job folders contain these subfolders:

● Control: Files that control job processing, such as job template
files and APA files

● Digital Print: Files waiting for the digital print queue. Files are
deleted when they enter the digital print queue or when the digital
print application closes.

● Fonts: Font files converted using Per-Job Font Converter
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● HotFolders: Any hot folders that you create for the job

○ Processed: Files resulting from hot folder processing.

● System: Files generated from—or required for— refining,
preflighting, and importing impositions.

● UserDefinedFolders: Any job-related files that you place here,
folders that you create, or custom folders that you set up in Prinergy
Administrator.

● WebDownLoads, WebUploads, and WebAnnotatedProofs:
Files being exchanged with customers using Prepress Portal.

You can view job folders in a file browser, but do not change the file
structure of the System folder and its subfolders, or you may lose
data. If you view the System folder, note that some files in it are
visible from a Windows-based computer but not from a Macintosh
computer.

Creating jobs and pre-jobs

1. In Job Finder, select Jobs to create a job or select Pre-Jobs to create
a pre-job.

2. Select File > New Job or File > New Pre-Job.
The Create New Job dialog box or Create New Pre-Job dialog box
appears.

3. Perform one of the following actions:

○ Use the lists to select the group in which you want to create the
job or pre-job, and click Open.

○ Click New Group to create a new group. In the Create New
Group box, type a name for the new group, following the naming
requirements, and click Create.

4. If your system has more than one server, in the Job Home Server
box, select the server on which you want to create the job or pre-
job.

5. If your system has servers that share volumes, in the Job Volume
box, select the volume on which you want to create the job or pre-
job.

6. In the Name box, type a name for the job or pre-job, following the
naming requirements.

7. If you want to use the advanced job-creation features, click 
beside Options and set the options as follows:

● To base the new job on a template job, select the Template Job
check box. In the Select Template Job dialog box, use the lists to
locate and select the template job on which you want to base

Creating jobs and pre-jobs 85



the new job. Select the options that you want to copy from the
template job, and click OK.

● To set job attributes for the new job—such as number of layers,
due date, or default color setup—select the Job Attributes check
box. In the Set Job Attributes dialog box, set the attributes that
you want, and click OK.

● To import an exported job, select the Import Job check box. In
the Import Job dialog box, select the exported job that you want
to import, and click OK.

8. Click Create.

The job or pre-job appears in a new Job Manager window.

Create New Job / Pre-Job dialog box

This dialog box has two different names. The name is Create New Job
when you are creating a job and Create New Pre-Job when you are
creating a pre-job.

The dialog box displays the settings that were entered when the last
job was created.

lists

The drop-down and the list work together to navigate groups.

When the drop-down displays:

● Groups on <server name>, the list displays the groups on
the specified server

● A group name, the list displays the contents of the specified
group, including jobs and groups

When you click the drop-down, you see the path of the
displayed item in reverse order. For example, if the drop-down
displays a subgroup, when you click the drop-down, you see the
name of the group that the subgroup is in, followed by Groups
on <server name>.

Open

Opens the selected item.

New Group

Click this button to display the Create New Group dialog box,
which you use to create a new group (rather than selecting an
existing group) in which to create the new job or pre-job.
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Home

Server

Lists the servers on which you can create jobs and pre-jobs. The
Server list is available only if you have more than one server.

Volume

Lists the volumes on the server that you selected in the Server
list. The Volume list is available only if your system has more
than one shared volume.

Create new Job/Pre-Job as

Type a name for the new job or pre-job. The name must:

● Be 31 characters or less
● Be unique, even if other jobs or pre-jobs are created in

different groups
● Not be the same as the group name-to avoid confusion
● Not include the following special characters: \ / : ' \ " ? * < >

|
● Not start or end with a space character or end with a .

(period)

Options

Click  beside Options to display more options for creating a job or
pre-job.

Template Job

Select this check box to display the Select Template Job dialog
box, which you use to base your new job or pre-job on a
template job.

Job Attributes

Select this check box to display the Set Job Attributes dialog
box, which you use to set the job attributes for the new job or
pre-job.

Import Job

Select this check box to display the Import Job dialog box,
where you can base your new job or pre-job on a previously
exported job.
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Select Template Job dialog box

lists

The drop-down and the list work together to navigate groups.

When the drop-down displays:

● Groups on <server name>, the list displays the groups on
the specified server

● A group name, the list displays the contents of the specified
group, including jobs and groups

When you click the drop-down, you see the path of the
displayed item in reverse order. For example, if the drop-down
displays a subgroup, when you click the drop-down, you see the
name of the group that the subgroup is in, followed by Groups
on <server name>.

Hot Folders

Select this check box to copy the hot folders from the template
job to the new job.

Image Search Paths

Select this check box to copy the image search paths from the
template job to the new job.

Note: A search path to a folder within a job folder is a relative search
path. A path to a folder outside of a job folder—for example, a path to an
image library—is an absolute search path. When a job is set up to use a
template job's search paths, relative search paths become references to
folders within the new job but absolute search paths continue to
reference the same folders that were referenced in the template job.

Font Search Paths

Select this check box to copy the font search paths from the
template job to the new job.

Note: A search path to a folder within a job folder is a relative search
path. A path to a folder outside of a job folder—for example, a path to an
image library—is an absolute search path. When a job is set up to use a
template job's search paths, relative search paths become references to
folders within the new job but absolute search paths continue to
reference the same folders that were referenced in the template job.

Job Favorites

Select this check box to copy the Job Favorites from the
template job to the new job.
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Automated Page Assignment

Select this check box to copy the Automated Page Assignment
(APA) file from the template job to the new job.

Information from the APA file with the latest date and time in
the template job is added to the Job.apa file in the <job
folder>\Control folder for the new job. If you use both the
Import Job option (with an APA file) and the Template Job
option (including the APA file), the APA file from the imported
job overwrites the APA file from the template job.

Active Rule Sets

Select this check box to copy the active rule sets from the
template job to the new job.

Layered PDF Versioning (LPV) Version Plan

Select this check box to copy the version plan from the template
LPV job to the new job. For more information, see the Prinergy
Layered PDF Versioning User Guide.

Imposition Plans

Select this check box to copy the imposition plans from the
template job to the new job. This automates imposition
selection and reduces repetitive tasks when you create new
jobs.

RIP To Use

Select this check box to have the new job use the same RIP as
the template job. The RIP will be either the Adobe PDF Print
Engine (APPE) RIP or the Adobe CPSI RIP, depending on which
RIP was selected in the template job's attributes.

Color Setup

Select this check box to have the new job use the same
ColorFlow color setup as the template job.

Job attributes

Job status

Job status is an attribute that you can set for a job or pre-job. Job
status options are:

● Created: The default status of any job created in Prepress Portal.
● In Prepress: Indicates a job or pre-job is active. Files dropped into

the hot folder of the job or pre-job are processed. Also, the job or
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pre-job is included in Prinergy reports. This is the default status of
all new jobs and pre-jobs.

● Ready for Final Output, Completed Final Output, On Press, and
Shipped: Indicates progress of a job or pre-job. These statuses must
be set manually.

● Completed: Indicates a job or pre-job is inactive. Files dropped into
the hot folder of the job or pre-job are not processed. Also, the job
or pre-job is not included in Prinergy reports. This is the default
status of any job that is purged using the purge process template. It
is also the default status of any retrieved job.

Job attributes
Though most job information is generated automatically, you can set
some optional job attributes to help you track a job's due dates and
status. You also set job attributes to enable ColorFlow for the job and
to select a default color setup for the job. You can set job attributes
when you create a job, or later in Job Finder or Job Manager.

Job attributes include:

● Whether the job is enabled for ColorFlow, and if so, the job's default
color setup

● The RIP to use for the job
● Regional versioning. If you are using legacy versioning, it is the

maximum number of pages that you can assign to a page position.
Regional versioning is also called layers for versioning.

● Due date and times for the proof and the final output
● Job code
● Job status
● Whether to enable the job for Web access by a specific print buyer

through Prepress Portal

Job attributes are optional; you do not have to set them to successfully
run a job.

You can set and view job attributes in the Job Attributes dialog box and
view job attributes in the Job Finder columns.

Setting job status and other attributes

Requirements:

Ensure that the jobs or pre-jobs are not open in Job Manager.
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1. In Job Finder, select one or more jobs or pre-jobs.

2. Perform one of the following actions:

To Do This

Set the status to
Completed

From the Edit menu, select Set Job to Completed.

Set the status to In
Prepress

From the Edit menu, select Set Job to In Prepress.

Change any
attribute or set any
status

From the Edit menu, select Edit Job Attributes. In
the Edit Job Attributes dialog box, set or modify the
options as desired, and click OK.

Note: Newly set job attributes do not appear in the Job Finder window until
you refresh it by clicking View > Refresh.

If you cannot see a column with the attribute you set, such as the
Job Status column, you must display the column.

Tip: You can also set job attributes when creating a new job or pre-job.

Edit / Set Job Attributes dialog box
This dialog box has two names. The name is Set Job Attributes when
you are creating a new job or pre-job or Edit Job Attributes when you
are changing an existing job or pre-job.

ColorFlow

Enable ColorFlow

Select this option to enable ColorFlow for the job.

ColorFlow simplifies the process of setting up color and
ensuring that jobs are processed using correct color settings.

When you enable ColorFlow for the job, and then process the
job's files using a refine or output process template, the files are
processed according to the ColorFlow settings that you
configure in those process templates.

Note: After you run a job with ColorFlow enabled, you cannot re-run the
job without ColorFlow enabled unless you re-create the job.

Default Color Setup

Select a default color setup for the job.

A color setup is a collection of several device conditions and the
color control elements (curves, device profiles, and DeviceLink
profiles) that are required to match a common target on all the
reproduction devices.
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When you refine a job's pages using a refine process template
in which ColorFlow settings are enabled, the color setup that is
assigned to the refined pages is either the color setup specified
in the refine process template or the default color setup for the
job, depending on how the refine process template is
configured.

For more information about ColorFlow, see Using ColorFlow
software on page 831.

RIP Options

RIP Name

Select Adobe PDF Print Engine or Adobe CPSI to choose the
RIP for the job.

Adobe PDF Print Engine is the default RIP.

Final Output Handling When RIP is Different

Select Fail or Warn to indicate how you want final output
handled when the RIP is different.

For example if you submit a job that contains a PostScript
object that the RIP cannot process, you could set this option to
Fail to indicate that an operator needs to remake any proofs
that have been made using that RIP.

Regional Versioning

Regular Job

Select this option if the job is a regular job and versioning is not
required.

Layered PDF Versioning (LPV) Job

For information about Layered PDF Versioning, see the Prinergy
Layered PDF Versioning User Guide.

Legacy Versioning Job

Select this option if you are using the original Prinergy system
to create multiple versions of a publication. This versioning
system requires multiple imposition plans and the manipulation
of color separations.

For more information, see the Prinergy Regional Versioning User
Guide.
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Max Layers

The maximum number of pages that you can assign to one page
position. This information is set in the Edit Job Attributes dialog
box and only applies to legacy versioning jobs.

Due Date Time

Proof

The date and time when proofs for the job are due. This date is
exported with a job.

Click Edit next to this option to display the Proof Due Date
dialog box, which you use to enter the month, day, year, and
time when the proofs are due.

Click Clear next to this option to delete the previously entered
due date.

The computer's operating system controls date and time
formats.

Final Output

The date and time when the final output for the job is due. This
date is exported with a job. This date also appears in Prepress
Portal.

Click Edit next to this option to display the Output Due Date
dialog box, which you use to enter the month, day, year, and
time when the final output is due.

Click Clear next to this option to delete the previously entered
due date.

The computer's operating system controls date and time
formats.

Miscellaneous

Job Alias

The alias of jobs in your system. For systems where the job
name is a number, the job alias provides the meaningful job
name. Job Alias corresponds to Job Description in InSite
Prepress Portal. If you change the job alias in Prinergy, the job
description in InSite Prepress Portal is changed.

Job Code

A job code that you specify. The job code can be anything that
is meaningful to you or to your customer.
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The job code is:

● Available to an imposition job ticket
● Available as a variable mark on the job's output
● Exported with a job
● Included in CIP3 files when Prinergy generates CIP3 files

during final output

The job code also appears in Prepress Portal, if the job is
enabled for Web access through Prepress Portal. If you change
the job code in Prinergy, the job code in PrePress Portal is
changed.

Job Status

The status of the job. When a job is created, its status is set to
In Prepress.

You can change a job's status in the Edit Job Attributes dialog
box. The following statuses are available:

● Created
● In Prepress
● On Press
● Shipped
● Completed
● Ready for Final Output
● Completed Final Output

If the job is enabled for Web access through Prepress Portal,
the following additional statuses are available:

● In Cart
● Pending Order Approval
● Order Requested
● Order Accepted
● Order Rejected

Select Enable Press Side Proofing if the workflow includes the
Kodak PressProof software.

APA behavior on RIP

This job attribute is available when you use Automated Page
Assignment (APA) and create CT/LW jobs.

This job attribute determines how to resolve any conflicts
between the page position assignments specified in the APA file
and pages that have been previously assigned to a position in
Prinergy Workshop.
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When you refine a page, Prinergy looks in the Automated Page
Assignment (APA) file to determine its page set position and
then automatically assigns it to this position. There are times,
however, when there may already be a page assigned to that
page set position. When Prinergy encounters this conflict, it
needs to determine which of the following actions to take:

● Retain the page currently assigned to this position and leave
the newly refined page as unassigned.

● Assign the newly refined page to the page position specified
in the APA file and unassign the page currently assigned to
this position.

The APA behavior on RIP attribute enables you to choose how
Prinergy handles page assignment conflicts when it re-refines a
page in this job. Select:

● Retain Assignments to retain the page currently assigned to
the position specified in APA file, and leave the re-refined
page as unassigned.

● Overwrite Assignments to assign the refined page to the
position specified in the APA file, overwriting the existing
page assignment. The page that is currently assigned to this
position then becomes unassigned.

● None to disregard the APA file entirely. This means that a
re-refined page that has never been assigned stays
unassigned; and a re-refined page that has been assigned
stays in its assigned position.

This job attribute overrides the default APA behavior for new
jobs which is set in Prinergy Administration. For information on
how to set default APA behavior for new jobs, see the Prinergy
System Administration Guide.

Note: The job's APA files are stored in the <Job>/Control folder. If there
is more than one APA file, for example, Job.apa and Job.v1.apa, Prinergy
looks at the APA file with the latest date and time. It does not refer to the
version number in the file name.

Web Access

Enable Web Access

Allows the selected customer to view the job in Prepress Portal.

When you select the Enable Web Access check box, the Select
Web Access Customer dialog box appears. Select the customer
for whom you want to allow Web access for the job.
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Customer

Lists the customer whose name you selected when you enabled
Web access to the job.

Managing jobs

Job management

After you create jobs or pre-jobs, you can:

● Find them, if you're not sure about the job's name or location
● Open them
● Rename them
● Move them between groups
● Move them between Prinergy systems
● Copy them
● Add notes to them
● Add custom fields to them
● Destroy them

Finding jobs

If you want to open a job but are not sure of its exact name or its group,
you can search for it with the Find Job dialog box.

If you know the exact name, you can enter it.

If you do not know the exact name, you can use the "*" wild card in
place of one or more letters. For example, if you search for magazine*,
you will find all jobs that start with magazine. You can use multiple
wild cards in the same search.

You can use uppercase or lowercase letters. Case does not matter in
the search.

The search results display each job that matches your search and the
group it is in. When you select a job and click Open, the job opens.

Opening jobs

You can open a job from either Job Finder or Job Manager. You can
open pre-jobs from Job Finder only.

Each job opens in a new Job Manager window. You can open several
Job Manager windows at once.

If you're not sure about the job's name or location, see Finding jobs and
pre-jobs on page 98.
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Renaming jobs

You can rename jobs and pre-jobs in Job Finder.

You cannot rename a job if any processes are in progress on elements
of that job.

You can rename a job while the job is open in Job Manager, but the
name change does not take effect in Job Manager until you close and
reopen the job. You can still start processes in Job Manager when it is
showing the old job name.

You can also Renaming groups on page 110.

Adding custom fields to jobs

You can create custom fields for jobs or for elements within a job, so
that you can track unique information about the job or element.
Custom fields let you determine the type of information that you store
and display about a job or job element.

Adding notes to jobs

You can add notes to a job. You can also edit or delete job notes. All
users can see the notes that others have added. Notes have a time
stamp to show when they were last modified.

Prepress Portal users can work with job notes. Prepress Portal job
notes that are visible to all users are also visible in Workshop. Job
notes created in Workshop are visible to InSite administrators.

Dashboard users can do everything with job notes that you can do in
Workshop, including adding, editing, deleting, and viewing Workshop
job notes.

Destroying jobs

If you never intend to finish or use a job or pre-job, you can destroy it.
You can select multiple jobs at a time to destroy with a single
operation.

Important: Destroying a job or pre-job permanently deletes all files and
information about the job or pre-job. You cannot retrieve it later.

To keep a copy of the job for future use, see About Archiving, Purging,
and Retrieving Jobs.

Getting information on jobs

You can get detailed information about jobs or pre-jobs in the Job Info
dialog box. The Job Info dialog box displays information about all of the
job or pre-job details, including file size information.

Getting information on jobs 97



You can get information about multiple jobs or pre-jobs from Job
Finder. Each one has a separate Job Info dialog box.

You can get information about the currently open job from Job
Manager.

Finding jobs and pre-jobs

1. In Job Finder, select the Jobs view to find a job or the Pre-Jobs view
to find a pre-job.

2. From the Edit menu, select Find Job or Find Pre-Job.

3. In the Find Job dialog box, type the name of the job that you want to
find.

You can use either uppercase or lowercase letters and the *
(asterisk) as a wild card.

4. Click OK.

The Find Job Results dialog box appears, displaying the jobs that
match your search.

To help you identify your job, the following information is listed:
name, group in which the job resides, job code, location of the job,
and the date and time that the job was created.

5. Select the job that you want to open, and click Open.

Tip: You can also double-click the job to open it.

A Job Manager window opens for the job.

Find Job dialog box

Job Name

The name of the job your want to search for.

Find Job Results dialog box

Name

The name of each job that matches your search.

Select one of the jobs listed and click Open.

Group

The group in which the job or pre-job was created.

Job Code

The job code that you specified when you created the job.
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Location

The file path to the job or pre-job, using the UNC format (\
\<servername>\<jobvolume>\Jobs\<jobname>).

Created

The date and time when you created the job or pre-job.

Opening jobs and pre-jobs

The way that you open jobs and pre-jobs depends on which window
you are in.

○ If you are in the Job Finder window:

1. Select the Jobs view to open a job, or the Pre-Jobs view to open
a pre-job.

2. Perform one of the following actions:

● Double-click the job or pre-job.
● Select the job or pre-job, and from the File menu, select Open

Job.
● Right-click the job or pre-job and select Open Job.

○ If you are in the Job Manager window:

1. From the File menu, select Open.
2. In the Open Job dialog box, select the job that you want to open

and click Open.

Open Job dialog box

lists

The drop-down and the list work together to navigate folders.

When the drop-down displays:

● Volumes, the list displays the volumes in your system
● A volume name, the list displays folders at the root of the

selected volume
● A folder name, the list displays the contents of that folder

When you click the drop-down, you see the path of the
displayed item in reverse order. For example, if the drop-down
displays a subfolder, when you click the drop-down, you see the
name of the folder that the subfolder is in, followed by the name
of the volume that the folder is on, followed by Volumes.
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Open

Use this button to open the item selected in the list.

Renaming jobs and pre-jobs

1. In Job Finder, select the Jobs view to rename a job or the Pre-Jobs
view to rename a pre-job.

2. Select the job or pre-job.

3. From the File menu, select Rename Job.

Note: Rename Job is not available if any processes are occurring on the job's
elements.

4. In the Rename Job dialog box, type the new name, following the
naming requirements.

5. Click Rename.

If the job is open in Job Manager, the name change does not take
effect in Job Manager until you close and reopen the job.

Rename Job dialog box

New Name

Enter a new name for the job.

Using job notes

1. In Job Manager, from the Job menu, select Notes.

2. In the Job Notes dialog box:

To Do This

Add a job note Type a note in the Add a New Note box, and click
Add.

Job notes are visible to Dashboard users and InSite
administrators.

Change a job note Select the job note, and click Edit. Make your changes
and click Save.

The changed note is moved to the top of the list.

Delete a job note Select the job note, and click Delete.

This job note is marked as deleted and hidden.
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To Do This

Show deleted job
notes

Select the Show Deleted Notes check box. To see the
full text of a deleted job note, select the note, and
click View.

Note: Job notes are not deleted permanently. When
you select this check box, all the job notes for this job
that have been created, edited, or deleted are
displayed.

Job Notes dialog box

list

Lists all the notes for a job, including job notes created in
Prepress Portal that are visible to all users, and all job notes
created in Dashboard. The list includes a few lines of each job
note. To view the full text of a job note, select it and click Edit.

Add a New Note

Type a new job note in this box and click Add.

Add

This button is available only after you type text in the Add a
New Note box. Click this button to add the text in the Add a
New Note box to the job notes list.

Job notes are visible to Dashboard users and InSite
administrators.

Edit

Click this button to edit the selected note or to view the full text
of the selected note.

After making changes click Save. The changed note is moved to
the top of the list.

Delete

Click this button to mark the selected note as deleted and to
hide it. (Job notes are not deleted permanently; they are
hidden.) To display deleted job notes, select Show Deleted
Notes.

Show Deleted Notes

Select this check box to display all the job notes that have been
created, edited, or deleted for this job.
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View

This button is available only after you select a deleted job note.
Click this button to view the full text of the deleted job note.

Destroying jobs and pre-jobs
Important: Destroying a job or pre-job permanently deletes all files and
information about the job or pre-job.

1. Start destroying a job in one of these ways, depending on which
window you are in:

In Do This

Job Finder Select the jobs or pre-jobs. From the File menu, select
Destroy Entire Job.

Job Manager From the Job menu, select Destroy > Destroy.

2. In the Destroy Job dialog box, type your user name in the User
Name box and your password in the Password box.

3. Click Destroy.

Destroy Job dialog box

User name

Enter the user name associated with your Prinergy Workshop
account.

Password

Enter the password associated with your Prinergy Workshop
account.

Viewing information about jobs and pre-jobs

1. Select a job or pre-job:

In Do This

Job Finder Select one or more jobs or pre-jobs

Job Manager Select the  <job name> button

2. From the File menu, select Get Info.

The Job Info dialog box appears displaying details about the job. If you
selected more than one job or pre-job, a separate Job Info dialog box
appears for each one.
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Job Info dialog box

Name

The name of the job, pre-job, or group. This column cannot be
hidden.

Kind

Indicates whether the selection is a Job or Pre-Job.

Details

The information in the Details area is specific to each type of element.
Click  to expand this collapsible section to view more details.

Pages Approved

The number of approved pages, over the total number of pages
in the job.

APA Behavior on RIP

Displays how this job resolves conflicts between the page
position assignments specified in the APA file and pages that
have been previously assigned to a position in Prinergy
Workshop.

● Retain Assignments to retain the page currently assigned to
the position specified in APA file, and leave the re-refined
page as unassigned.

● Overwrite Assignments to assign the refined page to the
position specified in the APA file, overwriting the existing
page assignment. The page that is currently assigned to this
position then becomes unassigned.

● Select None to disregard the APA file entirely. This means
that a re-refined page that has never been assigned stays
unassigned; and a re-refined page that has been assigned
stays in its assigned position.
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Archive Status

The quantity of files in the job that you have archived at any
time. Possible statuses are:

● None: The job has not been archived.
● Some: Some but not all files in the job were archived. This

can occur when you:

○ Archive only selected files, not the whole job
○ Archive the job, and then add one or more files to the job,

for example, by adding input or processing an input file
that had not been processed before the archive

○ Change one or more of the archived files, for example by
processing it again

● All: The job was archived and no changes have been made to
any files in the job.

Created

The date and time when you created the job or pre-job.

Errors/Warnings

Displays the most important error or warning status from the
most recent processes in the Processes pane of Job Manager.

Final Output Count

The number of separations you have output using the final
output process template, over the total number of separations
in the job.

Final Output Due

The date and time that the final output for the job is due. This
information is set in the Edit Job Attributes dialog box.

Full Surfaces

The number of surfaces for which all positions have pages
assigned, over the total number of surfaces in the job.

Group

The group in which the job or pre-job was created.

Job Code

A job code that you specify. The job code can be anything you
desire. It can be a code that is meaningful to you or to your
customer.
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The job code is:

● Available to an imposition job ticket
● Available as a variable mark on the job's output
● Exported with a job
● Included in CIP3 files when Prinergy generates CIP3 files

during final output

The job code also displays in Prepress Portal, if the job is
enabled for web access through Prepress Portal.

Job Home

The full path name for the job folder location.

Job Status

The status of the job. When a job is created its status is set to In
Prepress.

You can change job status in the Edit Job Attributes dialog box.
Possible statuses are.

● Created
● In Prepress
● Ready for Final Output
● Completed Final Output
● On Press
● Shipped
● Completed

Last Archived

The date and time that someone last archived the job.

Last Final Output

Date and time the last separation was output using a final
output process template.

Max Layers

The maximum number of pages you can assign to one page
position. This information is set in the Edit Job Attributes dialog
box, and only applies to legacy versioning jobs.

Name

The name of the job, pre-job, or group. This column cannot be
hidden.
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Online

Indicates whether a job is fully or partially Offline or Online.

Offline indicates that no files in the job's job folder exist on the
job home server. Files from outside the job folder may still be
online. When you fully purge a job, its status is Offline since
purging removes all files in the job folder from the job home
server.

Online indicates that at least one file for the job is on the job
home server.

If this column is blank, the status of the job is not known.

Proof Due

The date and time that the proofs for the job are due. This
information is set in the Edit Job Attributes dialog box.

Stale Archive Status

The quantity (All Some, or None) of files in the job that have
changed since the last archive.

Web Access Customer

The name of the customer for whom you have enabled web
access. This information is set in the Edit Job Attributes dialog
box.

Sizes

Expand this collapsible section to view information about the size of
the job folder and related files.

Job Folder

The total size of all files in the job folder.

Other Files

The total size of all files that have been added to the job but are
located outside of the job folder.

Custom Fields

You can create custom fields for jobs or for elements within a job, so
that you can track unique information about the job or element.
Custom fields let you determine the type of information that you view
about a job or job element.

Custom Fields appear in the Job Info dialog box when you create
custom fields using the Custom Fields dialog box. You can edit values
for custom fields in the Job Info dialog box.
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Note: The fields in this dialog box also appear as columns in Job Finder
window on page 16.

Changing a job to a pre-job or a pre-job to a job

In Job Finder, you can change a pre-job to a job or a job to a pre-job.

It is possible to perform these actions on a group of jobs (or pre-jobs)
simultaneously.

Note: Changing a pre-job to a job might stop InSite upload processing from
working on that job, depending on how the InSite software is configured.

1. In Job Finder, select the job or pre-job that you want to change.

2. Select the File menu.

○ If you are in the Pre-Jobs view, select Move to Job.

After Prinergy changes the pre-job to a job, it appears in the
Jobs view.

○ If you are in the Jobs view, select Move to Pre-Job.

After Prinergy changes the job to a pre-job, it appears in the Pre-
Jobs view.

Move Job dialog box

lists

The drop-down and the list work together to navigate folders.

When the drop-down displays:

● Volumes, the list displays the volumes in your system
● A volume name, the list displays folders at the root of the

selected volume
● A folder name, the list displays the contents of that folder

When you click the drop-down, you see the path of the
displayed item in reverse order. For example, if the drop-down
displays a subfolder, when you click the drop-down, you see the
name of the folder that the subfolder is in, followed by the name
of the volume that the folder is on, followed by Volumes.

Open

Use this button to open the item selected in the list.

Move to <group name>

Click this button when you are ready to move the job to the
group selected in the list.
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Job groups

About job groups

The jobs and pre-jobs in Job Finder are organized into groups that you
create. Grouping jobs makes them easier to find and manage.

For example, if you produce a monthly magazine, you might want to
create a group for it, and then, within that group, create a separate job
for each issue of the magazine.

You can create a new group while you create a job or pre-job, or
separately. You can further organize your jobs by creating groups
within groups.

If you later decide to organize your jobs in a different way, you can
move jobs between groups, move groups into other groups, and
rename groups. You can also delete a group, if it is empty.

Groups are not part of the folder structure that you can see in a file
browser. They are part of the data structure inside Prinergy.

Moving jobs and pre-jobs between groups

1. In Job Finder, select the Jobs view to move a job, or the Pre-Jobs
view to move a pre-job.

2. Select the job or pre-job.

3. Select File > Change Group of Job.

4. In the Change Group dialog box, use the lists to locate and select
the group to which you want the job or pre-job to go.

5. Click Move to "<group name>".

Creating groups
Tip: You can also create a group when Creating jobs and pre-jobs on page 85.

1. In Job Finder, from the File menu, select New Group.

Tip: You can also right-click anywhere in Job Finder and select New Group.

2. In the Create New Group dialog box, use the lists to locate the root
of the volume or the existing group that you want to create the new
group in.

3. In the New Group Name box, type a name for the group.

4. Click Create.
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Create New Group dialog box

lists

The drop-down and the list work together to navigate groups.

When the drop-down displays:

● Groups on <server name>, the list displays the groups on
the specified server

● A group name, the list displays the contents of the specified
group, including jobs and groups

When you click the drop-down, you see the path of the
displayed item in reverse order. For example, if the drop-down
displays a subgroup, when you click the drop-down, you see the
name of the group that the subgroup is in, followed by Groups
on <server name>.

Open

This is not visible if you open this dialog box from the Create
New Job or Create New Pre-Job dialog box.

Use this button to open the item selected in the list.

New Group Name

Type a name for the new group. The group name must:

● Be 31 characters or less
● Be unique

In addition to giving the group a unique name, avoid using
the same name for your group and your job; it can cause
confusion.

● Not include the following special characters: \ / : ' \ " ? * < >
|

● Not start or end with a space character or end with a .
(period)
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Moving groups

1. In Job Finder, select the group.

2. From the File menu, select Change Group (of group) .

Tip: You can also right-click the group and select Change Group (of group).

3. In the Change Group dialog box, use the lists to locate either the
root or group that you want to move the group into.

4. Click Move to "<new location>".

Move Group dialog box

lists

The drop-down and the list work together to navigate groups.

When the drop-down displays:

● Groups on <server name>, the list displays the groups on
the specified server

● A group name, the list displays the contents of the specified
group, including jobs and groups

When you click the drop-down, you see the path of the
displayed item in reverse order. For example, if the drop-down
displays a subgroup, when you click the drop-down, you see the
name of the group that the subgroup is in, followed by Groups
on <server name>.

Open

Opens the selected item.

Move to "<new location>"

Click this button when you are ready to move the group to the
location selected in the list.

Renaming groups

1. In Job Finder, select the group that you want to rename.

2. From the File menu, select Rename Group.

Tip: You can also right-click the group and select Rename Group.

3. In the Rename Group dialog box, type a new name for the group in
the New Name box.

4. Click Rename.
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Rename Group dialog box

New Name

Type a name for the new group. The group name must:

● Be 31 characters or less
● Be unique

In addition to giving the group a unique name, you should
avoid using the same name for your group and your job; it
can cause confusion.

● Not include the following special characters: \ / : ' \ " ? * < >
|

● Not start or end with a space character or end with a .
(period)

Deleting groups

1. In Job Finder, ensure the group is empty.

● If the group contains sub groups, delete them.
● If a group contains jobs or pre-jobs, destroy or move them.

2. Select the group.

3. From the File menu, select Delete Group.

Tip: You can also right-click the group and select Delete Group.

4. When a confirmation message appears, click OK.

Copying and moving jobs between servers
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About copying jobs

In Prinergy, you can copy original jobs and pre-jobs to create new jobs
and pre-jobs on your Prinergy system. You can copy a job when you
need to perform the following tasks:

● Create a backup of a job. For example, you can copy an original job
and make revisions, remakes or test changes on the new copied job,
leaving the original job intact.

● Move a job. For example, you can copy a job to another server/
share combination on your Prinergy system and delete the original
job.

● Retrieve an archived job to a newly created copy of the job. For
example, you can archive and purge Job 1, copy Job 1 to create Job
2, and retrieve Job 1 into Job 2.

When you copy a job, all job related data from the original job is copied
to the new job. If the original job is online, the job folder contents are
copied to the new job. If the original job if offline, you have to use the
Archiver to retrieve the job folder contents into the new job.

When you copy a job, it is optional to copy the history log and the job
folder of an original job to a new job. If you choose to copy the history
log and the job folder, the new job will contain all of the functionality
and job attributes of the original job, including: pages, page sets,
imposition plans, page assignments, version plans, color libraries,
history processing information, miscellaneous files, archives, hot
folders, job notes, custom fields, as well as, image and font search
paths. For image and font search paths, the paths are copied, but any
content residing outside of the job folder is not copied.

You can copy a job using a pre-set copy job process template. After a
job has been copied, you can change the job data as necessary. You
can only copy one job at a time.

As with any job, a job that is created using the copy job function can be
destroyed.

About moving jobs

There are several ways to move jobs and pre-jobs in Job Finder:

● You can move jobs and pre-jobs from one group to another within
the same Prinergy system using the File > Change Group (of Job)
function.

● You can move jobs and pre-jobs to another volume using the File >
Copy Job function. When you copy a job, a copy of the job remains
on the server. After a job is copied, you can delete the original
version.
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● You can move jobs and pre-jobs to another Prinergy system using
the File > Move Job From Remote Server function. When you move
a job or pre-job, the job files remain on the job's home server.

● You can also move jobs and pre-jobs to another server by exporting
them.

About moving jobs from a remote server

In Job Finder, you can move jobs and pre-jobs between two Prinergy
systems using theFile > Move Job From Remote Server function.
When you move a job or pre-job, the job files remain on the job's home
server. Previously, you could move jobs and pre-jobs to another server
only by exporting them.

This feature is useful for the following tasks:

● Upgrading a server—you can move all of the jobs off a Prinergy
system before upgrading it.

● Maximizing production—you can move jobs between Prinergy
systems to distribute the workload. For example, if you have 20 jobs
running on one primary server and only five jobs running on another
primary server, you can move some jobs to achieve better
throughput.

For instructions about moving jobs and pre-jobs between two Prinergy
systems, see Moving jobs from remote servers on page 116.

Limitations

When you move a job or pre-job from another Prinergy system, make
sure that you are aware of the following limitations:

● Job folders—The job files remain on the source server.
● Process templates—if the job has a hot folder that processes files

using a custom process template, it is assumed that the process
template on the target Prinergy system has the same settings as the
process template on the source Prinergy system.

● Custom fields—when you move a job that contains custom field
information, it is also available for the job on the target Prinergy
system.

● Rules-Based Automation—when you move a job that has rule sets
enabled in it, the rule sets are copied from the source Prinergy
system and re-enabled in the moved job on the target Prinergy
system. However, if a rule is executing when the job is moved,
execution is permanently stopped.
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Requirements

When you move a job or pre-job from another Prinergy system, make
sure that you are aware of the following requirements:

● Both Prinergy systems must be running the same Prinergy version.
● The source job or pre-job must not be in use when you move the

job.
● The job cannot be purged—either partially or fully.
● The target Prinergy system must not already have a job with the

same name.
● The job cannot have a hot folder that processes files using a custom

process template, unless the custom process template also exists
on the target Prinergy system.

● The target server (the one you are moving the job from) must be
defined as the job home of the destination server. To do this:

1. On the primary server, open Prinergy Administrator > Tools >
Files Shares.

2. On Network File Shares Configuration, click Add.
3. In the Choose New Share box, enter the server name (or ID) and

the job home that you want to share (for example,
AraxiVolume_ServerName_J) .

4. When new share host is added to File Shares (on the left side),
select it with the cursor, and then select the Share can be used
for job home check box on the right side.

Copying jobs and pre-jobs

1. In Job Finder, select the Jobs view to copy a job or the Pre-Jobs
view to copy a pre-job.

2. Select a job or pre-job that you want to copy.

From the File menu, select Copy Job or right-click on the job and
select Copy Job.

3. Do one of the following in the Copy Job / Pre-Job dialog box:

○ Use the lists to select the group in which you want to copy your
job and click Open.

○ Click New Group to create a new group. In the Create New
Group box, type a name for the new group following the naming
requirements, and then click Create.

4. If your system has more than one server, from the Server box,
select the server on which you want to copy the job or pre-job.

5. If your system has more than one shared volume, from the Volume
box, select the volume on which you want to create the job or pre-
job.

114 Chapter 6—Jobs



6. In the Create new Job as box, type a name for the job or pre-job,
following the naming requirements.

7. If you want to copy a job using a pre-set copy job process template,
click the Select button. From the Choose Process Template dialog
box, select a Copy Job process template and click OK.

8. Click Copy Job.

9. From the Start Process dialog box, set the attributes you want, and
click OK.

The copied job or pre-job appears in a new Job Finder window.

Copy Job / Pre-Job dialog box

This dialog box has two different names. The name is Copy Job when
you are copying a job and Copy Pre-Job when you are copying a pre-
job.

The dialog box displays the settings that were entered when the last
job was copied.

lists

The drop-down and the list work together to navigate groups.

When the drop-down displays:

● Groups on <server name>, the list displays the groups on
the specified server

● A group name, the list displays the contents of the specified
group, including jobs and groups

When you click the drop-down, you see the path of the
displayed item in reverse order. For example, if the drop-down
displays a subgroup, when you click the drop-down, you see the
name of the group that the subgroup is in, followed by Groups
on <server name>.

Open

Opens the selected item.

New Group

Click this button to display the Create New Group dialog box,
which you use to create a new group (rather than selecting an
existing group) in which to copy the new job or pre-job.

Home
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Server

Lists the servers on which you can copy jobs and pre-jobs. The
Server list is available only if you have more than one server.

Volume

Lists the volumes on the server that you selected in the Server
list. The Volume list is available only if your system has more
than one shared volume.

Create new Job/Pre-Job as

Type a name for the new job or pre-job. The name must:

● Be 31 characters or less
● Be unique, even if other jobs or pre-jobs are created in

different groups
● Not be the same as the group name-to avoid confusion
● Not include the following special characters: \ / : ' \ " ? * < >

|
● Not start or end with a space character or end with a .

(period)

Moving jobs from remote servers

Requirements:

If you want to move jobs and pre-jobs from another Prinergy system,
you must be logged on to Workshop on the primary server that you
want to move the job to.

Before you can move a job (or pre-job) from a remote server, you must
make sure that the target server (that you are bringing the job from) is
defined as the job home of the destination server (the one you are
bringing the job to).

1. On the primary server, open Prinergy Administrator, and select
Tools > Files Shares.

2. In Network File Shares Configuration dialog box, click the Add
button.

3. In the Choose New Share box, enter the server name (or ID) and
the job home that you want to share—for example,
AraxiVolume_ServerName_J.

4. After the new share host is added to the file shares (on the left
side), select it, and select the Share can be used for job home
check box.
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Move the job

After you define the target server as the job home of the destination
server, you can move the job.

1. In Job Finder, select the Jobs view to move a job or the Pre-Jobs
view to move a pre-job.

2. Select the job or pre-job.

3. Select File > Move Job from Remote Server.

4. In the Move Job from Remote Server dialog box, select the server
that you want to move the job from.

5. In the jobs list, select a single job or multiple jobs to move.

6. Click Move to "<server name>".

The server name that is listed on the button indicates the server
that Workshop is connected to.

Move Job from Remote Server dialog box

Server <list>

Select the primary server from the list that you want to move a
job from.

Jobs <list>

Select a job group from the list and the job(s) that you want to
move.

Move to "<server name>"

Click this button when you are ready to move the job(s) from
the server.

The server name that is listed on the button indicates the server
that Workshop is connected to.

Copy Job process template

This topic applies only if you are copying jobs or pre-jobs.

Copy Job Folder

Select this check box to copy the job folder contents from the
original job to the new job.

If the original job is online, the job folder contents are copied to
the new job. If the original job if offline, you have to use the
Archiver to retrieve the job folder contents into the new job.
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Copy Job History

Select this check box to copy the job history contents from the
original job to the new job.

Custom fields

About custom fields
Create custom fields so that you can track unique information about
each job or each element within a job, such as all of the surfaces in a
job.

For example, you can use custom fields for the following tasks:

● To show who is the salesperson for a job. For example, you can
create a custom field at the job level, called Salesperson, and view
the information in the Visible Columns or Get Info dialog boxes.

● To create variable marks and custom file naming. For example, if
you have created custom fields at the job level or job element level
(Page, Page Set, Imposition, Signature, Surface, and Separation),
you can use them for variable marks and custom file naming. For
example, for the mark $[CustomFieldSurface_Web], Web is the
name that you defined for the custom field surface, and it would
print on output.

Where custom fields appear

When you create custom fields:

● They appear in the Get Info dialog box if the Show in Workshop
check box is selected in the Custom Fields Manager.

● They appear in the main windows of Workshop if the Show in
Workshop check box is selected in the Custom Fields Manager and
the field's check box is selected in the Visible Columns dialog box
for the window, view, or pane.

○ Job-level fields appear as columns in Job Finder.
○ Element-level fields appear as columns in Job Manager. For

example, fields for pages can appear as columns in the Pages
pane.

● They are available for use in Rules-Based Automation (RBA). You
can use RBA to enter values, or you can use a change in a custom
field as a trigger for a rule. For example, if you create a custom field
for a job, each time users enter values in the custom field, they
trigger the Job Custom Field Changed event.
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Entering values into custom fields

You can enter values for custom fields in these ways:

● Manually in Workshop
● Automatically by importing an imposition that is part of a JDF file

that contains custom field data
● Automatically via Business Link by setting up Prinergy to get data

for custom fields from an XML file created by an MIS (management
information system) when the MIS creates a new Prinergy job via
Business Link

● Using the Set Custom Fields action in RBA

Rights to work with custom fields

User rights for custom fields is controlled using Prinergy Administrator.
You must have a specific user right to modify which custom fields are
defined and what their default value and visibility is. Without the right
to manage custom fields, the Custom Fields Manager is in read-only
mode, and its title displays the words “Read only.” Any Workshop user
can edit the values assigned to custom fields. For information about
setting user rights for managing custom fields, see Prinergy System
Administration guide.

Viewing custom fields
You can display custom fields in Workshop.

Requirements: To see any custom field in Workshop, the Show in
Workshop check box must be selected next to the field in Custom
Fields Manager.

○ To show fields as columns in Job Finder or Job Manager, perform
any of the following actions:

○ To show a job-level field in Job Finder, select View > Visible
Columns, and select the custom fields that you want to see in
Job Finder.

○ To show an element-level field in Job Manager, select View >
Visible Columns, and select the custom fields that you want to
see in the appropriate pane in Job Manager.

For example, select the Pages pane, select View > Visible
Columns, and select the custom fields that you want to see in
the Pages pane in Job Manager.
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Tip: Use the Select All and Deselect All buttons if you must select or clear
a large number of fields.

○ To view fields for a specific job or element, perform any of the
following actions:

○ To view the information in a job-level field from Job Finder, right-
click a job, and select Get Info.

○ To view the information in a job-level field from Job Manager,
right-click the job button , and select Get Info.

○ To view the information in an element-level field from Job
Manager, right-click an element, and select Get Info.

For example, right-click a page in the Pages pane, select Get
Info, and look for the field in the Custom Fields area of the Get
Info dialog box.

Creating custom fields
Create a custom field for a job or a job element, such as a surface.

Prerequisite: To create, modify, or delete a custom field, you must
have a specific right in Prinergy Administrator. Otherwise, the Custom
Fields Manager is in read-only mode, and its title displays the words
“Read only.”

1. In Job Finder or Job Manager, from the Tools menu, select Custom
Fields Manager.

2. In the Custom Fields Manager, select one of the following options:

○ If you want the field to describe an entire job, select Job.
○ If you want the field to describe elements within each job, select

the element. Options are: Page, Page Set, Page Position,
Imposition Plan, Signature, Surface, or Separation.

3. Click Add, and define the custom field’s Name, Type, and Default
Value. Then, click Add, and click Close.

4. If you do not want the field to appear in Workshop, clear the check
box next to the field in the Show in Workshop column.

Custom Fields Manager dialog box
You can use the Custom Fields Manager dialog box to create custom
fields for a job, or for elements in a job.

Note: If this dialog box is in read-only mode, you do not have rights to work with
custom fields. Contact your system administrator to give you rights using Prinergy
Administrator.
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Category

Select a job or job element to display and manage custom field
information. Click  to expand or minimize the category list
panel.

Name

Identifies the names of the custom fields for the element
selected.

You cannot edit this column. If you want to update the name of
the custom field, you have to delete the custom filed and create
a new one.

Default Value

Identifies the default value of the custom field.

You can edit a default value for a custom field by selecting the
default value column and updating the value. For example, if the
Type for the default value is set to Date, you can select the
default value column and click the triangle to display a calendar
to select a new date.

Type

Identifies the data type for the custom field that is used to show
information about the job or element selected. The options are
as follows:

Text: Use alphabetical characters only.

Integer: Use whole numbers only.

Decimal: Use numerical values only.

Yes/No: Checkbox (selected=Yes)

Date: Select a date from the calendar.

You cannot edit this column. If you want to update the data
type for the custom field, you have to delete the custom field
and create a new one.

Show in Workshop

In Job Finder and Job Manager, this check box identifies if the
custom fields for the job or element selected appear in the
Visible Columns and Get Info dialog boxes. You can turn this
value ON or OFF for the custom field by selecting or clearing
the check box.
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Create

Click the Create button to add a new custom field for the job or
element selected.

Delete

Select a custom field, and click Delete to remove it from the
system. When a warning message appears, click Continue to
confirm the deletion.

XSLT for Link JDFs

Import metadata from Link JDFs

XSLT for Link JDFs

You can create custom fields automatically if you use Business
Link software and have a defined XSLT file.

If you select this check box, the custom fields for the element
you selected are automatically created and populated with
information from an XSLT file that you selected.

XSLT file

Select the XSLT file that Prinergy uses to interpret the JDF file.

Add Custom Fields dialog box
Use this dialog box to create a custom field.

Name

Identifies the names of the custom fields for the element
selected.

You cannot edit this column. If you want to update the name of
the custom field, delete the custom filed and create a new one.

Default Value

Identifies the default value of the custom field.

You can edit a default value for a custom field by selecting the
default value column and updating the value. For example if the
Type for the default value is set to Date, you can select the
default value column and click the triange to display a calendar
to select a new date.
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Type

Identifies the data type for the custom field that is used to show
information about the job or element selected. The options are
as follows:

Text: Use alphabetical characters only.

Integer: Use whole numbers only.

Decimal: Use numerical values only.

Yes/No: Checkbox (selected=Yes)

Date: Select a date from the calendar.

You cannot edit this column. If you want to update the data
type for the custom field, you have to delete the custom field
and create a new one.

Add

Click this button to finish the process of creating a new custom
field, and close the Add Custom Field dialog box.

After clicking this button, start typing values for another new
custom field or click Close to return to Custom Fields Manager.
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7 Input files

Customer files

About preparing customer files

Customer files are the source files that you use to produce the final
printed product.

General best practices

● Composite files are preferred, but separated files such as those
created with QuarkXPress or Adobe PageMaker, are also
acceptable. However, the separations set in separated input files
cannot be modified in Prinergy. With composite input files, you can
decide at the last minute how you want to output colors. If you
require trapping and color matching, you must use composite input
files. You can mix composite and separated files in the same
Prinergy job.

● We recommend that you always include or embed fonts in your
input files.

● Customer files can be stored on any server or disk that Prinergy can
see. When you add files to a Prinergy job, you tell the system where
the customer files are stored.

For information about specific file formats, see:

● About Supported Input File Types
● About Copydot Scans and Other DCS Files
● About Processing CT/LW and TIFF/IT
● About Duotones
● About PDF Input Files
● About Transparency Support

For information about preparing files from specific software, see:

● About Illustrator
● About PageMaker
● About QuarkXPress
● About Adobe Photoshop
● About InDesign
● About Macromedia FreeHand



About supported input file types

Prinergy supports the following types of input files:

● PDF 1.2, 1.3, 1.4 (separated or composite).
● PDF 1.5 files are supported; however, PDF 1.5 features are not fully

supported. (See Note 1.)

○ Layers: For LPV jobs, you can retain layers of incoming files. For
non-LPV jobs, visible layers are united onto a single layer.

● PDF 1.6 files are supported; however, some PDF 1.6 features are not
supported, for example, Open Type fonts. (See Note 1.)

○ If Open Type fonts are detected, the input file is flattened.

● PDF/X-1a:2001, PDF/X-3
● PostScript Level 1, 2, and PostScript 3 (separated or composite)

(See Note 3.)
● EPS
● DCS 1 and DCS-2 (single or multi-file)
● CT/LW (Kodak Brisque and PS/M 5 and up) (See Note 2.) Includes

New, Native, and Handshake formats of CT and LW
● TIFF/IT-P1 (See Note 2.)
● TIFF
● JPEG

Prinergy also supports variable data input files for outputting to a
digital printer. Currently, only Kodak NexPress and Creo Spire digital
printers are supported. The NexPress only supports the PPML/VDX
file type. The Creo Spire supports PPML/VDX, PPML/GA and VPS file
types.

Notes:

● PDF 1.5 and 1.6 files can be processed if they are free of features that are not
supported.

● Supported only if your system includes a CEPS JTP.
● For color-separated files, some functionality, such as trapping and color

management, is not available.

About FreeHand

Adobe FreeHand best practices for Prinergy:

● In File/Output Options, select ASCII Images, turn on Include OPI
comments.

● Save as EPS.

Note that FreeHand will include OPI comments for TIFF only (not EPS).
To perform OPI on an EPS (including DCS), create a sample of the file
using an image sampler. OPI-ing a DCS is desirable because Prinergy
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will recomposite the DCS on OPI into the composite page allowing you
to use Prinergy trapping.

About Illustrator

To prepare Illustrator 8 files for use in Prinergy:

● When you save a file, include the document fonts to ensure you
don't have to add the fonts in Prinergy. If you choose not to include
document fonts, you must set the font search path in Prinergy.

● Handling DCS files should be largely unnecessary. Copydot images
should be saved as PDF in TIFF Assembler Plus and then placed into
Illustrator. Contone images with spots can be saved from
Photoshop as PSD, TIFF, or PDF and then placed in Illustrator. If,
however, DCS files still need to be placed in Illustrator, you must
create a low-resolution placement file from the DCS using an image
sampler. Place the .samp file in the Illustrator file, and refine in
Prinergy using a refine process template with OPI.

● Ensure any die lines are stroked with a unique spot color and are set
to overprint. If this isn't done, the settings can be corrected in
Prinergy, but it is more efficient to correct in Illustrator.

● Ensure varnishes are filled and/or stroked with a unique spot color
and are set to overprint.

● Save your file as an Illustrator EPS Level 3 using the following
settings in the EPS Format dialog box:

○ Compatibility-8.0
○ Preview-8-bit IBM PC
○ Under Options, select Include Placed Files, Include Document

Fonts, and CMYK PostScript. Deselect Include Document
Thumbnails.

To prepare Illustrator 9 and later files for use in Prinergy:

● Follow the instructions for preparing Illustrator 8 files.
● Illustrator 9 and later is capable of outputting PDF 1.4 (native

transparency), and PDF 1.5 (layers), both of which Prinergy handles
well.

○ Native transparency can be useful because of its increased
quality and smaller files. Enable Native transparency in the Save
PDF dialog box by selecting Compatibility: Acrobat 5 (PDF 1.4).
Alternately, selecting PDF/X-4 from the Standard drop-down
list in the Save PDF dialog is another good starting point for
creating good PDFs for Prinergy's use. Check the other panels in
the dialog box to ensure that other settings are appropriate for
your environment.

○ Layers are useful only if you are preparing files for use with
Layered PDF Versioning jobs. Enable layers in the Save PDF
dialog box by selecting Compatibility: Acrobat 6 (PDF 1.5), and
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then selecting the Create Acrobat Layers from Top-Level Layers
check box.

● These settings can be saved as a preset in Illustrator. For more
information about transparency, see About transparency
support on page 163. For more information, consult the Illustrator
online help.

It may also be helpful to set the document size to be equal to the
dieline.

1. Open the PDF in Acrobat.
2. With Pitstop, select the outer extents of the dieline.
3. Activate the Pitstop Artboard tool.
4. From the Artboard Presets menu, select Fit to Selected Art.
5. To then add bleed, go to File > Document setup, and enter the

bleed amount.
6. Save the PDF and bring it into Prinergy.

About InDesign

InDesign 2.0 and later is capable of outputting PDF 1.4 (native
transparency), and PDF 1.5 (layers), both of which Prinergy handles
well.

● Native transparency can be useful because of its increased quality
and smaller files. Enable Native transparency in the Export PDF
dialog box by selecting Compatibility: Acrobat 5 (PDF 1.4).
Alternately, selecting PDF/X-4 from the Standard drop-down list in
the Export PDF dialog is another good starting point for creating
good PDFs for Prinergy's use. Check the other panels in the dialog
box to ensure that other settings are appropriate for your
environment.

● Layers are useful only if you are preparing files for use with Layered
PDF Versioning jobs. Enable layers in the Export PDF dialog box by
selecting Compatibility: Acrobat 6 (PDF 1.5), and then selecting the
Create Acrobat Layers check box.

These settings can be saved as a preset in InDesign. For more
information, consult the InDesign online help.

For more information about transparency, see About transparency
support on page 163.

About PageMaker
● Composite PostScript is required if you want to use Prinergy's

trapping or color matching features.
● When printing PostScript, you should select a printer driver and

PPD that support color devices. Prinergy installs a PPD with
Prinergy Workshop that meets this criteria (Prinergy Refiner.ppd).
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You should use an Apple LaserWriter printer driver version 8.5.1 or
newer.

● You should include registration marks when preparing your
PostScript files. In the Print Document dialog box, click Paper .
Select the Printer's marks and Page information check boxes. In the
Paper size box, select Custom . A new paper size that allows for the
marks is displayed in the Custom Paper Size dialog box.

● Prinergy determines the trim box from crop mark information
supplied in PageMaker 6.0, 6.5 and 7.0 PostScript files that include
registration marks.

● We recommend that you always include or embed fonts in the
PostScript files.

About Photoshop
● When saving DCS files from Photoshop and placing them in desktop

software such as Illustrator or QuarkXPress, save the DCS file as
either a grayscale composite or a color composite file with a
preview. Prinergy will merge high-resolution DCS data to composite
when it OPIs composite thin PostScript.

● You must save the file with a preview, otherwise the desktop
software may not add the OPI comments.

● For DCS 1 files, select either of:

○ Color Composite
○ Grayscale Composite

Do not choose No Composite PostScript.
● For DCS-2 files, select one of:

○ Single File with Grayscale Composite
○ Multiple File with Grayscale Composite
○ Single File with Color Composite
○ Multiple File with Color Composite

Do not choose Single File DCS No Composite or Multiple File DCS,
No Composite as this may cause OPI comments to disappear when
placed in QuarkXPress.

● For TIFF images, you can use clipping paths, spot colors, soft masks,
and drop shadows with OPI. See Including spot color channels
during OPI on page 270 and About using OPI with transparent
effects on page 267.

About copydot scans and other DCS files

Reformat copydot scans to 2 KB tiles (2048 pixels x 2048 pixels), and
G4 compression.

You can add DCS 1 and DCS-2 files directly to a job. When adding DCS
files, add only the main file (the DCS control file); do not add the
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separation files. DCS files can be single-file or multi-file. When
processed through the normalize function, they become PDF files
(separated) that cannot be color matched or trapped. For information
about creating composite output, see the Re-combine check box in the
refine process template.

An alternative workflow is to place partial-page raster DCS files in page
layout software, such as QuarkXPress or Adobe PageMaker, and save
the files as composite thin PostScript. You can then add the PostScript
file to a Prinergy job. When Prinergy fattens the file, it creates a
composite DCS file.

About duotones

If you create duotones with Adobe Photoshop 3.0 or 4.0 or any version
of Corel PhotoPaint, you must save the duotones as separated DCS
files. Saving as composite PostScript (EPS) will not preserve spot
colors (that is, the image will be converted to process colors).

If you create duotones in Adobe Photoshop 5.0, you must save them
using Adobe Photoshop 5.0.2. Photoshop 5.0 prevents duotones from
working correctly on PostScript 3 devices. The free upgrade to
Photoshop 5.0.2 is available for download from http://
www.adobe.com/.

Saving duotones in Photoshop software

To save duotones in Photoshop, select Image > Mode > Multichannel.
Then, save the file as DCS singles. Ensure that the image is not set to
CMYK mode in Photoshop software. If the image is set to CMYK
mode, spot colors are converted to process colors in Prinergy.

Saving duotones in layout software

You can output duotones (that were created in Adobe Photoshop 5.0.2
and saved as DCS files) from layout software as one of the following
formats:

● Composite PostScript with OPI comments (composite thin
PostScript). When Prinergy fattens the file, it creates a composite
file.

● Separated PostScript with images (separated fat PostScript).
Prinergy cannot perform trapping and color-handling functions on
separated input files.

About QuarkXPress
Determine the best method and format of outputting from
QuarkXPress for you. Also, read about any issues and observations
about your version of QuarkXPress from a Prinergy perspective.
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What's New in QuarkXPress 8

The QuarkXPress 8 software introduces PANTONE color library
support and an updated user interface.

● PANTONE color library support: The color library includes added
support for the latest color systems from Pantone (PANTONE®
Goe™ Bridge coated). Prinergy 4.1.2.1 and 5.0 ships with PANTONE 
Goe color libraries.

● User Interface: Although the user interface is somewhat updated,
most of the Quark user experience has changed little from previous
versions, ensuring easy transition to the new product

● Added features, for example, Bezier drawing tools, grid tool, super
step-and-repeat.

What's New in QuarkXPress 7

The QuarkXPress 7 software includes transparent-looking effects,
corrected trim box information, improved blends, color setups, and
more.

● Transparency: You can now create transparent-looking effects, such
as drop shadows and knock-backs. When outputting PDF files from
QuarkXPress, the transparency is flattened to PDF 1.3. There is no
native PDF 1.4 transparency output from QuarkXPress, so Prinergy
will not need to flatten QuarkXPress 7 pages.

● TrimBox: TrimBox information is correct for both Adobe PostScript
and PDF output. In QuarkXPress 6.5, PDF output did not have
TrimBox information; the TrimBox information was interpreted from
PostScript files that were submitted to the Prinergy software

● Blends: Blends are represented by one high-quality shading object.
In QuarkXPress 6.5, blend objects were represented by many small
adjacent boxes, which could sometimes result in banding on
high-resolution output.

● PDF/X-1 and PDF/X-3: You can output PDF files with PDF/X-1 or
PDF/X-3 certification.

● Color Setups: Input setups allow you to specify source profiles.
Output Setups include characteristics such as mode (composite or
separated), model (for example, DeviceN), and the ICC profile to
apply-for example, generic Quark CMYK or US Web Coated
(SWOP) v2. After you define the color control options, you can
select them in the output style Color pane.

● Color Library changes: The new Pantone Color Bridge Library is built
into QuarkXPress 7.0.

● Job jackets/JDF: You can use "job jackets" to constrain document
attributes at the design stage, and you can export job jackets to
other software applications.
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What's New in QuarkXPress 6.5

The QuarkXPress 6.5 software introduces support for DeviceN colors,
composite CMYK output, and PDF output.

In previous versions of QuarkXPress, many objects could not be
reproduced in composite files without the use of third-party
extensions, such as the Creo Colorized TIPP extension. Other objects
could not be reproduced from QuarkXPress in composite files, for
example, multi ink objects.

QuarkXPress 6.5 supports:

● DeviceN colors, so you can create spot-colorized TIFF files without
using the Creo Colorized TIFF extension

● The ability to output composite CMYK, and As Is colors. (As Is
colors provide the ability to output composite CMYK and images in
the color space in which they are defined using the As Is selection in
the Print Style list.)

● The ability to generate PDF files directly from QuarkXPress, due to
its Jaws PDF engine

What are the new print settings in QuarkXPress 6.5?

The Print dialog box in QuarkXPress 6.5 is very similar to the dialog
box in QuarkXPress 5. Like QuarkXPress 5, QuarkXPress 6.5 includes
the OPI extension, which doesn't allow Print Style control over OPI.
You may want to disable the OPI extension. The other controls seem to
behave as in QuarkXPress 5.

The most significant change to outputting in QuarkXPress 6.5 is the
ability to output DeviceN and As Is colors.

The following provides a brief description of different types of output
options:

● Selecting Composite CMYK will convert TIFF images to CMYK.
● Selecting Composite RGB will convert TIFF images to RGB.
● Selecting As Is will leave images in the color space in which they are

defined.
● Selecting DeviceN will represent pages with DeviceN where

appropriate. This will allow spot-colorized TIFFs and multiple inks.
Creo recommends you select this option when printing documents
that include spot colors. Images retain their original color spaces.
This is the recommended setting when generating PostScript for
Prinergy and Kodak Prinergy Evo.

These print colors are also available when exporting PDF from
QuarkXPress 6.5. However, due to geometry limitations when using
PDF direct from QuarkXPress 6.5, many operators find that it's better
to output PostScript and refine directly in Prinergy or Prinergy Evo.
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QuarkXPress 8.1 and later

In QuarkXPress 8.1 and later, transparency effects no longer need to be
flattened. QuarkXPress 8.1 can output native PDF 1.4 transparency,
which works well with Prinergy. You can configure this by creating a
new PDF style in QuarkXPress, and then going to the Transparency
panel and selecting the Export Transparency Natively option. Be sure
to check the other tabs to ensure the correctness of those settings. For
more information, consult your QuarkXPress help.

QuarkXPress 7 and 8.0: Issues and observations

Most known issues with QuarkXPress 7 and 8 involve transparency,
colorized TIFF files, and geometry from PostScript.

Transparency

● Transparency support still very limited in QuarkXPress 8.0 and
earlier. Transparency in imported PDFs is not retained on export.
The PDF import filter (Quark JAWs engine) still flattens
transparency while converting everything to internal Quark format.
Transparency objects created in QuarkXPress are more likely to
retain their transparency appearance than placed PDFs that contain
transparency.

● When flattening, QuarkXPress 7and 8 rasterizes objects that are
below a transparent object. For example, transparency over a vector
EPS file will result in a rasterized version of the vector data with the
visual effect of the transparency. Because of this, for placed EPS
files with very fine features (such as small text), you should increase
the QuarkXPress flattening resolution in the output style.

● Using transparency and artificial font styles (such as artificial bold,
italic, outline, shadow) may not result in the correct output.
QuarkXPress 7 warns you about this when outputting.

● Using transparency with overprints (set in QuarkXPress or in placed
EPS files) does not work. Overprint objects often disappear or knock
out on output, when there is a transparent object on top of them.

Transparency with OPI

● OPI seems to work well with transparency when using bitmap-
based TIFF and raster EPS images. When an image interacts with
transparency, the QuarkXPress software renders the affected
portion of the image with its transparency effect, using the highest
resolution data available. QuarkXPress places the rendered version
of the image on top of the OPI placement, so when you trigger OPI,
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it places the unaffected image below the effected portion of the
image.

● Vector EPS files work with OPI but are rasterized in areas where
they interact with transparency.

● OPI does not work for file formats with low-resolution FPO/proxy
and DCS previews. The QuarkXPress software renders the
transparent effect using the low-resolution preview in the FPO and
DCS, because the high-resolution data is not available. These image
types will be low-resolution in areas where they interact with
transparency, even after the high-resolution OPI swap has taken
place.

Placed PDF files

As in earlier versions of the QuarkXPress software, placing PDF files
may not work correctly. Objects inside the PDF file that use overprints
or native unflattened PDF 1.4 transparency often don't output correctly
from QuarkXPress. If you need to retain the appearance of overprints
and transparency effects in a PDF file to be placed:

1. Open the PDF file in the Adobe Acrobat software.
2. Save the file in EPS format.
3. Place the EPS file (not the PDF file) in QuarkXPress.

Note: Placing a large, almost invisible, transparent object (for example, 0.1% tint)
over a PDF file forces the QuarkXPress flattener to rasterize the PDF, often with
better results.

Color recommendations

Use a DeviceN color setup, such as Composite CMYK and Spot, when
working with spot colors. However, this setting will convert LAB and
RGB images to CMYK. Quark's color management will convert RGB to
CMYK using the ICC profile specified in the color setup. If it is
important to preserve LAB and RGB images in their original color
spaces, select the As Is output option.

If you do not intend to color manage CMYK to CMYK conversions
during output and you are using QuarkXPress 7 Default or
QuarkXPress Emulate Legacy source setups, then no color conversion
would be performed on CMYK data. The reason no color conversions
would be performed in this case is because both default setups have
the Color Manage CMYK Sources to CMYK Destinations setting
disabled.

In order to preserve spot color information you need to use DeviceN
instead of composite CMYK output. To use DeviceN, click Edit > Color
Setups > Source. Click Duplicate to create a copy of the default setup.
In the CMYK tab, click Color Manage CMYK Sources to CMYK
Destinations, and save the setup with a new name.
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To set your global defaults to use DeviceN, click Preferences > Print
Layout > Color Manager > Source Options > Source Setup, and select
the source setup you created in this procedure.

Colorized TIFF files

● Colorized TIFF files used with OPI result in lost background color.
Instead, create the effect in Adobe Photoshop or output fat
PostScript.

● Multi-ink colorized TIFF files do not output correctly. In a fat
workflow, multi-ink colorized TIFF files are missing from the final
PDF file. In a thin workflow, they are converted to CMYK on thin
PDF output or are colored incorrectly in thin PostScript output.

Geometry from PostScript

● PostScript generated from the Print dialog results in incorrect
TrimBox geometry after refine in Prinergy. This was fixed in Prinergy
3.1.0.3.

● Bleed box in Quark7 PS is rotated. Exporting PDF from Quark
maintains the correct bleedbox. This was fixed in Prinergy 4.1.2.2.

● QuarkXPress 8 geometry issues that were fixed in Prinergy 4.1.2.2:

○ PostScript subpage (refined) rotated 90
○ PostScript missing trim and bleed after refine

● PostScript generated from QuarkXPress 8.01 Print dialog box results
in missing geometry (trim box and bleed box information). To
workaround this issue, export PDF from QuarkXPress instead of
using the Print dialog box. This was fixed in Prinergy 5.1.2.1.

QuarkXPress 6.5: Issues and observations

The QuarkXPress 6.5 software has issues with blends, QuarkXPress-
generated PDF files, colorized TIFFs used with OPI, and PDFs placed in
QuarkXPress.

● If you are running a Prinergy system only, an Invalid Restore error
from Prinergy normalize function may occur when refining DeviceN
color PostScript. This has been fixed in Prinergy 2.1.0.21 and later.
This was also an issue for older versions of the Distiller Assistant.
Workarounds included outputting as PDF from QuarkXPress 6.5, or
pre distilling using a newer version of the Distiller Assistant.

● Blends from QuarkXPress 6.5 may be subject to stepping, which is
abrupt shifts in tone. Blends are represented not as a single high-
quality shading object, but as multi object groups. Check for this by
viewing a QuarkXPress 6.5 PDF file in wire frame mode. This might
not be an issue for small blends, high-contrast blends, or lower-LPI
scenarios, but it may produce stepping effects in blends with subtle
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transitions over long distances. This might be fixed in a future
update of QuarkXPress 6.5.

● QuarkXPress-generated PDF files do not include trim box geometry
information. You must enter trim box geometry manually in
Prinergy Workshop or with the Acrobat Geometry Editor plug-in for
both Prinergy and Prinergy Evo. PostScript files from QuarkXPress
6.5 that are run through Prinergy Evo or a Distiller Assistant-
enabled Distiller, do not have this issue.

● Colorized TIFFs used with OPI result in lost background color.
● Placing PDFs in QuarkXPress 6.5 and outputting is somewhat

unpredictable if placing prepress-quality PDF files, because
overprints may get changed, resulting in lost traps.

New image filters in Quark 6.5

QuarkXPress 6.5 has these additional image filters: Vista and PSD
Import. In general, Creo recommends that the following conditions be
followed for these plug-ins:

● Vista-modified images: composite fat DeviceN output, or cautious
use of OPI.

● PSD-placed images: use composite fat DeviceN for most cases. If
PSD includes spot colors, use separated fat PostScript. Avoid use of
OPI.

Image Filters Test Results

Vista Xtension-Fat
Workflow

Separated fat PostScript output and Composite fat
PostScript using DeviceN PostScript output both y ield
good results.

Composite fat using CMYK colorspace might be
adequate for some CMYK-only jobs, but note that spot-
colorized TIFFs will be converted to CMYK.

VistaXtension-OPI
Workflow

Before generating thin PostScript, the user needs to
export images that have been modified by Vista, using
Render Picture Alterations option in the File > Save
Picture or Collect for Output dialog box in QuarkXPress.

If you create thin PostScript without exporting the
images, the resulting Prinergy subpage has incorrect
non-altered image information.

Colorized TIFFs lose their background colors after
refining. This is a known issue with QuarkXPress 6 thin
PostScript.
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Image Filters Test Results

PSD Import
Xtension-Fat
Workflow

Simple use of PSD files (turning layers on/off, turning
channels on/off, applying different opacities) works fine
with fat PostScript from QuarkXPress.

Alpha masks in PSD files work best with composite fat
output. (When using separated fat PostScript, the alpha
channel clipping path edge becomes a separate spot
color separation.)

Spot colors in PSD files do not work with composite
PostScript. Spot colors are changed to process colors,
even if using DeviceN output. Separated PostScript
works fine.

PSD Import
Xtension-OPI
Workflow

When document is output as thin PostScript and is
processed through Prinergy using OPI, "missing image"
errors occurs in Prinergy for some PSD images that have
alpha mask, alpha channel, and spot color channel.
Layers and channels that are turned off in QuarkXPress
are not represented in the resulting Prinergy subpage.

QuarkXPress 5: Issues and observations

The QuarkXPress 5 software has issues with the OPI XTension. Also,
you are still required to output colorized TIFFs in composite PostScript.

With regards to PostScript output, QuarkXPress 5.0 contains few
improvements over previous versions. No major problems are
introduced, but existing composite PostScript output issues are not
fixed. Some minor PostScript fixes are introduced, for example, stroke
overpints in composite PostScript. However, the Creo Color TIFF
XTension (formerly the Prinergy Print XTension) is still required to
output colorized TIFFs in composite PostScript.

Some new features have been introduced, including forms,
AppleScripting, and web page creation.

However, a Prinergy-specific problem regarding the OPI XTension has
also been introduced. The OPI XTension allows QuarkXPress to output
OPI 2.0 comments. If using this extension with Prinergy OPI, the Usage
dialog box has an OPI pane that enables you to turn off specific images
for OPI. When printing thin PostScript, QuarkXPress creates PostScript
with the OPI 2.0 comment "IncludedImageQuality: 3.0", which
indicates that the OPI system should NOT attempt to merge the image.
However, Prinergy will still incorrectly attempt to perform the OPI
merge. To work around this problem, remove the OPI XTension, or do
not disable specific images for OPI in the Usage/OPI dialog box.

Also note that if the OPI XTension is active, you cannot create a
Composite Thin or Composite Fat Print Style in QuarkXPress.
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PostScript versus PDF

In most cases with QuarkXPress 7 and later, PDF output is as good as
PostScript output.

In QuarkXPress 6 and earlier, there are clear benefits to outputting
PostScript files rather than PDF files.

In all versions of QuarkXPress, PostScript output can give a better final
result in the following situations:

● When placing a PSD file with an alpha mask
● When a transparency interacting with a placed PDF file results in

medium-quality JPEG compressed images

Also, you will need to prepare separated PostScript from QuarkXPress
if:

● You want to maintain QuarkXPress traps.
● You are using QuarkXPress 5.x or later and are using TIFF files that

are colorized with spot colors and are not using the colorized TIFF
XTension. (This is no longer necessary with QuarkXPress 6.x or
later DeviceN output.)

● You have placed DCS files and either want to work "fat" or the DCS
is vector-based or a format that cannot be merged by Prinergy OPI.

● You are encountering a problem with composite PostScript from
QuarkXPress.

Outputting a PDF using Export

This is the recommended method of outputting QuarkXPress files. This
method is available in QuarkXPress 7 and later.

Requirements: Ensure that in the Preferences dialog box, in the PDF
tab, you have selected Create PDF.

1. In the QuarkXPress software, open the document.

2. Select File > Export > Layout as PDF.

3. Select the PDF style that you want to use.

138 Chapter 7—Input files



Outputting a PostScript file using Export

If you choose to output to PostScript instead of to PDF from
QuarkXPress, we recommend that you use this method to generate the
output. This method is available in QuarkXpress 7 and later.

1. In the QuarkXpress software, open the document and click
Preferences.

2. In the Preferences dialog box, in the PDF tab, click Create
PostScript file for Later Distilling.

3. Select File > Export > Layout as PDF .

A PostScript file is created.

Outputting a PostScript file using Print

Use these procedures if you want to generate output from
QuarkXPress using the Print dialog box (instead of using the Export
option). This is the traditional method of outputting QuarkXPress files.

1. Downloading the Refiner PPD
If outputting PostScript files from QuarkXPress for the Prinergy or
Prinergy Evo refiner, configure your printer drivers or software to
use the Prinergy Refiner PPD, which supports color devices.

2. Setting up a PostScript printer
Setup a PostScript printer to use the Prinergy Refiner PPD for
creating a PostScript file of your job from your original authoring
software, such as QuarkXPress. You can use an actual or virtual
PostScript printer to create a PostScript file.

3. Printing to a PostScript file from QuarkXPress 7 and 8
After downloading the refiner and setting up a PS printer, use this
procedure to print a PS file from QuarkXPress 7 or 8.

4. Relevant Options for Printing to PS
Use the following settings when printing QuarkXPress files to
PostScript for Prinergy.

Downloading the Refiner PPD

If outputting PostScript files from QuarkXPress for the Prinergy or
Prinergy Evo refiner, configure your printer drivers or software to use
the Prinergy Refiner PPD, which supports color devices.

Requirements:

Note: The Prinergy Refiner PPD file comes with the Prinergy Evo Client software.
See the Prinergy Evo Installation guide for more information.

If you prefer, you can use Imation's Prepress Xtension instead of the
Prinergy Refiner PPD file.
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1. In a Web browser, go to https://ecentral.creo.com/.

2. Click Self Support > Downloads.

3. Select a product. For example, Prinergy Connect.

4. Enter the search word: ppd.

5. Click Go.

6. Select the Prinergy Refiner PPD file, and uncompress and copy the
file to the following location on your Macintosh hard drive:
Library\Printers\PPDs\Contents\Resources
\en.lproj.

Setting up a PostScript printer

Setup a PostScript printer to use the Prinergy Refiner PPD for creating a
PostScript file of your job from your original authoring software, such
as QuarkXPress. You can use an actual or virtual PostScript printer to
create a PostScript file.

Requirements: You must have downloaded the Prinergy Refiner PPD
file.

Note: If installing Prinergy Evo Client software, see the Prinergy Refiner PPD
installation README taht comes with the Prinergy Evo Client installation image.

1. Start the Mac Printer Setup Utility software located at:
Applications\Utilities\Printer Setup Utility.

Note: In Mac OS X version 10.2, this is Print Setup. In Mac OS X version
10.3, this is PrinterSetupUtility.

After starting the Printer Setup Utility, the list of printers that are
currently installed appears.

2. Click Add.

3. In the list, select IP Printing. In the Printer's Address box, type
localhost.

4. Clear the Use default queue on server check box.

5. Enter a Queue Name that is the name of the new printer, for
example, PostScript.

6. In the Printer Model box, select Creo Products.
Prinergy Refiner appears in the Model Name box.

7. Click Add and exit the Printer Setup Utility.

You are now set up to create a PostScript file of your job from your
original authoring software.

140 Chapter 7—Input files



Printing to a PostScript file from QuarkXPress 7 and 8

After downloading the refiner and setting up a PS printer, use this
procedure to print a PS file from QuarkXPress 7 or 8.

1. In the QuarkXPress software, open the document and click File >
Print.

2. Click Printer, and click OK in the message dialog box.

3. In the Print dialog box, click PDF and select Save PDF as PostScript.

4. In the Save dialog box, save the file to the desired location and
name. Click Save.

5. In the Print dialog box, on the Device tab, in the PPD box, select
Prinergy Refiner.

6. On the Color tab, in the Mode box, select Composite. In the Setup
box, select As is. Select the appropriate options for OPI, marks, and
other aspects. See Relevant Options for Printing to PS on page 141.

7. Click Print.

Relevant Options for Printing to PS

Use the following settings when printing QuarkXPress files to
PostScript for Prinergy.

Device Options

PPD Prinergy Refiner PPD

Paper Size Custom as desired

Resolution 2400 dpi

Color Options

Mode Composite

Setup As is

See notes on Color Recommendations.

Picture Options

Output Normal

Ful resolution TIFF output ON

Resolution 2400 dpi

Font Options

Select All ON

Note: We recommend that you always include or embed fonts in the PostScript
files.

Printing to a PostScript file from QuarkXPress 7 and 8 141



Registration Marks Options

Mode Centered

Width and Height As desired

Note: Include registration marks when preparing your PostScript files. Select either
Centered or Off Center. These marks will automatically be applied when the file is
refined. You will be able to view and modify the settings using Prinergy's
Geometry Editor plug-in to Adobe Acrobat and the Set Page Geometry dialog box.

Layer Options

Select All ON

Transparency Options

Ignore Transparency Flattening ON

OPI Options

OPI Active OFF for hi-res output

ON for lo-res output. Set Tiff Options
and EPS Options as OFF. (Don't
include images.)

ON for image proxy output. Set Tiff
Options and EPS Options as ON.
(Include images.)

Advanced Options

PostScript Level Level 3

Setting Up Output Styles

In QuarkXPress, you can set up output styles for PDF and PostScript
files, such as fat composite or thin separated.

Output styles make it easy to create consistent PostScript and PDF
files and help to reduce errors when configuring the Print dialog box.

1. In QuarkXPress, select Edit > Output Styles.

2. In the Verification list, select None, PDF/X-1, or PDF/X-3.

3. On the Pages, Metadata, and Hyperlinks tabs, select the options
that you want.

4. On the Compression tab:

○ For color and grayscale images, in the Compression box, select
Manual ZIP (8-bit), and in the Resolution box, select 300.

○ For monochrome images, in the Compression box, select CCITT
G4, and under Resolution, select the Compress Text and Line
Art option.
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5. On the Color tab:

a. In the Mode box, select Composite.
b. In the Setup box, select Composite CMYK and Spot or a similar

DeviceN color setup. (To access color setups in QuarkXPress,
select Edit > Color Setups > Output.

6. On the Fonts tab, select the Download all fonts option.

7. On the Marks tab, in the Registration marks mode box, select
Centered.

8. On the Bleed tab, select 0.25 inch.

9. On the Transparency tab:

a. Ensure that the Ignore transparency flattening check box is
cleared. (Required).

b. In the Transparency flattening resolution box, select 300 dpi,
OR

If job quality requires higher resolution, select 600 dpi. You can
then choose to either retain the 600 dpi resolution from
QuarkXPress, OR use Prinergy (Optimize pane) to downsample
the 600 dpi image to 300 dpi.

Retaining the 600 dpi resolution from QuarkXPress provides a
better quality result than using Prinergy to downsample. The
300 dpi anti-aliased result will render better than the 300 dpi
result that you get from QuarkXPress

10. On the OPI tab, select the options that you want.

For a thin workflow, select the OPI Active option, and do not select
the TIFF Include Images, Low Resolution, and EPS Include Images
options.

11. On the JDF tab, select the options that you want.

Adding and deleting files

About adding and removing files

Input files are those files received from your customer (the print buyer)
that make up the content of the publication being printed. Once you
have created a job for the publication, you can add input files to the job.
You must add input files to the job before you can begin processing
them.

Preparing customer files

For information on how to prepare specific formats of customer files,
see About Preparing Customer Files. For a list of the input formats
supported, see About Supported Input File Types.
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For information about setting to use in specific creative software, see
About FreeHand, About Illustrator, About InDesign, About PageMaker,
About Photoshop, and About QuarkXPress.

For information about recommended Distiller settings, see Acrobat
Distiller 4, Acrobat Distiller 5, Acrobat Distiller 6, Acrobat Distiller 7,
and Acrobat Distiller 8.

For detailed information about specific file types, see Copydot scans
and DCS files, CT/LW and TIFF/IT, Duotones, PDF, and About
Transparency Support in Prinergy 4.

Adding files to a job

You can add files manually using the Add Input File menu item or
automatically by using a hot folder. You can also add files by dragging
them from a file browser into Job Manager.

Source of input files

When you add files to the job, you are creating an entry in the database
referencing the location of the files. Therefore, you can store input files
on any input volume; you do not have to copy the files to the job folder
in order to add them to the job. (We recommend that you store the
input files for a job in the job folder, but this is not required.)

Input files and archiving

When you archive the job, a copy of the original input files is archived
along with the job.

When you add input files using a hot folder, the input files are stored in
the <job folder>\HotFolders\Processed folder. When you
archive the job, the input files are archived along with the job.

Removing files

You may need to remove an input file that you have added to a job—for
example, if you added the wrong file or you discover a problem with
the file and want to fix and re-add it.

You can delete a page from a job without deleting the input file from
which it was generated. However, you must remove both the original
input file and any pages generated from that input file before you can
re-add the same input file or another input file of the same name.
Alternatively, if you do not want to delete the pages associated with
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the input file, you can rename the input file before re-adding it to the
job.

See also:
About preparing customer files on page 125
About supported input file types on page 126
About FreeHand on page 126
About Illustrator on page 127
About InDesign on page 128
About PageMaker on page 128
About Photoshop on page 129
About copydot scans and other DCS files on page 129
About duotones on page 130
CT/LW and TIFF/IT files on page 153
PDF files on page 160
About transparency support on page 163
About recommended Acrobat Distiller 8, 9, and X settings for
content on page 165

Adding input files using the menu

Requirements: Ensure that the job to which you want to add input files
is open in Job Manager.

1. Perform one of the following actions:

○ From the File menu, select Add Input Files.
○ Right-click a blank area of the Input Files pane and select Add

Input Files.

2. In the Add Input Files dialog box, in the Select Files to Add section,
browse to and select the input files that you want to add.

Tip: The dialog box remembers the location that you last navigated to before
closing the dialog box.

3. Perform one of the following actions:

○ Click Add Selected to add the selected files.
○ Click Add All to add all of the input files in the open folder.

4. If you want to automatically process the files to be added, select
the Process Selected Files using Process Template check box, and
click Select to choose a process template.

5. Click OK.

The added files appear in the Input Files pane of Job Manager.

Adding input files using the menu 145



Adding input files using drag-and-drop

Requirements: Ensure that the job to which you want to add input files
is open in Job Manager.

1. Select a file (or files) from any location—your workstation desktop,
a USB storage device, a DVD, across the network file system, or
somewhere on the Prinergy volume.

2. Drag-and-drop the files either into the Input Files pane or onto a
process template in the Process Templates pane.
The Add Input Files dialog appears, listing the files that were
dragged and dropped.

3. (Optional) Select the Exclude invalid file types if some of the
selected files are not valid input files.

Note: Invalid files appear with a yellow warning icon.

4. If the files are from a location other than the Prinergy volume, enter
the path or browse to a location on the Prinergy volume where you
want the input files to be copied, in the Copy Path box.

Tip: The path that appears by default is %JOB%\UserDefinedFolders—a
relative path that copies files to the UserDefinedFolder folder in the
current job. It is possible to configure a different default copy path in Prinergy
Administrator.

Note: It is not mandatory to have a copy path if the files are already located on
the Prinergy volume. If you clear the Copy files to Prinergy volume check box,
the files will be registered and added to the job.

5. If you want to automatically process the files to be added, select
the Process Selected Files using Process Template check box, and
click Select to choose a process template.

Note: If you dropped the file directly onto a process template, the Add Input
Files dialog has the Process Selected Files using Process Template check box
selected, and the name of the process template populated.

6. Click OK.

The added files appear in the Input Files pane of Job Manager.

Note: If you drag and drop a file with the same name as one that has already been
added to the job, you will see a message asking whether to overwrite the existing
file. If you overwrite the file, the new file will not be re-registered or re-processed.
It is recommended to remove the original file with all its corresponding pages from
the job before dragging and dropping a new version.
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Adding input files using a hot folder

1. Open the job.

2. Create a hot folder for the job.

3. Add files to the hot folder.

The result depends on the type of files and the type of hot folder.

Removing input files

You remove input files and delete pages.

1. In the Input Files pane of the Pages or Signatures view, select the
input files.

2. From the File menu, select Remove Input, or right-click the files and
select Remove Input.

Deleting pages

You remove input files and delete pages.

1. In the Pages pane of the Pages or Signatures view of Job Manager,
select the pages.

2. From the File menu, select Delete Page, or right-click the files and
select Delete Page.

Add Input Files dialog box

The Add Input Files dialog has different options available, depending
on whether you are adding the files using the Add Input File menu item
or whether you are dragging and dropping files from a file browser into
Job Manager.

Options available when selecting input files to add

Select Files To Add

Use the lists in this section to browse to and select the input
files that you want to add to the job.

Files of Type

Select an option to filter the files that are displayed in the Select
Files to Add section by a specific file type. Only files of the
selected type are displayed.
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Options are:

● All Eligible Files
● All Files
● PostScript (PS)
● Encapsulated PostScript (EPS)
● Portable Document Format (PDF)
● Tagged Image File Format (TOF, TIFF, TIFFIT, TIFF-IT)
● Desktop Color Separation (DCS)
● Brisque Page (ASSG, CH, CT, LW, NLW, NCT)
● Variable Data Files (PPML, VDX, VPS)
● JPEG (JPG, JPEG)

By default All Eligible Files is selected. An eligible file is any file
of any of the types listed above.

Show Hidden Files

Select this check box to include hidden files, such as system
files, in the results.

You can set the default selection of this check box on the View
tab of the Workshop Preferences dialog box.

Select All Includes Subfolders

Select this option and then click Add All to include all of the
input files in the open folder and all of its subfolders in the Files
to Add box.

Volumes

Displays all volumes in the Prinergy system.

Job Folder

Opens the job folder for the current job.

Open

Opens the selected item.

Add Selected

Displays selected files in the Files To Add box.

Add All

Displays all files in the open folder in the Files To Add box.

Remove Selected

Removes the selected files from the Files To Add box.
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Remove All

Removes all files from the Files To Add box.

Files To Add

Lists the input files that you have selected to add to the job.

Process Selected Files using Process Template

Select this check box to automatically refine the selected files
you are adding to the job. For information on the process
template to be used to process the files, click the Select button.

Options available when dragging and dropping input files
into Job Manager

These options are available whether you dropped the input files into
the Input Files pane or onto a process template in the Process
Templates pane.

Files To Add

Lists the input files that you have dragged and dropped into Job
Manager.

Exclude invalid file types

When this check box is selected, the invalid file types in the list
are grayed out, and are not copied and registered in the job.

Remove Selected

Removes the selected files from the Files To Add box.

Copy files to Prinergy volume

If the files are from a location other than the Prinergy volume,
this option is selected by default, so you can copy the input files
to the Prinergy volume. If the files are located on the Prinergy
volume, you have the option of copying the files to a different
location on the Prinergy volume.

Copy Path

Enter the path or browse to a location on the Prinergy volume
where you want the input files to be copied.

Overwrite all files with same name

If this check box is selected, if the destination directory contains
input files with the same names, the copied files will overwrite
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those existing files. No warnings appear. If this check box is not
selected, a message dialog will ask you to confirm whether you
want to overwrite the existing files.

Note: If you overwrite a file, the new file will not be re-registered or re-
processed. It is recommended to remove the original file with all its
corresponding pages from the job before dragging and dropping a new
version.

Process Selected Files using Process Template

Select this check box to automatically refine the selected files
you are adding to the job. If you dropped the file directly onto a
process template, this check box is automatically selected, and
the name of the process template populated.

Correcting input files

About correcting input files
There are different ways to revise or correct a subset of pages from a
multi-page document.

The approach you choose is dictated by the file format of the original
job and the number of pages that need to be revised.

You can revise or correct pages either after refining or after page
assignment.

Overwriting all pages in a file (multiple-pages-per-file original)
If the original file has multiple pages and many of the pages need
corrections, you can create a corrected input file that includes all of the
pages, similar to the original. When it is refined, all of the original pages
are overwritten. Page assignments are preserved.

This approach may not be appropriate if manual edits were made to
some of the pages—for example, manual traps, PDF edits, and so on.
Manual edits are overwritten when the entire set of pages is
overwritten. This approach may also be inappropriate if the file takes a
long time to write out of Quark or InDesign, or a long time to refine in
Prinergy.
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1. Correct the pages in the source software, and create a new PDF file
that includes all of the pages.

2. Refine the new input file.

○ If the original file was added using a hot folder, drop the revision
file with the same name into the hot folder.

○ If the original file was added manually in Workshop, overwrite
the original file on disk with the revision file, and refine the
revision file from Workshop. There is no need to re-add the file
to Workshop.

Existing pages are overwritten. Page assignments are preserved.

Example

The original job file is book.pdf and it contains pages 1
through 98. Refining it in Prinergy creates the files
book.p1.pdf through book.p98.pdf.

The corrected file is also called book.pdf and contains
pages 1 through 98. Refining it in Prinergy creates the files
book.p1.pdf through book.p98.pdf. This
overwrites the existing refined pages and keeps any
existing page assignments.

Overwriting individual pages (multiple-pages-per-file original)
If the original file has multiple pages and a limited number of pages
need corrections, you can create corrected input files with new names
that each have one page per file. When the pages are refined, the
original pages are not overwritten. Page assignment must be redone for
the corrected pages.

In this approach, the original pages are preserved, but the corrected
files are assigned to the page set and are output to plate. The benefit of
this approach is that the original pages are present and can be referred
to. However, this may cause confusion because there are multiple
copies of a page.

1. Create the corrected pages so that there's a single page in each file.
Ensure that you use a consistent, predictable naming convention.

2. Refine the new file(s).
The existing pages are not overwritten. Page assignments are not
preserved.

3. Assign the revised pages to the page set either manually or using
APA.

Example

The original job file is book.pdf and contains pages 1
through 98. Refining it in Prinergy creates the files
book.p1.pdf through book.p98.pdf.
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The corrected files are named with a convention that lists
their page number, such as book.RevPage2.pdf and
book.RevPage74.pdf. Refining them in Prinergy
creates the files book.RevPage2.p1.pdf and
book.RevPage74.p1.pdf.

By default, Prinergy does not automatically assign the
revised pages to the existing page set. The revised pages
can be assigned manually or automatically by refining the
new file with APA. For the example above, the APA
pattern would be ASSIGN=
"[$].RevPage[#Position].p1.pdf" "*"
[#Position] 1.

Overwriting individual pages (single-page-per-file original)
If the original files each have one page and a limited number of the
pages need corrections, you can create corrected input files that each
have one page per file. When the pages are refined, the original
incorrect pages are overwritten. Page assignments are preserved.

This approach makes page revisions indistinguishable from pages
without revisions in the final job.

1. Create the corrected pages so that there's a single page in each file.
Use the same naming convention as the original pages.

For instructions, see Splitting a multi-page PDF file into single pages.

2. Refine the new files.
The existing page is overwritten. Page assignments are preserved.

Example

The original job files are book.page1.pdf through
book.page98.pdf. Refining the job in Prinergy creates
the files book.page1.p1.pdf through
book.page98.p1.pdf.

The corrected files are called book.page2.pdf and
book.page74.pdf. Refining them in Prinergy creates
the files book.page2.p1.pdf and
book.page74.p1.pdf. This overwrites the existing
refined pages and keeps any existing page assignments.

See also:
Splitting a multi-page PDF file into single pages per file using
Acrobat on page 153
Splitting a multi-page PDF file into single pages per file using
QuarkXPress or InDesign on page 153
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Splitting a multi-page PDF file into single pages per file
using Acrobat

Use Acrobat to change a multi-page input file into multiple single-page
files before bringing it into Prinergy.

1. Create a multi-page PDF.
2. Using the Extract pages function in Acrobat, split the PDF into

single-page PDF files. If necessary, rename the files to the desired
naming convention using a third-party tool like 
ABetterFinderRename. There is a minor cost associated with this
tool.

Next: Make corrections to the job by overwriting a single page.

See also:
Overwriting individual pages (single-page-per-file original) on page 152

Splitting a multi-page PDF file into single pages per file
using QuarkXPress or InDesign

Use the QuarkXPress or InDesign software to change a multi-page job
into multiple single-page files before bringing it into Prinergy.

Requirements: This may require a third-party utility.

Follow the instructions for the software that you're using:

○ For InDesign—http://indesignsecrets.com/page-exporter-
utility-peu-5-script-updated-for-cs3.php. New files use the
naming convention <filename>.P02.pdf.

○ For QuarkXPress 7—From the Edit menu, select Output Styles.
Select the PDF Output Style that you want to use. In the Pages
pane, select Export pages as separate PDFs. New files use the
naming convention filename (Page 02).pdf.

○ For QuarkXPress or InDesign—http://
exportools.badiasoftware.com

Next: Make corrections to the job by overwriting a single page.

See also:
Overwriting individual pages (single-page-per-file original) on page 152

CT/LW and TIFF/IT files

About processing CT/LW and TIFF/IT files

The CEPS Conversion section of a refine process template defines how
Prinergy handles Brisque CT/LW or TIFF/IT-P1 input files. The CEPS
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JTP can be used to convert CT/LW and TIFF/IT to PDF files consisting
of two layers: continuous-tone (CT) and line work (LW).

General guidelines for using CT/LW files with Prinergy

For best results, follow these general guidelines when using CT/LW
files with Prinergy:

● Perform as much of the page preparation as possible in the
originating workflow/RIP to reduce the potential for introducing
errors. For example, perform color conversion, including spot color
handling and overprint settings, and trapping on the Brisque before
importing CT/LW files into Prinergy.

● Simplify the linework components for faster processing through
Prinergy. For example, try to avoid CT content in the LW file. If you
are working with TIFF/IT pages, avoid or simplify high resolution
contone (HC) components to obtain faster Prinergy processing
times.

● If you use Kodak Full Auto Frame (FAF)/RIP templates to create
CT/LW pages in the Brisque, use a specific template to create CT/
LW output that is optimized for use with Prinergy. For example, this
template could have the resolution set to match the Prinergy output
device resolution. This output template should also RIP vignettes to
the CT layer instead of the LW layer.

● When refining files with the CEPSConversion JTP, ensure that all the
page elements, for example, CT/ICT, LW/HC/ILW, ASSG/FP/IFP,
and so on, are available before starting the refine process in
Prinergy. If elements are missing, the refine process fails.

Preparing CT/LW and TIFF/IT files

When submitting CT/LW or TIFF/IT files to Prinergy software:

● Ensure that files are trapped and color-matched.
● Ensure that the CT/LW and TIFF/IT files are one of the following

file types:

○ CT/LW files generated by Brisque or PS/M
○ TIFF/IT-P1 files

● For CT/LW files, ensure that you add the ASSG, CT, and LW files to
a Prinergy job at the same time.

● For TIFF/IT-P1 files, ensure that you add the FP, CT, and LW files to
a Prinergy job at the same time

Note: If you are using the CEPS JTP to convert files to PDF, ensure that the input
resolution matches the desired output resolution. For example, when the desired
output is 2400 dpi, use the CEPS JTP with line work resampled to 2400 dpi.
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Merge separated CT/LW pages on the Brisque

Merge separated CT/LW pages on the Brisque before sending the
pages to Prinergy for processing. You can identify separated CT/LW
pages by their multiple LW files. The CEPS JTP and other products
such as CEPSLink cannot process separated CT/LW pages. To merge
separated CT/LW to composite CT/LW, use the Merge function on
the Brisque or PS/M before bringing the pages into Prinergy for
processing.

This function has no visible impact on final output and is recommended
for use with all separated CT/LW files.

There are two reasons why the CT/LW pages may be separated:

● Separated PostScript going into the Brisque may cause CT/LW
pages to be separated. This is the most common cause.

● Too many LW colors may cause CT/LW pages to be separated.
There is a limit of 64,000 colors in the NLW specification. If the
NLW is very complex, then the Brisque may have separated the CT/
LW. If you can't merge the CT/LW because of this limitation, then
you should try some of the other techniques, such as RIPing
vignettes to CT. This avoids separating the CT/LW as well as
improving output performance.

Detect excessively complex pages

There is a class of very complex pages that may still fail conversion in
the CEPS JTP. You can identify these pages by:

● CT/LW that is separated (multiple LW files) and that fails merging
to composite on the Brisque, or

● TIFF/IT with an HC file that cannot be opened in Kodak PressTouch
(a free download from eCentral).

There are two situations which can result in these very complex pages:

● Complex page characteristics combined with inappropriate RIP
choices can result in these very complex pages. Choosing different
RIP settings, as outlined later in this topic, may resolve this.

● PDF 1.4 style transparency using layered CTs can result in these
very complex pages. This can create many CT-to-CT edges. RIPing
CT-to-CT borders to CT resolution resolves this.

Unsupported types of CT/LW and TIFF/IT

If your files are not of the file types specified above—for example, if
your files are PS/2, Whisper, or Linotype-Hell—you must convert them
before Prinergy can use them.

You have the following options:
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If You Have Then

CT/LW files that the
CEPS JTP cannot use

Use the Translate function on the Brisque to convert
the files to a Brisque CT/LW file.

CT/LW or TIFF/IT files
that the CEPS JTP cannot
use

Use CEPSLink software or a third-party product to
convert them to PDF files or another format that
Prinergy recognizes.

For existing DCS files for which the CT/LW file is unavailable, see 
About copydot scans and other DCS files on page 129.

Using Enfocus PitStop to change color recipes

Enfocus PitStop handles CT and LW layers differently when you use it
to change color recipes in PDF files. For CT layers, Enfocus PitStop
displays only the color of the current selection; you can make color
retouches to the layer, but you can't change the color recipe. For LW
layers, Enfocus PitStop displays both the source and target color, so
you can change the color recipe. For more information, see the Enfocus
PitStop documentation.

Sample recommendations for processing CT/LW

These are sample recommendations for RIPing CT/LW through
Prinergy to a 2400 dpi device.

Option Advantages Potential Drawbacks When to Use

RIP: LW resolution =
2400.0 dpi (94.48819
dpm)

Reduces the potential
to introduce artifacts

None if page is RIPed to
correct resolution. May
result in very slight image
quality degradation if
resampling at conversion
stage.

Always (recommended)

RIP: CT resolution =
300.0 dpi

Reduces the potential
to introduce artifacts
when using PDF2Go on
Brisque 3

May result in very slight
image quality degradation

Always when using PDF2Go
on Brisque 3

RIP vignettes to CT
layer, not LW layer

Speeds up processing
time in Prinergy

May result in very slight
image quality degradation

Always (recommended)

In the Brisque RIP, set
CT on CT Border to CT
Res

Speeds up processing
time in Prinergy

In the final output, may
result in fuzzy edges where
contone images overlap

When processing speed is
more important than crisp
edges in the final output, or
when a page is too complex
to refine otherwise

In the Brisque RIP, set
Screen Grabs to CT
Res

Speeds up processing
time in Prinergy

In final output, may result in
fuzzy text in screen
captures

When processing speed is
more important than clearly
defined text in screen
captures
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Option Advantages Potential Drawbacks When to Use

Avoid running copydot
content through
Brisque

Speeds up processing
time in Prinergy and
eliminates several
opportunities to
introduce moiré
artifacts. Allows use of
Copydot JTP.

Partial page copydot inputs
might require Brisque
processing. Copydot must
be correct resolution prior
to entering Brisque.

Whenever possible
(recommended)

Avoid HC components
when creating TIFF/IT
sets. If you must
include HC
components, try to
minimize the amount
of data that they
contain.

Speeds up processing
time in Prinergy

Final output quality may be
affected. Specifics depend
on page characteristics.

When processing speed is
more important than various
aspects of final output
quality

About TIFF input files

The normalize function accepts the following TIFF Input Files:

● 8-bit TIFF files (composite as well) created in Adobe Photoshop
software, including files in grayscale, RGB, and CMYK color spaces.

● 1-bit Photoshop TIFF files (bitmaps)
● TIFFs with spot channels
● L*a*b* with indexed color spaces
● whole image and tile formatting.

The normalize function does not support 1-bit and 8-bit TIFF files from
third-party workflows and software.

About enhancing processing of CT/LW files

Prinergy takes longer to process raster-based files than vector-based
pages. However, there are some steps you can take to improve
performance when processing through Prinergy.

Among the settings that affect performance, there are some that may
adversely affect image characteristics. For example, an option may
result in blurry edges where contone images overlap, or fuzzy text in
screen shots. Evaluate whether the benefits of increased performance
outweigh the potential drawbacks.

RIP vignettes to the CT layer (not the LW layer)

When creating the CT/LW file using the Brisque RIP, RIP the vignettes
to the CT layer not the LW layer. RIPing vignettes to the CT layer
speeds up processing in Prinergy.

About TIFF input files 157



To RIP vignettes to the CT layer, enable the following settings in the
Vignette Handling window in the Brisque RIP pane:

● Scitex Vignettes
● Vignette to CT (CMYK)
● Convert Vignette to PS3

This option has minimal visible impact on final output and is
recommended for use with all CT/LW files.

Set CT on CT border to CT Res in the Brisque RIP

To increase Prinergy processing performance, in the CT Handling
window in the Brisque RIP pane, set CT on the CT Border to CT Res.

This may negatively affect your final output quality, resulting in fuzzy
edges where contone images overlap. Implement this option only if this
reduced output quality is acceptable.

Note: If the Brisque template that you are using contains a Kodak Full Auto Frame
(FAF) trapping atom as well as the RIP atom, you might have to change the FAF
settings in order to be able to select CT Res at the RIP stage.

Set Screengrabs to CT Res in the Brisque RIP

To increase Prinergy processing performance, in the CT Handling
window in the Brisque RIP pane, set Screengrabs to CT Res.

This may negatively affect your final image output quality, resulting in
fuzzy text in the screen captures. Implement this option only if this
reduced output quality is acceptable.

Avoid HC components when creating TIFF/IT pages

If possible, avoid creating HC (high-resolution contone) files when
creating TIFF/IT pages. HC components may process very slowly
through Prinergy. If you must include HC components, try to minimize
the amount of data that they contain. For example, avoid photograph-
like content. Text and flat tints in the HC are acceptable. Specific
instructions for avoiding HC components, or minimizing the amount of
data included, are software dependent.

Some general guidelines to follow are:

● Set CT on CT borders to CT Res. HC components may be created
when high-resolution borders exist between contone images.

● RIP vignettes to the CT layer.

As with the CT/LW file format, these settings may negatively affect
the output, depending on page characteristics. Use these settings only
if the benefits of increased performance outweigh the drawbacks.
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About eliminating artifacts when processing CT/LW files

Raster-based files can be prone to artifacts on the final output without
proper page preparation. (An artifact is an unexpected element, usually
a single-pixel black or white line.) High-resolution loose page proofs
may not show artifacts, although a high-resolution imposition proof
often does. Here are some recommendations for reducing artifacts.

Ensure that LW and output resolution match when imaging

Before submitting pages for final output, make sure that the LW
resolution matches the final output device resolution. If the LW
resolution doesn't match the output device resolution, Prinergy must
resample the LW data at the output stage, which may introduce
artifacts.

You can set the LW output resolution on a Brisque when creating CT/
LW pages. For example, if you are outputting to a 2400 dpi Kodak 
Trendsetter platesetter, RIP your pages to CT/LW with the LW
resolution set at 2400.0 dpi (94.48819 dpm). Or, you can set the LW
by refining the CT/LW file with a refine process template with the
CEPSConversion JTP enabled and set to resample at the appropriate
LW resolution. Use the Prinergy Process Template Editor to create or
edit a refine process template.

RIPing to the device resolution has no visible impact on final output and
is recommended for use with all CT/LW files. Setting the LW
resolution on a Brisque, that is, creating CT/LW at the correct
resolution, is preferable to setting it in Prinergy where you resample to
correct resolution at the conversion stage. Resampling to at the
conversion stage may have a slight visible impact, since resampling
errors may occur.

Avoid running Copydot pages through the Brisque

A copydot page that was run through the Brisque is susceptible to
moiré artifacts unless extreme care is taken.

Using the CEPS JTP

LW resolution: If possible, RIP LW to 2400 dpi (94.48819 dpm).
Always resample at the CEPS JTP stage of your refine process template
to ensure the resolution is correct.

Using PDF2Go on Brisque version 3

CT resolution: Should be set to a dpi that converts easily into
PostScript points. Recommended settings in dpi are: 300 dpi (11.81102
dpm), 320, 360, 375, 400, 450, 480, 500, 576, 600, 720, 750, and
800. This option may have a very slight negative impact on your final
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output quality, due to lowered CT resolution. If possible, RIP CT to 300
dpi. Always resample at the PDF2Go stage as well, to ensure that the
resolution is correct.

LW resolution: If possible, RIP LW to 2400 dpi (94.48819 dpm).
Always resample at the PDF2Go stage to ensure that the resolution is
correct.

Using PDF2Go on Brisque version 4

LW resolution: If possible, RIP LW to 2400 dpi (94.48819 dpm).
Always resample at the PDF2Go stage to ensure that the resolution is
correct.

Using ExportPS – Any Version

ExportPS is not currently recommended for bringing pages into
Prinergy. However, if using ExportPS, extreme caution must be taken at
the RIP stage, that is, at CT/LW creation, to ensure that the LW
resolution matches the intended device resolution, for example, 2400
dpi (94.48819 dpm). This is because ExportPS does not resample the
page. Sending an ExportPS page with the wrong resolution for output in
Prinergy, that is, resampling at the output stage, can introduce
artifacts.

Using the PostScript Bypass feature will enable you to avoid artifacts
on final output when importing ExportPS DCS files into Prinergy.
Contact your Kodak representative to set this up.

About moving CT/LW data around the network

Select the entire job folder to copy, not just the individual page
components or files.

Selecting the contents of the job folder instead of the folder itself and
copying the files to removable media results in a page that cannot be
processed because the assign file for the job is missing. The assign file
is located within the folder structure but is not visible on the Mac or
Brisque. If you are using a Brisque or a PS/M version 5 or later, it
automatically creates a hidden assign file when RIPing. The assign file
is necessary for processing the CT/LW page.

PDF files
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About PDF input files

PDF files can be used as input for a Prinergy workflow. These PDFs can
come from several sources:

● Saved directly out of creative software such as InDesign,
QuarkXPress, Illustrator, or Photoshop

● Created by distilling PostScript files from most creative software
using Acrobat

● Created by a PDF creation tool or suite such as Kodak Prepare
software

PDF or PostScript?

Saving creative work to a PDF file can have varying results depending
on the software and the features used to create the file.

Note: When Prinergy Workshop is installed, the system places some settings files
in the Acrobat Distiller folder. One of these files contains recommended
settings for Acrobat Distiller for distilling page and sheet mark PostScript files to
create PDF un-imposed marks files.

Separated PostScript

Separated files are locked down in terms of overprints and colorbreaks.
Composite files allow you to color manage and trap them.

Even though we recommend composite PS/PDF as input to Prinergy,
customers can still use separated files as input. However, distilling
separated PostScript can produce unwanted results in Prinergy
workflow, in that Distiller sometimes has difficulty determining the
color of the separated pages. When this file is brought into Prinergy,
Prinergy splits each separated page into its own subpage element. You
can overcome this issue by using the Separations Repair Acrobat plug-
in on the file before bringing it into Prinergy.

Advanced attributes

PDF 1.4 Transparency: Prinergy supports transparent objects in digital
masters.

PDF 1.5 Layers: Prinergy supports layered input files. For Layered PDF
Versioning (LPV) jobs, you can preserve layers of incoming PDF files.
For non-versioning jobs, Prinergy will automatically unite the visible
layers to a single layer during the refine process.

PDF 1.5 16-bit Images: Prinergy does not support 16-bit images in
digital masters. However, 16-bit images will be converted to 8-bit
images during refine without converting the file to PDF 1.3.

PDF 1.6 OpenType Fonts and 3D Annotations: Prinergy currently does
not support OpenType fonts in digital masters. Files with this kind of
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object are very rare. It is difficult to create this object with the current
desktop applications. When Prinergy encounters this kind of object, it
will convert the file to PDF 1.3. Note that converting to PDF 1.3 will also
flatten any transparent objects in the file.

Non-separable Blend Modes and Non-white-preserving Blend Modes:
Non-separable blend modes (Hue, Saturation, Color, Luminosity) and
non-white-preserving blend modes (Difference and Exclusion) are not
supported by the following:

● Separation Viewer plug-in
● Vector output JTP (not for use when creating separated output)
● Prepress Portal Smart Review proofing

This means that files that use the non-separable or non-white-
preserving blend modes will fail:

● To separate in Separation Viewer
● To trap in PDF Trapper
● To output separated vector output
● To proof in Prepress Portal Smart Review unless the proofing mode

uses the Proofing JTP

About PDF specification levels

The following represent only limited highlights of the specification
levels for input files in the print industry.

Level Attributes

PostScript level 1 Able to draw objects and images with one color, that is,
separated.

PostScript level 2 Includes all the attributes of PostScript 1 with the
addition of composite colors such as RGB and CMYK.

PostScript level 3 Includes all the attributes of PostScript 2 with the
addition of DeviceN and shading objects.

PDF 1.3 Almost the equivalent of PostScript 3.

When you move from PDF 1.4 to an earlier specification level (that is, PDF 1.3,
PostScript level 3, and earlier), there is no native transparency. The move to an
earlier level will invoke flattening.

PDF 1.4 Includes all the attributes of PDF 1.3 with the addition of
transparency and JBIG2 compression.

PDF 1.5 Includes all the attributes of PDF 1.4 with the addition of
layers and JPEG 2000 compression.

PDF 1.6 Includes all the attributes of PDF 1.5 with the addition of
native Open Type fonts.
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About transparency support
Transparency is an effect that you can build in Adobe Illustrator 9 and
later and Adobe InDesign 2 and later. When you write a PDF 1.4 file
from these software applications, the file contains native transparency.

Prinergy now supports transparent objects in digital masters. This
transparency support should:

● Enable simpler, faster, and more accurate trapping
● Retain the number of editable objects in Acrobat
● Help to eliminate artifacts (on output, especially in low-resolution

proofs) that are sometimes introduced during flattening

Differences between Prinergy versions

Prior to Prinergy 4, transparent objects in PDF 1.4 and later files had to
be flattened to PDF 1.3 objects during the normalizing process.
Flattening is the process of converting all overlapping transparent
areas into discrete, opaque areas to represent the look of the original
transparency. Flattening retains the vector integrity of the objects as
much as possible; however, flattening may rasterize some objects,
depending upon file complexity.

The flattening feature is available in Prinergy 4 and later by selecting
Flatten to PDF 1.3 in the Normalize section of the refine process
template.

Handling files with transparency

The following file formats (by their nature) do not contain native
transparency:

● PS
● EPS
● DCS
● PDF 1.3 or earlier
● PDF/X-1a (PDF/X-1a is a restricted subset of PDF that prohibits

transparency.)

(If the original file had contained transparency effects, they would have
been flattened.) Because these formats do not include native
transparency, they cannot take advantage of Prinergy 4's transparency
handling.

To take advantage of Prinergy's transparency handling, ensure that
your incoming files contain native (unflattened) transparency. To do
this, save incoming files as PDF 1.4 or later in Illustrator and InDesign.

To determine whether a PDF file contains native transparency, open
the file in Acrobat and use the Transparency Flattening tool (the
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location of this varies by Acrobat version). Set the Highlight list to
Transparent Objects. If any objects in the preview appear in red, there
is native transparency in the file.

You can preserve transparency during the refine process. The PDF 1.4
to PDF 1.6 (Acrobat 5 to 7) list on the Normalize pane in the refine
process template has the following options:

● Flatten to PDF 1.3: Prinergy detects and flattens all files with native
PDF 1.4 transparency, using the highest quality setting. This is the
behavior from Prinergy 3 and earlier.

● Leave as is: Prinergy detects and preserves transparent effects in
PDF 1.4 or later files.

● Fail: Prinergy detects but fails when it encounters transparent
objects.

Processing transparent files: possible approaches

Desktop
Application

Refine Output Notes

Save as PDF
1.3 input

Refine to PDF
1.3 digital
master

Output with
CPSI RIP

This workflow was possible in Prinergy 3.x. Flattening occurs at
the input creation step (from the desktop software). Sites that
receive PostScript, EPS, DCS, PDF 1.3, or PDF/X:1-a input use
this workflow.

This workflow is useful when you need PDF 1.3, PDF/X-1a, or
PostScript for downstream processing and want to put the
responsibility for flattening on the page creator.

Save as PDF
1.4 input

Refine to PDF
1.3 digital
master

Output with
CPSI RIP

This workflow was possible in Prinergy 3.x. Sites that receive
PDF 1.4 or later can use this workflow.

Flattening occurs when Prinergy refines the input file. This
workflow is useful when you need PDF 1.3, PDF/X-1a, or
PostScript for downstream processing but want Prinergy to
perform the flattening. (Prinergy's flattening assumes highest
quality output so there is no possibility of the file being flattened
with quality settings that are too low.)

Save as PDF
1.4 input

Refine to PDF
1.4 digital
master

Output with
CPSI RIP

This workflow is possible only in Prinergy 4.0 and later. Sites
that receive PDF 1.4 or later can use this workflow.

Flattening only occurs when Prinergy's CPSI RIP processes the
PDF digital master file. This workflow is useful when you want
the benefit of native transparency workflow and prefer the file
not to be flattened during refine.

Drawbacks to this are that CPSI RIP's flattening can slow
output. Flattening can take time on complex files so not
flattening on input means you are deferring flattening to the
output stage. Additionally, when pages have text below
transparent images, for example, low-resolution proofs might
still have text that looks fat.
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Desktop
Application

Refine Output Notes

Save as PDF
1.4 input

Refine to PDF
1.4 digital
master

Output with
Adobe PDF
Print Engine

This workflow is possible only in Prinergy 4.0 and later. Sites
that receive PDF 1.4 or later can use this workflow.

Flattening does not occur in this workflow. This workflow is
useful when you want the benefit of native transparency
workflow and prefer the file not to be flattened.

About recommended Acrobat Distiller 8, 9, and X settings for
content

Use the following settings when distilling content files to PDF files for
Prinergy input. For distilling marks, see Recommended Acrobat Distiller
8, 9, and X settings for marks on page 692.

General

File Options

Compatibility Acrobat 5.0 (PDF 1.4 and later)

Use this setting if you want
transparent objects to be handled
natively without flattening during the
refine process.

Object Level Compression Off

Auto-Rotate Pages Off
Binding Left
Resolution 2400 dpi

Page Range All Pages

Embed thumbnails ON

Optimize for fast web view OFF

Default Page Size

Width 8.5
Height 11.0
Units Inches

Images

Color Images

Downsample Off

Compression ZIP
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Color Images

Image Quality High

Grayscale Images

Downsample Off

Compression ZIP

Monochrome Images

Downsample Off

Compression CCITT Group 4

Anti-Alias to gray Off

Fonts

Embed all fonts ON

Subset embedded fonts when percent of characters used is
less than

100%

When embedding fails Cancel Job

Embedding Base 14 Fonts

Color

Adobe Color Settings

Settings File None

Color Management Policies Leave Color Unchanged

Document Rendering Intent Default

Device-Dependent Data

Preserve under color removal and black generation settings ON

When transfer functions are found Preserve

Preserve halftone Information ON

Advanced

Options

Allow PostScript file to override Adobe PDF settings OFF

Allow PS Xobjects ON

Convert gradients to smooth shades ON

Convert smooth lines to curves ON
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Options

Preserve Level 2 copypage Semantics ON

Preserve Overprint Settings ON

Overprinting Default is Non-Zero Overprinting ON

Save Adobe PDF Setting in PDF File OFF

Save Original JPEG Images in PDF File if possible OFF

Save Portable Job Ticket in PDF File OFF

Use Prologue.PS and Epilogue.PS OFF

Create Job Definition Format (JDF) File OFF

Document Structuring Conventions (DSC)

Process DSC comments ON

Log DSC warnings OFF

Preserve EPS information from DSC ON

Preserve OPI comments OFF

Preserve Document information from DSC ON

Resize page and center artwork for EPS files ON

Standards

Compliance Standard None

Raster-separated data

Formatting raster-separated data to use with Workshop and
Pandora

Using Copydot Toolkit Pro, format raster separated data for use in
Workshop or Pandora. You can format 1-bit TIFF, Raster DCS, and
Copydot input files.

1. Merging Dielines to Artwork in Copydot Toolkit

When dielines are received in a separate file, merge them to the
artwork.

Optional: If necessary, correct the dieline Orientation in copydot
toolkit.

2. Setting the Trim Box in Copydot Toolkit

Set the trim box and bleed to match the margins for the artwork.
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3. Reformatting TIFF Files as a High-Resolution PDF in Copydot
Toolkit

Reformat TIFF files to a high-resolution PDF format.

4. Refining Input Files Manually

Refine the prepared high-resolution PDF in Workshop.

Note: You must use a refine process template that generates thumbnails.

Correcting the dieline orientation in Copydot Toolkit

When dielines are created separately from artwork, the dieline
orientations may not match. You can correct the orientation.

Perform one of these actions:

○ In Copydot Toolkit Viewer, from the Edit menu, select Rotation.
○ In Workshop, from the Edit menu, select Set Page Geometry.

Re-output the dieline separation as TIFF.

Merging dielines to artwork in copydot toolkit

In some cases, the dieline may be scanned separately from the artwork
and delivered in a separate file. Use the registration feature of Copydot
Toolkit (CTK) to bring the dieline into the job and position it correctly
relative to the artwork.

The prerequisites for performing this procedure are:

● Copydot Toolkit 4.0 Pro
● The artwork in a CTK-supported formats
● The dieline in a CTK-supported formats
● The resolutions of the artwork and dieline match—for example,

both are 2400 dpi.

If the dieline is not the same resolution as the artwork, the dieline is
scaled relative to the artwork. Because the dieline was created
separately from the artwork, its orientation may not match the
artwork's orientation.

Note: If the dieline has not been scanned, you can export it from the CAD
application in EPS format. Then, refine the EPS file in Prinergy and output it in 1-bit
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TIFF format at a resolution that matches the artwork. CTK can then read the 1-bit
TIFF representation of the dieline.

1. In CTK, create a new job, and add the artwork separations.

2. Locate the dieline separation file, and then add the file to the job.

3. When prompted, keep the existing separations (do not discard the
artwork separations).

4. Click the View button to start the Image Viewer.

5. From the Registration menu, select Restart Registration to activate
the registration tools.

6. In the Image Viewer Separation Manager, select the dieline
separation and use the Move Separation tool to move the dieline
relative to the 1-up artwork.

7. When the dieline is correctly positioned, from the Registration
menu, select Approve Registration and Save.

Setting the trim box in Copydot Toolkit

1. Create a new job or select an existing job in the Jobs window.

2. From the Input menu, select Browse, and select the TIFF files you
want to view.

The TIFF files appear in the Process dialog box. You may need to
assign colors so they appear correctly.

For more information, see the Copydot Toolkit User Guide.

3. Click View.

Zoom files are created for viewing.

4. Zoom out until you can see the entire frame.

5. Click the Page Frame (Crop) Tool button, and drag the frame so it
matches the size of the dieline.

6. From the File menu, select Save.

7. From the Edit menu, select Active Frame.
The Edit Active Frame dialog box appears.

8. In the Output dialog box:

a. Click the Page Frame option button.
b. Under Bleed, assign bleed to the margins of the page.
c. Under Film Crop, assign an equal value to margins of the page.

9. Click OK.

10. From the File menu, select Save.

The trim box is set with bleed added.
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Reformatting TIFF files as a high-resolution PDF in Copydot ToolKit

1. Close the Image Viewer window.

2. In the Settings area of the Job window (right side), under Process,
in the Output Type box, select Copydot.

3. In the Output File box, under Output, browse to a location to save
the PDF.

4. In the General tab, under Output, make the following selections:

● In the Resolution box, enter the output resolution.
● In the File Format box, select PDF.
● In the File Generation box, select Composite.
● In the Color Space box, select CMYK+.
● In the Compression box, select G4.
● In the Interleave box, select Plane.
● In the Image Format box, select Tiled.
● In the Tile Height box, enter 2048.
● In the Tile Width box, enter 2048.

5. Under Output, click the Place/Prev tab and make the following
selections:

● Select LoRes Preview.
● In the Color Space box, select CMYK.
● In the Compression box, select None.
● In the Resolution (ppi) box, select 72.

6. Click Browse and select the desired location.

7. In the Output File box, enter a name for the reformatted PDF.
(Ignore the Save as type pop-up menu.)

Note: Copydot Toolkit automatically appends the file name with .PDF, so you
do not need to enter a filename extension.

8. Under Execution, click the Restart Processing button.

The TIFF files are reformatted as a high-resolution PDF.
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8 Starting processes

About starting processes
One of the tasks that you will perform most frequently in Prinergy
Workshop is initiating processing. For example, processes include
refining input files, proofing, making film or plates, archiving job files,
and submitting files to digital devices. Any element can undergo some
sort of processing.

In general, you initiate a process by selecting the elements to be
processed, and then select the desired process template or digital
device. All of the process templates and digital devices are listed in the
Process Templates pane of Job Manager.

When you start a process, you can edit the process template
temporarily.

You can start a process in several ways:

● Using a menu item
● Dropping elements onto a process template or digital device in the

process templates pane
● Using the pop-up menu (right-clicking the element and navigating to

the process template)
● Using the pop-up menu in the process templates pane (selecting the

elements, right-clicking the process template in the process
templates pane, and selecting Start Processing).

Starting processes
You can run a process on one or more jobs from Job Finder, a single job
from Job Manager, or selected files from Job Manager.

1. Select the files or jobs that you want to affect:

To Affect Do This

One or more jobs In Job Finder, select the jobs.

One job In Job Manager, click the Job  button.

Note: The Job button applies only to export and
storage processes.



To Affect Do This

Specific files in a job In Job Manager, select the files from the Pages,
Signatures, Separations, or Storage view.

2. Choose the process template:

If You Are In Do This

Job Finder or Job
Manager

Right-click the selection, and using the cascading
menus, select the process template.

Job Finder or Job
Manager

From the Process menu, using the cascading menus,
select the process template.

Job Manager Drag the selection to the Process Templates pane,
and drop it on the process template.

Job Manager In the Process Templates pane, right-click the
process template and select Start Processing.

Note: The only process templates available are the ones that apply to your
selection. Process templates that do not apply are unavailable.

3. In the Start Process dialog box, modify the options as desired.

When you submit a job to a digital device, the Start Process for
Digital Printing dialog box is displayed.

4. If desired, modify the process template before starting the process
by clicking Edit Process Template, modifying the process template,
and clicking OK.

5. Click OK to begin processing.

The Process Info dialog box appears if Show Process Info Window
When Process Is Created is selected in the Prinergy Workshop
Preferences dialog box.

Bypassing the Start Process dialog box

Press and hold the Alt or Option key while dragging elements onto
a process template.

Note: You cannot modify the process template before starting the process or
make other changes in the Start Process dialog box, such as changing the
process name or priority or entering a comment about the process.

Note: For digital print jobs, you cannot bypass the Start Process for Digital
Printing dialog box.

Stopping, pausing, and resuming processes
You can stop or pause a process before it ends. If you stop a process,
you cannot resume it. If you pause it, you can resume it.
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Note: You cannot pause a digital print job, once it has been submitted to a digital
device. If you stop a digital print job that is running on a digital device, you cannot
resume the process; you must resubmit the job.

1. In Job Manager, on the Active tab of the Processes pane, select the
process.

2. Perform one of the following actions:

○ From the Process menu, select Processing Tools, and then
select Stop, Pause, or Resume.

○ Right-click the process and select Stop, Pause, or Resume.
○ In the Process Info dialog box and click the Stop button.

Tip: You can also stop, pause, or resume a process from Queue Manager.

Deleting completed processes

1. On the Completed tab of the Processes pane in Job Manager,
select the process that you want to delete.

2. Perform one of the following actions:

○ From the File menu, select Delete Process.
○ Right-click the process, and select Delete Process.

Generating a process report for troubleshooting
To help troubleshoot a problem, generate a detailed report about a
specific process to send to your service representative.

1. In the Processes pane in Job Manager, select an active or
completed process.

2. From the Process menu, select Processing Tools.

3. In the Comment box of the Create Process Report dialog box,
record any information that may help the service representative
solve the problem. This text is added to a comment file in the
resulting zip file.

Three files (.stdout, .txt, .zip) are generated in the following directory:
%ServerName%\%AraxiHome%\CreoAraxi\support
\ProcessErrorInfo\%JobName%\%ProcessName-
ProcessCode%\
Next:

Send the .zip file to your service representative.
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Choose process template dialog box

Select a template from the list

Select a workflow processor or server.

Navigation tree

Expand the navigation tree to select the desired process
template.

Start Process dialog box

Process Template

Displays the name of the selected process template

Process Name

Displays information about the process. By default, information
is displayed in the following format:

<workflow processor>:<process template group>:<process
template>:<number of elements being processed> <type of element
being processed>

However, you can rename the process as desired.

User Comment

Enables you to type a comment associated with the process, if
desired.

The comment appears in the Process Info dialog box for the
process and is stored in the History view for the job.

Priority

Use this list to assign a priority to this process. These are the
options:

● Low
● Normal (default)
● High
● Urgent

A process with a specific priority will be executed before
processes with a lower priority, and after processes with a
higher priority. For example, a process set to High will be
executed before any processes set to Low or Normal, and after
any processes set to Urgent. If multiple processes are
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submitted with the same priority, they are executed in the order
in which they were submitted.

Add Process Template to Job Favorites

Select this option to automatically add the selected process
template to the Job tab of the Process Templates pane for the
job (if the process template has not already been added).

By default, this option is not selected. However, you can select
Automatically Add Templates Used for Processing to Job
Favorites in the Workshop Preferences dialog box to have the
Add Process Template to Job Favorites selected by default
whenever you initiate a process.

This option is available only if you start a process from Job
Manager, not from Job Finder.

Work Type

Use this list to indicate the type of work being done, so that
your company can track and report on job costs and status. The
names of the available work types have two parts—a category,
followed by an item. These are the built-in work types:

● Regular or Original Work – System defined original work
item

● Alteration Chargeable – System defined chargeable
alteration

● Alteration Non-Chargeable – System defined non
chargeable alteration

● Rework Chargeable – System defined chargeable re-work
item

● Non chargeable re-work – System defined non chargeable
re-work item

In addition to these work types, you can click Edit next to the
Work Type list to add new work types. You can modify items or
delete work types that you create, but you cannot modify or
delete built-in work types.

Note: This option is available only if the Prinergy Business Link software
is connected to your Prinergy system and if you start a process from Job
Manager, not from Job Finder.

Edit

Click this button to add and modify work items for a specific
work category. Any items that you add appear under Work
Type in the Start Process dialog box.
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Note: This option is available only if the Business Link software is
connected to your Prinergy system and if you start a process from Job
Manager, not from Job Finder.

Edit Process Template

Click this button to view and modify the selected process
template before initiating the process.

When you modify a process template in this way, any changes
to the process template are temporary and are discarded once
the process is complete. The changes do not affect the original
process template and they are not saved with the job. You
cannot redo the same process without making the same
changes to the process template again.

PDF Layer Selection

Click this button to view the layers in the input file and to
choose which layers you want to retain. All retained layers are
united and applied to the base content. Layers that are not
retained are discarded.

Color Mappings

This button is visible only when you start a refine or loose page
output process template. Click this button to change how colors
will be output.

When you refine pages, this button opens the Color Mappings
dialog box. The button does not appear when you refine input
files.

When you generate loose page output, this button opens the
Color Output dialog box.

Tonal Control

Click this button to open the Tonal Control dialog box. This
dialog box enables you to assign a ColorFlow curve channel to a
separation, surface, or job selected for plate output. It also
enables you to make on-the-fly tonal adjustments to these
curves, without affecting the original ColorFlow curves. This
button is visible only for halftone output processes.

Zip Filename

The name of the export file. By default, it displays the name of
the job, plus the .zip file name extension. You can change the
file name, but ensure it ends with .zip.

This box is visible only when starting an export process.
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Output Comment

Use this box to type a comment associated with the output, if
desired. This box defaults to the last output comment that you
entered on this workstation.

The comment is stored in the History view for the job.

You can also place this text on output using the variable mark $
[OutputComment] in page or sheet marks.

Selected Items

Expand this section to view a list of the jobs or elements
selected for processing.

Layered PDF Flattening Warning

When you process layered PDF files, a warning message
appears to indicate that if the PDF 1.4-1.6 (Acrobat 5-7) option
located in the Normalize section of the refine process template
is set to Flatten to PDF 1.3, the refined files will be flattened and
layers will be combined as indicated in the Layer Selection
dialog box.

Layer handling happens before flattening, so that layers are
handled as specified in the Layer Selection dialog box before
flattening occurs. This allows you to omit certain layers before
processing the page as PDF 1.3. As a general rule, for Layered
PDF Versioning (LPV) jobs, you do not want to flatten to PDF
1.3, which would destroy the layers of the incoming PDF 1.5 file.
This would defeat the purpose of using layered input.

Note: If you use Rules-Based Automation to start a process, most options in the
dialog box do not apply, so they are not displayed.

Start Process for Digital Printing dialog box

Digital Device Queue

Displays the name of the selected queue on the digital device.

Process Name

Displays information about the process you are submitting to
the digital device. By default, information is displayed in the
following format:

<digital device>:<print settings>:<number of pages being
processed>

However, you can rename the process as desired.
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User Comment

Use this box to type a comment associated with the process, if
desired.

The comment appears in the Process Info dialog box for the
process and is stored in the History view for the job.

Priority

For most digital devices, jobs are processed in the order that
they are submitted. You can use this list to select the
processing priority for some jobs. Possible priorities are:

● Low
● Normal (default)
● High
● Urgent

A process with a specific priority will be executed before
processes with a lower priority, and after processes with a
higher priority. For example, a process set to High will be
executed before any processes set to Low or Normal, and after
any processes set to Urgent. If multiple processes are
submitted with the same priority, they are executed in the order
in which they were submitted.

Add Digital Print Target to Job Favorites

Select this option to automatically add the selected digital
device to the Job tab of the Process Templates pane for the job
(if the digital device has not already been added).

By default this option is not selected. However, you can select
Automatically Add Templates Used for Processing to Job
Favorites in the Workshop Preferences dialog box to have the
Add Digital Print Target to Job Favorites selected by default
whenever you initiate a process.

This option is available only if you start a process from Job
Manager, not from the Job Finder.

Work Type

Use this list to indicate the type of work being done, so that
your company can track and report on job costs and status. The
names of the available work types have two parts-a category,
followed by an item. The built-in work types are:

● Regular or Original Work - System defined original work
item

● Alteration Chargeable - System defined chargeable
alteration
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● Alteration Non-Chargeable - System defined non
chargeable alteration

● Rework Chargeable - System defined chargeable re-work
item

● Non chargeable re-work - System defined non chargeable
re-work item

In addition to these work types you can click Edit next to the
Work Type list to add new work types. You can modify items or
delete work types that you create, but you cannot modify or
delete built-in work types.

Note: This option is available only if Link software is connected to your
Prinergy system and if you start a process from Job Manager, not from
the Job Finder.

Edit

Click this button to add and modify work items for a specific
work category. Any items that you add appear under Work
Type in the Start Process dialog box.

Note: This option is available only if Link software is connected to your
Prinergy system and if you start a process from Job Manager, not from
the Job Finder.

Items to Submit

This tab lists elements that are being submitted to the digital
device.

Content Preparation

This tab allows you to select the settings that determine how
the multi-page PDF file that you will submit to the digital device
is going to be created.

If you are in the Pages view, and you submit one or more files
from the Page Position pane or Page pane to a digital device
listed in the Process Templates pane, the Loose Page Proof
Template area is displayed in the Content Preparation tab. You
can do the following actions:

● Click the Select button to choose a digital device from the
Process Template dialog box.

● Click the Edit button to change the settings.
● Click the Color Mapping button to define color output

options.
● Click the Select Versions button to identify which versions

you want to output.

If you are in the Pages view, and you submit a file from the
Input File pane to a digital device, the Content Preparation tab is
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not displayed because you are submitting the actual input file
directly to the digital device.

If you are in the Signature view or Separations view, and you
submit one or more files from the Page Position pane to a digital
device, the Loose Page Proof Template area is displayed in the
Content Preparation tab and you can do the actions described
above. If you submit an imposition plan, the Imposition Proof
Template area is displayed in the Content Preparation tab. You
can Select and Edit an imposition template, and use the Select
Versions button, but the Color Mapping button is not
displayed.

Note: If you are submitting a job that has JDF content, make sure that
you have set up the correct JDF template for the digital device. See the
Digital Print Installation and Configuration guide.

Color Mappings

This button is only visible when you start a refine or loose page
output process template. Click this button to change how colors
will be output.

When refining pages this button opens the Color Mappings
dialog box. The button does not appear when refining input
files.

When generating loose page output this button opens the Color
Output dialog box.

Select Versions

For jobs that have versioning, you can output all languages or
select specific languages to output.

Print Settings

This tab allows you to select the print settings to determine
how the PDF file is printed using the digital device.

In the JDF Template box click the Select button to choose the
JDF template to associate to the PDF file.

In the Print Settings area the Print Job Name is listed in which
the PDF file resides. You can change the print job name if you
want. In the Quantity box, select the number of copies that you
want to print.

Note: If you are submitting a job that has JDF content, make sure that
you have set up the correct JDF template for the digital device. See the
Digital Print Installation and Configuration guide.
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Device

This tab displays information about the type of digital device
that you selected and it's current status.

Device status may be in any of the following states.

● Available
● Unavailable
● Idle (waiting and ready)
● Down
● Status Unknown

Additional information about the device status may be
displayed depending on the type of digital device.

Layered PDF Flattening Warning

When you process layered PDF files a warning message
appears to indicate that if the PDF 1.4-1.6 (Acrobat 5-7) option
located on the Normalize section of the refine process template
is set to Flatten to PDF 1.3, the refined files will be flattened and
layers will be combined as indicated in the Layer Selection
dialog box.

Layer handling happens before flattening, so that layers are
handled as specified in the Layer Selection dialog box before
flattening occurs. This allows you to omit certain layers before
processing the page as PDF 1.3. As a general rule, for LPV jobs
you do not want to flatten to PDF 1.3, which would destroy the
layers of the incoming PDF 1.5 file. This would defeat the
purpose of using layered input.

Note: If you use Rules-Based Automation to start a process, most options in the
dialog box do not apply, so they are not displayed.

File Browser dialog box

Unlabeled list and results area

Selecting an item in the list at the top left of the dialog box
displays that item's contents in the box below.

When you select:

● Volumes, the volumes in your system appear
● A volume name, folders at the root of the selected volume

appear
● A folder name, files within the folder appear
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The path of the displayed item in the list appears in reverse
order, for example, folder name followed by volume name.

Desktop

Click this button to locate items on the computer desktop.

Open

Opens the selected item.

Show Hidden Files

Select this check box to include hidden files, such as system
files, in the results.

You can set the default selection of this check box on the View
tab of the Workshop Preferences dialog box.
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9 Process templates

About process templates
A process template is a file containing a collection of options and
parameters that tells Prinergy how to perform a process.

When you initiate processing on a job or element, you must select a
process template that contains the desired processing parameters.

Use Process Template Editor to create, view, and modify process
templates and workflow templates. Process templates contain
instructions for a process, and workflow templates link two or more
process templates together to offer you more automation. Also use
Process Template Editor to change the order or grouping of process
templates.

For a list of all process templates, click the Options tab. For more
information about workflow templates, see About workflow
templates on page 937.

About modifying process templates
You can make either permanent or temporary changes to a process
template.

Make permanent changes to a process template if you want the
changes to be in effect whenever someone uses the process template in
the future, regardless of which job or Prinergy Workshop client they are
accessing the template from.

Make temporary changes to a process template if you want those
changes to be in effect only while a specific process is executed, and
discarded once the process is complete.

About temporarily modifying process templates
When you choose a process template to execute and the Start Process
dialog box appears, you are given the option to edit the process
template before running it.



When you edit a process template in this way, any changes to the
process template are temporary and are discarded once the process is
complete.

The changes do not affect the original process template and they are
not saved with the job. You cannot redo the same process without
making the same changes to the process template again.

About protecting process templates
You can determine which users will be allowed to create and edit
process templates in Prinergy Workshop. This is done by setting user
rights in Prinergy Administrator.

When a user who doesn't have the right to edit process templates is
logged into Prinergy Workshop, an [x] appears to the right of the
Process Template Editor menu options; the menu options are dimmed
and unavailable. In addition, clicking Edit Process Templates in the
Start Process window will allow you to only check the process template
parameters and not change and save them.

For more information about setting user rights, see the Prinergy System
Administration guide.

What are JTPs?
Job Ticket Processors (JTPs) are software components that implement
specific actions or tasks to be performed as part of an Adobe Extreme
system. The real work of an Extreme system is performed by one or
more JTPs. This means that the kind of work of which an Extreme
system is capable is determined by the JTPs installed in it.

All JTPs share common responsibilities and capabilities, but each JTP
also has its own unique task. JTPs perform their tasks based on the
information available in a PJTF file. Different JTPs make use of certain
parts of a PJTF file and ignore other parts of the file. This allows
multiple JTPs to share the same PJTF file and its associated PDF files.
As each JTP performs its task, it consults the PJTF file for input and
updates the PJTF file with the new information. For example, the
Normalizer JTP looks for PostScript file descriptions in the PJTF and,
after processing, changes the file description so it points to the new
PDF file and not to the original PostScript file. This allows the next JTP
in the sequence to operate on the PDF files, rather than the original
PostScript files.

Each JTP has a unique name that describes its purpose. It is possible to
have multiple copies of the same JTP running at the same time on the
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same server or on different servers. This allows for distribution and
parallel processing.

Prinergy contains a number of JTPs created to implement specific tasks
that are not provided by the standard Extreme system. For example,
Prinergy uses a JTP to generate thumbnails during refining and another
JTP for archiving functions. In some cases, the functionality of a
standard JTP has been extended.

Creating process templates
You can also create a new process template from the related Process
Template Editor.

1. In the Process Templates pane, right-click the process template
group you want (the folder just above the process templates), and
select New Process Template.

2. Set the process template parameters as desired.

3. Click Save.

4. In the Save Process Template dialog box, select the group in which
you want to save the process template, or create and select a new
process template group.

To Do This

Create a new group Type a name for the new group and click Create
Process Template Group.

Open an existing
group

Double-click the group in the list.

Tip: You can also select the group and select Open.

5. Type a name for the new process template, then click Create
Process Template.
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Creating process templates based on an existing
process template

1. In the Process Templates pane, locate a process template, and
double-click it.

2. In the process template, modify the parameters as desired.

3. Click Save As.

4. Select an existing process template group in which the new process
template will be located, or create and select a new process
template group.

To Do this

Create a new group Type a name for the new group and click Create
Process Template Group.

Open an existing
group

Double-click the group in the list.

Tip: You can also select the group and select Open.

5. Type a name for the new process template and click Create
Process Template.

Save process template dialog box
Note: This dialog box also applies to saving workflow templates.

lists

By default, the list displays the root of the selected process
template group, and the list displays the process templates for
the selected process template group.

The bottom box displays the process template name.

Create Process Template

Click this button to create a new process template.

If you opened an existing process template and want to save it
as a new process template, you must modify the process
template name before this button changes from Save Process
Template to Create Process Template.

Create Process Template Group

Click this button to create a new process template group. A
process template group is the level just above the process
templates.
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Modifying process templates

1. In the Process Templates pane, locate a process template, and
double-click it.

2. In the process template, modify the parameters as desired.

3. Click Save.

Temporarily modifying process templates
1. Start a process.

2. In the Start Process dialog box, click Edit Process Template.
The process template opens in the Process Template Editor for the
server or workflow processor on which the process template
resides.

3. In the process template, modify the parameters as desired, and
click OK.

4. In the Start Process dialog box, click OK to begin processing.

Note: Once processing is complete, the changes that you made to the process
template are discarded. The changes do not affect the original process
template and they are not saved with the job. You cannot redo the same
process without making the same changes to the process template again.

Renaming process templates
Note: You can also rename a process template from the Process Template Editor.

1. In the Process Templates pane, locate a process template, right-
click it, and select Rename.

2. Type a new name for the process template and click Rename.
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Deleting process templates
Note: You can also delete a process template from Process Template Editor.

1. In the Process Templates pane, select the process template that
you want to delete.

2. Right-click the selection and select Delete.

3. If prompted to confirm that you want to delete the process
template, click Continue.
The process template disappears from the Process Templates
pane.

Process Template Editor

Process templates

Prinergy offers several types of process templates. For option
descriptions for each process template type, see:

● Refine Process Template Options
● Bypass Refine Process Template Options
● Loose Page Output Process Template Options
● Imposition Output Process Template Options
● Publish File Process Template
● Final Output Process Template Options
● CTLW Karat Output Process Template Options
● Archive Process Template Options
● Retrieve Process Template Options
● Archive Medium Logical Copy Process Template Options
● Purge Process Template Options
● Import Process Template Options (Jobs)
● Import Process Template Options (Impositions)
● Export Process Template Options
● Generate Versioned Pages Process Template Options
● Copy Job Process Template Options

Workflow templates

Prinergy offers workflow templates, which combine two or three
process templates. See About Workflow Templates.

Factory read-only templates

See Factory Templates.
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For menu descriptions, see Menus in Process Template Editor.

See also:
Factory templates on page 189
File Browser dialog box on page 190
Menus in Process Template Editor on page 190
Refine process template on page 201
Import process template (impositions) on page 358
Loose Page Output process template on page 433
Imposition Output process template on page 489
Final Output process template on page 544
Export process template on page 865
Import process template (jobs) on page 870
Archive process template on page 879
Purge process template on page 882
Retrieve process template on page 885
Archive Medium Logical Copy process template on page 892
About workflow templates on page 937

Saving factory templates
You can use a factory template as a regular process template.

1. Open Process Template Editor.

2. Under Factory Read-Only Templates, select and open a factory
template.

3. Select File > Save As.

4. Double-click the group where you want to save the process
template.

5. Type a name for the factory template.

6. Click Create Process Template.

The factory template is now available for use as a regular process
template.

Factory templates
Factory templates provide a stable set of process templates that can be
used when the Response Center is troubleshooting a case. For
example, when the Response Center asks you to run your file through a
specific factory process template, they will have an easier time
troubleshooting your file. The factory template takes out the
uncertainty that other features such as ColorConvert or Trap haven't
been accidentally turned on and affect the outcome.
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Another advantage of factory templates is that they provide stable
starting points for useful configurations. For example, you'll have a
reasonable starting point for the settings of a contone PDF raster
process template.

By default, the factory templates are visible only in the Process
Template Editor. These templates do not appear in either the Job
Manager window or the Start Process dialog box so as not to be
inadvertently used in an incorrect manner.

To use a factory template as a regular process template, see Saving
Factory Templates.

File Browser dialog box

lists

By default, the list displays the root of the selected process
template group, and the list displays the process templates for
the selected process template group.

The bottom box displays the process template name.

Volumes

Click this button to display all of the volumes in the Prinergy
system.

Show Hidden Files

Select this check box to display hidden files, such as system
files, in the list.

You can set the default selection of this check box in the View
tab of the Workshop Preferences dialog box.

Menus in Process Template Editor

Workshop menu in Process Template Editor
Note: This menu is available only when running Prinergy Workshop on a
Macintosh client.

About Prinergy Workshop

Displays information about Prinergy Workshop, including the
version number, a list of licensed features, and the server name.
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Preferences

Use to view and modify Prinergy Workshop preferences. When
you select this menu item, the Workshop Preferences dialog
box appears.

Note: On a Windows client, this menu item appears under the Edit menu.
On a Macintosh client, it appears under the Workshop menu.

Quit / Quit Prinergy Workshop

Quits Prinergy Workshop. Any open Prinergy Workshop
windows are closed.

File menu in Process Template Editor
Note: Not all menu items are available all the time. Some menu items are available
only when specific process templates or process template groups are selected.

New Process Template

Select an existing process template or process template group
and then select New Process Template to create a new process
template of the same type.

For example select an existing archive process template or
archive process template group and then select New Process
Template. A new archive process template opens with the
default archive process template settings.

Modify and save the new process template as desired.

New Process Template Group

Select an existing process template type process template
group, or process template and then select New Process
Template Group to create a new process template group.
Name the new process template group as desired.

New Workflow Template

Select a type of workflow template then select New Workflow
Template to display a dialog box of options for a workflow
template. Use the dialog box to create a new workflow
template.

New Workflow Template Group

Select a type of workflow template then select New Workflow
Template Group. Prinergy places an unnamed process template
group in the Process Template Editor dialog box. The cursor
blinks in the highlighted but unnamed group for you to name it.
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Open

Opens the selected process template.

Delete

Deletes the selected process template or process template
group.

Rename

Enables you to rename the selected process template or
process template group.

Change Group Icon

Enables you to change the icon that represents the selected
process template group. When you select this menu item, the
File Browser dialog box opens. From there, you can browse to
and select the icon that you want to associate with the selected
process template group.

Close Window

Closes the current window, but does not quit Prinergy
Workshop.

Quit

Quits Prinergy Workshop. Any open Prinergy Workshop
windows are closed.

See also:
Creating and modifying workflow templates on page 938

Edit menu in Process Template Editor
Note: Not all menu items are available all the time. Some menu items are available
only when specific process templates or process template groups are selected.

Cut

Select a process template that you want to copy to another
process template group and then select Cut. When you Paste
the process template into the new process template group, the
process template simultaneously appears in the new process
template group and disappears from its original process
template group. (Compare to Copy.)

Copy

Select a process template that you want to copy to another
process template group and then select Copy. When you Paste
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the process template into the new process template group the
process template appears in the new process template group.
(Compare to Cut.)

Paste

Pastes the copied process template to the selected process
template group. (See also Cut and Copy.)

Note: You can only move a process template from one process template
group to another process template group of the same type. For example,
you can move an archive process template from one archive process
template group to another archive process template group, but not to a
purge process template group.

View menu in Process Template Editor

Refresh

Updates the contents of the current window.

Tools menu in Process Template Editor

Change User

Displays the Connect to Server dialog box where you can log in
as another user without quitting Prinergy Workshop.

This menu item appears only if you have Kodak Prinergy
Business Link software connected to the Prinergy system.

Job Finder

Opens Job Finder.

If you are already in Job Finder, this menu item is unavailable.

Destroy History Entries

In the History view, select one or more history entries and then
use Destroy History Entries to delete the selected entries.

Process Template Editor

Launches Process Template Editor, where you can create and
modify process templates.

Automated Page Assignment Editor

Starts the Automated Page Assignment Editor, which you use
to create and check APA files.
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Queue Manager

Launches Queue Manager, where you can view the Job Ticket
Processors (JTPs) and process types.

Media Manager

Launches Media Manager, where you can manage your archive
tapes and disk volumes.

System History

Launches System History, which displays the detailed history of
all the activity occurring outside of job context (such as jobs
and groups that were created or destroyed), as well as job
archive, purge, and retrieve history.

Smart Hot Folder Manager

Launches the Smart Hot Folder Manager dialog box, where you
can add, edit and delete smart hot folders.

Configure Imposition Application

Displays the Configure Imposition Applications dialog box,
where you can identify the location of imposition software that
you want to integrate with Prinergy Workshop.

Start Imposition Application

Displays the Start Imposition Application dialog box, where you
choose which imposition software to start. You create this list
of imposition applications with the Configure Imposition
Application tool from the Tools menu. If an application requires
a license and is licensed, it appears in bold.

Color Editor

Launches Color Editor, where you can create color recipes for
all jobs.

Color Space Editor

Launches Color Space Editor, where you can create and edit
color spaces.

Font Converter

Launches Font Converter, where you can convert font files into
PFA (Printer Font ASCII) format, which Prinergy requires to
correctly process fonts.

194 Chapter 9—Process templates



Preflight Profile Manager

Launches Preflight Profile Manager, where you can, during the
refine process, evaluate PDFs to detect problems that may
affect processing in a publishing or prepress workflow.

Digital Print Administration Console

Launches the Digital Print Administrator, where you can add
and configure a digital print application that Prinergy can launch
to print PDFs.

Rule Set Manager

Opens the Rule Set Manager, where you can create and edit
rule sets. The Rule Set Manager also lets you organize rule sets
into groups.

Activate Rule Set in Selected Jobs

Opens the Select Rule Set dialog box, where you can activate
rule sets for one or more jobs.

Help menu in Process Template Editor

Online help

Starts your Web browser and displays the Prinergy online help.

On <current window or view>

Starts your Web browser and displays the Prinergy Workshop
user guide, open to the topic for the currently selected window
or view.

eCentral Online Support

Starts your Web browser and displays the eCentral portal at 
https://ecentral.kodak.com/.

Visit graphics.kodak.com

Starts your Web browser and displays the Kodak Web site at 
http://graphics.kodak.com/default.htm.

Keyboard shortcuts in Process Template Editor

Macintosh
Keyboard
Shortcut

Windows
Keyboard
Shortcut

Description

 + Delete Ctrl + Delete Destroys the selected process template or process template group

 + RETURN Ctrl + Enter Opens the selected process template
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Macintosh
Keyboard
Shortcut

Windows
Keyboard
Shortcut

Description

 + C Ctrl + C Copies the selected process template

 + N Ctrl + N When a process template type, process template group, or process
template is selected, opens a new process template of the same type.

For example, select an existing archive process template or archive
process template group, and then press Ctrl + N. A new archive process
template opens with the default archive process template settings.

 + Q Ctrl + Q Quits Prinergy Workshop

 + R Ctrl + R Refreshes the current window

 + V Ctrl + V Pastes a copied process template into the selected process template
group

 + W Ctrl + W Closes the Process Template Editor window

 + X Ctrl + X Removes the selected process template

Process template groups

About process template groups

Process templates are organized by category, type, and group. For
example:

● Output (category)

○ Final Output (type)

● Auto Flat Output (group)

Within each type, Prinergy comes with some default groups created,
although you can rename or delete these groups and create new
groups as desired. You can also change the group icons.

Note: Process template groups for imposition output and final output are usually
grouped by output device type, such as Kodak Trendsetter Spectrum for
imposition output process templates. We recommend selecting an icon
appropriate for the device type, if available.

196 Chapter 9—Process templates



Creating process template groups

You can create a new process template group when you create a new
process template, or directly in Process Template Editor. To create a
new process template group from Process Template Editor:

1. Open Process Template Editor.

2. Perform one of the following actions:

○ Select an existing process template type, process template
group, or process template and then from the File menu, select
New Process Template Group.

○ Right-click a process template type and select New Process
Template Group.

3. Type a name for the new group and press Enter.

Renaming process template groups

1. Open the Process Template Editor and select the process template
group that you want to rename.

2. From the File menu, select Rename, or right-click the selection and
select Rename.
The cursor appears next to the process template group name.

3. Type a new name and press Enter.
The process template group is renamed in Process Template Editor
and in the Process Templates pane of Job Manager.

Deleting process template groups
Note: Deleting a process template group also deletes any process templates
within that group.

1. Open Process Template Editor and select the process template
group that you want to delete.

2. From the File menu, select Delete, or right-click the selection and
select Delete.

3. When prompted to confirm that you want to delete the group, click
Delete.
The process template group disappears from Process Template
Editor and from the Process Templates pane of Job Manager.
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Changing process template group icons

1. Open Process Template Editor and select the process template
group whose icon you want to change.

2. From the File menu, select Change Group Icon, or right-click the
selection and select Change Group Icon.

3. In the File Browser dialog box, browse to and select the icon that
you want to represent the process template group.

4. Click OK.

Moving process templates between groups

1. Open Process Template Editor and select the process template that
you want to move.

2. Perform one of the following actions:

To Do this

Copy the process template to
another process template group and
keep a copy in the original group

From the Edit menu, select Copy, or
right-click the selection and select
Copy.

Copy the process template to
another process template group and
remove it from the original group

From the Edit menu, select Cut, or
right-click the selection and select
Cut.

3. Select the process template group to which you want to copy the
process template.

Note: You can only move a process template from one process template
group to another process template group of the same type. For example, you
can move an archive process template from one archive process template
group to another archive process template group, but you cannot move an
archive process template from an archive process template group to a purge
process template group.

4. From the Edit menu, select Paste, or right-click the selection and
select Paste.

The process template appears in the selected group in Process
Template Editor and in the Process Templates pane of Job Manager.
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10 Refining

About refining
Refining is a key Prinergy process. In addition to converting your files to
PDF, it can perform copydot handling, color conversion, trapping,
thumbnail generation, and more. In most cases, you must refine your
files before you can produce quality output in Prinergy.

Refined files include embedded fonts and images, so you do not have to
manage the fonts and images of refined files.

You can choose to refine files while adding them to a job or later. When
you refine files, you select a refine process template that contains
predetermined settings. This process template guides the files through
a series of JTPs.

Note: Files can be refined multiple times in order to apply different refine process
settings. Refining also enables you to map colors.

Bypassing refine

If you are confident that your PDF input files are press-ready, you can
choose to bypass the refine process. Bypassing refine ensures that the
content does not change, and saves processing time and resources.

To bypass refine, you must use the Bypass Refine process template,
which will only register your PDF input files with associated colorant
and geometry attributes into the Prinergy system.

XMP metadata

Prinergy preserves XMP metadata in your input files. XMP is a
standards-based metadata schema, providing structure for your
information records.

XMP metadata can be used in a number of ways. For example, XMP
metadata can include information regarding 3rd party OPI and trapping.
It can also include information for future use, for example, whether or



not the file has already been preflighted by Prinergy, and if the preflight
profile is GWG (Ghent Working Group) compliant.

See also:
About supported input file types on page 126
About adding and removing files on page 143
About common density limit on page 256
About neutral density on page 256
About overprint conversion on page 257
About overprint handling on page 257
About step limit on page 262
About thumbnails on page 262
About reducing and preserving spot colors during refine on page 807

Refining input files manually
Requirements: You have already added input files to a job using a menu
item or a hot folder.

1. In the Input Files pane of Job Manager, select the input files that
you want to process.

2. Follow the instructions in Starting Process and select a process
template.

You can choose any refine process template.

Prinergy refines the input files into PDF pages which appear in the
Pages pane.

See also:
Starting processes on page 171

Refining input files using a hot folder

1. Open the job.

2. Create a hot folder for the job and link it to the desired process
template.

You can choose any refine process template.

3. Add files to the hot folder.

The result depends on the type of files and the type of hot folder.
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Refine process template
At the top of the process template is the Generate list, which you use
to select type of PDF to generate during the refine process. The choices
are:

● PDF
● PDF/X-1a:2001
● PDF/X-3:2002

The refine process template contains several sections. Each section
defines a subprocess of the refine process.

CEPS Conversion section of the Refine process template

The CEPS Conversion section of a refine process template defines how
Prinergy takes CT/LW and TIFF/IT-P1 input files and generates PDF
files. The resulting PDF files consist of two layers: line-work (LW) and
continuous-tone (CT).

Note: Prinergy handles TIFF/IT-P1, CT/LW (generated by Brisque or PS/M 5 and
later), and handshake pages (from PS/M 4 and earlier, and other sources); it does
not handle other forms of these files. You must convert other types of CT/LW files
to PostScript before you input them to Prinergy, or to an accepted input format
using a translation function, such as that found on the Brisque. Also, when
generating files from Brisque for Prinergy, you must ensure the files are trapped
and color-matched before you submit them to Prinergy.

JTP

Select the job ticket processor (JTP) you want to use for Brisque
CT/LW files.

Note: You set up JTPs using Prinergy Administrator.

Resample LW

Resamples LW files to the specified resolution.

To enable resampling select the Resample LW check box and
then select the device resolution from the list, and specify the
unit of measurement for the resolution.

To disable resampling clear the Resample LW check box.

Scaling

Type the percentage at which you want Prinergy to scale CT/
LW files. Type 100% for no scaling.

Note: Scaling isn't recommended for CT/LW files.
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Fonts and Images section of the Refine process template

The Fonts and Images section of a refine process template controls
image replacement (PDF OPI) and font handling in PostScript, EPS, and
PDF input files during the normalizing step of the refine process.

Image Replacement

Standard OPI Image Links

Search for High-Resolution Images in Image Search Paths

Select this check box to direct Prinergy to request high-
resolution images in image search paths.

This check box applies to PostScript or PDF files that contain
OPI comments in low-resolution images generated by Asset
Library.

If the image is not found Prinergy either fails or continues with a
warning, depending on what is selected in the Fail on Missing
Images check box.

Asset Library Image Proxy Links

Search for High-Resolution Images in Asset Library

Select this check box to direct Prinergy to request high-
resolution images from Asset Library, an integrated asset
management system that enables you to easily manage a job's
digital assets, such as images and text.

This check box applies to PostScript or PDF files that contain
OPI comments in low-resolution images generated by Asset
Library.

If the image is not found Prinergy either fails or continues with a
warning, depending on what is selected in the If Asset Library
Image Not Found list.

History Logging

Use this list to determine whether History view displays
messages about images found in Asset Library and how much
detail is provided. Choose:

● Verbose to list the name of the PDF page that contains an
Asset Library image and the name of the image. The list
includes one line per image found.

● Normal to list the name of the PDF page that contains an
Asset Library image, the number of images on the page, and
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the name of the first image. The list includes one line per
PDF page.

● Terse to list the name of the input file, the number of PDF
pages that contain Asset Library images, and the total
number of images. The list includes one line per input file.

● None if you do not want History view to display messages
about Asset Library images

If Asset Library Image Not Found

Determines whether a page fails when Prinergy cannot find an
image in Asset Library for OPI. The options are:

● Warn & Search in Image Search Paths
● Fail Page

This list applies only when Search For High-Resolution Images
in Asset Library is selected.

Image Search Path Options

Search for Subfolders

Select this check box to have Prinergy automatically search
through the subfolders for images for an OPI image swap.
Searches the subfolders in alphabetical order and all immediate
subfolders are searched first before looking deeper.

Earlier versions of Prinergy required you to specify each folder
that contained images for the OPI image swap. This could be a
lot of work if you organize images into many different folders.
Now, while looking for a matching image, you can instruct the
system to search through subfolders.

If the option is selected, Prinergy searches the subfolders in
alphabetical order and searches all immediate subfolders are
searched first before looking deeper. The following diagram
shows the search order if the search path was set to the folder
images. The numbers indicate the order in which the OPI
engine encounters each file as it searches through the
subfolders.
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If the OPI engine is looking for the image fish.tif it will find file
number 5 inside the folder hires from tim after searching the
root folder (the folder images) and after searching the folder
dons images. If the OPI engine is looking for the image logo.eps,
it will find file number 2 rather than number 4.

Users are advised to consider that different images with the
same file name might be discovered by the search algorithm in
unexpected ways. The example contains two images named
logo.eps and this ambiguity could cause bad results. Users are
advised to check the refined pages carefully if there is any
doubt.

Recursive searching can take a long time if Prinergy has to
search many subfolders. Performance of refine processing may
be affected: be cautious when using this feature with search
paths pointing to large disks.

Skip Images With These Suffixes

If this check box is selected, OPI image replacement will not be
done for images with suffixes that are specified in this box (for
example, .tiff, .jpg, .jpeg).

This option is useful when there are high-resolution TIFF files
and low-resolution FPO (for placement only) files on the same
PDF page.

Fail on Missing Images

Available when the Search for High-Resolution Images in
Image Search Paths check box is selected.

Fails the normalize process when OPI can't locate an image.

When you enable this feature, Prinergy produces an error
message when OPI can't find an image for the input file.
Prinergy fails to produce a PDF file due to the missing image,
and displays an error message and/or icon ( ) in three places:
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in the Active Processes pane in Job Manager, in the Process
Info dialog box, and on the History view in Job Manager.

When you disable this feature Prinergy displays a warning
message or icon ( ) in the above locations when it can't find an
image for the input file. Prinergy still produces a PDF file, but it
is missing an image.

Image Attributes

Apply Clipping Path in Photoshop TIFFs

Select this check box to use the clipping path directly from
Adobe Photoshop TIFF images.

Note: If the source file is not designed to use the clipping path from the
Photoshop TIFF, unintended image clipping can occur. Check the refined
files carefully if there is any doubt.

Clear this check box to ignore the clipping path set in
Photoshop TIFF images.

Include Spot Channels in Photoshop TIFFs

Includes the spot color channels in addition to the CMYK
channels during OPI image replacement.

When this check box is selected, the OPI engine merges the
CMYK color channels with all spot color channels to produce a
single, multichannel DeviceN image. Further refine processing
such as color matching and trapping will function correctly for
these images. When this check box is cleared, all of the spot
color channels in the image file are ignored.

Spot color channels are created and edited using the Channels
palette. Note that although Adobe Photoshop includes the
name of the spot color channel, it does not include the recipe.
Users should select the Lookup Recipe in Color Database
option in the Spot Color Handling section of the refine process
template, to get an accurate color recipe for proper color
matching and trapping.

Be aware that Adobe InDesign software will not omit TIFF files
for OPI that contain spot colors, even when OPI is selected in
the Print dialog box. One workaround is to place a plain CMYK
TIFF proxy image first, generate PostScript from InDesign
software including the OPI comments (but omitting images),
and then put the TIFF file containing the desired spot color
channels into the search directories.
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Image Transparency

Create Soft Masks from Photoshop TIFF Alpha Channels

Creates effects such as feathered edges or soft silhouettes
during OPI image replacement.

Normal clipping paths cannot produce this effect-clipping paths
give only a hard edge to the image. Soft masks may give either a
hard or soft edge, depending on the design of the mask.

When enabled, the OPI engine looks inside the Adobe
Photoshop TIFF for an alpha channel to be used to create a soft
mask for the source image. If more than one alpha channel is
present, the first one is used-the remaining alpha channels are
ignored. When this check box is cleared, all the alpha channels
are ignored.

Note: This should not be confused with the Photoshop masking or
transparency features that are part of the Layers palette. Alpha channels
are created and edited using the Channels palette.

This feature is similar to the built-in capabilities of Adobe
InDesign, although it will work with QuarkXPress software or
any software that will generate OPI comments.

Make Drop Shadow Images Transparent

Select this check box to insert images into a layout that is
intended as a drop shadow for a second image that is placed on
top of the shadow image.

When this feature is enabled and the image is identified as a
drop shadow, the OPI engine applies the transparency blend
effect automatically. The image file names must use a special
extension that identifies them as drop-shadow images, rather
than normal (non-drop-shadow) images.

Transparent Drop Shadow Image Name Suffix

Sets the special extension for drop shadow images versus
normal images. The default extension is .shd. The value cannot
be blank.

Low Resolution Image Handling

Low Resolution Image Handling

Determines the system's response to low-resolution images.
The of Contone Resolution Below (ppi) box and the of Bitmap
Resolution Below (ppi) box determine which images are
considered low resolution.
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Select Ignore low resolution images when you want the system
to continue processing regardless of the image quality. No
warning messages are generated. When this option is selected,
the of Contone Resolution Below (ppi) box and the of Bitmap
Resolution Below (ppi) box are unavailable.

Select Warn for low resolution images when you want the
system to display a warning message/icon ( ) when the
resolution is less than the values indicated in the of Contone
Resolution Below (ppi) box and the of Bitmap Resolution
Below (ppi) box, but to continue processing.

Select Fail on low resolution images when you want the system
to display an error message/icon ( ) when the resolution is less
than the values indicated in the of Contone Resolution Below
(ppi) box and the of Bitmap Resolution Below (ppi) box, and to
stop processing. The system produces a PDF file, but a large,
black X covers the PDF content.

of Contone Resolution Below

The system handles contone images with resolutions below this
value with the action specified for low-resolution images in the
Low Resolution Image Handling box.

of Bitmap Resolution Below

The system handles bitmap images with resolutions below this
value with the action specified for low-resolution images in the
Low Resolution Image Handling box.

Fonts

Prinergy can only embed missing fonts when the input file is PostScript
or EPS. If Refining to PDF/X-1a:2001, Prinergy can also embed fonts if
the source files are PDF.

Fail on Missing Fonts

Select to have the system fail the refine to PDF process when it
can't find a font. When the system can't find a font in either the
input file or in a search path specified in the Font Search Path
dialog box, it produces a PDF file with a large, black X covering
the content, and an error message and icon appear in the
Processes pane and in the History view.

If you clear this check box a warning message and icon appears
in the Processes pane and History view when the system can't
find fonts in either the input file or in a search path specified in
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the Font Search Path dialog box. The system still produces a
PDF file, but the content is missing fonts.

In both cases if the process template has the Try Emulation
First check box selected, the system tries to synthesize the
missing font using Adobe's SuperATM Font Library. If the
process template has the Try Emulation First check box
cleared, or the system was unable to simulate the missing font,
the it uses the font specified in the Default Font box (the
system default is Courier).

Default Font

Type the name of the default font that you want Prinergy to use
as a substitute for missing fonts. Recommended setting:
Cleared.

If no font is specified Prinergy uses Courier font as a substitute.

Prinergy uses the default font when:

● A font is not embedded in the PostScript file
● A font is not installed (when you installed the Normalizer

JTP)
● A font can't be found in a font search path
● The Try Emulation First check box is not selected, or

Prinergy could not synthesize the font

Try Emulation First

Enables synthetic font substitution. When an input file's missing
fonts are part of Adobe's SuperATM Font Library, Prinergy can
construct synthetic fonts using Adobe's MultipleMaster font
technology. However, when missing fonts are not part of
Adobe's SuperATM Font Library, Prinergy uses the default font
specified in the Default Font box.

Therefore if Prinergy discovers a missing font and the process
template has the Try Emulation First check box selected,
Prinergy tries to simulate the missing font using Adobe's
SuperATM Font Library. If the process template has the Try
Emulation First check box cleared, or Prinergy was unable to
simulate the missing font, Prinergy uses the font specified in the
Default Font box (the system default is Courier).

Recommended setting: Cleared.

Remove Font XUIDs

XUID stands for extended unique ID, which is a font
characteristic introduced with Normalizer 6.
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Select this check box to remove font XUIDs if you are refining
files that may be exported and ripped on systems that use the
3011 RIP (Prinergy 2.2.1.10 or earlier) or other older RIPs.

If left unchecked, the older RIP may crash in some
circumstances.

Use System Fonts

Select to use fonts installed on the system instead of the fonts
embedded in the input files. If selected, the system fonts are
embedded in the input file during the refine process.

If you select this option but the system does not have the same
fonts as the input file, one of the following occurs:

● If the input file has embedded fonts, the refine process uses
these embedded fonts instead.

● If the input file does not have embedded fonts, the refine
process fails.

Note: This option does not work for Type3 fonts.

Override Resolution at 1200 dpi

Select this check box if you want to override the underlying
resolution that the normalize function uses when refining files.
This is required if you need to process low-resolution Asian
fonts.

See also:
About using OPI with transparent effects on page 267
Using soft masks during OPI on page 268
Using drop shadows during OPI on page 269
Including clipping paths during OPI on page 270
Including spot color channels during OPI on page 270
About image search paths on page 304
Font Converter on page 313

Normalize section of the refine process template

The Normalize section of a refine process template defines how
PostScript files are converted to reliable PDF pages.

This section is required and cannot be disabled.

JTP

Specifies the job ticket processor that Prinergy will use for
normalizing.
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Note: You set up JTPs using Prinergy Administrator.

PDF Level Handling

Indicates how Prinergy will handle PDF 1.4-1.6 files.

PDF 1.4-1.6 (Acrobat 5-7) files can contain a transparency
feature that cannot be described in native form in PostScript or
in PDF 1.3. For transparency and layers to be represented in
PostScript and PDF 1.3 files, the file must be flattened into a
single layer.

These are the options for handling PDF 1.4-1.6 files:

Leave as is

PDF 1.4-1.6 files are processed without any conversion.

Flatten to PDF 1.3

Prinergy flattens PDF 1.4-1.6 files into a single layer.

Fail

Processing fails when Prinergy encounters any PDF
1.4-1.6 files.

Warn when Converting

This option is available when you select Flatten to PDF
1.3. Prinergy gives a warning when it flattens a file.

Default Page Size

Specifies the page size for the refined PDF file.

Select from the list of common sizes, or select Custom, and
then enter your own default measurements.

When you select a standard size, the Width and Height boxes
are set to the correct values. If you change these values, the box
is automatically set to Custom. Use the Width and Height
boxes to specify the default page width and height in the
selected unit of measure.

In most cases, input files contain page size information.
Prinergy uses the page size information in the input file unless
you select the Override Page Size check box, or if the input file
does not contain page size information.

If you select the Override Page Size check box, Prinergy uses
the information in the Default Page Size area, instead of the
page size information in the input file.
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When input files do not contain page size information, Prinergy
automatically uses the information in the Default Page Size
area. The following files are examples of PostScript files that do
not contain page size information:

● PostScript from PTX (the Imation PrePress XTension for
QuarkXPress)

● PostScript from the QuarkXPress software that uses the
Save as EPS option

● PostScript from LaserWriter drivers later than version 8.4
● Files produced by custom or proprietary software—for

example, directory printers, phone books, and so on

Apply Acrobat rotation

Retains the page rotation specified in Acrobat.

If this check box is selected, the resulting refined file retains the
rotation as specified in Acrobat, even if used in older Prinergy
releases or other workflow RIPs that do not honor the Acrobat
rotation.

Suppress Generation of Failed SubPages

Prevents a page from being generated if it fails on refine.

If this check box is selected and an input file fails on refine,
Prinergy does not register the input file in the database nor does
it generate a PDF page.

All error-free subpages in the file will generate normally. For
example, if a file contains three subpages and the first is flawed,
this is the result:

● The first subpage refines with an error and no file named
<file>.p1.pdf is generated.

● The second and third subpages refine correctly and files
named .p2.pdf and .p3.pdf are generated.

Apply Photoshop-embedded ICC Profiles

Indicates that Prinergy should turn any ICC color profile that
was embedded as a comment into an EPS file or other image file
using Adobe Photoshop software, into a standard ICC color
profile in the refined PDF file. If you want the profile to be
applied during color matching, you should also enable the
ColorConvert section of the refine process template.

Clear this check box if you want the color data in the file to
remain unchanged.
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Lines

Minimum Line Weight

Specifies the desired minimum weight of thin lines in input files.
Type the minimum size, and select a unit of measure.

Thicken Thin Lines (PS Only)

Thickens lines in input files that are below the line weight
specified in the Minimum Line Weight box. The lines are
thickened to the weight specified in the Minimum Line Weight
box.

Note: This feature does not thicken thin lines in PDF input files. If you
select the Thicken Thin Lines (PS Only) check box and either the Warn
for thin lines or Fail on thin lines options and submit a mix of PDF and
PostScript files to Prinergy, Prinergy will thicken thin lines in the
PostScript files and either warn you about thin lines in the PDF files or fail
the refine process on the PDF files with thin lines.

Thin Line Handling

Determines how the system handles lines in input files that are
thinner than the value specified in the Minimum Line Weight
box. There are three options:

Ignore thin lines

Thin lines are ignored and no warning message appears.

Warn for thin lines

The system detects thin lines that it cannot thicken and
displays a warning message.

Fail on thin lines

The system fails the refine to PDF process when it
detects thin lines that it cannot thicken.

Note: If you select the Thicken Thin Lines (PS Only) check box and either
the Warn for thin lines or Fail on thin lines options and submit a mix of
PDF and PostScript files to Prinergy, Prinergy will thicken thin lines in the
PostScript files and either warn you about thin lines in the PDF files or fail
the refine process on the PDF files with thin lines.

Security

Secure PDF Password

Stores the password needed to successfully open and process a
secure PDF document.

212 Chapter 10—Refining



A PDF document can have password security for opening, or
editing and printing, or both. In order to successfully normalize
the document, the most significant password must be provided.
Type the editing and printing password if it has been set in the
document. Otherwise, type the opening password.

Note: Prinergy supports the following security methods—password with
40-bit RC4, 128-bit RC4, or 128-bit AES encryption. The following
security methods do not work with Prinergy—password with 256-bit AES
encryption, Certificate-based security, and Adobe LiveCycle Rights
Management.

Separations

Re-combine

Specifies that overprinting should be used to create a
composite PDF file from a separated input file. Re-combining
enables the file to be trapped and to be viewed from devices
that cannot combine separations.

Selecting the Re-combine option automatically enables the
Copydot option of the refine process template. This protects
any copydot images that might be in the file from being trapped
and/or color matched. Trapping or color matching copydot
images can introduce artifacts or cause the Trapper to run very
slowly.

Note: For best results, disable the ColorConvert section if using the re-
combine feature. Using color matching with Re-combine produces
unpredictable knockouts.

If you must color match, ensure that you perform the following
actions:

● Clear the Set Overprint CMYK White to Knockout check
box (which is enabled by default in the ColorConvert
section). If the check box is selected, the re-combine feature
may convert blank (white) objects to an overprint CMYK
white object in the composite PDF.

● Check the output carefully for unintended knockouts.

Note: For best results, do not trap recombined pages unless you are
certain that the pages do not already contain traps. Software such as
QuarkXPress inserts traps in separated output only. Because mixing
traps from other software with Prinergy traps can give inconsistent
results, ensure that a single trapping method is used.

Input Config File
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Normalizer Input Configuration File

The Normalizer Input Configuration file is a configuration file
used by the Prinergy system.

By default, Prinergy Workshop is set up to use the standard
configuration file (NormInputConfig). Most Prinergy users
will not need to change this selection.

Some customers may have modified this file for such purposes
as PostScript bypass. If you need one or more specialized
versions of the configuration file, you can attach one to a refine
process template by clicking the Browse button and selecting
the file from its network location. This feature allows the
NormInputConfig file to be process-template-specific,
which is useful in certain workflow configurations.

Note: If you do not use the Browse button to select a path, but type in a
file name instead, Prinergy will search for the file in the executable
directory (%AraxiHome%\AdobeExtreme\bin).

The Prinergy Administrator Diagnostics viewer (DIAG) will
show which configuration file is being used.

Color Space Control

Input File Control

The color space control settings let you screen for input file
data that is in nonpress (nonCMYK or nongrayscale) color
spaces.

Ignore

Prinergy ignores RGB or device-independent data in
input files. If you select Ignore, the Detect RGB and
Detect Device Independent check boxes are
unavailable and cannot be selected. If Prinergy
encounters RGB or device-independent data, it gives no
message and doesn't fail the job.

Warn

Prinergy issues a warning when the selected data type
is found in the input file. A warning message and yellow
triangle appear in the Process Info dialog box and job
history for each check box that is selected. A PDF file is
created. A large X does not cover the PDF content.

Fail

Prinergy fails the job when the selected data type is
found in the input file. An error message and red X
appear in the Process Info dialog box and job history for
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each check box that is selected. A PDF file is created,
but the content is covered by a large black X.

Input File Control works in conjunction with the Detect RGB
and Detect Device Independent check boxes. You select an
Input File Control option to indicate how you want Prinergy to
respond when it locates data in a nonpress color space. You
select the Detect RGB and/or Detect Device Independent
check boxes to indicate what type of data you want Prinergy to
detect.

Note: Settings in the ColorConvert section of the refine process template
determine if and how the undesired color spaces are converted.

You can set these same options in the Optimize section of the
refine process template. You can have the Color Space Control
settings enabled in either the Normalize section or the
Optimize section, or both. Turning the settings on in the
Optimize section allows you to check that color conversion was
performed in the refine stage as you expected.

You might want to warn only about RGB and CIE-based color
spaces in the Normalize section, because you are converting
them in the Color Matcher, but warn during optimizing about
CIE-based color spaces that the Color Matcher wasn't set up to
convert.

Detect RGB

Select this option to have Prinergy detect RGB data in the input
file.

The Input File Control selection determines what Prinergy will
do if it finds RGB data.

The Detect RGB check box is unavailable if the Input File
Control selection is Ignore.

Detect Device Independent (ICCBased, Lab, CalGray, and CalRGB)

Select this option to have Prinergy detect device-independent
data in the input file—for example CIE L*a*b* data.

The selection for Input File Control determines how Prinergy
behaves when it finds device-independent data.

The Detect Device Independent check box is unavailable if the
Input File Control selection is set to Ignore.

Separated File Control

These control settings let you detect nongray images (raster
data) and nongray vector data in separated input files.
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In each of the Detect Non Gray Images and the Detect Non
Gray Vector Data lists, select one of the following options:

Ignore

No warning is issued.

Warn

A warning is issued when Prinergy detects nongray data
(of the type specified).

Fail

The refine process fails when Prinergy detects nongray
data (of the type specified).

CEPS Detector

Enable CEPS (CT/LW and TIFF/IT) Detection

If the Enable CEPS (CT/LW and TIFF/IT) Detection feature is
selected, Prinergy will detect CT/LW content or converted
forms of CT/LW or TIFF/IT on a page. Prinergy marks the CT/
LW data so that it is not trapped and any overprint settings are
not modified.

Trapping CT/LW data may produce artifacts such as hairline
gaps on the refined PDF page. Changing overprint settings may
create a result that was not intended, such as removing existing
traps.

This feature is helpful for mixed content—for example, content
with vector text and CEPS format images. In this case, the
Enable CEPS Detection feature will mark the CEPS content so it
will not be trapped and the overprint settings will not be
changed. The vector content will be trapped and the overprint
settings will be changed.

This feature is also useful for sites where the operator does not
know whether a page was originally CEPS. In this case, the
feature will mark the entire CEPS page so it will not be trapped
and the overprint settings will not be changed. Vector-based
pages will be trapped and overprint settings will be changed.

If this feature is enabled and CT/LW or TIFF/IT data is detected
in an input file during refining, a message appears in the Process
Info dialog box for the process, and in the history log.

Note: This feature works only if you use the Trapper and Color Matcher
JTPs.

Versioning Automated Page Assignment
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Build Versioned Page

Select this check box if you are using page name patterns to
automatically link refined pages to versioned pages.

This is part of layered PDF versioning. For information, see the
Prinergy Layered PDF Versioning User Guide.

Spread Splitting

The reader-spread-splitting feature automates the process of
splitting 2-up reader spreads into discrete pages. These discrete
pages can then be assigned to page set positions and the
imposition.

Note: You can split reader spreads only during the first refine.

Split Reader's Spread Pages

Select this check box to enable the types of reader spread
layouts. Select the check box beside the icons that represent
how the pages are laid out.

● When splitting a multipage file, determine how the pages are
bound (left- or right-bound) and the location of the first and
last pages. Consider -N- to be the last page in the spread.

Binding style First and last
pages

Select check box

Left Bound Together

Apart

Together

Right Bound Together

Apart

Together

● When splitting a single-page file, determine how the two
pages are laid out. Consider -N- to be page 2. (Ignore the
Left Bound and Right Bound labels and the other page
icons.)

Page 1 Select check box

On the left

On the right

Centerfold Bleed

Specifies the size of the bleed box for the split page. The bleed
is captured from the adjoining page.
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PDF Box Handling

Eliminate TrimBox and BleedBox

If this check box is selected, Prinergy uses the trim and bleed
values in the media box.

If this check box is cleared, Prinergy uses the trim and bleed
values in the original PDF file.

Output Intent

Use this area to specify an ICC profile or named print condition
in the Output Intents section of the PDF/X file that you are
generating.

A named print condition is a documented printing situation with
a defined relationship between input data and the colorimetry
of the printed image. Typically, named print conditions are
registered with an organization such as the ICC.

Perform one of the following actions:

● To specify an ICC profile, select the Profile check box, and
specify the path of a profile.

● To specify a named print condition, select the Name check
box, and select a print condition from the list.

● To use the ICC profile specified in the ColorConvert section
for PDF/X generation, click the Use ColorConvert
Destination profile check box.

Note: Match Colors in Page Content in the ColorConvert section
must be selected.

This area is available only when a PDF/X format is selected in
the Output To list at the top of the process template.

See also:
About transparency support on page 163
Copydot section of the Refine process template on page 220
About reader spread splitting on page 260
About PDF/X on page 630

PDF Preflight section of the Refine process template

The PDF Preflight section of a refine process template defines the
profile used to check for errors and defines how to handle those errors.
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Important: Enabling this section disables the following options in other sections of
the refine process template because the preflight profile is controlling these
aspects:

● In the Generate list, the PDF/X-1a:2001 option is unavailable
● In the Normalize section, Color Space Control and CEPS Detector areas are

unavailable
● In the Optimize section, all areas are unavailable

In the preflight profile, the Font and OPI controls do not operate, even
though they are available. Prinergy will, however, report missing fonts
in a preflight report regardless of the profile setting.

Preflight Profile Files

Select a PDF Preflight profile to use to evaluate your pages.

Preflight Handling

Select to determine how Prinergy responds to PDF Preflight
errors in a page. (You classify conditions that are errors in PDF
Preflight profile editor.)

Warnings: Ignore on Warning-Prinergy completes processing.

Warnings: Warn on Warning-PDF Preflight warns you of
warnings. Warning messages appear in the Active Processes
Pane in Job Manager and in the History view.

Warnings: Fail on Warning-PDF Preflight places an 'X' across
all pages with warnings. The preflight process does not stop at
the first warning.

Error: Ignore on Error-Prinergy completes processing.

Error: Warn on Error-PDF Preflight warns you of errors.
Warning messages appear in the Active Processes Pane in Job
Manager and in the History view.

Error: Fail on Error-PDF Preflight places an 'X' across all pages
with errors. The preflight process does not stop at the first
error.

Note: You can select only an equal or more severe behavior for errors as
for warnings. For example, if you select Warn on Warning, then the
choices for errors is reduced to only Warn on Error or Fail on Error.

Note: You can stop the generation of failed subpages when you set up
your preflight profile to Fail on Errors. In the refine process template,
Normalize section, select the Suppress Generation of Failed Subpages
check box.

Report
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Create Report on Error

Select if you want a PDF Preflight report for each PDF page that
has preflight errors.

Always Create Report

Select if you want a PDF Preflight report for each PDF page.

Auto Report Generation

Automatically generate PDF version of Preflight Report

Select if you want Prinergy to automatically generate a PDF
version of the Preflight report. One Preflight report is created for
each input file.

The resulting report is appropriate for distribution outside of the
Prinergy system, for example, e-mailing.

Create One Report per Input File

Select to create a separate PDF Preflight report for each PDF
page.

This option is not available unless you select the Automatically
generate PDF version of Preflight Report check box.

Preflight Report Location

Type the path or navigate to the directory in which you want the
Preflight report to be created.

Copydot section of the Refine process template

The Copydot section of a refine process template defines how Prinergy
handles copydot files.

When you enable the Copydot section, the system automatically
reformats copydot images for optimal performance during output. Only
disable the Copydot section for one or more of the following reasons:

● Your input files lack copydot images.
● You have already optimized the copydot images in your input files.
● You don't need alternate images.

JTP

Select a job ticket processor (JTP) to use for copydot files.

Note: You set up JTPs using Prinergy Administrator.
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Resample

Enables resampling of copydot files to the specified resolution.
Use this feature when you want the resolution of copydot
images in your refined content to match that of your output
device.

Select the Resample check box to enable resampling of copydot
files.

Clear the Resample check box to disable resampling of copydot
files.

Note: You can resample copydot images during final output instead of
during refining.

Target Resolution

Specify the resolution of the target output device in the X and Y
boxes, and then select a unit of measure.

Generate Alternate Images

Generates alternate low-resolution images, which Prinergy uses
when you use the Publish PDF feature. The system
automatically descreens alternate copydot images to 300 dpi,
and they are JPG compressed.

Select this check box to generate an alternative image for each
copydot image.

Clear this check box to disable this feature.

Spot Color Handling section of the Refine process template

The Spot Color Handling section of a refine or re-refine process
template defines how Prinergy handles spot colors, and defines which
libraries color recipes are retrieved from.

This section is required and cannot be disabled.

JTP

Select the JTP (job ticket processor) to use for spot color
handling. Spot Color Handling uses the Color Matcher JTP.

Note: You set up JTPs using Prinergy Administrator.
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Map Spot Colors

Note: The options in the Color Mappings dialog box override the options in this
section.

Enable Spot Color Mapping

Enables you to control spot color mapping.

If this check box is selected, you can either:

● map all colors to process by selecting the Map All Spot
Colors to Process option

● map some colors to process and not others by editing the
Color Mappings dialog box

● not map spot colors by selecting the Don't Map Spot Colors
option

If this check box is cleared, all spot color mapping is disabled,
including the settings in the Color Mappings dialog box.

Map All Spot Colors to Process

Converts spot colors in input files to process color.

This option is only available when the Enable Spot Color
Mapping check box is selected.

Don't Map Spot Colors

Retains spot color definitions as they are defined in the input
file.

This option is only available when the Enable Spot Color
Mapping check box is selected.

Customize Spot Color Mapping

Selecting this option enables the Color Mapping button which
allows you to specify spot color mapping instructions for a list
of colors, as well as indicate the default setting for colors not
listed.

If this option is not selected, the Color Mapping button is not
available and you can access color mapping from the Start
Process dialog box.

If you set spot color mapping in the Start Process dialog box,
the color mapping setting in the process template are ignored.

Process CEPS Data

Select this check box to specify spot color mapping and color
matching of CEPS data.
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For more information, see the help on the CEPS Conversion
section and the Normalize section of the refine process
template.

Source of Color Recipes

Extract Recipe from the File

Select this option to use the color recipes defined in the PDF
file.

Lookup Recipe in Color Database

Select this option to look up the color recipes in Prinergy color
libraries.

Color Libraries

Selectable

From the Selectable list select the color libraries that you want
Prinergy to search for color recipes, and click Add.

Note: Ensure that you select color libraries with color spaces that are
compatible with the Final Output Process Profile.

Selected

Using Move Up and Move Down arrange the color libraries in
the Selected box in the order (descending) that you want them
to be searched.

To remove a color library from the list select the color library
and click Delete.

Use Recipe from File if not found in Color Database

Select this check box if you want to use the color recipe defined
in the PDF file if the color is not found in any of the selected
color libraries within Prinergy.

Note: Currently, this check box cannot be cleared.

Auto-Resolve Spot Color Naming Conflicts

If the Auto-Resolve Spot Color Naming Conflicts option is
enabled, Prinergy automatically changes some PANTONE spot
color name endings.

For example, spot colors ending in CV or CVC are always
renamed with a C name ending.

The following table indicates how Prinergy will change spot
color name endings.
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Original Spot Color Name Ending Spot Color Name Ending After Auto-Resolve

CV, CVC, PC, EC, no suffix C

CVU U

The following spot color name endings are not changed: C, U,
CVS.

Where spot colors are renamed, they are renamed on all pages
of a refined document, not just on pages that have identical
colors with different name endings.

The purpose of the renaming is to have identical PANTONE
spot colors end up on the same separation, even if they have
different name endings. A single plate can then be made for
that PANTONE color for the sheet.

Note: PANTONE 028 C (coated) and PANTONE 028 U (uncoated) both
print using the same ink (a mixture of pigments specified by the
PANTONE corporation), but they are different colors because they are
print on different paper stocks (coated vs. uncoated). Prinergy doesn't
automatically rename these colors because it assumes they are different
colors. However, you may use the color mapping feature to force the
colors to show up on the same separation.

Resolve Ambiguous Spot Color Definitions

Causes the system to choose a single spot color definition if a
file contains multiple definitions for a spot color.

The system chooses the best definition based on the color
space and alternate color definition (ACD).

● A definition with Separation color space that defines the
colorant is preferred over a DeviceN color space where the
colorant is only one of many colorants.

● The ACD is chosen in the following order of priority:

1. L*a*b*
2. CMYK
3. Gray
4. RGB

If this check box is cleared, any file with multiple definitions for
a spot color may:

● Not display the spot color consistently in the layout
application (such as QuarkXPress and InDesign)

● Incorrectly map the spot colors to process if Map All Spot
Colors to Process is also selected
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Convert to Destination

Primary Color Output

Specify the ICC profile that objects to be color-matched will use
for final output.

You must specify an ICC profile in this box, regardless of
whether your final output process is for a proofer or printer.

Note: This box is located in the ColorConvert section and the Spot Color
Handling section of the refine process template. Changing the entry in
one section changes the entry in the other section.

Note: In the ColorConvert section, the Primary Color Output box is
unavailable when the Enable ColorFlow check box is selected. The ICC
profile is automatically delivered by ColorFlow in this case.

See also:
Color Mappings dialog box on page 826

ColorConvert section of the refine process template
The ColorConvert section of the refine process template defines how
Prinergy handles overprints and uses ICC profiles and ColorFlow device
conditions to transform color data from the input color space to the
output color space.

JTP

Select the JTP (job ticket processor) to use for color conversion.
For converting colors, use the Color Matcher JTP.

Note: You set up JTPs in Prinergy Administrator.

Overprint Conversion

Select to perform automatic conversion of overprints.

Set Colors to Knock Out

Select this check box to override the overprint setting in the
input file and knock out the colors. As a result, color printing
order affects which separation is knocked out.

This feature makes content color matching available for all
objects on a PDF page.

Set Black to Overprint when Black is ___ % or higher

Select this check box to overprint pure black objects (that is,
K=1–100% and CMY=0%) when the black tint equals or is
greater than the value that you specify in the adjacent box. For
example, if an input file contains a black object with 75% black

ColorConvert section of the refine process template 225



and you type 70% in the adjacent box, Prinergy overprints the
object.

Set Rich Black to Overprint

Note: The Set Rich Black to Overprint check box is available only when
the Color Matcher JTP is used.

Select this check box to overprint all rich black objects (that is,
K=100%, and at least one of C, M, and Y has more than 0%
tint). When the Set Rich Black to Overprint check box is
selected, the Set Black to Overprint check box is automatically
selected.

Note: Overprinting rich black may result in high ink coverage in some
areas, depending on the percentage of tint in the C, M, and Y channels.

Set Overprint CMYK White to Knock Out

Select this check box to knock out all white objects.

White is considered white when black (K) is less than 0.9%—
that is, C=0%, M=0%, Y=0%, and K<0.9%.

Sometimes a graphic designer inadvertently defines white
(which is really the absence of ink) to be overprinted, which
makes white objects invisible when the file is RIPed. For white
to be visible, it must be knocked out.

If you want all white objects to be overprinted, clear the Set
Overprint CMYK White to Knock Out check box.

Enable Gray Overprint

Note: The Enable Gray Overprint check box is available only when the
Color Matcher JTP is used.

The Enable Gray Overprint check box affects grayscale objects
that are set to be overprinted. The Color Matcher JTP
represents the overprint mode of grayscale objects in a way
that the RIP can process. By default, this check box is selected.

When the Enable Gray Overprint check box is cleared, the
Color Matcher JTP doesn't affect the overprinting of grayscale
objects. This results in knockout behavior for CMYK objects
below the grayscale object and may be the preferred behavior
in some situations.

Note: You can view the overprint mode in the Enfocus PitStop software
and view the results in the Virtual Proofing System software or in the
Acrobat software.
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Enable CMYK Overprint

Select this check box to convert the overprint mode from OPM
0 to OPM 1.

When an object is overprinted with OPM 0, channels with no
data are painted with a tint of zero. For example, the zero
channels in a 100,0,0,0 CMYK object knock out the channels of
a 0,100,100,100 CMYK object. The channels of the
0,100,100,100 CMYK object overprint only a spot object.

When an object is overprinted with OPM 1, channels with no
data are not painted at all, causing background objects that are
painted in that channel to show through the channel. For
example, the zero channels in a 100,0,0,0 CMYK object
overprint the channels of a 0,100,100,100 CMYK object.

For more information on OPM, see a PostScript or PDF
reference guide.

Overprint Handling (CPU Intensive)

Select this check box to use vector overprint handling, which
prevents overprinted objects from generating unintended
knockouts, including on objects printed on a transparency stock.

Apply vector overprint handling if you are converting spot
colors to process colors or if you are color matching from one
CMYK color space to another CMYK color space. Kodak
Spotless color management involves the conversion of most
spot colors to process colors.

Note: Applying vector overprint handling is very CPU intensive. Your
computer may slow down considerably.

Note: This feature does not eliminate all overprints. For example, in
objects where overprinting does not have an effect on output, these
objects are still considered overprints. For example, if you set black to
overprint other objects, but one black object is not placed on top of
another object, the black object is still considered an overprinted object
after overprint handling.

Final Output Resolution

Type the resolution that is suitable for the intended output
device.

The default setting is 2400 dpi.

Preserve Traps

Select this check box to preserve existing Kodak traps when
vector overprint handling is used.
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Note: When existing traps are preserved, you cannot remove them in
later processing. You must remove the traps in the original file. Traps are
color-managed as regular objects.

Match Colors

The Color Matcher JTP handles color management in Prinergy.
It performs the following functions:

● RGB image conversion
● CMYK-to-CMYK color matching

Prinergy is shipped with a standard ICC profile that
automatically converts RGB images and graphics to CMYK.

For CMYK-to-CMYK color matching, the Color Matcher JTP
uses ICC profiles to transform the color space of a PDF file to a
color space that is appropriate for a particular output device.
The Color Matcher JTP is a purchased option for Prinergy.

When color matching is selected during the refine process,
color data is matched to an output device.

Preserve White and Black Colors for Graphics

When this option is selected, the Color Matcher JTP bypasses
pure white and pure black. For example, if an input file has a
build of 0,0,0,100, Color Matcher does not touch the input
build of pure black, for graphics only. Similarly, for pure white, if
an input file has a CMYK build of 0,0,0,0, Color Matcher does
not touch the input build of pure white. The following builds are
also preserved:

● 255,255,255 RGB
● 0,0,0 RGB
● 255 Gray
● 0 Gray

Preserve Any CMYK Pure Black for Graphics

When this option is selected, Color Matcher bypasses all
CMYK (0, 0, 0, 0...100) colors. The options are available
regardless of whether ColorFlow is used. The options are also
unrelated to the use of a DeviceLink profile.

Override Embedded Profiles

Select the desired CYMK Graphics, CMYK Images, RGB
Graphics, and RGB Images check boxes to ignore the color
profiles that are embedded in input files. These selections
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enable you to assign different profiles to images and graphics,
as specified in the Assign Input Device Conditions area.

Note: If no profiles are specified in the Assign Input Device Conditions
area, the embedded profiles are removed and are not replaced.

If you do not select a check box, the Color Matcher JTP
processes a color space for images and graphics that have an
embedded profile, working in conjunction with the Primary
Color Output profile. Images and graphics are converted to the
CIE L*a*b* space before being converted to the final output
space. If there is no embedded profile, the Color Matcher JTP
processes a color space for a profile assigned in the Assign
Input Device Conditions area.

Enable ColorFlow

Select this check box to use the ColorFlow software, which
provides color relationship management that unifies all color
elements (such as ICC profiles and curves) and manages the
relationship between them and the device print conditions.
When you select Enable ColorFlow, the adjacent Snapshot and
Color Setup lists become available.

Snapshot

A ColorFlow snapshot captures the state of the entire color
database, making its elements available to the workflow and
providing a convenient backup. The snapshot feature makes it
unnecessary for you to manually save and name multiple
versions of your color control elements after adjusting them. At
any time, you can easily roll back (revert) to the state of a
previous snapshot in the ColorFlow software. If you roll back to
a previous snapshot, ColorFlow behaves as if changes after that
snapshot never happened.

When you have completed your work in ColorFlow to a certain
level and you are satisfied with the elements in color setups,
you will mark a snapshot as approved. By default in Prinergy
Connect, the currently approved snapshot is used. Only one
snapshot can be in the approved state at any time.

Color Setup

From this list of color setups that have been created in the
ColorFlow software, select either a specific color setup or
<Job_ColorSetup>.

Note: This list includes all color setups that have been created in the
ColorFlow software. A color setup is a collection of device conditions and
the color control elements (curves, device profiles, and DeviceLink
profiles) that are required to match a common target on all the
reproduction devices.
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All color setups associated with the selected color database
snapshot are listed.

If you select a specific color setup, that color setup is applied to
a job's files when the files are refined using this process
template. If you select <Job_ColorSetup>, the default color
setup specified for the job is used instead.

Assign Input Device Conditions

In this section, you can assign source profiles (device profiles)
to images and graphics to define the input color space for those
objects. Source profiles use an RGB color space, similar to a
scanner, digital camera, or monitor. Images refers to raster
image data, and Graphics refers to vector data.

You can also use a DeviceLink profile that includes both the
source and the destination ICC profiles. A DeviceLink profile
can be used to replace a source file in Prinergy. DeviceLink
profiles enable you to go from one color space to another
without converting to CIE L*a*b* and produce very good results
with more shadow detail. The most common types of
DeviceLink profiles are RGB to CMYK and CMYK to CMYK.

Both CMYK-to-CMYK and RGB-to-CMYK profiles convert from
one color space to another—for example, from a source color
space to a destination color space. The CMYK-to-CMYK profile
also converts from one color model to another.

The source profile is applied if the CMYK Images, CMYK
Graphics, RGB Images, or RGB Graphics check box is selected
and a selected object in the input file does not have an
embedded profile. Each type of object has a check box for
selecting color matching and a box where you can enter the
input ICC profile file information.

Note: An ICC profile is a color space description that acts as a standard
for accurate reproduction of colors across different platforms, devices,
and applications, according to the standards of the International Color
Consortium (ICC). For example, an ICC profile that describes a specific
RGB device, such as a Kodak EasyShare camera, provides a mapping of
the camera's red, green, and blue color space to device-independent
L*a*b* coordinates (or CIELAB color space). ICC profiles are stored on
your home server at CreoAraxi\data\ICC-Profiles.

To disable color matching for an object type with no embedded
profile, clear the check box beside that object type.

Note: The default action for RGB images and graphics is to convert them
to CMYK using a standard ICC profile that is shipped with Prinergy. The
default source profile is Monitor\Adobe RGB 1998.icm, and the
default destination profile is US WebCoated SWOP.icm.
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Note: When the Enable ColorFlow check box has been selected, you
select input device conditions, not ICC profiles or DeviceLink profiles.
The input device conditions that are available in this case are the
conditions that have been configured in ColorFlow (which then supplies
the DeviceLink profiles for the CMYK-to-CMYK or RGB-to-CMYK
conversion). For more information, see Tell me more about the
ColorFlow and Prinergy integration on page 837.

Primary Color Output

Specify the ICC profile that objects to be color-matched will use
for final output.

You must specify an ICC profile in this box, regardless of
whether your final output process is for a proofer or printer.

Note: This box is located in the ColorConvert section and the Spot Color
Handling section of the refine process template. Changing the entry in
one section changes the entry in the other section.

Note: In the ColorConvert section, the Primary Color Output box is
unavailable when the Enable ColorFlow check box is selected. The ICC
profile is automatically delivered by ColorFlow in this case.

Prefer embedded Output Intents for Final Output Profile

If your input file is PDF/X-3 and you want to use the color
profile specified in the PDF/X-3 output intents, select the Prefer
embedded Output Intents for Final Output Profile check box.

Note: This check box may also support PDF/X-1a input files with an
output intent tag.

Retain CMYK Black In

Select this check box to preserve black in images and graphics
that are defined in the CMYK color space.

For ICC-based color-matching engines, CMYK images and
graphics are transformed from CMYK to L*a*b* and back to
CMYK, so that Prinergy can perform color matching. During the
transformation from CMYK (four components) to CIE L*a*b*
(three components) and back again, the black (K channel
separation information—UCR/GCR) has in the past been
destroyed. When selected, this check box instructs the Color
Matcher JTP to preserve the black channel information as much
as possible. As a result, the amount of black relative to CMY in
the images and graphics remains about the same. This practice
helps reduce ink consumption.

Note: When you select this check box, the Color Matcher JTP requires
additional processing time because of the extra calculations involved.
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Note: When ColorFlow has been specified, the Retain CMYK Black In
options are unavailable, because all black generation parameters are
specified when DeviceLink profiles are created.

CMYK Images

Select this check box to preserve the black channel information
when CMYK images are transformed from CMYK to L*a*b* and
back to CMYK.

CMYK Graphics

Select this check box to preserve the black channel information
when CMYK graphics are transformed from CMYK to L*a*b*
and back to CMYK.

Rendering Intent

Select a colorimetric rendering intent for the selected object
types:

● In the Images in: section, select CMYK, RGB, or Calibrated
Colors

● In the Graphics in: section, select CMYK, RGB, or Calibrated
Colors

Select Relative to turn off gamut compression and retain color
saturation for the selected object types.

Select Perceptual to use gamut compression and produce fewer
saturated colors for the selected object types.

Select From PDF to use the rendering intent that is specified in
the file when output by the creative software for the selected
object types.

Select Absolute to represent the colors solely with the light
source for the selected object types. No correction is made for
the output media's white point. For example, an output media's
white point might be the color of paper with no print marks on
it.

Select Saturation to represent the colors in a way that
preserves or emphasizes saturation for the selected object
types.

Note: Calibrated colors are described in a device-independent color
space, such as an ICC-based color space, CalGray, or CalRGB. For
colorimetric rendering of calibrated colors, do not select the Override
Embedded Profiles check box.
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Treat pure gray RGB as gray

Select this check box to convert pure gray RGB to a black-only
process color.

Pure gray RGB is defined as any gray that is created by equal
values of red, green, and blue—for example, R=23, G=23, B=23.

Treat shading as

Use this option for color-matching shadings.

By default, this option is set to Image, because Prinergy
typically treats shading objects as images. When an input file
doesn't define a source profile for shading, Prinergy uses the
source profile from the image.

Select Graphic for PDF pages with shading and gradients that
look similar, when you want shading and gradients to appear
the same after color matching.

Process CEPS Data

Select this check box to specify spot color mapping and color
matching of CEPS data.

For more information, see the help on the CEPS Conversion
section and the Normalize section of the refine process
template.

Color match 1-bit images

Select this check box to color match 1-bit images. One-bit
images are images that represent two tones, typically black and
white. The pixel is either a 0 or 1 value. Examples are copydot
images.

Note: When selected, this check box converts 1-bit images to 8-bit
images. The conversion causes pages to become larger and to render
more slowly. Clear this check box if you do not require color matching of
1-bit images or if the feature causes unacceptable performance
degradation. (For example, copydot files take a very long time to refine
and render.)

This check box is available when Match Colors in Page Content
is selected.

Reset to Defaults

Select to return all options to the default (factory-set) values.

Trap section of the refine process template

The Trap section of the refine process template determines how
Prinergy handles trapping in input files.
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JTP

Specifies the JTP (job ticket processor) that Prinergy will use for
trapping.

Note: You set up JTPs using Prinergy Administrator.

Trap Settings

Retrap Trapped Pages

Instructs the system to retrap pages that have already been
trapped in Prinergy. This does not delete traps created in
upstream software.

Trap Time-out

Manages job throughput by setting a time limit on the trapping
step of the refine process. If the site production schedule
requires that there be a maximum time limit on trapping files,
any files that exceed the time limit can either be reviewed in the
Prinergy PDF Trap Editor plug-in in Acrobat or trapped at a time
when no other jobs are in the queue.

The default setting for Trap Time-out is 0 seconds—that is, no
expiration time for the trap step. Any other setting for Trap
Time-out would typically factor in the demands of the shop
schedule and the complexity of the file being trapped.

Note: This option is available only if the Trapper JTP is selected in the
JTP box.

Trap Tiling Pattern

Traps all of the internal objects in a tiling pattern. Trapping a
tiling pattern can result in too much complexity and can slow
down trapping, so this option can be turned off. The Trap Tiling
Pattern check box is selected by default. The rest of the file is
also trapped.

Note: This option is available only if the Trapper JTP is selected in the
JTP box.

Size

Width/Height

Specifies the width and height of a trap.

Type in the values for width and height, and then choose a unit
of measure.
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Line Splits

Controls the size of traps that extend into stroked objects.

Strokes with a width of up to <x>% of the trap width specified
will get an inside trap with half the stroke width.

As a result, the system avoids a third color in the stroke center
that is a different color than the trap colors.

Range: 0% to 10,000.0%

For example:

Default line split = 200.0%

Stroke width = 0.4 pt

Trap width = 0.25 pt

Result = Inside trap width of 0.2 pt

Here, the trap width multiplied by the line split value is greater
than the stroke width divided by the two inside traps, (0.25 × 2)
> (0.4/2), so the inside traps are forced to shrink to half the
stroke width, or 0.2 pt.

If the line split is more than 200.0%, and the trap width is
greater than the stroke width divided by two, then the trap
width is forced to be half of the stroke width.

If the line split is 0.0%, the feature is disabled and there is no
change to the trap width; trapping into the stroke is like
trapping into any other object.

Geometry

Line Joins

Determines the shape of the corner between two trap segments
—that is, where the lines join. You can select one of the
following styles:

● Bevel
● Round
● Miter

Miter Limit

Determines whether a mitered trap will shorten to a bevel
shape. Available when you select Miter for the Line Joins
option.

Range: 100% to 10,000%
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Default: 500.0%

3 Color Joins

Determines the shape of a trap where three or more objects
meet. You can select one of the following shapes:

● Mitered Corners
● Clipped Chokes

Trap Trimming

Reduces the size and shape of traps that extend into small
objects.

Where a regular trap can get too close to another object such
as white knockout text, the trap is trimmed back to the center
point of the object that is accepting the trap. This can result in a
trap with a variable width along its length.

In the Trap Trimming box, select Automatic to have the trap
trimming feature re-examine any traps created in this job and
reduce them as needed.

Note: This option is available only with the Advanced Trapping option.

Cutbacks

Create Cutbacks

Select to create a trap where multi-colored objects border with
white areas of the page. This prevents mis-registration artifacts
from being visible along white edges and helps keep knockout
(reversed) text from filling in.

Create Cutbacks when Primary tint value is above

Determines the minimum primary tint value at which cutbacks
should be created.

Create Cutbacks when Primary ink Neutral Density is above

Determines the minimum primary ink neutral density value at
which cutbacks should be created.

Cutbacks width percentage of global traps

Determines relative width of global traps that should be taken
up by the cutbacks.
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Images

Trap to

Controls whether or not images trap to objects and/or images
trap to images.

Select the Objects check box to trap images to objects; clear
this check box to disable this feature. This feature lets images
trap to other objects such as trapping vector images to raster
data. A small image area around a vector object is sampled to
determine the average color value of the trap object.

And/or:

Select the Images check box to trap images to images; clear this
check box to disable this feature.

Direction

Controls the placement of traps between an image and an
object and/or an image and another image. These are the
options:

Automatic

Determines the best direction based on the general rule
of trapping light colors into dark colors.

Center

Causes the trap to span the border between the two
items that require a trap, regardless of the light to dark
relationship.

Into Image

Creates a trap between an image and an object by
spreading the object into the image.

Into Object

Creates a trap between an image and an object by
spreading the image into the object.

Bitmaps

Controls how a complex bitmap or masked image is to be
trapped. These are the options:

Trap All Bitmaps

Traps all colorized bitmaps and masked images with
vector traps, no matter how complex the bitmaps are.
This can take some time (even hours) to complete,
because to trap a page containing colorized bitmap
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images, the trapper must trace the outline of all of the
nonwhite pixels to create vectors to use as traps.

Ignore Complex Bitmaps

Converts and traps colorized bitmap images except for
too-complex bitmaps. Complexity is determined by an
estimate of how long it would take to create vector
outlines for a given bitmap.

Ignore All Bitmaps

Does not trap any bitmap images. Tags all bitmaps and
masked images as complex bitmaps.

Any bitmaps tagged as complex bitmaps can be trapped
manually using the Prinergy PDF Trap Editor software.

Copydot images are ignored for trapping.

Trap Resolution

Reduces file size by resampling any image data in the trap area
to a lower resolution.

Range: 10 to 10,000 dpi

Recommended setting: 100 dpi

Trap

Prinergy can create a trap when the file meets all of the following
conditions:

● The difference between two separations, relative to the lower of the
two, exceeds the value in the Relative Step Limit box in opposite
directions.

● The sum of common neutral densities for all separations is less than
the value in the Common Density Limit box.

● The absolute difference in the amount of colorants between two
objects is greater than the Minimum Absolute Step Limit.

Step Limit

Determines whether a trap will be generated between adjacent
colors (objects) depending on the relative difference (in %) in
their amounts of colorants (inks). If the relative difference in
amounts of colorants between two objects is less than the
relative step limit specified, then no traps are generated.

The Color Settings section lets you override this setting for
specific colors.

A setting of 100 disables trapping.
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Range: 1% to 100%

Default: 25.0%

Minimum Absolute Step Limit

Determines that no traps will be generated between adjacent
colors (objects) if the absolute difference in the amount of
colorants between two objects is less than the absolute step
limit.

This limit is intended to prevent traps between very light colors
or colors with very small color steps as found in blends. For a
trap to occur, the difference between amounts of colorants
(separations) must be greater than this Minimum Absolute
Step Limit and the value set for the relative step limit.

Range: 1% to 100%

Default: 5.0%

Common Density Limit

Determines whether a trap will be generated between adjacent
objects that have common colors. If the two objects have
enough common color, a trap is not required.

If a color is to be trapped based on the Step Limit value, the
neutral density of the shared color is calculated and compared
to the Common Density Limit value. If the shared neutral
density is greater than the limit, no trapping occurs.

A setting of 3.294 is approximately equivalent to the sum of
100% of each of the CMYK inks. A trap is always created if you
type a value greater than or equal to 3.294.

Range: 0.001 to 10.0

Default: 0.5

Centerline Trap Limit

Determines whether centerline traps are created between
objects with similar values for neutral density. The system
compares the neutral densities of two adjacent colors and
creates a centerline trap when the neutral density of the lighter
area is greater than the neutral density of the darker area
multiplied by the Centerline Trap Limit value.

Note: You cannot add a centerline trap between black or opaque inks.

A setting of 0 results in almost all centerline traps. A setting of
100 results in no centerline traps unless adjacent objects have
exactly the same value for neutral density.
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Range: 1% to 100%

Default: 100%

Trap Color Scaling

Lightens the intensity of the trap color.

Trap color scaling helps to make traps in sensitive trapping
situations less noticeable, for example, when trapping pastels.
Scaling reduces the visibility of traps by reducing the amount of
each component ink relative to its contribution to the trap color.

The system applies the Trap Color Scaling value to the
separation values of the trap that originates from the lighter
color (when neutral densities are compared).

A setting of 0 makes the traps invisible because all separations
of the trap color become equal to the darker color. A setting of
100 turns Trap Color Scaling off.

Range: 0 to 100%

Default: 100%

The Trap Color Scaling option in the Color Settings section lets
you override this setting for specific colors.

Keepaway Mode

Applies an opaque white trap to eligible color intersections. An
eligible color intersection is one that is between adjacent
objects painted by different inks. That is, each object is painted
by at least one ink that does not paint the other.

A keepaway trap is also called a knockout trap or a reverse trap.

Keepaway mode is used in packaging trapping.

Black

These options determine how Prinergy handles black and rich black.
You can set a particular separation to Treat Color as Black in the
Prinergy Color Editor. This option is available with the PDF Trapper
JTP.

Black Width Scaling

Calculates the black trap width as a percentage of the Trap
Width value. The additional margin ensures that any support
screens for a rich black don't peek out from under the black.

A 100% setting pulls back an object's color separations, except
for the black, the same distance as the trap width used on the
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rest of the page. Traps to black objects are the same size as
other traps.

A less than 100% setting produces narrower traps. For
example, a 50% scale means that traps to black objects will be
50% smaller than the usual trap width.

A greater than 100% setting produces wider traps. For example,
a 200% scale means that traps to black objects will be twice
the size of the usual trap width.

Range: 1% to 1000%

Default: 100%

Black Color Limit

Determines the minimum screen percentage at which the
trapping engine considers black to be 100%, and therefore
applies black trapping rules.

Black trapping rules include:

● Traps to objects defined as black are affected by Black
Width Scaling.

● Colors placed underneath overprinting black solid objects
form rich blacks. In areas where a rich black borders an
unpainted object such as the substrate, the color under the
black will be kept back from the border.

● The rules above do not apply unless the tint of the black
objects is greater than or equal to the Black Color Limit.

A setting of 0 means that all screen percentages of the color
black are considered black. A setting of 100 means that only
solid black is considered black.

Range: 1% to 100%

Default: 95%

Black Density Limit

Determines the neutral density value at which the trap engine
considers an ink to be black, and therefore applies black
trapping rules.

Any ink set to a density higher than black causes the black to be
treated as the lighter color. The black spreads into the higher
density color. You may want to set a metallic ink density higher
than black so that it traps correctly.

A setting of 10.0 means that no ink is considered black.

Range: 0.00 to 10.00
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Default: 1.6

Overprint Black Strokes...Up To

Sets all black strokes with a width of up to <n.n> pt to overprint
instead of trapping them. This overprint also applies to all
strokes colored with spot colors whose neutral density is higher
than the Black Density Limit.

Select this check box to enable this feature, and then specify a
stroke width or accept the default. Clear the check box to
disable this feature.

Range: 1 to 100 points

Note: This option is available only if the Trapper JTP is selected in the
JTP box.

Overprint Black Graphics

Sets all black vector graphics to overprint instead of trapping
them. This overprint also applies to vector graphics colored
with spot colors whose neutral density is higher than the Black
Density Limit.

Select the Overprint Black Graphic check box to enable this
feature; clear the check box to disable this feature.

Overprint Black Bitmaps

Sets all black bitmap graphics to overprint instead of trapping
them. This overprint also applies to bitmap graphics colored
with spot colors whose neutral density is higher than the Black
Density Limit.

Select the Overprint Black Bitmaps check box to enable this
feature; clear the check box to disable this feature.

Note: This option is available only if the Trapper JTP is selected in the
JTP box.

Text

You may want to handle text created with small font sizes differently
where readability might be affected by applying standard trapping
rules. In some cases, overprinting or smaller trap sizes provide better
results.

Overprint Black Text Limit

Overprints black text with a point size less than or equal to this
value.
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A setting of 0 points causes all text to be treated the same as
other objects. A setting of 100 causes all text sized less than or
equal to 100 points to be overprinted rather than trapped.

You may want to choose a point size equal to your body text to
make headlines trap normally and body text overprint.

Range: 0 to 1000 pt

Default: 12 pt

Small Text Size Limit

Determines at what point size text traps should be scaled. The
scale percentage is set in the Small Text Width Scaling (%)
box.

Note: Overprint cannot be used with colored text because overprinting
changes the color of the text. For small colored text, you may want to set
a smaller trap size. A setting of 0 means that no text traps are scaled. A
setting of 100 means that traps are scaled for all text sized less than or
equal to 100 points. Scaling traps for text that is 6 points or smaller (the
default value) can significantly improve readability.

Range: 0 to 100 pt

Default: 6 pt

Small Text Width Scaling

Calculates the width of a small text trap as a percentage of the
Trap Width value. Scaled traps are applied to text objects
based on the value of Small Text Size Limit.

Range: 0 to 1000%

Default: 75%

Text Grouping

Groups text objects when trapping. All of the characters in a
group will have the same trap direction and color.

Choose from the following grouping options—none, characters,
words (default), lines.

Grouping by units larger than characters—such as words and
lines—speeds up trapping and can sometimes give better visual
results. Grouping by characters gives the most flexibility since
each character can then have a different trap direction and
color, depending on its background. A setting of none will keep
the text groupings that are set up when the file is converted to
PDF.

Note: This option is available only if the Trapper JTP is selected in the
JTP box.
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Color Settings

The Color Settings area lets you override some of the global settings
by entering values for individual colors.

Ink Set

Specifies color settings for ink sets.

Select an ink set in the list. The neutral densities for the process
colors change to those specified by the ink set.

Neutral Density

Specifies the neutral density value for each process color.

Step Limit

Determines whether a trap will be generated between adjacent
colors (objects) depending on the relative difference (in %) in
their amounts of colorants (inks). If the relative difference in
amounts of colorants between two objects is less than the
relative step limit specified, then no traps are generated.

A setting of 0 removes Step Limit as a criteria for trapping. A
setting of 100 disables trapping.

Range: 0 to 100%

There is also an absolute threshold of 5% to prevent traps
between very light colors. See Minimum Absolute Step Limit.

Trap Color Scaling

Lightens the intensity of the trap color for a particular
separation.

Trap color scaling helps to make traps in sensitive trapping
situations less noticeable, for example, when trapping pastels.
Scaling reduces the visibility of traps by reducing the amount of
each component ink relative to its contribution to the trap color.

The system applies the Trap Color Scaling value to the
separation values of the trap that originates from the lighter
color (when neutral densities are compared).

A setting of 0 makes the traps invisible because all separations
of the trap color become equal to the darker color. A setting of
100 switches off Trap Color Scaling.
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Range: 0 to 100%

See also:
About common density limit on page 256
About neutral density on page 256
About step limit on page 262
Trapping examples on page 265
About trapping tools on page 323

Optimize section of the Refine process template

The Optimize section of a refine process template defines how
Prinergy optimizes high-resolution images in input files.

This section is required and cannot be disabled.

Note: If using PDF Preflight, the Optimize pane is unavailable because the preflight
profile is controlling these options.

JTP

Select a job ticket processor (JTP) to use for optimizing.

Note: You set up JTPs using Prinergy Administrator.

Prepare PDF for Edit

You can prepare a PDF file for edit as part of the refining
process. Select this check box to only prepare the PDF file for
edit but not open it in Illustrator. If you do not select this check
box, then when you select PDF Editing > Open PDF for Editing
in Job Manager, Prinergy has to prepare the PDF file first before
opening it for editing.

Color Images

Resample

Enables downsampling of color images. When enabled the
system downsamples color images to the value set in the Down
to box, using the method selected in the list.

Select the Resample check box to enable downsampling of
color images, and then select a type of downsampling:

● Select Average for faster, less accurate downsampling.
● Select Bicubic for slower but more accurate downsampling.

Clear the Resample check box to disable downsampling of color
images.
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Down to

Specifies the resolution to which the system downsamples
images.

The Down to box in the Color Images area applies to color
images.

The Down to box in the Grayscale Images area applies to
grayscale images.

In the Down to box, type the resolution to which you want the
system to downsample images.

Recommended setting: double the lpi value. For example, 400
ppi for 200 lpi, 300 ppi for 150 lpi, 170 ppi for 85 lpi.

Note: The Down to and the if Above options are linked by ratio. When
you change the Down to value, the if Above value changes according to
the existing ratio between the two options.

if Above

Specifies the minimum resolution an image must be for the
system to downsample it. The system does not downsample
images with a resolution below the number specified in this
option.

The if Above box in the Color Images area applies to color
images.

The if Above box in the Grayscale Images area applies to
grayscale images.

In the if Above box, type the minimum resolution an image
must be for the system to downsample it.

Note: The Down to and the if Above options are linked by ratio. This ratio
is the actual value stored in each process template, and it is stored as an
integer. When you open a process template, the system calculates the if
Above value from the Down to value and the ratio between the two
options. When you change the if Above value, the Down to value stays
the same, but the system rounds the if Above value to the nearest
integer, according to the ratio between the two options.

Compression

Compresses color images using the selected compression
format.

Select None to disable image compression.

Select JPEG (Lossy) to compress images using a JPEG format.

Select ZIP (Lossless) to compress images using the ZIP format.
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Quality

Applies to JPEG compression options only.

Select a level of compression from the list. The compression
level decreases as the quality level increases.

Grayscale Images

Resample

Enables downsampling of grayscale images. When enabled the
system downsamples grayscale images to the value set in the
Down to box, using the method selected in the list.

Select the Resample check box to enable downsampling of
grayscale images, and then select a type of downsampling:

● Select Average for faster, less accurate downsampling.
● Select Bicubic for slower but more accurate downsampling.

Clear the Resample check box to disable downsampling of
grayscale images.

Down to

Specifies the resolution to which the system downsamples
images.

The Down to box in the Color Images area applies to color
images

The Down to box in the Grayscale Images area applies to
grayscale images.

In the Down to box, type the resolution to which you want the
system to downsample images.

Recommended setting: double the lpi value. For example, 400
ppi for 200 lpi, 300 ppi for 150 lpi, 170 ppi for 85 lpi.

Note: The Down to and the if Above options are linked by ratio. When
you change the Down to value, the if Above value changes according to
the existing ratio between the two options.

if Above

Specifies the minimum resolution an image must be for the
system to downsample it. The system does not downsample
images with a resolution below the number specified in this
option.

The if Above box in the Color Images area applies to color
images.
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The if Above box in the Grayscale Images area applies to
grayscale images.

In the if Above box, type the minimum resolution an image
must be for the system to downsample it.

Note: The Down to and the if Above options are linked by ratio. This ratio
is the actual value stored in each process template, and it is stored as an
integer. When you open a process template, the system calculates the if
Above value from the Down to value and the ratio between the two
options. When you change the if Above value, the Down to value stays
the same, but the system rounds the if Above value to the nearest
integer, according to the ratio between the two options.

Compression

Compresses grayscale images using the selected compression
format.

Select None to disable image compression.

Select JPEG (Lossy) to compress images using a JPEG format.

Select ZIP (Lossless) to compress images using the ZIP format.

Quality

Applies to JPEG compression options only.

Select a level of compression from the list. The compression
level decreases as the quality level increases.

Color & Grayscale Alternate Images

Generate

Generates alternate low-resolution images of the images in the
input file. An alternate image is used when creating low
resolution PDFs from Publish PDF, or Vector output from
Prinergy, or Insite Prepress Portal.

Select the Generate check box to enable alternate images; clear
the Generate check box to disable alternate images.

at

Determines the resolution of alternate images.

Type the resolution at which you want Prinergy to generate
alternate images.
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if Above

When you select the Generate check box images with a ppi
above this value are downsampled to the value set in the at ppi
box. Images below this value are not downsampled.

Compression

Compresses color and grayscale images using the selected
compression format.

Select JPEG (Lossy) to compress images using a JPEG format.

Select ZIP (Lossless) to compress images using the ZIP format.

Color Space Control

Digital Master Control

The color space control settings let you screen for input file
data that is in nonpress (nonCMYK or nongrayscale) color
spaces.

The Digital Master Control option works in conjunction with
the Detect RGB and Detect DeviceIndependent check boxes.

You select a Digital Master Control option to indicate how you
want Prinergy to respond when it locates data in a nonpress
color space. You select the Detect RGB and/or Detect Device
Independent check boxes to indicate what type of data you
want Prinergy to detect.

Note: Settings in the ColorConvert section of the refine process template
determine if and how the undesired color spaces are converted.

Select Ignore if you want Prinergy to ignore RGB or device-
independent data in input files. If you select Ignore the Detect
RGB and Detect Device Independent check boxes are
unavailable and cannot be selected. If Prinergy encounters RGB
or device-independent data, it gives no message and doesn't fail
the job.

Select Warn if you want Prinergy to issue a warning if the
selected data type is found in the input file. A warning message
and yellow triangle appear in the Process Info dialog box and
job history for each check box that is selected. A PDF page is
created. A large X does not cover the content.

Select Fail to have Prinergy fail the job when the selected data
type is found in the input file. An error message and red X
appear in the Process Info dialog box and job history for each
check box that is selected. A PDF page is created but is covered
by a large black X.
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You can set these same options in the Normalize section of the
refine process template. You can enable the color space control
settings in either the Normalize section or the Optimize
section, or both. Turning the settings on in the Optimize section
allows you to check that color conversion was performed in the
refine stage as you expected.

You might want to warn only about RGB and CIE-based color
spaces in the Normalize section, because you are converting
them in the Color Matcher, but warn during optimizing about
CIE-based color spaces that the Color Matcher wasn't set up to
convert.

Detect RGB

Select to have Prinergy detect RGB data in the input file.

The Digital Master Control selection determines what Prinergy
will do if it finds RGB data.

The Detect RGB check box is unavailable if the Digital Master
Control selection is Ignore.

Detect Device Independent (ICC-Based, Lab, CalGray, and CalRGB

Select this option to have Prinergy detect device-independent
data in the input file, for example L*a*b* data.

The selection for Digital Master Control determines Prinergy's
actions when it finds device-independent data.

The Detect Device Independent check box is unavailable if the
Digital Master Control selection is set to Ignore.

Separated File Control

These control settings let you detect nongray images (raster
data) and nongray vector data in separated input files.

In each of the Detect Non Gray Images and the Detect Non
Gray Vector Data lists, select one of the following options:

Ignore

No warning is issued.

Warn

A warning is issued when Prinergy detects nongray data
(of the type specified).

Fail

The refine process fails when Prinergy detects nongray
data (of the type specified).
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Detect painted colorants in

Select the area of the PDF page from which painted colorants
are extracted.

Select Entire Page to extract painted colorants from the entire
PDF page.

Select Media Box to extract painted colorants from the media
box only.

Select Trim Box to extract painted colorants from the trim box
only.

For example, there might be objects outside the trim box
painted in, let's say, cyan. If there are no cyan objects inside the
trim box and you select this option; then there will be no cyan in
the list of colors for the page and you will not have cyan
separation to print.

Selecting Media Box or Trim Box might decrease performance.

See also:
Editing PDF files in Adobe Illustrator on page 329

Thumbnail section of the Refine process template

This section has only one setting:

JTP

Select the JTP (job ticket processor) to use for thumbnail
generation.

Note: You set up JTPs using Prinergy Administrator.

Impose section of the Refine process template

The Impose section of a refine process template defines how Prinergy
automatically handles the imposition after the refine process. You can
enable only one of the four options in any refine process template.

Treat Input Files as Flats

Enables automatic page set and imposition plan creation.

When you enable this feature, Prinergy assumes the input file is
a flat. It automatically creates a page set and an imposition plan
and populates both with the contents of the PDF file.

Note: The imposition plan that Prinergy creates does not contain margins
or marks.
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Create Page Set and Assign Pages

Enables automatic page set creation and page assignments for
input files that have the same number of pages as the page set.

When you enable this feature, Prinergy automatically creates a
page set and assigns pages to the page set based on the page
order in the input file.

Automated Page Assignment-Retain Assignments, Using Job Settings

Enables the Automated Page Assignment (APA) feature.

When you enable this feature, Prinergy automatically assigns
PDF pages to page set positions according to the instructions in
an APA file (Job.apa), which is stored in the <job
folder>\Control folder. However when you resubmit a
page, for example, a corrected page, the system does not
automatically assign it to a page position.

Note: If there is more than one APA file in the <job folder>
\Control folder, for example, Job.apa and Job.v1.apa, the
system uses the file with the latest date and time. It doesn't
automatically use the file with the latest version number.

Automated Page Assignment-Overwrite Assignments, Using Job
Settings

Enables the Automated Page Assignment (APA) feature.

When you enable this feature, Prinergy automatically assigns
PDF pages to page set positions according to the instructions in
an APA file (Job.apa) which is stored in the <job folder>
\Control folder. When you resubmit a page, for example, a
corrected page, the system automatically assigns the corrected
page to a page position, overwriting the existing page in the
page set.

Note: If there is more than one APA file in the <job folder>
\Control folder, for example, Job.apa and Job.v1.apa, the
system uses the file with the latest date and time. It doesn't
automatically use the file with the highest version number.

About bypassing refine
If you are confident that your PDF input files are press-ready, you can
choose to bypass the refine process. Bypassing refine ensures that the
content does not change, and saves processing time and resources.

Important: This feature should not be used for files that are of unknown quality or
are prone to problems. For such files, a full refine (including the normalization,
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color conversion, and optimization) is best. The general recommendation for input
files is to still do a full refine.

Press-ready PDFs

A press-ready PDF file is a file for which the printer only needs to
impose, perform a last Prinergy Virtual Proofing System (VPS) check,
and do the final output. The printer site is not expected to perform any
modifications on the input files, since the publisher has checked that
color conversion has taken place, traps and overprints are present in
the file, preflight problems have been corrected, fonts have been
included, the file RIPs correctly, and so on. The printer assumes that all
settings in the files are as the page-preparation site intends on final
output.

The bypass refine process

To bypass refine, process your PDF input files using the Bypass Refine
process template, which only registers your PDF input files with
associated colorant and geometry attributes into the Prinergy system;
it does not change the contents of the file.

Important: Because no preflighting or corrections are performed, take care to
proof your output. You should proof to an appropriate separation-capable proofer,
such as to the Prinergy VPS software or to a Trendsetter Spectrum platesetter, to
ensure that the separations and page content RIP and output as expected.

Note: Apparent document size discrepancy between input and refined PDF as
seen in Workshop is a result of information that is added to the refined page. That
is, colorant information is put into the PDF to allow Workshop to display painted
colorants for each file.

Bypass Refine process template
Use the bypass refine process template to register your press-ready
PDF files into the Prinergy system and to avoid refining the files.
Bypassing refine ensures that the content does not change, and saves
processing time and resources.

CAUTION: Because no preflighting or corrections are performed, proof all output
to ensure separations and content output as expected.

Thumbnail section

The Thumbnail section of a bypass refine process template defines
whether or not Prinergy generates thumbnails during the bypass refine
process.

This section has only one setting:
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JTP

Select the JTP (job ticket processor) to use for thumbnail
generation.

Note: You set up JTPs using Prinergy Administrator.

Impose section

The Impose section of a bypass refine process template defines how
Prinergy automatically handles the imposition after the bypass refine
process. You can enable only one of the following four options in a
bypass refine process template.

Treat Input Files as Flats

Enables automatic page set and imposition plan creation.

When you enable this feature, Prinergy assumes the input file is
a flat. It automatically creates a page set and an imposition plan
and populates both with the contents of the PDF file.

Note: The imposition plan that Prinergy creates does not contain margins
or marks.

Create Page Set and Assign Pages

Enables automatic page set creation and page assignments for
input files that have the same number of pages as the page set.

When you enable this feature, Prinergy automatically creates a
page set and assigns pages to the page set based on the page
order in the input file.

Automated Page Assignment-Retain Assignments, Using Job Settings

Enables the Automated Page Assignment (APA) feature.

When you enable this feature, Prinergy automatically assigns
PDF pages to page set positions according to the instructions in
an APA file (Job.apa), which is stored in the <job
folder>\Control folder. However when you resubmit a
page, for example, a corrected page, the system does not
automatically assign it to a page position.

Note: If there is more than one APA file in the <job folder>
\Control folder, for example, Job.apa and Job.v1.apa, the
system uses the file with the latest date and time. It doesn't
automatically use the file with the latest version number.
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Automated Page Assignment-Overwrite Assignments, Using Job
Settings

Enables the Automated Page Assignment (APA) feature.

When you enable this feature, Prinergy automatically assigns
PDF pages to page set positions according to the instructions in
an APA file (Job.apa) which is stored in the <job folder>
\Control folder. When you resubmit a page, for example, a
corrected page, the system automatically assigns the corrected
page to a page position, overwriting the existing page in the
page set.

Note: If there is more than one APA file in the <job folder>
\Control folder, for example, Job.apa and Job.v1.apa, the
system uses the file with the latest date and time. It doesn't
automatically use the file with the highest version number.

Why PDF?
Adobe's Portable Document Format (PDF) is a reliable file format for
storing line art, images, and text (including all required fonts) for
pages. Once created, a PDF file can be shared and reused among many
different people or processes. Since a PDF file can be viewed on-screen
or over the Web, it is simple to preview the content prior to making
finished output.

There are two key differences between PostScript and PDF formats:

● PostScript is, essentially, a programming language. PDF is a page
description language, making interpretation much more repeatable
and reliable.

● An entire PostScript file must be interpreted to obtain the content of
a single page. In a multi-page PDF file, the content for each page is
independent. If changes are made to a single page, only that page
needs to be reinterpreted.

PDF is the internal format for all of Prinergy's digital masters. Through
the refining process, PostScript files are interpreted, a display list is
created, and from that display list, a digital master PDF file is
constructed.
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About common density limit
Common Density Limit is used to prevent traps where they are not
needed. Traps are not needed if a gap will not be visible due to the
darkness or density at that place. It is controlled from the Trap section
of refine process templates.

Common density is a neutral density calculated from the common
parts of each single separation. In the table below, C60 M25 Y30 K10
and C40 M31 Y40 K14 have the common parts of C40 M25 Y30 K10.
Spot colors are also considered, if present. Therefore, the common
density is a value for the darkness for the worst possible
misregistration. If this common density is above the Common Density
Limit setting, no traps are required.

Separation Color1 Color2 Relative Ink Dot Percentage Step Limit (25%) Satisfied?

Cyan 60% 40% (60-40)/40 = 0.5 or 50% Yes, 50% >25%

Magenta 25% 31% (31-25)/25 = 0.24 or 24% No, 24% < 25%

Yellow 30% 40% (40-30)/30 = 0.33 or 33% Yes, 33% > 25%

Key 10% 14% Ignored, doesn't meet 5%
minimum difference

For the example above (common parts of C40 M25 Y30 K10), the
common density is calculated as follows (CD = common density, ND =
neutral density):

CD = ND[Cyan] + ND[Magenta] +ND[Yellow] +ND[Key]

= 0.19 +0.13 +0.05 +0.07

= 0.44

0.44 < 0.5

The common density of the two example colors is lower than the
default limit of 0.5, so a trap would be created.

About neutral density
You can control neutral density from the Trap section of refine process
templates.

All inks used for printing do not have the same darkness. For example,
yellow is lighter than cyan. Neutral density is used to specify the
darkness of a printing ink on paper. A neutral density of 0 is white (no
ink). For process colors, the neutral densities vary, depending on the
ink set (for example, EuroOffset, SWOP. For spot colors, neutral
density can be explicitly specified. If a spot color is normal (non-
opaque), neutral density can also be estimated from a given color.
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Example of neutral densities for process colors:

Cyan 0.61

Magenta 0.76

Yellow 0.16

Black 1.70

The neutral density of a non-100 percent value can be calculated from
the area coverage (0-100 percent) and the neutral density of the ink.
The neutral density of a composite color is the sum of neutral densities
for all of the separations.

About overprint conversion
The refine process handles overprints and knockouts two ways:

● Manually
● Automatically

You use the manual feature by setting options (Set Colors to
Knockout, Set Black to Overprint, Set Rich Black to Overprint, Set
Overprint CMYK White to Knockout, Enable Gray Overprint) in the
ColorConvert section of the refine process template.

Regardless of whether or not you select the manual overprint
conversion settings, the system performs some automatic overprint
and knockout conversions. This section describes how the system
automatically handles the following overprint and knockout
conversions:

● Die line overprint: The system overprints all objects in the Prinergy
color database that are designated as die lines.

● Transparent overprint: The system overprints all objects in the
Prinergy color database that are designated as transparent. This
feature resolves a QuarkXPress issue with varnishes.

About overprint handling
Overprint handling is a feature in the ColorConvert section of the
process template that helps to prevent overprinting objects from
generating unintended knockouts. You can apply overprint handling in
the refine, loose page output, and imposition output process templates.

The following examples show the effects of using overprint handling.
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Example 1: All colors are shared

Figure 1: The desired overprint effect

Figure 2: The outcome without and with overprint handling
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Example 2: Some shared, some unshared colors

Figure 3: The desired overprint effect

Figure 4: The outcome without and with overprint handling

Multiplicative blend formula

Prinergy uses the following formula to calculate the proper channel
color amount for the intersecting area of overprinting objects:

1 - (1 - Color1) x (1 - Color2) = multiplicative blended amount

where Color1 and Color2 are the underlying and overprinting amounts
of a shared channel color. For example, if 70% magenta and 10%
magenta were used, then Color1 and Color2 would be 0.7 and 0.1.
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About reader spread splitting
Adobe Reader spread splitting automates the process of splitting 2-up
reader spreads into discrete pages. The pages can then be assigned to
page set positions and the imposition.

Prinergy can split reader spreads only during the first refine. During this
process Prinergy:

● Duplicates each 2-up reader spread file
● In each 2-up reader spread file, changes the geometry to cut the

trim box exactly in half
● Depending on whether it is a right or left page, adjusts the bleed box

and media box to capture bleed from the adjoining page

Choosing the reader spread layout

Reader spread splitting appears in the Normalize section of the refine
process template. In the process template, you select how the pages
are arranged in the file so that Prinergy knows how many pages to
expect, and which half of the reader spread to interpret as which page.
The option you select in the process template depends on the number
of pages in the file.

If you are splitting a multipage reader spread:

1. Determine if the document is right-bound or left-bound.
2. Determine whether the first and last page (“N”) are together on the

same spread, or apart.
3. Select the applicable check box according to the following table.

Binding
Style

First and Last
Pages

Select Check Box

Left Bound Together

Apart

Together

Right Bound Together

Apart

Together

If you are splitting a single-page reader spread (each input file is one
pair of pages, or one reader spread):

1. Determine how the first and second page (“N”) are laid out.
2. Select the applicable check box according to the following table.

Note: When splitting a single-page file use only the first two icons to
determine how the two pages are arranged. Ignore the Left Bound and Right
Bound labels and the additional page icons.
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Page One Select Check Box

On the left

On the right

Feature limitations

Prinergy cannot be configured to automatically compensate for
inaccurate geometry in the input file (specifically the trim box setting).
If the trim box geometry is incorrect in the input file, you must
manually adjust for this. You can do this either before or after the
reader spread splitting process.

To adjust for incorrect geometry before the pages are split, do one of
the following:

● Use the Geometry Editor plug-in for Acrobat and adjust the trim
settings on the input files. For more information, see the Geometry
Editor guide.

● Pre-process the pages to set the geometry (using APA or the Set
Page Geometry feature in Prinergy Workshop) and output to
Vector PDF with Apply Geometry enabled. Bring the resulting PDF
into the final job and use the reader spread splitting feature to split
the pages.

To adjust for incorrect geometry after the pages are split, do one of the
following:

● Use the Geometry Editor plug-in for Acrobat and adjust the trim
settings on the split files. Re-refine the pages. For more information,
see the Geometry Editor guide.

● Use APA to re-set the trim box (in the even and odd pages) to their
appropriate values.

● Assign the pages to the page set positions in Prinergy Workshop.
Select the even pages and use the Set Page Geometry feature to
adjust the trim settings. Repeat for the odd pages.

For page splitting legacy CEPS (Brisque CT/LW or TIFF/IT) reader
spreads which have no accurate TrimBox: In Spread Splitting area of
the process template, set the Centerfold Bleed to 1/2" (or the distance
that you measure from the intended trim to the edge of the file's
MediaBox). Although the resulting pages still have inaccurate
TrimBoxes, they can be centered in the imposition to give proper
imposed output.

Notes:

● You cannot split a reader spread on a second refine. Although the options
appear in the process template during a second refine, the split does not occur.

● Since the APA geometry settings are processed after the reader spread
splitting, you currently cannot use APA to set geometry on the pre-split pages.
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You can, however, use APA to set geometry on the pages after they have been
split.

About step limit
You can set a relative step limit to affect whether a trap will be
generated between adjacent colors (objects) depending on the relative
difference in their amounts of colorants (inks). If the relative difference
in amounts of colorants between two objects is less than the step limit,
then no traps are generated. The step limit is controlled from the Trap
section of refine process templates.

For each ink, the relative ink dot percentage between two adjacent
colors is calculated as the difference between the two, divided by the
lower one. In the first example in the table below, Color1 at 60 percent
and Color2 at 40 percent lead to a relative ink dot percentage of (60 -
40)/40 = 0.5 or 50 percent.

A high value indicates a significant change between the two colors and
thus a possible need for a trap. The trapper compares the relative ink
dot percentage of the inks to the Step Limit (%) value, and considers
creating a trap if the value for at least two separations is larger than the
Step Limit (%) value and the step is in the opposite direction (that is,
from Color1 to Color2, the dot percentage increases for one ink and
decreases for another). Using the relative value here allows a higher
sensitivity for traps between light colors and a lower sensitivity for
traps between dark colors.

For the example in the table below, the trapper creates a trap because
two separations increase in opposite directions equal to or greater than
the Step Limit value of 25 percent.

Separation Color1 Color2 Relative Ink Dot Percentage Step Limit (25%) Satisfied?

Cyan 60% 40% (60-40)/40 = 0.5 or 50% Yes, 50% >25%

Magenta 25% 31% (31-25)/25=0.24 or 24% No, 24% < 25%

Yellow 30% 40% (40-30)/30 = 0.33 or 33% Yes, 33% > 25%

Key 10% 14% Ignored, doesn't meet 5%
minimum difference

About thumbnails
When working with pages it is helpful to use thumbnails to see the
page content.
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When thumbnails appear

To create thumbnails of your pages refine the input files using a refine
process template that has the Thumbnail section selected.

If you want thumbnails after you refine input files you can generate
them by refining the PDF pages withThumbnail selected.

To see thumbnails, select View > as Thumbnails in Job Manager. In
thumbnail view, pages are grouped by assignment.

If you edit a page with Adobe Acrobat, thumbnails in Job Manager do
not change automatically. If you want to update the thumbnail images,
refine the PDF page again.

How thumbnails look

Here are the thumbnails that you may see:

Icon Meaning Explanation

Actual The actual page is shown in miniature. If the page is layered only the
top subpage is visible.

Too big The resolution of the thumbnail exceeds the maximum size possible
in Prinergy, which is 1 MB.

Default Either of these situations:

● The thumbnail was not created (because the page was not
refined with Thumbnail selected) and the page has no errors.

● Actual thumbnails are not visible because Use Default (Blank)
Thumbnails is selected in the Prinergy Workshop Preferences
dialog box.

Error The page contains one or more errors. This icon appears even if the
thumbnail was not generated.

In layered pages:

● If thumbnails were generated, the error icon appears only if the
top subpage has an error. If a lower subpage has an error, you
can't see it.

● If thumbnails were not generated, the error icon appears if any
subpage has an error.

Layered The page is layered and more than one page is assigned to the page
position.

Layering is used for legacy versioning, varnishes, and adding text to
copydot scans.

Layered(Layere
d PDF
Versioning)

The page is layered using LPV.
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Controlling thumbnails

Control thumbnails in these ways:

● Viewing higher-resolution thumbnails

You can see higher-resolution thumbnails in Prinergy Workshop by
selecting Display Large Thumbnails in the Prinergy Workshop
Preferences dialog box. Large thumbnails are 24 dpi. The default
resolution of thumbnails is 6 dpi.

If you display large thumbnails in Prinergy Workshop, make sure
that Prinergy creates thumbnails with a resolution of at least 24 dpi.
For example, if Prinergy creates thumbnails at 6 dpi and you select
Display Large Thumbnails in Prinergy Workshop, the thumbnails
will be fuzzy. You can specify the resolution of thumbnails on the
Thumbnails tab of the Configuration Options dialog box in Prinergy
Administrator.

● Speeding the display by using blank thumbnails

To speed the display of the thumbnails view you can use
placeholders instead of real thumbnails. Select Use Default (Blank)
Thumbnails in the Prinergy Workshop Preferences dialog box.

This is useful for:

○ Large jobs in which displaying all generated thumbnails may
decrease performance

○ Jobs where the page content is similar and thumbnails don't help
to distinguish pages such as textual pages

● Make rows even in Thumbnail view

Display thumbnails in even-numbered rows by selecting Show an
Even Number of Thumbnails Per Row in All Page Views in the
Prinergy Workshop Preferences dialog box. This is useful with
reader spreads.

Interaction between thumbnails and proof processes

The JTP that generates thumbnails is the same one that generates
proofs. If your installation of Prinergy includes only one Proofing JTP,
you can experience delays when generating thumbnails and proofs at
the same time.

For example, if a proof takes a long time to generate, it may be queued
behind a refine process that includes thumbnail generation. Similarly, if
a refine process takes a long time, the thumbnail generation step may
be queued behind a proof process.
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Trapping examples

Standard corner trap

Bevel trap

Miter trap

Mitered corner trap

Round trap

Clipped choke trap
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Trap direction

Values selected in the Direction box yield the following results:

Center, Into Image, and Into Object

Black width scaling

Black width scaling ensures supporting screens don't peek out from
underneath black. This setting is the Black Width Scaling box in the
Black area of the in the Trap Settings area in the Trap section of the
Refine process template.

Small text scaling

Here is animation demonstrating how scaling affects trapping on small
text:

The text shown in the example is small-the letter l measures
approximately 0.5 points across. With 100 percent trapping at a trap
width of 0.3 points, the trap is so wide that the letter appears to be
overprinting. When the trap is scaled to 25 percent, the trap is more
appropriate to the size of the text.
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Trap color scaling

Here is animation showing the result of different values for Trap Color
Scaling (%):

About using OPI with transparent effects
When using the OPI step in the refine process, you can use
transparency features for TIFF images, such as soft masks and drop
shadows.

Soft masks

PDF files can contain images with soft masks, such as feathered edges
or soft silhouettes, that blend smoothly into the background—even if
the background contains text or other images.

If OPI is required for TIFF images, Prinergy creates the soft mask from
the first detected alpha channel in the TIFF file. The mechanism is
similar to importing images into the Adobe InDesign software.

For example, here is an original image, a soft mask, and the resulting
image with a soft mask:

Original image Soft mask Resulting image

Drop shadows

PDF files can have drop shadows that blend smoothly into the
document background. The objects behind a drop shadow show
through the drop shadow; they are not hidden by it.

Typically, drop shadows result from creating one image as a shadow
and placing it on top of another image. For example, here is an original
image, a drop shadow, and the resulting image with a drop shadow:

About using OPI with transparent effects 267



Original image Drop shadow image Resulting image

Using soft masks during OPI
You can create soft masks in refined PDF files during OPI.

1. Using the Channels palette in the Adobe Photoshop software,
create soft masks.

Note: In Photoshop, do not confuse soft masks with the masking or
transparency features that are part of the Layers palette.

2. Save the image as TIFF, and place it in a page layout software that
generates OPI comments on output.

3. Ensure that black text is on top of all other objects in the layout.

Prinergy preserves text as vector objects as long as the text is not
“under” any other objects. Make sure the entire text box is on top—
even the corners—because Prinergy looks at the bounding box of
the text.

4. Ensure that spot colors have been defined as desired before writing
the PostScript files.

The way that Prinergy treats objects depends on the color space
definition. If you want objects to appear only as CMYK, adjust the
color definition in the layout software, not when you refine.

If spot color conversion is unavoidable, use color management. In
the ColorConvert section of the refine process template, select the
Overprint Handling (CPU Intensive) check box and clear the Set
Colors to Knockout check box in the Overprint Conversion area.

5. Create thin PostScript from the layout software.

6. When refining the thin file, in the Image Replacement area of the
Fonts and Images section of the refine process template:

a. Select the Search for High-Resolution Images in Image Search
Paths check box to enable OPI.

b. Select the Create Soft Masks from Photoshop TIFF Alpha
Channels check box.

7. Refine the files.
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Using drop shadows during OPI
You can create drop shadows in refined PDF files during OPI.

1. Create the drop shadow in desktop publishing software.

For example, you can use ShadowCaster in the QuarkXPress
software, use InDesign shadow-creation tools, or create the
shadow manually in Photoshop.

You can create the drop-shadow image in grayscale, RGB, or CMYK
color space. Grayscale is the most common color space.

2. Ensure that black text is on top of all other objects during layout,
including the entire bounding box of the text.

The Prinergy software preserves text as vector objects only if none
of the text is under an object.

3. Ensure that spot colors have been defined as desired before writing
PostScript files.

The way that Prinergy treats objects depends on the color-space
definition, such as spot colors versus process colors. If you want
objects to appear only as CMYK, adjust the color definition in the
layout software, not when you refine.

If spot color conversion is unavoidable, use color management. In
the ColorConvert section of the refine process template, select the
Overprint Handling (CPU Intensive) check box and clear the Set
Colors to Knockout check box in the Overprint Conversion area.

4. For best results, save the image in TIFF format.

5. Decide which file extension you will use to identify drop-shadow
images in Prinergy.

With ShadowCaster in QuarkXPress, the default extension is .shd,
but you can use any extension that you want.

6. Change the extension of the image file name to the drop-shadow
file extension that you chose in step 5.

7. In the Image Replacement area of the Fonts and Images section of
the refine process template:

a. Select the Search for High-Resolution Images in Image Search
Paths check box to enable OPI.

b. Select the Make Drop Shadow Images Transparent check box.
c. If you are using a file extension other than .shd, type the

extension in the Transparent Drop Shadow Image Name Suffix
box.

8. Refine the files.
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Including clipping paths during OPI
With OPI, you can use the spot color channels created in TIFF images.

Notes: If the images are not Photoshop TIFF files, Prinergy ignores clipping paths.
To use the spot color channels, you can use alternative methods. In software other
than InDesign, save the images as DCS files, and replace them in the original
layout. With InDesign, which does not omit TIFF files for OPI-containing spot
colors even when OPI is selected in the Print dialog box, do either of the following
actions:

● Create a plain alternate CMYK image for use as a proxy. Print the PostScript
including the OPI comments but omitting the images. Add the TIFF file
containing the desired spot color channels to an image search path.

● Use proxy images created by an OPI solution, such as ColorCentral or Asset
Library, for low-resolution image placement into InDesign. These images will
be replaced by their high-resolution counterparts during the OPI step of the
refine process.

1. Create the image as TIFF files in the Photoshop software.

2. In the Image Replacement area of the Fonts and Images section of
the refine process template, select the Search for High-Resolution
Images in Image Search Paths check box to enable OPI.

3. In the Image Attributes area, select the Apply Clipping Path in
Photoshop TIFFs check box.

4. Refine the files.

Including spot color channels during OPI
With Prinergy OPI, you can include the spot color information
contained in the channels of TIFF images.

Note: If the images are not Photoshop TIFF files, Prinergy ignores spot color
channels during OPI. Save the images as DCS files and replace them in the original
layout.

The InDesign software does not omit TIFF files for OPI-containing spot colors,
even when OPI is selected in the Print dialog box. Create a plain CMYK image as a
proxy, print the PostScript, including the OPI comments but omitting images, and
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then add the TIFF file containing the desired spot color channels into an OPI
search path location in the Prinergy software.

1. Using the Channels palette in Photoshop, create the images as TIFF
files.

2. In the Image Replacement area of the Fonts and Images section of
the refine process template, select the Search for High-Resolution
Images in Image Search Paths check box to enable OPI.

3. In the Image Attributes area, select the Include Spot Colors in
Photoshop TIFFs check box.

4. In the Spot Color Handling section of the refine process template,
select the Lookup Recipe in Color Database check box to provide
an accurate color definition for proper color matching and trapping.

You need to look up the recipe because Photoshop includes only
the name of the spot color channel, not the color definition.

The Prinergy software merges the CMYK color channels with all spot
color channels to produce a single, multi-channel (DeviceN) image.

PDF preflight

About PDF preflight

With PDF Preflight, you can, during the refine process, evaluate PDF
pages to detect problems that may affect processing in a publishing or
prepress workflow.

PDF Preflight conforms to all 2005 Ghent PDF Workgroup PDF/X-Plus
specifications. For more information, see http://
www.ghentpdfworkgroup.org.

Preflight profiles

PDF Preflight uses profiles to compare the PDF files to a number of
criteria. Each profile represents a collection of settings that is checked
during the refine process.

You must use the Preflight Profile Manager to add a preflight profile
before preflighting PDF pages.

The following preflight profiles have been created in accordance with
the GWG specifications for market segments:

Preflight Profiles for Market Segments

Advertising for Newspapers SheetCMYK

Magazine Ads SheetSpot High Resolution
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Preflight Profiles for Market Segments

Packaging Design High Resolution SheetSpot Low Resolution

Packaging Design Low Resolution WebCMYK Kodak News

Packaging Offset WebSpot News

Packaging Gravure WebCMYK High Resolution

Packaging Flexo WebSpot High Resolution

Viewing Preflight reports

After preflighting a job you can view a report of problems in the page
that may affect processing in a publishing or prepress workflow. The
report provides the criteria comparison results.

To determine whether or not a PDF Preflight report has been generated
for a PDF file, you must display the Preflight Report column in Job
Manager.

About page box layout

media box Defines the location and size of the physical medium on which the page is intended to be
displayed or printed.

bleed box Defines the bounds to which the contents of the page should be clipped when output in a
production environment. Default value is the page's crop box.

trim box Defines the intended dimensions of the finished page after trimming. This may be smaller
than the media box to allow for production-related content such as printing instructions, cut
marks, or color bars. The default value is the page's crop box.

art box Defines the extent of the page's meaningful content, including potential white space. Default
value is the page's crop box.

crop box Defines the region to which the contents of the page are to be clipped (or cropped) when
displayed or printed. Unlike the other boxes, the crop box has no defined meaning in terms of
physical page geometry or intended use, it merely suggests where the page should be clipped.

PDF/X-1a restrictions

PDF Preflight checks that files comply with PDF/X-1a:2001 standard.
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In either of the following situations, you must specify either the art box
or trim box.

● Page box layout does not conform with press layout
● Layout has no crop box or crop box is equal to media box

The art box defines the extent of a page's meaningful content. If you
are using only part of a page, the art box is the area of text, pictures,
and needed white space. The rest of the page, which is blank, isn't
considered.

If you are using the whole page, then you must specify the trim box,
media box, and the bleed box. If the bleed box is not already defined,
you can specify that the normalizer function set the bleed box to be
equal to the media box.

Press layout specifications:

● The outer box must be the media box.
● The bleed box must be inside or equal to the media box.
● The trim box must be inside or equal to the bleed box.
● The layout has no crop box or the crop box is equal to the media

box.

Minimum Trim to Bleed Margin: PDF Preflight checks whether the
document contains predetermined or sufficient bleed.

Minimum Bleed to Media Margin: See the preceding diagram to see
how media margin is defined. PDF Preflight checks whether the
document contains predetermined bleed.

Example

To set Prinergy to check the size of the trim box and check whether a
bleed box is defined, perform the following steps.

In Preflight Profile Editor > Page > Layout:

● In the Page box layout does not conform with list, select Press
Layout.

● Set Minimum Trim to Bleed Margin to 2 pt.
● Set Minimum Bleed to Media Margin to 2 pt.

With these settings, Prinergy checks whether a bleed box is defined. If
it is not, Prinergy defines it during the refine process.
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Preflighting PDF files

1. If required, add a PDF Preflight profile that contains the settings you
want checked.

2. In Job Manager, right-click the PDF files you want to preflight,
select Refine and then the refine process template you want to use.

3. In the Start Process dialog box, click Edit Process Template.

4. In the process template, click the PDF Preflight section box to
enable PDF Preflight.

5. In Preflight Profile File, select the PDF Preflight profile you want to
check the PDF files against (see Step 1).

Modify the other PDF Preflight options in the refine process
template as desired.

6. In the process template, click OK.

7. In the Start Refine Process dialog box, click OK.

Managing Preflight profiles

1. From the Tools menu, select Preflight Profile Manager.

2. Perform one of the following as appropriate:

If You Want
To...

Then...

View a profile Select a profile, and view the description that appears in
the Descriptions box.

To view the settings, click Edit. In the Preflight Profile
Editor, after viewing the settings, click Cancel.

Add a profile Click Add, configure the settings as desired, and then click
Save.

In the Profile Name dialog box, type a name for the new
profile.

Edit a profile Select a profile, click Edit, modify the settings as desired,
and then click Save.

Copy a profile Select a profile, click Edit, modify the settings as desired,
and then click Save As.

In the Profile Name dialog box, type a name for the new
profile.

Remove a
profile

Select a profile, and then click Delete.
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Viewing PDF Preflight reports

1. In Job Manager, click a PDF file that has a PDF Preflight report.

2. From the Job menu, click Preflight Report Viewer.

The PDF Preflight report appears.

Generating PDF Preflight reports for distribution

To create PDF Preflight reports that you can distribute via e-mail or use
with Prepress Portal, automatically generate PDF versions of the
reports. In automatically generated reports, the links will work outside
the Prinergy file system. Links in manually generated reports do not
work outside the Prinergy file system.

1. If required, add a PDF Preflight profile that contains the settings you
want checked.

2. Start a refine process template on the PDF files that you want to
preflight.

Be sure to use a process template with the following options in the
PDF Preflight section:

● A preflight profile
● The desired action on errors
● Whether to always create a report, or to create a report only

when at least one error is detected
● Select Automatically generate PDF version of Preflight Report
● A preflight report location. If e-mailing the report, use, for

example, %JOB%\Reports. If distributing the report with
Prepress Portal, use %JOB%\WebDownloads.

Tip: You can either create a refine process template in advance or you can edit
the refine process template when you start the refine process.

3. If you want proofs to go to the same location as the preflight
reports, generate the proofs using an output process template with
the following options:

● In the Output To list, select PDF (Vector output).
● In the Device section, in the Device Path box, use the same path

as the one used for preflight reports.

If e-mailing the files, use, for example, %JOB%\Reports.

If distributing the files with Prepress Portal, use %JOB%
\WebDownloads.

● In the File Format section, in the Include Images as list, select
Low Resolution.

Viewing PDF Preflight reports 275



Tip: To automatically send proofs and preflight reports to the same location,
create a workflow template linking both process templates.

Preflight Profile Manager

List

Lists the preflight profiles defined in Prinergy. Select a profile to
edit or delete.

Author

Displays the author name.

Description

Displays the profile description or selected category of preflight
criteria.

Edit

Opens the Preflight Profile Editor, and lets you edit the preflight
profile.

Add

Opens the Preflight Profile Editor, and lets you add a new
preflight profile.

Lock

Restricts or enables you to edit the preflight profile. This option
can be set using this dialog box or by using the User Rights tab
on the Configuration Options dialog box in Administrator.

Delete

Lets you remove a preflight profile.

Preflight Profile Editor

Preflight Profile Editor appears when you are adding or editing a
preflight profile.

Categories

Select the category that you want to set.

● Document: PDF Preflight identifies Acrobat compatibilities,
compression, encryption, security, and other properties.

● Page: PDF Preflight detects empty pages and identifies the
page size, annotations, bleed detection, and other properties.
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● Font: PDF Preflight determines whether specific fonts are in
the PDF file and whether they are embedded. PDF Preflight
only embeds Apple TrueType and Type 1 fonts.

● Color: PDF Preflight detects color space information, spot
colors, rendering information, and color management
settings.

● Image: PDF Preflight identifies the image resolution and
determines whether images are skewed or flipped and
whether color, grayscale, and black-and-white images are
compressed.

● OPI: PDF Preflight determines whether Open Prepress
Interface (OPI) is used. If it is, PDF Preflight detects the OPI
version and determines whether high-resolution images in
the OPI path are missing.

● Text and Line Art: PDF Preflight identifies the size of text
and the line widths. It also detects white text and objects
and flatness tolerance, and defines and detects the live area.

● PDF/X: PDF Preflight determines whether the PDF file
conforms to PDF/X-1a or PDF/X-3 and whether the file
contains PostScript fragments.

Detect

Select the check box beside the setting that you want. For
settings with a triangle ( ), click the triangle to expand the
section.

Report

Enables you to specify how you want the PDF Preflight report to
record the preflighting results. For each preflight setting, select
one of the following:

●  Information: Displays the results of the PDF Preflight
operation. If the PDF Preflight Report area in the process
template is set to Always create report, the operation is
logged in the PDF Preflight report and labeled as
Information.

●  Warning: Warns you when the PDF file does not comply
with the settings that you specified in the PDF Preflight
profile. The PDF file may not output correctly. If the PDF
Preflight Report area in the process template is set to
Always create report, the failed settings are logged in the
PDF Preflight report and labeled as a Warning.

●  Error: Specifies the severity of this condition if you do not
specify Fix, or if the file could not be repaired. Select this
setting when you need to identify problems that must be
corrected before moving the PDF file to the next stage in the

PDF preflight 277



workflow. The process template setting for Preflight
Handling (Ignore Errors, Warn on Errors, Fail on Errors)
determines how Prinergy handles Preflight error conditions.

Note: These warnings are different from the condition icons that appear
in Job Manager when a file is being processed.

Fix

For settings which have a Fix option a  in the Fix column
indicates that the Fix option is selected. A  in the Fix column
indicates that the Fix option is not selected.

Click the triangle ( ) to expand the section and see a brief
summary of what the software does when the Fix option is
selected.

Save

Closes the dialog box and saves any changes you've made.

Save As

Lets you save the profile with a new name.

Cancel

Closes the dialog box without saving any changes.

Document settings in Preflight Editor

Information

Title

Detects the PDF file's title, which may have been set by the
person who created the file in the source software, such as
Adobe Illustrator.

Beside Options, type a title in the box. To confirm that the PDF
file you're checking has the title that you typed, select Is or
Contains. To confirm that the PDF file does not have the title
that you typed, select Is Not or Does Not Contain.

To change the title select the Fix check box, and type a new
name in the adjacent box. When you select the Fix check box,
PDF Preflight displays  in the Fix column.

Subject

Detects the PDF file's subject name, which may have been set
by the person who created the file in the source software.
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Beside Options, type a subject in the box. To confirm that the
PDF file you're checking has the subject that you typed, select Is
or Contains. To confirm that the PDF file does not have the
subject that you typed, select Is Not or Does Not Contain.

To change the subject name select the Fix check box.

Author

Detects the PDF file's author, which may have been set by the
person who created the file in the source software.

Beside Options, type the author's name in the box. To confirm
that the PDF file that you're checking has the author that you
typed, select Is or Contains. To confirm that the PDF file does
not have the author that you typed, select Is Not or Does Not
Contain.

To change the author select the Fix check box.

Producer

Identifies the PDF file's producer, which is the software that
generated the PDF file, such as Acrobat Distiller 5.0.

Beside Options, type a producer name in the box. To confirm
that the PDF file that you're checking has the producer that you
typed, select Is or Contains. To confirm that the PDF file does
not have the producer that you typed, select Is Not or Does Not
Contain.

To change the producer select the Fix check box.

Creator

Identifies the PDF file's creator, which is the software that
created the original document, such as Microsoft Word.

Beside Options, type a creator name in the box. To confirm that
the PDF file that you're checking has the creator that you typed,
select Is or Contains. To confirm that the PDF file does not have
the creator that you typed, select Is Not or Does Not Contain.

To change the creator select the Fix check box.

Keyword

Detects keywords in the PDF file. Use when you want to search
for keywords in a document, instead of relying on the file name
or opening the document and searching its contents.

Beside Options, type a keyword in the box. To confirm that the
PDF file that you're checking has the keyword that you typed,
select Is or Contains. To confirm that the PDF file does not have
the keyword that you typed, select Is Not or Does Not Contain.
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To change the keyword select the Fix check box.

Modification and creation date are not set

Identifies the PDF file's modification and creation dates.

To add a date to the current date select the Fix check box.

Trap flag

Detects the PDF file's trapping information

Select Detect if Trap flag Is or I s not set to:

● Trapped
● Not Trapped
● Unknown

To change the trap flag setting select the Fix check box. For
example, if you select Trap flag is not set to Trapped and PDF
Preflight detects that the flag isn't set to trapped in the PDF file,
PDF Preflight changes it to trapped when you select the Fix
check box. If you select Trap flag Is, the Fix check box is not
available.

If you convert the PDF file to PDF/X PDF Preflight automatically
selects Trap flag is not set to: Not Trapped.

Format

PDF version is

Determines whether the PDF file is Not Equal to or Less Than
PDF version 1.3, 1.4, or 1.5. Adobe Acrobat 4.0 and later fully
supports PDF version 1.3.

Besides Options, select the PDF version.

PDF Preflight checks for PDF 1.4 or PDF 1.5 objects in the PDF
file. If the file includes PDF 1.4 or 1.5 objects, most software
cannot process the file correctly without flattening and
converting it to PDF 1.3. Note that a PDF file may be created by
Acrobat Distiller 5.0 and later and still be compatible with PDF
1.3.

PDF uses more advanced features than

Determines whether the PDF file uses more advanced features
than PDF version 1.3 or 1.4.

PDF Preflight checks for PDF 1.4 or PDF 1.5 objects in the PDF
file. If the file includes PDF 1.4 or 1.5 objects, most software
cannot process the file correctly without flattening and
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converting it to PDF 1.3. A PDF file may be created by Adobe
Acrobat Distiller 5.0 and later and still be compatible with PDF
1.3.

Nonoptimal compression

Identifies the methods of compression for the PDF file. PDF
Preflight uses ZIP and LZW compression for color images that
are not optimally compressed and CCITT compression for
monochrome images that are not optimally compressed.

To use ZIP compression select the Fix check box.

Document is ASCII encoded

Determines whether the PDF file uses ASCII or binary encoding.
ASCII encoding works on all platforms and operating systems.
Binary encoding provides smaller files and is acceptable in most
situations.

To remove the ASCII encoding select the Fix check box.

Document is damaged

Determines whether the PDF file has missing objects, such as
graphics.

PDF2Go Files

Detects files from PDF2Go software. PDF Preflight detects
whether the PDF file is a Brisque or PDF2Go file or a PDF
version of the Brisque Export PostScript file. PDF2Go files
include only CEPS (CT/LW) data and should be protected from
data manipulation, such as overprint and trapping.

Document contains Layers

PDF Preflight detects whether the PDF file has layers.

Document structure is compressed

PDF Preflight detects whether the PDF file metadata structure is
compressed.

Security

Encryption

Determines whether the PDF file uses any encryption. Third-
party software, such as Acrobat, can use encryption to restrict
access to a PDF file. You can also set a password that restricts
functions (for example, printing or selecting text) and restricts
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other people from changing the security options that you
selected.

Printing

Determines whether the PDF file permits printing.

Content editing

Determines whether the PDF file permits content changes.

Annotation editing and form authoring

Determines whether the PDF file permits changes to
annotations, including links, bookmarks, attachments, and
comments in the file. This also detects whether the PDF file
allows the creation of forms. A PDF form can collect data from a
user and then send the data via e-mail.

Metadata

Document contains form fields

Detects whether the PDF file contains interactive form fields to
be filled in by the user. The data from these fields can be
exported or imported into other programs.

Document contains article threads

Detects whether the PDF file contains article threads, which link
together items of content within the document that are logically
connected but not physically sequential. For example,
magazines and newspapers arrange text that may flow from
column to column and sometimes across multiple pages. In
Acrobat, you use the Article tool to create a series of linked
rectangles that connect the various sections of an article.

Document contains Sun JavaScript

Detects whether the PDF file contains JavaScript, which can be
added to a form field, link, bookmark, document, or page action.

Document contains thumbnails

Detects whether the PDF file contains thumbnails. Thumbnails
are miniature previews of the pages in a document. In Acrobat,
you can use page thumbnails to jump quickly to a selected page
and to adjust the view of the pages.

Document contains bookmarks

Detects whether the PDF file contains bookmarks. A bookmark
is a type of link that appears on the Bookmarks tab in the
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navigation pane. Each bookmark goes to a different view or
location in the document. You can use electronic bookmarks as
you would with paper documents-to mark a place in a
document to which you want to return. You can also use a
bookmark to direct the reader's attention to where you want it.

Document does not conform to tagged PDF conventions

Detects whether or not the PDF file conforms to tagged PDF
conventions (by determining whether or not the file contains
the key Marked set to the value true in a MarkInfo dictionary).

A PDF conforming to tagged PDF conventions allow
applications to easily extract and reuse content from a PDF
document. The conventions are described in the PDF
Specification.

Document contains actions

Detects whether the PDF file contains actions. In Acrobat, an
action is an event that you can assign to a link, bookmark, page,
and form field. It can include displaying a specified destination
in a document, opening a file, submitting a form, and playing a
sound or movie.

Document contains unused destinations

Detects whether the PDF file contains unused destinations. A
destination is a particular view of a document, including the
page of the document to be displayed and the zoom to use
when displaying the page. Destinations may be associated with
outline items, annotations, or actions.

Page settings in Preflight Editor

Information

Empty Pages

Detects empty pages in the PDF file.

Separated Pages

PDF Preflight detects whether there are separated pages in the
PDF file that are independent of PDF/X-1a specified controls.

Multiple Pages

PDF Preflight detects whether the PDF file contains multiple
pages.
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Graphic element lies completely outside of the media box

PDF Preflight detects whether the PDF file contains graphic
elements that are outside of the media box.

To remove all graphic elements that are outside of the media
box, select the Fix check box.

Report transparent element

PDF Preflight detects whether the PDF file contains elements
that are transparent.

Annotation

Annotations are included

Determines whether the PDF file includes any annotations. An
annotation could be a note, link, bookmark, attachment, or
movie or sound file.

To search for all annotations, select Any annotation. To exclude
the printer's mark or trap network annotations, select Except
Printer's Mark or Trap Network annotations. Printer's mark
and trap network annotations are allowed outside of the bleed
box in PDF/X files.

To remove the annotations, select the Fix check box.

Annotations are set to print

Determines whether the annotations in the PDF file will print.

To ensure that annotations don't print, select the Fix check box,
and select Do not print annotations or select Remove
annotations.

Layout

Measurement units

Determines the linear units used for the size of pages. You can
select points, picas, inches, centimeters, or millimeters. The
default is points.

Page size is defined by the

Determines the PDF box that defines the page size. Options
include media box, crop box, trim box, art box, and bleed box.
Trim box is likely to be the most useful setting.

Page size is not

Determines whether pages are the same size in the PDF file.
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To confirm that all the pages in the PDF file are the same size,
select Equal for all pages.

To confirm that the media boxes of the pages are the size that
you specify, select the second option beside the two boxes, and
type the media box dimensions in the boxes.

To change the page size, select the Fix check box. If you
selected Equal for all pages, and you want to set the page size
to the bounding box, select Enclosing bounding box. The
enclosing bounding box refers to the PDF media box.

To set the page size to dimensions that you specify, select the
second option, type the page dimensions in the boxes, and from
the Align page content to list, select an alignment option.

Page orientation is not equal for all pages

Determines whether pages are a combination of portrait and
landscape orientations.

To change all pages to the same orientation, select the Fix
check box, and select Portrait or Landscape, according to your
requirements.

Page box layout does not conform with <list>

PDF Preflight detects whether the page box layout in the PDF
file does not conform with Press Layout or Screen Viewing
Layout.

Select Press Layout or Screen Viewing Layout, and enter the
Minimum Trim to Bleed Margin and Minimum Bleed to Media
Margin points.

PDF Preflight checks whether the document contains
predetermined or sufficient bleed.

Select the Layout has crop box equal to trim box or Layout has
no crop box or crop box is equal to media box option.

Scaling

Page scaling factor is used

PDF Preflight detects whether the PDF file contains page
scaling.

Page scaling ensures that a page prints with the same scale
factor that is displayed on the screen.
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Bleed

Measurement units

Determines the linear units used for the size of pages. You can
select points, picas, inches, centimeters, or millimeters. The
default is points.

Bleed detection

Determines whether the image extends to the bleed box.
Defines the maximum gap that can exist between the trim box
and the bleed box before the image requires bleed.

To adjust the bleed detection, enter the desired values. By
default, bleed detection is turned off.

Check objects that touch the trim box, or objects that almost
touch the trim box (within a certain distance).

Consider image content when deciding if images have sufficient
bleed option to determine if the detection should take into
account the content of images—for example, whether or not
white pixels are acceptable.

You may find that the bleed detection feature works best if you
enter the minimum bleed that is acceptable, rather than the
minimum bleed that is ideal. For example, if you ask designers
to create a 0.125-in. bleed, but find that a 0.0625-in. bleed is
acceptable, the preflight results have fewer messages if you ask
PDF Preflight to look for a 0.0625-in. bleed.

Note: This option can result in slower performance.

Note: The preflight bleed detection feature detects and reports bleed
problems even when the trim box is equal to the media box. For example,
a user might create a file in the QuarkXPress software with <X> amount
of bleed, save and export the PDF file with no crop marks, and then
import and refine it with <X> amount of bleed preflight detection.

Font settings in Preflight Editor

Type

True Type

Determines whether the PDF file contains TrueType fonts.
TrueType fonts are built into Windows and Macintosh
operating systems and print well on both PostScript and non-
PostScript printers.
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Type 1

Determines whether the PDF file contains Type 1 fonts. Type 1
fonts, also called PostScript fonts, contain defined character
shapes in an encoded PostScript format and contain hints in
their character definitions. Hints help reproduce font outlines
while maintaining the font shape at low resolutions.

Type 3

Determines whether the PDF file contains Type 3 fonts, which
are mostly ornamental and decorative. Type 3 fonts may
contain gradations or be entirely black. Type 3 fonts produce
larger files than TrueType or Type 1 fonts.

Multi-Master

Determines whether the PDF file contains Multi-Master fonts,
which give designers more flexibility with a typeface. Use a
Multi-Master font to create many variations of the same font.

Composite

Determines whether the PDF file contains Composite fonts,
which enable the encoding of very large character sets and
writing that is not horizontal. Composite font technology can be
used worldwide.

City font is used

Determines whether the PDF file contains fonts named after
cities. Macintosh system fonts typically have city names, for
example, Athens, Chicago, Geneva, London, New York, San
Francisco, Venice, and Monaco.

Name

Font Name

Checks the PDF file for the font names that appear in the Font
Name boxes. Type the font name in the box. You can add up to
eight Font Name boxes by clicking the plus sign (+). To delete a
font name, select the box and click the minus sign (-).

Embedding

Font is not embedded

Determines whether any fonts in the PDF file are not
embedded. Embedding prevents font substitution when readers
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view or print the file and ensures that readers see the text in its
original format.

If some fonts are not embedded in the PDF file select the Fix
check box and select Embed Font to embed the fonts. PDF
Preflight can embed Type 1 and TrueType fonts. To replace all
text objects with vector objects in the output, select Outline
font. This eliminates font formats that some RIPs may not be
able to process. Text output in this way cannot be edited.

To ignore Base 14 fonts select Ignore 14 base fonts. Base 14
fonts are sometimes not embedded in PDF files because they're
installed on most computers.

Double byte font is completely embedded

PDF Preflight detects whether double-byte fonts are completely
embedded in the PDF file.

Embedded font is OpenType

PDF Preflight detects whether a PDF file contains embedded
OpenType fonts.

Embedded font is <list>

To determine whether the PDF file contains all embedded fonts
select Complete. To determine if the PDF file contains only a
subset of embedded fonts, select Subset.

Style

Artificial Bold

Certain software applications allow you to specify artificial font
styles, such as bolding and italics, even though the type family
itself does not support the style. Use this feature to determine
whether or not the PDF file contains any fonts with the
following artificial styles:

● Artificial Bold
● Artificial Italic
● Artificial Outline
● Artificial Shadow

Artificial Italic

Certain software applications allow you to specify artificial font
styles, such as bolding and italics, even though the type family
itself does not support the style. Use this feature to determine
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whether or not the PDF file contains any fonts with the
following artificial styles:

● Artificial Bold
● Artificial Italic
● Artificial Outline
● Artificial Shadow

Artificial Outline

Certain software applications allow you to specify artificial font
styles, such as bolding and italics, even though the type family
itself does not support the style. Use this feature to determine
whether or not the PDF file contains any fonts with the
following artificial styles:

● Artificial Bold
● Artificial Italic
● Artificial Outline
● Artificial Shadow

Artificial Shadow

Certain software applications allow you to specify artificial font
styles, such as bolding and italics, even though the type family
itself does not support the style. Use this feature to determine
whether or not the PDF file contains any fonts with the
following artificial styles:

● Artificial Bold
● Artificial Italic
● Artificial Outline
● Artificial Shadow

Color settings in Preflight Editor

PDF Preflight includes some color condition detection and correction
parameters that are not available in the ColorConvert section of the
refine process template.

Preflight reports include color information based on both the settings in
the ColorConvert section of the refine process template and the
preflight options that you select in the Preflight Editor.
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Process & RGB

A non press color is used

Determines whether the PDF file contains specific colors in the
text, line art, and in pixel images that use one or more of the
following color models:

● RGB
● Calibrated Gray
● Calibrated RGB
● LAB
● ICC Based

Pattern or indexed color is used

Determines whether the PDF file contains an indexed color
space. Select Pattern or indexed color is used to select colors
from a color map or color table in another color space. An
indexed color space can considerably reduce the amount of
data required to represent a sampled image.

Shading is used

Determines whether pattern shading is used in the PDF file

Ink coverage is lower than

Determines whether there is enough ink coverage in the PDF
file to register on the plate. The default is 4%. You cannot enter
a value less than 0 or greater than 3200.

To restrict ink coverage detection within a bounding box, select
the Restrict to elements within check box, and then select
media box, crop box, trim box, art box, or bleed box.

Optionally, you can select Ignore colorant "All" to ignore the
registration color.

Note: The Ignore colorant "All" setting applies to both high and low
coverage. If you select it when checking for low ink coverage, it will also
apply if you select the Ink coverage is higher than check box.

Select the Detect image ink coverage check box to define a
minimum area of connected pixels that must be below the ink
coverage limit before an error is triggered. Then, use the
Sample area size box and unit list to define a square area of
connected pixels. You can enter a value between 0 and 3.5 inch
or 9 cm, depending on the unit that was selected in the
preferences.
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Ink coverage is higher than

Determines whether the PDF file contains too many combined
inks to produce a given color. You cannot enter a value less
than 0 or greater than 3200.

To restrict ink coverage detection within a bounding box, select
the Restrict to elements within check box, and then select
media box, crop box, trim box, art box, or bleed box.

Optionally, you can select Ignore colorant "All" to ignore the
registration color.

Note: The Ignore colorant "All" setting applies to both high and low
coverage. If you select it when checking for high ink coverage, it will also
apply if you select the Ink coverage is lower than check box.

Select the Detect image ink coverage check box to define a
minimum area of connected pixels that must exceed the ink
coverage limit before an error is triggered. Then, use the
Sample area size box and unit list to define the side length of
the square area of connected pixels. You can enter a value
between 0 and 3.5 inch or 9 cm, depending on the unit that was
selected in the preferences. If the average ink coverage of the
pixels is above the limit, an error will be triggered.

RGB Black or CMYK Black is used

Determines whether the PDF file contains any black that is
mixed from RGB or CMYK.

To convert black to grayscale, select the Fix check box.

RGB Gray or CMYK Gray is used

Determines whether the PDF file contains any gray that is
mixed from RGB or CMYK.

To convert gray to grayscale, select the Fix check box.

Impure CMYK Black is used (sum of Cyan, Magenta, and Yellow
exceeds 70%)

Determines whether the PDF file contains any impure black.
Black produced when the sum of cyan, magenta, and yellow
inks exceed 70% is considered impure.

To convert the impure black to pure CMYK black, select the Fix
check box.
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Impure CMYK Gray is used (equal and non-zero amounts of Cyan,
Magenta, and Yellow)

Determines whether the PDF file contains any impure gray.
Gray produced by equal amounts of cyan, magenta, and yellow
is considered impure.

To convert the impure gray to shades of black ink only, select
the Fix check box.

Spot Color

Spot color is used

Identifies painted spot colors in the PDF file.

To restrict spot color detection within a bounding box, select
the Restrict to elements within check box, and then select
media box, crop box, trim box, art box, or bleed box.

Spot color definition is ambiguous

Determines when two spot colors use the same name but have
different alternate color space (ACS) values or different recipes
(for example, CMYK equivalents) in the PDF file.

To repair the ambiguous spot colors, select the Fix check box.
PDF Preflight uses the spot color with L*a*b* ACS, then CMYK
ACS, then gray ACS, and finally RGB ACS. If the spot colors use
the same ACS, PDF Preflight uses the first instance of the spot
color and applies that instance to all other spot colors with the
same name.

Spot color suffix is not

Determines specific PANTONE spot color name endings in the
PDF file. In the list, you can select C, CV, CVC, CVS, CVU, CVP,
or U.

For example, if you select Spot color suffix is not: CV, PDF
Preflight checks the PDF file for spot color suffixes that are not
CV. To change the name endings to CV, select the Fix check
box.

Use this option to ensure that identical PANTONE spot colors
appear on the same separation, even if they originally had
different name endings.

Spot color has an alternative color space other than CMYK or Gray

Identifies spot colors with an ACS definition other than CMYK
or gray in the PDF file.
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Number of separations

Determines the number of separations in the PDF file and
compares it to a number that you specify. To specify the
number of separations, select a setting in the Options: Is list,
and type a number in the adjacent box.

To not count CMYK colors, select the Do not count colors
(C,M,Y,K) check box.

To not count All colors, select the Do not count All check box.

To not count a separation that you specify, select the Do not
count check box, and type the name of the separation in the
adjacent box.

To restrict spot color detection within a bounding box, select
the Restrict to elements within check box, and select media
box, crop box, trim box, art box, or bleed box.

Rendering Parameters

Custom transfer curve used for images

Determines whether the PDF file contains a custom transfer
curve. A custom transfer curve adjusts the values of color
components in the file to compensate for the output device and
the human eye. The transfer curve can be text and line art,
images, or any other element.

To add or remove a custom transfer curve, select the Fix check
box, and select Apply Transfer curve or Remove Transfer
curve. To apply a transfer curve, the curve must use CMYK or a
spot color, and PDF Preflight profile must use color
management.

Custom halftone curve is used

Determines whether the PDF file contains a custom halftone
curve. A custom halftone curve defines characteristics such as
screen angle, frequency, screen shape, and proprietary screen
names. Screen information is applicable to RIPs that convert
data to bitmaps.

To remove a custom halftone curve, select the Fix check box.

Under Color Removal function is used

Determines whether the PDF file contains an under-color-
removal function. An under-color-removal function reduces the
amounts of cyan, magenta, and yellow to compensate for the
amount of black that was added by black generation.
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To remove the under-color-removal function, select the Fix
check box.

Rendering intent for text and line art are not

Determines whether the rendering intent for the text and line
art is not one of the on-screen settings. In the Options list,
select one of the following settings:

Absolute Colorimetric

Colors are solely represented using the light source. No
correction is made for the output medium's white point.
For example, an output medium's white point might be
the color of paper with no print marks on it.

Relative Colorimetric

Colors are represented using a combination of the light
source and the output medium's white point.

Perceptual

Colors are represented in a way that provides a pleasing
perceptual appearance.

Saturation

Colors are represented in a way that preserves or
emphasizes saturation.

The rendering intent influences the conversion from device-
independent color spaces to a target color space.

To change the rendering intent setting, select the Fix check box.
For example, if you selected Absolute Colorimetric and PDF
Preflight detects that text and line art are not set to Absolute
Colorimetric in the PDF file, PDF Preflight changes the text and
line art when you select the Fix check box.

Rendering intent for images is not

Determines whether the rendering intent for images in the PDF
file is not one of the on-screen options. In the Options list,
select one of the following options:

● Absolute Colorimetric
● Relative Colorimetric
● Perceptual
● Saturation

To change the rendering intent setting, select the Fix check box.
For example, if you selected Absolute Colorimetric in the
Options list and PDF Preflight detects that images are not set to
Absolute Colorimetric in the PDF file, PDF Preflight changes
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them to Absolute Colorimetric when you select the Fix check
box.

Rendering intent operator is used

Preflight detects the use of the rendering intent operator in the
content stream and reports its use.

Black generation curve is used

Determines whether the PDF file uses the black generation
curve, which calculates the level of black to use when
converting RGB colors to CMYK.

To remove the black generation function, select the Fix check
box.

Detect if Halftone phase is used

PDF Preflight detects whether the PDF file contains halftone
phases.

To remove all halftone phases, select the Fix check box.

ICC Profiles

Text and line art <list> tagged with ICC profile

Determines whether the PDF file is tagged with an ICC profile
for text, line art, and images.

To determine whether the PDF file contains text and line art
that are tagged with an ICC profile, click Text and Line Art
above the Detect area. Select Text and line art, and in the
adjacent list, select are or are not.

To determine whether the PDF file contains images that are
tagged with an ICC profile, click Images above the Detect area.
Select Images and in the adjacent list, select are or are not.

To change the ICC profile, select the Fix check box, and select
one of the following settings:

● Select Remove ICC profile to remove the embedded ICC
profile from the PDF file.

● Tag with source ICC profile to add a source ICC profile to the
PDF file. In the Source ICC Profiles area, select one or more
of the following profiles:

○ CMYK
○ RGB
○ Gray
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In the adjacent list, select a profile.

Multi Channel

NChannel color space is used

PDF Preflight detects whether a PDF file uses NChannel color
spaces.

Image settings in Preflight Editor

Resolution

Resolution of color or grayscale image is below

Determines whether any color or grayscale images in the PDF
file have a lower resolution than the value that you specify. To
change the resolution, type a value in the adjacent box. The
default is 150 dpi.

Resolution of color or grayscale image is above

Determines whether any color or grayscale images in the PDF
file have a higher resolution than the value that you specify. The
default is 300 dpi.

To reduce the resolution, select the Fix check box, type a
number in the adjacent box, and select one of the following
settings:

● Average downsampling to average the pixels in a sample
area and replace the entire area with average pixel color at
the specified resolution.

● Bicubic downsampling to use a weighted average to
determine pixel color. This usually yields better results than
the simple averaging method of downsampling. Bicubic is
the slowest but most precise method, resulting in the
smoothest tonal gradations.

Resolution of B&W images is below

Determines whether any black-and-white images in the PDF file
have a lower resolution than the value that you specify. To
change the resolution, type a value in the adjacent box. The
default is 1200 dpi.

Resolution of B&W images is above

Determines whether any black-and-white images in the PDF file
have a higher resolution than the value that you specify. To
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change the resolution, type a value in the adjacent box. The
default is 2400 dpi.

Kodak alternate <list> defined for images

Determines whether a Kodak alternate image is defined for
images. An alternate image is used when creating low
resolution PDFs from Publish PDF, or Vector output from
Prinergy, or Insite Prepress Portal.

● To detect whether alternate images are present, select
Kodak alternate <is> defined for images.

● To add alternate images if they aren't present, select Kodak
alternate <is not> defined for images and then select the Fix
check box.

Image has alternates defined

PDF Preflight detects whether the PDF file contains alternate
images for printing.

If you want to use an alternate image, select the And one of the
alternates is the default for printing check box.

Files contain CEPS data

Determines whether the PDF file contains any CEPS (CT/LW)
or TIFF/IT files.

If you select the Files contain CEPS data check box, PDF
Preflight marks the CT/LW data so that it is not trapped and
overprint settings are not modified. Trapping CT/LW data may
produce artifacts such as hairline gaps on the refined PDF.
Changing overprint settings may create a result that was not
intended, such as removing existing traps.

Select this check box for pages on which the content is mixed.
For example, the content may have vector text and CEPS format
images.

Image uses 16 bits per channel

PDF Preflight detects whether the PDF file contains any images
that use 16 bits per sample.

Position

Image is rotated at an angle that is not a multiple of 90 degrees

Determines whether the PDF file contains an image that is
rotated at an angle that is not a multiple of 90 degrees.
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Image is skewed

Determines whether the PDF file contains an image that has a
skew transformation applied. Ripping a skewed image from a
PostScript format into a raster (or bitmap format) can be very
time- and memory-intensive.

Image is flipped horizontally

Determines whether the PDF file contains an image that has
been transformed into a mirror image.

Image is not scaled proportionally

Determines whether the PDF file contains an image in which the
X scaling differs from the Y scaling.

To specify how much the X scaling can differ from the Y scaling,
select the Option check box and type a number in the adjacent
box. For example, if you select the Option check box and type
0.5%, PDF Preflight only detects images in which the X scaling
differs from the Y scaling by more than 0.5%.

Compression

Color or grayscale images

Determines whether the PDF file contains images that are
compressed using one or more of the on-screen options. From
the Options menu, select one of the following options:

● JPEG compressed. JPEG compression removes image data
and may reduce image quality. It can achieve much smaller
file sizes than ZIP compression.

● JPEG2000 compressed. JPEG2000 compression may
remove image data and may reduce image quality. It can
achieve much smaller file sizes than ZIP compression.

Note: If an image is compressed with JPEG2000 compression and
you modify it in Prinergy (for example, downsampling or color
matching the image), Prinergy will not be able to encode it back to
JPEG2000 compression. Therefore, it is recommended to select this
check box, so that these images are detected, and then select the Fix
check box and select ZIP (preferred) or JPEG as an alternative
compression type.

● ZIP compressed. ZIP compression works well with large
areas of single colors or repeating patterns, such as
screenshots and simple images.

● LZW compressed. LZW compression is used in GIF and TIFF
files. It is also suitable for compressing text files.

● Run Length compressed. Run Length compression does not
remove data to reduce the file size, so it doesn't affect the
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quality of images. It produces the best results in images that
contain large areas of solid white or black.

● Not compressed

To use another compression method for color or grayscale
images, select the Fix check box and select JPEG or ZIP. If you
select JPEG, select a level of quality from the adjacent list.

Black and white images are

Determines whether the PDF file contains black-and-white
images that are compressed using one or more of the following
methods of the on-screen options. From the Options menu,
select one of the following options:

● JBIG compressed. JBIG compression of bilevel images uses
only one bit to express the color value of each pixel. JBIG
compression does not remove data to reduce the file size, so
it doesn't affect the quality of images.

● CCITT compressed. CCITT compression is appropriate for
black-and-white images created in paint programs and for
images scanned with an image depth of 1 bit. It does not
remove data to reduce the file size, so it doesn't affect the
quality of images.

● ZIP compressed
● LZW compressed
● Run Length compressed
● Not compressed

To use another compression method for black-and-white
images, select the Fix check box and select CCITT G4, ZIP, or
Run Length. CCITT G4 is a general-purpose option that
produces good compression for most types of monochrome
images.

JPEG compression ratio

Detects JPEG images in the PDF file that may have deteriorated
because of a high compression ratio. PDF Preflight looks for
images with a higher compression ratio than the value that you
specify. The default value is 4.

OPI settings in Preflight Editor

OPI

OPI version is incompatible with

Determines whether the PDF file is incompatible with the OPI
version that you specify.
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To check OPI compatibilities select the OPI version is
incompatible with check box and select 1.3, 2.0, or 1.3 and 2.0
from the adjacent list. OPI 2.0 defines a new set of comments
and rules with no backward compatibility to version 1.x.

OPI is used

Determines whether the PDF file contains OPI images with a
higher resolution than the value that you specify.

To check an OPI image for a PDF file select the OPI is used
check box. To remove OPI image references with a higher
resolution than you want, select the Fix check box and type the
maximum resolution in the adjacent box.

Note: PDF Preflight will not detect OPI images if the Search for High-
Resolution Images in Image Search Paths check box is selected on the
Fonts and Images panel in the Refine process template. PDF Preflight will
not detect non embedded fonts, if the Fail on Missing Fonts check box is
selected on the Fonts and Images panel in the Refine process template.

High-resolution image in OPI path is missing

Determines whether the high-resolution image is missing in the
OPI path or in any folders in the path. If the image is missing,
additional processing of the PDF file may fail.

Text and Line Art settings in Preflight Editor

Text and Line Art

Text is smaller than <list> points

Determines whether the PDF file contains text that is smaller
than the font point size that you specify. The default is 5 points.

Text is smaller than <list> and is colored with <list> or more
separations

Determines whether the PDF file contains text that is smaller
than the font point size that you specify and is colored with the
number of separations that you specify. The defaults are 8
points for the font and two separations.

Text is smaller than <list> points and white

Determines whether the PDF file contains white text that is
smaller than the point size that you specify. The default is 5
points.
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White text does not knock out

Determines whether the PDF file contains white text that does
not knock out (that is, the text is invisible).

To knock out white text, select the Fix check box.

Black text is smaller than <list> points and does not overprint

Determines whether the PDF file contains black text that does
not overprint and is smaller than the font point size that you
specify.

To overprint the black text, select the Fix check box.

Text is invisible (text has no fill nor stroke color)

Determines whether the PDF file contains text that uses neither
stroke nor fill (that is, the text is invisible).

To remove the invisible text, select the Fix check box.

Line width less than <list> points

Determines whether the PDF file contains lines narrower than
the width value that you specify. The default is 2.0 points.

To increase the minimum line width, select the Fix check box.

Some software, such as Adobe Illustrator, creates color blends
between path objects by overlapping objects of a similar shape,
position, and color. This produces the visual effect of a shading
object. To protect the blend of these objects, select the Protect
Blend check box.

The following blend types are supported:

● Radial blends with concentric circles that are increasing or
decreasing

● Axial blends with overlapping paths of a similar shape but a
slightly different position

● Interleaved blends made up of groups of paths with a similar
shape but a slightly different position

Line width less than <list> points and is colored with <list> or more
separations

Determines whether the PDF file contains lines narrower than
the width value that you specify and that are colored with the
number of separations that you specify. The defaults are 5.0
points and two separations.

To increase the minimum line width, select the Fix check box.
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White objects do not knock out

Determines whether the PDF file contains white objects that are
not set to knock out.

To knock out white objects, select the Fix check box.

Flatness tolerance is different than <list> points

Determines whether the flatness tolerance in the PDF file is
different than the value that you specify. The flatness tolerance
controls the maximum permitted distance in device pixels
between the original path and an approximation of straight-line
segments. In other words, flatness tolerance controls the
precision of curve rendering.

To set the flatness tolerance in the PDF file to the number of
points that you specify, select the Fix check box.

Maximum miter limit is above <list>

Determines whether the PDF file contains text and line art that
has a miter limit above the number that you specify. The default
is 10.0 points.

To decrease the miter limit of text and line art to the number
specified, select the Fix check box.

Line art is invisible (line art has no fill nor stroke color)

Determines whether the PDF file contains line art that uses
neither fill nor a stroke color (that is, the line art is invisible).

To remove the invisible line art, select the Fix check box.

Live Area

Measurement units

Determines the linear units used for the size of pages. You can
select points, picas, inches, centimeters, or millimeters. The
default is points.

Live area detection: Page contains text that is too close to the inside
of the trim box

Determines how close text can be to the trim box.

To adjust the live area detection, enter the desired values. By
default, live area detection is turned off.

PDF/X settings in Preflight Editor

PDF/X
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Document does not conform to

Determines whether the PDF file conforms to PDF/X-1a or
PDF/X-3. PDF/X is an exchange format for sending pages
between a page preparation and printing site. PDF/X is a subset
of the full PDF specification and is intended to be more
predictable because it has commonly agreed-on characteristics.

To determine whether the PDF file conforms to one of the PDF/
X formats, select one of the following options:

● PDF/X-1a
● PDF/X-3: suitable for a color-managed workflow and allows

for the exchange of data in the device color space or in an
independent color space, such as L*a*b*, CalGray, or CalRGB

To convert the file to PDF/X-1a or PDF/X-3 select the Fix check
box and set the output intent that resides in the root of the PDF
file. The output intent describes how the PDF file should be
printed using a CMYK printing process. An output intent uses
either a registered profile (Standard ICC) or an output profile
(CMYK output ICC profiles).

● Standard ICC: a reference to a registered ICC profile on 
http://www.color.org. It is always set to CGATS TR 001,
which is SWOP (publication) printing in the U.S.

● CMYK output ICC profiles: from the adjacent list, select an
output ICC profile that was set up in PDF Preflight.

Output intent does not conform to <list> requirements

Checks that the output intent is valid according to the selected
PDF/X standards. The output intent identifies the final output
destination of the PDF file, so that everyone involved in the
workflow can take the output intent into account.

If the output intent is not valid, set the output intent in the PDF
document to:

● A standard ICC characterization name
● A CMYK ICC profile

Document contains embedded PostScript fragments

Determines whether the PDF file contains embedded PostScript
fragments. PostScript fragments may change the appearance of
the printed document but they don't appear in the screen
preview of the file.
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PDF/X format does not permit PostScript fragments in a PDF
file. Removing a fragment from a PDF file may also alter other
elements.

TrapNet annotation does not conform to <list> requirements

Detects whether the PDF file contains TrapNet annotations that
do not conform to PDF/X-1a:2001 or PDF/X-3:2002
requirements, depending on your selection.

Detect Unknown Objects

PDF Preflight detects whether the PDF file contains unknown
objects.

PDF/X version key is not set to <list>

Detects whether the version key for the PDF file is set to PDF/
X-1a:2001 or PDF/X-3:2002, depending on your selection.

Document contains annotation which lies inside printable area
(except TrapNet)

PDF Preflight detects whether the PDF file contains annotations
which lie inside the printable area, except for TrapNet.

To remove annotations which lie inside the printable area
except for TrapNet, select the Fix check box.

Image search paths

About image search paths

An image search path specifies the location of a job's high-resolution
images. They tell the system where to search for referenced images.

Image search paths apply only when:
● Images are not embedded inside input files. You do not use image

search paths when images are embedded inside input files.
● The input files have OPI comments
● The input files have not yet been processed
● OPI is enabled by selecting the Search for High-Resolution Images

in Image Search Paths check box in the Fonts and Images section of
the refine process template

If a job uses images in multiple folders, add an image search path for
each folder and then specify the order in which you want the system to
search the folders.

You can copy an image search path from an existing job when you
create the job or after it is created.
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How Prinergy searches for images

When searching for image files, Prinergy uses the following
information:

● The location of the input PostScript file
● The path and file name content of each OPI comment
● The user-specified image search path from the Image Search Paths

dialog box

If you use multiple image search paths, the list of search paths in the
Image Search Paths dialog box determines the order in which they are
searched. In other words, the system searches the paths starting at the
top of the list in the Image Search Paths dialog box. Click the Move Up
and Move Down buttons in the Image Search Paths dialog box to
rearrange the order of the search paths. See the example below.

To control the search, you can:

● Determine whether Prinergy searches the subfolders of image
search paths by selecting or clearing the Search Subfolders check
box in the Image Replacement area of the Fonts and Images
section of the process template. Prinergy searches the subfolders in
alphabetical order, and searches all immediate subfolders before
looking deeper. See the example below.

● Ignore certain types of images by selecting the Skip Images With
These Suffixes check box and specifying the file extensions that you
want the search to omit.

● Determine whether the refine process continues if an image is not
found by selecting or clearing the Failing on missing images check
box in the Fonts and Images section in the refine process template.

Example of searching multiple folders

Given the following conditions:

● A Macintosh share (used when writing the PostScript file) named
MacVolume1 at \\NT1\Share1\Folder1.

● The input PostScript file is located at \
\NT1\Share1\Folder1\Folder2\PostScriptFile.ps.

The Macintosh computer sees this location as
MacVolume1:Folder2:PostScriptFile.ps.

● One of the images used in the PostScript file is located at \
\NT1\Share1\Folder1\ImageFolder\Image.eps.

The Macintosh computer sees this location as
MacVolume1:ImageFolder\Image.eps.
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● The PostScript file contains the OPI comment:
%ALDImageFileName: MacVolume1:ImageFolder:Image.eps.

● The Image Search Paths dialog box in Prinergy Workshop contains
the following image search paths:

\\NT2\Share2\Folder3\Folder4\ImageFolder2
\\NT1\Share1\Folder1

Prinergy uses the following path names, in the order indicated, to find
Image.eps:

1. The same directory as the input PostScript file: \
\NT1\Share1\Folder1\Folder2\Image.eps

2. The first image search path: \
\NT2\Share2\Folder3\Folder4\ImageFolder2\Image.
eps

3. The second image search path: \
\NT1\Share1\Folder1\Image.eps

4. The same directory as the input PostScript file, with the
%ALDImageFileName: path \
\NT1\Share1\Folder1\Folder2\ImageFolder
\Image.eps

5. The first image search path, with the %ALDImageFileName: path \
\NT2\Share2\Folder3\Folder4\ImageFolder2\ImageF
older\Image.eps

6. The second image search path, with the %ALDImageFileName:
path \\NT1\Share1\Folder1\ImageFolder\Image.eps

Example of Searching Subfolders

This diagram shows the search order if the search path was set to the
images folder. The numbers indicate the order in which Prinergy
encounters each file as it searches through the subfolders.

If Prinergy was looking for the fish.tif image, it would find file
number 5 inside the hires folder after searching the images root
folder and after searching the don folder. If Prinergy was looking for
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the logo.eps image, it would find file number 2 rather than number
4.

If you give different images the same name, Prinergy may discover the
images in unexpected ways. The diagram contains two images named
logo.eps; this ambiguity could cause undesirable results. If there is
any doubt, carefully check the refined pages.

Recursive searching can take a long time if Prinergy has to search many
subfolders. Performance of refine processing may be affected. Be
cautious when using this feature with search paths that point to large
disks.

About Macintosh characters and paths

This topic does not address the Macintosh character set or possibilities
of translation from the Macintosh character set to the Windows NT file
name character set. All names in these examples are very simple. This
is only for clarity; it is not intended to imply restrictions on character
sets.

The system parses the %ALDImageFileName: comment to remove the
first portion of a Macintosh path. That portion is considered the disk
name. The system always ignores the disk name, because the name
may be ambiguous, or it may not exist as a folder name under the
Windows NT operating system.

Because the system removes the disk name, you can specify a disk
name in the Image Search Paths dialog box. To select a disk name, click
the Volumes button in the Image Search Paths dialog box, and then
select a volume. The system interprets the selected volume as the disk
name for the job.

About OPI

Prinergy accepts PostScript and PDF files that contains OPI links and
merges in high-resolution images following an image search path
defined by selecting Image Search Path from the Job menu in Job
Manager.

The parameters for OPI are set in the Fonts and Images section of the
refine process template, and OPI is resolved as part of that process.
This allows Prinergy to work with complete, optimized, reliable digital
masters carrying full resolution data-everything needed to output to
any device.

If you prefer, you can choose to continue using your own OPI. In this
case, you should perform OPI before adding input files to a Prinergy
job, and turn off the Prinergy OPI in the Fonts and Images section of
the refine process template.

For TIFF images, you can use clipping paths, spot colors, soft masks,
and drop shadows with OPI.
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Supported image formats

The table below lists the file formats that OPI supports and does not
support.

Supported Not Supported

EPS (RGB, grayscale, bitmap, CMYK, LAB, monotone, Photoshop
duotone), Scitex APR

JPEG TIFF (JIFF)

Scitex .e linked to CMYK TIFF, CMYK DCS, CMYK + spot DCS, and
multiple Scitex .e linked to a single HiRes file

Scitex .e linked to spot TIFF

TIFF (RGB, grayscale, bitmap, CMYK, LAB, LZW-compressed, JPEG-
compressed)

TIFF/IT

Scitex CT (CMYK, grayscale CT (RGB)

JPEG-encoded EPS (composite PostScript)
JPEG-encoded DCS (separated
PostScript)

JPEG JPEG 2000

PDF (Some software such as InDesign allows you to omit placed PDFs
for replacement with OPI. This is supported with Prinergy OPI.)

*Photoshop DCS 1.0 in a composite workflow. Formats supported: 8-bit
binary and ASCII Hex data format, 1-bit Copydot

1-bit images and other types of DCS
1.0 files in a composite workflow—for
example, Vector DCS

*Photoshop DCS 2.0 in a composite workflow

Formats supported: 8-bit binary, ASCII Hex data format, and the data
format where the decode was first done by an ASCII 85 filter and then
by a JPEG filter, 1-bit Copydot

1-bit images and other types of DCS
2.0 files in a composite workflow—for
example, Vector DCS

*Copydot DCS in a composite page from Renaissance scanner,
EskoScan, Autologic, PCC, LinoColor, DCSMaker, Fuji, Cezanne, or
NewsWay

*Prinergy enables OPI to support DCS 1.0 and 2.0 by intercepting the
DCS set during the OPI merge and substituting the DCS set with a
composite EPS file. Prinergy generates the EPS file by recombining the
color channels from the DCS set into a DeviceN image.

Supported Image References in PostScript Input Files

Prinergy's OPI supports the following image references in PostScript
input files:

● OPI version 1.3
● OPI version 2.0
● Imagemanager Pro (.lay file extensions)
● Scitex APR (.e file extensions)
● Helios (.lay file extensions)
● ColorCentral (.samp file extensions)
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Note: In some cases, the above software can produce a low-resolution image that
has a different file extension than the original high-resolution image. When
PostScript input files contain low-resolution images that have different file
extensions than the high-resolution images, Prinergy can replace the low-
resolution image with the high-resolution image as long as both files are in the
same folder.

About optimizing images

Optimizing is a function of the refiner that allows Prinergy to effectively
handle high-resolution images in the PDF workflow. Images are
downsampled according to specifications in the refine process
template and cropped automatically, so only the necessary resolution
and image portions are stored.

Downsampling

Sometimes the resolution specified for a contone image in the desktop
publishing software is greater than is needed, even for high-quality
color work. The additional resolution does not enhance the quality of
the image, but does make files larger. Downsampling stores the image
at a more appropriate resolution. An accepted rule of thumb is to set
downsampling to a ppi (pixels per inch) value that is twice the final
printed line screen or lpi (lines per inch). This is set in the Optimize
section of the refine process template.

Image cropping

When an image is included in a file, but the whole image is not
required, the file size is larger than necessary. Image cropping removes
all image information that is not visible, except for a small border
around the visible image. This happens automatically during the refine
process when converting PostScript to PDF.

In the example below, the entire image was stored in the input file. The
area within the rectangle is the visible portion. Optimizing discards
almost all of the non-visible portions of the image (a border of 1 pixel
outside the bounding box is retained).
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Adding image search paths

1. Open the job or pre-job.

2. From the Job menu, select Image Search Path.

3. In the Image Search Paths dialog box, click Add.

4. In the Select Folder dialog box, select the folder that contains the
images for the job, and click Select "<folder>".

5. Repeat steps 3 and 4 for each folder that you want searched.

Note: Subfolders are not searched. Add a search path for each specific folder
that you want searched.

6. If you added more than one image search path for more than one
folder, set the order in which they will be searched by selecting
folders and clicking Move Up or Move Down to move folders up or
down in the list.

7. Click OK.

Deleting image search paths

1. Open the job or pre-job.

2. From the Job menu, select Image Search Path.

3. In the Image Search Paths dialog box, select the image search path
and click Delete.

4. Click OK.

Setting the order of image search paths

1. Open the job or pre-job.

2. From the Job menu, select Image Search Path.

3. In the Image Search Paths dialog box, select a folder and click Move
Up or Move Down to move the folder up or down the list.

Move Up and Move Down are available only when the Image
search paths list contains more than one folder.

4. Click OK.

Image Search Paths dialog box

Image search paths

Lists the folders that contain images for the job. The order in
which the folders are listed is the order in which the system will
search the folders, starting with the folder at the top of the list.
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Add

Adds a path to the job. When you click this button, the Select
Folder dialog box appears. From there, you can select the folder
that the system will search for fonts or images.

Delete

Deletes the selected path.

Move Up

Moves the selected folder higher in the list of paths.

The system searches the folders in the order in which they are
listed, starting with the folder at the top of the list.

The button is available only when the paths list contains more
than one folder.

Move Down

Moves the selected folder lower in the list of paths.

The order in which the path folders are listed is the order in
which the system will search the folders, starting with the folder
at the top of the list.

The button is available only when the paths list contains more
than one folder.

Select Folder dialog box

Unlabeled list and results area

Selecting an item in the list at the top left of the dialog box
displays that item's contents in the box below.

When you select:

● Volumes, the volumes in your system appear
● A volume name, folders at the root of the selected volume

appear
● A folder name, files within the folder appear

The path of the displayed item in the list appears in reverse
order, for example, folder name followed by volume name.

Volumes

Displays all volumes in the Prinergy system.

Job Folder

Opens the job folder for the current job.
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Open

Opens the selected item.

Show Hidden Files

Select this check box to include hidden files, such as system
files, in the results.

You can set the default selection of this check box on the View
tab of the Workshop Preferences dialog box.

Relative

Select this option to add an image search path relative to the
job folder. Only the job folder itself or folders within the job
folder can be added as relative image search paths.

This is useful when you know that the images for all of your jobs
will always be stored in the job's job folder. If you create a
template job with a relative image search path pointing to the
template job's job folder, each job that you base on the
template job automatically has an image search path pointing
to its own job folder.

Note: This option is visible only when you open the Select Folder dialog
box from the Image Search Paths dialog box, not when you open it from
the Create Hot Folder for Job dialog box.

Select "<folder>"

Adds a path to the folder selected in the list, and closes the
Select Folder dialog box.

Fonts

Font handling overview
Prinergy requires that fonts be in Printer Font ASCII format. You may
need to use the Font Converter or add a font search path to the job.

If fonts are embedded in input files, or if the input files reference only
the base 138 Adobe fonts that are shipped with Prinergy in PFA
(Printer Font ASCII) format, Prinergy can refine and output PDF pages
without the Font Converter or a font search path.

If fonts are not embedded in input files, use the Font Converter to make
the font information available to Prinergy in PFA format. Add a font
search path to the job for the job to be able to use the converted fonts.
The font search path tells Prinergy where to locate the fonts for the job.
When Prinergy refines the job, the normalize step embeds font
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information from the specified Fonts folder in the PDF pages it creates
during the refine process.

If your input files contain OpenType fonts that are not embedded in the
file, or fonts from the Microsoft font suitcase, add the location of the
fonts to the font search path. There is no need to use the Font
Converter.

Subsetting or embedding fonts

Prinergy can process files with either subsetted or embedded fonts.
Fully embedding fonts increases file size but in some situations it is
preferable. For example, when you use Acrobat 6 to merge multiple
PDF files, embedding fonts results in fewer problems with font
resources and preserves the ability to edit fonts.

Font Converter
Use the Font Converter to convert font files to PFA (Printer Font ASCII)
format, which Prinergy requires to correctly process fonts.

Font Converter contains two tabs: a Global tab and a Job tab. Fonts on
the Global tab are stored on the home server and are available to all
jobs. Fonts on the Job tab are stored in the job folder and are available
only to that job. When in doubt, use the Job tab.

When Prinergy uses converted fonts

Prinergy uses converted fonts in two places:

● During the refine process, the normalize function uses PFA fonts to
embed font information in the PDF pages it produces.

● During the output process, the renderer requires fonts in PFA
format.

Supported source font types and formats

Font type refers to the content and structure of the information that is
used to describe a font. Font format refers to the type of file that is
used to store a font type.

The Font Converter can convert the following font types:

● PostScript Type 1
● PostScript Type 3
● PostScript Type 42
● PostScript Type 1 Multiple Master
● TrueType

The Font Converter can convert the following font formats:
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Source font format Description

Macintosh PostScript
in NTFS multi-stream
file

No file name extension expected with font file. Finder
type LWFN expected. POST resource in resource fork
evaluated. Format may contain all supported PostScript
font types.

Macintosh TrueType
in NTFS multi-stream
file

No file name extension expected with font file. Finder
type TFIL expected. SFNT resource in resource fork
evaluated. Format only contains TrueType font type.

Windows PFA No file name extension expected with font file. Format
may contain all supported PostScript font types.

Windows PFB File name extension (.pfb) expected with font file.
Format may contain all supported PostScript font types.

Windows TrueType File name extension (.ttf) expected with font file.
Format contains only TrueType font type.

Converted font type and format

The Font Converter always converts fonts to a PostScript font type PFA
format.

When the Font Converter converts PostScript font types, the font type
remains the same, but the format usually changes. When the Font
Converter converts TrueType fonts, the font type changes to PostScript
Type 42, and the format changes to PFA.

Note: For fonts that are difficult to convert, try using Macromedia Fontographer to
convert to a supported format.

Limitations of Font Converter

SMB file-sharing protocol does not support the Font Converter feature
in Workshop. Font Converter works only with font files that have
resource forks stored in an NTFS alternate data stream. Since SMB has
resource forks stored in separate files, you need to manually convert
the font files' resources to AFP format.

Font search paths
You need to use a font search path if the fonts for the job are not
available.

The font search path specifies the location of the fonts. You can copy a
font search path from an existing job when you create a new job, or you
can set the font search path later, from Job Manager.

You do not need to set a font search path when either of the following
is true:

● The fonts are embedded in the job files
● The fonts are in the <Job Folder>\Fonts folder
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When Prinergy processes a job and detects that fonts are missing, it
automatically looks in the following places, in the following order:

1. The location specified in the font search path for the job
2. The <Job Folder>\Fonts folder (for fonts converted for a

specific job)
3. The %AraxiHome%\CreoAraxi\Data\Fonts folder (for fonts

converted for all jobs)

When the fonts you want to use for the job are located in two or more
folders, you must add a search path for each folder that you want
Prinergy to search, and specify the order in which you want Prinergy to
search the folders.

Missing or non-embedded fonts can be embedded into the PDF during
the refining process. The font locations which the refiner uses for
embedding are:

● Normalizer fonts: %AraxiHome%\AdobeExtreme\bin\fonts
● Global font converter fonts: %AraxiHome%\CreoAraxi\data

\fonts
● Job font converter fonts: <Job Folder>\Fonts

Notes: The 14 base fonts are automatically embedded during refining. Therefore,
the Prinergy normalize function will not detect missing 14 base fonts in a PDF file.
To avoid this, customers can either:

● Clear the Ignore the 14 base fonts check box in the Preflight Profile Editor.
● Move the Normalizer fonts (except for Courier) out of the %AraxiHome%

\AdobeExtreme\bin\fonts folder. This prohibits the normalize function
from embedding missing fonts, and causes the normalize function to fail even
for the missing 14 base fonts.

OpenType fonts
The Font Converter does not support OpenType fonts.

If your input files contain OpenType fonts that are not embedded in the
file, add the location of the OpenType fonts to the font search path.
This is likely a rare scenario, since software capable of handling
OpenType fonts is also able to embed them.

Although the Font Converter cannot convert OpenType fonts, most
native applications, for example Adobe Creative Suite 3, convert
OpenType fonts to PostScript Type 1 (which the Font Converter
supports) when embedding fonts. You can also include embedded
OpenType fonts when exporting a PDF file from Macromedia
FreeHand. As OpenType fonts gain popularity, more software will start
supporting embedded OpenType fonts in exported PDF files.
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Asian fonts
Prinergy supports CJK (Chinese, Japanese, Korean) characters using
the Character Identifier (CID) font file format; it does not support the
Original Composite Format (OCF) font file format.

The following features are available:

● Downloading of aftermarket fonts from Apple Inc.
● Embedding of fonts during normalizing
● Trapping of fonts
● Outputting of fonts to proofing and final output devices

Frequently asked questions

● Is it feasible to normalize to PDF, embedding the CID fonts, and
then output to RIPs that do not have those same CID fonts
installed? What are the technical and legal implications of doing
this?

As long as the font vendor has determined that their license allows
end users to embed the fonts, it should work.

● Are bitmap fonts available for use on a Mac computer for page
layout?

Bitmap fonts for each CJK set are available from Adobe Systems,
Inc. and other vendors’ Web sites—for example, Monotype Imaging
Inc.

● Is there an upgrade policy for users who purchased OCF-formatted
fonts to upgrade to the new CID font format?

For Adobe fonts, yes. Contact the font vendor for the latest upgrade
pricing.

Available font bundles

When you purchase Prinergy, one of the following bundles is available,
depending on the country in which you live.

Note: You can purchase only one factory font bundle; that bundle must be
appropriate to your region. For example, if you are in Japan, you can buy either the
Basic Japanese or Advanced Japanese bundle, but not both.

Font bundle Bundle contains

Basic Japanese First five Morisawa font programs

Full Japanese All 23 Morisawa font programs

Simplified Chinese All SinoType font programs
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Font bundle Bundle contains

Traditional Chinese All Monotype font programs

Korean All Han Yang font programs

CJK All of the above

The following table lists which font bundles are available in specific
countries. If you require more fonts than the ones in the available font
bundle, you must purchase the fonts locally, and load them as
aftermarket fonts.

Country Available font bundle

Japan Basic Japanese or Full Japanese or CJK

People's Republic of China Simplified Chinese or CJK

Taiwan Traditional Chinese or CJK

Hong Kong Traditional Chinese or CJK

Korea Korean or CJK

CJK fonts are sold only as high-resolution versions. Japanese CJK fonts
are quite expensive, both for Kodak and for customers purchasing
those fonts as aftermarket packages. Kodak offers bundles as a
convenience to our customers. Purchasing bundles saves the time and
effort of purchasing the entire library and probably also saves money.

Some other issues to consider:

● Kodak cannot sell single font faces to customers. Fonts must be part
of a defined package. Contact Adobe or other font vendors to
purchase additional fonts.

● Kodak pays royalties for installed fonts for in-house systems (for
example, demonstration systems, and so on) at the same fee
schedule as for end users.

● These configurations don't cover the standard Roman versions or
any other potential versions (Arabic, Cyrillic, and so on). Kodak is
not obligated by Adobe to provide such versions.

● If you install the aftermarket font without the font bundle, and then
install the bundled font from Kodak, the aftermarket font may not
work. For this situation, you need to get a new license for the
aftermarket font from the font vendor, and then reinstall the font.

Here are the existing font bundles:

● Configuration 1: Japanese, Standard (five faces)

All of these fonts use the Adobe-Japan1-5 Character Collection.
Morisawa & Company, Ltd. owns the trademarks.

Ryumin Light KL

Gothic Medium BBB

Fonts 317



Futo Min A101

Futo Go B101

Jun 101
● Configuration 2: Japanese, Deluxe (23 faces)

All of these fonts use the Adobe-Japan1-5 Character Collection.
Morisawa & Company, Ltd. owns the trademarks.

Ryumin Light KL

Gothic Medium BBB

Futo Min A101

Futo Go B101

Jun 101

Midashi Min MA31

Midashi Go MB31

Shinsei Kaisho CBSK1

Ryumin Medium M-KL

Ryumin Bold B-KL

Ryumin Ultra U-KL

Shin Gothic L

Shin Gothic M

Shin Gothic B

Shin Gothic U

Jun 34

Jun 501

Gothic MB101 Bold

Gothic MB101 Heavy

Gothic MB101 Ultra

Ryumin Regular R-KL

Ryumin Heavy H-KL

Shin Gothic R
● Configuration 3: Simplified Chinese, Standard (one face)

All of these fonts use the Adobe-GB1-4 Character Collection. Adobe
owns the trademarks.

Adobe Song Std-Light
● Configuration 4: Traditional Chinese, Standard (one face)
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All of these fonts use the Adobe-CNS1-4 Character Collection.
Adobe owns the trademarks.

Adobe MingStd-Light
● Configuration 5: Korean, (one face)

All of these fonts use the Adobe-Korea 1-2 Character Collection.
Adobe owns the trademarks.

Adobe Myungjo Std-Medium

Font Protection for Factory-Installed Fonts

The only RIP property used to protect factory-installed fonts is license
ID. Adobe assigns a unique license ID to each font bundle. For the fonts
to be accessible, the ID of the font bundle must match the license ID
specified by the RIP executable (Normalizer JTP). (Serial number and
product name are relevant to after-market fonts, but not factory-
installed fonts.)

Font protection for after-market fonts

Serial number, license ID, and product name properties of the RIP are
used together to protect after-market fonts. The license ID and product
name do not need to be unique on each hardware system. In the case
of a Prinergy system, the license ID and product name will be the same
for all component hardware systems.

The AppleTalk Font Downloader used to download the font must
derive a unique serial number from some characteristic of the target
hardware system. The AppleTalk Font Downloader encrypts the font
files with a key derived from the serial number, license ID, and product
name. For the font to be used or embedded into PDF on the target
system, the RIP (Normalizer JTP) on that system must have the same
serial number.

By default, and according to agreements with Morisawa, Adobe derives
the serial number from the MAC (medium access control) address of
the network card installed on the target system. This prevents the user
from copying the installed font files from the original target system to a
different system, and then using or embedding a font. To prevent the
user from downloading the font from various systems, typical after-
market font installers have a protection scheme that permits only a
limited number of installs (for example, three).

Fonts 319



Converting fonts
Convert fonts using the Font Converter.

1. From the Tools menu, select Font Converter. If you are converting
fonts for a specific job only, open Font Converter from Job
Manager.

The Font Installation dialog box appears. The Currently Installed
Fonts box lists the fonts that have already been converted and
installed.

2. Select the volume on which the fonts you want to convert are
stored, and click Open.

3. Select and open folders in the volume until you find the fonts that
you want to convert.

4. Select the fonts, and click Install.

5. After Prinergy converts the selected fonts, click Done.

6. Add a font search path by performing the following as appropriate:

If you converted
fonts on this tab

Do this

Global For each job that uses the global fonts, add a font
search path to the CreoAraxi\Data\Fonts
folder on the home server that you are logged into.

Job Add a font search path to the <Job Folder>
\Font folder for the job.

Font Installation dialog box
Use the Font Installation dialog box to find and install fonts on your
system, and to remove installed fonts. The dialog box is available from
the Tools menu.

Unlabeled list and results area

Selecting an item in the list at the top left of the dialog box
displays that item's contents in the box below.

When you select:

● Volumes, the volumes in your system appear
● A volume name, folders at the root of the selected volume

appear
● A folder name, files within the folder appear

The path of the displayed item in the list appears in reverse
order, for example, folder name followed by volume name.
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Show Hidden Files

Select this check box to include hidden files, such as system
files, in the results.

You can set the default selection of this check box on the View
tab of the Workshop Preferences dialog box.

Volumes

Displays all volumes in the Prinergy system.

Open

Opens the selected item.

Install

Installs selected files to the Global tab or the Job tab, whichever
is selected.

Remove

Removes selected files from the Global tab or the Job tab,
whichever is selected.

Currently Installed Fonts

Global

Lists the fonts that are available to all jobs.

Job

Lists the fonts that are available only to the current job (the job
from which you opened the Font Installation dialog box).

Using font search paths
Add, delete, or change the order of font search paths.

Note: You may also create a new job and base it on a template job that has the
font search path you want to use.

1. From the Job menu, select Font Search Path.
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2. In the Font Search Path dialog box:

To Do this

Add a
font
search
path

a. Click Add.
b. In the Select Folder dialog box, select a folder.

Note: By default, the job folder appears, unless the job
volume is not mounted. The list displays only folders; it
does not display font files. Subfolders are not searched. You
need to add a search path for each folder that you want
searched.

● To add a search path for fonts that have been converted
with the Font Converter and are used globally, select
the following folder: AraxiVolume on <your
primary server>\CreoAraxi\Data\Fonts.

● To add a search path for fonts that have been converted
with the Font Converter and are job-specific, select the
following folder: <Job Folder>\Fonts.

c. Click Select "<folder name>".

Delete a
font
search
path

a. Select the font search path folder.
b. Click Delete.

Change
the font
search
path order

a. Select the font search path folder.
b. Click the Move Up or Move Down buttons to change the

order of the selected folder.

Note: The system searches through the folders starting at
the first one on the list.

3. Click OK.

Font Search Path dialog box
Use the Font Search Path dialog box to modify font search paths. The
dialog box is available from the Job menu.

Font Search Paths

Lists the folders that contain fonts for the job. The system
searches the folders in the order in which the folders are listed,
starting with the folder at the top of the list.

Add

Adds a path to the job. When you click this button, the Select
Folder dialog box appears. From there, you can select the folder
that the system will search for fonts or images.
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Delete

Deletes the selected path.

Move Up

Moves the selected folder higher in the list of paths.

The system searches the folders in the order in which they are
listed, starting with the folder at the top of the list.

The button is available only when the paths list contains more
than one folder.

Move Down

Moves the selected folder lower in the list of paths.

The order in which the path folders are listed is the order in
which the system will search the folders, starting with the folder
at the top of the list.

The button is available only when the paths list contains more
than one folder.

Adobe in Prinergy

About Adobe applications

Once you have refined input files to create PDF files you can:

● view the PDF pages on-screen using Adobe Acrobat
● modify page geometry using Adobe Acrobat
● edit traps using the PDF Trap Editor plug-in
● edit the PDF pages on-screen using Adobe Illustrator

You can start Acrobat from the File menu in Prinergy, or you can
double-click a PDF page in Prinergy Workshop to automatically launch
Acrobat.

You can start Illustrator using File > Open PDF for Editing, or you can
right-click a PDF page in the Pages pane of the Pages view of Job
Manager to convert the PDF page and edit it using Illustrator.

About trapping tools

Prinergy includes the following trapping components:

● Automatic trapper using the PDF Trapper JTP

This trapping component is part of Prinergy Workshop. It lets you
do automatic trapping as a part of the refining process, using the
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trapping parameters set in the refine process template. Additional
automatic trapping options are available in PDF Trap Editor.

● PDF Trap Viewer

The PDF Trap Viewer is included with the purchase of Prinergy. It is
a plug-in to Adobe Acrobat that lets you view traps created with the
automatic trapper.

● PDF Trap Editor

The PDF Trap Editor is an additional trapping component that can
be purchased separately. The PDF Trap Editor is a plug-in to Adobe
Acrobat that allows you to interactively create, change, and delete
traps. The advanced features of the PDF Trap Editor, such as setting
trap geometry, making keepaway traps, and trap path editing, are
used primarily in packaging.

Trapping using these tools has the following advantages:

● Resolution independence is maintained
● Prinergy can do spreads, chokes, and center traps
● You can view traps in the PDF Trap Viewer plug-in
● If you purchase a PDF Trap Editor plug-in, you can create and edit

traps interactively

If you need to adjust any traps, you can do the following:

● Retrap automatically with a different set of process template
parameters

● Use the PDF Trap Editor to retrap an entire page or change
individual traps

For more information on the trapping tools, launch Adobe Acrobat,
select Plug-In Help from the Help menu, and then select PDF Trap
Editor from the submenu.

Note: The PDF Trap Editor is object-based, so it traps object to object or object to
image. An object-based trapper is also sometimes called a vector-based trapper.
Other types of trappers include raster trappers and hybrid trappers. A raster
trapper traps rasterized data. Hybrid trappers combine raster and vector-based
trapping.

Trapping using other methods

There are other methods and tools for trapping as described below.
However, the content generator (the person creating the document)
does not always know much about trapping, so it is best to leave
trapping to the prepress shop or printer. As such, we recommend that
you trap inside Prinergy using the trapping tools.

If you trap directly in the layout application (QuarkXPress or
PageMaker), the following occurs:
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● Imported EPS vector art is not trapped.
● Colored text over images can only be spread, not choked.
● PostScript from trapped QuarkXPress documents must be poured

as separated files, which means you cannot convert spot colors to
process colors in Prinergy. PageMaker has some of the same
problems.

If you use a plug-in to QuarkXPress or PageMaker, the plug-in adds the
trapping parameters to the QuarkXPress or PageMaker file. The traps
are added to the page later.

About plug-ins for Adobe Acrobat

Prinergy may include the following plug-ins for Adobe Acrobat and
other tools:

Prinergy PDF Compare—enables you to display differences between
the original and revised pages within two versions of the same
document

Prinergy PDF Merge—enables you to combine unique content from
different versions of the same document into a new output document,
while preserving common objects, such as traps and screens

PDF Trap Viewer—lets you check selected trap and object properties
in already-refined and trapped PDF pages in Adobe Acrobat. You can
also delete all traps

PDF Trap Editor—lets you trap whole pages or selected objects, edit
existing traps, add traps, set trap geometry, and create keepaway traps
to a refined and/or trapped page in Acrobat. Includes PDF Trap Viewer
functions. Contains advanced features used mainly by packaging
printers.

Prinergy Separation Viewer—lets you view the separations of a PDF
file

Prinergy DotShop—lets you view, select, and edit halftone screening in
a PDF file

Prinergy Geometry Editor—lets you visually set the trim size for a page

Prinergy Separation Repair—lets you regroup separations that were
incorrectly grouped during refining

Prinergy View Accelerator—speeds up the display of a PDF by using
low-resolution (alternate) images

Prinergy Preflight Locator—used with PDF Preflight, it locates the
problematic elements in the PDF file directly from the PDF Preflight
report

Prinergy Plate Builder—lets you add white, bump, and varnish
separations to refined PDF files, based on existing objects in that file
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Adobe Acrobat Distiller Assistant software—lets Acrobat Distiller
users set options within a PDF file

Color TIFF XT software—solves the background colorized TIFF
problem using PostScript 3 technology. XT is necessary only with
QuarkXPress versions 4 and 5, not version 6.

Viewing or editing pages
Important: Make sure you delete all the traps in a PDF file before changing the
content. You may be unable to delete traps after editing the content. As a result,
the traps may remain in the file, possibly appearing as errors in the printed
product.

1. In the Pages pane of the Pages view or Signatures view of Job
Manager, click the PDF page you want to view.

2. Perform one of the following actions:

○ From the File menu, select Open in Adobe Acrobat.
○ Double-click the PDF page you want to view.

Note: You must have the job share mounted before double-clicking a PDF
page will automatically launch Adobe Acrobat.

When you edit a page with Adobe Acrobat, the system does not
update the thumbnails displayed in Job Manager. If you want to update
the thumbnail images, you must refine the PDF page using a refine
process template that has the Thumbnail section selected.

Viewing or editing traps

Once you open a page in Acrobat, you can start the PDF Trap Viewer
or a PDF Trap Editor from the Editing toolbar or the Tools menu in
Acrobat.

The PDF Trap Viewer plug-in is included with Prinergy. It lets you view
traps made in Prinergy.

The PDF Trap Editor plug-in is purchased separately and lets you
perform the following actions:

● View traps made in Prinergy
● Measure the color of an object, the trap, and the adjacent object
● Check the parameters used for trapping
● Delete individual traps or all traps from a page
● Edit individual traps
● Create traps
● Retrap a page with new parameters
● Edit trap geometry and the trap path, and set keepaway traps.

For assistance, once you have started Adobe Acrobat, see Plug-In Help
on the Help menu in Acrobat.
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Note: To view traps, you must have trapped files during the refine process. You
control trapping options in the refine process by setting the options in the Trap
section of a refine process template.

1. In the Pages pane of the Pages view of Job Manager, double-click a
page to start Adobe Acrobat.

2. From the Tools menu in Adobe Acrobat, select Kodak Tools and
then Kodak PDF Trap Viewer to view traps, or the PDF Trap Editor
to view and edit traps.

3. For assistance on using these tools, select Plug-In Help from the
Help menu in Acrobat, and then select Kodak PDF Trap Editor.

Deleting traps

You should delete traps from PDF pages before editing the pages
because you may be unable to delete traps after editing PDF page
content. As a result, the traps may remain in the file, appearing as
errors in the printed product.

1. In the Pages pane of the Page view of Job Manager, double-click a
page to start Adobe Acrobat.

2. From the Tools menu in Adobe Acrobat, select Kodak Tools >
Kodak PDF Trap Editor.

3. Click Delete all traps.

4. Close the PDF Trap Editor window.

5. Save the PDF file and close Adobe Acrobat.

Starting a plug-in for Adobe Acrobat

In Acrobat, in the toolbar, click the plug-in icon.

Note: For information on how to use the plug-ins, from the Help menu in
Acrobat, select Plug-in Help, and then select the plug-in that you want to use.

Prinergy PDF File Editor
With Prinergy PDF File Editor, you can use Adobe Illustrator and Adobe
Photoshop to edit refined PDF files.

PDF File Editor is a licensed feature and requires Adobe Illustrator CS3,
CS4, or CS5 for either Windows or Macintosh.

Prinergy PDF File Editor includes:

● Prinergy server components that convert a Prinergy PDF file into an
Illustrator file containing "Kodak Protected Art" objects and import
the changes back into the job after the conversion. This includes:
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○ A plug-in for Adobe Illustrator that lets you selectively convert
Kodak Protected Art objects into native Illustrator objects

○ A javascript component for Adobe Illustrator that submits the
changed file back into Prinergy

● The ability to automatically recognize changes in geometry and
colorants

● A new contextual menu in Prinergy Workshop that lets you open
refined PDF files in Illustrator, cancel an editing session, and resolve
conflicting edits. A new visible column shows which operator has
the PDF file open for editing.

Prinergy PDF File Editor has these benefits:

● Leverage your investment and skill sets in Illustrator and Photoshop
so that operators who know Illustrator or Photoshop need no further
training to be able to make edits to PDF files.

● Only the objects that need to be changed are converted to
Illustrator native format, reducing the risk of an error during the
conversion process.

● The Undo command is available if there are any problems
converting objects to Illustrator native format.

● Most image types are extracted into the Photoshop .psd format
and stored as external links to make image editing easy.

● When text changes are made, only the fonts that are used by the
changed text need to be loaded into the system, rather than
requiring all of the fonts in the document to be loaded into the
system.

At present, Prinergy PDF File Editor has these limitations:

● Not all object types can be converted to Illustrator native format,
including:

○ Duotone images. These images are saved as external inks in the
PDF file.

○ DeviceN colored fills, strokes, gradients, and text.
○ Gradients that are not radial or linear.

● The color space for art converted to native format must be CMYK.
Special color spaces are converted to CMYK on conversion.

● Transparent elements cannot be individually selected for
conversion to native art. Entire groups of elements must be
converted together.

Note: You can view the properties of a Kodak protected art element in PDF File
Editor without first converting the element to Native. In PDF File Editor, select a
protected art element, and then select Protected Art Properties from the Window
> Kodak menu. Information about the protected art element is displayed, such as
object type, color, fonts used, opacity, transparency blend mode, overprint state,
and the applied Dotshop screen instance.
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Editing PDF files in Adobe Illustrator
You can convert refined PDF files so that they can be edited in
Illustrator, and you can edit photographs or images in the PDF file in
Photoshop. After editing the PDF file, you can submit the edited PDF
file back to Prinergy.

Requirements:

● PDF File Editor requires Adobe Illustrator CS3, CS4, or CS5 for
either Windows or Macintosh.

● Adobe CS3, CS4, or CS5 must be installed before you install
Prinergy. If Prinergy is already installed, run Uninstall Workshop in
the Prinergy folder, and then reinstall Workshop after CS3, CS4,
or CS5 is installed. When installing Prinergy, be sure to select
Illustrator Plug-ins.

● If you want to keep older revisions of your edited pages, you can set
the number of revisions to retain in Prinergy Administrator. For
information about controlling revisioned pages for InSite, see the
Prinergy System Administration Guide.

● Always open .ai files in Illustrator, and always open .psd files in
Photoshop.

○ In Windows, right-click a file with the .ai file name extension,
and select Open File With. If necessary, select Choose Program.
Highlight the appropriate program, select Always use the
selected program to open this kind of file, and click OK.

○ For Macintosh instructions, in the Finder Help menu, search for
Always Open With, and follow the instructions.

1. In the Pages pane of the Pages view of Job Manager, right-click a
page and select PDF Editing > Open PDF for Editing.

If Prepare PDF for Edit was selected in the Optimize section of the
refine process template when the file was refined, Illustrator opens
the page for editing. Otherwise, the Process Info dialog box
appears, showing the conversion process, and then Illustrator
opens the page.
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In Job Manager, the file icon changes to show that the file is being
edited. You can select View > Visible Columns > Open For Edit By
to see who is editing the file.

2. In Illustrator, edit the page. You can use Photoshop to edit the
images in the Illustrator file.

To Do this

View the properties of a
Kodak protected art
element without first
converting it to Native.

Select a protected art element, and then select
Window > Kodak > Protected Art Properties to
display information about the selected protected
art element, such as object type, color, fonts
used, opacity, transparency blend mode,
overprint state, and the applied Dotshop screen
instance.

Edit object types in
native Illustrator format.
Some object types must
be converted to native
Illustrator format before
they can be edited.

Select the elements, and then select Filter >
Kodak > Convert to Native.

When you edit PDF files in Illustrator, the
working files are located in <Job folder>
\System
\IllustratorDocumentWorking. You can
also select File > Open Recent Files in Illustrator
to reopen a file that you were editing. When you
finish editing a file, it is deleted from the
IllustratorDocumentWorking folder.

Use Photoshop to edit
images in the PDF file.

Select the image, and then select Edit > Edit
Original.

Cancel editing of a PDF
file.

In the Pages pane of the Pages view of Job
Manager, right-click a page and select PDF
Editing > Cancel PDF Editing.

The file icon changes back to normal to show
that the file is no longer being edited.

3. When you finish editing the PDF file, select File > Scripts > Kodak >
Submit PDF to Prinergy to submit the PDF file to Workshop.
The PDF file is submitted to a hot folder to be processed by
Workshop.

See also:
Optimize section of the Refine process template on page 245

Resolving conflicts in Prinergy PDF File Editor
When you are editing a PDF file using Illustrator, if the same file is
edited elsewhere, such as in Acrobat, or if that file is refined again, the
file will be in a conflict state.

Requirements:

When a file is in a conflict state, the file icon changes to show there is a
conflict, and a PDF file with a .confilct extension is created in your job
folder.
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1. In the Pages pane of the Pages view of Job Manager, right-click a
page and select PDF Editing > Resolve Conflicting Edits.

Both PDF files open in Acrobat so that you can view and resolve the
conflcts.

2. In Acrobat:

To Do This

Check the differences
between PDF files.

Select Advanced > Kodak Tools > Prinergy PDF
Compare.

Merge a PDF file into the
opened PDF file.

Select Advanced > Kodak Tools > Prinergy PDF
Merge.

The file icon changes back to normal to show that the file is no
longer in a conflict state.

3. In Job Manager, if you select PDF Editing > Cancel PDF Editing, the
re-refined PDF file is kept and the PDF with the .conflict extension is
deleted.

Kodak Distiller Assistant

Kodak Distiller Assistant overview
The Kodak Distiller Assistant helps Acrobat Distiller produce press-
optimized, spot-color-enabled, top-quality PDF files for a composite
PDF 1.3 or PostScript 3 workflow.

The extra features of the Kodak Distiller Assistant, which are added via
a PostScript start-up file, are derived from the Prinergy normalize
function. Implementation of these features is identical between the
Prinergy normalize function and Acrobat Distiller, assuring users of
consistent results. The Kodak Distiller Assistant makes extensive use
of PostScript 3 features, including the following features:

● Idiom Recognition recognizes existing legacy PostScript code and
dynamically replaces it with optimized PostScript code.

● Smooth Shades is a graphical object describing a gradient or
gradient mesh. Instead of describing many small overlapping
rectangles, the PostScript code describes an area to fill and the
mathematical representation of the gradient in the gradient's
natural color space. Thus, the RIP can apply extended halftoning
and advanced rendering algorithms to eliminate the stepping
typically found in large areas.

● DeviceN Colorspace allows the PostScript file to describe
composite colors involving combinations of process and spot colors,
and allows multiple spot colors to be expressed together. This is
crucial for describing spot-to-spot blends, duotones, and so on.
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For more information, see the PostScript 3 Language Reference Manual.

The Kodak Distiller Assistant is technically a file that consists of a
group of PostScript "helper" files that resides in the StartUp folder
within the Distiller software. These files are active within both Prinergy
Connect and Prinergy Evo and are invoked whenever PostScript and
EPS files are encountered on input.

Setting up Kodak Distiller Assistant
Download and install the Kodak Distiller Assistant.

Requirements:

The Kodak Distiller Assistant supports both Mac and Windows clients.
This software is compatible with Adobe Acrobat 4.0 (or later), for 
Microsoft Windows 98, Windows XP, Windows NT, Windows 2000,
and Windows XP.

The Kodak Distiller Assistant replaces the older start-up files
PrinergyForDistiller and Synapse Distiller Startup.
If applicable, delete these files in your Startup folder when you
upgrade.

1. Go to http://graphics.kodak.com/.

2. Search for Distiller Assistant and download the zipped
file.

3. Extract and copy the CreoDistillerAssistant file to the
Distiller Startup folder.

○ If you are using Distiller 6, the folder location is C:
\Documents and Settings\All Users\Documents
\Adobe PDF 6.0\Startup on a Windows-based computer,
or /users/shared/Adobe PDF 6.0/startup on a Mac
computer.

○ If you are using Distiller 7, the folder location is C:
\Documents and Settings\All Users\Documents
\Adobe PDF 7.0\Startup on a Windows-based computer,
or /users/shared/Adobe PDF 7.0/startup on a Mac.

○ If you are using Distiller 8, the folder location is C:
\Documents and Settings\All Users
\Application Data\Adobe\Adobe PDF\Distiller
\Startup on a Windows-based computer , or /Library/
Application Support/Adobe/Adobe PDF/
Distiller/Startup on a Mac.

4. If applicable, delete any file named Example.ps from the Distiller
Startup folder because this file can interfere wtih the proper
operation of the Kodak Distiller Assistant.
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5. Copy the Creo PDF Pages.joboptions file to the Distiller
Settings folder.

○ If you are using Distiller 6, the folder location is C:
\Documents and Settings\All Users\Documents
\Adobe PDF 6.0\Settings on a Windows-based
computer , or /users/shared/Adobe PDF 6.0/
settings on a Mac.

○ If you are using Distiller 7, the folder location is C:
\Documents and Settings\All Users\Documents
\Adobe PDF 7.0\Settings on a Windows-based
computer , or /users/shared/Adobe PDF 7.0/
settings on a Mac.

○ If you are using Distiller 8, the folder location is C:
\Documents and Settings\All Users
\Application Data\Adobe\Adobe PDF\Distiller
\Settings on a Windows-based computer , or /Library/
Application Support/Adobe/Adobe PDF/
Distiller/Settings on a Mac.

6. You can delete the Prinergy Pages.joboptions file, but this
is not required.

7. Start Acrobat Distiller.

8. From the Distiller Job Options menu, select Creo PDF Pages.

Although these options are the recommended settings for Prinergy
input files, they are not required for the Kodak Distiller Assistant to
function properly.

The Kodak Distiller Assistant is always active and automatically does
its job by intercepting and improving PostScript codes.

Distiller Assistant components
The Kodak Distiller Assistant features solve problems that Acrobat
Distiller may encounter when distilling PostScript and EPS files to PDF.

The names of the features appear in the Acrobat Distiller startup
messages box.

Control Flatness v1.5

This feature enables or disables flatness size changes present in
the input file, and helps avoid problems where legacy PostScript
files set the flatness to a very high value. Many older Adobe RIP
products were unable to render complex paths (often
generating limitcheck errors). The workaround had been to
set the graphics state flatness to larger and larger values.
Unfortunately, this would often force the RIP to render paths as
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a smaller number of line segments, resulting in curves which
appeared flat (for example, circles that appear like stop signs).

Many legacy files still contain high flatness values, but newer
RIPs (and the Distiller) can cope without raising the flatness
value. This feature assists these legacy files by pretending to
increase the flatness value, but letting the RIP render paths as
smoothly as it can.

Note: The maximum resolution that still requires flatness control is 600
dpi. It is not necessary to control flatness if the device resolution is
greater than this value. This check is not done in Distiller.

CreoScitex Artwork Systems ArtPro Separations v1.0

This feature rewrites some ArtPro procsets more efficiently to
ensure better performance.

Adobe OPI Helper v1.5

The Prinergy normalize function uses an Adobe OPI merging
engine. This feature corrects several bugs in that engine. Recent
additions to this feature support Adobe PageMaker colorized
images correctly. The PageMaker bug would cause tinted
images to be output at 100% intensity, rather than as set in the
document for composite workflows.

Minimum Line Width v1.4

Many legacy applications generate PostScript that draws very
thin lines (hairlines), expecting that the output will be
appropriate for 300 or 600 dpi devices. When device
resolutions increase to 2400 dpi, these thin lines seem to
disappear, especially on a printing press. This is because the
PostScript requests the smallest possible line (for example, a
single device pixel). At 300 dpi, one device pixel is equal to
0.24 pt. At 2400 dpi, one device pixel is equal to 0.03 pt.

This feature monitors and modifies PostScript requests for line
thickness, and ensures that the smallest thickness request is
0.216 pt or larger so the lines will appear even on high
resolution devices. This check and enforcement works even
when the input PostScript is scaled.

Control Smoothness v1.0

This feature enables or disables smoothness settings in files
and resets the initial smoothness value to 0.002, which seems
to be a good value for all RIPs.
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Creo Rampage v1.1

This feature allows DCS sets created by Rampage to process to
PDF without losing elements.

CreoScitex Vignettes v1.2

This feature contains logic to convert gradients created by the
Scitex Blends XT into PS Level 3 smooth shades.

Detect RGB Images v1.1

This feature detects RGB images "masquerading" as /
DeviceGray images in separated PostScript and forces them
back to /DeviceRGB. Images in /DeviceRGB color space that
appear in separated PDF files are properly rejected by the
refiner's resource checking.

This module detects and converts back to RGB for:

● Photoshop RGB (tested with QuarkXPress 4.04 separated
PostScript)

● RGB EPS using the colorimage operator embedded in
QuarkXPress separated PostScript

Eliminate OPI Clip v1.1

Some EPS and DCS files (for example, copydot scans) have a
bounding box equal to the trim only (does not include bleed).
When Adobe OPI merges an EPS or DCS image, it generates
PostScript to set up a clip equal to the bounding box that is
specified in the image file.

This feature detects the use of clips by Adobe OPI when it
merges EPS graphics and eliminates the clip.

InDesign Extra Color Fix v1.3

Under some circumstances, InDesign v1.1 emits extra named
colors for process colors such as _Cyan_,_Magenta_,_Yellow_
and _Black_ (The erroneous part is the underscores.) when
printing composite PostScript.

This feature stops InDesign PostScript from generating
erroneous separations.

Prevent Adobe FrameMaker CropBox v1.0

FrameMaker sets the CropBox to be the trim box. This is not
desirable for printers because it causes the trim marks (crop
marks), which are painted outside of this box, to be clipped out
so they do not appear on printed output.
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Global Graphics ScriptWorks Compatibility v1.0

In the past, some of the files with Harlequin-specific commands
have generated a rangecheck error in Distiller. This feature
allows these commands to work in Distiller.

Separate Level 2 Images v1.1

When Photoshop JPEG EPS files are included in a preseparated
PostScript file, the images do not separate correctly; instead,
the images appear only on the black plate. This feature
intercepts these compressed images and allows them to
separate correctly into their CMYK channels.

Note: This separation process requires extra processing time in Distiller.

This feature enables support, in separated PostScript, for
composite (CMYK) images that use the dictionary form of the
image operator. This kind of image cannot be separated
properly with a Level 1 Separator.

Creo Shfill Overprint Fix v1.1

This feature forces shaded fills to overprint.

Creo Zap Printer Controls v1.4

The HP LaserJet driver for Windows often includes PJL
commands in the PostScript file. Sending the PostScript to a
non-HP printer often causes PostScript errors. Since Distiller is
not an HP printer, these files will also fail during conversion to
PDF. This feature adds support to avoid unnecessary PostScript
errors, even when the incoming PostScript file is generated with
an HP LaserJet printer driver.

Automatic Geometry Recognition v2.3

This feature installs several idioms to capture and automatically
set the trim size from PostScript files. The supported software
is:

● QuarkXPress 3.32 and later, including XPress Passport and
XPress Japanese

This feature installs idioms to replace crop mark painting
procedures from QuarkXPress to detect, and potentially set
geometry values, from crop marks and registration marks as
specified by the user.

● Adobe PageMaker 6.0/6.5, including the Japanese version

This feature installs idioms to replace the crop mark painting
procedure from Adobe PageMaker 6.0/6.5 to capture the
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four edges of the trim box, and to set the page trim based on
these marks.

● Adobe InDesign 1.0 and later

These idioms work by intercepting and recording the location of
crop marks when the PostScript draws them. This requires
enabling the crop marks when printing to a PostScript file from
these applications.

For best results for viewing and modifying the trim box after the
PDF is created, use the Kodak Prinergy Geometry Editor
software.

Copydot Enhancements v1.2

This feature is an idiom to improve the PDF workflow for legacy
copydot files created by Creo Renaissance scanners or the
Kodak Copydot Toolkit software. This feature assists with tiling
issues, and we highly recommend that you use this component
when converting copydot EPS files to PDF pages.

For more information about CopyDot Toolkit, go to http://
graphics.kodak.com/

Enhance Quark Color Separator v1.0

The PostScript-based color separation code in QuarkXPress
does not correctly print Photoshop DCS-2 images with clipping
paths. This feature provides a PostScript Level 3 idiom to
correct this behavior. It supports QuarkXPress 3.32 and later,
including XPress Passport.

Prevent FrameMaker RGB v1.0

PostScript generated by Adobe FrameMaker will automatically
detect that it is executing within Distiller, and when it does, it
converts all colors from CMYK to RGB. This feature was added
to FrameMaker with the expectation that the PDF would only be
viewed on the computer monitor and not printed.

To overcome this limitation of FrameMaker, this feature adds
an idiom to intercept and fool the check for Distiller, returning a
better result (for example, that no CMYK-to-RGB color
conversion is necessary).

Adobe Illustrator Patches v1.11

Under some circumstances, Adobe Illustrator converts spot
color gradients to process color smooth shades. This feature
adds idioms to replace the Illustrator logic. It preserves spot
colors by using DeviceN color space, and converts gradients to
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smooth shades. It does not affect the Illustrator blend tool. It
applies only to objects created with the gradient tool.

Additionally, this feature prevents Illustrator from substituting
Courier for missing fonts. Missing fonts are properly reported in
the Distiller log file. It supports Adobe Illustrator versions 7 and
8. It does not modify the behavior of versions 9 or 10. It also
supplements Distiller's built-in support for older versions of
Illustrator.

Quark Custom Blends v1.4

This feature is a set of idioms that replaces the custom color
(spot color) blend code from Quark XPress 3 and 4, and uses
the Smooth Shades patterns and DeviceN color space from
PostScript 3 to represent these graphical constructs in a way
that both produces smoother blends and still retains the custom
colors. Blends with a mixture of spot and process colors are also
supported.

This feature supports QuarkXPress 3.32 and later, including
XPress Passport. It does not replace the Distiller built-in
support for process-to-process blends.

Notes: This feature has the following limitations:

● These smooth shading blends looks "banded" in Acrobat, but that is
only a visual effect of the CMYK to RGB transformation and a visual
effect related to rendering slightly different colors butted together.

● Quark converts "multi-ink" colorants to process colors when a "multi-
ink" colorant is used as an endpoint in a blend. If such a blend is
constructed with one endpoint as a "multi-ink" colorant and the other
endpoint as a spot color, Quark will represent this as a blend from a
process color to a spot color (that is, the "multi-ink" colorant is lost).

FreeHand Blends v1.6

This feature is a set of idioms that reproduces the blends from
the MacroMedia FreeHand software (version 7 and later) using
Smooth Shades and DeviceN color spaces. It avoids the
"convert to process" behavior as well as increases the quality of
blends.

This feature replaces Distiller's built-in support, and allows
Distiller to create composite PDF files with spot color gradients
from FreeHand. Note that this is contrary to the FreeHand
documentation, which states that gradients with spot colors will
be converted to process color. This feature ensures that spot
colors are retained properly.

Notes: This feature has the following limitations:

● Viewing these smooth shading blends in Acrobat looks "banded" but
that is only a visual effect of the CMYK to RGB transformation and a
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visual effect related to rendering slightly different colors butted
together.

● These idioms currently target FreeHand 7 and 8. They have also been
tested successfully with FreeHand 9. Earlier or later versions are not
directly supported, although some may work.

HelpShiraCeps2Ps

This feature optimizes Distiller for more efficient processing of 
Shira files.
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11 Page sets and impositions

Page sets

Page sets

A page set is like a run list in Preps—it displays the pages of the job in
reader order.

You can obtain a page set in the following ways:

● Add a page set manually in Prinergy Workshop using the Add Page
Set menu item

● Import an imposition plan into Prinergy Workshop, which
automatically creates a page set from the imposition plan

● Import a populated job ticket from Preps. The run list is imported
and converted to a populated Prinergy page set.

Benefits of adding a page set manually

If you added a page set manually, you have the following options when
you import the imposition plan:

● Link the imposition plan to the existing page set
● Create a new page set

In the first case, any pages that you assigned to the page set are
automatically assigned to the corresponding positions of the imposition
plan. The advantage of this is that you can do page assignment in
Prinergy Workshop before you know what imposition plan you will be
using. Once the imposition plan is identified, you can import an
unpopulated imposition plan and link it to the page set, and pages are
automatically assigned to the positions of the imposition plan.

Adding a page set automatically with Imposition Import

If you create a page set by importing an imposition plan into Prinergy
Workshop, the page set is linked to the imposition plan. Then, if you
assign a page to a position in the imposition plan in Prinergy Workshop,
the page is also assigned to the corresponding page position in the page
set. Alternatively, if you assign a page to a position in the page set, the
page is also assigned to the corresponding position in the imposition
plan to which the page set is linked.



Adding a page set automatically by importing a Preps job
ticket

If you create a page set by importing a populated Preps job ticket into
Prinergy Workshop, the page set is automatically linked to the
imposition plan. The run list information is mapped to the page set
position in Prinergy.

One page set and multiple imposition plans

Once a page set is created and pages are assigned to it, you can import
multiple imposition plans and link each imposition plan to the same
page set. This enables you to easily assign the same pages to different
imposition plans if you want to output the pages to multiple presses
that each require a different imposition plan.

Naming requirements for page sets and impositions

Avoid the characters #, $, and % in page sets and impositions because
they can interfere with Automated Page Assignment (APA) operation.

About assigning pages

You can assign pages in Prinergy Workshop or in imposition software.

Assigning Pages in Workshop

If you want to add or change page assignments after importing an
imposition plan you can:

● Manually assign pages to and unassign pages from the imposition
plan

● Use Automated Page Assignment (APA) to modify the APA file to
reassign the pages.

When you import an unpopulated imposition, no pages are
automatically assigned, but you can manually assign pages to the
imposition plan. The advantage of creating an unpopulated imposition
plan, is that you can create one generic imposition plan and reuse it in
many Prinergy jobs, rather than having to create a unique imposition
plan for every job.

Assigning Pages in the Imposition Software

For information about assigning pages in imposition software see your
imposition software documentation.

Versioning

If you want to assign multiple pages to one position, see About legacy
versioning on page 1022.

342 Chapter 11— Page sets and impositions



About assigning specific positions to pages

You can manually specify the positions to which the selected pages will
be assigned by using the Range box on the Assign Page to Page Set
Position Dialog Box. This is useful when you want to assign a single
page to multiple positions or assign pages to nonconsecutive page
positions.

A range can be composed of a single position or a list of positions.

● If the range is a list of positions, a selected page is assigned to all of
the positions in the list. Individual assignment positions are
separated by commas or hyphens. A range of positions can be
written as two positions separated by a hyphen and enclosed in
parentheses. A multiple assignment for one selected page can be
written as positions separated by commas.

● If more than one page is selected any multiple assignments or
ranges must be enclosed in parentheses.

Here are some guidelines for entering positions.

These examples assume that the pages listed in the Page column are:
pages A, B, C, and D.

You can assign each page to a single page position or to multiple page
positions. To assign a page to a single page position, simply type the
number of the page position. For example, type 1 to assign Page A to
page position 1.

Position Page

p1 Page A

Page B

Page C

Page D

Use commas to separate the range of page positions to which each
page will be assigned. For example type 1,2,3,4 to assign Page A to
page position 1, Page B to page position 2, and so on.

Position Page

p1 Page A

p2 Page B

p3 Page C

p4 Page D

To assign a single page to multiple page positions, enclose the list of
page positions in parentheses. To assign a single page to consecutive
page positions, use a hyphen to indicate the first and last page
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positions. For example, type (1-2) to assign Page A to page positions 1
and 2.

Position Page

p1-2 Page A

Page B

Page C

Page D

To assign a single page to nonconsecutive page positions use commas
to separate the page positions. For example, type (1,3) to assign Page
A to page positions 1 and 3.

Position Page

p1,3 Page A

Page B

Page C

Page D

To assign multiple pages to a consecutive range of page positions you
do not need to use parentheses. For example, type 1-4 to assign Page A
to page position 1, Page B to page position 2, and so on.

Position Page

p1 Page A

p2 Page B

p3 Page C

p4 Page D

To enter a range of page positions for each of the selected pages
enclose each range in parentheses and separate with commas. For
example, type 1, (2-4), (5,7), 8 for the following results:

Position Page

p1 Page A

p2-4 Page B

p5,7 Page C

p8 Page D

To assign a single page to multiple page positions, both consecutive
and nonconsecutive, enclose the whole list of page positions in
parentheses. For example, type (1,3-5,7) to assign Page A to page
positions 1, 3, 4, 5, and 7.
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Position Page

p1,3-5,7 Page A

Page B

Page C

Page D

About copying page assignments between page sets

You can copy page assignments from one page set to another page set
using the Copy Page Assignments menu item.

This is useful, for example, when you want to copy page assignments
between two imposition plans that are each linked to a different page
set, or when a last-minute decision is made to output using a different
layout and/or media size and you need to replace the imposition plan.

About deleting page sets

If you no longer need a particular page set in your job you can delete it
using the Delete Page Set menu item. It disappears from the Pages
view of Job Manager.

You cannot delete a page set if there are pages assigned to any of its
page positions or if it is linked to an imposition plan. You must
unassign any assigned pages and remove any linked imposition plans
before deleting the page set.

About layering pages in page sets

Layering is the ability to assign two or more PDF pages to a single page
position. The layering feature is useful for the following situations:

● Versioning
● Varnishes
● Adding text to Copydot scans

When you assign two or more pages to one page position the
thumbnail of the page position displays a large V.

The V identifies the page position as a layered page position, and the V
is associated with the bottom layer or page in the page position.

You can view the PDF pages in Adobe Acrobat but you can only view
them one at a time. To view all the layers, you can output a Virtual
Proofing System proof, and view the proof in Virtual Proofing System
software.
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Notes:

● When you output the job, all layers above the bottom layer must be set to
overprint.

● The system cannot trap between layers. It can only overprint layers.

About page sets and multiple imposition plans

Page sets can be used in increasingly complex ways to help control
page assignment and the use of multiple imposition plans. This topic
describes three strategies for controlling assignments.

One page set and one imposition plan

In a basic example one page set is linked to one imposition plan.
Prinergy will automatically create a page set when the imposition plan
is added to a job. The page set created contains the same number of
page positions as the imposition plan. In this example, it is not
necessary for you to know how to manipulate page sets in any way.

One page set for each imposition plan

In a slightly more advanced scenario you can use page sets to name
page positions. This is useful for jobs that contain multiple imposition
plans. In this scenario, one page set is still linked to only one imposition
plan, but more than one imposition plan is registered. By naming the
page sets, page assignment is easier because you can tell by the
position name which page to put there. For example, if there is one
imposition plan for covers and one imposition plan for body pages, you
can set a prefix of C for the page positions in the page set linked to the
covers imposition plan and a prefix of B for the page positions in the
page set linked to the body imposition plan.

Naming Page Sets (B)
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One page set with multiple imposition plans

For advanced operations, you can link one page set to more than one
imposition plan. This is useful for situations where you want to print
the same job on different presses that require different imposition
plans or when you make a last-minute press change. To link a page set
to multiple imposition plans, you select the existing page set when
adding imposition plans to the job.

Linking Pages (A) to a Page Set (B), then to Multiple Imposition Plans
(C)

Adding page sets

This procedure describes how to add a page set to a job using the Add
Page Set menu item. You can also create a page set automatically
when you import an imposition.

1. Open the job in Job Manager.

2. From the File menu, select Add Page Set.

3. In the Add Page Set dialog box, specify the page number for the
first page of the page set, and the number of pages in the page set.

Change the page set name and prefix if desired.

4. Click Add.

The page set appears in the Page Sets pane of the Pages view with
no pages assigned to its positions.

If desired, you can now manually assign to the positions of the page
set or import an imposition plan and link it to this page set.

Add Page Set dialog box

Existing Page Sets

Lists any existing page sets for the job.

New Page Set Name

Displays a name for the new page set. You can edit this name
by typing a new name in the box.
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Prefix

Displays the letter that will be used to identify the page
positions in the new page set. You can change the prefix by
typing up to five alphanumeric characters. The prefix must not
end with a number.

When you select an existing page set this option is blank.

Page Start

The starting page number for the page set. You can type in this
box to change the starting page number.

Note: When you select an existing page set from the Existing Page Sets
box this option displays the starting page number for the existing page
set.

Page Count

The total number of pages for the page set. You can type in this
box to change the total number of pages.

Note: When you select an existing page set from the Existing Page Sets
box this option displays the total number of pages for the existing page
set.

Page End

The ending page number for the page set. The number is
calculated by adding the numbers in the Page Start and Page
Count boxes.

Layering pages

1. Enable the layering feature for the job:

a. In Job Finder, select the job.
b. From the Edit menu, select Edit Job Attributes.
c. In Max Layers, type the desired number of layers.

2. Open the job in Job Manager, and add your input files.

3. Using a refine process template that generates thumbnails, refine
the input files.

4. Create, edit, or import the imposition plan.

For information about creating and editing, see Preps on page 1059
and Imposition software on page 1087. For information about
importing, see Importing impositions on page 355.

5. From the View menu, select as Thumbnails.

6. Drag the base PDF page thumbnails to the desired page positions.

348 Chapter 11— Page sets and impositions



7. Drag the second layer of PDF page thumbnails to the desired page
positions, on top of the base PDF page thumbnails.
The layered pages display a large black V.

Deleting page sets

Page sets can only be deleted if they are not linked to an imposition
plan. Remove the imposition plan to break the link between an
imposition plan and a page set.

1. In the Page Sets pane of the Pages view of Job Manager, click the
Group by Page Set icon ( ) so that the page sets display by group.

2. Select the page set that you want to delete.

3. From the File menu, select Delete Page Set.

4. If prompted to confirm, click Continue.

Manually assigning pages to page sets and imposition plans

You can manually assign pages to the positions of a page set or
imposition plan by dragging pages onto positions or by using the
Assign Page to Position menu item.

1. In the Pages pane of the Pages or Signatures view of Job Manager,
select the pages that you want to assign.

Note: If you want to use the automatic method, select pages in the order that
you want them assigned.

2. Perform one of the following actions:

To Do This

Manually
make
assignments

Drag the pages onto the desired positions of the page set
(in the Pages view) or imposition plan (in the Signatures
view).

If you select multiple pages, drag them to the first position
to which you want to assign pages.

Automatically
make
assignments

From the Edit menu, select Assign Page to Position. (You
can also right-click the selection and select Assign Page to
Position.)

In the Assign Page to Page Set Position dialog box, specify
the page set and page positions to which you want to
assign the pages, and then click OK.

Assign Page to Page Set Position dialog box

Page Set

Displays the name of the page set to which you are assigning
the selected pages.
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Position

Use this list to select the page positions to which you want to
assign the selected pages. Options are:

● Position
● Odd Position
● Even Position
● Unassigned Position

Starting at

Displays the page number at which you want to start the range
of page assignments. You can type in this box to change the
starting page number.

Range

Use this box instead of the Position list when you want to
manually specify the page positions to which the selected pages
(as listed in the Page column) will be assigned.

To assign a single page to multiple positions, use brackets in the
Range box. For example, typing (1,3,5) in Range box will
assign the selected single page to positions 1, 3, and 5,

To assign multiple pages to nonconsecutive positions, don't use
brackets in the Range box. For example, typing 1,3,5 in the
Range box will assign the selected three pages to positions 1, 3,
and 5.

Position

Displays the page position to which the page will be assigned
based on the position or range that you specified.

Page

The name of the page that will be assigned to the page position.
Pages are listed in the order in which you selected them.

Copying page assignments between page sets
Note: To copy assignments from one page set to another page set, more than one
page set must be added to the job.

1. In the Page Sets pane of the Pages view of Job Manager, select the
positions that you want to copy.

Tip: To select all of the positions at once, click the name of the page set.

2. From the Edit menu, select Copy Page Assignments.
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3. In the Copy Page Assignments dialog box, in the To Page Sets list,
select the page set to which you want to copy the assignments.

You can also select more than one page set.

The selected assignments are copied to the destination page set. If
there is an existing assignment for a position in the destination
page set, the existing assignment is overwritten.

Copy Page Assignments dialog box

Copy Assignment

Indicates the layer of the source position to be copied.

Currently only the Base Page layer is available.

To Page Set

Indicates the page set to which you want to copy the page
assignments. You can also select more than one page set.

Unassigning pages from page set positions

1. Perform one of the following actions:

○ To unassign pages from a page set, select the pages in the Page
Sets pane of the Pages view.

○ To unassign pages from an imposition plan, select the pages in
the Imposition Plans pane of the Signatures view.

Tip: To select all of the positions in a page set or imposition plan at once, click
the name of the page set or imposition plan. To select all of the positions in all
page sets or imposition plans, from the Edit menu, select Select All Page
Positions or right-click and select Select All Page Positions.

2. Perform one of the following actions:

○ Drag the selected pages and drop them onto the Pages pane.
○ From the Edit menu, select Unassign.

Impositions

About imposition plans

An imposition plan provides layout information for pages in a job.

If you often edit or create imposition plans after you have created a
Prinergy job, you can speed up the task of working with imposition
software by integrating it with Prinergy. See About integrating
imposition software on page 1087.
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Supported imposition file types

You can import the following types of files (and their related marks
files) into Prinergy:

Files from
imposition software

Imposition
software release

Unpopulated
PJTF

Populated
PJTF

Unpopulated
JDF

Populated
JDF

Preps 6.0 and later yes yes yes yes

5.0 and later yes yes yes yes

4.1.2 yes yes yes -

4.0.6 yes yes - -

3.7.7 yes - - -

Pandora 1.2 and later - yes - -

Dynagram DynaStrip 4.0 and later* yes - - -

Ultimate
Technologies
ImpoStrip

7.0 and later* yes - yes -

Heidelberg Prinect
Signa Station

6 and later* yes yes - -

Facilis 4.0 - - yes yes

3.7 yes - - -

Note: The Preps DLL on the Prinergy server (which is used to convert Preps jobs,
JDFs, and so on to impositions) only works in Preps 6 mode. This means that sites
with Preps 5 clients must migrate these clients to Preps 6 in order to edit Prinergy
impositions. Check the eCentral portal for online training resources, or contact
your Kodak representative for training options. Preps version 5 and earlier are no
longer tested or supported. Functions that previously used Preps 5 (for example,
creation of impositions from within Prinergy jobs, creation of impositions outside
of Prinergy jobs, editing of impositions, and so on) may still work, but if problems
are discovered, customer support will advise upgrading to Preps 6.

Preps 5 templates can be migrated by opening and saving them in the
Preps 6.2 standalone application. The Prep 6.2 application and DLL
have been modified to translate Preps 5 templates to Preps 6 mode at
the moment they're opened.

* Not all releases of the imposition software are qualified. For the most
current information, contact a service representative.

For information about other imposition software, please contact your
imposition software vendor.

Note: Portable Job Ticket Format (PJTF) files can have extensions other
than .pjtf—for example, .jt.
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About importing populated job tickets from Preps

You can create a populated job ticket in Preps by including real files
(pages) in the Preps run list. The products, parts, and assembly
information (run list) from the Preps job ticket are imported into
Prinergy.

The generated PJTF or JDF file includes a UNC path to the run list files.

Important: Before you can import a populated job ticket from Preps, the following
tasks must be completed:

● A system administrator must enable the Import Populated Job Ticket option
in the Import/Export JTP in Prinergy Administrator. For more information, see
the Prinergy System Administration Guide.

● For the Mac only, a system administrator must correctly configure the
SFMHOSTS file by setting the mapping of the Macintosh zone to the Windows
2000 server. The syntax is zone:sfmservername=ntservername. For
example, if you have an Windows 2000 server named CWA420 in the
Production zone, the entry in the SFMHOSTS file would be
Production:CWA420=CWA420. The SFMHOSTS file is located in <
%AraxiHome%>\CreoAraxi\etc.

Importing product intent

If the populated job ticket that is imported from Preps contains
products and parts, these are imported into the job, and are displayed
in Workshop in the Product/Part column in the Pages view.

The Run List column in Workshop displays the run list as it was defined
in Preps. This run list information is mapped to the page set position in
Prinergy.

Assigning pages via an APA file

If pages were not assigned in the Preps job ticket, you can process the
files using a refine process template with the Automated Page
Assignment (APA) option turned on in the Impose section. Prinergy
imports the populated job ticket and creates an APA file with page and
geometry assignment instructions based on the populated job ticket.
The APA file is created in <job folder>\Control.

Each time you import a populated job ticket into a job, Prinergy adds
the populated job ticket information at the beginning of the APA file,
and increments the file name (Job.apa, Job.v1.apa,
Job.v2.apa).
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About importing impositions

You can import an imposition at any time to:

● Add an imposition to a job.

(This includes reusing an existing imposition and substituting new
pages rather than creating a new imposition.)

● Rename an imposition. Currently, Prinergy does not support
renaming of impositions. To rename an imposition, import it and
change the name during the import.

For the import to be successful:

● The marks file and imposition file must be stored in the same folder.
● The new pages must be the same shape and size as the original

pages.

Using menus or hot folders

You can import imposition and marks files using the Import Imposition
menu item or by dropping the imposition and marks files into a hot
folder or smart hot folder.

When you import an imposition plan it appears in the Imposition Plans
pane of the Signatures view.

About removing vs. destroying imposition plans

If you no longer need a particular imposition plan in your job you can
remove or destroy it. Whether you remove or destroy an imposition
plan depends on whether you will need the job's input files, pages, or
page sets again.

Removing

You remove an imposition plan using the Remove Imposition menu
item.

When you remove an imposition plan it disappears from the Imposition
Plans pane of the Signatures view from the Separations view and from
the Storage view. Any references to it are deleted from the database.

Any input files pages, and page sets associated with the imposition
plan are not deleted; they continue to appear in Job Manager.

Destroying

You destroy an imposition plan using the Destroy Imposition menu
item.

While Remove Imposition removes only the imposition plan from the
job (and not associated pages or page sets), Destroy Imposition
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destroys the imposition plan as well as its associated input files, pages,
and page sets. Destroying an imposition plan enables you to remove a
job's files while retaining its settings, such as the image search path.
Once an imposition plan is destroyed, you cannot retrieve it or its
associated files. Therefore, if you think that you might need the job's
input files, pages, or page sets again, consider removing the imposition
plan rather than destroying it.

When you destroy an imposition plan it disappears from the Imposition
Plans pane of the Signatures view from the Separations view and from
the Storage view. Any references to it are deleted from the database.

As well, any page set linked to the imposition plan, pages assigned to
the imposition plan, and input files from which those pages originated
disappear from the Pages, Signatures, and Storage views of Job
Manager, and any references to those files are deleted from the
database. Any pages that were assigned to the imposition plan are also
removed from the job folder. Any input files from which those pages
originated are removed from their original input volume.

Note: If you try to destroy an imposition plan but another imposition plan in the
same job is using the same input files, pages, or page sets, the system will not
destroy them.

Importing impositions

1. From the File menu, select Import Imposition.

2. In the Import Imposition dialog box, in Select a file to use for the
imposition, browse to and select the imposition plan that you want
to import.

● For a Preps imposition, select ImpositionName.pjtf. You can
also select ImpositionName.jdf and ImpositionName.job.

● For a Pandora imposition, select ImpositionName.in.jt.

Imposition and marks files are originally stored in <job folder>
\TransientLayouts\<client computer>. They may have
been moved to another location on a mounted volume. If there is a
marks file, it must be in the same folder as the imposition file or the
import will fail.

3. Click  to expand the Options section.

4. Modify the Imposition Name if desired.

5. Choose the page set.

If using Do this

Pandora Select Create New Page Set to create a page set based on the
imposition in Pandora.
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If using Do this

Preps Select Create New Page Set to create a page set based on the
run list in Preps.

Select Use Existing Page Set to link an existing page set to the
imposition.

If you select:

● Create New Page Set, specify the page set name, prefix, and
number of pages.

● Use Existing Page Set, select the page set from the list. Only
those page sets with the same number of page positions as the
imposition being imported are available.

Note: These settings override the import process template settings.

6. Click Import.

The imposition plan appears in the Signatures, Separations, and
Storage views of Job Manager.

Importing a populated job ticket from Preps

1. In Prinergy Workshop, create a job.

2. In Job Manager, import an imposition from Preps.
The following items are imported from the Preps job ticket to the
Prinergy job:

● Input files referenced in the job ticket are added to the job.
● If the job ticket contains products and parts, these are imported

into the job, and are displayed in the Product/Part column in the
Pages view and Signatures view.

● If pages were assigned in the Preps job ticket, the Run List
column in Workshop displays the Preps run list and this
information is mapped to the page set position in Prinergy.

Note: If pages were not assigned in the Preps job ticket, you can process
the files using a refine process template with the Automated Page
Assignment (APA) option turned on in the Impose section. Based on the
instructions in the APA file, Prinergy assigns the refined pages to the page
set positions and the geometry to the pages.

Updating imposition plans
Update your imposition instead of having to manually re-import your
modified imposition.

When you've made changes to an imposition that do not affect the
page assignment, use Update Imposition. For example, if you changed
a mark in an imposition, use Update Imposition to bring in the changes
without having to reassign the pages.
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1. In the Signatures view, select the imposition that you want to
update, and right-click to open the context menu.

2. Click Update Imposition.

3. In the Update Imposition dialog box, in Select a file to use for the
imposition, browse to and select the imposition plan that you want
to update.

● For a Preps imposition, select ImpositionName.pjtf. You can
also select ImpositionName.jdf and ImpositionName.job.

● For a Pandora imposition, select ImpositionName.in.jt.

Imposition and marks files are originally stored in <job folder>
\TransientLayouts\<client computer>. They may have
been moved to another location on a mounted volume. If there is a
marks file, it must be in the same folder as the imposition file or the
import will fail.

4. Modify the Imposition Name if desired.

5. Check to ensure the page set is correct.

6. Click Update.

7. In the Start Process dialog box, check to ensure the import settings
are correct, and click OK.

Removing imposition plans

Removing an imposition plan does not delete its associated page sets,
pages, and input files.

The imposition plan disappears from the Signatures, Separations, and
Storage views of Job Manager and references to the files are deleted
from the database.

1. In the Imposition Plans pane of the Signatures or Separations view
of Job Manager, select the imposition plan that you want to
remove.

2. From the File menu, select Remove Imposition.

3. If prompted to confirm, click Continue.

Destroying imposition plans
Important: Only destroy an imposition plan when you are certain you will never
need it again. When you destroy an imposition plan, Prinergy permanently
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removes the imposition plan, page sets, sub pages, and input files associated with
the imposition plan. All references to the files are deleted from the database.

1. In the Imposition Plans pane of the Signatures or Separations view
of Job Manager, select the imposition plan that you want to
destroy.

2. From the File menu, select Destroy Imposition.

The Destroy Imposition dialog box appears, prompting you to
confirm the deletion.

3. In the User Name box, type your user name.

4. In the Password box, type your password.

5. Click Destroy.

Preserving cutting data from Preps
Use this procedure to preserve cutting data in a Preps imposition so
that the data is available for a downstream cutting system.

1. From a Preps Pro job, print a PJTF with the Embed CIP3 Cutting
Data option selected in the Print dialog box.

2. Import the PJTF into a Prinergy job.

3. When outputting to final output, in the Press Interface box of the
PrintLink section, select Heidelberg CPC32 Version 2.0.

A PPF file is created in the folder as specified in the process template.

Next: Add this PPF file to your cutting software.

Import process template (impositions)

This topic applies only when you are importing impositions. If you are
importing a job, see Import process template (jobs) on page 870.

Two types of process templates are available for importing: ImportAll
and ImportJobIncremental. To import impositions use the ImportAll
process template.

Import section

Select this check box to enable the Import section of the import
process template.

It determines how Prinergy imports impositions, exported jobs,
and exported job files.
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JTP

Select a JTP to use for importing.

Note: You set up JTPs using Prinergy Administrator.

If Page Set Already Exists

Determines what happens if a page set with the same name
already exists.

Note: When importing an imposition plan via a hot folder, choose any
option except Keep existing page set and imposition.

The options are:

● Fail import: Stops the import process.
● Delete existing page set and imposition: Replaces the

existing page set and imposition with the page set and
imposition being imported.

● Create alternate page set and imposition: Creates a new
page set and links it to the imposition plan, without affecting
the existing page set or its assignments. This is the default in
the ImportAll process template.

● Keep existing page set and create new imposition: Retains
the original page set and links it to the new imposition. The
imported and existing sets must have the same number of
positions. Selecting this option enables the check boxes in
the Page Sets Options area of the import process template.

● Keep existing page set and imposition: Retains the existing
page set and imposition. The imported and existing sets
must have the same number of positions. This is the default
in the ImportJobIncremental process template. Selecting
this option enables the check boxes in the Page Sets
Options area of the import process template.

Page Set Options

A set of check boxes that specify how to handle page
assignments in an existing page set when the new imposition is
linked to that page set. The check boxes are:

● Existing assignments replaced by new assignments:
Prinergy replaces the old page assignments with the new
page assignments in the imported file. In the
ImportIncremental process template, this check box is
selected by default.

● Existing assignments replaced by new unassignments:
Prinergy removes page assignments from pages that are not
assigned (blank) in the imported file. When this check box is
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selected, the other two check boxes in Page Set Options are
automatically selected.

● Existing unassigned replaced by new assignment: Prinergy
retains existing assignments and applies any new
assignments from the imported job or populated PJTF to any
unassigned positions in the existing page set. This check box
is always selected.

The check boxes are available only if the If Page Set Already
Exists list is set to either Keep existing page set and create new
imposition or Keep existing page set and imposition .

These check boxes are especially important when you want to
manually assign pages to a page set and then link the page set
to multiple imposition plans.

Set Initial Separations After Imposition Import

In the imposition software, you may inadvertently add marks
that contain separations that are not present in the content of
the refined pages.

● Select this check box when you want Prinergy to ignore the
additional separations in the marks.

● Clear this check box when you want Prinergy to show the
additional colors in the marks.

Important: Clear this check box if you are doing color mapping in the
imposition software. Otherwise, Prinergy may ignore your color
mapping changes.

Overwrite Existing Automated Page Assignment File

Select this check box if you want Prinergy to overwrite the
existing APA file and use the assignments specified in the job
you are importing.

Continue Job Import if CRC Error Found

Select this check box when you want Prinergy to skip any files
with CRC errors without failing the import. The names of the
files with errors are logged in the History view, so you can
correct and reimport these files into the job.

Do Auto Page Assignment After Unpopulated Imposition Import

Select this check box when you want Prinergy to perform APA
assignment and allow pages to be automatically assigned
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whether they have been refined before or after an imposition
import.

Important: Do not select this check box unless you have an APA file with
the assignments that you want applied to the selected page set. Any
existing assignments are deleted if you have an empty or invalid APA file
and this check box is selected.

If you clear this check box, pages can NOT be automatically
assigned if they have been processed before an unpopulated
imposition import (or before a page set is created).

Center Pages in Imposition

(For imposition imports only)

Specify the placement of each PDF page trim box (or media
box) within its assigned imposition trim box during the job
import.

The options are:

● Honor Existing—Preserves the existing placement of each
PDF page (centered or not centered) when the job is
imported.

● Centered— Each PDF page trim box is centered within its
imposition trim box. You can then reassign pages to different
positions without worrying about the image shifts caused by
different trim box sizes on different PDF pages.

● Not Centered-Each PDF page trim box is positioned in the
lower-left corner of its imposition trim box.

Signature ID Code area

Template

Type a series of tags such as %jobname<n>%
%imposition<n>%%version<n>%%signature<n>%
%numsections%.

This overrides the default settings specified in Administrator.

Number of sections per signatures in one imposition

Type the total number of sections in each signature. For
example, if you import an imposition with five signatures and
signatures 2 and 5 each contains two sections, enter 1,2,1,1,2.

This overrides the default settings specified in Administrator.
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Normalize for PDF Marks File section

Select this check box to enable the Normalize for PDF Marks
Files section of the import process template, which determines
how Prinergy normalizes PDF marks files.

JTP

Select the job ticket processor you want to use for normalizing
the marks files.

Note: You set up JTPs using Prinergy Administrator.

Remove Font XUIDs

XUID stands for extended unique ID, which is a font
characteristic introduced with Normalizer 6.

Select this check box to remove font XUIDs if you are refining
files that may be exported and ripped on systems that use the
3011 RIP (Prinergy 2.2.1.10 or earlier) or other older RIPs.

If left unchecked, the older RIP may crash in some
circumstances.

Normalize for PostScript Marks Files section

Select this check box to enable the Normalize for PostScript
Marks Files section of the import process template, which
determines how Prinergy normalizes PostScript marks files.

JTP

Select the job ticket processor you want to use for normalizing
the marks files.

Note: You set up JTPs using Prinergy Administrator.

Images

Do OPI Image Replacement

Select this check box to enable OPI, which replaces OPI
comments with images from the defined search paths. Images
can reside on any Windows NT server accessible on the
network.

Note: Image search paths do not search subfolders, so be sure to add
each subfolder specifically.
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Fail on Missing Images

This check box applies only when OPI can't locate an image for
the input file. You can select or clear this check box
independently of the Do OPI Image Replacement check box.

Select this check box if you want Prinergy to fail the normalize
process and not produce a PDF page.

Clear this check box if you want Prinergy to continue producing
the PDF file with a missing image.

In either case Prinergy displays an error message or icon ( ) in
these places in Job Manager:

● In the Active Processes pane.
● In the Process Info dialog box.
● On the History view.

Low Resolution Image Handling

Determines what Prinergy does when images are lower than the
resolutions specified in the Of Contone Resolution Below and
the Of Bitmap Resolution Below. The options are:

● Ignore low resolution images-Does not display warning
message and continues processing.

● Warn for low resolution images-Displays a warning
message or icon ( ), but continues processing.

● Fail on low resolution images- Stops processing and
displays a warning message or icon ( ). Prinergy produces a
PDF covered by a large, black X.

Of Contone Resolution Below

Prinergy handles contone images with resolutions below this
value with the action specified for low-resolution images in the
Low Resolution Image Handling list.

This box is not available if Low Resolution Image Handling is
set to Ignore low resolution images.

Of Bitmap Resolution Below

Prinergy handles bitmap images with resolutions below this
value with the action specified for low-resolution images in the
Low Resolution Image Handling list.

This box is not available if Low Resolution Image Handling is
set to Ignore low resolution images.

Fonts
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Remove Font XUIDs

XUID stands for extended unique ID, which is a font
characteristic introduced with Normalizer 6.

Select this check box to remove font XUIDs if you are refining
files that may be exported and ripped on systems that use the
3011 RIP (Prinergy 2.2.1.10 or earlier) or other older RIPs.

If left unchecked, the older RIP may crash in some
circumstances.

Optimize for PostScript Marks Files section

Select this check box to enable the Optimize for PostScript
Marks Files section of the import process template, which
determines how Prinergy optimizes PostScript marks files.

JTP

Select a job ticket processor (JTP) to use for optimizing
PostScript marks files.

Note: You set up JTPs using Prinergy Administrator.

Color Images

Resample

Select this check box to downsample images with a resolution
above the value in the If Above box to the value set in the Down
to box.

If you select the check box, select type of downsampling in the
list. The options are:

● Average - Provides faster but less accurate downsampling.
● Bicubic - Provides slower but more accurate downsampling.

The Resample check box under Color Images applies only to
color images. The Resample check box under Grayscale Images
applies only to grayscale images.

Down to

Type the lowest resolution to which Prinergy downsamples
images. The recommended setting is double the lpi value. For
example, 400 ppi for 200 lpi, 300 ppi for 150 lpi, 170 ppi for 85
lpi.
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The Down to box in the Color Images area applies to color
images. The Down to box in the Grayscale Images area applies
to grayscale images.

Note: The Down to and the if Above options are linked by ratio. This ratio
is stored as an integer in each process template. When you open a
process template, Prinergy calculates the if Above value from the Down
to value and the stored ratio. When you change the if Above value, the
Down to value stays the same, but the system rounds the if Above value
to the nearest integer, according to the ratio between the two options.

if Above

Type the minimum resolution an image must be for Prinergy to
downsample it.

The if Above box under Color Images applies to color images.
The if Above box under Grayscale Images applies to grayscale
images.

Note: The Down to and the if Above options are linked by ratio. This ratio
is stored as an integer in each process template. When you open a
process template, Prinergy calculates the if Above value from the Down
to value and the stored ratio. When you change the if Above value, the
Down to value stays the same, but the system rounds the if Above value
to the nearest integer, according to the ratio between the two options.

Compression

Select a compression format for compressing images. The
options are:

● None-Disables image compression.
● JPEG (Lossy)-Compresses images using a JPEG format.
● ZIP (Lossless)-Compresses images using the ZIP format.

The Compression list under Color Images applies to color
images. The Compression list under Grayscale Images applies
to grayscale images.

Quality

Applies only if the Compression list is set to JPEG (Lossy).

Select a level of compression. The compression level decreases
as the quality level increases.

The Quality list under Color Images applies to color images.
The Quality list under Grayscale Images applies to grayscale
images.

Grayscale Images
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Resample

Select this check box to downsample images with a resolution
above the value in the If Above box to the value set in the Down
to box.

If you select the check box, select type of downsampling in the
list. The options are:

● Average-Provides faster but less accurate downsampling.
● Bicubic-Provides slower but more accurate downsampling.

The Resample check box under Color Images applies only to
color images. The Resample check box under Grayscale Images
applies only to grayscale images.

Down to

Type the lowest resolution to which Prinergy downsamples
images. The recommended setting is double the lpi value. For
example, 400 ppi for 200 lpi, 300 ppi for 150 lpi, 170 ppi for 85
lpi.

The Down to box in the Color Images area applies to color
images. The Down to box in the Grayscale Images area applies
to grayscale images.

Note: The Down to and the if Above options are linked by ratio. This ratio
is stored as an integer in each process template. When you open a
process template, Prinergy calculates the if Above value from the Down
to value and the stored ratio. When you change the if Above value, the
Down to value stays the same, but the system rounds the if Above value
to the nearest integer, according to the ratio between the two options.

if Above

Type the minimum resolution an image must be for Prinergy to
downsample it.

The if Above box under Color Images applies to color images.
The if Above box under Grayscale Images applies to grayscale
images.

Note: The Down to and the if Above options are linked by ratio. This ratio
is stored as an integer in each process template. When you open a
process template, Prinergy calculates the if Above value from the Down
to value and the stored ratio. When you change the if Above value, the
Down to value stays the same, but the system rounds the if Above value
to the nearest integer, according to the ratio between the two options.
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Compression

Select a compression format for compressing images. The
options are:

● None-Disables image compression.
● JPEG (Lossy)-Compresses images using a JPEG format.
● ZIP (Lossless)-Compresses images using the ZIP format.

The Compression list under Color Images applies to color
images. The Compression list under Grayscale Images applies
to grayscale images.

Quality

Applies only if the Compression list is set to JPEG (Lossy).

Select a level of compression. The compression level decreases
as the quality level increases.

The Quality list under Color Images applies to color images.
The Quality list under Grayscale Images applies to grayscale
images.

Import Raw Imposition Files section

Profile

Select Default if you use Preps Integration and you want to
import raw imposition files, which include:

● JDF stripping parameters (.jdf or .xml)
● Preps .job files (from Preps or Kodak UpFront software)

Do not select PrepPrinergy. This option is used by the internal
Preps integration processes.

Device

Select the final output device on which this output is eventually
to be printed.

Output Signatures

All or Partial

Select All to import all signatures in the imposition, or select
Partial to import only some of the signatures in the imposition.

If you are importing only some of the signatures complete the
remaining controls in the Output Signatures box.
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Range

Type the range of signatures that you want to import.

Use a dash to indicate a range of webs; follow each web range
or individual web with a comma. For example, 1-7, 9, 12-14.

Sides

Select to import the Front, Back, or Front and Back of the
selected objects.

For example if you are printing signatures and select Front, this
control allows you to print all the front sides of the specified
signatures.

If you are printing webs and select Front, this control allows you
to print all the front sides of the specified webs.

Webs

Select All to import all webs or select Range to import only
some of the webs.

If you are importing only some of the webs type the range of
webs that you want to import in the Range box. Use a dash to
indicate a range of webs; follow each web range or individual
web with a comma. For example, 1-7, 9, 12-14.

Destroy Imposition dialog box

User Name

Type your user name for your system account.

Password

Type the password for your system account.

Import Imposition dialog box

Select a file to use for the imposition

Use this box to locate and select the imposition plan that you
want to import.

Information about the selected imposition plan appears in the
right pane of the dialog box.
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Files of Type

Select an option to filter the files that are displayed in the Select
a file to use for the imposition section by a specific file type.
Only files of the selected type are displayed.

Options are:

● All Eligible Files
● All Files
● Portable Job Ticket File (JT or PJTF)
● Job Definition File (JDF or XML)

By default, All Eligible Files is selected. An eligible file is any file
of the .pjtf, .icf, or .job type.

Show Hidden Files

Select this option to display hidden files such as system files, in
the Select a file to use for the imposition section.

The default selection of this option can be set in the View tab of
the Workshop Preferences dialog box.

Volumes

Displays accessible input volumes as defined in Administration
Console. If the input volume that you want does not appear, you
must add it to Administrator.

Job Folder

Opens the job folder for the current job.

Import

This button appears as Open when an input volume or folder is
selected. Click this button to open the selected volume or
folder.

This button appears as Import once an eligible imposition plan
has been selected. Click this button to import the selected
imposition plan.

Options

Select

Click this button to open the Choose Process Template dialog
box, where you can change the import process template that
controls the current import.
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Imposition Name

Displays the name of the imposition plan. You can change the
name as desired. The maximum length for the name is 260
characters.

Note: If you are importing an imposition plan with the same name as one
that is already part of the job, you can either type a unique name or allow
Prinergy to automatically add a version number to the imposition name.

Create New Page Set

Automatically creates a page set, based on information in the
imposition plan being imported, and links the page set to the
imposition plan that Prinergy generates from the imposition
plan. By default, the page set is given the same name as the
imposition plan, although you can change the name in the
Name box.

Name

Displays the name of the page set. You can change the name as
desired.

This option is available only when you select Create New Page
Set.

Prefix

Displays the letter that will be used to identify the page
positions in the new page set. You can change the prefix by
typing up to five alphanumeric characters. The prefix must not
end with a number.

This option is available only when you select Create New Page
Set.

From

Displays the first page set position number. You can change the
number as desired.

This option is available only when you select Create New Page
Set.

To

Displays the last page set position number. You can change the
number as desired.

This option is available only when you select Create New Page
Set.
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Note: The total number of page set positions must equal the number of
pages in the imposition.

Use Existing Page Set

Links the imposition plan being imported to an existing page set
in the job instead of creating a new page set. Select this option,
and from the list, select an existing page set to which the
imposition plan will be linked. Only page sets that contain the
same number of page positions as the imposition plan being
imported are available for selection.

This option is available only when the job contains an existing
page set.

Note: When you select this option, the page assignments in the
imposition plan being imported will overwrite the page assignments in
the existing page set. If you do not want to overwrite the page set
assignments, select Create New Page Set instead.

Page geometry

About page geometry

You can add or modify page geometry settings in three ways:

● Using your layout software—The system automatically applies
offsets from registration marks included in PostScript generated
from Adobe PageMaker and QuarkXPress files.

● In Prinergy using the Set Page Geometry dialog box —When you
know the measurements you want to apply, use the Set Page
Geometry dialog box to control trim size, offset, scale, and
orientation for your PDF pages.

● In Prinergy using the Geometry Editor—Prinergy includes a plug-in
to Adobe Acrobat that lets you visually set the trim size for a page.
Following are effective ways to use this plug-in:

○ If your input files are PDF, you can set the trim size before you
add the PDF files to a job. When you refine the PDF input files,
the system retains the trim size. Display the numerical trim size
in the Set Page Geometry dialog box .

○ For refined files, use the plug-in as a trim box viewer and editor.

For information about Geometry Editor, see the Geometry Editor
documentation.

Tip: To quickly apply a trim size to multiple files, visually set the trim size in the
Geometry Editor, and note the measurements. Then select all the pages you want
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to set to the same trim size and use the Set Page Geometry dialog box to set the
trim size for all selected pages.

If you modify the geometry on refined PDF pages, you must refine the
PDF page so that Prinergy recognizes the changes. When you refine a
PDF page, select a refine process template in which only the Normalize
section is enabled.

Using addition and subtraction when setting page geometry

You can do simple addition and subtraction in the Trim Size, Offset,
and Scale boxes of the Set Page Geometry dialog box.

This topic gives the syntax for addition and subtraction expressions
and examples of valid entries.

Note: You cannot do addition and subtraction in the Geometry Editor plug-in.

Syntax

The basic syntax of a valid entry is:

value [unit of measure] [+ / - value [unit of measure]]

Square brackets indicate optional entries. Units of measure are
optional; addition and subtraction are optional.

You can repeat [+ / - value [unit of measure]] as often as you like.

You can mix units of measure in expressions in the Trim Size and
Offset boxes.

For the Scale box, % is the only valid unit.

Examples:

You can make any of the following entries in the Trim Size or Offset
boxes:

23.5 + 15

25 pt - 2 pt

243 pt + 1.5 in - 7

You can make any of the following entries in the Scale box:

23 + 15

25 % - 2 %

25 + 5 % - 4

General rules

You can enter any number of digits after the decimal in the Trim Size
and Offset boxes. Values are rounded to three digits after the decimal.
For example, if you enter 1.2345, it is rounded to 1.235.
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Trim Size must be greater than or equal to 0.011 pt.

You can mix units of measure in an expression in the Trim Size and
Offset boxes, for example 3 in + 2 cm. The following unit entries are
valid: pt, pts, mm, cm, in, inch, or inches. If you don't specify any units,
the system applies the unit set in the Prinergy Workshop Preferences
dialog box to all values.

If some but not all units are specified, the system reads from left to
right to find the first value with a unit. The system applies that unit to
all preceding values and to all subsequent values without a unit until
the next value with a specified unit. The system applies that unit to all
subsequent values without a specified unit until the next value with a
specified unit, and so on. The system interprets the units when you
press tab. See the examples in the table below.

For the Scale box, % is the only valid unit.

The system ignores all spaces in expressions.

Trim size and offset: interpreting units of measure

For Trim Size and Offset boxes, the following table shows valid entries
and how the system interprets them in cases where different units
were entered or where units are missing. The system interprets units
when you press Tab. When you press OK then redisplay the Set Page
Geometry dialog box all values will have the unit of measure set in the
Prinergy Workshop Preferences dialog box and the change you entered
will be incorporated.

Trim Size or Offset entry After you press Tab

(e.g. Preferences unit is inches)

After you press OK and
redisplay

(e.g. Preferences unit is
inches)

23.5 + 15 The unit of measure specified in Workshop
Preferences is applied to all values, for
example, 1.25in + 2.5in

38.5 in

25 pt - 2 pt no change 0.319 in

243 pt + 1.575 in no change 3.375 in

23 + 15pt - 20 23pt +15pt - 20pt 0.25 in

23pt + 15 - 20 23pt +15pt - 20pt 0.25 in

23 + 15 - 20pt 23pt +15pt - 20pt 0.25 in

23pt + 15 - 10in + 12 23pt + 15pt - 10in + 12in 2.528 in

23 + 15pt - 10 + 12.25in 23pt + 15pt - 10pt + 12.25in 12.639 in

23.554343pts 23.554pt 0.327 in
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What Happens When You Press Tab or OK

When you press Tab:

● The system displays an error message if either the syntax or the
resulting value is invalid. Trim Size must be greater than or equal to
0.011 pt; Scale value must be greater than 0.

● Values in the Trim Size or Offset boxes are rounded to three digits
after the decimal.

● Units are interpreted according to the rules described above. Units
are changed to the standard, for example, pts to pt, and inch or
inches to in.

When you press OK:

● The system displays an error message if either the syntax or the
resulting value is invalid. Trim Size must be greater than or equal to
0.011 pt; Scale value must be greater than 0.

● If they weren't already rounded, values in the Trim Size or Offset
boxes are rounded to three digits after the decimal.

● If you redisplay the Set Page Geometry dialog box after pressing
OK, the updated values appear and all values have the Workshop
Preferences unit of measure.

Making Entries for Mixed Geometry Pages

If you select more than one PDF page in the Pages pane in Job Manager
and the pages have different geometry values, [mixed] appears in the
Trim Size, Offset, or Scale boxes in the Set Page Geometry dialog box.

Adding and subtracting works slightly differently for mixed pages.

To set geometry for mixed pages perform one of the following actions:

● Type a single value on top of the [mixed]. That value will be applied
to all pages.

● Type an addition or subtraction expression on top of the [mixed].
The amount will be added to or subtracted from the existing values
of the selected pages.

Mixed Geometry Pages: Interpreting Unit of Measure

For Trim Size and Offset boxes, the following table shows valid entries
for mixed pages. It also shows how the system interprets them in cases
where different units were entered or where units are missing. The
system interprets the unit when you press tab.

The values after [mixed] for which no unit was entered will be assigned
the unit specified in Prinergy Workshop Preferences dialog box, unless
a different unit of measure is specified near the [mixed].

374 Chapter 11— Page sets and impositions



Trim Size or Offset Entry After You Press Tab

(For example, Workshop Preferences unit
is inches)

After You Press OK and
Redisplay

(for example, Workshop
Preferences unit is inches)

[mixed] + 23 + 15.5 The unit of measure specified in Workshop
Preferences is applied to all values, for
example, [mixed] + 23in + 15.5in

[mixed]

[mixed] + 25 pt - 2 pt No change [mixed]

[mixed] - 243 pt + 1.525 in No change [mixed]

[mixed] - 23 + 15pt - 20 [mixed] - 23in + 15pt - 20pt [mixed]

[mixed] + 23pt + 15 - 20 [mixed] - 23pt +15pt - 20pt [mixed]

[mixed] - 23 + 15pt - 20 + 12in [mixed] - 23in + 15pt - 20pt + 12in [mixed]

[mixed] mm - 23 + 15 + 72pt [mixed] - 23mm + 15mm + 72pt [mixed]

Example: page offset

Figure 5: Animation Showing the Effect of the Offset Value

When Offset X and Y are set to -0.5 in, the page (red) is repositioned.
The trim box (black) does not move.

Example: page geometry order of operations

You can apply three geometry operations can be applied to PDF pages.
If all three operations are to be applied, the order in which the
operations are performed is offsets, scaling, and orientation/rotation,
as illustrated here:

1. Offsets are applied first.

For example here a page is offset 1 inch in both x and y directions.
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2. Scaling is next, including the same offset amounts as above.

The following page is scaled by 50 percent. The scaling is applied to
both the page and the offset amounts. The offsets are now 0.5
inches.

3. Rotation is last, including the same offset and scale as above.

The following rotation is applied around the lower-left corner of the
page after the offset and scaling. This means the rotation happens
0.5 inches down and left from the original page corner. Thus the
original content can actually end up imaging outside the new page
boundary as shown in the diagram.

90 degrees CW

180 degrees
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90 degrees CCW

Example: page orientation

The Orientation value in the Set Page Geometry Dialog Box rotates
and shifts the page so the lower-left corner is always in the same
position.

Setting page geometry

1. Select the Pages view or Signatures view.

2. In the Pages pane, select one or more pages.

3. From the Edit menu, select Set Page Geometry.

4. In the Set Page Geometry dialog box, enter the desire values.

● If geometry settings were included in Adobe InDesign or
QuarkXPress input files, those values appear in the dialog box.

● If no geometry settings exist, the dialog box displays default
values.

Note: You can enter simple addition and subtraction expressions.
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5. Click OK.

Set Page Geometry dialog box

Trim Size

Sets the horizontal (X) and vertical (Y measurements for the
trim box).

The trim box which is usually displayed as a dotted line, appears
on a proof if the Draw Trim & Bleed Lines check box is selected
on the loose page output process template.

If the trim box appears as other than a dotted line, it may have
been set differently for your system.

You can enter a decimal amount followed by a unit, for
example, 15.2 inches. You can also enter simple addition and
subtraction expressions, for example:

23 + 15 pt

25 pt - 2 pt

243 pt + 1.5 in

Valid units are pt, pts, mm, cm, in, inch, or inches. You can mix
different units. If no units are entered, the unit from Workshop
Preferences dialog box is used. Values are rounded to three
digits after the decimal point.

Offset

Horizontal and vertical offsets position the page in relation to
the lower-left corner of the trim box.

If the offset is set to 0, 0 (X, Y, the lower-left corner of the trim
box and page content are in the same position. Negative X and
Y offsets reposition the page content down and to the left.

You can enter a decimal amount, followed by a unit, for
example, 15.2 inches, or simple addition and subtraction
expressions. For example:

23 + 15 pt

25 pt - 2 pt

243 pt + 1.5 in.

Note: The order of geometry operations is:

1. Offsets
2. Scaling
3. Orientation
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If entries are made for all three operations, offsets are applied before
scaling and orientation.

Scale

Positive number indicating the horizontal (X) and vertical (Y
scaling percentage to apply).

Scaling is performed after offsets have been applied, but before
orientation.

Orientation

Page content is rotated and shifted so the lower-left corner is
positioned at the original point.

Select 0 90 CW (clockwise), 180, or 90 CCW
(counterclockwise).

Orientation is performed after offsets and scaling have been
applied.

Note: You can use addition and subtraction for Trim Size, Offset, and Scale
settings.

Centering pages

About centering pages

The Center Page menu item centers a refined page within its
imposition trim box. It matches the center of the page to the center of
the imposition trim box. You can then use Prinergy Workshop to
reassign pages to different positions in the imposition, and not
experience image shifts because the trim or media box sizes differ from
page to page.

The center of the page is calculated either from the page's trim box or
media box depending on the information available:

● If the refined page includes both trim box and media box
information then the trim box is used to center the page.

● If the refined page includes only media box information then the
media box is used to center the page.

You can use the Center Page menu item to center one or more pages.
You can easily return to the original page offsets using the Use Page
Offsets menu item.

By default, pages are positioned in the imposition trim box by the
lower-left corner of the page's trim or media box, rather than by the
center of the page.
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Note: When you import an imposition, you can indicate whether the pages in the
imported imposition should be centered. If you select Centered, all pages will be
centered. If you then unassign a page and replace it with another page, the
replacement page will also be centered. You can work with the Use Page Offsets,
and Center Page menu items to modify their placement as required.

Centering pages

1. In the Imposition Plans pane of the Signatures view, select the
pages that you want to center.

2. From the Edit menu, select Center Page.

3. To see the results of the change, ensure that the Center Page,
Offset, and Trim Size columns are visible in the Imposition Plans
pane of the Signatures view.

For pages that were centered:

● The Center Page column now displays Centered.
● The Offset column in the Imposition Plans pane of the Signatures

view now displays the centered offset, which is the difference
between the PDF page's media box and the imposition trim box.

For pages that were not centered:

● The Center Page column now displays Not Centered.
● The Offset column in the Imposition Plans pane is the same as the

offset in the Pages pane of the Signatures view, which is the
difference between the PDF page's media box and the page trim
box.

Returning centered pages to their original offsets

1. In the Imposition Plans pane of the Signatures view, select the
pages that you want to return to the original page offsets.

2. From the Edit menu, select Use Page Offsets.

The Offset column in the Imposition Plans pane displays the original
page offsets and the pages are no longer centered. The values in the
Pages pane do not change.

Automated Page Assignment (APA)

About Automated Page Assignment

Automated Page Assignment (APA) is a feature that automatically
assigns processed pages to the page set positions of an imposition
plan. It can also automatically assign geometry to pages.In some cases,
it automatically creates page sets.
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How it works

APA uses a file (with the extension .apa) to map the page positions of
an imposition plan to the file names of the pages that will be assigned
to those positions.

When you import an imposition plan into a job, Prinergy compares the
file names of the pages in the APA file to the file names of actual
processed pages in the job. If the file names match, Prinergy
automatically assigns the pages to the correct page positions of the
imposition plan.

After using APA if you manually assign and unassign pages, the APA
file is not updated with your changes. You can use APA files with
unpopulated imposition plans, populated impositions plans, and Page
Assigner files.

Creating APA Files Manually for Unpopulated Imposition
Plans

You create or import an unpopulated imposition, and then create an
APA file directly in the APA Editor, and then import the unpopulated
imposition. Prinergy automatically assigns the pages to the imposition
plan when you process the pages. Using this method, you can create
one generic imposition plan and reuse it in many Prinergy jobs, rather
than having to create a unique imposition plan for every job.

To create an unpopulated imposition in Preps assign blank pages to the
run list. To create an unpopulated imposition in Pandora do one of the
following:

● Place a dummy PDF (with no content) in the Pandora imposition.

To make the dummy PDF, create a simple box in Illustrator or other
graphics software, and save it as a PostScript file. Process the
dummy PostScript file in Prinergy Workshop into a PDF, open
Pandora, and place the dummy PDF. Save the imposition.

or
● Exclude the pages when exporting a job.

Export a Prinergy job that includes the imposition you want, and in
the export process template, clear Include Pages in Job Exports.
Create a new job and import the compressed file.

Importing Populated Imposition Plans

You can create a populated imposition plan in Preps and import it into
Prinergy Workshop.

Prinergy creates an APA file based on the page assignments in the
imposition plan. Each time you import the imposition plan into the job,
Prinergy adds the page assignment information to the APA file and
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increments the file name to the next version. For example, Job.apa,
Job.v1.apa, Job.v2.apa, and so on. You can use the APA Editor to
modify the APA file to change placeholder names or to use wild cards.

Using this method, you can change the pages without having to go
back to Preps to modify the original imposition.

About the names and location of APA files

Store APA files in the Control folder of the job folder. A Job.apa
file is automatically created in the Control folder in the job folder of
each new job.

The only valid APA filenames are Job.apa, Job.v1.apa,
Job.v2.apa, Job.v3.apa, and so on.

The first or only APA file for a job should be named Job.apa (the J
must be upper-case). To store more than one APA file for a job, include
a version number in the filename, for example, Job.v1.apa,
Job.v2.apa, and so on. APA uses the file with the most recent date
and time, rather than a file with a particular version number.

About geometry assignments

To create an instruction for automatic geometry assignment, add a row
in the Geometry Assignments tab, and then make an entry in each
column in the row. Each row creates one line in the APA file.

For example the following row assigns page geometry settings to the
refined page named Cover.p1.pdf.

Refined file
name

Offset X Offset Y Trim size X Trim size Y Scale X Scale Y Orientatio
n

Cover.p1.pd
f

-36 pt -36 pt 612.0 pt 792.0 pt 100% 100% 0

You can explicitly name the refined filename or use wild cards.

Using geometry settings from the input file

You can assign geometry from one of two sources:

● From parameters set in the APA file.

● From the page. To use this method, enter Mixed in the column for
that parameter in the Geometry Assignments view, such as offsets,
scaling, trim, or orientation.

Note: Some input files may not contain offsets. For example, DCS/EPS files will
not contain offsets. PostScript files generated from a native software application
using the Prinergy Refiner PPD will always contain offsets.
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Unit of measure conversion

For Offset X, Offset Y, Trim Size X, Trim Size Y:

● On the Geometry Assignments tab, you can enter points,
millimeters, centimeters, or inches. Valid unit entries are: pt, pts,
mm, cm, in, inch, or inches.

○ If you don't enter a unit of measure, Prinergy assumes the unit is
the unit set in the Prinergy Workshop Preferences dialog box.

○ If you do enter a unit of measure Prinergy converts it to the unit
of measure set in Prinergy Workshop Preferences dialog box. For
example, if your Workshop Preferences measurement unit is
inch and you enter 72 pt, Prinergy converts it to 1 in.

● On the Raw APA File tab, the unit of measure is always points.

Example 1: Pattern matching

This example shows the use of pattern matching.

The input files, refined files, and desired geometry assignments are:

Input files Book.pdf

Refined files Book.p1.pdf, Book.p2.pdf, Book.p3.pdf

Desired
geometry
assignments

Set the geometry for the pages. Set Offset X and Offset Y to -36
points, Trim X to 612 points, and Trim Y to 792 points. Scaling
is 100% and there is no change in orientation.

In the Geometry Assignments view, the instruction is:

Refined file
name

Offset X Offset Y Trim size X Trim size Y Scale X Scale Y Orientatio
n

.p .pdf -36 pt -36 pt 612.0 pt 792.0 pt 100% 100% 0

In the Raw APA File view, the instruction is:

GEOM= "[$].p[#].pdf" -36.0 -36.0 612.0 792.0 1 1 0

Example 2: Pattern matching and assigning geometry from
input files

This example shows the use of pattern matching and assigning
geometry from input files.

This example is has the same input files, refined files, and desired
geometry assignments as in Example 1, except it uses the trim size
from the input files.

In the Geometry Assignments view, the instruction is:
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Refined file
name

Offset X Offset Y Trim size X Trim size Y Scale X Scale Y Orientatio
n

.p .pdf -.5 in -.5 in Mixed Mixed 100% 100% 0

In the Raw APA File view, the instruction is:

GEOM= "[$].p[#].pdf" -36.0 -36.0 [ ] [ ] 1 1 0

Legend

Match Letters

Match letters (a-z A-Z) in the page filename. For example
.p1.pdf matches filenames Book.p1.pdf, Front matter.p1.pdf,

and JobXYZ.p1.pdf.

You can also specify the number of characters that this wild
card will match.

To verify the number of characters that will be matched, move
the cursor over the icon and check the length that is listed.

Match Digits

Match numbers (0-9) in the page filename. For example .p
.pdf matches filenames 12345.p1.pdf, 05282003.p2.pdf, and

01.p165.pdf..

You can also specify the number of characters that this wild
card will match.

To verify the number of characters that will be matched, move
the cursor over the icon and check the length that is listed.

Match Either

Match letters or numbers (a-z A-Z, 0-9) in the page filename.
For example .p .pdf matches filenames 12345.p1.pdf,
ABCDE.p2.pdf, Book cover99.p76.pdf, Book052803.p205.pdf.

Note: .p .pdf matches the same filenames.

You can also specify the number of characters that this wild
card will match.

To verify the number of characters that will be matched, move
the cursor over the icon and check the length that is listed.

 This Position

Indicates that this part of the page name is the same as the
page position to which the page will be assigned.
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For example if you enter Book.p .pdf, a matching wild card ( )
is inserted in the Position column. Book.p1.pdf is assigned to
position 1, Book.p2.pdf is assigned to position 2, and so on.

 This Page Set

Indicates that this part of the page name is the same as the
name of the page set or page set prefix to which the page will
be assigned.

For example if you enter .p1.pdf, a matching wild card ( ) is
inserted in the Page Set Name/Prefix column. Book.p1.pdf
would be assigned to the Book page set.

 All Page Sets

Assigns the page to the designated page position in all sets in
the job.

See also:
About wild cards and pattern matching in APA on page 398
Workshop Preferences dialog box on page 1036

Examples: APA page assignment

This topic shows APA page assignment examples in the Page
Assignments and Raw APA File views of the APA Editor.

For examples of using page position wild cards, see About Page Set
Position Wild Cards in APA.

Example 1: Using explicit page and page set assignments

This example shows the use of explicit page names, page set names,
and page positions.

The input files, refined pages, and desired page assignments are:

Input file Book.ps

Pages Book.p1.pdf, Book.p2.pdf, Book.p3.pdf

Desired page
assignments

Book.p1.pdf to Book-8up page set, position 1, layer 1

Book.p2.pdf to Book-8up page set, position 2, layer 1

Book.p3.pdf to Book-8up page set, position 3, layer 1

In the Page Assignments view, the instructions are:

Refined file name Page set name/
prefix

Position Layer

Book.p1.pdf Book-8up 1 1
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Refined file name Page set name/
prefix

Position Layer

Book.p2.pdf Book-8up 2 1

Book.p3.pdf Book-8up 3 1

In the Raw APA File view, the instructions are:

ASSIGN= "Book.p1.pdf" Book-8up 1 1

ASSIGN= "Book.p1.pdf" Book-8up 2 1

ASSIGN= "Book.p1.pdf" Book-8up 3 1

Example 2: Using a wild card (*) to name all page sets

This example shows the use of a wild card to assign a page to all page
sets.

The input files, refined pages, and desired page assignments are:

Input files: Book.ps

Refined pages: Book.p1.pdf, Book.p2.pdf, Book.p3.pdf ...

Desired page
assignments:

Book.p1.pdf to all page sets, position 1, layer 1

Book.p2.pdf to all page sets, position 2, layer 1

Book.p3.pdf to all page sets, position 3, layer 1

In the Page Assignments view, the instructions are:

Refined file name Page set name/
prefix

Position Layer

Book.p1.pdf 1 1

Book.p1.pdf 2 1

Book.p31.pdf 3 1

In the Raw APA File view, the instructions are:

ASSIGN= "Book.p1.pdf" "*" 1 1

ASSIGN= "Book.p1.pdf" "*" 2 1

ASSIGN= "Book.p1.pdf" "*" 3 1

Example 3: Using pattern matching

This example shows the use of a wild card as a back reference to the
page position.

The input files, refined pages, and desired page assignments are:

Input files Book.ps
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Refined pages Book.p1.pdf, Book.p2.pdf, Book.p3.pdf

Desired page
assignments

Book.p1.pdf to all page sets, position 1, layer 1.

Book.p2.pdf to all page sets, position 2, layer 1.

Book.p3.pdf to all page sets, position 3, layer 1.

In the Page Assignments view, the instructions are:

Refined file name Page set name/
prefix

Position Layer

Book.p .pdf 1

In the Raw APA File view, the instructions are:

ASSIGN="Book.p[#PgPosition]" "*" [#PgPosition] 1

Example 4: Assigning a two-page reader spread and
pattern matching

This example shows the assignment of pages from a two-page reader
spread input file to page positions.

The input files, refined pages, and desired page assignments are:

Input files Book_005_006.ps, Book_007_008.ps

Refined pages Book_005_006.p1.pdf, Book_005_006.p2.pdf,
Book_007_008.p1.pdf, Book_007_008.p2.pdf

Desired page
assignments

Book_005_006.p1.pdf to all page sets, position 5, layer
1.

Book_005_006.p2.pdf to all page sets, position 6, layer
1.

Book_007_008.p1.pdf to all page sets, position 7, layer
1.

Book_007_008.p2.pdf to all page sets, position 8, layer
1.

In the Page Assignments view, the instructions are:

Refined file name Page set name/
prefix

Position Layer

_ .p1.pdf 1

_ .p1.pdf 1

In the Raw APA File view, the instructions are:

ASSIGN= "[$]_[#PgPosition]_[#].p1.pdf" "*" [#PgPosition] 1

ASSIGN= "[$]_[#]_[#PgPosition].p2.pdf" "*" [#PgPosition] 1
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Example 5: Using pattern matching and multiple conditions

This example shows the use of pattern matching and multiple
conditions.

The input files, refined pages, and desired page assignments are:

Input files Book_001.pdf, Book_002.pdf, 005_Book.pdf,
006_Book.pdf

Refined pages Book_001.p1.pdf, Book_002.p1.pdf, 005_Book.p1.pdf,
006_Book.p1.pdf

Desired page
assignments

Book_001.p1.pdf to all page sets, position 1, layer 1.

Book_002.p1.pdf to all page sets, position 2, layer 1.

005_Book.p1.pdf to all page sets, position 5, layer 1.

006_Book.p1.pdf to all page sets, position 6, layer 1.

In the Page Assignments view, the instructions are:

Refined file name Page set name/
prefix

Position Layer

_ .p1.pdf 1

_ .p1.pdf 1

In the Raw APA File view, the instructions are:

ASSIGN= "[$]_[#PgPosition].p1.pdf" "*" [#PgPosition] 1

ASSIGN= "[#PgPosition]_[$].p1.pdf" "*" [#PgPosition] 1

Example 6: Using pattern matching and specifying the
number of characters to be matched

This example shows the use of pattern matching and specification of
the number of characters to be matched.

The input files, refined pages, and desired page assignments are:

Input files BookA001.pdf, BookB002.pdf, BookC003.pdf

Refined pages BookA001.p1.pdf, BookB002.p1.pdf, BookC003.p1.pdf

Desired page
assignments

BookA001.p1.pdf to all page sets at position 1, layer 1.

BookB002.p1.pdf to all page sets at position 2, layer 1.

BookC003.p1.pdf to all page sets at position 3, layer 1

In the Page Assignments view, the instructions are:

Refined file name Page set name/
prefix

Position Layer

 .p1.pdf 1
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In the Raw APA File view, the instructions are:

ASSIGN= "[%][#PgPosition].p1.pdf" "*" [#PgPosition] 1

Alternatively, you could use these instructions:

Refined file name Page set name/
prefix

Position Layer

 .p1.pdf 1

Note: For this instruction to work, you must specify the number of characters to be
matched by the first wild card. If you don't, the editor will display the second icon
in yellow, to indicate that there is an error. To specify the number of characters to
be matched, enter [$:5] in the Refined Filename column before adding the rest of
the page name. Or, go to the Raw APA File view and add :5 (colon, then a 5) to the
[$] wild card. It should appear as shown in the ASSIGN statement below. The
editor will change your entry to an icon that specifies that five characters are to be
matched. To verify this, move the cursor over the icon and check the length that is
listed.

The alternative instructions in the Raw APA File view are:

ASSIGN= "[$:5][#PgPosition].p1.pdf" "*" [#PgPosition] 1

Example 7: Using math expressions to determine page set
position

This example shows the use of math expressions in the APA file.

The input files, refined pages, and desired page assignments are:

Input files 1_frontcovers.pdf, 2_intro.pdf, 3_chpt_1.pdf, 4_chpt_2.pdf,
5_chpt_3.pdf, 6_chpt_4.pdf, 7_appendix.pdf

Refined pages 1_frontcovers.p1.pdf to 1_frontcovers.p10.pdf

2_intro.p1.pdf ... 2_intro.p38.pdf

3_chpt_1.p1.pdf ... 3_chpt_1.p516.pdf

4_chpt_2.p1.pdf ... 4_chpt_2.p8.pdf

5_chpt_3.p1.pdf ... 5_chpt_3.p30.pdf

6_chpt_4.p1.pdf ... 6_chpt_4.p8.pdf

7_appendix.p1.pdf
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Desired page
assignments

The 10 pages from the 1_frontcovers file assigned to page
positions one to 10.

The 38 pages from the 2_intro file assigned to page
positions 11 to 49.

The 516 pages from the 3_chpt_1 file assigned to page
positions 50 to 566.

The 8 pages from the 4_chpt_2 file assigned to page
positions 567 to 575.

The 30 pages from the 5_chpt_3 file assigned to page
positions 576 to 606.

The 8 pages from the 6_chpt_4 file assigned to page
positions 607 to 615.

The pages from the 7_appendix file assigned to page
positions from 616 on.

This example includes all the page assignment statements for a book
that consists of seven files. The page position is calculated using the
page number from the refined page name plus the number of pages in
each of the preceding files.

In the Page Assignments view, the instructions are:

Refined file name Page set
name/
prefix

Position Layer

1_frontcovers.p .pdf 1

2_intro.p .pdf  +10 1

3_chpt_1.p .pdf  +10+38 1

4_chpt_2.p .pdf  +10+38+516 1

5_chpt_3.p .pdf +10+38+516+8 1

6_chpt_4.p .pdf +10+38+516+8+30 1

7_appendix.p .pdf +10+38+516+8+30+8 1

In the Raw APA File view, the instructions are:

ASSIGN= "1_frontcovers.p[#PgPosition].pdf" "*" [#PgPosition] 1

ASSIGN= "2_intro.p[#PgPosition].pdf" "*" [#PgPosition]+10 1

ASSIGN= "3_chpt_1.p[#PgPosition].pdf" "*" [#PgPosition]+10+38 1

ASSIGN= "4_chpt_2.p[#PgPosition].pdf" "*" [#PgPosition]
+10+38+516 1

ASSIGN= "5_chpt_3.p[#PgPosition].pdf" "*" [#PgPosition]
+10+38+516+8 1

ASSIGN= "6_chpt_4.p[#PgPosition].pdf" "*" [#PgPosition]
+10+38+516+8+30 1
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ASSIGN= "7_appendix.p[#PgPosition].pdf" "*" [#PgPosition]
+10+38+516+8+30+8 1

Legend

Match Letters

Match letters (a-z A-Z) in the page filename. For example
.p1.pdf matches filenames Book.p1.pdf, Front matter.p1.pdf,

and JobXYZ.p1.pdf.

You can also specify the number of characters that this wild
card will match.

To verify the number of characters that will be matched, move
the cursor over the icon and check the length that is listed.

Match Digits

Match numbers (0-9) in the page filename. For example .p
.pdf matches filenames 12345.p1.pdf, 05282003.p2.pdf, and

01.p165.pdf..

You can also specify the number of characters that this wild
card will match.

To verify the number of characters that will be matched, move
the cursor over the icon and check the length that is listed.

Match Either

Match letters or numbers (a-z A-Z, 0-9) in the page filename.
For example .p .pdf matches filenames 12345.p1.pdf,
ABCDE.p2.pdf, Book cover99.p76.pdf, Book052803.p205.pdf.

Note: .p .pdf matches the same filenames.

You can also specify the number of characters that this wild
card will match.

To verify the number of characters that will be matched, move
the cursor over the icon and check the length that is listed.

 This Position

Indicates that this part of the page name is the same as the
page position to which the page will be assigned.

For example if you enter Book.p .pdf, a matching wild card ( )
is inserted in the Position column. Book.p1.pdf is assigned to
position 1, Book.p2.pdf is assigned to position 2, and so on.
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 This Page Set

Indicates that this part of the page name is the same as the
name of the page set or page set prefix to which the page will
be assigned.

For example if you enter .p1.pdf, a matching wild card ( ) is
inserted in the Page Set Name/Prefix column. Book.p1.pdf
would be assigned to the Book page set.

 All Page Sets

Assigns the page to the designated page position in all sets in
the job.

About rules for APA
● Page assignment and geometry assignment instructions are

independent. You can use either or both in an APA file.
● In each page assignment instruction, you can use either the page set

name or the page set prefix name.
● To express page names, you can either specify them explicitly or

use wild cards and pattern matching. For example:

Refined file name Explanation

Front.p1.pdf Names the page explicitly.

.p2.pdf  wild card matches letters in the page name.

.p .pdf  wild card matches letters, then  wild card matches
numbers in the page name.

.p .pdf  wild card matches either letters or numbers.

 wild card matches the page number and uses it as a
back reference to the page position.

● To assign a page to the same position in every page set use a wild
card for the page set name/prefix. For example:

Refined file name Page set name/
prefix

Position Layer

Book.p1.pdf 1 1

● To make a back reference to the page set name page set prefix,
position number, or layer number, use a pattern in the page name.
For example:

Refined file name Page set name/prefix Position Layer

.p1.pdf 1 1

Page.p .pdf pageset1 1

● To indicate page position use simple addition and subtraction
expressions. For example:
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Refined file name Page set name/prefix Position Layer

Cover.p .pdf 8-up  + 25 1

● To assign one page to several positions, use the All Positions (*),
Contiguous (..), and Noncontiguous (,) page position wild cards.
You must type these wild card characters using your keyboard; no
buttons are available. For example:

Refined file name Page set name/prefix Position Layer

6x9Page.p1.pdf OneFileToAllPgPostitions * 1

4x5Page.p1.pdf OneFileToContigRange 1..5 1

4x10Page.p1.pdf OneFileToNonContigRange 5,10,20,30 1

● To use a geometry setting from the input file, include Mixed for that
column in the Geometry Assignments view in the APA Editor. In a
raw APA file, include empty square brackets [ ] for that parameter
in the GEOM= statement.

File Name file.p1.pdf

Offset X -36 pt

Offset Y -36 pt

Trim Size X Mixed

Trim Size Y Mixed

ScaleX 1

ScaleY 1

Orientation 0

● Layer number is relevant only for versioning jobs. The base layer is
layer 1. For non-versioning jobs, type 1.

● Avoid using the characters *, %, #, and $ in filenames. Those are
wild card characters in APA text file syntax.

Legend

Match Letters

Match letters (a-z A-Z) in the page filename. For example
.p1.pdf matches filenames Book.p1.pdf, Front matter.p1.pdf,

and JobXYZ.p1.pdf.

You can also specify the number of characters that this wild
card will match.

To verify the number of characters that will be matched, move
the cursor over the icon and check the length that is listed.
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Match Digits

Match numbers (0-9) in the page filename. For example .p
.pdf matches filenames 12345.p1.pdf, 05282003.p2.pdf, and

01.p165.pdf..

You can also specify the number of characters that this wild
card will match.

To verify the number of characters that will be matched, move
the cursor over the icon and check the length that is listed.

Match Either

Match letters or numbers (a-z A-Z, 0-9) in the page filename.
For example .p .pdf matches filenames 12345.p1.pdf,
ABCDE.p2.pdf, Book cover99.p76.pdf, Book052803.p205.pdf.

Note: .p .pdf matches the same filenames.

You can also specify the number of characters that this wild
card will match.

To verify the number of characters that will be matched, move
the cursor over the icon and check the length that is listed.

 This Position

Indicates that this part of the page name is the same as the
page position to which the page will be assigned.

For example if you enter Book.p .pdf, a matching wild card ( )
is inserted in the Position column. Book.p1.pdf is assigned to
position 1, Book.p2.pdf is assigned to position 2, and so on.

 This Page Set

Indicates that this part of the page name is the same as the
name of the page set or page set prefix to which the page will
be assigned.

For example if you enter .p1.pdf, a matching wild card ( ) is
inserted in the Page Set Name/Prefix column. Book.p1.pdf
would be assigned to the Book page set.

 All Page Sets

Assigns the page to the designated page position in all sets in
the job.

About adding and subtracting page positions in APA

You can specify a page number offset in an APA file. You can enter
simple addition (+) and subtraction (-) expressions in page assignment
instructions in APA files.
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Math expressions are valid with or without spaces.

Note: Geometry assignments do not support addition and subtraction.

In the Page Assignments view, page offsets look like this:

Refined file name Page set name/
prefix

Position Layer

Page.p .pdf Pageset1 1

Page.p .pdf Pageset1  - 50 1

Page.p .pdf Pageset1  + 50 + 30 1

In the Raw APA File view, the same instructions are:

ASSIGN= "Page.p[#PgPosition].pdf" "Pageset1" [#PgPosition] 1

ASSIGN= "Page.p[#PgPosition].pdf" "Pageset1" [#PgPosition] 1

ASSIGN= "Page.p[#PgPosition].pdf" "Pageset1" [#PgPosition] + 50 +
30 1

Example 1

This example includes all the page assignment statements for a book
that consists of seven files. The page position is calculated using the
page number from the page name plus the number of pages in each of
the preceding files.

Refined file name Page set
name/prefix

Position Layer

1_frontcovers.p .pdf 1

2_intro.p .pdf  +10 1

3_chpt_1.p .pdf  +10+38 1

4_chpt_2.p .pdf  +10+38+516 1

5_chpt_3.p .pdf +10+38+516+8 1

6_chpt_4.p .pdf +10+38+516+8+30 1

7_appendix.p .pdf +10+38+516+8+30+8 1

The 10 pages from the 1_frontcovers file are assigned to page positions
one to 10.

The 38 pages from the 2_intro file are assigned to page positions 11 to
48.

The 516 pages from the 3_chpt_1 file are assigned to page positions 49
to 565.

The 8 pages from the 4_chpt_2 file are assigned to page positions 566
to 574.
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The 30 pages from the 5_chpt_3 file are assigned to page positions
575 to 605.

The 8 pages from the 6_chpt_4 file are assigned to page positions 606
to 614.

The pages from the 7_appendix file are assigned to page positions from
616 on.

Example 2

This example includes page assignments for a book that includes the
starting page number in the page names. For example,
Page_28_56.p1.pdf has a starting page number of 28.

The page position can be calculated by adding the starting page
number (for example 01 or 28) and the page number (for example 1
from P1, 2 from P2, 3 from P3, and so on), then subtracting 1. For
example, for page name Page_28_56.p3.pdf, the page position would
be 28 + 3 - 1 = 30.

Refined filenames are as follows:

Page_01_27.p1.pdf

Page_01_27.p2.pdf

Page_01_27.p3.pdf

... Page_01_27.p27.pdf

Page_28_56.p1.pdf

Page_28_56.p2.pdf

Page_28_56.p3.pdf

... Page_28_56.p56.pdf

In the Raw APA File view the instructions to assign the pages would
be:

ASSIGN= [$]_[#Start]_[$].p[#PgPosition].pdf "*" [#Start]+
[#PgPosition] -1 1

One way to add the instruction in the APA Editor is to type the
ASSIGN= statement in the Raw APA File view. If you do that the wild
cards will be correctly named. Alternatively, you can start entering it in
the Page Assignments view and make any required additions or
changes in the Raw APA File view.

In the Page Assignments view, the instruction will look like:

Refined file name Page set name/
prefix

Position Layer

_ _ .p .pdf + -1 1
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If you typed the ASSIGN statement in the Raw APA File view, the 
wild cards have the names Start and PgPosition. You can check the
wild card names by moving the cursor over the wild card icons.

When the APA instruction is executed, the resulting page assignments
will be:

Page_01_27.p1.pdf is assigned to page position 1.

Page_01_27.p2.pdf is assigned to page position 2.

Page_01_27.p3.pdf is assigned to page position 3.

... Page_01_27.p27.pdf is assigned to page position 27.

Page_28_56.p1.pdf is assigned to page position 28 + 1 - 1 = 28.

Page_28_56.p1.pdf is assigned to page position 28 + 2 - 1 = 29.

Page_28_56.p1.pdf is assigned to page position 28 + 3 - 1 = 30.

... Page_28_56.p56.pdf is assigned to page position 28 + 56 -1 = 83.

Legend

Match Letters

Match letters (a-z A-Z) in the page filename. For example
.p1.pdf matches filenames Book.p1.pdf, Front matter.p1.pdf,

and JobXYZ.p1.pdf.

You can also specify the number of characters that this wild
card will match.

To verify the number of characters that will be matched, move
the cursor over the icon and check the length that is listed.

Match Digits

Match numbers (0-9) in the page filename. For example .p
.pdf matches filenames 12345.p1.pdf, 05282003.p2.pdf, and

01.p165.pdf..

You can also specify the number of characters that this wild
card will match.

To verify the number of characters that will be matched, move
the cursor over the icon and check the length that is listed.

Match Either

Match letters or numbers (a-z A-Z, 0-9) in the page filename.
For example .p .pdf matches filenames 12345.p1.pdf,
ABCDE.p2.pdf, Book cover99.p76.pdf, Book052803.p205.pdf.

Note: .p .pdf matches the same filenames.
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You can also specify the number of characters that this wild
card will match.

To verify the number of characters that will be matched, move
the cursor over the icon and check the length that is listed.

 This Position

Indicates that this part of the page name is the same as the
page position to which the page will be assigned.

For example if you enter Book.p .pdf, a matching wild card ( )
is inserted in the Position column. Book.p1.pdf is assigned to
position 1, Book.p2.pdf is assigned to position 2, and so on.

 This Page Set

Indicates that this part of the page name is the same as the
name of the page set or page set prefix to which the page will
be assigned.

For example if you enter .p1.pdf, a matching wild card ( ) is
inserted in the Page Set Name/Prefix column. Book.p1.pdf
would be assigned to the Book page set.

 All Page Sets

Assigns the page to the designated page position in all sets in
the job.

About wild cards and pattern matching in APA

You can reduce the number of instructions in the APA file by using wild
cards and pattern matching.

Wild cards take advantage of similarities in page names. Without wild
cards, you must include a line for each page that you want to assign.
You must also include a line for each page to which you want to assign
geometry settings.

To enter wild cards, use the buttons in the Insert Wild cards area. All
of the buttons are described below.

Note: If you are creating an APA file in a text editor or on the Raw APA File tab,
see About Wild Cards in Raw APA.

Matching letters and digits

Use the Match Letters button , Match Digits button , or the Match
Either button  to match alphabetic characters, numbers, or both.

After inserting the wild cards, you can enter the number of characters
that you want the wild card to match. To verify the number of
characters to be matched, move the cursor over the icon and checking
the length that is listed.
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Assigning to all page sets

Use the All Page Sets button  to assign one or more designated pages
to all page sets in the job. For example:

Refined file name Page set name/
prefix

Position Layer

Job12345.p1.pdf 1 1

The above example assigns Job12345.p1.pdf to layer 1 of the first
position for all page sets in the job.

Back references to page set position

Use the This Position button  to use the page number in the page
name as a back reference to the page position. For example:

Refined file name Page set name/
prefix

Position Layer

Page.p .pdf pageset1 1

For example, you have refined filenames Page.p1.pdf, Page.p2.pdf,
Page.p3.pdf. You can use the page number (1, 2, 3, and so on) as a back
reference to the page position. The system will assign Page.p1.pdf to
page position 1, Page.p2.pdf to position 2, Page.p3.pdf to position 3,
and so on.

You can use simple addition and subtraction expressions in the back
references to positions. For example:

Refined file name Page set name/
prefix

Position Layer

Chapter1.p .pdf 8-up 1

Chapter2.p .pdf 8-up  + 25 1

The above instructions use the page number as a back reference to the
page position. Chapter 1 has 25 pages. An offset of 25 is used to
determine the page assignments for Chapter 2.

Back references to page set name

Use the This Page Set button .

Refined file name Page set name/
prefix

Position Layer

.p .pdf 1

For example, you have page sets called Cover and Inside. You have
refined page names Cover.p1.pdf, Cover.p2.pdf, Cover.p3.pdf,
Inside.p1.pdf, Inside.p2.pdf, and Inside.p3.pdf. Replace the first part of
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the page name with a This Page Set icon. (Add the second icon using
the This Position button.)

The system will assign:

Cover.p1.pdf to position 1 of the Cover page set

Cover.p2.pdf to position 2 of the Cover page set

Cover.p3.pdf to position 3 of the Cover page set

Inside.p1.pdf to position 1 of the Inside page set

Inside.p2.pdf to position 2 of the Inside page set

Inside.p3.pdf to position 3 of the Inside page set

Legend

Match Letters

Match letters (a-z A-Z) in the page filename. For example
.p1.pdf matches filenames Book.p1.pdf, Front matter.p1.pdf,

and JobXYZ.p1.pdf.

You can also specify the number of characters that this wild
card will match.

To verify the number of characters that will be matched, move
the cursor over the icon and check the length that is listed.

Match Digits

Match numbers (0-9) in the page filename. For example .p
.pdf matches filenames 12345.p1.pdf, 05282003.p2.pdf, and

01.p165.pdf..

You can also specify the number of characters that this wild
card will match.

To verify the number of characters that will be matched, move
the cursor over the icon and check the length that is listed.

Match Either

Match letters or numbers (a-z A-Z, 0-9) in the page filename.
For example .p .pdf matches filenames 12345.p1.pdf,
ABCDE.p2.pdf, Book cover99.p76.pdf, Book052803.p205.pdf.

Note: .p .pdf matches the same filenames.

You can also specify the number of characters that this wild
card will match.

To verify the number of characters that will be matched, move
the cursor over the icon and check the length that is listed.
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 This Position

Indicates that this part of the page name is the same as the
page position to which the page will be assigned.

For example if you enter Book.p .pdf, a matching wild card ( )
is inserted in the Position column. Book.p1.pdf is assigned to
position 1, Book.p2.pdf is assigned to position 2, and so on.

 This Page Set

Indicates that this part of the page name is the same as the
name of the page set or page set prefix to which the page will
be assigned.

For example if you enter .p1.pdf, a matching wild card ( ) is
inserted in the Page Set Name/Prefix column. Book.p1.pdf
would be assigned to the Book page set.

 All Page Sets

Assigns the page to the designated page position in all sets in
the job.

About page set position wild cards in APA

You can assign one page to selected page set positions using page
position wild cards. This is particularly useful for folding carton, flexible
packaging, or tag and label printers.

You can assign one page to any of the following:

To assign one page to Use this wild card

All positions All Positions (*)

A contiguous range of positions Contiguous (..)

A noncontiguous range of positions Noncontiguous (,)

Both a contiguous and noncontiguous
range of positions

Any combination of the Contiguous
(..) and Noncontiguous (,)

Entering page set position wild cards

As with other wild cards, you can enter these wild cards using either
the Page Assignments tab or the Raw APA File tab in the APA Editor,
or a text editor.
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If you enter the wild cards on the Page Assignments tab of the APA
Editor:

● Use the Position column.
● Type the wild cards using the keyboard. There are no buttons for

these wild cards.
● When you enter a range, do not put spaces between the numbers

and the wild cards.

If you are creating an APA file on the Raw APA File tab of the APA
Editor or in a text editor:

● Type an asterisk for the page set argument.

Syntax: ASSIGN= "page_name" "*" position_number 1

Example: ASSIGN= "book.p1.pdf" "*" 1 1

This statement assigns the page named book.p1.pdf to the first layer of
the first position number in every page set in the job.

Example 1A: Assigning one page to all page set positions

This example shows the use of the All Positions page set position wild
card (*) to assign one page to all page set positions.

The input files, refined pages, and desired page assignments are:

Input file 6x9Page.ps

Refined pages 6x9Page.p1.pdf

Desired page
assignments

6x9Page.p1.pdf to OneFileToAllPgPositions page set, position 1, layer 1

6x9Page.p1.pdf to OneFileToAllPgPositions page set, position 2, layer 1

6x9Page.p1.pdf to OneFileToAllPgPositions page set, position 3, layer 1

...

In the Page Assignments view, the instructions are:

Refined file
name

Page set name/prefix Position Layer

6x9Page.p1.pdf OneFileToAllPgPositions * 1

Note: The All Positions page set position wild card (*) in the Position column
refers to the asterisk character on your keyboard, not the APA All Page Sets wild
card ( ).

In the Raw APA File view, the instructions are:

!APA 1.0

ASSIGN= "6x9Page.p1.pdf" "OneFileToAllPgPositions" * 1
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Example 1B: Assigning one page to all page set positions in
all page sets

This example shows the use of the All Positions page set position wild
card (*) to assign one page to all page set positions in all page sets.

The input files, refined pages, and desired page assignments are:

Input file 6x9Page.ps

Refined pages 6x9Page.p1.pdf

Desired page
assignments

6x9Page.p1.pdf to all page sets, position 1, layer 1

6x9Page.p1.pdf to all page sets, position 2, layer 1

6x9Page.p1.pdf to all page sets, position 3, layer 1

...

In the Page Assignments view, the instructions are:

Refined file name Page set name/
prefix

Position Layer

6x9Page.p1.pdf * 1

Note: The All Positions page set position wild card (*) in the Position column
refers to the asterisk character on your keyboard, not the APA All Page Sets wild
card ( ).

In the Raw APA File view, the instructions are:

!APA 1.0

ASSIGN= "6x9Page.p1.pdf" "*" * 1

Example 2A: Assigning one page to a contiguous range of
page set positions

This example shows the use of the Contiguous page position wild card
(..) to assign one page to a contiguous range of page set positions.

The input files, refined pages, and desired page assignments are:

Input file 4x5Page.ps

Refined pages 4x5Page.p1.pdf

Desired page
assignments

4x5Page.p1.pdf to OneFileToContigRange page set, position 1, layer 1

4x5Page.p1.pdf to OneFileToContigRange page set, position 2, layer 1

4x5Page.p1.pdf to OneFileToContigRange page set, position 3, layer 1

4x5Page.p1.pdf to OneFileToContigRange page set, position 4, layer 1

4x5Page.p1.pdf to OneFileToContigRange page set, position 5, layer 1

In the Page Assignments view, the instructions are:
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Refined file name Page set name/
prefix

Position Layer

4x5Page.p1.pdf OneFileToContigRang
e

1..5 1

In the Raw APA File view, the instructions are:

!APA 1.0

ASSIGN= "4x5Page.p1.pdf" "OneFileToContigRange" 1..5 1

Example 2B: Assigning one page to a contiguous range of
page set positions in all page sets

This example shows the use of the Contiguous page position wild card
(..) to assign one page to a contiguous range of page set positions in all
page sets.

The input files, refined pages, and desired page assignments are:

Input file 4x5Page.ps

Refined pages 4x5Page.p1.pdf

Desired page
assignments

4x5Page.p1.pdf to all page sets, position 1, layer 1

4x5Page.p1.pdf to all page sets, position 2, layer 1

4x5Page.p1.pdf to all page sets, position 3, layer 1

4x5Page.p1.pdf to all page sets, position 4, layer 1

4x5Page.p1.pdf to all page sets, position 5, layer 1

4x5Page.p1.pdf to all page sets, position 25, layer 1

4x5Page.p1.pdf to all page sets, position 26, layer 1

4x5Page.p1.pdf to all page sets, position 27, layer 1

4x5Page.p1.pdf to all page sets, position 28, layer 1

4x5Page.p1.pdf to all page sets, position 29, layer 1

4x5Page.p1.pdf to all page sets, position 30, layer 1

In the Page Assignments view, the instructions are:

Refined file name Page set name/
prefix

Position Layer

4x5Page.p1.pdf 1..5,25..30 1

In the Raw APA File view, the instructions are:

!APA 1.0

ASSIGN= "4x5Page.p1.pdf" "*" 1..5,25..30 1
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Example 3A: Assigning one page to a noncontiguous range
of page set positions

This example shows the use of the Noncontiguous page set position
wild card (,) to assign one page to a noncontiguous range of page set
positions.

The input files, refined pages, and desired page assignments are:

Input file 4x6Page.ps

Refined pages 4x6Page.p1.pdf

Desired page
assignments

4x6Page.p1.pdf to OneFileToNonContigRange page set position 5, layer 1

4x6Page.p1.pdf to OneFileToNonContigRange page set, position 10, layer 1

4x6Page.p1.pdf to OneFileToNonContigRange page set, position 20, layer 1

4x6Page.p1.pdf to OneFileToNonContigRange page set, position 30, layer 1

4x6Page.p1.pdf to OneFileToNonContigRange page set, position 40, layer 1

4x6Page.p1.pdf to OneFileToNonContigRange page set, position 50, layer 1

In the Page Assignments view, the instructions are:

Refined file
name

Page set name/prefix Position Layer

4x6Page.p1.pdf OneFileToNonContigRange 5,10,20,30,40,50 1

In the Raw APA File view, the instructions are:

!APA 1.0

ASSIGN= "4x6Page.p1.pdf" "OneFileToNonContigRange"
5,10,20,30,40,50 1

Example 3B: Assigning one page to a noncontiguous range
of page set positions in all page sets

This example shows the use of the Noncontiguous page set position
wild card (,) to assign one page to a noncontiguous range of page set
positions in all page sets.

The input files, refined pages, and desired page assignments are:

Input file 4x6Page.ps

Refined pages 4x6Page.p1.pdf
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Desired page
assignments

4x6Page.p1.pdf to all page sets position 5, layer 1

4x6Page.p1.pdf to all page sets, position 10, layer 1

4x6Page.p1.pdf to all page sets, position 20, layer 1

4x6Page.p1.pdf to all page sets, position 30, layer 1

4x6Page.p1.pdf to all page sets, position 40, layer 1

4x6Page.p1.pdf to all page sets, position 50, layer 1

In the Page Assignments view, the instructions are:

Refined file name Page set name/
prefix

Position Layer

4x6Page.p1.pdf 5,10,20,30,40,50 1

In the Raw APA File view, the instructions are:

!APA 1.0

ASSIGN= "4x6Page.p1.pdf" "*" 5,10,20,30,40,50 1

Example 4A: Assigning one page to both a contiguous and
noncontiguous range of page set positions

This example shows the use of the Contiguous (..) and Noncontiguous
(,) page set position wild cards to assign one page to both a contiguous
and noncontiguous range of page set positions.

The input files, refined pages, and desired page assignments are:

Input file 4x10Page.ps

Refined pages 4x10Page.p1.pdf

Desired page assignments 4x10Page.p1.pdf to OneFileToBothRanges page set position 5, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 6, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 7, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 8, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 9, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 10, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 17, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 21, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 27, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 30, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 31, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 32, layer 1

In the Page Assignments view, the instructions are:
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Refined file
name

Page set name/prefix Position Layer

4x10Page.p1.pdf OneFileToBothRanges 5..10,17,21,27,30..32 1

In the Raw APA File view, the instructions are:

!APA 1.0

ASSIGN= "4x10Page.p1.pdf" "OneFileToBothRanges"
5..10,17,21,27,30..32 1

Example 4B: Assigning two pages to both a contiguous and
noncontiguous range of page set positions

This example shows the use of the Contiguous (..) and Noncontiguous
(,) page set position wild cards to assign two pages to both a
contiguous and noncontiguous range of page set positions.

The input files, refined pages, and desired page assignments are:

Input files 4x10Page.ps

5x6Page.ps

Refined pages 4x10Page.p1.pdf

5x6Page.p1.pdf
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Desired page assignments 4x10Page.p1.pdf to OneFileToBothRanges page set, position 5, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 6, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 7, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 8, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 9, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 10, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 17, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 21, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 27, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 30, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 31, layer 1

4x10Page.p1.pdf to OneFileToBothRanges page set, position 32, layer 1

5x6Page.p1.pdf to OneFileToBothRanges page set, position 11, layer 1

5x6Page.p1.pdf to OneFileToBothRanges page set, position 12, layer 1

5x6Page.p1.pdf to OneFileToBothRanges page set, position 13, layer 1

5x6Page.p1.pdf to OneFileToBothRanges page set, position 14, layer 1

5x6Page.p1.pdf to OneFileToBothRanges page set, position 15, layer 1

5x6Page.p1.pdf to OneFileToBothRanges page set, position 16, layer 1

5x6Page.p1.pdf to OneFileToBothRanges page set, position 18, layer 1

5x6Page.p1.pdf to OneFileToBothRanges page set, position 19, layer 1

5x6Page.p1.pdf to OneFileToBothRanges page set, position 20, layer 1

5x6Page.p1.pdf to OneFileToBothRanges page set, position 25, layer 1

5x6Page.p1.pdf to OneFileToBothRanges page set, position 29, layer 1

In the Page Assignments view, the instructions are:

Refined file
name

Page set name/
prefix

Position Layer

4x10Page.p1.pdf OneFileToBothRanges 5..10,17,21,27,30..32 1

5x6Page.p1.pdf OneFileToBothRanges 11..16,18..20,25,29 1

In the Raw APA File view, the instructions are:

!APA 1.0

ASSIGN= "4x10Page.p1.pdf" "OneFileToBothRanges"
5..10,17,21,27,30..32 1

ASSIGN= "5x6Page.p1.pdf" "OneFileToBothRanges"
11..16,18..20,25,29 1
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Example 4C: Assigning one page to both a contiguous and
noncontiguous range of page set positions in all page sets

This example shows the use of the Contiguous (..) and Noncontiguous
(,) page set position wild cards to assign one page to both a contiguous
and noncontiguous range of page set positions in all page sets.

The input files, refined pages, and desired page assignments are:

Input file 4x10Page.ps

Refined pages 4x10Page.p1.pdf

Desired page
assignments

4x10Page.p1.pdf to all page sets, position 5, layer 1

4x10Page.p1.pdf to all page sets, position 6, layer 1

4x10Page.p1.pdf to all page sets, position 7, layer 1

4x10Page.p1.pdf to all page sets, position 8, layer 1

4x10Page.p1.pdf to all page sets, position 9, layer 1

4x10Page.p1.pdf to all page sets, position 10, layer 1

4x10Page.p1.pdf to all page sets, position 17, layer 1

4x10Page.p1.pdf to all page sets, position 21, layer 1

4x10Page.p1.pdf to all page sets, position 27, layer 1

4x10Page.p1.pdf to all page sets, position 30, layer 1

4x10Page.p1.pdf to all page sets, position 31, layer 1

4x10Page.p1.pdf to all page sets, position 32, layer 1

In the Page Assignments view, the instructions are:

Refined file name Page set
name/prefix

Position Layer

4x10Page.p1.pdf 5..10,17,21,27,30..32 1

In the Raw APA File view, the instructions are:

!APA 1.0

ASSIGN= "4x10Page.p1.pdf" "*" 5..10,17,21,27,30..32 1

About creating raw APA

If you are creating an APA file in a text file or in the Raw APA File view
of the APA Editor, the syntax must confirm to some basic rules.

APA syntax in text files

When creating an APA file:

● Start the file with the header !APA 1.0.
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● Use exclamation marks to add comments to the file. APA ignores
the entire contents of any line that begins with an exclamation
mark.

● In each statement, do the following:

○ Separate the identifier (ASSIGN= or GEOM=) and the first
parameter with tabs and spaces.

○ Use double quotes to enclose parameters contain blanks.
(Parameters are listed below.) Even if you do not use blanks, we
recommend that you enclose most parameters in double quotes.

○ Separate parameters with tabs and spaces.
○ End the line with CR-LF (DOS), CR (Mac OS), or LF (The Open

Group UNIX). You can use a mixture of these characters in the
same APA file.

ASSIGN statement

The ASSIGN statement contains instructions for assigning pages to
page positions. You can use either page set name or page set prefix in
the ASSIGN statement.

!APA 1.0

! This is a comment line.

ASSIGN= page_name page_set_name position_number layer_number

The following table describes the parameters in the ASSIGN statement.

Parameters Description

page_name Name of the refined file, for example, "Book.p1.pdf" .

Either name the page explicitly or use wild cards and pattern matching.

page_set_name

Or

page_set_prefix

You can use either the name or the prefix.

Name of a page set in the job for example, "Book-8up" or "pageset1".

Name of a page set prefix in the job for example "p", "q", "r".

You can:

● Name the prefix explicitly.
● Use a wild card ("*") to assign the page to the designated position in all page

sets.
● Name a pattern in the page name then use it as a back reference to the page set

name or page set prefix.
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Parameters Description

position_number Position to which the page should be assigned in the page set for example, 1, 2, 3.

You can:

● Name the position number explicitly.
● Name a pattern in the page name then use it as a back reference to the position

number.

You can enter simple addition and subtraction expressions for the position number.
For example:

ASSIGN= "Page.p[#PgPos]" "p" [#PgPos]+25 1

layer_number Number of the layer to which the page should be assigned for example, 1, 2, 3. The
base layer is 1. This value is relevant only in versioning jobs. For non-versioning jobs,
use 1.

GEOM statement

The GEOM statement assigns geometry settings to pages.

!APA 1.0

! This is a comment line.

GEOM= page_name offsetX offsetY trimX trimY scaleX scaleY
orientation

The following table describes the parameters in the GEOM statement.

Parameters Description

page_name Name of the refined file, for example, "Book.p1.pdf" .

You can name it explicitly or use wild cards and pattern matching.

offsetX Positions the content horizontally in relation to the lower-left corner of the trim box
for the position. A negative number repositions the content to the left of the lower-
left corner. The offset is measured in points.

offsetY Positions the content vertically in relation to the lower-left corner of the trim box for
the position. A negative value repositions the content down from the lower-left
corner. The offset is measured in points.

trimX X (horizontal) trim size in points

trimY Y (vertical) trim size in points

scaleX Horizontal scaling relative to 1.0. 1.0 = 100%, .5 = 50%, ...

scaleY Vertical scaling relative to 1.0. 1.0 = 100%, .5 = 50%, ...

orientation Number of degrees that the image should be rotated. Must be 0 (no rotation), 90
CW (clockwise), 180, 90 CCW (counter-clockwise, or mixed (retain the original
orientation from the PDF).
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About wild cards in raw APA

You can use wild cards and pattern matching when you create an APA
file in a text file or in the Raw APA File view of the APA Editor.

The wild cards to match page names are:

● * or % match letters (A-Z, a-z)

Example Matches

"*.p1.pdf"

Or

"[%].p1.pdf"

book.p1.pdf, brochure.p1.pdf, and so on.

If enclosed in quotation marks matches book
cover.p1.pdf, Acme brochure.p1.pdf, and so on.

● [#] matches numbers (0-9)

Example Matches

"Book.p[#].pdf"

or

[#].p[#].pdf

Book.p1.pdf, book.p2.pdf, book.p3.pdf, and so on.

19823.p1.pdf, 9800.p1.pdf, 20030131.p1,pdf

● [$] matches letters or numbers (A-Z, a-z, 0-9)

Example Matches

"[$].p1.pdf" book.p1.pdf, brochure.p1.pdf, 12345.p1.pdf,
abc010103.p1.pdf, and so on.

● Adding a colon after #, %, or $ and then a number matches an exact
number of characters to the wild card

Example Matches

"[$:6][#].p1.pdf" BookA01.p1.pdf BookB02.p1.pdf, BookC03.p1.pdf, and
so on.

Note: "[$:5][#].p1.pdf" would give the same results because APA ignores the
zero.

Pattern matches can also be named and then used as a back reference
to the page set name, page set prefix, position number, and layer
number.

About named patterns as back references in raw APA

You can create named patterns as back references when you create an
APA file in a text file or in the Raw APA File view of the APA Editor.
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You can name a pattern and use the pattern as a back reference to
another parameter, including a:

● Page set name
● Page set prefix
● Position number
● Layer number

To name a pattern, include a name after the wild card and within the
square brackets, for example [#PagePosition] or [%Prefix]. You can
use any name you want, but it can be helpful to those reading the APA
file if the name identifies or relates to the information contained in the
pattern (that is page position, page set name, page set prefix, or layer
number) .

For example, "Book.p[#].pdf" could be used in the APA file to refer to
the page names Book.p1.pdf, Book.p2.pdf, Book.p3.pdf, and so on. The
numbers 1, 2, 3, and so on in the page names may correspond to the
page position numbers to which the pages will be assigned in the page
set (that is, Book.p1.pdf is assigned to page position number 1,
Book.p2.pdf is assigned to page position number 2, and so on). The
pattern can be named, for example [#PagePosition], and the named
pattern can be used as a back reference to the position number in the
ASSIGN statement.

Note: The APA Editor always uses [#PagePosition] to name a pattern used as a
back reference to the position number.

To use a named pattern as a back reference, use the pattern in place of
the relevant parameter in the ASSIGN statement. Remove any
character-count specifiers-for example, if the named pattern is
[%Prefix:2], the back reference is [%Prefix].

For example, this ASSIGN statement assigns all pages that match the
pattern to the corresponding page position in the page set named
Book-8up, that is, Book.p1.pdf to position 1, Book.p2.pdf to position 2,
and so on.

ASSIGN= "Book.p[#PgPosition].pdf" "Book-8up" [#PgPosition] 1

For example, this ASSIGN statement assigns all pages that match the
pattern to the corresponding page position in the corresponding page
set, for example, Inside.p1.pdf to position 1 in the Inside page set,
Inside.p2.pdf to position 2 in the Inside page set, Cover.p1.pdf to
position 1 in the Cover page set, Cover.p2.pdf to position 2 in the Cover
page set, and so on.

ASSIGN= "[$PageSet]-P[#PgPosition].p"
"[$PageSet].p[#PgPosition].pdf" "[$PageSet]" [#PgPosition] 1
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Adding and subtracting with named patterns and back
references

In many cases it is convenient to be able to specify a page number
offset in an APA file. Both addition (+) and subtraction (-) are
supported.

The following are all valid ASSIGN statements:

ASSIGN= "Page.p[#PgPosition].pdf" "*" [#PgPosition] 1

ASSIGN= "Page.p[#PgPosition].pdf" "*" [#PgPosition] - 50 1

ASSIGN= "Page.p[#PgPosition].pdf" "*" [#PgPosition] + 50 + 30 1

ASSIGN= "Page[#Num].p[#PgPosition].pdf" "*" [#Num] +
[#PgPosition] + 50 1

The rules are:

● Pattern-matching must use the # character.
● Math expressions are valid with or without spaces.

For example the following two expressions are treated the same:

[#Num]-24

[#Num] - 24

● Math operations are not supported for the GEOM statement.

This example include all page assignments for a book consisting of
seven files. The page position is calculated using the page number from
the page name ([#PgPosition]) plus the number of pages in each of the
preceding files.

ASSIGN= "1_frontcovers.p[#PgPosition].pdf" "*" [#PgPosition] 1

ASSIGN= "2_intro.p[#PgPosition].pdf" "*" [#PgPosition]+10 1

ASSIGN= "3_chpt_1.p[#PgPosition].pdf" "*" [#PgPosition]+10+38 1

ASSIGN= "4_chpt_2.p[#PgPosition].pdf" "*" [#PgPosition]
+10+38+516 1

ASSIGN= "5_chpt_3.p[#PgPosition].pdf" "*" [#PgPosition]
+10+38+516+8 1

ASSIGN= "6_chpt_4.p[#PgPosition].pdf" "*" [#PgPosition]
+10+38+516+8+30 1

ASSIGN= "7_appendix.p[#PgPosition].pdf" "*" [#PgPosition]
+10+38+516+8+30+8 1

The 10 pages from the 1_frontcovers file are assigned to page positions
one to 10.

The 38 pages from the 2_intro file are assigned to page positions 11 to
49.
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The 516 pages from the 3_chpt_1 file are assigned to page positions 50
to 566.

The 8 pages from the 4_chpt_2 file are assigned to page positions 567
to 575.

The 30 pages from the 5_chpt_3 file are assigned to page positions
576 to 606.

The 8 pages from the 6_chpt_4 file are assigned to page positions 607
to 615.

The pages from the 7_appendix file are assigned to page positions 616
on.

This example includes page assignments for a book that includes the
starting page number in its page names. The page position is
calculated by adding the starting page number [#Start] and the page
number from the page name [#PgPosition] and then subtracting 1.
Page names are as follows:

Page_01_27.p1.pdf ... Page_01_27.p27.pdf

Page_28_56.p1.pdf ... Page_28_56.p56.pdf

ASSIGN= [$]_[#Start]_[$].p[#PgPosition].pdf "*" [#Start]+
[#PgPosition] -1 1

Page_01_27.p1.pdf assigned to page position 1.

Page_01_27.p2.pdf assigned to page position 2...

...Page_01_27.p27.pdf assigned to page position 27.

Page_28_56.p1.pdf assigned to page position 28 + 1 - 1 = 28.

Page_28_56.p1.pdf assigned to page position 28 + 2 - 1 = 29.

Page_28_56.p1.pdf assigned to page position 28 + 3 - 1 = 30...

...Page_28_56.p56.pdf assigned to page position 28 + 56 -1 = 83.

Creating or editing APA files in the APA editor

1. From the Tools menu, select Automated Page Assignment Editor.

2. If you want to edit an existing APA file, from the File menu, select
Open APA File. In the Open APA File dialog box, browse to and
select the APA file that you want to open, and then click Open.

3. In the APA Editor, perform one of the following actions:

○ On the Page Assignments tab, add instructions.

For each instruction, click Add and then type values in each
column of the row or accept the default values. For information
about the columns, see Automated Page Assignment Editor.

○ Click the Geometry Assignments tab, and add instructions.
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For each instruction, click Add and then type values in each
column of the row or accept the default values. For information
about the columns, see Automated Page Assignment Editor.

○ If you know and want to use APA file syntax, click the Page
Assignments tab. Either enter the syntax directly and the APA
Editor will interpret your entries, or type ASSIGN statements
directly in the Raw APA File view.

4. From the Edit menu, select Simplify Duplicate Rows.
The APA Editor removes:

● Any row that performs the same page assignment as any other
row.

● Any explicit instructions that are covered by new wild card
instructions.

5. From the File menu, select Save APA File as.

6. In the Save APA File As dialog box, browse to and select the
Control folder of the job folder to which you want to apply the
APA file.

7. In the Save APA File As dialog box, type a name for the APA file.

Valid filenames are Job.apa, Job.v1.apa, Job.v2.apa, and
so on.

Each time you save using the Save APA File menu option, the
system saves a new version and increments the version number in
the file name.

8. Click Save.

9. Enable APA in a process template.

Creating or editing APA files in a text editor

1. Open a text editor.

Use an editor that supports Unicode or ASCII coding, for example,
Windows Notepad or WordPad on a Windows-based computer or
BBEdit on a Macintosh computer.

2. In the first line of the file, type !APA 1.0.

3. Type one or more statements, following the guidelines in Creating
Raw APA.

4. If you want to enter a comment, start the line with an exclamation
mark.

5. Save the file with an APA filename.

Valid filenames are Job.apa, Job.v1.apa, Job.v2.apa, and
so on.

6. Locate the file in the Control folder of the job folders.

7. Enable APA in a process template.
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Enable APA in process templates
You can enable APA at one of two stages of the workflow.

● Change the refine process template by enabling the Impose section
and selecting one of the Automated Page Assignment options in it.

You can do this in many ways, including:

○ Creating a new refine process template and enabling APA in it.
○ Temporarily changing an existing refine process template by

editing it from the Start Process dialog box and enabling APA.
○ Permanently changing an existing refine process template by

enabling APA.

● Change the Import process template by selecting Do Auto Page
Assignment After Unpopulated Imposition Import while you
import an imposition.

CAUTION: Do not select this check box unless you have an APA file with the
assignments that you want applied to the selected page set. Otherwise,
existing assignments are deleted. When you select this check box, Prinergy
also automatically assign pages that were refined before an imposition import
(before a page set is created).

See also:
Creating process templates on page 185
Modifying process templates on page 187
Temporarily modifying process templates on page 187
Refine process template on page 201
Importing impositions on page 355

Automated Page Assignment Editor

Page Assignments

Use this tab to create instructions that assign pages to the page
positions of a page set and imposition plan. Add a row and then make
entries in all columns for the row. Each row creates one line in the APA
file.

Additions or changes made in this view are automatically displayed in
the other views, and vice versa.

You can explicitly name the page filename, page set name/prefix
name, page set position, and layer, or use wild cards.

Refined Filename

Name of the refined file to which you want to assign geometry.
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You can state the filename explicitly for example,
Book.p1.pdf, or use wild cards.

Page Set Name/Prefix

The name of the page set or page set prefix to which you want
to assign pages.

You can state the page set name or page set prefix name
explicitly-for example 8PageLayout (page set name) or p, q, r
(page set prefix name)-or you can use wild cards.

You can use this button to assign a page to the same page
position in all page sets.

Position

The page position of the page set to which the page will be
assigned. You can state the page position explicitly-for
example, 1, 2, 3-or you can use a wild card.

You can also enter simple addition and subtraction expressions
in the Position column, for example:

● Refined Filename: Page.p .pdf
● Page Set Name/Prefix: p
● Page Set Position:  + 50
● Layer: 1

You can also assign one page to several page set positions
using the following page position wild cards:

● All Positions (*): Assigns one page to all page set positions.
● Contiguous (..): Assigns one page to a contiguous range of

page set positions.
● Noncontiguous (,): Assigns one page to a noncontiguous

range of page set positions.

Note: There are no buttons for the page position wild cards. Use your
keyboard to type the wild card character.

Layer

The layer of the page position to which the page will be
assigned for example, 1, 2, 3.

The layer number is relevant only in versioning jobs. The base
layer is 1. Use 1 as the layer number for non-versioning jobs.

Move Rows

The Add button adds a new row below the currently selected
row.
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The Remove button removes the currently selected row

The Move Down button moves the currently selected row down
in the list.

The Move Up button moves the currently selected row up in the
list.

Insert Wild Cards

Use the buttons in this area to create wild cards that assign
settings to multiple files instead of explicitly naming each file.

Match Letters 

Match letters (a-z A-Z in the page filename. For example
.p1.pdf matches filenames Book.p1.pdf, Front matter.p1.pdf,

and JobXYZ.p1.pdf.

You can also specify the number of characters that this wild
card will match.

To verify the number of characters that will be matched, move
the cursor over the icon and check the length that is listed.

Match Digits 

Match numbers (0-9) in the page filename. For example .p
.pdf matches filenames 12345.p1.pdf, 05282003.p2.pdf, and

01.p165.pdf.

You can also specify the number of characters that this wild
card will match.

To verify the number of characters that will be matched, move
the cursor over the icon and check the length that is listed.

Match Either 

Match letters or numbers (a-z A-Z, 0-9) in the page filename.
For example .p .pdf matches filenames 12345.p1.pdf,
ABCDE.p2.pdf, Book cover99.p76.pdf, Book052803.p205.pdf.

Note: .p .pdf matches the same filenames. You can also specify the
number of characters that this wild card will match.

To verify the number of characters that will be matched, move the cursor
over the icon and check the length that is listed.

This Position 

Indicates that this part of the page name is the same as the
page position to which the page will be assigned.
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For example if you enter Book.p .pdf, a matching wild card ( )
is inserted in the Position column. Book.p1.pdf is assigned to
position 1, Book.p2.pdf is assigned to position 2, and so on.

This Page Set 

Indicates that this part of the page name is the same as the
name of the page set or page set prefix to which the page will
be assigned.

For example if you enter .p1.pdf, a matching wild card ( ) is
inserted in the Page Set Name/Prefix column. Book.p1.pdf
would be assigned to the Book page set.

All Page Sets 

Assigns the page to the designated page position in all sets in
the job.

Geometry Assignment

Use this tab to create a geometry assignment instruction. Add a row
and then make an entry in each column in the row. Each row creates
one line in the APA file.

For example the following row assigns page geometry settings to the
refined page named Cover.p1.pdf.

Refined
Filename

Offset X Offset Y Trim Size
X

Trim Size
Y

Scale X Scale Y Orientation

Cover.p1.pdf -36 pt -36 pt 612.0 pt 792.0 pt 100% 100% 0

Additions or changes made in this view are automatically displayed in
the other views, and vice versa.

Refined Filename

Name of the refined file to which you want to assign geometry.

You can state the filename explicitly for example,
Book.p1.pdf, or use wild cards.

Offset X

Position of the PDF page horizontally in relation to the lower-
left corner of the trim box for the imposition page position.

A negative Offset X repositions the page content to the left of
the lower-left corner.

Enter Mixed to retain the original Offset X from the PDF page).
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Offset Y

Position of the PDF page vertically in relation to the lower-left
corner of the trim box for the imposition page position.

A negative Offset Y repositions the page content below the
lower-left corner.

Enter Mixed to retain the original Offset Y from the PDF page).

Trim Size X

X (horizontal) trim size.

Mixed, which is the default, retains the original Trim Size X from
the PDF.

Trim Size Y

Y (vertical) trim size.

Mixed, which is the default, retains the original Trim Size Y from
the PDF.

Scale X

Horizontal scaling, as a percentage.

Enter Mixed to retain the original Scale X from the PDF.

Scale Y

Vertical scaling, as a percentage.

Enter Mixed to retain the original Scale Y from the PDF.

Orientation

Number of degrees to rotate the page. Select one of the
following options:

● 0 (no rotation)
● 90 CW (clockwise)
● 180
● 90 CCW (counter-clockwise)
● Mixed

Mixed retains the original Orientation from the PDF.

Move Rows

The Add button adds a new row below the currently selected
row.

The Remove button removes the currently selected row
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The Move Down button moves the currently selected row down
in the list.

The Move Up button moves the currently selected row up in the
list.

Insert Wild Cards

Use the buttons in this area to create wild cards that assign
settings to multiple files instead of explicitly naming each file.

Match Letters 

Match letters (a-z A-Z in the page filename. For example
.p1.pdf matches filenames Book.p1.pdf, Front matter.p1.pdf,

and JobXYZ.p1.pdf.

You can also specify the number of characters that this wild
card will match.

To verify the number of characters that will be matched, move
the cursor over the icon and check the length that is listed.

Match Digits 

Match numbers (0-9) in the page filename. For example .p
.pdf matches filenames 12345.p1.pdf, 05282003.p2.pdf, and

01.p165.pdf.

You can also specify the number of characters that this wild
card will match.

To verify the number of characters that will be matched, move
the cursor over the icon and check the length that is listed.

Match Either 

Match letters or numbers (a-z A-Z, 0-9) in the page filename.
For example .p .pdf matches filenames 12345.p1.pdf,
ABCDE.p2.pdf, Book cover99.p76.pdf, Book052803.p205.pdf.

Note: .p .pdf matches the same filenames. You can also specify the
number of characters that this wild card will match.

To verify the number of characters that will be matched, move the cursor
over the icon and check the length that is listed.

Raw APA File

Displays the APA file as it would appear if you opened it in a
text editor. You can also use this view to copy or paste portions
of other APA files. The instructions that appear in this view are
written to an .apa file in the Control folder of the job folder.
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Additions or changes made in this view are automatically
displayed in the other views, and vice versa.

Open APA File dialog box

Unlabeled list and results area

Selecting an item in the list at the top left of the dialog box
displays that item's contents in the box below.

When you select:

● Volumes, the volumes in your system appear
● A volume name, folders at the root of the selected volume

appear
● A folder name, files within the folder appear

The path of the displayed item in the list appears in reverse
order, for example, folder name followed by volume name.

Show Hidden Files

Select this check box to include hidden files, such as system
files, in the results.

You can set the default selection of this check box on the View
tab of the Workshop Preferences dialog box.

Volumes

Displays all volumes in the Prinergy system.

Job Folder

Opens the job folder for the current job.

Save APA File as dialog box

Unlabeled list and results area

Selecting an item in the list at the top left of the dialog box
displays that item's contents in the box below.

When you select:

● Volumes, the volumes in your system appear
● A volume name, folders at the root of the selected volume

appear
● A folder name, files within the folder appear

The path of the displayed item in the list appears in reverse
order, for example, folder name followed by volume name.
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Show Hidden Files

Select this check box to include hidden files, such as system
files, in the results.

You can set the default selection of this check box on the View
tab of the Workshop Preferences dialog box.

Save APA File as

Saves a new APA file to the location that you specify with a file
name that you specify.

APA files must be stored in the <job folder>\Control
folder for the job to which you want to apply the APA files.

The only valid file names are Job.apa, Job.v1.apa, Job.v2.apa,
Job.v3.apa, and so on.

Volumes

Displays all volumes in the Prinergy system.

Job Folder

Opens the job folder for the current job.

Menus in Automated Page Assignment Editor

Workshop menu in APA Editor

Note: This menu is available only when running Prinergy Workshop on a
Macintosh client.

About Prinergy Workshop

Displays information about Prinergy Workshop, including the
version number, a list of licensed features, and the server name.

Preferences

Use to view and modify Prinergy Workshop preferences. When
you select this menu item, the Workshop Preferences dialog
box appears.

Note: On a Windows client, this menu item appears under the Edit menu.
On a Macintosh client, it appears under the Workshop menu.

Quit / Quit Prinergy Workshop

Quits Prinergy Workshop. Any open Prinergy Workshop
windows are closed.
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File menu in APA Editor

New APA File

Removes the APA file that you are currently working on and
creates a new APA file.

Important: If you want to save your work to an open APA file you must
do so before selecting New APA File.

Open APA File

Opens an existing APA File.

When you select Open APA File, the Open APA file dialog box
appears. From there, you can browse to and select the APA file
that you want to open, and then click Open.

Save APA File

Saves the open APA file in its current location and increments
the filename by one version. For example Job.v1.apa,
Job.v2.apa, and so on.

Save APA File as

Saves a new APA file to the location that you specify with a file
name that you specify.

APA files must be stored in the <job folder>\Control
folder for the job to which you want to apply the APA files.

The only valid file names are Job.apa, Job.v1.apa, Job.v2.apa,
Job.v3.apa, and so on.

Close Window

Closes the current window, but does not quit Prinergy
Workshop.

Edit menu in APA Editor

Cut

This menu item is unavailable.

Copy

This menu item is unavailable.

Paste

This menu item is unavailable.
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Cut Rows

Select one or more rows then use Cut Rows to remove the
rows.

Copy Rows

Select one or more rows then use Copy Rows to copy the rows.

Paste Rows

Select Paste Rows to paste one or more rows that were
previously copied or cut.

Insert Blank Row

Select Insert Blank Row to add a blank row below the current
row.

Delete Rows

Select one or more rows then use Delete Rows to remove the
rows.

Simplify Duplicate Rows

Select Simplify Duplicate Rows to remove an instruction that
performs the same assignment as another instruction. For
example, if you add an instruction with wild cards, select
Simplify Duplicate Rows to remove any instructions with
explicit names that are now covered by the wild card
instruction. Any instruction that remains after the rows are
simplified performs a different assignment than any other
remaining instruction.

Select All (unavailable)

View menu in APA Editor

Refresh

Updates the contents of the current window.

Tools menu in APA Editor

Change User

Displays the Connect to Server dialog box where you can log in
as another user without quitting Prinergy Workshop.

This menu item appears only if you have Kodak Prinergy
Business Link software connected to the Prinergy system.

426 Chapter 11— Page sets and impositions



Job Finder

Opens Job Finder.

If you are already in Job Finder, this menu item is unavailable.

Destroy History Entries

In the History view, select one or more history entries and then
use Destroy History Entries to delete the selected entries.

Process Template Editor

Launches Process Template Editor, where you can create and
modify process templates.

Automated Page Assignment Editor

Starts the Automated Page Assignment Editor, which you use
to create and check APA files.

Queue Manager

Launches Queue Manager, where you can view the Job Ticket
Processors (JTPs) and process types.

Media Manager

Launches Media Manager, where you can manage your archive
tapes and disk volumes.

System History

Launches System History, which displays the detailed history of
all the activity occurring outside of job context (such as jobs
and groups that were created or destroyed), as well as job
archive, purge, and retrieve history.

Smart Hot Folder Manager

Launches the Smart Hot Folder Manager dialog box, where you
can add, edit and delete smart hot folders.

Configure Imposition Application

Displays the Configure Imposition Applications dialog box,
where you can identify the location of imposition software that
you want to integrate with Prinergy Workshop.

Start Imposition Application

Displays the Start Imposition Application dialog box, where you
choose which imposition software to start. You create this list
of imposition applications with the Configure Imposition
Application tool from the Tools menu. If an application requires
a license and is licensed, it appears in bold.
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Color Editor

Launches Color Editor, where you can create color recipes for
all jobs.

Color Space Editor

Launches Color Space Editor, where you can create and edit
color spaces.

Font Converter

Launches Font Converter, where you can convert font files into
PFA (Printer Font ASCII) format, which Prinergy requires to
correctly process fonts.

Preflight Profile Manager

Launches Preflight Profile Manager, where you can, during the
refine process, evaluate PDFs to detect problems that may
affect processing in a publishing or prepress workflow.

Digital Print Administration Console

Launches the Digital Print Administrator, where you can add
and configure a digital print application that Prinergy can launch
to print PDFs.

Rule Set Manager

Opens the Rule Set Manager, where you can create and edit
rule sets. The Rule Set Manager also lets you organize rule sets
into groups.

Activate Rule Set in Selected Jobs

Opens the Select Rule Set dialog box, where you can activate
rule sets for one or more jobs.

Help menu in APA Editor

Online help

Starts your Web browser and displays the Prinergy online help.

On <current window or view>

Starts your Web browser and displays the Prinergy Workshop
user guide, open to the topic for the currently selected window
or view.

Quick Start Guide

Starts Adobe Acrobat and displays a PDF file of the Prinergy
Connect Quick Start Guide

428 Chapter 11— Page sets and impositions



eCentral Online Support

Starts your Web browser and displays the eCentral portal at 
https://ecentral.kodak.com/.

Visit graphics.kodak.com

Starts your Web browser and displays the Kodak Web site at 
http://graphics.kodak.com/default.htm.

About Prinergy Workshop

Displays information about Prinergy Workshop, including the
version number, a list of licensed features, and the Prinergy
server name.

Note: This menu item appears on the Help menu only when you are
running Prinergy Workshop on a Windows-based client computer. On a
Macintosh client computer, the menu item About Workshop appears on
the Workshop menu.

Keyboard shortcuts in APA Editor

Macintosh Keyboard
Shortcut

Windows Keyboard
Shortcut

Description

 + A Ctrl + A Select all.

 + C Ctrl + C Copy selection.

 + Shift + C CTRL+ Shift+ C Copy entire line.

 + D Ctrl + D Delete rows.

 + I Ctrl + I Insert blank row.

 + N Ctrl + N New APA file.

 + O Ctrl + O Open APA file.

 + R Ctrl + R Refresh the view.

 + S Ctrl + S Save APA file.

 + V Ctrl + V Paste selection.

 + Shift + V CTRL+ Shift+ V Paste entire line.

 + W Ctrl + W Close window.

 + X Ctrl + X Cut selection.

 + Shift + X Ctrl + Shift + X Cut entire row.
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Ganging
Gang pages or impositions from different jobs to save makeready,
plate, setup, and washup costs. Ganging is the act of combining pages
from different jobs or impositions onto one press sheet.

If you use Kodak Preps imposition software, take advantage of page
aliasing to help you manage ganged pages.

Identifying source pages and page aliases
If you use Preps to gang Prinergy pages, page aliases--instead of
copies--are created in the ganged job to help you manage changes.

Page aliases are links that are created from the original page to the
ganged job. Page aliases provide many benefits over copies, and are
automatically created when the populated imposition is imported into
Prinergy from Preps.

Benefits of page aliases

Page aliases provide the following benefits:

● Page aliases save file space because pages are not duplicated.
● Page edits are easily managed--for example:

○ If a page's contents are updated, when output, the alias
automatically picks up the latest updates of the original. There's
no need to duplicate the updated content to the alias.

Note: This benefit applies to simple updates only—for example, text
changes. Some changes, such as changes to the number of inks or
geometry changes, may invalidate the existing ganged imposition. In this
case, you will likely need to rebuild the ganged imposition.

○ If the approval status of a page changes, it is reflected in both
locations.

○ If the page geometry of a page changes, it is reflected in both
locations.

● History entries about ganged pages are logged in both the source
job and the ganged job.

● The percentage of the media used by each source job is
automatically calculated and listed in the history entries. Note that
the percentage is calculated on the basis of the number of pages on
the sheet, not on the surface area of the pages.

Note: A detailed report of ganged material usage by source job is available
with Prinergy Business Link software.

● On refine, each page is tagged so that if you copy it to a different
location before ganging it, the source job and source page can still
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be identified when it is imported into Prinergy in a ganged
imposition.

● Custom fields can be added to page aliases. Adding a custom field
to a source page adds the custom field to the alias. Adding a custom
field to an alias adds the custom field to the source page.

Note: Making changes to a page alias, such as re-refining or changing page
geometry, also affects the original page.

Identifying page aliases

In the source job, identify:

● Source pages by the  icon
● The page aliases for a selected source page in the Get Info dialog

box, in the Jobs with alias of page list

In the ganged job, identify:

● Page aliases by the  icon
● The source job of a selected page alias in either of the following

locations:

○ In the Pages view, in the Pages pane, in the Source Job column
○ The Get Info dialog box, in the Source Job list

Limitations

Page aliases are not available for:

● Pages that are re-refined after ganging—If you re-refine a page after
it has been ganged, but before the ganged imposition has been
imported, the ganged imposition will fail to import into Prinergy.
Therefore, ensure that page content is stable before ganging.

Note: Some changes, such as changes to the number of inks or geometry
changes, may invalidate the existing ganged imposition. In this case, you will
likely need to rebuild the ganged imposition.

● Job archive, purge or retrieve—If you archive a ganged job, the
orginal PDF pages are copied and archived. If the ganged job is
retrieved, the pages are not linked to the original job.

● Job export—If you export a ganged job, the original PDF pages are
copied and exported.

● Versioned jobs—If you gang versioned pages, the original PDF
pages are placed in the imposition.

● Copy job (to another server)—When a ganged job is copied to the
same server, page aliases are maintained. However, if a ganged job
is copied to another server, the original PDF pages are copied and
added to the job.

● Other imposition software—If you use imposition software other
than Preps to gang pages, page aliases may not be created. Using
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non-Preps software to build ganged jobs and aliases has not been
tested. The pages assigned to the impositions may be registered as
input files, and may require refining.

● Impositions populated within Prinergy—If, without using Preps, you
add more than one instance of a page to an imposition within
Prinergy, the pages are duplicated in the imposition.

Note: Prinergy now allows aliases and source pages to have different file names.
This enables you to take a copy of the PDF from the subpages folder and put it in
another folder, give the copy a new name, and create a layout job ticket that
references the renamed copy.

Ganging with page aliases
Page aliases are automatically created when you assemble with Preps
Ganging and import a ganged job into Prinergy using these steps.

Requirements:

For this procedure, using Preps 6.0 imposition software or later is
preferred. Preps versions 5 and earlier lower are no longer tested or
supported.

Important: Do not gang pages until the content is stable. If you rerefine a page
after it has already been ganged in Preps, the ganged layout is not imported into
Prinergy.

1. Start Preps Ganging.

2. Place refined pages into Preps Ganging. All refined pages contain a
hidden identification tag inserted on refine. You can place pages
using any of the following methods:

○ Drag the pages from Job Manager to Preps Ganging.
○ Drag the files from the System\Subpages folder for the job to

Preps Ganging.
○ Copy the files from the System\Subpages folder for the job

to another location on the job volume (for example, a staging
folder for gang jobs), either manually or using RBA. In Preps
Ganging, locate and add the files.

3. After you finish placing pages in the ganged imposition, print the
imposition to PJTF.

4. Import the populated imposition into a Prinergy job.

You can create a job specifically for the ganged imposition or use
an existing Prinergy job. If you use an existing Prinergy job, the
pages must have been refined in Prinergy 5 or later.

The import process template must have the Set Initial Separations
option selected, so that the separations are properly assigned to
the incoming imposition.

A page alias is created in the ganged layout for each tag that
matches that of an existing page.
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12 Outputs

Generating loose page output
Follow the instructions in Starting a Process and choose a loose page
output process template.

Tip:

● You can select pages in the Pages view or the Signatures view. Pages can be
assigned or unassigned. An imposition plan does not need to be added to the
job.

● Pages are sent to the proofing device in the order that they are selected.
● When the selected pages are assigned to a page set, and the page set is linked

to an imposition plan, the loose page output includes the imposition plan's trim
and bleed lines if they are configured in the process template.

Loose Page Output process template
At the top of the dialog box is the Output To list, which you use to
select the file format suitable for the output device you select in the
Device section. The file format selection determines the availability of
some options in this process template. For this reason, you should
select an output format before you set the other options in the process
template.

Copydot section of the Loose Page Output process template
This process template section defines how Prinergy handles copydot
files during loose page output.

When you enable the Copydot section, the system automatically
converts copydot images for optimal quality on your output device
during output. Only disable the Copydot section for one or more of the
following reasons:

● Your pages lack copydot images.
● You are outputting at your target device resolution.
● You don't need high-quality copydot images in your loose page

output.

JTP

Select a job ticket processor (JTP) to use for copydot files.



Note: You set up JTPs using Prinergy Administrator.

Resample

Enables resampling of copydot files to the resolution required by
the output device. The availability of this option is controlled by
the device you select in the Output To list at the top of the final
output process template dialog box.

Select the Resample check box to enable resampling of copydot
files. Prinergy resamples copydot files to the resolution required
by the output device you select in the Output To list at the top
of the process template.

Clear the Resample check box to disable resampling.

Note: You can resample copydot images during another step in the
process—refine, loose page output, or final output.

Descreen

Enables descreening of copydot files for contone output devices.
The availability of this option is controlled by the device you
select in the Output To list at the top of the process template.
This option becomes available only for 8-bit final output devices.

Select the Descreen check box to enable descreening.

Clear the Descreen check box to disable descreening.

Calibration Curve

Specifies a calibration curve from Kodak Harmony tonal
calibration software for the copydot files.

From the Calibration Curve box, select the calibration curve you
want Prinergy to use for copydot files.

Select %%NONE%% to disable this feature.

ColorFlow section of the Loose Page Output process template
The ColorFlow section of the loose page output process template
defines how Prinergy applies ColorFlow settings during loose page
output .

When you configure the ColorFlow settings in an output process
template, you select the device, device condition, and plate line, but not
a color setup. The color setup used is the one that was assigned to the
pages when they were refined—that is, either the color setup specified
in the refine process template that was used or the job's default color
setup. The color setup that is used during output processing is the
color setup specified for each page in the Color Setup column in the
Pages pane.
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WARNING: Output will fail if the color setup does not match the color setup
assigned during refine, unless the Allow undefined color setup or color setup
mismatch option is enabled.

It is possible to select from four modes for output to halftone devices
or files. These modes control the curves that are applied upon output.

Print Production

This halftone output mode reflects the standard operation of
Prinergy and ColorFlow for production. When this option is
selected, curves are applied to each output separation, as
described next:

● The print calibration curve for the separation, determined by
the selections from the Snapshot, Device, and Device
Condition lists, and possibly modified at run time by the
settings in the Tonal Control dialog box, is applied to
separation input tints.

● The plate calibration curve, determined by the selections from
the Plate Setup and Plate Line lists, is applied to the
separation tints modified by the print calibration curve.

Note: If None is selected from the Plate Setup and Plate Line lists, the
plate calibration curve is linear (has no effect).

This option is not available when a process template is
configured for continuous-tone (non-screened) output.

Print Characterization

This halftone output mode is used to print and measure the
response of a print device. When this option is selected, curves
are applied to each output separation as follows:

● The device curve for the separation, determined by the
selections from the Snapshot, Device, and Device Condition
lists, with no modifications from the Tonal Control dialog
box, is applied to separation input tints.

● The plate calibration curve, determined by the selections from
the Plate Setup and Plate Line lists, is applied to the
separation tints modified by the print calibration curve.

Note: If None is selected from the Plate Setup and Plate Line lists, the
plate calibration curve is linear (has no effect).

When this option is selected, the Device list contains all curved
print devices in the selected snapshot, and the Device
Condition list contains all ColorFlow device conditions in the
selected snapshot that use the selected device. If the selected
device condition uses a plate setup, the Plate Setup list displays
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this plate setup, and the Plate Line list contains all ColorFlow
plate lines controlled by the plate setup in the selected
snapshot.

When this option is selected, the Color Setup list is not
available.

This option is not available when a process template is
configured for continuous-tone (non-screened) output.

Plate Verification

This halftone output mode is used to verify the linear response
of plates produced by a particular plate line (consisting of the
computer-to-plate device, plate processor setup, and
chemistry), with a selected screening system. When this option
is selected, the following results occur:

● Only the plate calibration curve, determined by the selections
from the Plate Setup and Plate Line lists, is applied to input
tints of all separations.

● No print calibration curve is applied.

When this option is selected, the Plate Setup list contains all
ColorFlow plate setups in the selected snapshot, and the Plate
Line list contains all ColorFlow plate lines controlled by the
selected plate setup in the selected snapshot.

When this option is selected, the Color Setup, Device, and
Device Condition lists are not available.

This option is not available when a process template is
configured for continuous-tone (non-screened) output.

Plate Characterization

This halftone output mode supports imaging and measuring the
uncalibrated (or intrinsic) response of a plating line, such that a
plate linearization curve can be computed. When this option is
selected, no calibration curves are applied to input tints of any
separations.

When this option is selected, none of the lists in the ColorFlow
section are available.

This option is not available when a process template is
configured for continuous-tone (non-screened) output.

Allow undefined color setup or color setup mismatch

This check box enables the job to run when the selected color
setup differs from the color setup assigned by the refine
process, or if the color setup has not been defined. Note that
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when this feature is enabled, output could be significantly
different.

To use this feature, it is recommended to select an approved
color setup listed in the snapshot or by ID number. This will
ensure that the list of devices and device conditions are filtered
to include only those available in the selected color setup. Then,
the Allow undefined color setup or color setup mismatch check
box can be selected and output will succeed with a warning
message.

To output refined pages with no color setup assigned to them,
you can select the Allow undefined color setup or color setup
mismatch setting.

The list of devices and device conditions is unfiltered when
<Job_Color_Setup> is selected. Note that this may cause
output to fail, if the device and device condition selected are not
in the job color setup. A message will be logged in the process
history, and you will need to either select a device and device
condition used in the job color setup or use the recommended
solution, as described above.

When <Color_Setup_Assigned_by_Refine> is selected, the list
of devices and device conditions is also unfiltered, and the
Allow undefined color setup or color setup mismatch check
box is grayed out and cannot be used. Note that this is the
default color setup setting for all process templates that were
upgraded from Prinergy Connect 5.1.

Snapshot

A ColorFlow snapshot captures the state of the entire color
database, making its elements available to the workflow and
providing a convenient backup. The snapshot feature makes it
unnecessary for you to manually save and name multiple
versions of your color control elements after adjusting them. At
any time, you can easily roll back (revert) to the state of a
previous snapshot in the ColorFlow software. If you roll back to
a previous snapshot, ColorFlow behaves as if changes after that
snapshot never happened.

When you have completed your work in ColorFlow to a certain
level and you are satisfied with the elements in color setups,
you will mark a snapshot as approved. By default in Prinergy
Connect, the currently approved snapshot is used. Only one
snapshot can be in the approved state at any time.

This list is not available if the Plate Characterization option is
selected.
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Color Setup

This list displays the names of all color setups in the selected
snapshot. At the top of the list is Color setups assigned by
Refine, followed by Job color setup.

This list is available only if the Print Calibration mode is
selected.

Allow undefined color setup or color setup mismatch

This check box enables the job to run when the selected color
setup differs from the color setup assigned by the refine
process, or if the color setup has not been defined. Note that
when this feature is enabled, output could be significantly
different.

To use this feature, it is recommended to select an approved
color setup listed in the snapshot or by ID number. This will
ensure that the list of devices and device conditions are filtered
to include only those available in the selected color setup. Then,
the Allow undefined color setup or color setup mismatch check
box can be selected and output will succeed with a warning
message.

To output refined pages with no color setup assigned to them,
you can select the Allow undefined color setup or color setup
mismatch setting.

The list of devices and device conditions is unfiltered when
<Job_Color_Setup> is selected. Note that this may cause
output to fail, if the device and device condition selected are not
in the job color setup. A message will be logged in the process
history, and you will need to either select a device and device
condition used in the job color setup or use the recommended
solution, as described above.

When <Color_Setup_Assigned_by_Refine> is selected, the list
of devices and device conditions is also unfiltered, and the
Allow undefined color setup or color setup mismatch check
box is grayed out and cannot be used. Note that this is the
default color setup setting for all process templates that were
upgraded from Prinergy Connect 5.1.

Device

An individual occurrence of a physical device that captures or
produces an image. Devices have a type and customer-
specified properties, such as a name and location in the plant.
Because the declaration of a device does not include its
operating conditions—such as ink selection, type of screening,
and paper—you cannot measure the color response of a device
on its own.
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When a process template is configured for halftone (screened)
output processes, this list displays the names of all curved
devices used in PCO (primary color output) or SCO (secondary
color output) device conditions in the selected color setup and
snapshot. Curved print devices are those with the following
device types:

● Offset press—for example, sheetfed, heatset web, coldset
web

● Digital press—for example, Versamark
● Digital halftone proofer—for example, Kodak Approval,

Trendsetter Spectrum

When a process template is configured for continuous-tone
(non-screened) output, this list displays the names of all non-
curved devices used in PCO or SCO device conditions in the
selected color setup and snapshot. Non-curved devices are
those with the following device types:

● Digital press—for example, Nexpress
● Inkjet proofer—for example, Kodak Matchprint Inkjet, Kodak

Veris
● CMYK reference

This list is not available if the Plate Verification or Plate
Characterization option is selected.

Device Condition

A combination of a device and the operating conditions in
which the device captures or produces an image. A device
condition has a known color response. Device conditions can be
divided into groups such as print conditions (press and proofer
devices), capture conditions (scanner and camera devices), and
reference print conditions (industry specifications). A device
condition can include more than one device. If all the devices
are the same device type, they use the same consumables and
operational settings, and they can be calibrated to yield the
same color response.

When a specific color setup is selected, this list contains all
ColorFlow device conditions that use the selected device and
are used in the PCO or an SCO of the selected color setup and
snapshot.

This list is not available if the Plate Verification or Plate
Characterization option is selected.
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Plate Setup

If the selected device condition uses a plate setup in the
selected snapshot, this plate setup is displayed here. Otherwise,
this list displays None.

This list is not available if the Plate Characterization option is
selected. It is also not available when a process template is
configured for continuous-tone (non-screened) output.

Plate Line

You establish the behavior of a particular plate, screening, and
plating line by plating a tint ramp, manually measuring the
resulting dot area on the plate, and entering the values in the
Plate Setups dialog box in the ColorFlow software.

A ColorFlow plate line is associated with only one plate setup.
In your shop, you may use a platesetter and chemistry to
process several different screenings. To model this, in
ColorFlow, create similar plate lines in the other plate setups.
You can name them to match the equipment in your plant. You
may want to create several plate lines to indicate when
chemistry changes occur. For example, if you routinely change
solutions on Mondays, you might create different ColorFlow
plate lines for Monday, Wednesday, and Friday.

If the Plate Setup list displays a plate setup, the Plate Line list
contains all ColorFlow plate lines controlled by the plate setup
in the selected snapshot. If the Plate Setup list displays None,
the Plate Line list also displays None.

This list is not available if the Plate Characterization option is
selected. It is also not available when a process template is
configured for continuous-tone (non-screened) output.

ColorConvert section of the Loose Page Output process template
This process template section defines how Prinergy handles color
converting during loose page output.

Color converting, as part of loose page output, transforms the color
description of colored objects in a PDF page to the appropriate final
output color space, and then to the appropriate color space of the loose
page output device. As a result, the loose page output simulates the
intended final output.

JTP

Select the job ticket processor (JTP) to use for color conversion.

You set up JTPs using Prinergy Administrator.
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Match Colors

Match Colors in Page Content

Enables the Color Matcher to match hues in the page content
for proofing. In other words, it enables color matching as it was
done in Prinergy 1.1 (as opposed to using the Color Matcher to
affect the L*a*b* spot color recipes).

Select this check box to enable this feature; clear the check box
to disable this feature.

When you enable this feature, you can set the Assumed Source
or DeviceLink Profile option.

Assumed Source or DeviceLink Profile

Select Exactly as Applied During Refining to use the same
profile that was used during the refine process. If the file was
not color converted during refining, or the profile is missing, an
error is displayed.

Select As Defined Below, if Not Set in Refining to use the same
profile that was used during the refine process, if the file was
color converted during refining. If the file was not color
converted during refining, the profile defined in the Input
Device Conditions box will be used.

Select Exactly as Defined Below to use the profile selected in
the Input Device Conditions box.

Input Device Conditions

Available when Assumed Source or DeviceLink Profile is set to
As Defined Below, if not set in Refining or Exactly as Defined
Below.

From the list, select Browse to locate the appropriate profile file
for final output.

Rendering Intent

Select Relative Colorimetric if the proofing paper is similar to
the paper that will be used during final output.

Select Absolute Colorimetric to simulate the color of the paper
that will be used during final output.

Select PDF to use the rendering intent specified in the PDF file
when output by the creative software during final output.

Select Perceptual to use rendering that uses gamut
compression and produces less saturated colors during final
output.
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Select Saturation to make sure colors are represented in a way
that preserves or emphasizes saturation during final output.

Retain CMYK Black

Preserves black in images and graphics that are defined in
CMYK or RGB color space. For ICC-based color matching
engines, CMYK images and graphics get transformed from
CMYK to L*a*b* and back to CMYK color in order to perform
color matching. In going from CMYK (four components) to
L*a*b* (three components) and back again, the black (K)
channel separation information (UCR/GCR) has in the past
been destroyed. Selecting this check box instructs the Color
Matcher to preserve the black generation information from the
source color space. As a result, the amount of black relative to
CMY in the images and graphics stays about the same. The
purpose of this feature is to help preserve the visual weight of
images and graphics.

Note: When you enable this feature, Color Matcher requires some
additional processing time because of the extra calculations involved.

Overprint Handling (CPU Intensive)

(See About overprint handling on page 257)

Select to prevent overprinting objects from generating
unintended knockouts.

If you are converting spots to process for a proof, or if you are
color-matching one CMYK space to another CMYK space for a
proof, you probably need to apply overprint handling, even if
you applied it during refine.

To use overprint handling, you must:

1. In the ColorConvert section, select:

● The Color Matcher JTP
● The Match Colors in Page Content check box
● The Overprint Handling check box

2. Choose between raster and vector overprint handling in the
Methods list.

Note: The raster option is available only when Shades=256 is
selected in the Render section of the process template.

Method

Choose to use vector or raster overprint handling for this output
process.
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Select Raster when outputting to low-resolution contone
proofers (for example, Veris digital proofer or Matchprint Inkjet
proofer).

Note: To use raster overprint handling, you must select, in the Render
section of the process template, Shades=256.

Additional factors to consider:

● Raster overprint handling can be applied only to continuous
tone data

● Raster overprint handling occurs after the RIP
● Raster processing time increases exponentially as the

resolution increases
● Raster overprint handling eliminates all overprints

Select Vector when outputting to halftone (screen) proofers
(for example, the Spectrum device), or to high-resolution
contone proofers.

Additional factors to consider:

● Vector overprint handling occurs before the RIP
● Depending on the complexity of the file, vector overprint

handling could take longer than raster overprint handling.
● Vector overprint handling does not eliminate all overprints.

In objects where overprinting does not have an effect on the
output, the objects retain an overprint status. For example, if
you set black to overprint, but one black object is not placed
on top of another object, this black object is, after overprint
handling, still an overprinting object.

Preserve Traps

Select this check box to preserve existing Kodak traps when
vector overprint handling is used.

Note: When existing traps are preserved, you cannot remove them in
later processing. You must remove the traps in the original file. Traps are
color-managed as regular objects.

Process CEPS Data

Select this check box to enable spot color mapping and color
matching of CEPS data.

For further information, see the CEPS Conversion Section and
the Normalize Section of the Refine Process Template.
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Process Marks

Select this check box when you want to apply color
management to your marks file. Depending on the type of mark,
it may be necessary to enable Overprint Handling to
appropriately convert the mark and apply the necessary color
transformation.

Note: When Process Marks is checked, both sheet marks and page
marks are color managed.

Color match 1-bit images

Select this check box to color match 1-bit images. One-bit
images are images that represent two tones, typically black and
white. The pixel is either a 0 or a 1 value. Examples are copydot
images.

Note: This feature will convert 1-bit images to 8-bit images. This causes
pages to become larger and to render more slowly. Turn off this feature if
you do not require color matching of 1-bit images, or if the feature causes
unacceptable performance degradation. (For example, copydot files take
a very long time to refine and render.)

This feature is available when Match Colors in Page Content is
selected.

Device Condition

Enables the ICC profile for a proofing device. The ICC profile
characterizes the way the proofing device prints.

Enable this feature by selecting a profile in the Device Condition
box. A profile should always be present because the Color
Matcher needs it for mapping spots and other tasks.

Source of Color Recipes

Extract Recipe from the File

Select to use the color recipes embedded in the file.

Lookup Recipe in Color Database

Select to use the color libraries selected in this process
template.

Color Libraries

From the Selectable list, select the color libraries you want
Prinergy to search for color recipes, and click Add.
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Arrange the color libraries in the Selected list in the order that
you want Prinergy to search. Use the Move Up and Move Down
buttons.

Note: Ensure that you select color libraries with color spaces that are
compatible with the Proof Process Profile.

Use Recipe from File if not found in Color Database

Select this check box to use color recipes embedded in the file if
Prinergy does not find the colors in the selected color libraries.

Layout section of the Loose Page Output process template
This process template section defines how Prinergy places the pages
on the output media during loose page output.

Media

Media Configuration

This option becomes available when you select Kodak Proofers
in the Output To list.

Specifies the type of paper you're using in the Kodak proofing
device. Select a paper type from the list.

Thickness

This option becomes available when you select an Epson device
in the Output To list.

Type the thickness of the paper you are using in the Thickness
box, and then select a unit of measurement.

Layout for Kodak Proofers

Select a template to control how multiple pages are arranged on
a single proof.

This box is available only for those proofers that are connected
via Kodak Proofing Software (KPS).

For more information, see the Kodak proofer documentation.

Name

Available when a vendor's device has been defined through the
Prinergy Administrator. Available options are determined by the
device.
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Size

Determines the size of the media to which you will output the
final files.

Select Digital to generate an output file, for example, a file for
Virtual Proofing System software. When you select Digital, the
Min Width, Min Height, Max Width, Max Height, and Layout is
90° Different Than Media boxes are unavailable.

Select Cut sheet, Roll fed, or Roll fed (transverse), depending
on the media being used.

Min Width

Sets the minimum width for the specified media in the unit of
measure selected in the list.

Min Height

Sets the minimum height for the specified media in the unit of
measure selected in the list.

For cut sheet, enter the sheet height. For roll fed, enter the
height of the smallest proof you want to make on the device.

Max Width

Sets the maximum width for the specified media in the unit of
measure selected in the list.

Max Height

Sets the maximum height for the specified media in the unit of
measure selected in the list.

Duplexing

This option is available for composite files; it is unavailable for
separated files.

Specifies the type of duplexing.

From the Duplexing box, select Turn or Tumble to enable this
feature. Select None to disable duplexing.

Front Shift and Back Shift

The Front Shift Along Width...Along Height and Back Shift
Along Width...Along Height options give finer adjustment
when aligning two-sided proofs than with Center Along Width/
Height. Use these measurements to shift and align front and
back pages along their turn or tumble axes, depending on the
page or imposition orientation (portrait or landscape).
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These options are available only when Duplexing has been set
to Turn or Tumble.

You can specify the shift in points, inches, centimeters, or
millimeters.

Layout is 90° Different Than Media

Available when you select Cut Sheet or Roll Fed from the
Sizebox. This option is unavailable when you select Digital from
the Size box or when you select the Reduce to Fit Media check
box.

Select this check box when the orientation of data is at a 90°
angle to the orientation of the media (for example, you are
trying to output a landscape layout to a portrait device). You
must also select either Auto clockwise or Auto
counterclockwise in the Orientation box.

Note: This option is not available when you select Veris/Matchprint
Inkjet in the Output To list at the top of the pane.

Center and crop page to media size

Select this check box when the sheet size of the device is
smaller than the media box of the PDF page.

PDF Box to Use

Select the Trim Box or the Media Box to use as the area of
output content.

For example, selecting the trim box produces trimmed output,
that is, output without bleeds or registration marks.

Placement

Type

Select the type of placement.

When you select Top Left to Bottom Right placement the N-up
option button is selected and the Number of Pages Across
option becomes available.

When you select Page Set Booklet, the 2x1 option button is
selected and the Vertical Gutter Width option becomes
available
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Style

Determines how many pages Prinergy places on each sheet.

● Select Auto Fit to let the system determine the best layout,
depending on the files submitted.

● Select 2x1 to specify two pages across and one page down.
● Select 1x2 to specify one page across and two pages down.
● Select N-up to specify the number of pages across and

down.

Number of Pages Across

Available when N-up is selected in the Style box.

Determines the number of pages to place horizontally on each
sheet.

Down

Available when N-up is selected in the Style box.

Determines the number of pages to place vertically on each
sheet.

Vertical Gutter Width

Available when Auto Fit is selected in the Style box or N-up is
selected in the Style box and the Number of Pages Across box
contains a value greater than 1.

Determines the minimum space allowed, in the selected unit of
measure, for vertical gutters when automatically fitting pages
on a sheet. This value may be reduced if the Reduce Gutters if
Required check box is selected.

Horizontal Gutter Height

Available when Auto Fit is selected in the Style box, or N-up is
selected in the Style box and the Down box contains a value
greater than 1.

Determines the minimum space allowed, in the selected unit of
measure, for horizontal gutters when automatically fitting pages
on a sheet. This value may be reduced if the Reduce Gutters if
Required check box is selected (see below).

Orientation

(See Example: orientation on page 653)

Rotates an entire imposition as a unit.

Select Auto clockwise to automatically rotate an image
clockwise when rotating would result in a better fit.
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Select Auto counterclockwise to automatically rotate an image
counter-clockwise when rotating would result in a better fit.

Note: Loose page proofs do not have an imposition plan. When you
identify the media (in the Media area), an imposition plan is assumed
that is always equal to the media, and thus is the best fit. Therefore,
selecting Auto clockwise or Auto counterclockwise will have no effect
unless the Layout is 90° Different than Media check box is also selected.
When this check box is selected, the assumed imposition is rotated by
90°, which matches the layout but does not match the media. The layout
is then automatically rotated (clockwise or counterclockwise) to result in
a better fit to the media. Select 0°, 90°, 180°, or 270° to rotate an image
the specified amount in a clockwise direction.

Scaling

Scale Vector

Applies scaling to the layout prior to screening the file. The
scaling is based on vector data (PDF data).

Apply Scaling from Layout

Select to use the scaling specified in the original layout
application, for example, Pandora.

Note: This feature is not compatible with Preps.

Custom

Enter scaling percentages for the Along Width and Along
Height directions.

Fit to Media Size

If the specified layout produces an image too large for the
media, the image is scaled to fit.

You cannot see the scaling percentage. Select this check box
only when a proof scaled to an unspecified reduction is
acceptable.

Non-Printable Margin

If the Fit to Media Size option was selected, you can identify the
non-printable margins that should be taken into account when
determining scaled layouts.

Specify left, right, top, and bottom non-printable margins
appropriate to the output device and media, in the selected unit
of measure.

Loose Page Output process template 449



Scale Raster

Applies raster scaling to the layout. Raster scaling is an optional
feature that will allow you to apply distortion after the files are
screened.

Raster scaling is recommended for prescreened files (copydot)
or files that contain 1-bit TIFF images, since the prescreened
bitmap data cannot be properly scaled with vector scaling
(could generate artifacts).

Clear this check box to disable this feature.

Apply Scaling from Layout

Select to use the scaling specified in the original layout
application, for example, Pandora.

Note: This feature is not compatible with Preps.

Custom

Enter scaling percentages for the Along Width and Along
Height directions.

Spacing

Add Extra Horizontal Space

(See Example: add extra horizontal space on page 654)

Determines where unused horizontal space should be
positioned.

● Select Right margin only to position unused space at the
right margin, allowing for excess to be easily cut off.

● Select Evenly to both margins to divide unused space evenly
between the right and left margins.

● Select Evenly to all gutters and margins to divide unused
space evenly between the vertical gutters and right and left
margins.

Add Extra Vertical Space

(See Example: add extra vertical space on page 653)
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Determines where unused vertical space should be positioned.

● Select Bottom margin only to position unused space at the
bottom margin, allowing for excess to be easily cut off.

● Select Evenly to both margins to divide unused space evenly
between the top and bottom margins.

● Select Evenly to all gutters and margins to divide unused
space evenly between the horizontal gutters and top and
bottom margins.

Reduce Gutters if Required

Allows gutter values (set in the Horizontal Gutter Height and
Vertical Gutter Width boxes in the Placement section) to be
reduced if required to fit pages. If selected, gutters will be
reduced only to the values set in the Min Horizontal Gutter
Height and Min Vertical Gutter Width boxes.

Min Vertical Gutter Width

Available if the Reduce Gutters if Required check box is
selected, N-up is selected in the Style box, and the Down box
contains a value greater than 1.

Vertical gutters are not reduced below this value.

Min Horizontal Gutter Height

Available if the Reduce Gutters if Required check box is
selected, N-up is selected in the Style box, and the Number of
Pages Across box contains a value greater than 1.

Horizontal gutters are not reduced below this value.

Preview

(See About previewing loose page output on page 752)

Displays the Imposition Preview dialog box, which graphically displays
how the PDF pages will fit on the selected media. It is based on the
settings in the Layout section of the Loose Page Output process
template and the page size you specify in the Assumed Page Size
option in the Imposition Preview dialog box.

When you change the options in the Layout section of the Loose Page
Output process template, the Imposition Preview dialog box is
automatically updated.

Note: You must specify a page size for the Assumed Page Size option in the
Imposition Preview dialog box for the graphic in the dialog box to correctly display.

Loose Page Output process template 451



Render section of the Loose Page Output process template
This process template section determines the output resolution and
how the system handles spot colors during loose page output.

JTP

Select the job ticket processor (JTP) to use for rendering.

Note: You set up JTPs using Prinergy Administrator.

Device Resolutions

This list is available when an output device format is selected in
the Output To list.

Select a resolution for the selected device in the list.

Resolution X

Available when the Device Resolutions box is unavailable.

Type a resolution value.

Resolution Y

Available when the Device Resolutions box is unavailable and
mixed resolution values are allowed for the output format
selected in the Output To list.

Type a resolution value.

Color Model

Select the process color model to use for output.

The list of values varies, depending on the output format
selected in the Output To list.

Shades

To set the number of shades of gray to output, select 1 for
screened data or 256 for continuous tone data. When 1 is
selected, the Calibration & Screening section of the refine
process template is available for input.

The list of values varies, depending on the output format
selected in the Output To list and the color model selected in
the Color Model list.

Do Separations

Available when the output format selected in the Output To list
supports separated output and DeviceCMYK is selected in the
Color Model options.
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Select if you want Prinergy to output separations. Clear this
check box if you want Prinergy to output a single composite file.

Spot Color Handling

Determines how spot colors should be handled on loose page
output.

The list of values varies, depending on the output format
selected from the Output To list.

● Select Convert to process to convert spot colors to process
colors.

Note: When Convert to process is selected, Vector
Overprint Handling (in the ColorConvert section) is
automatically turned on to ensure the correct appearance of
any overprinting spot colors.

● Select Output separately to preserve spot colors on output.
● Select Don't output to suppress output of spot colors.

Always Use Color Combiner to Convert Spots

This check box is available when Output Separations Handling
is set to Convert separations to process.

If the input files contain overprinted spot colors, the Color
Combiner, which is a plug-in to the renderer, will combine the
layers and output the overprinted colors correctly.

When this check box is cleared, the renderer handles the
conversion of spot colors to process colors if the following
conditions exist:

● Input files are composite.
● All spot colors are set to opaque in the color database. (If a

spot color is not in the color database, opaque is assumed.)

If the above conditions are not met, the Color Combiner will be
used, even if the Always Use Color Combiner to Convert Spots
check box is cleared.

We recommend that you always select this check box.

See About Color Combiner on page 805.

Dielines Overprint Other Content

This check box is cleared and unavailable if the Do Separations
check box is cleared and unavailable.

Select this check box to specify whether die lines overprint
other content. Clear this check box if you do not want die lines
to overprint other content.
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The Dielines Overprint Other Content check box is available for
the following outputs:

● DCS Raster
● Kodak Approval TIFF
● LQS TIFF
● VPS
● Windows Bitmap

Anti-Aliasing

Select this check box to enable anti-aliasing, and then in the at
Ratio list, specify a ratio for anti-aliasing.

Anti-aliasing is a technique of improving the appearance of
output by minimizing the "stair step" effect on rasterized
output. It does so by rendering to a higher resolution than the
intended output, and then downsampling to the intended
output. This generates "averaged" pixels which softens the
"stair step" effect on low-resolution output. The ratio value for
anti-aliasing refers to the factor used to determine the
intermediate resolution. A higher ratio results in higher quality,
but can have an effect on output speed. For example, if the
output is a 300 DPI 8-bit TIFF, and the anti-alias ratio is 4,
Prinergy will render an intermediate output at 1200 DPI (4 x
300 DPI), and then downsample to the user-requested 300
DPI. Anti-aliasing is only available for 8-bit (256 shade) output.

Fail if font problems detected

Select this check box to fail the output process if a file has
missing fonts.

Note: This feature is not available for vector outputs (PDF, PS2, PS3, EPS,
DCS Vector, PDF/X-1a, PDF/X-3, CT/LW, and DELTA).

Ignore Embedded Fonts in Marks Files

Select this check box if you want Prinergy to ignore embedded
fonts in a marks file and to look for the fonts in the system
fonts folder.

Important: You must install the fonts in %ServerName%\%AraxiHome
%\AdobeExtreme\bin\fonts, or the output will fail.

Convert Text to Paths

This check box converts fonts to outlines before a file is RIPed.

This option was added in Prinergy 3.0 when the CPSI 3016 RIP
was included with Prinergy. This option helped situations where
the 3016 RIP failed to process the fonts on certain jobs.
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This option has limited usefulness now, but is included as a
potential workaround in rare cases where fonts are not
rendered correctly by the RIP. It is not recommended that you
enable this on on a permanent basis. When using this option for
specific jobs, it is recommended that you ensure that both
proofs and plates are output with this option.

Note that when you select the Convert Text to Paths check box,
you will have text appear fatter on low-resolution proof output.
You can overcome this appearance problem by either:

● Rendering to a higher resolution, if rendering to 1-bit output,
such as Virtual Proofing System

● Using anti-aliasing, if rendering to contone output

Note: This check box is only available for raster output formats
(.VPS, .TIFF, and so on).

Overlay Versioned Content

This check box applies to Layered PDF Versioning. For
information, see the Prinergy Layered PDF Versioning User Guide.

Versioning Proof Mapping Color

This box applies to Layered PDF Versioning. For information,
see the Prinergy Layered PDF Versioning User Guide.

Kodak Approval

Densities

Type an integer between -22 and +22.

For more information, see your Approval documentation.

CT/LW

CT Resolution

Type a resolution value in dots per inch (dpi) for the continuous
tone (CW) files created during refine.

Note: 304.8 dpi = 12 dpm

LW Resolution

Type a resolution value in dots per inch (dpi) for the line work
(LW) files created during refine.

Note: 2032.0 dpi = 80 dpm
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Border Handling

Select the resolution at which the borders of overlapping
images are rendered.

● Borders to CT—Render borders at the resolution specified in
the CT Resolution box. If two images overlap, the transition
from one continuous tone (CT) image to the next may
appear jagged.

● Borders to LW—Render borders at the resolution specified
in the LW Resolution box. This improves the resolution of
the overlap area, but increases process time and size of the
output file.

● Borders to Smart Edge—Improves the appearance of CT to
CT borders and ensures that the number of line work (LW)
colors is not increased.

Output Kind

Select the format to which you want to output. You can output:
CT/LW Job Only, TIFF/IT Job Only, or CT/LW and TIFF/IT
Jobs.

Force Vignette to CT

Select to convert gradations to the continuous tone (CT) layer.
Also, gradations created as Post Script Level 2 are converted to
Post Script 3 to obtain high quality gradations when converted
to CT data.

Converting to CT results in less banding and better quality
images than converting to line work (LW). Converting to CT
also adds noise to the resulting CTs, creating a smoother image.

Note: If you clear this check box, some vignettes are still converted to CT
data (for example, Post Script Level 2 gradations).

Force LW Vignette to CT

Select to convert to the continuous tone (CT) layer, the
vignettes (gradations and blends) that AVR (Automatic
Vignette Recognition) identifies.

AVR recognizes a vignette as an image with a color difference
(C,M,Y, or K) of 6% or less.

An output file in which blends are converted to CT is smaller
than an output file in which blends are converted to line work
(LW).

456 Chapter 12—Outputs



Screen Grabs

Select the resolution at which you want screen captures to be
rendered.

● Grabs to CT—Renders screen captures at the resolution
specified in the CT Resolution box.

● Grabs to LW—Renders screen captures at the resolution
specified in the LW Resolution box.

CT Type

Select the CT (continuous tone) type you want to output.

● NativeCT—Renders CT to the Kodak native (Whisper) CT
format. This format supports up to 4 separations CMYK, and
up to 256 shades/separation.

Note: A CT Native file is given a .ct extension.

● HandshakeCT—Renders CT to the Kodak CT Handshake
format. This format supports up to 4 separations CMYK, and
up to 256 shades/separation.

Note: A CT Handshake file is given a .ch extension.

● NewCT—Renders CT to the Kodak extended CT format
which supports spot colors, and up to 32 separations, and up
to 256 shades/separation.

Note: A New CT file is given a .nct extension.

LW Type

Select the LW (line work) type you want to output.

● NativeLW—Renders LW to the Kodak native (Whisper) LW
format. This format supports up to 4 separations CMYK, and
up to 248 colors.

Note: A Native LW file is given a .lw extension.

● HandshakeLW—Renders LW to the Handshake LW format.
This format supports up to 4 separations CMYK, and up to
248 colors.

Note: A Handshake LW file is given a .lh extension.

● NewLW—Renders LW to the Kodak extended LW format.
This format supports up to 32 separations CMYK, and up to
64,000 colors.

Note: A New LW file is given a .nlw extension.
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Make CT same size as Linework file

Select this check box to insert 1-pixel DeviceCMYK CT images
in the upper-left and lower-right corners of the media box of the
PDF pages. The resulting CT layer:

● Is the same size as the LW layer
● Has all DeviceCMYK process colorants

This check box applies only when both:

● Output To at the top of the process template is set to CT/
LW (CTLWOutput)

● Output Kind in the CT/LW area of the Render section is set
to either TIFF/IT Job Only or CT/LW and TIFF/IT Jobs

TIFF/IT Suffix

TIFF/IT FP

When outputting to TIFF/IT, you can specify the file name
ending for the final page (FP) file. Type the file name suffix,
which can include characters before the extension. For example,
_FP.tif

TIFF/IT CT

When outputting to TIFF/IT, you can specify the file name
ending for the continuous tone (CT) file. Type the file name
suffix, which can include characters before the extension. For
example, _CT.tif

TIFF/IT LW

When outputting to TIFF/IT, you can specify the file name
ending for the line work (LW) file. Type the file name suffix,
which can include characters before the extension. For example,
_LW.tif

TIFF/IT HC

When outputting to TIFF/IT, you can specify the file name
ending for the high-resolution contone (HC) file. Type the file
name suffix, which can include characters before the extension.
For example, _HC.tif

Note: High-resolution contone (HC) files are line work files with more
than 256 colors.
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Calibration and Screening section of the loose page output process
template

This process template section provides calibration and screening file
information during loose page output.

These options are available when you select 1 in the Shades option, in
the Render section of the process template.

Calibration

Plate Curve

Select None if you do not want to apply plate linearization
curves to your output. This option is set to None by default.

To apply a plate curve to your output, select the curve in the list.

You must select a plate curve in the Prinergy process template,
even when Print Curve (Calibration) is set to Auto.

Note: Plate curves are always applied to page, sheet, and imposition
marks. Select None if you do not want curves applied to marks.

Print Curve (Calibration)

Select None if you do not want to apply print dot gain
compensation curves to your output.

To apply a print calibration curve to your output, select the
curve in the list.

Select Auto to automatically select the most appropriate curve.
Depending on the Screening Method selected, the Harmony
software determines the curve to use, based on dot shape and
screen frequency data from your job or the process template.
Harmony looks in the following locations in the process
template:

● Dot Shape and Screen Ruling boxes
● Screen Frequency box
● Harmony Medium box
● In the Render section, the Device Resolutions box (or

Resolution X and Resolution Y boxes)

If you assign a calibration curve in the Prinergy DotShop
software for use on a mark, you must select the Keep DotShop
Settings or Use Document's Screening, if Present screening
mode.

Note: To control the application of the selected print curve for an
individual page, sheet, or imposition mark, select the Calibrate check box
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in the Marks section of the process template. This allows you to apply
print curves to imposition content without applying print curves to
marks.

Harmony Medium

Available when you select Auto in the Print Curve (Calibration)
list, it lists the Harmony media that are defined in your
Harmony curve database. If the Harmony Medium list is
available but the list is empty, no Harmony media are defined.
The selected Harmony media is used to identify an appropriate
calibration curve.

Select a Harmony media in the list.

Minimum Dot Size

Type the lowest tint percentage, with up to one decimal place,
at which dots will be imaged—for example, 10% or 10.5%. This
feature is available only if you specified a plate or print curve.

You can use this feature to remove scum dots on flexo plates.

Screening Mode

(See also the topic about document screening in this guide.)

● Select Override all Screening to use the screening specified
in the process template. This option ignores any screening
specified in the source PDF file or the Prinergy DotShop
software.

● Select Keep DotShop Settings to use the screening specified
in the DotShop software, when available. For pages that are
not modified in DotShop, the screening specified in the
process template is used.

● Select Use Document's Screening, if Present to use the
screening specified in the source PDF file.

This option also uses the screening specified in DotShop,
when available. For pages containing no screening
information, the screening specified in the process template
is used.

You can use one or more of the Angles, Frequencies, and
Dot Shapes settings specified on the page and allow the
process template to determine the parameters that you did
not specify.

Note: If Prinergy does not support the screen angles in the source PDF
file, the nearest supported angle is used.
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Note: This option offers the greatest risk of poor results, because screen
angles identified in the source PDF file may not be suitable for the output
device.

Screen Type and Screen System

(See also the topics about screen types and screen systems.)

Screen Type lists the following default screening information:

● Maxtone screen types are based on the Prinergy AM
(conventional or rational tangent) screening technology.

○ The Maxtone CX screen type is configurable. To
configure the size of highlights and shadow dots, type
values in the Dot Width Highlights and Shadows boxes.

○ The Maxtone NX screen type is also configurable. To
configure the size of highlights and shadow dots, select
values from the Dot Size Highlights and Shadows lists.

Note: It is also possible to select the dot size for the highlights and
shadows using DotShop Composer. Kodak Maxtone NX works on
the entire page, so all objects defined with Maxtone NX must
have dots of the same size. If there are multiple dot sizes selected,
the output process will fail.

○ Maxtone IS screen types are used for seamless sleeve
and cylinder output device applications. If you select
Maxtone IS, the resolution set in the Render section of
the process template must be identical to the resolution
in the IS screen system. Most IS screen systems are
predefined in the IS screen set and cannot be modified in
the process template. For information about defining IS
screen sets, see the Prinergy System Administration Guide.

To see how items in the list of IS screen systems can be
hidden, see the topic about hiding IS screen sets.

○ Maxtone IS CX screen types are used for seamless sleeve
and cylinder output device applications, but they are
configurable. If you select Maxtone IS CX, the resolution
set in the Render section of the process template must be
identical to the resolution in the IS screen set.

● Staccato identifies the Kodak Staccato stochastic screening
family.

○ The Staccato NX screen type is configurable. To
configure the size of highlights and shadow dots, type a
value in the Dot Size Highlights > Shadows box.

Select a screen system for the format selected in the Output To
list.
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Dot Shape

(See also the topic about dot shapes.)

Select a dot shape in the list.

The list of available dot shapes varies, depending on the screen
system selected in the Screen System list.

Device Resolutions

Displays the values set in the Resolution X and Resolution Y
boxes in the Render section of the process template.

Screen Ruling

Available when Maxtone, Maxtone CX, or Maxtone NX is
selected in the Screen System list.

The list of available screen rulings varies, depending on the
setting in the Screen System, Device Resolutions, and Output
To lists.

If you select an IS screen set, you cannot change the Screen
Ruling value.

Feature Size

Available when Staccato, Staccato CX, or Staccato NX is
selected in the Screen System list.

Select the most appropriate feature size (in microns or pixels)
for the screen system. A smaller number produces finer-grained
output.

The list of available feature sizes varies, depending on the
setting in the Screen System, Device Resolutions, and Output
To lists.

Note: The Staccato feature sizes denote a dot size somewhere between
the actual highlight and the midtone dot size.

Note: The Staccato CX or NX (first order) feature size denotes the exact
dot size of the highlight and quarter tone dots. Resolution is factored into
the Staccato CX or NX (first order) dot size calculations.

Note: Staccato feature sizes listed as <##>.1 indicate a first-order
screen, where <##> is the approximate dot size of the highlight and
quarter tone dots.

Midtone Frequency

Available when Staccato CX or Staccato NX is selected in the
Screen Type and Screen System lists.

Select a Staccato CX/NX midtone frequency in the list. A larger
number indicates a finer dot structure.
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Midtone frequency is an accurate measure of the number of dot
structures per inch in the midtones of Staccato CX/NX screens.
Frequency is expressed in lines per inch (lpi) and is a useful
metric with AM and FM screens when assessing qualitative,
lithographic, and imaging behavior. Staccato CX/NX midtone
frequency is comparable to Maxtone and Maxtone CX/NX
screen ruling.

Values in this box are governed by resolution and licensing. For
a complete list of the available Staccato CX midtone
frequencies and dot widths, including configurations that match
Staccato screen type feature sizes, see the section about
document screening, in this guide.

Screen Color

In the Screen Color and at Angle boxes, perform the following
tasks:

● Set screening for colors other than the four process colors
● Swap the process color screens within screen systems
● Assign a screen to the "Default" color. This screen will be

used for any color that doesn't have its own screening value
in the output process template or color database.

The screen angles associated with each process color in the at
Angle box vary, depending on the setting in the Screen System
and Dot Shape lists.

To assign a screen to a color in the Screen Color box, type the
name of a spot color, or type Default to select the default
screen angle. Use the correct capitalization and spacing in color
names.

Note: To swap two screens (for example, magenta for black), modify the
entries for both colors. In this example, modify the setting in the at Angle
box for magenta to use the black screen, and modify the setting in the at
Angle box for black to use the magenta screen.

Default Spot Color Handling

Determines how Prinergy assigns screen angles to spot colors
that do not have screen angles assigned in the Screen Color and
at Angle boxes or in the Color Editor.

To choose C, M, Y, or K as the default color screen angle, select
Screen as. To cycle through the available color screen angles,
select Cycle Through Screen Angles.
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Screen as

To assign a different default spot color screen angle, select a
color in the list.

For IS screening, Prinergy cannot assign the Others angle as the
default spot color angle.

Cycle Through Screen Angles

Select this option to assign default spot color screen angles
cyclically to the available process colors, in CMYK order.
Prinergy does not assign process colors that have already been
used to screen a spot color.

If Staccato Extended is selected in the Screen System list, the
list of screens cycles from Screen #1 through to Screen #10.

For IS screening, Prinergy cannot cycle through angles other
than CMYK.

Do not increase yellow ruling

To reduce moiré, the AM screening algorithm provides yellow
screen frequencies (lpi) that are up to 14% higher than the
cyan, magenta, and black screens. If you want a Y screen that is
more similar to the Y screen in Prinergy 2.2 and earlier, select
this check box. It limits yellow screen frequencies to between
-4% and 4% of the ruling of the C, M, and K screens. For
example, if the C, M, and K screens are at 150 lpi, this check box
limits the screening algorithm to providing a Y screen between
144 lpi and 156 lpi.

This setting does not affect the yellow frequency of an IS screen
set. To change the yellow frequency of an IS screen set, use the
IS Screen Set Editor.

Rotate Screens With Pages

Select to rotate screens with reader orientation for each page in
an imposition.

When some pages are rotated 90°, rotating screens with the
pages allows all pages to be screened at the same angle.

Screens are only rotated at 90° so pages that are oriented at
other angles are not affected. The result of rotating screens is
apparent when you screen with dot shapes that are not
rotationally symmetric, such as Elliptical and Line.
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Rotate Screens With Pages is cleared Rotate Screens With Pages is selected

Mirror Screens with Output

Select to mirror screens so they are consistent across all
devices (for output devices that have intrinsically mirrored
output).

Note: This will affect the screen angle rotation on the printed page and
should be used only for compatibility with legacy printing.

When the Mirror Screens with Output check box is selected,
selecting the Mirror Print check box in the Device section of the
process template causes screen angles to become mirrored
with the output. This is useful for some printing processes that
require mirrored film or plates, to ensure consistency of screen
angles with digital dot proofs.

Mirror Print is selected

Mirror Screens with Output is cleared

Mirror Print is selected

Mirror Screens with Output is selected

Note: If Round is selected in the Dot Shape list, the Rotate Screens With
Pages and Mirror Screens With Output selections don't affect output.

Set Halftone Phase for each Page

Select to have the renderer reset the origin of the halftone
screen for each page on an imposition.

When selected, this option ensures that each page on an
imposition has the same bitmap pattern.

This is useful for a label printer who wants each label on the
imposition to be identical. A difference in the halftone screen
origin for each label can sometimes show up as a visible
difference at the edges of the labels.
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Screen Solids

Applies a screening pattern to solid areas in order to better
absorb excess ink. This screening feature results in cleaner
printing of solid areas.

Screen solids can also be effective in reducing ink consumption
during proofing.

In the as box, type a value between 0% and 99.8% to indicate
the percentage at which you want to screen all objects with
solid (100%) tint.

Maxtone CX Dot Width

Note: This option is not available when Maxtone or Staccato is selected
in the Screen Types list.

Highlights

Type the size (in microns) of the Maxtone dot for
highlights.

Shadows

Type the size (in microns) of the Maxtone reverse dot
for shadows.

Highlights

Type the size (in microns) of the Maxtone dot for highlights.

Shadows

Type the size (in microns) of the Maxtone reverse dot for
shadows.

HyperFlex

Screening technology that allows for smaller dots and/or
graphic elements to be held on flexo plates during UV exposure
of a plate.

For more information about HyperFlex, see the Prinergy
Advanced Flexo User Guide.

HyperFlex Classic

When imaging on flexo plates, select to enhance Maxtone dots
with HyperFlex Classic technology.

Note: Kodak Hyperflex Classic is not intended for offset use.

In the extreme highlight areas, Maxtone simulates FM
screening by randomly removing dots from the AM grid.

466 Chapter 12—Outputs



HyperFlex Classic helps to support and strengthen Maxtone by
placing light valves where dots have been removed.

Pixels

Type the HyperFlex dot size in pixels.

To determine the proper HyperFlex dot size, you must perform
a series of flexo exposure tests. For more information, see the
Prinergy Advanced Flexo Implementation User Guide.

HyperFlex Advanced

In flexo applications, select to use HyperFlex Advanced with
Maxtone, Maxtone CX, Maxtone NX, Maxtone IS, Maxtone IS
CX, and Staccato NX screen types.

Note: Hyperflex Advanced is not intended for offset use.

HyperFlex Advanced places light valves around halftone dots to
strengthen and support individual dots.

Size

Type the size of the light valve in pixels. The minimum value is 1
and the maximum value is 16.

As feathering (a reduction in HyperFlex size as tone value
increases) is being applied, this value specifies the starting size
of the light valve. The light valve size is scaled back, in a linear
fashion, to zero (at the tint percentage specified in the Limit
box).

Distance: Start/End

Enter the distance between the center of the light valve and the
center of the dot.

Suggested settings—Enter the same values in the Start and End
boxes, and use a larger value than you enter in the Merge
Distance box. For example, type 2 in both the Start and End
boxes, and type 1 in the Merge Distance box. This positions the
light valves equidistant between adjacent halftone dots.

If you are not using the suggested settings, in the Start box,
type the distance from the light valve to the center of the
smallest halftone dot. In the End box, type the distance (in
pixels) from the light valve to the center of the largest dot, as
specified in the Limit box.

Merge Distance

Enter a value that determines where the light valves will be
positioned in relation to the halftone dots.
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Suggested settings—Enter the same values in the Start and End
boxes. Enter a smaller value in the Merge Distance box than
you entered in the Start and End boxes. For example, type 2 in
both the Start and End boxes, and type 1 in the Merge Distance
box. This positions the light valves equidistant between
adjacent halftone dots.

Limit

Type the tint percentage above which HyperFlex Advanced will
no longer be applied. The general recommendation is to set the
Limit between 20% and 50%.

DigiCap

Kodak DigiCap is screening software for digital photopolymer
(flexo) media that improves the transfer of ink in solid areas,
using small reverse dots (a tint).

Set the DigiCap texture by specifying the size of the reverse
dots and the tint percentage. In the Texture with boxes, type
the length and width of the reverse dots. The maximum size is
10 pixels by 10 pixels.

In the as box, type the tint percentage. For example, a 92% tint
creates an area with 8% coverage of reverse dots.

To determine the proper DigiCap feature size and percentage,
you must perform a print test containing multiple combinations
of coarseness levels and tint percentages. You cannot
determine the feature size or percentage without
comprehensive press tests. For more information, see the
Prinergy Advanced Flexo Implementation User Guide.

In the Keepaway box, type the distance (in pixels) between the
edge of elements to which DigiCap texturizing should not be
applied and the start of DigiCap texturizing.

See also:
About document screening on page 637
About dot shapes on page 638
Screen types on page 641
About screen systems on page 643
Setting up Maxtone screens on page 663
Setting up Staccato screens on page 664
Creating and editing IS screen sets on page 665
Hiding IS screen sets on page 668
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Processed File Options section of the Loose Page Output process
template

This process template section identifies the file naming parameters
during loose page output.

Prinergy-defined File Naming

Use Prinergy-defined File Naming

Select to use the default file naming convention for output files.

Maximum Characters for File Name

Type the maximum number of characters for the page name
part of the file name.

Note: If you select Respect Mac Filenames, the maximum number is 17.

Respect Macintosh Filenames

Select to shorten Prinergy file names to 31 or fewer characters,
because Macintosh file names are restricted to a length of 31
characters.

For loose page output, the Prinergy file name consists of:

● 18 characters for the page name (including the period that
separates the page name and extensions)

● 13 characters for surface, version, and color extension
(including periods).

For example, thisisthepagename.1A.vers.M.VPS.

When you select this check box, Prinergy shortens the first
name part of the file name to the number of characters that you
specify in the Maximum Characters for File Name box.

When you select this check box, spot colors are represented in
the file name by an index number.

When you clear this check box, the full spot color name is
added to the output file name, with PANTONE abbreviated to
PMS, and the CVC or CV suffix removed.

Overwrite Existing Files with Same Name

(See About outputting to a file on page 661)

Select if you want to use the newer files when multiple files
have the same name.
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Available when Job-Relative File is selected in the Output Type
box.

Custom File Naming

Use Custom File Naming

Select this check box if you want to specify the output file
names.

Notes: If you select this check box:

● And if you want to respect Macintosh file names, you must restrict
each tag in the Filename Template box, so that the longest possible
file name is 31 characters or less.

● Overwrite Existing File with Same Name is selected. If you want to
generate and keep iterations of a file, include a %version% tag in
the Filename Template box.

Filename Template

(See About custom file naming on page 657)

Type the file name format for the output files.

Controlfile Filename Template

If outputting to a format which requires a control (master) file,
type the file name format for the control file.

Use Full Spot Color Names

Select this check box if you want to use the spot color names in
the output file names (instead of numbers which are derived
from the spot color order).

Note: To use this check box, you must include the %color% tag in the
Filename Template.

PDF File Name

If printing to PDF, the PDF file name is based on the job name by
default. To modify the PDF file name, type the file name you
want in the box.
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File Format section of the Loose Page Output process template
This process template section identifies the format and compression
settings of the output files during loose page output.

Include Images as

If printing to PDF, select Original to output the original images
in the output file.

Select Low Resolution to output low-resolution versions of the
images in the output file.

Compression

(See About outputting to a file on page 661)

The compression options that are available vary depending on
the output format selected in the Output To list at the top of
the process template. The following compression options are
available:

● None—Select if you do not want to compress files
● CCITTG3—Not available if outputting to a non-screened

format
● CCITTG4—Not available if outputting to a non-screened

format
● LZW
● RLE
● ZIP—Select if you use Kodak Staccato screening software

Note: Compression methods CCITTG3 and CCITTG4 are unavailable if
the Always use Color Combiner to Convert Spots check box is selected
in the Render section of the process template or if any Staccato
screening system is selected in the Screen System box in the Calibration
& Screening section.

Quality

The quality control option is available only if the Output To list
is set to JPEG.

Prinergy provides five JPEG compression quality options
ranging from maximum quality (the least compression and the
smallest loss of data) to minimum quality (the most
compression and the greatest loss of data).

● Maximum
● High
● Medium
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● Low
● Minimum

The lower the quality of JPEG compression, the smaller the file
size, but the greater the chance of noticeable blockiness in
certain areas of the image. You should experiment with JPEG
compression levels to see what amount of image degradation is
acceptable for your purposes.

Advanced TIFF Tags

(See About advanced TIFF tags on page 650)

Select to add advanced TIFF tags to output files.

Note: Unless you are outputting to Virtual Proofing System 2.0 or
Copydot Toolkit software, we do not recommend selecting this option
because some devices that do not recognize advanced TIFF tags may
reject the entire file.

Available when a TIFF or Virtual Proofing System format is
selected in the Output To list at the top of the process
template.

Use Custom TIFF Title Tag

Select the check box and type a custom name in the box to
create custom title tags in the TIFF file. This feature replaces
the need to manually edit the TIFF file.

Use this feature when sending Virtual Proofing System files
through Digital Blueline to merge separations from different
signatures.

Note: In the box, you can include variables such as %job% and
%signature% .

DCS File Format

Select Single File to generate one pre-separated DCS file—that
is, one file that contains all the pre-separated colors. The file
name will be, for example: <PDF filename>.p00n.eps.

Select Multiple Files to generate a DCS file set—that is, one file
for each color separation, plus a master file for the set. The file
names will be, for example:

<PDF filename>.p00n.dcs.eps
<PDF filename>.p00n.C.eps
<PDF filename>.p00n.M.eps
<PDF filename>.p00n.Y.eps
<PDF filename>.p00n.K.eps
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<PDF filename>.p00n.1.eps
Available when DCS is selected in the Output To list at the top
of the process template.

EPS Data

Select the encoding method to use for EPS data.

Available when EPS Raster is selected in the Output To list at
the top of the process template.

DCS Data

Select the encoding method to be used for DCS output.

Available when DCS is selected in the Output To list at the top
of the process template.

EPS Compression

Select the compression method to use for EPS output, or None
if you do not want to compress EPS files.

Available when EPS Raster is selected in the Output To list at
the top of the process template.

DCS Compression

Select the compression method to be used for DCS output, or
select None if you do not want to compress the DCS file.

Available when DCS is selected in the Output To list at the top
of the process template.

Add TIFF Preview to DCS Master File

Select to add a preview file to the master file for a DCS-2
multiple file set. You can view the preview file in software such
as Preps and QuarkXPress.

Specify a resolution for the preview file in the at Resolution box.

Available in the Loose Page Output and Imposition Output
process templates when EPS vector or DCS (raster or vector) is
selected in the Output To list. Available in the Final Output
process template when DCS raster is selected in the Output To
list.

Always use custom Large TIFF format

This check box is available only when the file output type is set
to TIFF. By default, this option is disabled.
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Select this check box to create a JDF file that links multiple large
TIFF files (less than 4 GB). This set of files represents a single
plate.

Document Format

Select Multi Page to generate one output file for the entire
range of selected surfaces or Single Page to generate one file
for each surface.

Available in the Loose Page Output and Imposition Output
process templates when a vector output (except DCS) is
selected in the Output To list. Available in the Final Output
process template when PS3 (PostScriptOut) is selected in the
Output To list.

Single Page is not recommended for digital printers.

Vector Output Options

Output Format

Select Composite or Separated output. The selection
determines whether or not conversion is required based on the
input file format. Select Automatic to generate files in the same
format (composite or separated) as the input files.

Note: Separated PDF/X-1a:2001 and composite DCS-2 are not
supported.

Note: Spot color handling (omission, mapping, and converting) in the
Color Separations dialog box is not supported for composite vector
output.

Note: The Automatic option is available when vector output (except
DCS) is selected from the Output To list at the top of the process
template.

Render Shadings

Select to render PostScript 3 vector objects with Level 3 smooth
shades to produce rasterized contone objects in order to meet
the PostScript Level 2 standard. Target workflows may process
rasterized objects faster than vector ones, but there may be
some quality degradation for subtle shadings that extend over
long distances.

Specify a resolution for the rendered shadings in the at
Resolution box.

Available when DCS, PS2, PS3, or PDF is selected in the Output
To list.
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Font Outlining

Select to replace all text objects with vector objects in output
pages.

This is available to DCS, PDF, and separated PostScript vector
output formats. It is useful for eliminating font formats that
certain RIPs may not be able to process. Text output in this way
cannot be edited and when previewed in Adobe Acrobat, will
look bolder than the original text due to loss of font hinting for
low-resolution monitors.

Delete Traps

Select to remove any Prinergy-generated traps from PDF,
PostScript Level 2, and DCS-2 output files.

Trapping-generated overprints remain in the files.

Apply Geometry

Select to apply geometry settings to PDF, PostScript Level 2,
and DCS-2 output files.

You can set the geometry for a page (offset scale, orientation)
in the Set Page Geometry dialog box.

If this check box is selected, the geometry is applied to the
output file. To access the Set Page Geometry dialog box, from
the Edit menu, select Set Page Geometry.

Simulate overprints (CMYK only)

Select to replace overprint intersections with an opaque object.

This creates a page that maintains its integrity on output, even
if a downstream publisher or printer configures their workflow
to override overprints.

Preserve PDF Layers

Applies to the Layered PDF Versioning feature. For more
information, see the Layered PDF Versioning user guide.

Send PostScript duplexing commands

Select to print on both sides of the media. Assuming a portrait
sheet orientation, select Turn print pages side to side by
flipping on the long edge. Select Tumble to print both sides by
flipping on the short edge.

This option simply adds the duplex command to the PostScript
output. The consuming device may not support this command.
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Create Preflight Report, If Available

Select this option to create a preflight report, if you already have
a preflight profile set up and you have set the options on the
Refine process template, PDF Preflight panel.

Output Intent

Use this area to specify an ICC profile or named print condition
in the Output Intents section of the PDF/X file that you are
generating.

A named print condition is a documented printing situation with
a defined relationship between input data and the colorimetry
of the printed image. Typically, named print conditions are
registered with an organization such as the ICC.

Perform one of the following actions:

● To specify an ICC profile, select the Profile check box, and
specify the path of a profile.

● To specify a named print condition, select the Name check
box, and select a print condition from the list.

● To use the ICC profile specified in the ColorConvert section
for PDF/X generation, click the Use ColorConvert
Destination profile check box.

Note: Match Colors in Page Content in the ColorConvert section
must be selected.

This area is available only when a PDF/X format is selected in
the Output To list at the top of the process template.

Device section of the Loose Page Output process template
This process template section identifies device-related parameters for
the output during loose page output.

Output Type

Select Absolute File or Printer to enter the path for a specific
network device or file location.

Select Job-Relative File to enter a path that is relative to the
location of the job folder.

Note: The default is Job-relative file and the Device Path box default is
%JOB%.

Typing a path for a network device in the Device Path box
automatically sets the Output Type to Absolute File or Printer.
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Submit as Multiple Print Jobs

Select to submit a separate job for each surface that is output.

Available when Absolute File or Printer is selected as the
Output Type or when the Delta option in the Render section is
enabled.

Device Path

The default setting depends on the value selected as the Output
Type.

● If Output Type is Absolute File or Printer, the default is
Clear. Type the name of a Windows NT network output
device using the UNC (Universal Naming Convention) path.
Or you can click Browse to select a file location.

● If Output Type is Job-Relative File, the default is %JOB
%Proofs. The default value places the output in the Proofs
folder of the job that creates the process. You can change
the Proofs folder to any subfolder found in a job folder.

You can also include the following marks in the Device Path
box:

● $[jobname;n]
● $[ProcessPlanName;n]

Note: Replace the n in the marks name with a number between one and
99 to specify how many characters from the associated mark to include
in the mark.

For example, %JOB%Proofs\$[jobname;6] for
MyJobName becomes %JOB%Proofs\MyJobN.

Mirror Print

Select to output media with the emulsion side down.

Negative Print

Select to output a negative image.

Cut Media

Select when you want the device to automatically cut the
media.

Available when a device with a media cutting system is selected
in the Output To list.

Load Media

Select when you want the device to automatically load the
media.
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Available when a device with a media loading system is
selected in the Output To list.

Unload Media

Select when you want the device to automatically unload
media.

Available when a format for a device with a media loading
system is selected in the Output To list.

Manually

Select when you want the device to prompt the operator to load
the device manually.

Available when a format for a device with a media loading
system is selected in the Output To list.

Media Unload Mode

Select the mode for unloading media.

Available when a format for a device with a media loading
system is selected in the Output To list. See your device's
documentation for more information.

HPRTL Device

If you have a Hewlett-Packard device, select HP.

If you have the Kodak Iris 43WIDE device, select Iris/Mutoh.

HPRTL is a raster file format developed by Hewlett-Packard and
used by a number of device manufacturers.

Available when HPRTL is selected in the Output To list.

Proofer Name

Dynamically lists all of the proofers discovered on the network.
Type or select the name of the particular proofer to which you
want to send the proof.

The name may include both the proofing controller's name and
the proofer name in a ControllerName/ProoferName format.

Available when Veris/Matchprint Inkjet is selected in the
Output To list. For more information about proofers, see the
proofer documentation.

Proofer Model

A read-only box that describes the type of proofer selected in
the Proofer Name list.
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Number of Proofs

Type the number of copies that you want printed.

This box applies only when Output To is set to Veris/
MatchPrint Inkjet.

Include JDF for Digital Print section of the Loose Page Output
process template

Enable this section if you are generating PDFs to a digital printer and
you want to use a JDF file to communicate with the printer.

The Include JDF for Digital Print section is available only when the
Output To list is set to either PDF (Vector output), PDF Raster, or
TIFF.

Job Settings

Number of Copies

Type the number of copies to be printed.

Job Name

(See About custom file naming on page 657)

Determines the job name that is sent from Prinergy to the
digital printer using standard Prinergy placeholders. The default
%job% displays the job name as specified in Prinergy.

Device Selection

Select a Device Type

From the Select a Device Type list, select a digital printer
controller.

The selection you make affects the options that are available in
the Select JDF Templates, Media Selection, Media Handling,
and Device Specific Settings.

Send Files to Printer using

Select Network Copy or HTTP Protocol to determine how the
content file is referenced in the JDF file that is copied to the hot
folder on the digital printer.
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PDF Path

Type the path to the folder where Prinergy creates the PDF for
the printer to output. You can also click Browse and locate the
folder.

If you are sending these files to a hot folder, this path must not
be the one specified in the JDF Path box. The JDF specification
requires that only the JDF files be dropped into a JDF-enabled
hot folder.

PDF File Name

(See About custom file naming on page 657)

Type the file name of the PDF file that Prinergy generates. Use
standard Prinergy placeholders, such as %JOBNAME%.
%extension%.

JDF Path

Type the path to the folder where Prinergy will create the JDF
file. You can also click Browse and locate the folder.

If you are sending files to a hot folder, this path must be the hot
folder for the digital printer. It cannot be the same folder
specified in the PDF Path box. The JDF specification requires
that only the JDF files be dropped into a JDF-enabled hot folder.

JDF File Name

(See About custom file naming on page 657)

Type the file name of the JDF file that Prinergy generates. Use
standard Prinergy placeholders, such as %JOBNAME%.jdf.

Select JDF Templates

Select Named Features

Use this field only as instructed by the Prinergy Digital Print
Installation and Configuration Guide.

If necessary, enter JDF parameters for Prinergy to send in the
JDF file to the digital print controller. Typically, these
parameters are specific to the digital print controller. Not all
digital print controllers require or support this option. The
parameters are not visible in Prinergy.

Select JDF File

Click the Browse button to locate the appropriate template. If
you do not specify a template, the default template is used.
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Media Selection
Use Default Media Handling

Select this option to use the default options displayed.
Otherwise, click Use Selected Media Handling to customize the
settings.

Use Selected Media

Select this option to customize weight, size, and other aspects
of the media.

Weight

Type the weight of the paper stock that the job is to be printed
on. If the paper set on the printer has a range of weights (e.g.
81-105 gsm), any number within that range matches.

Color

Select the color of the paper stock that the job is to be printed
on.

If you select None, Prinergy does not send color information to
the digital printer.

Coatings

Select a coating such as Glossy or Satin to indicate that the
paper stock is coated, or select None to indicate that the paper
stock is uncoated.

Size

Select the size of the paper stock that the job is to be printed on.
Choose from:

● Letter, Legal, A4, and other standard paper sizes.

If you select one of these sizes, you can use the Width and
Height boxes to modify the default measurements of the
paper.

● Automatic—The size is set to the size of the pages or
surfaces.

● None—The size is set to the size of the default paper defined
by the printer queue.

● Custom—Use the Width and Height boxes to specify the
measurements.

This option affects only the paper size that the digital printer
uses. It does not affect the PDF that Prinergy sends to the digital
printer. To change the size of the PDF sent by Prinergy, use the
Layout section of the Imposition Output process template.

Typically the paper size matches the size of the page or surface.
If the paper size does not match the page or surface size, most
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digital printers can scale, center, shift, and impose the PDFs
onto the paper.

Width

Type the width of the paper stock that the job is to be printed
on. If the paper set on the printer has a range of widths, any
number within that range matches.

Height

Type the height of the paper stock that the job is to be printed
on. If the paper set on the printer has a range of heights, any
number within that range matches.

Media Handling

Use Default Media Handling

Select this option to use the default options displayed.
Otherwise, click Use Selected Media Handling to customize the
settings.

Use Selected Media Handling

Select this option to customize duplexing and collation settings.

Duplexing

Select an item that controls whether the printer prints on both
sides of the paper. Choose from:

● SingleSided—Print only on one side of the paper.
● Turn—Print two-sided head-to-head (flip on the paper's long

side or the Y-axis of the paper in portrait orientation)
● Tumble—Print two-sided head-to-toe (flip on the paper's

short side or X-axis of the paper in landscape orientation)

Collation

Select either Sheet or None to control whether the printer
collates the output.

Device Specific Settings

Device Name

Type the name of the digital printer or the print server. For
example, type Spire01.

Queue

Type the name of the print queue. For example, type
ProcessStore.
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Device Type

Type the type and version of the digital printer to assist Xerox
FreeFlow Print Manager in translating the JDF. For example,
type DC8000_SPIRE1.0.

Protocol

Type the name of the print protocol that the digital printer uses.
Xerox FreeFlow Print Manager translates the JDF into this print
protocol. For example, type SPIREPR.

Job Spec

Type the name of a pre-defined workflow.

This box applies only when you have selected an HP device.

Marks section in the Loose Page Output process template
This process template section determines how marks are handled
during loose page output.

Extra Margin for Marks and Bleed

When calculating the position of pages, additional space is
included for marks and the bleed, if indicated.

Provide margin values for Left, Right, Top, and Bottom margins,
in the selected unit of measure.

Bleed for Unassigned Pages

Prints a bleed line when proofing PDF pages that have not yet
been assigned to a position of an imposition plan. When
assigned pages are proofed, the bleed lines are taken from the
imposition plan.

Provide values for Left, Right, Top, and Bottom in the selected
unit of measure.

Crop Distance Beyond Bleed for Pages

Creates an additional margin beyond the bleed marks to allow
output of the software information that is positioned outside
the bleed.

Provide values for Left, Right, Top, and Bottom, in the selected
unit of measure.

This value, and any value that extends the crop beyond the page
size, allows the entire page image to be output (up to the page
size defined by other layout measurements).

A negative value moves the crop inside the bleed by the
specified amount.
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If the pages are assigned to page positions linked to an
imposition plan, this value is added to the bounding box defined
on the imposition plan. If the assigned page positions are linked
to multiple imposition plans, the largest bounding box is
calculated and this value is added to the calculated
measurement.

Default Marks Font

Prinergy can populate variable marks with double-byte
characters such as those found in Japanese, Chinese, and
Korean.

Here's an example of how you could use the feature:

1. Create a Preps imposition file that includes a variable mark,
such as $[PageName].

2. In Prinergy, in the Default Marks Font box in the Marks
section of the imposition output process template, type the
exact name of the double-byte font that can be used in case
the variable mark's original font was not a double-byte font.
The font must reside either in a Prinergy-aware font folder or
in the job's font search path.

3. Submit the imposition file to Prinergy.

If the imposition file contains a page name with double-byte
fonts, Prinergy outputs the file with these characters.

Sheet Marks

Identify the name and location of a PDF file containing sheet
marks (for example variable marks, logo, and signoff line). Click
Browse to locate and select a file.

Calibrate

When this check box is selected, the plate curve and print curve
are applied to the mark. The curves applied are the ones
selected in the Plate Curve list and Print Curve list in the
Calibration and Screening section of the process template.
When this check box is cleared, only the plate curve is applied.
To prevent the application of the plate curve to a mark, select %
%None%% in the Plate Curve list in the Calibration and
Screening section of the process template.

Locate Sheet Marks Adjacent to

(See Sheet marks options explained on page 695 and Sheet
marks on final output on page 691.)

Select Left, Right, Bottom, or Top to determine on which edge
of the paper or plate a sheet mark is placed.
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The default setting is Bottom.

at Distance

(See Calculating the at distance value on final
output on page 692.)

Determines where, relative to the edge, the mark is placed:

● Sheet marks are placed relative to the plate edge. Depending
on the distance you type, you can place the sheet mark on
the press sheet or on the plate.

● Page marks are placed relative to the finished page size (the
imposition hole).

Justified

Select Left, Center, or Right to determine the justification for
the sheet mark.

The default value is Center.

Page Marks

Identify the name and location of a PDF file containing page
marks. Click Browse to locate and select a file.

You may need to provide space for page marks by increasing
gutter measurements.

The variable mark $[PagePositionNumber] or $[PPN] can be
used to verify that the pages are in the correct page set
positions in the imposition.

Calibrate

When this check box is selected, the plate curve and print curve
are applied to the mark. The curves applied are the ones
selected in the Plate Curve list and Print Curve list in the
Calibration and Screening section of the process template.
When this check box is cleared, only the plate curve is applied.
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To prevent the application of the plate curve to a mark, select %
%None%% in the Plate Curve list in the Calibration and
Screening section of the process template.

Locate Page Marks Adjacent to

Select where to place the page marks in relation to the page's
trim box.

When you select Right or Left, the page marks rotate as
follows:

● Left—rotates the mark 90° counterclockwise
● Right—rotates the mark 90° clockwise
● Bottom—no rotation
● Top—no rotation

at Distance

(See Calculating the at distance value on final
output on page 692.)

Determines where, relative to the edge, the mark is placed:

● Sheet marks are placed relative to the plate edge. Depending
on the distance you type, you can place the sheet mark on
the press sheet or on the plate.

● Page marks are placed relative to the finished page size (the
imposition hole).

Draw Trim and Bleed Marks

Determines where, in relation to each page, trim and bleed
marks should be placed. Trim and bleed marks are created in
registration color and are 0.25 points in weight. Bleed marks are
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solid lines; trim marks are dashed lines. Trim marks are drawn
according to the option selected:

None

Trim and bleed marks are not drawn.

On Content

Trim and bleed marks are drawn on the content
(complete trim marks are drawn on the proof).

Outside Content

Trim and bleed marks do not extend to the content
(only the four corners appear on the proof).

Note: In order to print bleed lines on loose page output, the page must be
assigned to a page set that is linked to an imposition plan. The bleed lines
are taken from the imposition plan.

Safe Protect Box

The safe protect box enables you to print proofing lines within
the trim box (or media box) on a proof to check that the page
content is within the page margins. The safe protect box is
drawn on the proof inside the trim or media box.

This feature is available in the loose page output and imposition
output process templates when the Draw Trim and Bleed
Marks option is set to On Content or Outside Content.

Note: If you select Output To Virtual Proof, you can select the Safe
Protect Box check box even if you select None for Draw Trim and Bleed
Marks. In this case, you can view the safe protect box in the Virtual
Proofing System software. The safe protect box is not printed on the
proof.

Select the Safe Protect Box check box and in each of the Left,
Right, Top, and Bottom boxes, type the distance from the trim
or media box that you want the safe protect lines to appear.
You can type different numbers in each of the four sides.

When calculating where to place the safe protect lines, note
that Prinergy measures from various starting points as shown in
the following table.

Proof Safe protect box is measured from this location

Imposition The imposition hole trim box
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Loose page ● The PDF page trim box—if the PDF page
includes trim

● The PDF page media box—if the PDF page does
not include trim

If a PDF page includes trim, it appears in the Trim
Size column in the Pages pane of the Pages view.

Note: If the PDF page does not include trim, you
can define it using the Prinergy Geometry Editor
plug-in for Adobe Acrobat. After the trim is
defined, refine the page again.

The lines of the safe protect box are drawn according to the
option selected for trim and bleed marks:

● If you selected Outside Content, only the four corners of the
safe protect box appear on the proof.

● If you selected On Content, the complete box is drawn on
the proof.

Note: If you entered information for Trim Adjustment, the Safe Protect
Box dimensions are calculated based on the Trim Adjustment
dimensions.

Trim Adjustment

If you are using pages that have no trim or an incorrect trim box,
in the Trim Adjustment area, type the distance from the edge of
the page that you want trim lines to appear in each of the Left,
Right, Top, and Bottom boxes.

You can type different numbers in each of the four sides.

Trim Adjustment is available only when you select Draw Trim
and Bleed Marks, and On Content or Outside Content.

Note: If you enter information for Trim Adjustment, the Safe Protect Box
dimensions are calculated based on the Trim Adjustment dimensions.

Locate Crop Mark of Length

Available if On Content or Outside Content is selected in the
Draw Trim and Bleed Marks box.

Determines the length of the crop marks to be drawn, in the
selected unit of measure.

The at Distance box determines how far away from content to
draw the crop mark.

at Distance

Available when On Content or Outside Content is selected in
the Draw Trim and Bleed Marks box.
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Determines how far away from content to draw the crop mark.

Unit Used for Variable Marks

Select the unit you want to use to measure variable marks—
inch, cm (centimeter), mm (millimeter), or pts (points).

Slugline

A slugline mark is a text or variable mark that you place on
loose page, imposition, or final output. Instead of using Sheet
Marks or Page Marks, you can use Slugline to quickly place a
slugline mark.

A slugline mark does not need a PDF file, so you can easily
place a mark without creating a PDF file. However, a slugline
mark is just a line of text or a variable mark. You can only
specify the text size.

● In the Slugline mark box, type the text or variable mark.
● In the Text size box, type the font size for the mark.
● In Place on media, specify the distance from left and from

bottom.

Note: If you are using a variable mark in your slugline, the _offset and
_replace parameters, and any page-oriented variables parameters, are
not currently supported.

Generating imposition outputs
Follow the instructions in Starting a Process and choose an imposition
output process template.

Tip: You can select signatures or surfaces in the Signatures view. Pages must be
assigned to a page set that is linked to an imposition plan.

See also:
Starting processes on page 171
Imposition Output process template on page 489

Imposition Output process template
At the top of the dialog box is the Output To list, which you use to
select the file format suitable for the output device you select in the
Device section. The file format selection determines the availability of
some options in this process template. For this reason, you should
select an output format before you set the other options in the process
template.
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Copydot section of the Imposition Output process template
This process template section defines how Prinergy handles copydot
files during imposition output.

When you enable the Copydot section, the system automatically
converts copydot images for optimal quality on your output device
during output. Only disable the Copydot section for one or more of the
following reasons:

● Your pages lack copydot images.
● You are outputting at your target device resolution.
● You don't need high-quality copydot images in your imposition

output.

JTP

Select a job ticket processor (JTP) to use for copydot files.

Note: You set up JTPs using Prinergy Administrator.

Resample

Enables resampling of copydot files to the resolution required
by the output device. The availability of this option is controlled
by the device you select in the Output To list at the top of the
final output process template dialog box.

Select the Resample check box to enable resampling of copydot
files. Prinergy resamples copydot files to the resolution required
by the output device you select in the Output To list at the top
of the process template.

Clear the Resample check box to disable resampling.

Note: You can resample copydot images during another step in the
process—refine, loose page output, or final output.

Descreen

Enables descreening of copydot files for contone output
devices. The availability of this option is controlled by the
device you select in the Output To list at the top of the process
template. This option becomes available only for 8-bit final
output devices.

Select the Descreen check box to enable descreening.

Clear the Descreen check box to disable descreening.
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Calibration Curve

Specifies a calibration curve from Harmony tonal calibration
software for the copydot files.

From the Calibration Curve box, select the calibration curve you
want Prinergy to use for copydot files.

Select %%NONE%% to disable this feature.

ColorFlow section of the Imposition Output process template
The ColorFlow section of the imposition output process template
defines how Prinergy applies ColorFlow settings during imposition
output .

When you configure the ColorFlow settings in an output process
template, you select the device, device condition, and plate line, but not
a color setup. The color setup used is the one that was assigned to the
pages when they were refined—that is, either the color setup specified
in the refine process template that was used or the job's default color
setup. The color setup that is used during output processing is the
color setup specified for each page in the Color Setup column in the
Pages pane.

WARNING: Output will fail if the color setup does not match the color setup
assigned during refine, unless the Allow undefined color setup or color setup
mismatch option is enabled.

It is possible to select from four modes for output to halftone devices
or files. These modes control the curves that are applied upon output.

Print Production

This halftone output mode reflects the standard operation of
Prinergy and ColorFlow for production. When this option is
selected, curves are applied to each output separation, as
described next:

● The print calibration curve for the separation, determined by
the selections from the Snapshot, Device, and Device
Condition lists, and possibly modified at run time by the
settings in the Tonal Control dialog box, is applied to
separation input tints.

● The plate calibration curve, determined by the selections from
the Plate Setup and Plate Line lists, is applied to the
separation tints modified by the print calibration curve.

Note: If None is selected from the Plate Setup and Plate Line lists, the
plate calibration curve is linear (has no effect).
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This option is not available when a process template is
configured for continuous-tone (non-screened) output.

Print Characterization

This halftone output mode is used to print and measure the
response of a print device. When this option is selected, curves
are applied to each output separation as follows:

● The device curve for the separation, determined by the
selections from the Snapshot, Device, and Device Condition
lists, with no modifications from the Tonal Control dialog
box, is applied to separation input tints.

● The plate calibration curve, determined by the selections from
the Plate Setup and Plate Line lists, is applied to the
separation tints modified by the print calibration curve.

Note: If None is selected from the Plate Setup and Plate Line lists, the
plate calibration curve is linear (has no effect).

When this option is selected, the Device list contains all curved
print devices in the selected snapshot, and the Device
Condition list contains all ColorFlow device conditions in the
selected snapshot that use the selected device. If the selected
device condition uses a plate setup, the Plate Setup list displays
this plate setup, and the Plate Line list contains all ColorFlow
plate lines controlled by the plate setup in the selected
snapshot.

When this option is selected, the Color Setup list is not
available.

This option is not available when a process template is
configured for continuous-tone (non-screened) output.

Plate Verification

This halftone output mode is used to verify the linear response
of plates produced by a particular plate line (consisting of the
computer-to-plate device, plate processor setup, and
chemistry), with a selected screening system. When this option
is selected, the following results occur:

● Only the plate calibration curve, determined by the selections
from the Plate Setup and Plate Line lists, is applied to input
tints of all separations.

● No print calibration curve is applied.

When this option is selected, the Plate Setup list contains all
ColorFlow plate setups in the selected snapshot, and the Plate
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Line list contains all ColorFlow plate lines controlled by the
selected plate setup in the selected snapshot.

When this option is selected, the Color Setup, Device, and
Device Condition lists are not available.

This option is not available when a process template is
configured for continuous-tone (non-screened) output.

Plate Characterization

This halftone output mode supports imaging and measuring the
uncalibrated (or intrinsic) response of a plating line, such that a
plate linearization curve can be computed. When this option is
selected, no calibration curves are applied to input tints of any
separations.

When this option is selected, none of the lists in the ColorFlow
section are available.

This option is not available when a process template is
configured for continuous-tone (non-screened) output.

Allow undefined color setup or color setup mismatch

This check box enables the job to run when the selected color
setup differs from the color setup assigned by the refine
process, or if the color setup has not been defined. Note that
when this feature is enabled, output could be significantly
different.

To use this feature, it is recommended to select an approved
color setup listed in the snapshot or by ID number. This will
ensure that the list of devices and device conditions are filtered
to include only those available in the selected color setup. Then,
the Allow undefined color setup or color setup mismatch check
box can be selected and output will succeed with a warning
message.

To output refined pages with no color setup assigned to them,
you can select the Allow undefined color setup or color setup
mismatch setting.

The list of devices and device conditions is unfiltered when
<Job_Color_Setup> is selected. Note that this may cause
output to fail, if the device and device condition selected are not
in the job color setup. A message will be logged in the process
history, and you will need to either select a device and device
condition used in the job color setup or use the recommended
solution, as described above.

When <Color_Setup_Assigned_by_Refine> is selected, the list
of devices and device conditions is also unfiltered, and the

Imposition Output process template 493



Allow undefined color setup or color setup mismatch check
box is grayed out and cannot be used. Note that this is the
default color setup setting for all process templates that were
upgraded from Prinergy Connect 5.1.

Snapshot

A ColorFlow snapshot captures the state of the entire color
database, making its elements available to the workflow and
providing a convenient backup. The snapshot feature makes it
unnecessary for you to manually save and name multiple
versions of your color control elements after adjusting them. At
any time, you can easily roll back (revert) to the state of a
previous snapshot in the ColorFlow software. If you roll back to
a previous snapshot, ColorFlow behaves as if changes after that
snapshot never happened.

When you have completed your work in ColorFlow to a certain
level and you are satisfied with the elements in color setups,
you will mark a snapshot as approved. By default in Prinergy
Connect, the currently approved snapshot is used. Only one
snapshot can be in the approved state at any time.

This list is not available if the Plate Characterization option is
selected.

Color Setup

This list displays the names of all color setups in the selected
snapshot. At the top of the list is Color setups assigned by
Refine, followed by Job color setup.

This list is available only if the Print Calibration mode is
selected.

Allow undefined color setup or color setup mismatch

This check box enables the job to run when the selected color
setup differs from the color setup assigned by the refine
process, or if the color setup has not been defined. Note that
when this feature is enabled, output could be significantly
different.

To use this feature, it is recommended to select an approved
color setup listed in the snapshot or by ID number. This will
ensure that the list of devices and device conditions are filtered
to include only those available in the selected color setup. Then,
the Allow undefined color setup or color setup mismatch check
box can be selected and output will succeed with a warning
message.
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To output refined pages with no color setup assigned to them,
you can select the Allow undefined color setup or color setup
mismatch setting.

The list of devices and device conditions is unfiltered when
<Job_Color_Setup> is selected. Note that this may cause
output to fail, if the device and device condition selected are not
in the job color setup. A message will be logged in the process
history, and you will need to either select a device and device
condition used in the job color setup or use the recommended
solution, as described above.

When <Color_Setup_Assigned_by_Refine> is selected, the list
of devices and device conditions is also unfiltered, and the
Allow undefined color setup or color setup mismatch check
box is grayed out and cannot be used. Note that this is the
default color setup setting for all process templates that were
upgraded from Prinergy Connect 5.1.

Device

An individual occurrence of a physical device that captures or
produces an image. Devices have a type and customer-
specified properties, such as a name and location in the plant.
Because the declaration of a device does not include its
operating conditions—such as ink selection, type of screening,
and paper—you cannot measure the color response of a device
on its own.

When a process template is configured for halftone (screened)
output processes, this list displays the names of all curved
devices used in PCO (primary color output) or SCO (secondary
color output) device conditions in the selected color setup and
snapshot. Curved print devices are those with the following
device types:

● Offset press—for example, sheetfed, heatset web, coldset
web

● Digital press—for example, Versamark
● Digital halftone proofer—for example, Kodak Approval,

Trendsetter Spectrum

When a process template is configured for continuous-tone
(non-screened) output, this list displays the names of all non-
curved devices used in PCO or SCO device conditions in the
selected color setup and snapshot. Non-curved devices are
those with the following device types:
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● Digital press—for example, Nexpress
● Inkjet proofer—for example, Matchprint Inkjet, Kodak Veris
● CMYK reference

This list is not available if the Plate Verification or Plate
Characterization option is selected.

Device Condition

A combination of a device and the operating conditions in
which the device captures or produces an image. A device
condition has a known color response. Device conditions can be
divided into groups such as print conditions (press and proofer
devices), capture conditions (scanner and camera devices), and
reference print conditions (industry specifications). A device
condition can include more than one device. If all the devices
are the same device type, they use the same consumables and
operational settings, and they can be calibrated to yield the
same color response.

When a specific color setup is selected, this list contains all
ColorFlow device conditions that use the selected device and
are used in the PCO or an SCO of the selected color setup and
snapshot.

This list is not available if the Plate Verification or Plate
Characterization option is selected.

Plate Setup

If the selected device condition uses a plate setup in the
selected snapshot, this plate setup is displayed here. Otherwise,
this list displays None.

This list is not available if the Plate Characterization option is
selected. It is also not available when a process template is
configured for continuous-tone (non-screened) output.

Plate Line

You establish the behavior of a particular plate, screening, and
plating line by plating a tint ramp, manually measuring the
resulting dot area on the plate, and entering the values in the
Plate Setups dialog box in the ColorFlow software.

A ColorFlow plate line is associated with only one plate setup.
In your shop, you may use a platesetter and chemistry to
process several different screenings. To model this, in
ColorFlow, create similar plate lines in the other plate setups.
You can name them to match the equipment in your plant. You
may want to create several plate lines to indicate when
chemistry changes occur. For example, if you routinely change
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solutions on Mondays, you might create different ColorFlow
plate lines for Monday, Wednesday, and Friday.

If the Plate Setup list displays a plate setup, the Plate Line list
contains all ColorFlow plate lines controlled by the plate setup
in the selected snapshot. If the Plate Setup list displays None,
the Plate Line list also displays None.

This list is not available if the Plate Characterization option is
selected. It is also not available when a process template is
configured for continuous-tone (non-screened) output.

ColorConvert section of the Imposition Output process template
This process template section defines how Prinergy handles color
converting during imposition output.

Color converting, as part of imposition output, transforms the color
description of colored objects in a PDF page to the appropriate final
output color space, and then to the appropriate color space of the
imposition output device. As a result, the imposition output simulates
the intended final output.

JTP

Select the job ticket processor (JTP) to use for color conversion.

You set up JTPs using Prinergy Administrator.

Match Colors

Match Colors in Page Content

Enables the Color Matcher to match hues in the page content
for proofing. In other words, it enables color matching as it was
done in Prinergy 1.1 (as opposed to using the Color Matcher to
affect the L*a*b* spot color recipes).

Select this check box to enable this feature; clear the check box
to disable this feature.

When you enable this feature, you can set the Assumed Source
or DeviceLink Profile option.

Assumed Source or DeviceLink Profile

Select Exactly as Applied During Refining to use the same
profile that was used during the refine process. If the file was
not color converted during refining, or the profile is missing, an
error is displayed.
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Select As Defined Below, if Not Set in Refining to use the same
profile that was used during the refine process, if the file was
color converted during refining. If the file was not color
converted during refining, the profile defined in the Input
Device Conditions box will be used.

Select Exactly as Defined Below to use the profile selected in
the Input Device Conditions box.

Input Device Conditions

Available when Assumed Source or DeviceLink Profile is set to
As Defined Below, if not set in Refining or Exactly as Defined
Below.

From the list, select Browse to locate the appropriate profile file
for final output.

Rendering Intent

Select Relative Colorimetric if the proofing paper is similar to
the paper that will be used during final output.

Select Absolute Colorimetric to simulate the color of the paper
that will be used during final output.

Select PDF to use the rendering intent specified in the PDF file
when output by the creative software during final output.

Select Perceptual to use rendering that uses gamut
compression and produces less saturated colors during final
output.

Select Saturation to make sure colors are represented in a way
that preserves or emphasizes saturation during final output.

Retain CMYK Black

Preserves black in images and graphics that are defined in
CMYK or RGB color space. For ICC-based color matching
engines, CMYK images and graphics get transformed from
CMYK to L*a*b* and back to CMYK color in order to perform
color matching. In going from CMYK (four components) to
L*a*b* (three components) and back again, the black (K)
channel separation information (UCR/GCR) has in the past
been destroyed. Selecting this check box instructs the Color
Matcher to preserve the black generation information from the
source color space. As a result, the amount of black relative to
CMY in the images and graphics stays about the same. The
purpose of this feature is to help preserve the visual weight of
images and graphics.
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Note: When you enable this feature, Color Matcher requires some
additional processing time because of the extra calculations involved.

Overprint Handling (CPU Intensive)

(See About overprint handling on page 257)

Select to prevent overprinting objects from generating
unintended knockouts.

If you are converting spots to process for a proof, or if you are
color-matching one CMYK space to another CMYK space for a
proof, you probably need to apply overprint handling, even if
you applied it during refine.

To use overprint handling, you must:

1. In the ColorConvert section, select:

● The Color Matcher JTP
● The Match Colors in Page Content check box
● The Overprint Handling check box

2. Choose between raster and vector overprint handling in the
Methods list.

Note: The raster option is available only when Shades=256 is
selected in the Render section of the process template.

Method

Choose to use vector or raster overprint handling for this output
process.

Select Raster when outputting to low-resolution contone
proofers (for example, Veris digital proofer or Matchprint Inkjet
proofer).

Note: To use raster overprint handling, you must select, in the Render
section of the process template, Shades=256.

Additional factors to consider:

● Raster overprint handling can be applied only to continuous
tone data

● Raster overprint handling occurs after the RIP
● Raster processing time increases exponentially as the

resolution increases
● Raster overprint handling eliminates all overprints

Select Vector when outputting to halftone (screen) proofers
(for example, the Spectrum device), or to high-resolution
contone proofers.
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Additional factors to consider:

● Vector overprint handling occurs before the RIP
● Depending on the complexity of the file, vector overprint

handling could take longer than raster overprint handling.
● Vector overprint handling does not eliminate all overprints.

In objects where overprinting does not have an effect on the
output, the objects retain an overprint status. For example, if
you set black to overprint, but one black object is not placed
on top of another object, this black object is, after overprint
handling, still an overprinting object.

Preserve Traps

Select this check box to preserve existing Kodak traps when
vector overprint handling is used.

Note: When existing traps are preserved, you cannot remove them in
later processing. You must remove the traps in the original file. Traps are
color-managed as regular objects.

Process CEPS Data

Select this check box to enable spot color mapping and color
matching of CEPS data.

For further information, see the CEPS Conversion Section and
the Normalize Section of the Refine Process Template.

Process Marks

Select this check box when you want to apply color
management to your marks file. Depending on the type of mark,
it may be necessary to enable Overprint Handling to
appropriately convert the mark and apply the necessary color
transformation.

Note: When Process Marks is checked, both sheet marks and page
marks are color managed.

Color match 1-bit images

Select this check box to color match 1-bit images. One-bit
images are images that represent two tones, typically black and
white. The pixel is either a 0 or a 1 value. Examples are copydot
images.

Note: This feature will convert 1-bit images to 8-bit images. This causes
pages to become larger and to render more slowly. Turn off this feature if
you do not require color matching of 1-bit images, or if the feature causes
unacceptable performance degradation. (For example, copydot files take
a very long time to refine and render.)
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This feature is available when Match Colors in Page Content is
selected.

Device Condition

Enables the ICC profile for a proofing device. The ICC profile
characterizes the way the proofing device prints.

Enable this feature by selecting a profile in the Device Condition
box. A profile should always be present because the Color
Matcher needs it for mapping spots and other tasks.

Source of Color Recipes

Extract Recipe from the File

Select to use the color recipes embedded in the file.

Lookup Recipe in Color Database

Select to use the color libraries selected in this process
template.

Color Libraries

From the Selectable list, select the color libraries you want
Prinergy to search for color recipes, and click Add.

Arrange the color libraries in the Selected list in the order that
you want Prinergy to search. Use the Move Up and Move Down
buttons.

Note: Ensure that you select color libraries with color spaces that are
compatible with the Proof Process Profile.

Use Recipe from File if not found in Color Database

Select this check box to use color recipes embedded in the file if
Prinergy does not find the colors in the selected color libraries.

Layout section of the Imposition Output process template
This process template section defines how Prinergy places the pages
on the output media during imposition output.

Media

Media Configuration

This option becomes available when you select Kodak Proofers
in the Output To list.
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Specifies the type of paper you're using in the Kodak proofing
device. Select a paper type from the list.

Thickness

This option becomes available when you select an Epson device
in the Output To list.

Type the thickness of the paper you are using in the Thickness
box, and then select a unit of measurement.

Layout for Kodak Proofers

Select a template to control how multiple pages are arranged on
a single proof.

This box is available only for those proofers that are connected
via Kodak Proofing Software (KPS).

For more information, see the Kodak proofer documentation.

Name

Available when a vendor's device has been defined through the
Prinergy Administrator. Available options are determined by the
device.

Size

Determines the size of the media to which you will output the
final files.

Select Digital to generate an output file, for example, a file for
Virtual Proofing System software. When you select Digital, the
Min Width, Min Height, Max Width, Max Height, and Layout is
90° Different Than Media boxes are unavailable.

Select Cut sheet, Roll fed, or Roll fed (transverse), depending
on the media being used.

Min Width

Sets the minimum width for the specified media in the unit of
measure selected in the list.

Min Height

Sets the minimum height for the specified media in the unit of
measure selected in the list.

For cut sheet, enter the sheet height. For roll fed, enter the
height of the smallest proof you want to make on the device.
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Max Width

Sets the maximum width for the specified media in the unit of
measure selected in the list.

Max Height

Sets the maximum height for the specified media in the unit of
measure selected in the list.

Duplexing

This option is available for composite files; it is unavailable for
separated files.

Specifies the type of duplexing.

From the Duplexing box, select Turn or Tumble to enable this
feature. Select None to disable duplexing.

Front Shift and Back Shift

The Front Shift Along Width...Along Height and Back Shift
Along Width...Along Height options give finer adjustment
when aligning two-sided proofs than with Center Along Width/
Height. Use these measurements to shift and align front and
back pages along their turn or tumble axes, depending on the
page or imposition orientation (portrait or landscape).

These options are available only when Duplexing has been set
to Turn or Tumble.

You can specify the shift in points, inches, centimeters, or
millimeters.

Placement

Orientation

(See Example: orientation on page 653)

Rotates an entire imposition as a unit.

Select Auto clockwise to automatically rotate an image
clockwise when rotating would result in a better fit.

Select Auto counterclockwise to automatically rotate an image
counter-clockwise when rotating would result in a better fit.

Center Along Width

Centers the imposition plan along the horizontal axis of the
media.
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Center Along Height

Centers the imposition plan along the vertical axis of the media.

Shift Along Width

(See Example: shifting images horizontally and
vertically on page 654)

Available if the Center Along Width check box is cleared.

Shifts the imposition plan from the left edge of the media along
the horizontal axis.

Shift Along Height

(See Example: shifting images horizontally and
vertically on page 654)

Available if the Center Along Height check box is cleared.

Shifts the imposition plan from the bottom edge of the media
along the vertical axis.

Flat Rotation

Makes a small angle rotation of the flat or output image. Also
called plate cocking. Derive the (0.0) percentage value, or
gradient, in one of two ways:

● Physically measure the first occurrence of a rotation to find
the gradient that you can then apply for all jobs that use that
rotation

● Convert a given angle into its gradient

To measure for a gradient:

● Formula: gradient = rise/run x 100 where:
● Rise: (y-axis) measure the distance between where the flat's

rotating corner started and where it must be moved as a
straight line that meets the x-axis at a 90° angle. Example: 2
units

● Run: (x-axis) measure the distance along the x-axis from the
non-rotated corner of the flat to the point where the vertical
line transects the x-axis at a right angle. Example: 90 units

● Calculation: 2/90 x 100 = 2.2
● The maximum percentage value is 3.1.

To convert an angle to a gradient:
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● Formula: gradient = tangent of the angle of rotation x 100
● Calculation using a scientific calculator and an angle of 0.5°:
● 0.5° + Tan(gent) key = 0.008 x 100 = 0.8
● The maximum angle of rotation is 1.78°.

Note: To convert a gradient to an angle, enter the gradient into the
calculator and apply the inverse tangent function. Example: 2.2% is
entered as 0.022 + Inv(erse) key + Tan key = 1.26°.

● Indicate whether the rotation is to be clockwise or
counterclockwise.

Note: The process template does not let you select flat rotation and
web growth at the same time. However, when web growth is applied,
flat rotation can be specified in the web growth profile.

Punch Setting

Available when a format for an imagesetter that has an
automatic punching system (for example, Heidelberg Herkules)
is selected in the Output To list.

Select a punch type. For more information about punch types,
see your device documentation.

Scaling

Scale Vector

Applies scaling to the layout prior to screening the file. The
scaling is based on vector data (PDF data).

Apply Scaling from Layout

Select to use the scaling specified in the original layout
application, for example, Pandora.

Note: This feature is not compatible with Preps.

Custom

Enter scaling percentages for the Along Width and Along
Height directions.

Fit to Media Size

If the specified layout produces an image too large for the
media, the image is scaled to fit.

You cannot see the scaling percentage. Select this check box
only when a proof scaled to an unspecified reduction is
acceptable.
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Non-Printable Margin

If the Fit to Media Size option was selected, you can identify the
non-printable margins that should be taken into account when
determining scaled layouts.

Specify left, right, top, and bottom non-printable margins
appropriate to the output device and media, in the selected unit
of measure.

Scale Raster

Applies raster scaling to the layout. Raster scaling is an optional
feature that will allow you to apply distortion after the files are
screened.

Raster scaling is recommended for prescreened files (copydot)
or files that contain 1-bit TIFF images, since the prescreened
bitmap data cannot be properly scaled with vector scaling
(could generate artifacts).

Clear this check box to disable this feature.

Apply Scaling from Layout

Select to use the scaling specified in the original layout
application, for example, Pandora.

Note: This feature is not compatible with Preps.

Custom

Enter scaling percentages for the Along Width and Along
Height directions.

Assign Web Growth Profile, if Available

(See Example: web growth profile on page 730 and Applying
and removing a web growth profile on page 739)

Enables the system to digitally compensate for distortion on
press using a web growth profile file (<file name>.wgp) and a
tower color file (ColorTowerMap.txt).

Web growth scaling can be used in situations where each plate
must be scaled by a different (or identical) factor.
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Select the Use Web Growth Profile option to enable this
feature. Then do one of the following:

● Select Use profiles assigned in Job Manager only. If a profile
is not assigned in Job Manager, no web growth profile will be
applied.

● Select Default Profile and either type or browse to select a
profile that will be used for all sheets when this process
template is used.

Note: Web growth profiles can be assigned in Job Manager or in
Process Template Editor. If a web growth profile is specified for a job
in Job Manager, this overrides any web growth profile that is assigned
here, unless you also select the Override profiles assigned in Job
Manager check box.

● Select Assign Profile to Sheet to select a profile for each
individual sheet. This feature is useful when, for example,
you need different profiles for the left and right webs of a
multi-web run. A "sheet" in the Assign Profile to Sheet list
box refers to two surfaces printed on two sides of the same
substrate. For example, a multi-web layout consisting of a
single signature with two webs would map Sheet 1 to
Signature 1 sides A and B, and map Sheet 2 to Signature 1
sides C and D. If there were a second signature, then Sheet 3
would map to Signature 2 sides A and B, and Sheet 4 would
map to Signature 2 sides C and D.

Note: If a web growth profile is specified for a job in Job Manager, this
overrides any web growth profiles that are assigned here, unless you
also select the Override profiles assigned in Job Manager check box.

Signature Booklet

Enable Signature Booklet

Signature Booklet (digital blueline proofing) enables you to
create a 1-up or 2-up reader-order proof of the page set
positions-from an imposition plan layout.

A signature booklet is similar to a digital blueline, except that
each page is refined separately and then compiled.

Document Binding

This list becomes available when you select 2-up from the Type
list.

Select how the signature booklet will be bound: Left, Right, Top,
or Bottom.
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Type

Select how many pages will output on the sheet:

● To output two PDF pages per sheet (one front and one back)
in reader order by signature, select 1-up

● To output four PDF pages per sheet (two front and two
back) in reader order by signature, select 2-up

Use... with offset

Determines how much of the area around the page's bleed or
trim box to include when printing. You can increase the offset
amount to see the bleed area, gutters, imposition and page
marks, and parts of neighboring imposed pages. Be sure the
output sheet is large enough to accommodate both the pages
and the bleed or trim offset amount.

● To print with only the final bleed or trim, type 0.0
● To image content outside the page's bleed or trim box, type

a positive value and select a measurement from the list. The
offset amount you choose depends on the size of the gutter,
but typically 6 to 13 mm (0.25 to 0.5 inches) is sufficient.

Duplex Offsets

This option applies only if you are outputting to a duplexing
laser printer.

Adjust for the mechanical misalignment in the laser printer's
duplexing unit. There are alignment test targets that you can
run that directly measure how far off the front and back are
from center. Use the Front Shift Along Width and Along Height
and Back Shift Along Width and Along Height values to
compensate for any misalignments. Select the units of measure
in the list.

Page Marks

Identify the name and location of a PDF file containing page
marks. Click Browse to locate and select a file.

You may need to provide space for page marks by increasing
gutter measurements.

The variable mark $[PagePositionNumber] or $[PPN] can be
used to verify that the pages are in the correct page set
positions in the imposition.

Calibrate

When this check box is selected, the plate curve and print curve
are applied to the mark. The curves applied are the ones
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selected in the Plate Curve list and Print Curve list in the
Calibration and Screening section of the process template.
When this check box is cleared, only the plate curve is applied.
To prevent the application of the plate curve to a mark, select %
%None%% in the Plate Curve list in the Calibration and
Screening section of the process template.

Locate Page Marks Adjacent to

Select where to place the page marks in relation to the page's
trim box.

When you select Right or Left, the page marks rotate as
follows:

● Left—rotates the mark 90° counterclockwise
● Right—rotates the mark 90° clockwise
● Bottom—no rotation
● Top—no rotation

at Distance

(See Calculating the at distance value on final
output on page 692.)

Determines where, relative to the edge, the mark is placed:

● Sheet marks are placed relative to the plate edge. Depending
on the distance you type, you can place the sheet mark on
the press sheet or on the plate.

● Page marks are placed relative to the finished page size (the
imposition hole).
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Render section of the Imposition Output process template
This process template section determines the output resolution and
how the system handles spot colors during imposition output.

JTP

Select the job ticket processor (JTP) to use for rendering.

Note: You set up JTPs using Prinergy Administrator.

Device Resolutions

This list is available when an output device format is selected in
the Output To list.

Select a resolution for the selected device in the list.

Resolution X

Available when the Device Resolutions box is unavailable.

Type a resolution value.

Resolution Y

Available when the Device Resolutions box is unavailable and
mixed resolution values are allowed for the output format
selected in the Output To list.

Type a resolution value.

Color Model

Select the process color model to use for output.

The list of values varies, depending on the output format
selected in the Output To list.

Shades

To set the number of shades of gray to output, select 1 for
screened data or 256 for continuous tone data. When 1 is
selected, the Calibration & Screening section of the refine
process template is available for input.

The list of values varies, depending on the output format
selected in the Output To list and the color model selected in
the Color Model list.

Do Separations

Available when the output format selected in the Output To list
supports separated output and DeviceCMYK is selected in the
Color Model options.
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Select if you want Prinergy to output separations. Clear this
check box if you want Prinergy to output a single composite file.

Output Separations Handling

Determines how separations should be handled during
imposition output.

The list of values varies, depending on the output format
selected in the Output To list.

● Select Convert separations to process if you want spot
colors converted to process colors.

Note: When Convert separations to process is selected, Vector
Overprint Handling (in the ColorConvert section) is automatically
turned on to ensure the correct appearance of any overprinting spot
colors.

● Select Output all separations to preserve spot colors on
output.

Always Use Color Combiner to Convert Spots

This check box is available when Output Separations Handling
is set to Convert separations to process.

If the input files contain overprinted spot colors, the Color
Combiner, which is a plug-in to the renderer, will combine the
layers and output the overprinted colors correctly.

When this check box is cleared, the renderer handles the
conversion of spot colors to process colors if the following
conditions exist:

● Input files are composite.
● All spot colors are set to opaque in the color database. (If a

spot color is not in the color database, opaque is assumed.)

If the above conditions are not met, the Color Combiner will be
used, even if the Always Use Color Combiner to Convert Spots
check box is cleared.

We recommend that you always select this check box.

See About Color Combiner on page 805.

Dielines Overprint Other Content

This check box is cleared and unavailable if the Do Separations
check box is cleared and unavailable.

Select this check box to specify whether die lines overprint
other content. Clear this check box if you do not want die lines
to overprint other content.
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The Dielines Overprint Other Content check box is available for
the following outputs:

● DCS Raster
● Kodak Approval TIFF
● LQS TIFF
● VPS
● Windows Bitmap

Anti-Aliasing

Select this check box to enable anti-aliasing, and then in the at
Ratio list, specify a ratio for anti-aliasing.

Anti-aliasing is a technique of improving the appearance of
output by minimizing the "stair step" effect on rasterized
output. It does so by rendering to a higher resolution than the
intended output, and then downsampling to the intended
output. This generates "averaged" pixels which softens the
"stair step" effect on low-resolution output. The ratio value for
anti-aliasing refers to the factor used to determine the
intermediate resolution. A higher ratio results in higher quality,
but can have an effect on output speed. For example, if the
output is a 300 DPI 8-bit TIFF, and the anti-alias ratio is 4,
Prinergy will render an intermediate output at 1200 DPI (4 x
300 DPI), and then downsample to the user-requested 300
DPI. Anti-aliasing is only available for 8-bit (256 shade) output.

Fail if font problems detected

Select this check box to fail the output process if a file has
missing fonts.

Note: This feature is not available for vector outputs (PDF, PS2, PS3, EPS,
DCS Vector, PDF/X-1a, PDF/X-3, CT/LW, and DELTA).

Ignore Embedded Fonts in Marks Files

Select this check box if you want Prinergy to ignore embedded
fonts in a marks file and to look for the fonts in the system
fonts folder.

Important: You must install the fonts in %ServerName%\%AraxiHome
%\AdobeExtreme\bin\fonts, or the output will fail.

Convert Text to Paths

This check box converts fonts to outlines before a file is RIPed.

This option was added in Prinergy 3.0 when the CPSI 3016 RIP
was included with Prinergy. This option helped situations where
the 3016 RIP failed to process the fonts on certain jobs.
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This option has limited usefulness now, but is included as a
potential workaround in rare cases where fonts are not
rendered correctly by the RIP. It is not recommended that you
enable this on on a permanent basis. When using this option for
specific jobs, it is recommended that you ensure that both
proofs and plates are output with this option.

Note that when you select the Convert Text to Paths check box,
you will have text appear fatter on low-resolution proof output.
You can overcome this appearance problem by either:

● Rendering to a higher resolution, if rendering to 1-bit output,
such as Virtual Proofing System

● Using anti-aliasing, if rendering to contone output

Note: This check box is only available for raster output formats
(.VPS, .TIFF, and so on).

Overlay Versioned Content

This check box applies to Layered PDF Versioning. For
information, see the Prinergy Layered PDF Versioning User Guide.

Versioning Proof Mapping Color

This box applies to Layered PDF Versioning. For information,
see the Prinergy Layered PDF Versioning User Guide.

Kodak Approval

Densities

Type an integer between -22 and +22.

For more information, see your Approval documentation.

Calibration and Screening section of the imposition output process
template

This process template section provides calibration and screening file
information during imposition output.

These options are available when you select 1 in the Shades option, in
the Render section of the process template.

Calibration

Plate Curve

Select None if you do not want to apply plate linearization
curves to your output. This option is set to None by default.
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To apply a plate curve to your output, select the curve in the list.

You must select a plate curve in the Prinergy process template,
even when Print Curve (Calibration) is set to Auto.

Note: Plate curves are always applied to page, sheet, and imposition
marks. Select None if you do not want curves applied to marks.

Print Curve (Calibration)

Select None if you do not want to apply print dot gain
compensation curves to your output.

To apply a print calibration curve to your output, select the
curve in the list.

Select Auto to automatically select the most appropriate curve.
Depending on the Screening Method selected, the Harmony
software determines the curve to use, based on dot shape and
screen frequency data from your job or the process template.
Harmony looks in the following locations in the process
template:

● Dot Shape and Screen Ruling boxes
● Screen Frequency box
● Harmony Medium box
● In the Render section, the Device Resolutions box (or

Resolution X and Resolution Y boxes)

If you assign a calibration curve in the Prinergy DotShop
software for use on a mark, you must select the Keep DotShop
Settings or Use Document's Screening, if Present screening
mode.

Note: To control the application of the selected print curve for an
individual page, sheet, or imposition mark, select the Calibrate check box
in the Marks section of the process template. This allows you to apply
print curves to imposition content without applying print curves to
marks.

Harmony Medium

Available when you select Auto in the Print Curve (Calibration)
list, it lists the Harmony media that are defined in your
Harmony curve database. If the Harmony Medium list is
available but the list is empty, no Harmony media are defined.
The selected Harmony media is used to identify an appropriate
calibration curve.

Select a Harmony media in the list.
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Minimum Dot Size

Type the lowest tint percentage, with up to one decimal place,
at which dots will be imaged—for example, 10% or 10.5%. This
feature is available only if you specified a plate or print curve.

You can use this feature to remove scum dots on flexo plates.

Screening Mode

(See also the topic about document screening in this guide.)

● Select Override all Screening to use the screening specified
in the process template. This option ignores any screening
specified in the source PDF file or the Prinergy DotShop
software.

● Select Keep DotShop Settings to use the screening specified
in the DotShop software, when available. For pages that are
not modified in DotShop, the screening specified in the
process template is used.

● Select Use Document's Screening, if Present to use the
screening specified in the source PDF file.

This option also uses the screening specified in DotShop,
when available. For pages containing no screening
information, the screening specified in the process template
is used.

You can use one or more of the Angles, Frequencies, and
Dot Shapes settings specified on the page and allow the
process template to determine the parameters that you did
not specify.

Note: If Prinergy does not support the screen angles in the source PDF
file, the nearest supported angle is used.

Note: This option offers the greatest risk of poor results, because screen
angles identified in the source PDF file may not be suitable for the output
device.

Screen Type and Screen System

(See also the topics about screen types and screen systems.)

Screen Type lists the following default screening information:
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● Maxtone screen types are based on the Prinergy AM
(conventional or rational tangent) screening technology.

○ The Maxtone CX screen type is configurable. To
configure the size of highlights and shadow dots, type
values in the Dot Width Highlights and Shadows boxes.

○ The Maxtone NX screen type is also configurable. To
configure the size of highlights and shadow dots, select
values from the Dot Size Highlights and Shadows lists.

Note: It is also possible to select the dot size for the highlights and
shadows using DotShop Composer. Maxtone NX works on the
entire page, so all objects defined with Maxtone NX must have
dots of the same size. If there are multiple dot sizes selected, the
output process will fail.

○ Maxtone IS screen types are used for seamless sleeve
and cylinder output device applications. If you select
Maxtone IS, the resolution set in the Render section of
the process template must be identical to the resolution
in the IS screen system. Most IS screen systems are
predefined in the IS screen set and cannot be modified in
the process template. For information about defining IS
screen sets, see the Prinergy System Administration Guide.

To see how items in the list of IS screen systems can be
hidden, see the topic about hiding IS screen sets.

○ Maxtone IS CX screen types are used for seamless sleeve
and cylinder output device applications, but they are
configurable. If you select Maxtone IS CX, the resolution
set in the Render section of the process template must be
identical to the resolution in the IS screen set.

● Staccato identifies the Staccato stochastic screening family.

○ The Staccato NX screen type is configurable. To
configure the size of highlights and shadow dots, type a
value in the Dot Size Highlights > Shadows box.

Select a screen system for the format selected in the Output To
list.

Dot Shape

(See also the topic about dot shapes.)

Select a dot shape in the list.

The list of available dot shapes varies, depending on the screen
system selected in the Screen System list.
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Device Resolutions

Displays the values set in the Resolution X and Resolution Y
boxes in the Render section of the process template.

Screen Ruling

Available when Maxtone, Maxtone CX, or Maxtone NX is
selected in the Screen System list.

The list of available screen rulings varies, depending on the
setting in the Screen System, Device Resolutions, and Output
To lists.

If you select an IS screen set, you cannot change the Screen
Ruling value.

Feature Size

Available when Staccato, Staccato CX, or Staccato NX is
selected in the Screen System list.

Select the most appropriate feature size (in microns or pixels)
for the screen system. A smaller number produces finer-grained
output.

The list of available feature sizes varies, depending on the
setting in the Screen System, Device Resolutions, and Output
To lists.

Note: The Staccato feature sizes denote a dot size somewhere between
the actual highlight and the midtone dot size.

Note: The Staccato CX or NX (first order) feature size denotes the exact
dot size of the highlight and quarter tone dots. Resolution is factored into
the Staccato CX or NX (first order) dot size calculations.

Note: Staccato feature sizes listed as <##>.1 indicate a first-order
screen, where <##> is the approximate dot size of the highlight and
quarter tone dots.

Midtone Frequency

Available when Staccato CX or Staccato NX is selected in the
Screen Type and Screen System lists.

Select a Staccato CX/NX midtone frequency in the list. A larger
number indicates a finer dot structure.

Midtone frequency is an accurate measure of the number of dot
structures per inch in the midtones of Staccato CX/NX screens.
Frequency is expressed in lines per inch (lpi) and is a useful
metric with AM and FM screens when assessing qualitative,
lithographic, and imaging behavior. Staccato CX/NX midtone
frequency is comparable to Maxtone and Maxtone CX/NX
screen ruling.
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Values in this box are governed by resolution and licensing. For
a complete list of the available Staccato CX midtone
frequencies and dot widths, including configurations that match
Staccato screen type feature sizes, see the section about
document screening, in this guide.

Screen Color

In the Screen Color and at Angle boxes, perform the following
tasks:

● Set screening for colors other than the four process colors
● Swap the process color screens within screen systems
● Assign a screen to the "Default" color. This screen will be

used for any color that doesn't have its own screening value
in the output process template or color database.

The screen angles associated with each process color in the at
Angle box vary, depending on the setting in the Screen System
and Dot Shape lists.

To assign a screen to a color in the Screen Color box, type the
name of a spot color, or type Default to select the default
screen angle. Use the correct capitalization and spacing in color
names.

Note: To swap two screens (for example, magenta for black), modify the
entries for both colors. In this example, modify the setting in the at Angle
box for magenta to use the black screen, and modify the setting in the at
Angle box for black to use the magenta screen.

Default Spot Color Handling

Determines how Prinergy assigns screen angles to spot colors
that do not have screen angles assigned in the Screen Color and
at Angle boxes or in the Color Editor.

To choose C, M, Y, or K as the default color screen angle, select
Screen as. To cycle through the available color screen angles,
select Cycle Through Screen Angles.

Screen as

To assign a different default spot color screen angle, select a
color in the list.

For IS screening, Prinergy cannot assign the Others angle as the
default spot color angle.

Cycle Through Screen Angles

Select this option to assign default spot color screen angles
cyclically to the available process colors, in CMYK order.
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Prinergy does not assign process colors that have already been
used to screen a spot color.

If Staccato Extended is selected in the Screen System list, the
list of screens cycles from Screen #1 through to Screen #10.

For IS screening, Prinergy cannot cycle through angles other
than CMYK.

Do not increase yellow ruling

To reduce moiré, the AM screening algorithm provides yellow
screen frequencies (lpi) that are up to 14% higher than the
cyan, magenta, and black screens. If you want a Y screen that is
more similar to the Y screen in Prinergy 2.2 and earlier, select
this check box. It limits yellow screen frequencies to between
-4% and 4% of the ruling of the C, M, and K screens. For
example, if the C, M, and K screens are at 150 lpi, this check box
limits the screening algorithm to providing a Y screen between
144 lpi and 156 lpi.

This setting does not affect the yellow frequency of an IS screen
set. To change the yellow frequency of an IS screen set, use the
IS Screen Set Editor.

Rotate Screens With Pages

Select to rotate screens with reader orientation for each page in
an imposition.

When some pages are rotated 90°, rotating screens with the
pages allows all pages to be screened at the same angle.

Screens are only rotated at 90° so pages that are oriented at
other angles are not affected. The result of rotating screens is
apparent when you screen with dot shapes that are not
rotationally symmetric, such as Elliptical and Line.

Rotate Screens With Pages is cleared Rotate Screens With Pages is selected

Mirror Screens with Output

Select to mirror screens so they are consistent across all
devices (for output devices that have intrinsically mirrored
output).
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Note: This will affect the screen angle rotation on the printed page and
should be used only for compatibility with legacy printing.

When the Mirror Screens with Output check box is selected,
selecting the Mirror Print check box in the Device section of the
process template causes screen angles to become mirrored
with the output. This is useful for some printing processes that
require mirrored film or plates, to ensure consistency of screen
angles with digital dot proofs.

Mirror Print is selected

Mirror Screens with Output is cleared

Mirror Print is selected

Mirror Screens with Output is selected

Note: If Round is selected in the Dot Shape list, the Rotate Screens With
Pages and Mirror Screens With Output selections don't affect output.

Set Halftone Phase for each Page

Select to have the renderer reset the origin of the halftone
screen for each page on an imposition.

When selected, this option ensures that each page on an
imposition has the same bitmap pattern.

This is useful for a label printer who wants each label on the
imposition to be identical. A difference in the halftone screen
origin for each label can sometimes show up as a visible
difference at the edges of the labels.

Screen Solids

Applies a screening pattern to solid areas in order to better
absorb excess ink. This screening feature results in cleaner
printing of solid areas.

Screen solids can also be effective in reducing ink consumption
during proofing.

In the as box, type a value between 0% and 99.8% to indicate
the percentage at which you want to screen all objects with
solid (100%) tint.
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Maxtone CX Dot Width

Note: This option is not available when Maxtone or Staccato is selected
in the Screen Types list.

Highlights

Type the size (in microns) of the Maxtone dot for
highlights.

Shadows

Type the size (in microns) of the Maxtone reverse dot
for shadows.

Highlights

Type the size (in microns) of the Maxtone dot for highlights.

Shadows

Type the size (in microns) of the Maxtone reverse dot for
shadows.

HyperFlex

Screening technology that allows for smaller dots and/or
graphic elements to be held on flexo plates during UV exposure
of a plate.

For more information about HyperFlex, see the Prinergy
Advanced Flexo User Guide.

HyperFlex Classic

When imaging on flexo plates, select to enhance Maxtone dots
with HyperFlex Classic technology.

Note: Hyperflex Classic is not intended for offset use.

In the extreme highlight areas, Maxtone simulates FM
screening by randomly removing dots from the AM grid.
HyperFlex Classic helps to support and strengthen Maxtone by
placing light valves where dots have been removed.

Pixels

Type the HyperFlex dot size in pixels.

To determine the proper HyperFlex dot size, you must perform
a series of flexo exposure tests. For more information, see the
Prinergy Advanced Flexo Implementation User Guide.
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HyperFlex Advanced

In flexo applications, select to use HyperFlex Advanced with
Maxtone, Maxtone CX, Maxtone NX, Maxtone IS, Maxtone IS
CX, and Staccato NX screen types.

Note: Hyperflex Advanced is not intended for offset use.

HyperFlex Advanced places light valves around halftone dots to
strengthen and support individual dots.

Size

Type the size of the light valve in pixels. The minimum value is 1
and the maximum value is 16.

As feathering (a reduction in HyperFlex size as tone value
increases) is being applied, this value specifies the starting size
of the light valve. The light valve size is scaled back, in a linear
fashion, to zero (at the tint percentage specified in the Limit
box).

Distance: Start/End

Enter the distance between the center of the light valve and the
center of the dot.

Suggested settings—Enter the same values in the Start and End
boxes, and use a larger value than you enter in the Merge
Distance box. For example, type 2 in both the Start and End
boxes, and type 1 in the Merge Distance box. This positions the
light valves equidistant between adjacent halftone dots.

If you are not using the suggested settings, in the Start box,
type the distance from the light valve to the center of the
smallest halftone dot. In the End box, type the distance (in
pixels) from the light valve to the center of the largest dot, as
specified in the Limit box.

Merge Distance

Enter a value that determines where the light valves will be
positioned in relation to the halftone dots.

Suggested settings—Enter the same values in the Start and End
boxes. Enter a smaller value in the Merge Distance box than
you entered in the Start and End boxes. For example, type 2 in
both the Start and End boxes, and type 1 in the Merge Distance
box. This positions the light valves equidistant between
adjacent halftone dots.
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Limit

Type the tint percentage above which HyperFlex Advanced will
no longer be applied. The general recommendation is to set the
Limit between 20% and 50%.

DigiCap

DigiCap is screening software for digital photopolymer (flexo)
media that improves the transfer of ink in solid areas, using
small reverse dots (a tint).

Set the DigiCap texture by specifying the size of the reverse
dots and the tint percentage. In the Texture with boxes, type
the length and width of the reverse dots. The maximum size is
10 pixels by 10 pixels.

In the as box, type the tint percentage. For example, a 92% tint
creates an area with 8% coverage of reverse dots.

To determine the proper DigiCap feature size and percentage,
you must perform a print test containing multiple combinations
of coarseness levels and tint percentages. You cannot
determine the feature size or percentage without
comprehensive press tests. For more information, see the
Prinergy Advanced Flexo Implementation User Guide.

In the Keepaway box, type the distance (in pixels) between the
edge of elements to which DigiCap texturizing should not be
applied and the start of DigiCap texturizing.

See also:
About document screening on page 637
About dot shapes on page 638
Screen types on page 641
About screen systems on page 643
Setting up Maxtone screens on page 663
Setting up Staccato screens on page 664
Creating and editing IS screen sets on page 665
Hiding IS screen sets on page 668
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Processed File Options section of the Imposition Output process
template

This process template section identifies the file naming parameters
during imposition output.

Prinergy-defined File Naming

Use Prinergy-defined File Naming

Select to use the default file naming convention for output files.

Maximum Characters from Job Name

Type the maximum number of characters for the job name part
of the file name.

Note: Share a maximum of 18 characters between the Maximum
Characters From Job Name box and the From Imposition Template
Name box.

From Imposition Template Name

Type the maximum number of characters for the imposition
template name part of the file name.

Note: Share a maximum of 18 characters between the Maximum
Characters From Job Name box and the From Imposition Template
Name box.

Respect Mac Filenames

Select to shorten Prinergy file names to 31 characters or less,
because Macintosh file names are restricted to a length of 31
characters.

For imposition output and final output, the Prinergy file name
consists of:

● 18 characters for the job name and imposition name
(including periods)

● 13 characters for surface, version, and color extensions
(including the periods that separate each item)

For example, jobname.imposname.1A.vers.M.VPS.

When you select this check box, Prinergy shortens the first part
of the file name. You specify the maximum number of
characters for the job name in the Maximum Characters From
Job Name box. You specify the maximum number of characters
for the imposition name in the From Imposition Template
Name box.
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When the Respect Mac Filenames check box is selected, spot
colors are represented in the file name by an index number.

When the Respect Mac Filenames check box is cleared, the full
spot color name is added to the output file name, with the word
PANTONE abbreviated to PMS, and the CVC or CV suffix
removed.

Overwrite Existing Files with Same Name

(See About outputting to a file on page 661)

Select if you want to use the newer files when multiple files
have the same name.

Available when Job-Relative File is selected in the Output Type
box.

Custom File Naming

Use Custom File Naming

Select this check box if you want to specify the output file
names.

Notes: If you select this check box:

● And if you want to respect Macintosh file names, you must restrict
each tag in the Filename Template box, so that the longest possible
file name is 31 characters or less.

● Overwrite Existing File with Same Name is selected. If you want to
generate and keep iterations of a file, include a %version% tag in
the Filename Template box.

Filename Template

(See About custom file naming on page 657)

Type the file name format for the output files.

Controlfile Filename Template

If outputting to a format which requires a control (master) file,
type the file name format for the control file.

Use Full Spot Color Names

Select this check box if you want to use the spot color names in
the output file names (instead of numbers which are derived
from the spot color order).

Note: To use this check box, you must include the %color% tag in the
Filename Template.
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PrintConsole Session Naming

Custom session naming

Information not yet available.

File Format section of the Imposition Output process template
This process template section identifies the format and compression
settings of the output files during imposition output.

Include Images as

If printing to PDF, select Original to output the original images
in the output file.

Select Low Resolution to output low-resolution versions of the
images in the output file.

Compression

(See About outputting to a file on page 661)

The compression options that are available vary depending on
the output format selected in the Output To list at the top of
the process template. The following compression options are
available:

● None—Select if you do not want to compress files
● CCITTG3—Not available if outputting to a non-screened

format
● CCITTG4—Not available if outputting to a non-screened

format
● LZW
● RLE
● ZIP—Select if you use Kodak Staccato screening software

Note: Compression methods CCITTG3 and CCITTG4 are unavailable if
the Always use Color Combiner to Convert Spots check box is selected
in the Render section of the process template or if any Staccato
screening system is selected in the Screen System box in the Calibration
& Screening section.

Quality

The quality control option is available only if the Output To list
is set to JPEG.

Prinergy provides five JPEG compression quality options
ranging from maximum quality (the least compression and the
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smallest loss of data) to minimum quality (the most
compression and the greatest loss of data).

● Maximum
● High
● Medium
● Low
● Minimum

The lower the quality of JPEG compression, the smaller the file
size, but the greater the chance of noticeable blockiness in
certain areas of the image. You should experiment with JPEG
compression levels to see what amount of image degradation is
acceptable for your purposes.

Advanced TIFF Tags

(See About advanced TIFF tags on page 650)

Select to add advanced TIFF tags to output files.

Note: Unless you are outputting to Virtual Proofing System 2.0 or
Copydot Toolkit software, we do not recommend selecting this option
because some devices that do not recognize advanced TIFF tags may
reject the entire file.

Available when a TIFF or Virtual Proofing System format is
selected in the Output To list at the top of the process
template.

Use Custom TIFF Title Tag

Select the check box and type a custom name in the box to
create custom title tags in the TIFF file. This feature replaces
the need to manually edit the TIFF file.

Use this feature when sending Virtual Proofing System files
through Digital Blueline to merge separations from different
signatures.

Note: In the box, you can include variables such as %job% and
%signature% .

DCS File Format

Select Single File to generate one pre-separated DCS file—that
is, one file that contains all the pre-separated colors. The file
name will be, for example: <PDF filename>.p00n.eps.

Select Multiple Files to generate a DCS file set—that is, one file
for each color separation, plus a master file for the set. The file
names will be, for example:

<PDF filename>.p00n.dcs.eps
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<PDF filename>.p00n.C.eps
<PDF filename>.p00n.M.eps
<PDF filename>.p00n.Y.eps
<PDF filename>.p00n.K.eps
<PDF filename>.p00n.1.eps
Available when DCS is selected in the Output To list at the top
of the process template.

EPS Data

Select the encoding method to use for EPS data.

Available when EPS Raster is selected in the Output To list at
the top of the process template.

DCS Data

Select the encoding method to be used for DCS output.

Available when DCS is selected in the Output To list at the top
of the process template.

EPS Compression

Select the compression method to use for EPS output, or None
if you do not want to compress EPS files.

Available when EPS Raster is selected in the Output To list at
the top of the process template.

DCS Compression

Select the compression method to be used for DCS output, or
select None if you do not want to compress the DCS file.

Available when DCS is selected in the Output To list at the top
of the process template.

Add TIFF Preview to DCS Master File

Select to add a preview file to the master file for a DCS-2
multiple file set. You can view the preview file in software such
as Preps and QuarkXPress.

Specify a resolution for the preview file in the at Resolution box.

Available in the Loose Page Output and Imposition Output
process templates when EPS vector or DCS (raster or vector) is
selected in the Output To list. Available in the Final Output
process template when DCS raster is selected in the Output To
list.
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Always use custom Large TIFF format

This check box is available only when the file output type is set
to TIFF. By default, this option is disabled.

Select this check box to create a JDF file that links multiple large
TIFF files (less than 4 GB). This set of files represents a single
plate.

Document Format

Select Multi Page to generate one output file for the entire
range of selected surfaces or Single Page to generate one file
for each surface.

Available in the Loose Page Output and Imposition Output
process templates when a vector output (except DCS) is
selected in the Output To list. Available in the Final Output
process template when PS3 (PostScriptOut) is selected in the
Output To list.

Single Page is not recommended for digital printers.

Vector Output Options

Output Format

Select Composite or Separated output. The selection
determines whether or not conversion is required based on the
input file format. Select Automatic to generate files in the same
format (composite or separated) as the input files.

Note: Separated PDF/X-1a:2001 and composite DCS-2 are not
supported.

Note: Spot color handling (omission, mapping, and converting) in the
Color Separations dialog box is not supported for composite vector
output.

Note: The Automatic option is available when vector output (except
DCS) is selected from the Output To list at the top of the process
template.

Render Shadings

Select to render PostScript 3 vector objects with Level 3 smooth
shades to produce rasterized contone objects in order to meet
the PostScript Level 2 standard. Target workflows may process
rasterized objects faster than vector ones, but there may be
some quality degradation for subtle shadings that extend over
long distances.

Specify a resolution for the rendered shadings in the at
Resolution box.
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Available when DCS, PS2, PS3, or PDF is selected in the Output
To list.

Font Outlining

Select to replace all text objects with vector objects in output
pages.

This is available to DCS, PDF, and separated PostScript vector
output formats. It is useful for eliminating font formats that
certain RIPs may not be able to process. Text output in this way
cannot be edited and when previewed in Adobe Acrobat, will
look bolder than the original text due to loss of font hinting for
low-resolution monitors.

Delete Traps

Select to remove any Prinergy-generated traps from PDF,
PostScript Level 2, and DCS-2 output files.

Trapping-generated overprints remain in the files.

Apply Geometry

Select to apply geometry settings to PDF, PostScript Level 2,
and DCS-2 output files.

You can set the geometry for a page (offset scale, orientation)
in the Set Page Geometry dialog box.

If this check box is selected, the geometry is applied to the
output file. To access the Set Page Geometry dialog box, from
the Edit menu, select Set Page Geometry.

Simulate overprints (CMYK only)

Select to replace overprint intersections with an opaque object.

This creates a page that maintains its integrity on output, even
if a downstream publisher or printer configures their workflow
to override overprints.

Preserve PDF Layers

Applies to the Layered PDF Versioning feature. For more
information, see the Layered PDF Versioning user guide.

Send PostScript duplexing commands

Select to print on both sides of the media. Assuming a portrait
sheet orientation, select Turn print pages side to side by
flipping on the long edge. Select Tumble to print both sides by
flipping on the short edge.

This option simply adds the duplex command to the PostScript
output. The consuming device may not support this command.
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Create Preflight Report, If Available

Select this option to create a preflight report, if you already have
a preflight profile set up and you have set the options on the
Refine process template, PDF Preflight panel.

Output Intent

Use this area to specify an ICC profile or named print condition
in the Output Intents section of the PDF/X file that you are
generating.

A named print condition is a documented printing situation with
a defined relationship between input data and the colorimetry
of the printed image. Typically, named print conditions are
registered with an organization such as the ICC.

Perform one of the following actions:

● To specify an ICC profile, select the Profile check box, and
specify the path of a profile.

● To specify a named print condition, select the Name check
box, and select a print condition from the list.

● To use the ICC profile specified in the ColorConvert section
for PDF/X generation, click the Use ColorConvert
Destination profile check box.

Note: Match Colors in Page Content in the ColorConvert section
must be selected.

This area is available only when a PDF/X format is selected in
the Output To list at the top of the process template.

Device section of the Imposition Output process template
This process template section identifies device-related parameters for
the output during imposition output.

Output Type

Select Absolute File or Printer to enter the path for a specific
network device or file location.

Select Job-Relative File to enter a path that is relative to the
location of the job folder.

Note: The default is Job-relative file and the Device Path box default is
%JOB%.

Typing a path for a network device in the Device Path box
automatically sets the Output Type to Absolute File or Printer.
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Submit as Multiple Print Jobs

Select to submit a separate job for each surface that is output.

Available when Absolute File or Printer is selected as the
Output Type or when the Delta option in the Render section is
enabled.

Device Path

The default setting depends on the value selected as the Output
Type.

● If Output Type is Absolute File or Printer, the default is
Clear. Type the name of a Windows NT network output
device using the UNC (Universal Naming Convention) path.
Or you can click Browse to select a file location.

● If Output Type is Job-Relative File, the default is %JOB
%Proofs. The default value places the output in the Proofs
folder of the job that creates the process. You can change
the Proofs folder to any subfolder found in a job folder.

You can also include the following marks in the Device Path
box:

● $[jobname;n]
● $[ProcessPlanName;n]
● $[ImpPlanName;n]

Note: Replace the n in the marks name with a number between one and
99 to specify how many characters from the associated mark to include
in the mark. For example, %JOB%Proofs\$[jobname;6] for
MyJobName becomes %JOB%Proofs\MyJobN.

Output Blank Surfaces for Duplexing and Collating

Select when you want to output an imposition that is supposed
to have blank surfaces, that is, surfaces with no separations; so
that duplexing or collating will be correct.

Mirror Print

Select to output media with the emulsion side down.

Negative Print

Select to output a negative image.

Cut Media

Select when you want the device to automatically cut the
media.
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Available when a device with a media cutting system is selected
in the Output To list.

Load Media

Select when you want the device to automatically load the
media.

Available when a device with a media loading system is
selected in the Output To list.

Unload Media

Select when you want the device to automatically unload
media.

Available when a format for a device with a media loading
system is selected in the Output To list.

Manually

Select when you want the device to prompt the operator to load
the device manually.

Available when a format for a device with a media loading
system is selected in the Output To list.

Media Unload Mode

Select the mode for unloading media.

Available when a format for a device with a media loading
system is selected in the Output To list. See your device's
documentation for more information.

HPRTL Device

If you have a Hewlett-Packard device, select HP.

If you have the Iris 43WIDE device, select Iris/Mutoh.

HPRTL is a raster file format developed by Hewlett-Packard and
used by a number of device manufacturers.

Available when HPRTL is selected in the Output To list.

Proofer Name

Dynamically lists all of the proofers discovered on the network.
Type or select the name of the particular proofer to which you
want to send the proof.

The name may include both the proofing controller's name and
the proofer name in a ControllerName/ProoferName format.
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Available when Veris/Matchprint Inkjet is selected in the
Output To list. For more information about proofers, see the
proofer documentation.

Proofer Model

A read-only box that describes the type of proofer selected in
the Proofer Name list.

Number of Proofs

Type the number of copies that you want printed.

This box applies only when Output To is set to Veris/
MatchPrint Inkjet.

Include JDF for Digital Print section of the Imposition Output
process template

Enable this section if you are generating to a digital printer.

When this check box is selected:

● Prinergy merges all of the generated signatures and surfaces into a
single file before sending to the digital printer.

If this check box is cleared, Prinergy sends each individual surface or
signature to the printer as a separate file.

● You can use a JDF file to communicate with the digital printer.

The Include JDF for Digital Print section is available only when the
Output To list is set to a PDF type, including either PDF (Vector
output), PDF Raster, or TIFF.

Job Settings

Number of Copies

Type the number of copies to be printed.

Job Name

(See About custom file naming on page 657)

Determines the job name that is sent from Prinergy to the
digital printer using standard Prinergy placeholders. The default
%job% displays the job name as specified in Prinergy.
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Device Selection

Select a Device Type

From the Select a Device Type list, select a digital printer
controller.

The selection you make affects the options that are available in
the Select JDF Templates, Media Selection, Media Handling,
and Device Specific Settings.

Send Files to Printer using

Select Network Copy or HTTP Protocol to determine how the
content file is referenced in the JDF file that is copied to the hot
folder on the digital printer.

PDF Path

Type the path to the folder where Prinergy creates the PDF for
the printer to output. You can also click Browse and locate the
folder.

If you are sending these files to a hot folder, this path must not
be the one specified in the JDF Path box. The JDF specification
requires that only the JDF files be dropped into a JDF-enabled
hot folder.

PDF File Name

(See About custom file naming on page 657)

Type the file name of the PDF file that Prinergy generates. Use
standard Prinergy placeholders, such as %JOBNAME%.
%extension%.

JDF Path

Type the path to the folder where Prinergy will create the JDF
file. You can also click Browse and locate the folder.

If you are sending files to a hot folder, this path must be the hot
folder for the digital printer. It cannot be the same folder
specified in the PDF Path box. The JDF specification requires
that only the JDF files be dropped into a JDF-enabled hot folder.

JDF File Name

(See About custom file naming on page 657)

Type the file name of the JDF file that Prinergy generates. Use
standard Prinergy placeholders, such as %JOBNAME%.jdf.

Imposition Output process template 535



Select JDF Templates

Select Named Features

Use this field only as instructed by the Prinergy Digital Print
Installation and Configuration Guide.

If necessary, enter JDF parameters for Prinergy to send in the
JDF file to the digital print controller. Typically, these
parameters are specific to the digital print controller. Not all
digital print controllers require or support this option. The
parameters are not visible in Prinergy.

Select JDF File

Click the Browse button to locate the appropriate template. If
you do not specify a template, the default template is used.

Media Selection

Use Default Media Selection

Select this option to use the default options displayed.
Otherwise, click Use Selected Media to customize the settings.

Use Selected Media

Select this option to customize weight, size, and other aspects
of the media.

Weight

Type the weight of the paper stock that the job is to be printed
on. If the paper set on the printer has a range of weights (e.g.
81-105 gsm), any number within that range matches.

Color

Select the color of the paper stock that the job is to be printed
on.

If you select None, Prinergy does not send color information to
the digital printer.

Coatings

Select a coating such as Glossy or Satin to indicate that the
paper stock is coated, or select None to indicate that the paper
stock is uncoated.

Size

Select the size of the paper stock that the job is to be printed on.
Choose from:

● Letter, Legal, A4, and other standard paper sizes.
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If you select one of these sizes, you can use the Width and
Height boxes to modify the default measurements of the
paper.

● Automatic—The size is set to the size of the pages or
surfaces.

● None—The size is set to the size of the default paper defined
by the printer queue.

● Custom—Use the Width and Height boxes to specify the
measurements.

This option affects only the paper size that the digital printer
uses. It does not affect the PDF that Prinergy sends to the digital
printer. To change the size of the PDF sent by Prinergy, use the
Layout section of the Imposition Output process template.

Typically the paper size matches the size of the page or surface.
If the paper size does not match the page or surface size, most
digital printers can scale, center, shift, and impose the PDFs
onto the paper.

Width

Type the width of the paper stock that the job is to be printed
on. If the paper set on the printer has a range of widths, any
number within that range matches.

Height

Type the height of the paper stock that the job is to be printed
on. If the paper set on the printer has a range of heights, any
number within that range matches.

Media Handling

Use Default Media Handling

Select this option to use the default options displayed.
Otherwise, click Use Selected Media Handling to customize the
settings.

Use Selected Media Handling

Select this option to customize duplexing and collation settings.

Duplexing

Select an item that controls whether the printer prints on both
sides of the paper. Choose from:
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● SingleSided—Print only on one side of the paper.
● Turn—Print two-sided head-to-head (flip on the paper's long

side or the Y-axis of the paper in portrait orientation)
● Tumble—Print two-sided head-to-toe (flip on the paper's

short side or X-axis of the paper in landscape orientation)

Collation

Select either Sheet or None to control whether the printer
collates the output.

Device Specific Settings

Device Name

Type the name of the digital printer or the print server. For
example, type Spire01.

Queue

Type the name of the print queue. For example, type
ProcessStore.

Device Type

Type the type and version of the digital printer to assist Xerox
FreeFlow Print Manager in translating the JDF. For example,
type DC8000_SPIRE1.0.

Protocol

Type the name of the print protocol that the digital printer uses.
Xerox FreeFlow Print Manager translates the JDF into this print
protocol. For example, type SPIREPR.

Job Spec

Type the name of a pre-defined workflow.

This box applies only when you have selected an HP device.

Marks section in the imposition output process template
This process template section determines how marks are handled
during imposition output.

Sheet Marks

Identify the name and location of a PDF file containing sheet
marks (for example variable marks, logo, and signoff line). Click
Browse to locate and select a file.
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Calibrate

When this check box is selected, the plate curve and print curve
are applied to the mark. The curves applied are the ones
selected in the Plate Curve list and Print Curve list in the
Calibration and Screening section of the process template.
When this check box is cleared, only the plate curve is applied.
To prevent the application of the plate curve to a mark, select %
%None%% in the Plate Curve list in the Calibration and
Screening section of the process template.

Locate Sheet Marks Adjacent to

(See Sheet marks options explained on page 695 and Sheet
marks on final output on page 691.)

Select Left, Right, Bottom, or Top to determine on which edge
of the paper or plate a sheet mark is placed.

The default setting is Bottom.

at Distance

(See Calculating the at distance value on final
output on page 692.)

Determines where, relative to the edge, the mark is placed:

● Sheet marks are placed relative to the plate edge. Depending
on the distance you type, you can place the sheet mark on
the press sheet or on the plate.

● Page marks are placed relative to the finished page size (the
imposition hole).

Justified

Select Left, Center, or Right to determine the justification for
the sheet mark.

The default value is Center.
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Draw Trim and Bleed Marks

Determines where, in relation to each page, trim and bleed
marks should be placed. Trim and bleed marks are created in
registration color and are 0.25 points in weight. Bleed marks are
solid lines; trim marks are dashed lines. Trim marks are drawn
according to the option selected:

None

Trim and bleed marks are not drawn.

On Content

Trim and bleed marks are drawn on the content
(complete trim marks are drawn on the proof).

Outside Content

Trim and bleed marks do not extend to the content
(only the four corners appear on the proof).

Note: In order to print bleed lines on loose page output, the page must be
assigned to a page set that is linked to an imposition plan. The bleed lines
are taken from the imposition plan.

Safe Protect Box

The safe protect box enables you to print proofing lines within
the trim box (or media box) on a proof to check that the page
content is within the page margins. The safe protect box is
drawn on the proof inside the trim or media box.

This feature is available in the loose page output and imposition
output process templates when the Draw Trim and Bleed
Marks option is set to On Content or Outside Content.

Note: If you select Output To Virtual Proof, you can select the Safe
Protect Box check box even if you select None for Draw Trim and Bleed
Marks. In this case, you can view the safe protect box in the Virtual
Proofing System software. The safe protect box is not printed on the
proof.

Select the Safe Protect Box check box and in each of the Left,
Right, Top, and Bottom boxes, type the distance from the trim
or media box that you want the safe protect lines to appear.
You can type different numbers in each of the four sides.

When calculating where to place the safe protect lines, note
that Prinergy measures from various starting points as shown in
the following table.

Proof Safe protect box is measured from this location

Imposition The imposition hole trim box
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Loose page ● The PDF page trim box—if the PDF page
includes trim

● The PDF page media box—if the PDF page does
not include trim

If a PDF page includes trim, it appears in the Trim
Size column in the Pages pane of the Pages view.

Note: If the PDF page does not include trim, you
can define it using the Prinergy Geometry Editor
plug-in for Adobe Acrobat. After the trim is
defined, refine the page again.

The lines of the safe protect box are drawn according to the
option selected for trim and bleed marks:

● If you selected Outside Content, only the four corners of the
safe protect box appear on the proof.

● If you selected On Content, the complete box is drawn on
the proof.

Note: If you entered information for Trim Adjustment, the Safe Protect
Box dimensions are calculated based on the Trim Adjustment
dimensions.

Trim Adjustment

If you are using pages that have no trim or an incorrect trim box,
in the Trim Adjustment area, type the distance from the edge of
the page that you want trim lines to appear in each of the Left,
Right, Top, and Bottom boxes.

You can type different numbers in each of the four sides.

Trim Adjustment is available only when you select Draw Trim
and Bleed Marks, and On Content or Outside Content.

Note: If you enter information for Trim Adjustment, the Safe Protect Box
dimensions are calculated based on the Trim Adjustment dimensions.

Locate Crop Mark of Length

Available if On Content or Outside Content is selected in the
Draw Trim and Bleed Marks box.

Determines the length of the crop marks to be drawn, in the
selected unit of measure.

The at Distance box determines how far away from content to
draw the crop mark.

at Distance

Available when On Content or Outside Content is selected in
the Draw Trim and Bleed Marks box.
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Determines how far away from content to draw the crop mark.

Unit Used for Variable Marks

Select the unit you want to use to measure variable marks—
inch, cm (centimeter), mm (millimeter), or pts (points).

Imposition Marks Calibration

Select one of the following options to determine how imposition
marks are calibrated.

Calibrate

The plate curve and print curve are applied to the
imposition mark. The curves applied are the ones
selected in the Plate and Print Curve list in the
Calibration and Screening section of the process
template.

Do Not Calibrate

Only the plate curve is applied.

Honor Calibration in Imposition

The plate and print curves are applied in a similar
manner, according to whether calibration for the mark
is enabled or disabled in the imposition software. To
prevent the application of the plate curve to a mark,
select %%None%% in the Plate Curve list in the
Calibration and Screening section of the process
template. This applies to Preps 5.2 and later; however,
Preps 6.0 and later is required in order to edit Prinergy
impositions.

Show Press Sheet/Show Plate Edge

Select one or both check boxes to show the location of the
press sheet from the plate edge on imposed proofs. The
defaults are set to OFF.

Default Marks Font

Prinergy can populate variable marks with double-byte
characters such as those used for the Japanese, Chinese, and
Korean languages.

Here's an example of how you could use the feature:

1. Create a Preps imposition file that includes a variable mark,
such as $[PageName].

2. In Prinergy, in the Default Marks Font box in the Marks
section of the imposition output process template, type the
exact name of the double-byte font that can be used in case
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the variable mark's original font was not a double-byte font.
The font must reside either in a Prinergy-aware font folder or
in the job's font search path.

3. Submit the imposition file to Prinergy.

If the imposition file contains a page name with double-byte
fonts, Prinergy outputs the file with these characters.

Slugline

A slugline mark is a text or variable mark that you place on
loose page, imposition, or final output. Instead of using Sheet
Marks or Page Marks, you can use Slugline to quickly place a
slugline mark.

A slugline mark does not need a PDF file, so you can easily
place a mark without creating a PDF file. However, a slugline
mark is just a line of text or a variable mark. You can only
specify the text size.

● In the Slugline mark box, type the text or variable mark.
● In the Text size box, type the font size for the mark.
● In Place on media, specify the distance from left and from

bottom.

Note: If you are using a variable mark in your slugline, the _offset and
_replace parameters, and any page-oriented variables parameters, are
not currently supported.

Generating final output
Follow the instructions in Starting a Process and choose a final output
process template.

Tip:

● Before making plates or film, prepare imposition output and, optionally,
approve all proofs.

● Select signatures in the Signatures view.

See also:
Selecting items in Job Manager on page 30
Starting processes on page 171
Final Output process template on page 544
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Final Output process template
At the top of the dialog box is the Output To list, which you use to
select the file format suitable for the output device you select in the
Device section. The file format selection determines the availability of
some options in the process template. For this reason, you should
select an output format before you set the other options in the process
template.

Copydot section of the Final Output process template
This process template section defines how Prinergy handles copydot
files during final output.

When you enable the Copydot section, the system automatically
converts copydot images for optimal quality on your output device
during output. Only disable the Copydot section for one or more of the
following reasons:

● Your pages lack copydot images.
● You are outputting at your target device resolution.

JTP

Select a job ticket processor (JTP) to use for copydot files.

Note: You set up JTPs using Prinergy Administrator.

Resample

Enables resampling of copydot files to the resolution required
by the output device. The availability of this option is controlled
by the device you select in the Output To list at the top of the
final output process template dialog box.

Select the Resample check box to enable resampling of copydot
files. Prinergy resamples copydot files to the resolution required
by the output device you select in the Output To list at the top
of the process template.

Clear the Resample check box to disable resampling.

Note: You can resample copydot images during another step in the
process—refine, loose page output, or final output.

Descreen

Enables descreening of copydot files for contone output
devices. The availability of this option is controlled by the
device you select in the Output To list at the top of the process
template. This option becomes available only for 8-bit final
output devices.
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Select the Descreen check box to enable descreening.

Clear the Descreen check box to disable descreening.

Calibration Curve

Specifies a calibration curve from Harmony tonal calibration
software for the copydot files.

From the Calibration Curve box, select the calibration curve you
want Prinergy to use for copydot files.

Select %%NONE%% to disable this feature.

ColorFlow section of the final output process template
The ColorFlow section of the final output process template defines
how Prinergy applies ColorFlow settings during final output.

When you configure the ColorFlow settings in an output process
template, you select the device, device condition, and plate line, but not
a color setup. The color setup used is the one that was assigned to the
pages when they were refined—that is, either the color setup specified
in the refine process template that was used or the job's default color
setup. The color setup that is used during output processing is the
color setup specified for each page in the Color Setup column in the
Pages pane.

WARNING: Output will fail if the color setup does not match the color setup
assigned during refine, unless the Allow undefined color setup or color setup
mismatch option is enabled.

It is possible to select from four modes for output to halftone devices
or files. These modes control the curves that are applied upon output.

Print Production

This halftone output mode reflects the standard operation of
Prinergy and ColorFlow for production. When this option is
selected, curves are applied to each output separation, as
described next:

● The print calibration curve for the separation, determined by
the selections from the Snapshot, Device, and Device
Condition lists, and possibly modified at run time by the
settings in the Tonal Control dialog box, is applied to
separation input tints.

● The plate calibration curve, determined by the selections from
the Plate Setup and Plate Line lists, is applied to the
separation tints modified by the print calibration curve.

Note: If None is selected from the Plate Setup and Plate Line lists, the
plate calibration curve is linear (has no effect).
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This option is not available when a process template is
configured for continuous-tone (non-screened) output.

Print Characterization

This halftone output mode is used to print and measure the
response of a print device. When this option is selected, curves
are applied to each output separation as follows:

● The device curve for the separation, determined by the
selections from the Snapshot, Device, and Device Condition
lists, with no modifications from the Tonal Control dialog
box, is applied to separation input tints.

● The plate calibration curve, determined by the selections from
the Plate Setup and Plate Line lists, is applied to the
separation tints modified by the print calibration curve.

Note: If None is selected from the Plate Setup and Plate Line lists, the
plate calibration curve is linear (has no effect).

When this option is selected, the Device list contains all curved
print devices in the selected snapshot, and the Device
Condition list contains all ColorFlow device conditions in the
selected snapshot that use the selected device. If the selected
device condition uses a plate setup, the Plate Setup list displays
this plate setup, and the Plate Line list contains all ColorFlow
plate lines controlled by the plate setup in the selected
snapshot.

When this option is selected, the Color Setup list is not
available.

This option is not available when a process template is
configured for continuous-tone (non-screened) output.

Plate Verification

This halftone output mode is used to verify the linear response
of plates produced by a particular plate line (consisting of the
computer-to-plate device, plate processor setup, and
chemistry), with a selected screening system. When this option
is selected, the following results occur:

● Only the plate calibration curve, determined by the selections
from the Plate Setup and Plate Line lists, is applied to input
tints of all separations.

● No print calibration curve is applied.

When this option is selected, the Plate Setup list contains all
ColorFlow plate setups in the selected snapshot, and the Plate
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Line list contains all ColorFlow plate lines controlled by the
selected plate setup in the selected snapshot.

When this option is selected, the Color Setup, Device, and
Device Condition lists are not available.

This option is not available when a process template is
configured for continuous-tone (non-screened) output.

Plate Characterization

This halftone output mode supports imaging and measuring the
uncalibrated (or intrinsic) response of a plating line, such that a
plate linearization curve can be computed. When this option is
selected, no calibration curves are applied to input tints of any
separations.

When this option is selected, none of the lists in the ColorFlow
section are available.

This option is not available when a process template is
configured for continuous-tone (non-screened) output.

Allow undefined color setup or color setup mismatch

This check box enables the job to run when the selected color
setup differs from the color setup assigned by the refine
process, or if the color setup has not been defined. Note that
when this feature is enabled, output could be significantly
different.

To use this feature, it is recommended to select an approved
color setup listed in the snapshot or by ID number. This will
ensure that the list of devices and device conditions are filtered
to include only those available in the selected color setup. Then,
the Allow undefined color setup or color setup mismatch check
box can be selected and output will succeed with a warning
message.

To output refined pages with no color setup assigned to them,
you can select the Allow undefined color setup or color setup
mismatch setting.

The list of devices and device conditions is unfiltered when
<Job_Color_Setup> is selected. Note that this may cause
output to fail, if the device and device condition selected are not
in the job color setup. A message will be logged in the process
history, and you will need to either select a device and device
condition used in the job color setup or use the recommended
solution, as described above.

When <Color_Setup_Assigned_by_Refine> is selected, the list
of devices and device conditions is also unfiltered, and the
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Allow undefined color setup or color setup mismatch check
box is grayed out and cannot be used. Note that this is the
default color setup setting for all process templates that were
upgraded from Prinergy Connect 5.1.

Snapshot

A ColorFlow snapshot captures the state of the entire color
database, making its elements available to the workflow and
providing a convenient backup. The snapshot feature makes it
unnecessary for you to manually save and name multiple
versions of your color control elements after adjusting them. At
any time, you can easily roll back (revert) to the state of a
previous snapshot in the ColorFlow software. If you roll back to
a previous snapshot, ColorFlow behaves as if changes after that
snapshot never happened.

When you have completed your work in ColorFlow to a certain
level and you are satisfied with the elements in color setups,
you will mark a snapshot as approved. By default in Prinergy
Connect, the currently approved snapshot is used. Only one
snapshot can be in the approved state at any time.

This list is not available if the Plate Characterization option is
selected.

Color Setup

This list displays the names of all color setups in the selected
snapshot. At the top of the list is Color setups assigned by
Refine, followed by Job color setup.

This list is available only if the Print Production mode is
selected.

Allow undefined color setup or color setup mismatch

This check box enables the job to run when the selected color
setup differs from the color setup assigned by the refine
process, or if the color setup has not been defined. Note that
when this feature is enabled, output could be significantly
different.

To use this feature, it is recommended to select an approved
color setup listed in the snapshot or by ID number. This will
ensure that the list of devices and device conditions are filtered
to include only those available in the selected color setup. Then,
the Allow undefined color setup or color setup mismatch check
box can be selected and output will succeed with a warning
message.
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To output refined pages with no color setup assigned to them,
you can select the Allow undefined color setup or color setup
mismatch setting.

The list of devices and device conditions is unfiltered when
<Job_Color_Setup> is selected. Note that this may cause
output to fail, if the device and device condition selected are not
in the job color setup. A message will be logged in the process
history, and you will need to either select a device and device
condition used in the job color setup or use the recommended
solution, as described above.

When <Color_Setup_Assigned_by_Refine> is selected, the list
of devices and device conditions is also unfiltered, and the
Allow undefined color setup or color setup mismatch check
box is grayed out and cannot be used. Note that this is the
default color setup setting for all process templates that were
upgraded from Prinergy Connect 5.1.

Device

An individual occurrence of a physical device that captures or
produces an image. Devices have a type and customer-
specified properties, such as a name and location in the plant.
Because the declaration of a device does not include its
operating conditions—such as ink selection, type of screening,
and paper—you cannot measure the color response of a device
on its own.

When a process template is configured for halftone (screened)
output processes, this list displays the names of all curved
devices used in PCO (primary color output) or SCO (secondary
color output) device conditions in the selected color setup and
snapshot. Curved print devices are those with the following
device types:

● Offset press—for example, sheetfed, heatset web, coldset
web

● Digital press—for example, Versamark
● Digital halftone proofer—for example, Kodak Approval,

Trendsetter Spectrum

When a process template is configured for continuous-tone
(non-screened) output, this list displays the names of all non-
curved devices used in PCO or SCO device conditions in the
selected color setup and snapshot. Non-curved devices are
those with the following device types:
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● Digital press—for example, Nexpress
● Inkjet proofer—for example, Matchprint Inkjet, Kodak Veris
● CMYK reference

This list is not available if the Plate Verification or Plate
Characterization option is selected.

Device Condition

A combination of a device and the operating conditions in
which the device captures or produces an image. A device
condition has a known color response. Device conditions can be
divided into groups such as print conditions (press and proofer
devices), capture conditions (scanner and camera devices), and
reference print conditions (industry specifications). A device
condition can include more than one device. If all the devices
are the same device type, they use the same consumables and
operational settings, and they can be calibrated to yield the
same color response.

When a specific color setup is selected, this list contains all
ColorFlow device conditions that use the selected device and
are used in the PCO or an SCO of the selected color setup and
snapshot.

This list is not available if the Plate Verification or Plate
Characterization option is selected.

Plate Setup

If the selected device condition uses a plate setup in the
selected snapshot, this plate setup is displayed here. Otherwise,
this list displays None.

This list is not available if the Plate Characterization option is
selected. It is also not available when a process template is
configured for continuous-tone (non-screened) output.

Plate Line

You establish the behavior of a particular plate, screening, and
plating line by plating a tint ramp, manually measuring the
resulting dot area on the plate, and entering the values in the
Plate Setups dialog box in the ColorFlow software.

A ColorFlow plate line is associated with only one plate setup.
In your shop, you may use a platesetter and chemistry to
process several different screenings. To model this, in
ColorFlow, create similar plate lines in the other plate setups.
You can name them to match the equipment in your plant. You
may want to create several plate lines to indicate when
chemistry changes occur. For example, if you routinely change
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solutions on Mondays, you might create different ColorFlow
plate lines for Monday, Wednesday, and Friday.

If the Plate Setup list displays a plate setup, the Plate Line list
contains all ColorFlow plate lines controlled by the plate setup
in the selected snapshot. If the Plate Setup list displays None,
the Plate Line list also displays None.

This list is not available if the Plate Characterization option is
selected. It is also not available when a process template is
configured for continuous-tone (non-screened) output.

ColorConvert section of the Final Output process template
This process template section defines how Prinergy handles color
converting during final output.

This section is useful if:

● The device that is actually used for final output is different than the
final output device that was identified during the refine or proof
process

● ColorConvert was not enabled during the refine or proof process.
For example, in a late-binding workflow, operators do not alter the
original color information in the files until the output stage.

JTP

Select the job ticket processor (JTP) to use for color conversion.

You set up JTPs using Prinergy Administrator.

Match Colors

Match Colors in Page Content

Enables the Color Matcher to match hues in the page content
for proofing. In other words, it enables color matching as it was
done in Prinergy 1.1 (as opposed to using the Color Matcher to
affect the L*a*b* spot color recipes).

Select this check box to enable this feature; clear the check box
to disable this feature.

When you enable this feature, you can set the Assumed Source
or DeviceLink Profile option.

Assumed Source or DeviceLink Profile

Select Exactly as Applied During Refining to use the same
profile that was used during the refine process. If the file was
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not color converted during refining, or the profile is missing, an
error is displayed.

Select As Defined Below, if Not Set in Refining to use the same
profile that was used during the refine process, if the file was
color converted during refining. If the file was not color
converted during refining, the profile defined in the Input
Device Conditions box will be used.

Select Exactly as Defined Below to use the profile selected in
the Input Device Conditions box.

Input Device Conditions

Available when Assumed Source or DeviceLink Profile is set to
As Defined Below, if not set in Refining or Exactly as Defined
Below.

From the list, select Browse to locate the appropriate profile file
for final output.

Rendering Intent

Select Relative Colorimetric if the proofing paper is similar to
the paper that will be used during final output.

Select Absolute Colorimetric to simulate the color of the paper
that will be used during final output.

Select PDF to use the rendering intent specified in the PDF file
when output by the creative software during final output.

Select Perceptual to use rendering that uses gamut
compression and produces less saturated colors during final
output.

Select Saturation to make sure colors are represented in a way
that preserves or emphasizes saturation during final output.

Retain CMYK Black

Preserves black in images and graphics that are defined in
CMYK or RGB color space. For ICC-based color matching
engines, CMYK images and graphics get transformed from
CMYK to L*a*b* and back to CMYK color in order to perform
color matching. In going from CMYK (four components) to
L*a*b* (three components) and back again, the black (K)
channel separation information (UCR/GCR) has in the past
been destroyed. Selecting this check box instructs the Color
Matcher to preserve the black generation information from the
source color space. As a result, the amount of black relative to
CMY in the images and graphics stays about the same. The
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purpose of this feature is to help preserve the visual weight of
images and graphics.

Note: When you enable this feature, Color Matcher requires some
additional processing time because of the extra calculations involved.

Overprint Handling (CPU Intensive)

(See About overprint handling on page 257)

Select to prevent overprinting objects from generating
unintended knockouts.

If you are converting spots to process for a proof, or if you are
color-matching one CMYK space to another CMYK space for a
proof, you probably need to apply overprint handling, even if
you applied it during refine.

To use overprint handling, you must:

1. In the ColorConvert section, select:

● The Color Matcher JTP
● The Match Colors in Page Content check box
● The Overprint Handling check box

2. Choose between raster and vector overprint handling in the
Methods list.

Note: The raster option is available only when Shades=256 is
selected in the Render section of the process template.

Method

Choose to use vector or raster overprint handling for this output
process.

Select Raster when outputting to low-resolution contone
proofers (for example, Veris digital proofer or Matchprint Inkjet
proofer).

Note: To use raster overprint handling, you must select, in the Render
section of the process template, Shades=256.

Additional factors to consider:

● Raster overprint handling can be applied only to continuous
tone data

● Raster overprint handling occurs after the RIP
● Raster processing time increases exponentially as the

resolution increases
● Raster overprint handling eliminates all overprints
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Select Vector when outputting to halftone (screen) proofers
(for example, the Spectrum device), or to high-resolution
contone proofers.

Additional factors to consider:

● Vector overprint handling occurs before the RIP
● Depending on the complexity of the file, vector overprint

handling could take longer than raster overprint handling.
● Vector overprint handling does not eliminate all overprints.

In objects where overprinting does not have an effect on the
output, the objects retain an overprint status. For example, if
you set black to overprint, but one black object is not placed
on top of another object, this black object is, after overprint
handling, still an overprinting object.

Preserve Traps

Select this check box to preserve existing Kodak traps when
vector overprint handling is used.

Note: When existing traps are preserved, you cannot remove them in
later processing. You must remove the traps in the original file. Traps are
color-managed as regular objects.

Process CEPS Data

Select this check box to enable spot color mapping and color
matching of CEPS data.

For further information, see the CEPS Conversion Section and
the Normalize Section of the Refine Process Template.

Process Marks

Select this check box when you want to apply color
management to your marks file. Depending on the type of mark,
it may be necessary to enable Overprint Handling to
appropriately convert the mark and apply the necessary color
transformation.

Note: When Process Marks is checked, both sheet marks and page
marks are color managed.

Color match 1-bit images

Select this check box to color match 1-bit images. One-bit
images are images that represent two tones, typically black and
white. The pixel is either a 0 or a 1 value. Examples are copydot
images.

Note: This feature will convert 1-bit images to 8-bit images. This causes
pages to become larger and to render more slowly. Turn off this feature if
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you do not require color matching of 1-bit images, or if the feature causes
unacceptable performance degradation. (For example, copydot files take
a very long time to refine and render.)

This feature is available when Match Colors in Page Content is
selected.

Process (Destination) Profile

Enables the ICC profile for a proofing device. The ICC profile
characterizes the way the proofing device prints.

Enable this feature by selecting a profile in the Process
(Destination) Profile box. Leave this box blank to disable the
feature.

Source of Color Recipes

Extract Recipe from the File

Select to use the color recipes embedded in the file.

Lookup Recipe in Color Database

Select to use the color libraries selected in this process
template.

Color Libraries

Always Use Color Combiner to Convert Spots

Available when a proof output format is selected in the Output
To list (not available for final output).

If the input files contain overprinted spot colors, the Color
Combiner, which is a plug-in to the renderer, combines the
layers and outputs the overprinted colors correctly.

When cleared, the renderer handles the conversion of spot
colors to process colors if the following conditions exist:

● input files are composite
● all spot colors are set to Opaque in the color database (if the

spot color is not in the color database, Opaque is assumed)

If the above conditions are not met, the Color Combiner will be
used even if the Always Use Color Combiner to Convert Spots
is cleared.

Recommended setting: Selected.
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This check box appears in both the Render section and the
ColorConvert section. Changing it in one place changes it in the
other.

Selectable and Selected

From the Selectable list, select the color libraries that you want
Prinergy to search for color recipes, and click Add.

Arrange the color libraries in the Selected box in the order
(descending) that you want them to be searched. Use the Move
Up and Move Down buttons.

Note: Ensure that you select color libraries with color spaces that are
compatible with the Final Output Process Profile box of the Spot Color
Handling section of the refine process template.

Use Recipe from File if not found in Color Database

Select this check box to use color recipes embedded in the file if
Prinergy does not find the colors in the selected color libraries.

Layout section of the Final Output process template
This process template section defines how Prinergy places the pages
on the output media during final output.

Media

Paper

This option becomes available when you select Kodak Proofers
in the Output To list.

Specifies the type of paper you're using in the Kodak proofing
device. Select a paper type from the list.

Thickness

This option becomes available when you select an Epson device
in the Output To list.

Type the thickness of the paper you are using in the Thickness
box, and then select a unit of measurement.

Media Registration

When using the Kodak Magnus VLF platesetter, select a media
registration which is a collection of several registration settings,
such as punch and registration camera settings, for your
requirements. When you select a media size, a list of
compatible registrations becomes available. Setting registration
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in Prinergy means that you do not have to set up registration
parameters each time you load a plate.

Media registrations, which are set up for specific presses and
can apply to a single plate size or a range of plate sizes, are
created in Print Console.

Name

Available when a vendor's device has been defined through the
Prinergy Administrator. Available options are determined by the
device.

Size

Determines the size of the media to which you will output the
final files.

Select Digital to generate an output file, for example, a file for
Virtual Proofing System software. When you select Digital, the
Min Width, Min Height, Max Width, Max Height, and Layout is
90° Different Than Media boxes are unavailable.

Select Cut sheet, Roll fed, or Roll fed (transverse), depending
on the media being used.

Min Width

Sets the minimum width for the specified media in the unit of
measure selected in the list.

Min Height

Sets the minimum height for the specified media in the unit of
measure selected in the list.

For cut sheet, enter the sheet height. For roll fed, enter the
height of the smallest proof you want to make on the device.

Max Width

Sets the maximum width for the specified media in the unit of
measure selected in the list.

Max Height

Sets the maximum height for the specified media in the unit of
measure selected in the list.

Duplexing

This option is available for composite files; it is unavailable for
separated files.

Specifies the type of duplexing.
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From the Duplexing box, select Turn or Tumble to enable this
feature. Select None to disable duplexing.

Front Shift and Back Shift

The Front Shift Along Width...Along Height and Back Shift
Along Width...Along Height options give finer adjustment
when aligning two-sided proofs than with Center Along Width/
Height. Use these measurements to shift and align front and
back pages along their turn or tumble axes, depending on the
page or imposition orientation (portrait or landscape).

These options are available only when Duplexing has been set
to Turn or Tumble.

You can specify the shift in points, inches, centimeters, or
millimeters.

Placement

Orientation

(See Example: orientation on page 653)

Rotates an entire imposition as a unit.

Select Auto clockwise to automatically rotate an image
clockwise when rotating would result in a better fit.

Select Auto counterclockwise to automatically rotate an image
counter-clockwise when rotating would result in a better fit.

Center Along Width

Centers the imposition plan along the horizontal axis of the
media.

Center Along Height

Centers the imposition plan along the vertical axis of the media.

Shift Along Width

(See Example: shifting images horizontally and
vertically on page 654)

Available if the Center Along Width check box is cleared.

Shifts the imposition plan from the left edge of the media along
the horizontal axis.

Shift Along Height

(See Example: shifting images horizontally and
vertically on page 654)
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Available if the Center Along Height check box is cleared.

Shifts the imposition plan from the bottom edge of the media
along the vertical axis.

Scale Shift Amounts

Automatically adjusts placement based on scaling.

If the Scale Shift Amounts check box is cleared, placement is
not adjusted when scaling is applied.

By default the Scale Shift Amounts check box is selected.

Flat Rotation

Makes a small angle rotation of the flat or output image. Also
called plate cocking. Derive the (0.0) percentage value, or
gradient, in one of two ways:

● Physically measure the first occurrence of a rotation to find
the gradient that you can then apply for all jobs that use that
rotation

● Convert a given angle into its gradient

To measure for a gradient:

● Formula: gradient = rise/run x 100 where:
● Rise: (y-axis) measure the distance between where the flat's

rotating corner started and where it must be moved as a
straight line that meets the x-axis at a 90° angle. Example: 2
units

● Run: (x-axis) measure the distance along the x-axis from the
non-rotated corner of the flat to the point where the vertical
line transects the x-axis at a right angle. Example: 90 units

● Calculation: 2/90 x 100 = 2.2
● The maximum percentage value is 3.1.

To convert an angle to a gradient:

● Formula: gradient = tangent of the angle of rotation x 100
● Calculation using a scientific calculator and an angle of 0.5°:
● 0.5° + Tan(gent) key = 0.008 x 100 = 0.8
● The maximum angle of rotation is 1.78°.

Note: To convert a gradient to an angle, enter the gradient into the
calculator and apply the inverse tangent function. Example: 2.2% is
entered as 0.022 + Inv(erse) key + Tan key = 1.26°.
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● Indicate whether the rotation is to be clockwise or
counterclockwise.

Note: The process template does not let you select flat rotation and
web growth at the same time. However, when web growth is applied,
flat rotation can be specified in the web growth profile.

Punch Setting

Available when a format for an imagesetter that has an
automatic punching system (for example, Herkules) is selected
in the Output To list.

Select a punch type. For more information about punch types,
see your device documentation.

Scaling

Scale Vector

Applies scaling to the layout prior to screening the file. The
scaling is based on vector data (PDF data).

Apply Scaling from Layout

Select to use the scaling specified in the original layout
application, for example, Pandora.

Note: This feature is not compatible with Preps.

Custom

Enter scaling percentages for the Along Width and Along
Height directions.

Fit to Media Size

If the specified layout produces an image too large for the
media, the image is scaled to fit.

You cannot see the scaling percentage. Select this check box
only when a proof scaled to an unspecified reduction is
acceptable.

Non-Printable Margin

If the Fit to Media Size option was selected, you can identify the
non-printable margins that should be taken into account when
determining scaled layouts.

Specify left, right, top, and bottom non-printable margins
appropriate to the output device and media, in the selected unit
of measure.
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Scale Raster

Applies raster scaling to the layout. Raster scaling is an optional
feature that will allow you to apply distortion after the files are
screened.

Raster scaling is recommended for prescreened files (copydot)
or files that contain 1-bit TIFF images, since the prescreened
bitmap data cannot be properly scaled with vector scaling
(could generate artifacts).

Clear this check box to disable this feature.

Apply Scaling from Layout

Select to use the scaling specified in the original layout
application, for example, Pandora.

Note: This feature is not compatible with Preps.

Custom

Enter scaling percentages for the Along Width and Along
Height directions.

Assign Web Growth Profile, if Available

(See Example: web growth profile on page 730 and Applying
and removing a web growth profile on page 739)

Enables the system to digitally compensate for distortion on
press using a web growth profile file (<file name>.wgp) and a
tower color file (ColorTowerMap.txt).

Web growth scaling can be used in situations where each plate
must be scaled by a different (or identical) factor.

Select the Use Web Growth Profile option to enable this
feature. Then do one of the following:

● Select Use profiles assigned in Job Manager only. If a profile
is not assigned in Job Manager, no web growth profile will be
applied.

● Select Default Profile and either type or browse to select a
profile that will be used for all sheets when this process
template is used.

Note: Web growth profiles can be assigned in Job Manager or in
Process Template Editor. If a web growth profile is specified for a job
in Job Manager, this overrides any web growth profile that is assigned
here, unless you also select the Override profiles assigned in Job
Manager check box.

● Select Assign Profile to Sheet to select a profile for each
individual sheet. This feature is useful when, for example,
you need different profiles for the left and right webs of a
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multi-web run. A "sheet" in the Assign Profile to Sheet list
box refers to two surfaces printed on two sides of the same
substrate. For example, a multi-web layout consisting of a
single signature with two webs would map Sheet 1 to
Signature 1 sides A and B, and map Sheet 2 to Signature 1
sides C and D. If there were a second signature, then Sheet 3
would map to Signature 2 sides A and B, and Sheet 4 would
map to Signature 2 sides C and D.

Note: If a web growth profile is specified for a job in Job Manager, this
overrides any web growth profiles that are assigned here, unless you
also select the Override profiles assigned in Job Manager check box.

Render section of the Final Output process template
This process template section determines the output resolution and
how the system handles spot colors during final output.

JTP

Select the job ticket processor (JTP) to use for rendering.

Note: You set up JTPs using Prinergy Administrator.

Device Resolutions

This list is available when an output device format is selected in
the Output To list.

Select a resolution for the selected device in the list.

Resolution X

Available when the Device Resolutions box is unavailable.

Type a resolution value.

Resolution Y

Available when the Device Resolutions box is unavailable and
mixed resolution values are allowed for the output format
selected in the Output To list.

Type a resolution value.

Color Model

Select the process color model to use for output.

The list of values varies, depending on the output format
selected in the Output To list.
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Shades

To set the number of shades of gray to output, select 1 for
screened data or 256 for continuous tone data. When 1 is
selected, the Calibration & Screening section of the refine
process template is available for input.

The list of values varies, depending on the output format
selected in the Output To list and the color model selected in
the Color Model list.

Do Separations

Available when the output format selected in the Output To list
supports separated output and DeviceCMYK is selected in the
Color Model options.

Select if you want Prinergy to output separations. Clear this
check box if you want Prinergy to output a single composite file.

Always Use Color Combiner to Convert Spots

Available when a proof output format is selected in the Output
To list (not available for final output).

If the input files contain overprinted spot colors, the Color
Combiner, which is a plug-in to the renderer, combines the
layers and outputs the overprinted colors correctly.

When cleared, the renderer handles the conversion of spot
colors to process colors if the following conditions exist:

● input files are composite
● all spot colors are set to Opaque in the color database (if the

spot color is not in the color database, Opaque is assumed)

If the above conditions are not met, the Color Combiner will be
used even if the Always Use Color Combiner to Convert Spots
is cleared.

Recommended setting: Selected.

This check box appears in both the Render section and the
ColorConvert section. Changing it in one place changes it in the
other.

Anti-Aliasing

Select this check box to enable anti-aliasing, and then in the at
Ratio list, specify a ratio for anti-aliasing.

Anti-aliasing is a technique of improving the appearance of
output by minimizing the "stair step" effect on rasterized
output. It does so by rendering to a higher resolution than the

Final Output process template 563



intended output, and then downsampling to the intended
output. This generates "averaged" pixels which softens the
"stair step" effect on low-resolution output. The ratio value for
anti-aliasing refers to the factor used to determine the
intermediate resolution. A higher ratio results in higher quality,
but can have an effect on output speed. For example, if the
output is a 300 DPI 8-bit TIFF, and the anti-alias ratio is 4,
Prinergy will render an intermediate output at 1200 DPI (4 x
300 DPI), and then downsample to the user-requested 300
DPI. Anti-aliasing is only available for 8-bit (256 shade) output.

Fail if font problems detected

Select this check box to fail the output process if a file has
missing fonts.

Note: This feature is not available for vector outputs (PDF, PS2, PS3, EPS,
DCS Vector, PDF/X-1a, PDF/X-3, CT/LW, and DELTA).

Ignore Embedded Fonts in Marks Files

Select this check box if you want Prinergy to ignore embedded
fonts in a marks file and to look for the fonts in the system
fonts folder.

Important: You must install the fonts in %ServerName%\%AraxiHome
%\AdobeExtreme\bin\fonts, or the output will fail.

Convert Text to Paths

This check box converts fonts to outlines before a file is RIPed.

This option was added in Prinergy 3.0 when the CPSI 3016 RIP
was included with Prinergy. This option helped situations where
the 3016 RIP failed to process the fonts on certain jobs.

This option has limited usefulness now, but is included as a
potential workaround in rare cases where fonts are not
rendered correctly by the RIP. It is not recommended that you
enable this on on a permanent basis. When using this option for
specific jobs, it is recommended that you ensure that both
proofs and plates are output with this option.

Note that when you select the Convert Text to Paths check box,
you will have text appear fatter on low-resolution proof output.
You can overcome this appearance problem by either:

● Rendering to a higher resolution, if rendering to 1-bit output,
such as Virtual Proofing System

● Using anti-aliasing, if rendering to contone output
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Note: This check box is only available for raster output formats
(.VPS, .TIFF, and so on).

Calibration and Screening section of the Final Output process
template

This process template section provides calibration and screening file
information during final output.

These options are available when you select 1 in the Shades option, in
the Render section of the process template.

Calibration

Plate Curve

Select None if you do not want to apply plate linearization
curves to your output. This option is set to None by default.

To apply a plate curve to your output, select the curve in the list.

You must select a plate curve in the Prinergy process template,
even when Print Curve (Calibration) is set to Auto.

Note: Plate curves are always applied to page, sheet, and imposition
marks. Select None if you do not want curves applied to marks.

Print Curve (Calibration)

Select None if you do not want to apply print dot gain
compensation curves to your output.

To apply a print calibration curve to your output, select the
curve in the list.

Select Auto to automatically select the most appropriate curve.
Depending on the Screening Method selected, the Harmony
software determines the curve to use, based on dot shape and
screen frequency data from your job or the process template.
Harmony looks in the following locations in the process
template:

● Dot Shape and Screen Ruling boxes
● Screen Frequency box
● Harmony Medium box
● In the Render section, the Device Resolutions box (or

Resolution X and Resolution Y boxes)

If you assign a calibration curve in the Prinergy DotShop
software for use on a mark, you must select the Keep DotShop
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Settings or Use Document's Screening, if Present screening
mode.

Note: To control the application of the selected print curve for an
individual page, sheet, or imposition mark, select the Calibrate check box
in the Marks section of the process template. This allows you to apply
print curves to imposition content without applying print curves to
marks.

Harmony Medium

Available when you select Auto in the Print Curve (Calibration)
list, it lists the Harmony media that are defined in your
Harmony curve database. If the Harmony Medium list is
available but the list is empty, no Harmony media are defined.
The selected Harmony media is used to identify an appropriate
calibration curve.

Select a Harmony media in the list.

Minimum Dot Size

Type the lowest tint percentage, with up to one decimal place,
at which dots will be imaged—for example, 10% or 10.5%. This
feature is available only if you specified a plate or print curve.

You can use this feature to remove scum dots on flexo plates.

Screening Mode

(See also the topic about document screening in this guide.)

● Select Override all Screening to use the screening specified
in the process template. This option ignores any screening
specified in the source PDF file or the Prinergy DotShop
software.

● Select Keep DotShop Settings to use the screening specified
in the DotShop software, when available. For pages that are
not modified in DotShop, the screening specified in the
process template is used.

● Select Use Document's Screening, if Present to use the
screening specified in the source PDF file.

This option also uses the screening specified in DotShop,
when available. For pages containing no screening
information, the screening specified in the process template
is used.

You can use one or more of the Angles, Frequencies, and
Dot Shapes settings specified on the page and allow the
process template to determine the parameters that you did
not specify.
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Note: If Prinergy does not support the screen angles in the source PDF
file, the nearest supported angle is used.

Note: This option offers the greatest risk of poor results, because screen
angles identified in the source PDF file may not be suitable for the output
device.

Screen Type and Screen System

(See also the topics about screen types and screen systems.)

Screen Type lists the following default screening information:

● Maxtone screen types are based on the Prinergy AM
(conventional or rational tangent) screening technology.

○ The Maxtone CX screen type is configurable. To
configure the size of highlights and shadow dots, type
values in the Dot Width Highlights and Shadows boxes.

○ The Maxtone NX screen type is also configurable. To
configure the size of highlights and shadow dots, select
values from the Dot Size Highlights and Shadows lists.

Note: It is also possible to select the dot size for the highlights and
shadows using DotShop Composer. Maxtone NX works on the
entire page, so all objects defined with Maxtone NX must have
dots of the same size. If there are multiple dot sizes selected, the
output process will fail.

○ Maxtone IS screen types are used for seamless sleeve
and cylinder output device applications. If you select
Maxtone IS, the resolution set in the Render section of
the process template must be identical to the resolution
in the IS screen system. Most IS screen systems are
predefined in the IS screen set and cannot be modified in
the process template. For information about defining IS
screen sets, see the Prinergy System Administration Guide.

To see how items in the list of IS screen systems can be
hidden, see the topic about hiding IS screen sets.

○ Maxtone IS CX screen types are used for seamless sleeve
and cylinder output device applications, but they are
configurable. If you select Maxtone IS CX, the resolution
set in the Render section of the process template must be
identical to the resolution in the IS screen set.

● Staccato identifies the Staccato stochastic screening family.

○ The Staccato NX screen type is configurable. To
configure the size of highlights and shadow dots, type a
value in the Dot Size Highlights > Shadows box.
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Select a screen system for the format selected in the Output To
list.

Dot Shape

(See also the topic about dot shapes.)

Select a dot shape in the list.

The list of available dot shapes varies, depending on the screen
system selected in the Screen System list.

Device Resolutions

Displays the values set in the Resolution X and Resolution Y
boxes in the Render section of the process template.

Screen Ruling

Available when Maxtone, Maxtone CX, or Maxtone NX is
selected in the Screen System list.

The list of available screen rulings varies, depending on the
setting in the Screen System, Device Resolutions, and Output
To lists.

If you select an IS screen set, you cannot change the Screen
Ruling value.

Feature Size

Available when Staccato, Staccato CX, or Staccato NX is
selected in the Screen System list.

Select the most appropriate feature size (in microns or pixels)
for the screen system. A smaller number produces finer-grained
output.

The list of available feature sizes varies, depending on the
setting in the Screen System, Device Resolutions, and Output
To lists.

Note: The Staccato feature sizes denote a dot size somewhere between
the actual highlight and the midtone dot size.

Note: The Staccato CX or NX (first order) feature size denotes the exact
dot size of the highlight and quarter tone dots. Resolution is factored into
the Staccato CX or NX (first order) dot size calculations.

Note: Staccato feature sizes listed as <##>.1 indicate a first-order
screen, where <##> is the approximate dot size of the highlight and
quarter tone dots.

Midtone Frequency

Available when Staccato CX or Staccato NX is selected in the
Screen Type and Screen System lists.
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Select a Staccato CX/NX midtone frequency in the list. A larger
number indicates a finer dot structure.

Midtone frequency is an accurate measure of the number of dot
structures per inch in the midtones of Staccato CX/NX screens.
Frequency is expressed in lines per inch (lpi) and is a useful
metric with AM and FM screens when assessing qualitative,
lithographic, and imaging behavior. Staccato CX/NX midtone
frequency is comparable to Maxtone and Maxtone CX/NX
screen ruling.

Values in this box are governed by resolution and licensing. For
a complete list of the available Staccato CX midtone
frequencies and dot widths, including configurations that match
Staccato screen type feature sizes, see the section about
document screening, in this guide.

Screen Color

In the Screen Color and at Angle boxes, perform the following
tasks:

● Set screening for colors other than the four process colors
● Swap the process color screens within screen systems
● Assign a screen to the "Default" color. This screen will be

used for any color that doesn't have its own screening value
in the output process template or color database.

The screen angles associated with each process color in the at
Angle box vary, depending on the setting in the Screen System
and Dot Shape lists.

To assign a screen to a color in the Screen Color box, type the
name of a spot color, or type Default to select the default
screen angle. Use the correct capitalization and spacing in color
names.

Note: To swap two screens (for example, magenta for black), modify the
entries for both colors. In this example, modify the setting in the at Angle
box for magenta to use the black screen, and modify the setting in the at
Angle box for black to use the magenta screen.

Default Spot Color Handling

Determines how Prinergy assigns screen angles to spot colors
that do not have screen angles assigned in the Screen Color and
at Angle boxes or in the Color Editor.

To choose C, M, Y, or K as the default color screen angle, select
Screen as. To cycle through the available color screen angles,
select Cycle Through Screen Angles.
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Screen as

To assign a different default spot color screen angle, select a
color in the list.

For IS screening, Prinergy cannot assign the Others angle as the
default spot color angle.

Cycle Through Screen Angles

Select this option to assign default spot color screen angles
cyclically to the available process colors, in CMYK order.
Prinergy does not assign process colors that have already been
used to screen a spot color.

If Staccato Extended is selected in the Screen System list, the
list of screens cycles from Screen #1 through to Screen #10.

For IS screening, Prinergy cannot cycle through angles other
than CMYK.

Do not increase yellow ruling

To reduce moiré, the AM screening algorithm provides yellow
screen frequencies (lpi) that are up to 14% higher than the
cyan, magenta, and black screens. If you want a Y screen that is
more similar to the Y screen in Prinergy 2.2 and earlier, select
this check box. It limits yellow screen frequencies to between
-4% and 4% of the ruling of the C, M, and K screens. For
example, if the C, M, and K screens are at 150 lpi, this check box
limits the screening algorithm to providing a Y screen between
144 lpi and 156 lpi.

This setting does not affect the yellow frequency of an IS screen
set. To change the yellow frequency of an IS screen set, use the
IS Screen Set Editor.

Rotate Screens With Pages

Select to rotate screens with reader orientation for each page in
an imposition.

When some pages are rotated 90°, rotating screens with the
pages allows all pages to be screened at the same angle.

Screens are only rotated at 90° so pages that are oriented at
other angles are not affected. The result of rotating screens is
apparent when you screen with dot shapes that are not
rotationally symmetric, such as Elliptical and Line.
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Rotate Screens With Pages is cleared Rotate Screens With Pages is selected

Mirror Screens with Output

Select to mirror screens so they are consistent across all
devices (for output devices that have intrinsically mirrored
output).

Note: This will affect the screen angle rotation on the printed page and
should be used only for compatibility with legacy printing.

When the Mirror Screens with Output check box is selected,
selecting the Mirror Print check box in the Device section of the
process template causes screen angles to become mirrored
with the output. This is useful for some printing processes that
require mirrored film or plates, to ensure consistency of screen
angles with digital dot proofs.

Mirror Print is selected

Mirror Screens with Output is cleared

Mirror Print is selected

Mirror Screens with Output is selected

Note: If Round is selected in the Dot Shape list, the Rotate Screens With
Pages and Mirror Screens With Output selections don't affect output.

Set Halftone Phase for each Page

Select to have the renderer reset the origin of the halftone
screen for each page on an imposition.

When selected, this option ensures that each page on an
imposition has the same bitmap pattern.

This is useful for a label printer who wants each label on the
imposition to be identical. A difference in the halftone screen
origin for each label can sometimes show up as a visible
difference at the edges of the labels.
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Screen Solids

Applies a screening pattern to solid areas in order to better
absorb excess ink. This screening feature results in cleaner
printing of solid areas.

Screen solids can also be effective in reducing ink consumption
during proofing.

In the as box, type a value between 0% and 99.8% to indicate
the percentage at which you want to screen all objects with
solid (100%) tint.

Maxtone CX Dot Width

Note: This option is not available when Maxtone or Staccato is selected
in the Screen Types list.

Highlights

Type the size (in microns) of the Maxtone dot for
highlights.

Shadows

Type the size (in microns) of the Maxtone reverse dot
for shadows.

Highlights

Type the size (in microns) of the Maxtone dot for highlights.

Shadows

Type the size (in microns) of the Maxtone reverse dot for
shadows.

HyperFlex

Screening technology that allows for smaller dots and/or
graphic elements to be held on flexo plates during UV exposure
of a plate.

For more information about HyperFlex, see the Prinergy
Advanced Flexo User Guide.

HyperFlex Classic

When imaging on flexo plates, select to enhance Maxtone dots
with HyperFlex Classic technology.

Note: Hyperflex Classic is not intended for offset use.

In the extreme highlight areas, Maxtone simulates FM
screening by randomly removing dots from the AM grid.
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HyperFlex Classic helps to support and strengthen Maxtone by
placing light valves where dots have been removed.

Pixels

Type the HyperFlex dot size in pixels.

To determine the proper HyperFlex dot size, you must perform
a series of flexo exposure tests. For more information, see the
Prinergy Advanced Flexo Implementation User Guide.

HyperFlex Advanced

In flexo applications, select to use HyperFlex Advanced with
Maxtone, Maxtone CX, Maxtone NX, Maxtone IS, Maxtone IS
CX, and Staccato NX screen types.

Note: Hyperflex Advanced is not intended for offset use.

HyperFlex Advanced places light valves around halftone dots to
strengthen and support individual dots.

Size

Type the size of the light valve in pixels. The minimum value is 1
and the maximum value is 16.

As feathering (a reduction in HyperFlex size as tone value
increases) is being applied, this value specifies the starting size
of the light valve. The light valve size is scaled back, in a linear
fashion, to zero (at the tint percentage specified in the Limit
box).

Distance: Start/End

Enter the distance between the center of the light valve and the
center of the dot.

Suggested settings—Enter the same values in the Start and End
boxes, and use a larger value than you enter in the Merge
Distance box. For example, type 2 in both the Start and End
boxes, and type 1 in the Merge Distance box. This positions the
light valves equidistant between adjacent halftone dots.

If you are not using the suggested settings, in the Start box,
type the distance from the light valve to the center of the
smallest halftone dot. In the End box, type the distance (in
pixels) from the light valve to the center of the largest dot, as
specified in the Limit box.

Merge Distance

Enter a value that determines where the light valves will be
positioned in relation to the halftone dots.
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Suggested settings—Enter the same values in the Start and End
boxes. Enter a smaller value in the Merge Distance box than
you entered in the Start and End boxes. For example, type 2 in
both the Start and End boxes, and type 1 in the Merge Distance
box. This positions the light valves equidistant between
adjacent halftone dots.

Limit

Type the tint percentage above which HyperFlex Advanced will
no longer be applied. The general recommendation is to set the
Limit between 20% and 50%.

DigiCap

DigiCap is screening software for digital photopolymer (flexo)
media that improves the transfer of ink in solid areas, using
small reverse dots (a tint).

Set the DigiCap texture by specifying the size of the reverse
dots and the tint percentage. In the Texture with boxes, type
the length and width of the reverse dots. The maximum size is
10 pixels by 10 pixels.

In the as box, type the tint percentage. For example, a 92% tint
creates an area with 8% coverage of reverse dots.

To determine the proper DigiCap feature size and percentage,
you must perform a print test containing multiple combinations
of coarseness levels and tint percentages. You cannot
determine the feature size or percentage without
comprehensive press tests. For more information, see the
Prinergy Advanced Flexo Implementation User Guide.

In the Keepaway box, type the distance (in pixels) between the
edge of elements to which DigiCap texturizing should not be
applied and the start of DigiCap texturizing.

See also:
About document screening on page 637
About dot shapes on page 638
Screen types on page 641
About screen systems on page 643
Setting up Maxtone screens on page 663
Setting up Staccato screens on page 664
Creating and editing IS screen sets on page 665
Hiding IS screen sets on page 668
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PrintLink section of the Final Output process template
This process template section defines how Prinergy creates PPF (Print
Production Format) files during final output.

When the PrintLink section is enabled, Prinergy generates PPF files and
ink reports when you initiate this process template.

Note: You can generate PPF files without creating plates or film. To generate only
PPF files, on the final output process template, clear the check box on the Device
horizontal bar, and select the check box on the PrintLink horizontal bar.

Preview Resolution

Defines the resolution for the plate preview that appears on the
press console viewing station. Select one of the following
resolutions in the list:

● Low resolution is approximately 12.5 ppi, which gives good
preview images.

● Medium resolution is approximately 25 ppi, which gives a
sharper preview image with more detail.

● High resolution is approximately 50 ppi, which gives the
sharpest available preview image with the most detail.

● Very High resolution is up to 100 ppi, which gives the
sharpest available preview image with the most detail,
depending on the plate output resolution.

Note: Higher resolutions give better quality preview images, but they
dramatically increase the preview image file size.

Output Type

Select one of the following options:

● Absolute File, and then type the path to a specific network
device or file in the Put Files in Directory box—or click
Browse and locate the network device or file.

● Job-Relative File. A %Job% variable appears in the Put Files
in Directory box, indicating that Prinergy will place PPF files
in the job folder. To specify a specific location in the job
folder, expand the path.

Note: If you enter a path for a network device in the Put Files in Directory
box, Prinergy automatically changes the Output Type option to Absolute
File, if it is not selected.

Put Files in Directory

Specifies where Prinergy places the PPF files that it generates.
Select a directory on a PPF file reader workstation.
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Important: Ensure the destination directory that you select has enough
space for PPF files generated by the PrintLink digital ink-profiling
software.

Rotation from CTP to Press

Adds rotation information to PPF files. Select 0°, 90°, 180°,
270° to rotate the plate the specified amount in a clockwise
direction.

Note: This option is set during Prinergy installation. Before you change
this option, contact a service representative.

File Generation Mode

Determines the format of the PPF files. Select one of the
following options in the list:

● One file per sheet to generate a combined PPF file that
contains information for the entire press sheet.

● One file per surface to generate a combined PPF file that
contains information for an entire surface.

● One file per separation to generate a separated PPF file—
that is, PrintLink generates a PPF file for each separation.

Press Interface

Specifies the press interface for which the PPF files are
intended. Select a specific type of press interface if you're using
one of the press interfaces listed; otherwise select Generic
Press Interface. If you selected Generic Press Interface, go to
the Press Interface Configuration File box to select a
configuration file. Note the number of divisions for the following
manual Press Interface options:

Press Interface option Number of divisions

Manual 100 divisions (0 to 100)

ManualHeidelberg 16 divisions, each with 16 subdivisions (1 to
16 : 1 to 16). For example, 50% is 8:16.

ManualHeidelberg1 24 divisions, each with 20 subdivisions (1 to
24 : 1 to 20)

ManualManroland 254 divisions (0 to 254)

ManualManRoland1 24 divisions (1 to 24)

Number of Ink Key Zones

Type the number of ink key zones.
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Press Width

Press width should be set to the zone size multiplied by the
number of ink zones. For more information about zone sizes,
see the press manufacturer documentation.

Press Height

Type the maximum height that is printable on the press. For
more information, see the press manufacturer documentation.

The ink key calculations are based on the PrintLink Preview
Resolution. A resolution of approximately 2 ppm or 50 ppi is
required for accuracy (for a render resolution of 2400 dpi ). The
Preview Resolution inside the PrintLink file is calculated
according to a down sample factor, which is dependent on the
render resolution and the PrintLink Preview Resolution selected.
For more information, see the documentation about Preview
Resolution.

Send Files Using FTP

Enables Prinergy to send PPF files via FTP (file transfer
protocol) to a PPF file reader workstation. Use this option for
PPF file reader workstations that are not running Windows,
such as a Heidelberg PPG (Prepress Gateway). Select the Send
Files Using FTP check box to enable this option; clear the check
box to disable this option.

FTP Address

Type the FTP address of the PPF file reader workstation to
which you want PrintLink to FTP the PPF files.

FTP Logon Name

Type the FTP logon name.

FTP Password

Type the FTP password.

Delete Files After FTP Completes

Deletes PPF files from Prinergy after they are successfully
FTPed to the PPF file reader workstation. Select the Delete Files
After FTP Completes check box to enable this feature; clear the
check box to disable this feature.

Use Custom File Naming

Select this check box if you want to specify the output file
names.
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Notes: If you select this check box:

● And if you want to respect Macintosh file names, you must restrict
each tag in the Filename Template box, so that the longest possible
file name is 31 characters or less.

● Overwrite Existing File with Same Name is selected. If you want to
generate and keep iterations of a file, include a %version% tag in
the Filename Template box.

Filename Template

Type the file name format for the output files.

Notes: If you want to name the PPF file with values taken from JDF file,
delete the variables that appear by default in the Filename Template box
and enter the following:

● %SignatureJDFName%
● %SheetJDFName%

Press Interface Configuration File

(See Customizable tags in the PrintLink PPF file on page 747)

Tells Prinergy where the PrintLink configuration file is located.
Click Browse to locate and select the configuration file.

The PrintLink configuration file enables you to customize the
CIP3 tags and to modify default press interface settings in PPF
files.

Processed Files section of the Final Output process template
This process template section identifies the file naming parameters
during final output.

Prinergy-defined File Naming

Use Prinergy-defined File Naming

Select to use the default file naming convention for output files.

Maximum Characters from Job Name

Type the maximum number of characters for the job name part
of the file name.

Note: Share a maximum of 18 characters between the Maximum
Characters From Job Name box and the From Imposition Template
Name box.
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From Imposition Template Name

Type the maximum number of characters for the imposition
template name part of the file name.

Note: Share a maximum of 18 characters between the Maximum
Characters From Job Name box and the From Imposition Template
Name box.

Respect Mac Filenames

Select to shorten Prinergy file names to 31 characters or less,
because Macintosh file names are restricted to a length of 31
characters.

For imposition output and final output, the Prinergy file name
consists of:

● 18 characters for the job name and imposition name
(including periods)

● 13 characters for surface, version, and color extensions
(including the periods that separate each item)

For example, jobname.imposname.1A.vers.M.VPS.

When you select this check box, Prinergy shortens the first part
of the file name. You specify the maximum number of
characters for the job name in the Maximum Characters From
Job Name box. You specify the maximum number of characters
for the imposition name in the From Imposition Template
Name box.

When the Respect Mac Filenames check box is selected, spot
colors are represented in the file name by an index number.

When the Respect Mac Filenames check box is cleared, the full
spot color name is added to the output file name, with the word
PANTONE abbreviated to PMS, and the CVC or CV suffix
removed.

Overwrite Existing Files with Same Name

(See About outputting to a file on page 661)

Select if you want to use the newer files when multiple files
have the same name.

Available when Job-Relative File is selected in the Output Type
box.
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Custom File Naming

Use Custom File Naming

Select this check box if you want to specify the output file
names.

Notes: If you select this check box:

● And if you want to respect Macintosh file names, you must restrict
each tag in the Filename Template box, so that the longest possible
file name is 31 characters or less.

● Overwrite Existing File with Same Name is selected. If you want to
generate and keep iterations of a file, include a %version% tag in
the Filename Template box.

Filename Template

(See About custom file naming on page 657)

Type the file name format for the output files.

Controlfile Filename Template

If outputting to a format which requires a control (master) file,
type the file name format for the control file.

Use Full Spot Color Names

Select this check box if you want to use the spot color names in
the output file names (instead of numbers which are derived
from the spot color order).

Note: To use this check box, you must include the %color% tag in the
Filename Template.

PrintConsole Session Naming

Custom session naming

Information not yet available.

Device section of the Final Output process template
This process template section identifies device-related parameters for
the output during final output.

Output Type

Select Absolute File or Printer to enter the path for a specific
network device or file location.

Select Job-Relative File to enter a path that is relative to the
location of the job folder.
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Note: The default is Job-relative file and the Device Path box default is
%JOB%.

Typing a path for a network device in the Device Path box
automatically sets the Output Type to Absolute File or Printer.

Submit as Multiple Print Jobs

Select to submit a separate job for each surface that is output.

Available when Absolute File or Printer is selected as the
Output Type or when the Delta option in the Render section is
enabled.

Device Path

The default setting depends on the value selected as the Output
Type.

● If Output Type is Absolute File or Printer, type the name of
a Windows NT network output device using the UNC
(Universal Naming Convention) path. Or you can click
Browse to select a file location.

● If Output Type is Job-Relative File, the default is %JOB
%Proofs. The default value places the output in the Proofs
folder of the job that creates the process. You can change
the Proofs folder to any subfolder found in a job folder.

Output Blank Surfaces for Duplexing and Collating

Select when you want to output an imposition that is supposed
to have blank surfaces, that is, surfaces with no separations; so
that duplexing or collating will be correct.

Mirror Print

Select to output media with the emulsion side down.

Negative Print

Select to output a negative image.

Cut Media

Select when you want the device to automatically cut the
media.

Available when a device with a media cutting system is selected
in the Output To list.

Load Media

Select when you want the device to automatically load the
media.
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Available when a device with a media loading system is
selected in the Output To list.

Unload Media

Select when you want the device to automatically unload
media.

Available when a format for a device with a media loading
system is selected in the Output To list.

Manually

Select when you want the device to prompt the operator to load
the device manually.

Available when a format for a device with a media loading
system is selected in the Output To list.

Media Unload Mode

Select the mode for unloading media.

Available when a format for a device with a media loading
system is selected in the Output To list. See your device's
documentation for more information.

HPRTL Device

If you have a Hewlett-Packard device, select HP.

If you have the Iris 43WIDE device, select Iris/Mutoh.

HPRTL is a raster file format developed by Hewlett-Packard and
used by a number of device manufacturers.

Available when HPRTL is selected in the Output To list.

Variable Mainscan Imaging

This area applies only when the final output device is a Kodak
device with the Variable Mainscan Resolution (VRM) option.

The VRM option adjusts the pixel resolution of the output
device in the mainscan (around-the-drum) direction to align the
pixel boundaries to the frequency of the lenticular lens
boundaries.

To image with the VRM option, select the Enable Variable
Mainscan Imaging check box, and then do one of the following
actions:

● If the TIFF file is already refined at a specific VMR resolution
(for example, 2423 dpi in mainscan x 2400 dpi in subscan)
that matches the lens pitch frequency, select Image at
rendered resolution.
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The resolution is specified in the Render section of the
process template.

Note: This method only supports integers. For more precise
resolutions, select Image at and specify the desired mainscan
resolution.

● If the mainscan resolution of the file needs to be further
adjusted, select Image at and specify the desired mainscan
resolution up to three decimal places.

You can enter any resolution that is within 3.2 percent (plus
or minus) of the rendered resolution. For example, you can
image a 2400 dpi TIFF file at 2423.765 dpi in the mainscan
direction.

In all instances, the subscan (along-the-drum) resolution
remains unaffected.

File Format section of the Final Output process template
This process template section identifies the format and compression
settings of the output files during final output.

Include Images as

If printing to PDF, select Original to output the original images
in the output file.

Select Low Resolution to output low-resolution versions of the
images in the output file.

Compression

(See About outputting to a file on page 661)

The compression options that are available vary depending on
the output format selected in the Output To list at the top of
the process template. The following compression options are
available:

● None—Select if you do not want to compress files
● CCITTG3—Not available if outputting to a non-screened

format
● CCITTG4—Not available if outputting to a non-screened

format
● LZW
● RLE
● ZIP—Select if you use Kodak Staccato screening software

Note: Compression methods CCITTG3 and CCITTG4 are unavailable if
the Always use Color Combiner to Convert Spots check box is selected
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in the Render section of the process template or if any Staccato
screening system is selected in the Screen System box in the Calibration
& Screening section.

Quality

The quality control option is available only if the Output To list
is set to JPEG.

Prinergy provides five JPEG compression quality options
ranging from maximum quality (the least compression and the
smallest loss of data) to minimum quality (the most
compression and the greatest loss of data).

● Maximum
● High
● Medium
● Low
● Minimum

The lower the quality of JPEG compression, the smaller the file
size, but the greater the chance of noticeable blockiness in
certain areas of the image. You should experiment with JPEG
compression levels to see what amount of image degradation is
acceptable for your purposes.

Advanced TIFF Tags

(See About advanced TIFF tags on page 650)

Select to add advanced TIFF tags to output files.

Note: Unless you are outputting to Virtual Proofing System 2.0 or
Copydot Toolkit software, we do not recommend selecting this option
because some devices that do not recognize advanced TIFF tags may
reject the entire file.

Available when a TIFF or Virtual Proofing System format is
selected in the Output To list at the top of the process
template.

Use Custom TIFF Title Tag

Select the check box and type a custom name in the box to
create custom title tags in the TIFF file. This feature replaces
the need to manually edit the TIFF file.

Use this feature when sending Virtual Proofing System files
through Digital Blueline to merge separations from different
signatures.

Note: In the box, you can include variables such as %job% and
%signature% .
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DCS File Format

Select Single File to generate one pre-separated DCS file—that
is, one file that contains all the pre-separated colors. The file
name will be, for example: <PDF filename>.p00n.eps.

Select Multiple Files to generate a DCS file set—that is, one file
for each color separation, plus a master file for the set. The file
names will be, for example:

<PDF filename>.p00n.dcs.eps
<PDF filename>.p00n.C.eps
<PDF filename>.p00n.M.eps
<PDF filename>.p00n.Y.eps
<PDF filename>.p00n.K.eps
<PDF filename>.p00n.1.eps
Available when DCS is selected in the Output To list at the top
of the process template.

EPS Data

Select the encoding method to use for EPS data.

Available when EPS Raster is selected in the Output To list at
the top of the process template.

DCS Data

Select the encoding method to be used for DCS output.

Available when DCS is selected in the Output To list at the top
of the process template.

EPS Compression

Select the compression method to use for EPS output, or None
if you do not want to compress EPS files.

Available when EPS Raster is selected in the Output To list at
the top of the process template.

DCS Compression

Select the compression method to be used for DCS output, or
select None if you do not want to compress the DCS file.

Available when DCS is selected in the Output To list at the top
of the process template.
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Add TIFF Preview to DCS Master File

Select to add a preview file to the master file for a DCS-2
multiple file set. You can view the preview file in software such
as Preps and QuarkXPress.

Specify a resolution for the preview file in the at Resolution box.

Available in the Loose Page Output and Imposition Output
process templates when EPS vector or DCS (raster or vector) is
selected in the Output To list. Available in the Final Output
process template when DCS raster is selected in the Output To
list.

Always use custom Large TIFF format

This check box is available only when the file output type is set
to TIFF. By default, this option is disabled.

Select this check box to create a JDF file that links multiple large
TIFF files (less than 4 GB). This set of files represents a single
plate.

Document Format

Select Multi Page to generate one output file for the entire
range of selected surfaces or Single Page to generate one file
for each surface.

Available in the Loose Page Output and Imposition Output
process templates when a vector output (except DCS) is
selected in the Output To list. Available in the Final Output
process template when PS3 (PostScriptOut) is selected in the
Output To list.

Single Page is not recommended for digital printers.

Vector Output Options

Output Format

Select Composite or Separated output. The selection
determines whether or not conversion is required based on the
input file format. Select Automatic to generate files in the same
format (composite or separated) as the input files.

Note: Separated PDF/X-1a:2001 and composite DCS-2 are not
supported.

Note: Spot color handling (omission, mapping, and converting) in the
Color Separations dialog box is not supported for composite vector
output.
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Note: The Automatic option is available when vector output (except
DCS) is selected from the Output To list at the top of the process
template.

Render Shadings

Select to render PostScript 3 vector objects with Level 3 smooth
shades to produce rasterized contone objects in order to meet
the PostScript Level 2 standard. Target workflows may process
rasterized objects faster than vector ones, but there may be
some quality degradation for subtle shadings that extend over
long distances.

Specify a resolution for the rendered shadings in the at
Resolution box.

Available when DCS, PS2, PS3, or PDF is selected in the Output
To list.

Font Outlining

Select to replace all text objects with vector objects in output
pages.

This is available to DCS, PDF, and separated PostScript vector
output formats. It is useful for eliminating font formats that
certain RIPs may not be able to process. Text output in this way
cannot be edited and when previewed in Adobe Acrobat, will
look bolder than the original text due to loss of font hinting for
low-resolution monitors.

Delete Traps

Select to remove any Prinergy-generated traps from PDF,
PostScript Level 2, and DCS-2 output files.

Trapping-generated overprints remain in the files.

Simulate overprints (CMYK only)

Select to replace overprint intersections with an opaque object.

This creates a page that maintains its integrity on output, even
if a downstream publisher or printer configures their workflow
to override overprints.

Send PostScript duplexing commands

Select to print on both sides of the media. Assuming a portrait
sheet orientation, select Turn print pages side to side by
flipping on the long edge. Select Tumble to print both sides by
flipping on the short edge.

This option simply adds the duplex command to the PostScript
output. The consuming device may not support this command.
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Output Intent

Use this area to specify an ICC profile or named print condition
in the Output Intents section of the PDF/X file that you are
generating.

A named print condition is a documented printing situation with
a defined relationship between input data and the colorimetry
of the printed image. Typically, named print conditions are
registered with an organization such as the ICC.

Perform one of the following actions:

● To specify an ICC profile, select the Profile check box, and
specify the path of a profile.

● To specify a named print condition, select the Name check
box, and select a print condition from the list.

● To use the ICC profile specified in the ColorConvert section
for PDF/X generation, click the Use ColorConvert
Destination profile check box.

Note: Match Colors in Page Content in the ColorConvert section
must be selected.

This area is available only when a PDF/X format is selected in
the Output To list at the top of the process template.

Marks section in the Final Output process template
This process template section determines how marks are handled
during final output.

Sheet Marks

Identify the name and location of a PDF file containing sheet
marks (for example variable marks, logo, and signoff line). Click
Browse to locate and select a file.

Calibrate

When this check box is selected, the plate curve and print curve
are applied to the mark. The curves applied are the ones
selected in the Plate Curve list and Print Curve list in the
Calibration and Screening section of the process template.
When this check box is cleared, only the plate curve is applied.
To prevent the application of the plate curve to a mark, select %
%None%% in the Plate Curve list in the Calibration and
Screening section of the process template.

588 Chapter 12—Outputs



Locate Sheet Marks Adjacent to

(See Sheet marks options explained on page 695 and Sheet
marks on final output on page 691.)

Select Left, Right, Bottom, or Top to determine on which edge
of the paper or plate a sheet mark is placed.

The default setting is Bottom.

at Distance

(See Calculating the at distance value on final
output on page 692.)

Determines where, relative to the edge, the mark is placed:

● Sheet marks are placed relative to the plate edge. Depending
on the distance you type, you can place the sheet mark on
the press sheet or on the plate.

● Page marks are placed relative to the finished page size (the
imposition hole).

Justified

Select Left, Center, or Right to determine the justification for
the sheet mark.

The default value is Center.

Unit Used for Variable Marks

Select the unit you want to use to measure variable marks—
inch, cm (centimeter), mm (millimeter), or pts (points).

Imposition Marks Calibration

Select one of the following options to determine how imposition
marks are calibrated.
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Calibrate

The plate curve and print curve are applied to the
imposition mark. The curves applied are the ones
selected in the Plate and Print Curve list in the
Calibration and Screening section of the process
template.

Do Not Calibrate

Only the plate curve is applied.

Honor Calibration in Imposition

The plate and print curves are applied in a similar
manner, according to whether calibration for the mark
is enabled or disabled in the imposition software. To
prevent the application of the plate curve to a mark,
select %%None%% in the Plate Curve list in the
Calibration and Screening section of the process
template. This applies to Preps 5.2 and later; however,
Preps 6.0 and later is required in order to edit Prinergy
impositions.

Default Marks Font

Prinergy can populate variable marks with double-byte
characters such as those found in Japanese, Chinese, and
Korean.

Here's an example of how you could use the feature:

1. Create a Preps imposition file that includes a variable mark,
such as $[PageName].

2. In Prinergy, in the Default Marks Font box in the Marks
section of the imposition output process template, type the
exact name of the double-byte font that can be used in case
the variable mark's original font was not a double-byte font.
The font must reside either in a Prinergy-aware font folder or
in the job's font search path.

3. Submit the imposition file to Prinergy.

If the imposition file contains a page name with double-byte
fonts, Prinergy outputs the file with these characters.

Slugline

A slugline mark is a text or variable mark that you place on
loose page, imposition, or final output. Instead of using Sheet
Marks or Page Marks, you can use Slugline to quickly place a
slugline mark.
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A slugline mark does not need a PDF file, so you can easily
place a mark without creating a PDF file. However, a slugline
mark is just a line of text or a variable mark. You can only
specify the text size.

● In the Slugline mark box, type the text or variable mark.
● In the Text size box, type the font size for the mark.
● In Place on media, specify the distance from left and from

bottom.

Note: If you are using a variable mark in your slugline, the _offset and
_replace parameters, and any page-oriented variables parameters, are
not currently supported.

Creating page and sheet mark files that include variable marks
Use these best practices when creating a file that will be used as a
page mark or sheet mark with Prinergy

To create page mark or sheet mark files, use software such as Adobe
InDesign, Adobe Illustrator, or QuarkXPress that allows registration
color.

Complete these steps, in this order More information

For variable marks (such as $[color]), choose fonts
that can be fully embedded so that the entire character
set is available.

Note: OpenType fonts are always subset, so they
cannot be used for variable marks. Unfortunately,
Illustrator software does not indicate which fonts are
OpenType and which are TrueType or PostScript Type
1, making it more difficult than InDesign to avoid the
OpenType fonts. Three fonts that will fully embed with
InDesign CS4 are BeaufortPro, ChaparralPro and
MyriadPro. Although these fonts display an OpenType
icon they are in reality Type 1 fonts.

InDesign CS5 is much better than CS4 at allowing the
full embedding of fonts, with many of the standard
fonts now working.
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Complete these steps, in this order More information

Check for any auto-substitution of ligatures (letter
pairs like ff, fi, tt) in your variable marks and change
them back to an actual two-letter pair. This may occur
in the QuarkXPress or InDesign software.

If the auto-substitution of ligatures is not changed
back to an actual two-letter pair, the name of the mark
will not be correctly interpreted, and the correct
variable data will not appear in the output.

The ligature controls for InDesign can be found in the
Character panel.

To replace ligatures with separate characters, select all
of your type, and ensure that Ligatures is not selected.

Select the color of the text of your mark, based on the
separation on which you want the information to
appear.

Issues to consider:

● Registration color will place the mark on every
plate.

● For the best legibility (no registration issues), bar
code marks might best be restricted to black only.

● Variable marks that can report different information
from each separation are automatically converted
to registration color when the mark is processed,
regardless of how they are colored in the original
PDF file. These include $[color], $[angle], $
[calcurve], and so on.

From InDesign, select File > Export to export to a PDF
file. From Illustrator, select File > Save As to send to a
PDF file.

To fully embed fonts (if full embedding is permitted),
in the Export Adobe PDF dialog box, select Advanced,
and type 0 in the Subset fonts when percent of
characters used is less than box.

Printing to PostScript is not recommended because it
is less reliable for fully embedding fonts. You must also
distill it before it can be checked for a completely
embedded font.
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Complete these steps, in this order More information

Check the PDF file to ensure that the fonts are fully
embedded.

a. After creating the PDF file, view it in Acrobat, and
select File > Properties.

b. Select the Fonts tab.
c. Ensure that no fonts are listed as Embedded

Subset. All fonts must show as Embedded.

If you discover a Font subset, return to your source
software, correct the problem, and generate a new
PDF file.

Actions that may trigger subsetting include:

● Use of OpenType fonts. To fix this problem, switch
to a TrueType or PostScript Type 1 font.

● Use of system fonts (the dfont version of 
Heidelberg Helvetica displays as TrueType in the
font menu in InDesign, but will always be subset).
To fix this problem, switch to a TrueType or
PostScript Type 1 font.

● Use of special characters, such as bullets or
ligatures, that may cause Identity-H (CID)
encoding, which will cause subsetting. To fix this
problem, remove the special characters and
replace ligatures as described above.

There should be no need to refine your PDF file again
in Prinergy . After you confirm that all fonts are fully
embedded, your PDF file is ready to use as a page
mark or sheet mark.

If you are working in a PDF to PDF Preps workflow, you
can use this same procedure to create a mark that
contains variable data for use with Preps software. The
one additional step is to print PostScript out of Acrobat
from your final PDF in order to have a placeholder
PostScript file to place on your Preps template.

Generating CT/LW output for the Karat digital device
You can have the Prinergy system output a continuous tone and line
work imposition and send it to a Karat digital device. A thumbnail of
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the file appears in the Karat user interface. The Karat device manages
the color and screening.

Follow the instructions in Starting a Process and select a CTLW
Karat output process template.

Tip:

● You can select pages in the Pages view or the Signatures view. Pages can
be assigned or unassigned. An imposition plan does not need to be added
to the job.

● Pages are sent to the Karat device in the order that they are selected.
● When the selected pages are assigned to a page set, and the page set is

linked to an imposition plan, the CT/LW output includes the imposition
plan's trim and bleed lines if they are configured in the process template.

A Karat job is created and stored in the CTLW-Output subfolder of
the job folder. You can also specify a location for the job that is outside
the job folder.

CTLW Karat Output process template
The CTLW Karat Output process template outputs a CT/LW
imposition and sends it to a Karat digital press, which manages the
color and screening.

ColorFlow section of the CTLW Karat Output process template
The ColorFlow section of the CTLW Karat output process template
defines how Prinergy applies ColorFlow settings during CT/LW output
to a Karat digital device.

When you configure the ColorFlow settings in an output process
template, you select the device, device condition, and plate line, but not
a color setup. The color setup used is the one that was assigned to the
pages when they were refined—that is, either the color setup specified
in the refine process template that was used or the job's default color
setup. The color setup that is used during output processing is the
color setup specified for each page in the Color Setup column in the
Pages pane.

WARNING: Output will fail if the color setup does not match the color setup
assigned during refine, unless the Allow undefined color setup or color setup
mismatch option is enabled.

Snapshot

A ColorFlow snapshot captures the state of the entire color
database, making its elements available to the workflow and
providing a convenient backup. The snapshot feature makes it
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unnecessary for you to manually save and name multiple
versions of your color control elements after adjusting them. At
any time, you can easily roll back (revert) to the state of a
previous snapshot in the ColorFlow software. If you roll back to
a previous snapshot, ColorFlow behaves as if changes after that
snapshot never happened.

When you have completed your work in ColorFlow to a certain
level and you are satisfied with the elements in color setups,
you will mark a snapshot as approved. By default in Prinergy
Connect, the currently approved snapshot is used. Only one
snapshot can be in the approved state at any time.

Device Name

An individual occurrence of a physical device that captures or
produces an image. Devices have a type and customer-
specified properties, such as a name and location in the plant.
Because the declaration of a device does not include its
operating conditions—such as ink selection, type of screening,
and paper—you cannot measure the color response of a device
on its own.

Device Condition

A combination of a device and the operating conditions in
which the device captures or produces an image. A device
condition has a known color response. Device conditions can be
divided into groups such as print conditions (press and proofer
devices), capture conditions (scanner and camera devices), and
reference print conditions (industry specifications). A device
condition can include more than one device. If all the devices
are the same device type, they use the same consumables and
operational settings, and they can be calibrated to yield the
same color response.

Plate Line

You establish the behavior of a particular plate, screening, and
plating line by plating a tint ramp, manually measuring the
resulting dot area on the plate, and entering the values in the
Plate Setups dialog box in the ColorFlow software.

A ColorFlow plate line is associated with only one plate setup.
In your shop, you may use a platesetter and chemistry to
process several different screenings. To model this, in
ColorFlow, create similar plate lines in the other plate setups.
You can name them to match the equipment in your plant. You
may want to create several plate lines to indicate when
chemistry changes occur. For example, if you routinely change
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solutions on Mondays, you might create different ColorFlow
plate lines for Monday, Wednesday, and Friday.

ColorConvert section of the CTLW Karat Output process template
This process template section defines how Prinergy handles color
converting during CT/LW output to a Karat digital device.

Color converting transforms the color description of colored objects in
a CT/LW page to the appropriate final output color space, and then to
the appropriate color space of the Karat digital device. As a result, the
CT/LW output simulates the intended final output.

Output to

The box contains CTLW Karat ; you cannot change this
information.

JTP

Select the job ticket processor (JTP) to use for color conversion.

You set up JTPs using Prinergy Administrator.

Match Colors

Match Colors in Page Content

Enables the Color Matcher to match hues in the page content
for proofing. Select this check box to enable this feature; clear
the check box to disable this feature.

When you enable this feature, you can set the Assumed Source
or DeviceLink Profile and the Rendering Intent options.

Assumed Source or DeviceLink Profile

Select Exactly as Applied During Refining to use the same
profile that was used during the refine process. If the file was
not color converted during refining, or the profile is missing, an
error is displayed.

Select As Defined Below, if Not Set in Refining to use the same
profile that was used during the refine process, if the file was
color converted during refining. If the file was not color
converted during refining, the profile defined in the Input
Device Conditions box will be used.

Select Exactly as Defined Below to use the profile selected in
the Input Device Conditions box.
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Input Device Conditions

Available when Assumed Source or DeviceLink Profile is set to
As Defined Below, if not set in Refining or Exactly as Defined
Below.

From the list, select Browse to locate the appropriate profile file
for final output.

Rendering Intent

Select Relative Colorimetric if the proofing paper is similar to
the paper that will be used during final output.

Select Absolute Colorimetric to simulate the color of the paper
that will be used during final output.

Select PDF to use the rendering intent specified in the PDF file
when output by the creative software during final output.

Select Perceptual to use rendering that uses gamut
compression and produces less saturated colors during final
output.

Select Saturation to make sure colors are represented in a way
that preserves or emphasizes saturation during final output.

Retain CMYK Black

Preserves black in images and graphics that are defined in
CMYK or RGB color space. For ICC-based color matching
engines, CMYK images and graphics get transformed from
CMYK to L*a*b* and back to CMYK color in order to perform
color matching. In going from CMYK (four components) to
L*a*b* (three components) and back again, the black (K)
channel separation information (UCR/GCR) has in the past
been destroyed. Selecting this check box instructs the Color
Matcher to preserve the black generation information from the
source color space. As a result, the amount of black relative to
CMY in the images and graphics stays about the same. The
purpose of this feature is to help preserve the visual weight of
images and graphics.

Note: When you enable this feature, Color Matcher requires some
additional processing time because of the extra calculations involved.

Overprint Handling (CPU Intensive)

(See About overprint handling on page 257)

Select to prevent overprinting objects from generating
unintended knockouts.
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If you are converting spots to process for a proof, or if you are
color-matching one CMYK space to another CMYK space for a
proof, you probably need to apply overprint handling, even if
you applied it during refine.

To use overprint handling, you must:

1. In the ColorConvert section, select:

● The Color Matcher JTP
● The Match Colors in Page Content check box
● The Overprint Handling check box

2. Choose between raster and vector overprint handling in the
Methods list.

Note: The raster option is available only when Shades=256 is
selected in the Render section of the process template.

Method

Choose to use vector or raster overprint handling for this output
process.

Select Raster when outputting to low-resolution contone
proofers (for example, Veris digital proofer or Matchprint Inkjet
proofer).

Note: To use raster overprint handling, you must select, in the Render
section of the process template, Shades=256.

Additional factors to consider:

● Raster overprint handling can be applied only to continuous
tone data

● Raster overprint handling occurs after the RIP
● Raster processing time increases exponentially as the

resolution increases
● Raster overprint handling eliminates all overprints

Select Vector when outputting to halftone (screen) proofers
(for example, the Spectrum device), or to high-resolution
contone proofers.

Additional factors to consider:

● Vector overprint handling occurs before the RIP
● Depending on the complexity of the file, vector overprint

handling could take longer than raster overprint handling.
● Vector overprint handling does not eliminate all overprints.

In objects where overprinting does not have an effect on the
output, the objects retain an overprint status. For example, if
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you set black to overprint, but one black object is not placed
on top of another object, this black object is, after overprint
handling, still an overprinting object.

Process CEPS Data

Select this check box to enable spot color mapping and color
matching of CEPS data.

For further information, see the CEPS Conversion Section and
the Normalize Section of the Refine Process Template.

Process Marks

Select this check box when you want to apply color
management to your marks file. Depending on the type of mark,
it may be necessary to enable Overprint Handling to
appropriately convert the mark and apply the necessary color
transformation.

Note: When Process Marks is checked, both sheet marks and page
marks are color managed.

Color match 1-bit images

Select this check box to color match 1-bit images. One-bit
images are images that represent two tones, typically black and
white. The pixel is either a 0 or a 1 value. Examples are copydot
images.

Note: This feature will convert 1-bit images to 8-bit images. This causes
pages to become larger and to render more slowly. Turn off this feature if
you do not require color matching of 1-bit images, or if the feature causes
unacceptable performance degradation. (For example, copydot files take
a very long time to refine and render.)

This feature is available when Match Colors in Page Content is
selected.

Device Condition

Enables the ICC profile, which characterizes the way the Karat
device prints.

Select a path to the ICC profile, or select Browse to locate the
profile.

Source of Color Recipes

Extract Recipe from the File

Select to use the color recipes embedded in the file.
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Lookup Recipe in Color Database

Select to use the color libraries selected in this process
template.

Color Libraries

From the Selectable list, select the color libraries you want
Prinergy to search for color recipes, and click Add.

Arrange the color libraries in the Selected list in the order that
you want Prinergy to search. Use the Move Up and Move Down
buttons.

Note: Ensure that you select color libraries with color spaces that are
compatible with the Proof Process Profile.

Use Recipe from File if not found in Color Database

Select this check box to use color recipes embedded in the file if
Prinergy does not find the colors in the selected color libraries.

Layout section of the CTLW Karat Output process template
This process template section defines how Prinergy places the pages
on the output media during CT/LW output to a Karat digital press.

Media

Media Configuration

This area is unavailable. The settings for the Karat device
determine the type of paper to be used.

Size

Determines the size of the media to which you will output the
final files.

Select Digital to generate an output file, for example, a file for
Virtual Proofing System software. When you select Digital, the
Min Width, Min Height, Max Width, Max Height, and Layout is
90° Different Than Media boxes are unavailable.

Select Cut sheet, Roll fed, or Roll fed (transverse), depending
on the media being used.

Min Width

Sets the minimum width for the specified media in the unit of
measure selected in the list.
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Min Height

Sets the minimum height for the specified media in the unit of
measure selected in the list.

For cut sheet, enter the sheet height. For roll fed, enter the
height of the smallest proof you want to make on the device.

Max Width

Sets the maximum width for the specified media in the unit of
measure selected in the list.

Max Height

Sets the maximum height for the specified media in the unit of
measure selected in the list.

Duplexing

This option is available for composite files; it is unavailable for
separated files.

Specifies the type of duplexing.

From the Duplexing box, select Turn or Tumble to enable this
feature. Select None to disable duplexing.

Front Shift and Back Shift

The Front Shift Along Width...Along Height and Back Shift
Along Width...Along Height options give finer adjustment
when aligning two-sided proofs than with Center Along Width/
Height. Use these measurements to shift and align front and
back pages along their turn or tumble axes, depending on the
page or imposition orientation (portrait or landscape).

These options are available only when Duplexing has been set
to Turn or Tumble.

You can specify the shift in points, inches, centimeters, or
millimeters.

Layout is 90° Different Than Media

Available when you select Cut Sheet or Roll Fed from the
Sizebox. This option is unavailable when you select Digital from
the Size box or when you select the Reduce to Fit Media check
box.

Select this check box when the orientation of data is at a 90°
angle to the orientation of the media (for example, you are
trying to output a landscape layout to a portrait device). You
must also select either Auto clockwise or Auto
counterclockwise in the Orientation box.
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Note: This option is not available when you select Veris/Matchprint
Inkjet in the Output To list at the top of the pane.

Center and crop page to media size

Select this check box when the sheet size of the device is
smaller than the media box of the PDF page.

PDF Box to Use

Select the Trim Box or the Media Box to use as the area of
output content.

For example, selecting the trim box produces trimmed output,
that is, output without bleeds or registration marks.

Placement

Type

Select the type of placement.

When you select Top Left to Bottom Right placement the N-up
option button is selected and the Number of Pages Across
option becomes available.

When you select Page Set Booklet, the 2x1 option button is
selected and the Vertical Gutter Width option becomes
available

Style

Determines how many pages Prinergy places on each sheet.

● Select Auto Fit to let the system determine the best layout,
depending on the files submitted.

● Select 2x1 to specify two pages across and one page down.
● Select 1x2 to specify one page across and two pages down.
● Select N-up to specify the number of pages across and

down.

Number of Pages Across

Available when N-up is selected in the Style box.

Determines the number of pages to place horizontally on each
sheet.

Down

Available when N-up is selected in the Style box.
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Determines the number of pages to place vertically on each
sheet.

Vertical Gutter Width

Available when Auto Fit is selected in the Style box or N-up is
selected in the Style box and the Number of Pages Across box
contains a value greater than 1.

Determines the minimum space allowed, in the selected unit of
measure, for vertical gutters when automatically fitting pages
on a sheet. This value may be reduced if the Reduce Gutters if
Required check box is selected.

Horizontal Gutter Height

Available when Auto Fit is selected in the Style box, or N-up is
selected in the Style box and the Down box contains a value
greater than 1.

Determines the minimum space allowed, in the selected unit of
measure, for horizontal gutters when automatically fitting pages
on a sheet. This value may be reduced if the Reduce Gutters if
Required check box is selected (see below).

Orientation

(See Example: orientation on page 653)

Rotates an entire imposition as a unit.

Select Auto clockwise to automatically rotate an image
clockwise when rotating would result in a better fit.

Select Auto counterclockwise to automatically rotate an image
counter-clockwise when rotating would result in a better fit.

Flat Rotation

Makes a small angle rotation of the flat or output image. Also
called plate cocking. Derive the (0.0) percentage value, or
gradient, in one of two ways:

● Physically measure the first occurrence of a rotation to find
the gradient that you can then apply for all jobs that use that
rotation

● Convert a given angle into its gradient

To measure for a gradient:
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● Formula: gradient = rise/run x 100 where:
● Rise: (y-axis) measure the distance between where the flat's

rotating corner started and where it must be moved as a
straight line that meets the x-axis at a 90° angle. Example: 2
units

● Run: (x-axis) measure the distance along the x-axis from the
non-rotated corner of the flat to the point where the vertical
line transects the x-axis at a right angle. Example: 90 units

● Calculation: 2/90 x 100 = 2.2
● The maximum percentage value is 3.1.

To convert an angle to a gradient:

● Formula: gradient = tangent of the angle of rotation x 100
● Calculation using a scientific calculator and an angle of 0.5°:
● 0.5° + Tan(gent) key = 0.008 x 100 = 0.8
● The maximum angle of rotation is 1.78°.

Note: To convert a gradient to an angle, enter the gradient into the
calculator and apply the inverse tangent function. Example: 2.2% is
entered as 0.022 + Inv(erse) key + Tan key = 1.26°.

● Indicate whether the rotation is to be clockwise or
counterclockwise.

Note: The process template does not let you select flat rotation and
web growth at the same time. However, when web growth is applied,
flat rotation can be specified in the web growth profile.

Scaling

Scale Vector

Applies scaling to the layout prior to screening the file. The
scaling is based on vector data (PDF data).

Scale Raster

Applies raster scaling to the layout. Raster scaling is an optional
feature that will allow you to apply distortion after the files are
screened.

Raster scaling is recommended for prescreened files (copydot)
or files that contain 1-bit TIFF images, since the prescreened
bitmap data cannot be properly scaled with vector scaling
(could generate artifacts).

Clear this check box to disable this feature.
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Spacing

Add Extra Horizontal Space

(See Example: add extra horizontal space on page 654)

Determines where unused horizontal space should be
positioned.

● Select Right margin only to position unused space at the
right margin, allowing for excess to be easily cut off.

● Select Evenly to both margins to divide unused space evenly
between the right and left margins.

● Select Evenly to all gutters and margins to divide unused
space evenly between the vertical gutters and right and left
margins.

Add Extra Vertical Space

(See Example: add extra vertical space on page 653)

Determines where unused vertical space should be positioned.

● Select Bottom margin only to position unused space at the
bottom margin, allowing for excess to be easily cut off.

● Select Evenly to both margins to divide unused space evenly
between the top and bottom margins.

● Select Evenly to all gutters and margins to divide unused
space evenly between the horizontal gutters and top and
bottom margins.

Reduce Gutters if Required

Allows gutter values (set in the Horizontal Gutter Height and
Vertical Gutter Width boxes in the Placement section) to be
reduced if required to fit pages. If selected, gutters will be
reduced only to the values set in the Min Horizontal Gutter
Height and Min Vertical Gutter Width boxes.

Min Vertical Gutter Width

Available if the Reduce Gutters if Required check box is
selected, N-up is selected in the Style box, and the Down box
contains a value greater than 1.

Vertical gutters are not reduced below this value.

Min Horizontal Gutter Height

Available if the Reduce Gutters if Required check box is
selected, N-up is selected in the Style box, and the Number of
Pages Across box contains a value greater than 1.
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Horizontal gutters are not reduced below this value.

Render section of the CTLW Karat output process template
The Render section of the CTLW Karat output process template
determines the output resolution and how Prinergy handles spot colors
during CT/LW output to a Karat digital press.

JTP

Select the CTLW Output job ticket processor (JTP) to use for
rendering.

Note: You set up JTPs in Prinergy Administrator.

Device Resolutions

This list is available when an output device format is selected in
the Output To list.

Select a resolution for the selected device in the list.

Resolution X

Select 2400 dpi or 2540 dpi.

Resolution Y

Select 2400 dpi or 2540 dpi.

Color Model

Select the process color model to use for output.

The list of values varies, depending on the output format
selected in the Output To list.

Shades

To set the number of shades of gray to output, select 1 for
screened data or 256 for continuous tone data. When 1 is
selected, the Calibration & Screening section of the refine
process template is available for input.

The list of values varies, depending on the output format
selected in the Output To list and the color model selected in
the Color Model list.

Do Separations

Available when the output format selected in the Output To list
supports separated output and DeviceCMYK is selected in the
Color Model options.

Select if you want Prinergy to output separations. Clear this
check box if you want Prinergy to output a single composite file.

606 Chapter 12—Outputs



Spot Color Handling

The options in this list determine how to handle spot colors on
loose page output.

The list of values varies, depending on the output format
selected in the Output To list.

● Select Convert to process to convert spot colors to process
colors.

Note: When Convert to process is selected, Vector Overprint
Handling (in the ColorConvert section) is automatically turned on to
ensure the correct appearance of any overprinting spot colors.

● Select Output separately to preserve spot colors on output.
● Select Don't output to suppress output of spot colors.

Always Use Color Combiner to Convert Spots

This check box is available when Output Separations Handling
is set to Convert separations to process.

If the input files contain overprinted spot colors, the Color
Combiner, which is a plug-in to the renderer, will combine the
layers and output the overprinted colors correctly.

When this check box is cleared, the renderer handles the
conversion of spot colors to process colors if the following
conditions exist:

● Input files are composite.
● All spot colors are set to opaque in the color database. (If a

spot color is not in the color database, opaque is assumed.)

If the above conditions are not met, the Color Combiner will be
used, even if the Always Use Color Combiner to Convert Spots
check box is cleared.

We recommend that you always select this check box.

See About Color Combiner on page 805.

Dielines Overprint Other Content

This check box is cleared and unavailable if the Do Separations
check box is cleared and unavailable.

Select this check box to specify whether die lines overprint
other content. Clear this check box if you do not want die lines
to overprint other content.
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The Dielines Overprint Other Content check box is available for
the following outputs:

● DCS Raster
● Kodak Approval TIFF
● LQS TIFF
● VPS
● Windows Bitmap

Anti-Aliasing

Select this check box to enable anti-aliasing, and then in the at
Ratio list, specify a ratio for anti-aliasing.

Anti-aliasing is a technique of improving the appearance of
output by minimizing the "stair step" effect on rasterized
output. It does so by rendering to a higher resolution than the
intended output, and then downsampling to the intended
output. This generates "averaged" pixels which softens the
"stair step" effect on low-resolution output. The ratio value for
anti-aliasing refers to the factor used to determine the
intermediate resolution. A higher ratio results in higher quality,
but can have an effect on output speed. For example, if the
output is a 300 DPI 8-bit TIFF, and the anti-alias ratio is 4,
Prinergy will render an intermediate output at 1200 DPI (4 x
300 DPI), and then downsample to the user-requested 300
DPI. Anti-aliasing is only available for 8-bit (256 shade) output.

Fail if font problems detected

Select this check box to fail the output process if a file has
missing fonts.

Note: This feature is not available for vector outputs (PDF, PS2, PS3, EPS,
DCS Vector, PDF/X-1a, PDF/X-3, CT/LW, and DELTA).

Ignore Embedded Fonts in Marks Files

Select this check box if you want Prinergy to ignore embedded
fonts in a marks file and to look for the fonts in the system
fonts folder.

Important: You must install the fonts in %ServerName%\%AraxiHome
%\AdobeExtreme\bin\fonts, or the output will fail.

Convert Text to Paths

This check box converts fonts to outlines before a file is RIPed.

This option was added in Prinergy 3.0 when the CPSI 3016 RIP
was included with Prinergy. This option helped situations where
the 3016 RIP failed to process the fonts on certain jobs.
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This option has limited usefulness now, but is included as a
potential workaround in rare cases where fonts are not
rendered correctly by the RIP. It is not recommended that you
enable this on on a permanent basis. When using this option for
specific jobs, it is recommended that you ensure that both
proofs and plates are output with this option.

Note that when you select the Convert Text to Paths check box,
you will have text appear fatter on low-resolution proof output.
You can overcome this appearance problem by either:

● Rendering to a higher resolution, if rendering to 1-bit output,
such as Virtual Proofing System

● Using anti-aliasing, if rendering to contone output

Note: This check box is only available for raster output formats
(.VPS, .TIFF, and so on).

Overlay Versioned Content

This check box applies to Layered PDF Versioning. For
information, see the Prinergy Layered PDF Versioning User Guide.

Versioning Proof Mapping Color

This box applies to Layered PDF Versioning. For information,
see the Prinergy Layered PDF Versioning User Guide.

Kodak Approval

Densities

Type an integer between -22 and +22.

For more information, see your Approval documentation.

CT/LW

CT Resolution

Type a resolution value in dots per inch (dpi) for the continuous
tone (CW) files created during refine.

Note: 304.8 dpi = 12 dpm

LW Resolution

Type a resolution value in dots per inch (dpi) for the line work
(LW) files created during refine.

Note: 2032.0 dpi = 80 dpm
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Border Handling

Select the resolution at which the borders of overlapping
images should be rendered:

● Borders to CT: Render borders at the resolution specified in
the CT Resolution box. If two images overlap, the transition
from one continuous tone (CT) image to the next may
appear jagged.

● Borders to LW: Render borders at the resolution specified in
the LW Resolution box. This improves the resolution of the
overlap area but increases processing time and size of the
output file.

● Borders to Smart Edge: Improves the appearance of CT-to-
CT borders and ensures that the number of line work (LW)
colors is not increased.

Output Kind

Select the format to which you want to output. You can output:

● CT/LW Job Only
● TIFF/IT Job Only
● CT/LW and TIFF/IT Jobs
● CTAndLW
● AllToCT

.

Force Vignette to CT

Select to convert gradations to the continuous tone (CT) layer
and to convert gradations created as PostScript Level 2 to
PostScript 3 (to obtain high-quality gradations when converted
to CT data).

Converting to CT results in less banding and better quality
images than converting to line work (LW). Converting to CT
also adds noise to the resulting CT layers, creating a smoother
image.

Note: If you clear this check box, some vignettes are still converted to CT
data—for example, PostScript Level 2 gradations.

Force LW Vignette to CT

Select to convert the vignettes (gradations and blends) that
AVR (Automatic Vignette Recognition) identifies to the
continuous tone (CT) layer.

AVR recognizes a vignette as an image with a color difference
©, M, Y, or K) of 6% or less.
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An output file in which blends are converted to CT is smaller
than an output file in which blends are converted to line work
(LW).

Screen Grabs

Select the resolution at which you want screen captures to be
rendered:

● Grabs to CT: Renders screen captures at the resolution
specified in the CT Resolution box.

● Grabs to LW: Renders screen captures at the resolution
specified in the LW Resolution box.

CT Type

Select the CT (continuous tone) type that you want to output:

● NativeCT: Renders CT to the Kodak native (Whisper) CT
format. This format supports up to four separations CMYK
and up to 256 shades per separation.

Note: A Native CT file is given a .ct extension.

● HandshakeCT: Renders CT to the Kodak CT Handshake
format. This format supports up to four separations CMYK
and up to 256 shades per separation.

Note: A Handshake CT file is given a .ch extension.

● NewCT: Renders CT to the Kodak extended CT format that
supports spot colors, up to 32 separations, and up to 256
shades per separation.

Note: A New CT file is given an .nct extension.

LW Type

Select the LW (line work) type that you want to output:

● NativeLW: Renders LW to the Kodak native (Whisper) LW
format. This format supports up to four separations CMYK
and up to 248 colors.

Note: A Native LW file is given an .lw extension.

● HandshakeLW: Renders LW to the Handshake LW format.
This format supports up to four separations CMYK and up to
248 colors.

Note: A Handshake LW file is given an .lh extension.
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● NewLW: Renders LW to the Kodak extended LW format.
This format supports up to 32 separations CMYK and up to
64,000 colors.

Note: A New LW file is given an .nlw extension.

Make CT same size as Linework file

Select to insert 1-pixel DeviceCMYK CT images in the upper-
left and lower-right corners of the media box on PDF pages. The
resulting CT layer:

● Is the same size as the LW layer
● Has all DeviceCMYK process colorants

This check box is available only when:

● Output To at the top of the process template is set to CT/
LW (CTLWOutput).

● Output Kind in the CT/LW area of the Render section is set
to TIFF/IT Job Only or CT/LW and TIFF/IT Jobs.

TIFF/IT Suffix

TIFF/IT FP

When outputting to TIFF/IT, specify the file name ending for
the final page (FP) file. Type the file name suffix, which can
include characters before the extension—for example,
_FP.tif.

TIFF/IT CT

When outputting to TIFF/IT, specify the file name ending for
the continuous tone (CT) file. Type the file name suffix, which
can include characters before the extension—for example,
_CT.tif.

TIFF/IT LW

When outputting to TIFF/IT, specify the file name ending for
the line work (LW) file. Type the file name suffix, which can
include characters before the extension—for example,
_LW.tif.

TIFF/IT HC

When outputting to TIFF/IT, specify the file name ending for
the high-resolution contone (HC) file. Type the file name suffix,
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which can include characters before the extension—for
example, _HC.tif.

Note: High-resolution contone (HC) files are line work files with more
than 256 colors.

Device section of the CTLW Karat Output process template
This process template section identifies device-related parameters for
the CT/LW output to a Karat digital press.

Output Type

Select Absolute File or Printer.

Submit as Multiple Print Jobs

Select to submit a separate job for each surface that is output.

Available when Absolute File or Printer is selected as the
Output Type or when the Delta option in the Render section is
enabled.

Device Path

Type the name of the Karat digital press using the UNC
(Universal Naming Convention) path. Or you can click Browse
to select the location.

You can also include the following marks in the Device Path
box:

● $[jobname;n]
● $[ProcessPlanName;n]

Note: Replace the n in the marks name with a number between one and
99 to specify how many characters from the associated mark to include
in the mark.

For example, %JOB%Proofs\$[jobname;6] for
MyJobName becomes %JOB%Proofs\MyJobN.

Mirror Print

Select to output media with the emulsion side down.

Negative Print

Select to output a negative image.

Cut Media

Select when you want the device to automatically cut the
media.
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Available when a device with a media cutting system is selected
in the Output To list.

Load Media

Select when you want the device to automatically load the
media.

Available when a device with a media loading system is
selected in the Output To list.

Unload Media

Select when you want the device to automatically unload
media.

Available when a format for a device with a media loading
system is selected in the Output To list.

Manually

Select when you want the device to prompt the operator to load
the device manually.

Available when a format for a device with a media loading
system is selected in the Output To list.

Media Unload Mode

Select the mode for unloading media.

Available when a format for a device with a media loading
system is selected in the Output To list. See your device's
documentation for more information.

Marks section in the CTLW Karat Output process template
This process template section determines how marks are handled
during CT/LW output to a Karat digital press.

Extra Margin for Marks and Bleed

When calculating the position of pages, additional space is
included for marks and the bleed, if indicated.

Provide margin values for Left, Right, Top, and Bottom margins,
in the selected unit of measure.

Bleed for Unassigned Pages

Prints a bleed line when proofing PDF pages that have not yet
been assigned to a position of an imposition plan. When
assigned pages are proofed, the bleed lines are taken from the
imposition plan.
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Provide values for Left, Right, Top, and Bottom in the selected
unit of measure.

Crop Distance Beyond Bleed for Pages

Creates an additional margin beyond the bleed marks to allow
output of the software information that is positioned outside
the bleed.

Provide values for Left, Right, Top, and Bottom, in the selected
unit of measure.

This value, and any value that extends the crop beyond the page
size, allows the entire page image to be output (up to the page
size defined by other layout measurements).

A negative value moves the crop inside the bleed by the
specified amount.

If the pages are assigned to page positions linked to an
imposition plan, this value is added to the bounding box defined
on the imposition plan. If the assigned page positions are linked
to multiple imposition plans, the largest bounding box is
calculated and this value is added to the calculated
measurement.

Default Marks Font

Here's an example of how you could use the feature:

1. Create a Preps imposition file that includes a variable mark,
such as $[PageName].

2. In Prinergy, in the Default Marks Font box in the Marks
section of the imposition output process template, type the
exact name of the double-byte font that can be used in case
the variable mark's original font was not a double-byte font.
The font must reside either in a Prinergy-aware font folder or
in the job's font search path.

3. Submit the imposition file to Prinergy.

If the imposition file contains a page name with double-byte
fonts, Prinergy outputs the file with these characters.

Sheet Marks

Identify the name and location of a PDF file containing sheet
marks (for example variable marks, logo, and signoff line). Click
Browse to locate and select a file.

Calibrate

When this check box is selected, the plate curve and print curve
are applied to the mark. The curves applied are the ones
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selected in the Plate Curve list and Print Curve list in the
Calibration and Screening section of the process template.
When this check box is cleared, only the plate curve is applied.
To prevent the application of the plate curve to a mark, select %
%None%% in the Plate Curve list in the Calibration and
Screening section of the process template.

Locate Sheet Marks Adjacent to

(See Sheet marks options explained on page 695 and Sheet
marks on final output on page 691.)

Select Left, Right, Bottom, or Top to determine on which edge
of the paper or plate a sheet mark is placed.

The default setting is Bottom.

at Distance

(See Calculating the at distance value on final
output on page 692.)

Determines where, relative to the edge, the mark is placed:

● Sheet marks are placed relative to the plate edge. Depending
on the distance you type, you can place the sheet mark on
the press sheet or on the plate.

● Page marks are placed relative to the finished page size (the
imposition hole).

Justified

Select Left, Center, or Right to determine the justification for
the sheet mark.

The default value is Center.

Page Marks

Identify the name and location of a PDF file containing page
marks. Click Browse to locate and select a file.
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You may need to provide space for page marks by increasing
gutter measurements.

The variable mark $[PagePositionNumber] or $[PPN] can be
used to verify that the pages are in the correct page set
positions in the imposition.

Calibrate

When this check box is selected, the plate curve and print curve
are applied to the mark. The curves applied are the ones
selected in the Plate Curve list and Print Curve list in the
Calibration and Screening section of the process template.
When this check box is cleared, only the plate curve is applied.
To prevent the application of the plate curve to a mark, select %
%None%% in the Plate Curve list in the Calibration and
Screening section of the process template.

Locate Page Marks Adjacent to

Select where to place the page marks in relation to the page's
trim box.

When you select Right or Left, the page marks rotate as
follows:

● Left—rotates the mark 90° counterclockwise
● Right—rotates the mark 90° clockwise
● Bottom—no rotation
● Top—no rotation

at Distance

(See Calculating the at distance value on final
output on page 692.)

Determines where, relative to the edge, the mark is placed:

● Sheet marks are placed relative to the plate edge. Depending
on the distance you type, you can place the sheet mark on
the press sheet or on the plate.

● Page marks are placed relative to the finished page size (the
imposition hole).
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Draw Trim and Bleed Marks

Determines where, in relation to each page, trim and bleed
marks should be placed. Trim and bleed marks are created in
registration color and are 0.25 points in weight. Bleed marks are
solid lines; trim marks are dashed lines. Trim marks are drawn
according to the option selected:

None

Trim and bleed marks are not drawn.

On Content

Trim and bleed marks are drawn on the content
(complete trim marks are drawn on the proof).

Outside Content

Trim and bleed marks do not extend to the content
(only the four corners appear on the proof).

Note: In order to print bleed lines on loose page output, the page must be
assigned to a page set that is linked to an imposition plan. The bleed lines
are taken from the imposition plan.

Safe Protect Box

The safe protect box enables you to print proofing lines within
the trim box (or media box) on a proof to check that the page
content is within the page margins. The safe protect box is
drawn on the proof inside the trim or media box.

This feature is available in the loose page output and imposition
output process templates when the Draw Trim and Bleed
Marks option is set to On Content or Outside Content.

Note: If you select Output To Virtual Proof, you can select the Safe
Protect Box check box even if you select None for Draw Trim and Bleed
Marks. In this case, you can view the safe protect box in the Virtual
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Proofing System software. The safe protect box is not printed on the
proof.

Select the Safe Protect Box check box and in each of the Left,
Right, Top, and Bottom boxes, type the distance from the trim
or media box that you want the safe protect lines to appear.
You can type different numbers in each of the four sides.

When calculating where to place the safe protect lines, note
that Prinergy measures from various starting points as shown in
the following table.

Proof Safe protect box is measured from this location

Imposition The imposition hole trim box

Loose page ● The PDF page trim box—if the PDF page
includes trim

● The PDF page media box—if the PDF page does
not include trim

If a PDF page includes trim, it appears in the Trim
Size column in the Pages pane of the Pages view.

Note: If the PDF page does not include trim, you
can define it using the Prinergy Geometry Editor
plug-in for Adobe Acrobat. After the trim is
defined, refine the page again.

The lines of the safe protect box are drawn according to the
option selected for trim and bleed marks:

● If you selected Outside Content, only the four corners of the
safe protect box appear on the proof.

● If you selected On Content, the complete box is drawn on
the proof.

Note: If you entered information for Trim Adjustment, the Safe Protect
Box dimensions are calculated based on the Trim Adjustment
dimensions.

Trim Adjustment

If you are using pages that have no trim or an incorrect trim box,
in the Trim Adjustment area, type the distance from the edge of
the page that you want trim lines to appear in each of the Left,
Right, Top, and Bottom boxes.

You can type different numbers in each of the four sides.

Trim Adjustment is available only when you select Draw Trim
and Bleed Marks, and On Content or Outside Content.

Note: If you enter information for Trim Adjustment, the Safe Protect Box
dimensions are calculated based on the Trim Adjustment dimensions.
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Locate Crop Mark of Length

Available if On Content or Outside Content is selected in the
Draw Trim and Bleed Marks box.

Determines the length of the crop marks to be drawn, in the
selected unit of measure.

The at Distance box determines how far away from content to
draw the crop mark.

at Distance

Available when On Content or Outside Content is selected in
the Draw Trim and Bleed Marks box.

Determines how far away from content to draw the crop mark.

Unit Used for Variable Marks

Select the unit you want to use to measure variable marks—
inch, cm (centimeter), mm (millimeter), or pts (points).

Slugline

A slugline mark is a text or variable mark that you place on
loose page, imposition, or final output. Instead of using Sheet
Marks or Page Marks, you can use Slugline to quickly place a
slugline mark.

A slugline mark does not need a PDF file, so you can easily
place a mark without creating a PDF file. However, a slugline
mark is just a line of text or a variable mark. You can only
specify the text size.

● In the Slugline mark box, type the text or variable mark.
● In the Text size box, type the font size for the mark.
● In Place on media, specify the distance from left and from

bottom.

Note: If you are using a variable mark in your slugline, the _offset and
_replace parameters, and any page-oriented variables parameters, are
not currently supported.

Proofs and final output

About supported output formats

This topic describes the output formats that Prinergy supports and
divides them into raster and vector output formats. The output format
is selected at the top of each output process template.
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The following qualities are also specified in the format descriptions:

● Composite or separated (specified for all output formats)

○ Composite—All separations are together in one page in one file.

Note: Not all composite formats support spot colors. Some composite
formats support CMYK process colors only.

○ Separated— All separations are in separate channels or files.

● Continuous or screened (specified for raster output only)

○ Contone (continuous tone (CT))— 8 bits per channel, 256
shades

○ Screened (halftone)— 1 bit per channel, prescreened, 1 shade

The following information pertains to output formats selected in the
Output To list on output process templates.

If you want to move a Prinergy job from one Prinergy system to
another, see About exporting jobs on page 863 or see About moving
jobs on page 112.

Option Description Recommended Use

Raster Output: Output files are bitmaps that represent an image as a matrix of dots. The output is similar to
what one might get from a scanner. Raster output is the result of sending vector data such as text or paths
through a RIP.

DCS Raster Creates screened or continuous
tone, separated output only.

Contains already-RIPed, screened
bitmap data that can be used with
any raster-based proofer. In
contrast, DCS vector output contains
data that is not RIPed or screened,
but is intended to be further
processed in another workflow or
RIP.

Output of spot colors is supported.

Screened: Use when you need a prescreened
DCS (copydot-like file. This is when you want
to preprocess a file to speed final output, or
when you want to lock down the screening.

Contone: Use when you want the final RIP to
perform the screening, and the final RIP
requires rasterized input. Using this method,
text edges will appear fuzzy.

Epson 5000 and Epson
9000

Creates 1-bit screened output.

Spot colors are converted to process.

Epson 5000 and Epson 9000 printers
respectively.

EPS Raster Creates screened or continuous
tone, composite output only.

This produces one composite bitmap
file. Spot colors are converted to
process colors (CMYK recipes).

Output is supported on four-color
process devices.

Third-party proofing devices that support
raster output— for example, Hewlett Packard
laser printers.
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Option Description Recommended Use

HPRTL Creates screened or continuous
tone, composite output only.

This produces one composite bitmap
file per separation. Spot colors are
converted to process colors (CMYK
recipes).

Output supported on four-color
process devices.

HP DesignJet plotters.

JPEG Creates continuous tone, composite,
RGB output only.

This produces one composite bitmap
file. Spot colors are converted to
process colors (CMYK recipes).

In some circumstances, useful for Web
proofing.

Kodak Approval EPS Creates 1-bit screened output.

Spot colors are converted to process
colors (CMYK recipes).

Kodak Approval printers when connected via
AIT or Global Graphics Harlequin.

Kodak Approval TIFF Creates 1-bit separated output
suitable for sending to Approval
printers.

Kodak Approval printers when connected via
AIT or Harlequin.

Kodak Proofers (KPS
direct connect)

Creates continuous tone, composite
output. Spot colors are converted to
process colors (CMYK recipes).

Prints directly to the Veris,
Matchprint Inkjet, or Kodak
Approval proofer

Kodak Veris digital proofer, Matchprint Inkjet
proofer, and Kodak Approval proofer when
connected via Kodak Proofing Software (KPS).

LQS TIFF Creates screened or continuous
tone, separated output only.

This produces one bitmap file. Spot
colors are supported.

Kodak Lotem Spectrum platesetter.
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Option Description Recommended Use

PDF Raster Creates screened or continuous
tone, composite output only.

This produces one composite bitmap
file.

Spot colors can be converted either
by Prinergy or by the digital printer.

Any digital printer that accepts PDF files.

If the digital printer is used for final output,
choose continuous tone output and configure
the digital printer to convert spot colors to
process.

If the digital printer is used for proofing a press
job, choose screened output and convert spot
colors to process in Prinergy.

Other uses of PDF raster:

● Providing remote sites with a soft proof
PDF that accurately represents Prinergy's
interpretation of the original vector file.

● Creating an instant copydot version of any
page.

Sites receiving a PDF raster file should
configure Acrobat or their RIP to respect
overprints.

Scitex CT (contone) Creates continuous tone, composite
output only.

This produces one continuous tone
(CT). Spot colors are converted to
process colors (CMYK recipes).

Use for output to devices that require Scitex
CT files.

TIFF Creates screened or continuous
tone, separated or composite output.

If separated output, spot colors are
retained and output.

If composite output, spot colors are
converted to process colors (CMYK
recipes).

Screened separated output

Lotem 400 platesetters.

Kodak Dolev 800 V imagesetters.

Spectrum proofing devices: Lotem Quantum
and Trendsetter devices.

Composite continuous tone output

Matchprint Inkjet proofer.

Other third-party proofing devices.

Virtual Proof Creates screened separated output.
Spot colors are retained.

Produces a Virtual Proofing System
bitmap file. Creates one bitmap file
per separation.

Virtual Proofing System software.

Windows Bitmap Creates screened or continuous
tone, separated output.

Spot colors are not supported.

Can be useful in some circumstances requiring
BMP output.

Vector output: Output is not screened or RIPed. Output files are often smaller and image faster than raster
format files. Text and paths are retained in vector form.
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Option Description Recommended Use

DCS (Vector output) Creates separated output.

Spot colors are retained. The output
DCS files can contain low-resolution
previews and OPI information. The
purpose is to produce reliable
PostScript for downstream
imposition, page layout, and RIPing,
outside of the Prinergy system.
Downstream systems include Preps, 
Kodak Allegro, Taipan, and
imagesetter systems.

Use when you want to place the page within
other software such as in a QuarkXPress
document or Preps imposition.

Note: This format will not work if you want to
send directly to an imagesetting device that
does not have software.

EPS (Vector output) Creates high-quality PostScript 3-
compatible EPS files.

Use when you need to place a file into desktop
software, such as QuarkXPress. Final results of
placing an EPS are often superior to placing a
PDF in the desktop software.

PDF (Vector output) If the input file is a composite PDF,
the output can be either composite
or separated.

If the input file is a separated PDF,
the output can only be separated.

If launched from Signatures or
Separations view, creates an
imposed PDF flat. If launched from
Pages view (pages pane, Pageset
pane), creates single-page or multi-
page PDFs, depending on Process
Template settings.

Use when you want to send the page or
imposition file to a RIP or software application
that can consume or work with PDF files, or to
create a PDF soft proof.

You can also omit and map separations for
composite input files when outputting vector
PDF (separated or composite). If using Legacy
Versioning (2 pages in 1 page set position),
vector PDF output will give you a single PDF
with the layered PDF on top of the other.
Various proofing-related functions, such as
adding page marks, trim lines, and creating a
signature booklet, can also be accomplished
with vector PDF.

PDF/X-1a:2001
(Vector output)

Creates composite output only.

Spot colors are retained.

Creates a flat or single-page PDF file.

Use when you want to send the file to a RIP or
software that can consume or work with PDF
files, or to create a PDF soft proof.

Also useful when exchanging advertisement
files or page files.

PS2 (Vector output) Creates a separated PostScript file
using PostScript Level 2.

Use when you want to send the page directly
to an imagesetting device, to impose in Preps,
or to output flats.

PS3 (PostScriptOut) If the input file is a composite PDF
file, the output can be either
composite or separated PostScript 3.

If the input file is a separated PDF
file, the output can only be
separated.

Use when you want to send the page directly
to an imagesetting device or to impose in
Preps, or to output flats.
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Option Description Recommended Use

CT/LW
(CTLWOutput)

Outputs PDF pages to CEPS pages in
Scitex CT/LW or TIFF/IT format.

CT/LW supports spot colors; TIFF/
IT does not.

Use CT/LW for output to other systems, for
example, Brisque or gravure imaging systems
that require CT/LW files.

Use TIFF/IT for advertising agencies that
require TIFF/IT files.

Note: To specify CT/LW or TIFF/IT output,
see the output process template Render
section.

About support output file types

Prinergy supports the following types of output files:

Raster formats:

● DCS Raster (screened or continuous tone)
● Epson 5000 (screened)
● Epson 9000 (screened)
● EPS Raster (screened or continuous tone)
● HPRTL (screened or continuous tone)
● JPEG (continuous tone)
● Kodak Approval EPS (screened)
● Kodak Approval TIFF (screened)
● Kodak Proofers (KPS direct connect) (continuous tone)
● LQS TIFF
● PDF Raster (screened or continuous tone)
● Scitex CT (continuous tone)
● TIFF (screened or continuous tone)
● Virtual Proofing System
● Windows Bitmap (screened or continuous tone)

Vector formats:

● DCS-2 Vector
● EPS Vector
● PDF Vector (separated or composite, depending on input)
● PDF/X-1a:2001
● PDF/X-3
● PostScript Level 2 (separated)
● PostScript 3 (separated or composite, depending on input)
● CT/LW or TIFF/IT

For information about each output file type, see About Output Formats.
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About generating proofs and final output

After refining your files, you can generate the following types of output:

● Loose page proofs—use to output unassigned pages.
● Imposition proofs—use to output signatures for proofing.
● Final output—use to output signatures for final output.

To generate these output types, you must have created an appropriate
output process template. Once you have an appropriate output
process template, you can use it to start a process.

See also:
About process templates on page 183
About supported output formats on page 620
About support output file types on page 625
About PDF/X on page 630
About soft proofs on page 636
About previewing loose page output on page 752

Remaking plates
If you need to remake a plate, you can do so using the Plate Remake
tool. This enables you to remake a plate using the same settings and
output device that were used to output the original plate.

For example, suppose that you are printing a job at night and notice
that one of the plates that was made during the day shift is damaged.
You can use the Plate Remake tool to quickly remake the plate without
needing to know how to use Workshop or what settings the day shift
operator used to make the original plate, and without opening the job
or modifying any process templates. The new plate is output using the
settings that were applied when the original plate was made, including
being output to the same device that was originally used.

Plate information is kept for 30 days, so you can remake a plate using
the Plate Remake tool for up to 30 days after the original plate was
output.

To remake a plate using the Plate Remake tool, you must know the
identification number of the plate.

Note: For a unique identification number to be printed on a plate for possible
remake later, the variable mark $[PlateID] must be included in one of the
following: the imposition marks file that was imported with the imposition; the
sheet marks file specified in the Marks section of the imposition output or final
output process template; or the Slugline mark box in the Marks section of the
imposition output or final output process template.
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1. Start Prinergy Workshop.

2. In Job Finder, select Tools > Plate Remake.

3. In the Plate Remake dialog box, in the Plate ID box, type the
identification number of the plate that you want to remake.

The Plate Details box is automatically populated with information
about the plate—for example, the job, imposition, signature,
surface, and separation.

4. In the Work Type list, select the reason why you are remaking the
plate.

Note: The work type applies only if you have Link software set up to work with
Prinergy.

5. If you want to customize the work type, click Edit. For information
about customizing the work type, see Customizing work
types on page 1097.

You cannot change any other settings that were used to make the
original plate. For example, you cannot change the output device.

6. Click OK.

The plate is output to the device specified in the process template
that was used to output the original plate.

Plate Remake dialog box
Use the Plate Remake dialog box to remake a plate using the same
settings and output device that were used to output the original plate.

Plate ID

Type the identification number of the plate that you want to
remake.

Plate Details

When you enter the plate ID, this box is automatically
populated with information about the plate—for example, the
job, imposition, signature, surface, and separation.

Work Type

If you have Business Link software set up to work with Prinergy,
select the reason why you are remaking the plate.

To customize the work type, click Edit. For information about
customizing the work type, see Customizing work
types on page 1097.

See also:
Remaking plates on page 626
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Applying ColorFlow curves and making tonal adjustments
If a printing plate has imaged and run on press, but the press is not
printing with the desired response, you may need to recreate the plate
using a different ColorFlow curve channel for one or more separations.
You can also make tonal adjustments to the assigned ColorFlow curve
channel. These adjustments, made on-the-fly from the Start Process
dialog box, are appended to the ColorFlow calibration curves and have
no effect on ColorFlow colorstores.

Applying a custom ColorFlow curve channel may be required if you
have a spot color that cannot use the default calibration curve—for
example, a metallic spot color. In such a situation, you can define a
custom curve channel in ColorFlow for Metallics. When a job is run,
selected spot color separations may be mapped to this (or another)
curve channel.

Tonal adjustments may be required because of mechanical problems
on the press or by lithographic problems caused by press ink/water
adjustments. Or else, a customer might simply want a color change. A
common solution is to remake one or more plates with an adjusted
calibration curve.

Note: This is different from the Plate Remake feature, where the primary purpose
is to produce an identical plate to replace a worn or broken plate, using the same
unique plate ID number, and the same settings and output device that were used
to output the original plate. Tonal adjustment is used when you need to produce a
different version of the plate.

1. In Prinergy Workshop, start a final output process.

2. In the Start Process dialog box, click the Tonal Control button.
The Tonal Control dialog box opens, automatically populated with
the information from the separations in the surfaces of the job
selected for output.

3. From Separation list, select the first separation that you want to
work on.
The Curve Channel list displays the ColorFlow curve channel that
has been assigned for the selected separation.

4. From the Curve Channel list, select a different curve channel, if
required.
The details of the curve channel that is selected are displayed in the
values and slider positions in the Tonal Adjustments section.
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5. In the Tonal Adjustments section, drag the sliders to make
adjustments. Alternatively, you can type the values in the boxes
under the sliders. The adjustment controls include:

● The Midtone (50%) control affects the full tonal range. The
Quartertone, 3/4 Tone, Highlight, and Shadow points are
adjusted according to the values in the Midtone control.

● The Quartertone (25%) control affects the lower half of the
tonal range. The Highlight point is adjusted according to the
value in the Quartertone control.

● The 3/4 Tone (75%) control affects the upper half of the tonal
range. The Shadow point is adjusted according to the value in
the 3/4 Tone control.

● The Highlight (10%) and Shadow (90%) controls are the most
localized, and do not affect any other adjustment points.

● Clicking Reset restores the tonal adjustment values to 0.0 and
the sliders to midpoint.

6. Repeat the process for any other separations that require tonal
adjustment.

7. Click OK to return to the Start Process dialog box.
The calibration curve channels are modified according to the
specified tonal adjustments.

Note: If you remake a plate using the Tools > Plate Remake menu item, all the
tonal adjustments applied to the original plate will be applied to the remake.
You cannot make further tonal adjustments to a remade plate.

Note: It is not possible to reduce solid colors (with 100% ink) using a
calibration curve adjusted with tonal adjustment. This is a limitation of Adobe.
If you want to reduce 100% solid colors (in particular, spot colors), you need
to set the Ouput PT parameter so that the Screen Solids value is 90%. For
example, in Final Output > Calibration & Screening, the Screen Solids value is
set to 90%.

Tonal Control dialog box
Use the Tonal Control dialog box to apply custom calibration curves for
a specific separation, surface, or job selected for plate output, or to
make on-the-fly tonal adjustments to those curves.

Separation

This list contains a list of each separation, in any surface of the
job, that has been selected for output in the job. Select the
separation that you want to work on.

Curve Channel

This list displays the ColorFlow curve channel that has been
assigned for the selected separation. Use this list to select a
different curve channel, if required.
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If you have a spot color that cannot use the default calibration
curve (for example, metallics), you must apply a custom
ColorFlow curve channel.

Tonal Adjustments

This section contains sliders that you can drag to make tonal
adjustments to the selected curve channel. Alternatively, you
can type the values in the boxes under the sliders.

Note: The sliders may appear too short if your screen resolution is set
low. If this occurs, increase your screen resolution.

Midtone (50%)

This control affects the full tonal range. The Quartertone, 3/4
Tone, Highlight and Shadow points are adjusted according to
the values in the Midtone control.

Quartertone (25%)

This control affects the lower half of the tonal range. The
Highlight point is adjusted according to the value in the
Quartertone control.

3/4 Tone (75%)

This control affects the upper half of the tonal range. The
Shadow point is adjusted according to the value in the 3/4
Tone control.

Highlight (10%)

This control affects the highlight tones only, and does not affect
any other adjustment points.

Shadow (90%)

This control affects the shadow tones only, and does not affect
any other adjustment points.

Reset

This button restores the tonal adjustment values to 0.0 and the
sliders to midpoint.

About PDF/X

Prinergy can generate PDF/X-1a:2001 and PDF/X-3:2003 files.

PDF/X is an exchange format for sending pages between a page
preparation site and a printing site. PDF/X is a subset of the full PDF
specification.
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A PDF/X file is intended to be more predictable because it has
commonly agreed-on characteristics. Using PDF/X does not guarantee
the performance of a file, but a PDF/X file will be free of certain
common prepress problems such as missing fonts and images, and
non-press color space.

Outputting to PDF/X

If you are intending to output PDF/X, you must first choose Refine to
PDF/X, rather than just outputting to PDF/X. Prinergy detects and
deals with many PDF/X issues at the refine stage. When you select a
PDF/X format when outputting, Prinergy checks the master files for
PDF/X conformance. However, some issues, including font embedding,
image replacement, and color conversion cannot be handled on output
and cause Prinergy to fail the file.

What are the flavors of PDF/X?

PDF/X-1 family:

PDF/X-1:1999—Approved by ANSI (American National Standards
Institute) as PDF/X-1 in October 1999. This format is based on PDF 1.2
plus Adobe Tech Note 5188.

PDF/X-1:2001—Approved by ISO (International Organization for
Standardization) in April 2001. This format is based on PDF 1.3. It is an
updated international version.

PDF/X-1a:2001—Approved by ISO in April 2001. This format is based
on PDF 1.3. Embedded files are not allowed. This is the version that
Prinergy can refine to.

PDF/X-1a:2003—Not yet approved, but the approval process is
underway. This format is based on PDF 1.4, but will not allow such 1.4
features as transparency and JBIG2 compression.

PDF/X-2—Not yet approved. All fonts must be embedded. PDF/X-2
does not use OPI; instead it uses a Global Unique ID (GUID) to
reference an external file. The external files must be PDF/X-1 or PDF/
X-3 files.

PDF/X-3:2002—Approved by ISO in 2002. This format is based on
PDF 1.3. It allows for PDF/X-1 color spaces plus L*a*b and RGB spaces.

PDF/X-3:2003—Not yet approved, but the approval process is
underway. This format is based on PDF 1.4, but does not allow such 1.4
features as transparency and JBIG2 compression.
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Technical requirements of PDF/X-1a:2001 and PDF/
X-3:2003

● Fonts must be embedded.
● If OPI is used, the high-resolution image must be swapped into the

file and the OPI comment removed.
● Transfer functions (TR and TR2) are not allowed. Prinergy fails

pages that contain custom transfer functions.
● Pre-separated pages are not allowed. For whole-page copydot DCS

input, Prinergy will try to recomposite the file, which would allow a
PDF/X-1a:2001-compliant page.

● Spot colors and CMYK are allowed; RGB and L*a*b* are not allowed.
● LZW and JBIG2 compression are not allowed.
● Bounding boxes are restricted. Each page must have a media box

that can include either a trim box or an art box, but not both. A page
can have a bleed box or crop box. The trim box or art box must be
entirely inside the bleed box or crop box.

● Halftone issues:

○ Named halftones are not permitted. This means you cannot use
DotShop screening, since Prinergy relies on the halftone name to
choose the screening. When refining to PDF/X-1a:2001, Prinergy
removes any halftone dictionary that contains a HalftoneName
key, including DotShop halftone dictionaries.

○ There is no Halftone Phase (HTP key).
○ Halftone Type can only be 1 or 5 (no threshold screening).

● Embedded PostScript fragments and PDF features beyond PDF 1.3
are not supported. Thus, transparency cannot be present; Prinergy
flattens transparencies in PDF 1.4 input.

● Annotation use is limited. Annotations are allowed if they lie
entirely outside the bleed box, or outside the art box or trim box if
there is no bleed box. The exception is the TrapNet annotation,
which is allowed without restrictions.

Note: Prinergy does not use TrapNet annotations for trapping.

Prinergy does not use TrapNet annotations for trapping.

When refining to PDF/X, Prinergy detects and deals with all of the
above issues where possible. If it is not possible to make a PDF/X-
compliant file, Prinergy fails the file.

What happens during refining

When you refine to PDF/X, the Normalize, Optimize, and
ColorConvert options in the refine process template must be selected.

During the normalize process, Prinergy does OPI replacement and
embeds fonts. The Search for High-Resolution Images in Image
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Search Paths option is enabled, though you can disable it. The Fail on
Missing Fonts option is enabled and you cannot disable it.

During color conversion, the input color space is converted to CMYK
plus spot colors.

CAUTION: If you have a L*a*b* PANTONE color library installed, selecting the
Look Up Recipe in Color Database option in the Source of Color Recipes area of
the Spot Color Handling section may cause Prinergy to fail the file. If the option is
not selected, and color recipes are defined using L*a*b*, Prinergy may also fail the
file. L*a*b* color space is not allowed for PDF/X-1a:2001 and PDF/X-3:2003 files.

During optimization, Prinergy checks for the remaining PDF/X issues. If
it is not possible to create a PDF/X-compliant file, Prinergy fails the file.

What happens when I select PDF/X-1a:2001 when
outputting in Prinergy?

The selected master files are checked for PDF/X-1a:2001 conformance,
in case a master file was edited and a non-PDF/X-1a:2001 element or
characteristic was introduced into the file. Some issues are corrected at
this point. However, some issues —including font embedding, image
replacement, and color conversion— cannot be handled at this point
and cause Prinergy to fail the file. The file must then be refined to PDF/
X-1a:2001 again.

If you select multiple pages and select Save Pages to Separate Files in
the Publish PDF Files dialog box on output, the selected files are
combined into one PDF/X-1a:2001 file.

What is the recommended workflow?

It is important to refine to PDF/X, because it ensures that your proof
cycle is based on the same PDF/X file that is output and sent to the
printer site.

1. Refine input files to PDF/X-1a: 2001
2. Refine (including OPI, font embedding, and color matching)
3. PDF/X-1a: 2001 digital master files are outputted. From the master

files, you can:

● Display in Acrobat View, or print on a printer which will accept
PDF/X as an input type, OR

● Export to PDF/X-1a, and send the files to a third party printer

Can I simply refine files to PDF as usual, and then output to
PDF/X-1a:2001 on Vector JTP output?

Though it might be possible to do so in some cases, in general this is
not the recommended way of working. In particular, color matching
must be performed during refine. A file needing color matching will not
be converted to PDF/X-1a:2001 on output if it has not been refined to
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PDF/X-1a:2001. Other issues addressed during refine include font
embedding and OPI.

What happens during vector output (Publish PDF or
Vector JTP)

When you select PDF/X when outputting in Prinergy, the selected
master files are checked for PDF/X conformance. This is in case a
master file has been edited and a non-PDF/X element or characteristic
has been introduced into the file. Some issues will be corrected at this
point, but some issues—including font embedding, image replacement,
and color conversion—cannot be handled at this point and will cause
Prinergy to fail the file. The file must be refined to PDF/X again.

Must I do OPI replacement?

PDF/X-1a:2001 requires that files not contain OPI comments. The
expectation is that OPI replacement was done and that the receiver of
the PDF/X file needs no additional external resources (fonts or
images) to process the file.

Prinergy does OPI replacement by default during refining to PDF/X-1a:
2001. In some cases, the high-resolution image is embedded in the
document but the file still contains OPI comments. An example of this
is where high-resolution TIFF files are placed in QuarkXPress and
printed as fat files. In these cases, Prinergy tries to perform OPI
replacement in these cases and generates a warning or error.

If you are working in a non-OPI workflow, clear both the Search for
High-Resolution Images in Image Search PathsReplacement and Fail
On Missing Images check boxes in the refine process template.

Can I refine a PDF/X-1a:2001 file?

Yes. Prinergy treats a PDF/X-1a:2001 file like any PDF input file. The
file can be refined to a regular PDF file, or it can be refined to a PDF/
X-1a:2001 file again. If it is refined to a regular PDF file, it no longer has
the PDF/X-1a:2001 identification keys. If it is refined to PDF/X-1a:
2001, Prinergy checks it the same as any other input file that is refined
to PDF/X-1a:2001.

What about PDF/X checkers?

Kodak has tested the following PDF/X checkers:

● Apago PDF/X-1 Checkup, version 2.5
● DDAP PDF/X Verifier version 2.0
● Callas pdfInspektor2, version 1.0
● Enfocus PitStop, version 5.02 using Profile: PDF/X-1a:2001 v2
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In our testing, our PDF/X-1a output consistently passes the Apago and
DDAP checkers.

We found that pdfInspektor2 and PitStop provide error notifications in
the following cases even though the file is PDF/X-1a:2001-compliant:

● Callas pdfInspektor reports in all cases that “OutputIntent Info
missing,” even though all PDF/X-1a:2001 required information is
present.

● Callas pdfInspektor reports the use of BX and EX operators as
errors, even though the PDF/X-1a:2001 specification says these are
okay. What is prohibited are non-PDF 1.3 operators, even within BX
and EX.

● Enfocus PitStop reports that “Document does not use modern
compression mechanisms.” This is generated in PitStop by the
“Compression is not optimal” check, which is not related to PDF/
X-1a:2001. If this check is left out, this error is not reported.

● Enfocus PitStop reports “Custom halftone function found” whenever
there is a Halftone (HT) key. But the Halftone key is permitted in a
PDF/X-1a:2001 file if the Halftone Type is 1 or 5.

Are there any known issues with the implementation of
PDF/X-1a:2001 in Prinergy?

If a PDF/X page that has the Trapped key set to true is brought into
Prinergy and refined with the Trap section of the process template
enabled, Prinergy tries to retrap the page.

When creating a PDF/X-1a:2001 output file, the Trapped key in the
PDF/X-1a:2001 file is always set to false. This is because it is difficult
to automatically determine if all trapping has been done.

If an input file is a PDF 1.4 file, then the master file has the PDF 1.4
version tag in it, and possibly a Metadata key. (Note that PDF 1.4
transparency will have been flattened.) On output (using vector PDF
output, or Publish PDF output), the file has the proper PDF 1.3 version
tag and no Metadata key.

If an input file is a PDF file and does not have the Title or Producer keys
filled out, then the master file likewise does not have these keys filled
out. On output, the Producer key is filled out, but the Title key is not.

What if I don’t want to use the PDF/X feature in Prinergy?

If you don’t want to use PDF/X format as your digital master file,
simply configure your process template to generate PDF instead of
PDF/X-1a:2001. Prinergy generates digital master files the way it
always does. This allows the Prinergy functionality that is not possible
with PDF/X.
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What about PDF/X-3?

A PDF/X-3 file can contain Output Intents, which indicate the file's
intended target device, including its color profile.

The system warns you if PDF/X-3 input files contain Output Intents
and shows the value of the Output Intents in the history log. This
happens automatically; you do not need to enable this feature.

If your input file is PDF/X-3, you can use the color profile specified in
the PDF/X-3 Output Intents. Select the Prefer embedded PDF/X-3
Output Intents for Final Output Profile check box, which is located in
the ColorConvert section of the refine process template.

If your output is PDF/X-3, you can specify an ICC profile or named
print condition for the PDF/X-3 Output Intents in the Output Intents
area of the File Format section of the output process template.

To check PDF/X-3 compliance and color accuracy of a workflow, refine
and output the Altona Test Suite.

Where Can I Find More Information About PDF/X?

● http://www.iso.org/—ISO-15930 description of the differences in
technical requirements between PDF/X-1a:2001 and PDF/
X-3:2003

● http://www.npes.org/standards/cgats.html—a link to CGATS
(Committee for Graphic Arts Technologies Standards), the group
writing the specification

● http://direct2.timeinc.com—Time Inc. recommendations on file
submission

See also:
Using the Altona Test Suite on page 662

About soft proofs

A soft proof is a proof displayed on the monitor. Within Prinergy, you
can create soft proofs in the following ways:

● View pages with Adobe Acrobat
● Create TIFF files
● Create files to be viewed with Virtual Proofing System software

Adobe Acrobat

In Job Manager you can view and edit individual pages with Adobe
Acrobat. This method of soft proofing does not require a process
template. Proofing with Acrobat shows you the PDF page content, but
not any imposed or screened pages. Use Virtual Proofing System to
view these details.
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Virtual Proofing System

To soft-proof individual or imposed pages you can create a file for
viewing with Virtual Proofing System software. With Virtual Proofing
System software you can:

● View the imposed layout (imposed proof only)
● View separations
● View backups of surfaces (imposed proof only)
● View safe protect box
● Zoom in on specific content
● Turn on trim lines
● Check measurements

To create a soft proof, follow the instructions in Starting
processes on page 171, and select a Virtual Proofing System software
process template.

To view VPS files, right-click the pages, surfaces, signatures, or
separations that you want to view--anywhere that a VPS file has been
created--and select Open VPS Files in the context menu. Alternatively,
select File > Open VPS Files.

Note: You cannot open VPS files from the Pages pane if the VPS files were output
from the Page Sets pane—the resulting VPS files from each location are different.
When outputting VPS files from the Page Sets pane, it incorporates geometry
information from the associated imposition, whereas outputting VPS files from the
Pages pane includes geometry from just the page.

For information about using Virtual Proofing System, see the Virtual
Proofing System documentation.

About document screening

The following limitations apply when you select Use document's
screening, if present in the Screening Mode box on the Calibration &
Screening section of an output process template:

● Possible screen angles are 0, 15, 30, 45, 60, 75, 90, 105, 120, 135,
150, 165. Screen angles you specify from the desktop software are
rounded to the nearest applicable screen angle.

● For any object, unless you're mixing AM and FM screens, set the
screens for all separations to the same frequency. In other words,
you can have the bumper of the car in an ad screened at 175 lpi and
the hood screened at 133 lpi, but you shouldn't have the bumper's
cyan separation screened at 175 lpi and its magenta separation
screened at 133 lpi. Setting all separations to the same frequency is
easy to do, as many software applications support a screen all
separations at same frequency feature.

● There are no standards for dot shape names-Ellipse in one software
application might have a different orientation or shape than Ellipse
in another software application. When you select Use document's
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screening, if present, Prinergy respects the PostScript spot function
included with the screen specification.

About dot shapes

You can specify the dot shape in the Calibration & Screening section of
output process templates.

Note: This topic only applies to regular (rational tangent) screening. For IS
screening, see IS screening on page 665.

With CTP there is little difference between dot shapes in the plating
process, but there are some subtle differences on press.

In film workflow, mechanical gain in the imaging and plating process
exacerbated mechanical gain on the plates and caused nonlinearities
where neighboring dot structures touched, causing a tonal jump right
on the plate. This problem was further compounded by mechanical
gain on press, leading to even larger visual tone jumps where the dots
met.

Thermal CTP eliminates all mechanical gain in the plating process.
Even where neighboring dot structures touch, there is no bleeding of
the pixels or dot shape into one another, like there is in an analog and/
or Gaussian-based exposure system. The result is accurate tonal
reproduction onto the plate, so that Round, Euclidean, and Elliptical all
produce the same physical dot area on the plate. However, there are
subtle mechanical differences between the dot shapes, based on how
they respond on press, because the compounding effect of plating gain
has been eliminated and the tone jumps are not nearly as obvious.

The accuracy of pixel-for-pixel reproduction, and therefore the edges
of each halftone dot, is wholly dependant on the optical resolution of
the device and media. For CTP devices that do not deliver accurate
reproduction of each pixel, differences will be less subtle.

The choice of dot shape is more critical when the plating system
produces mechanical gain or loss on plate greater than 4%. Most
thermal CTP systems produce linear output and do not affect your
choice of dot shapes. Photopolymer plates such as those found on
violet CTP and modern high speed negative thermal plates produce
measurable levels of gain on plate and users should take note of tone
jumps in the tints where neigbouring dot structures touch. Choosing a
dot shape that avoids tone jumps in critical areas may be important in
selecting the best dot shape for your print application or typical subject
matter.

Generally, Round, Euclidean, and Elliptical dots produce similar
physical dot area on the plate, but they may respond differently on
press. Also, subtle mechanical differences may be seen where the dots
touch.
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Elliptical

This dot shape is used to avoid the sharp transition at 50 percent that
is characteristic of the Euclidean dot shape. This is an excellent dot
shape for general use. However, it is not suitable for printing flesh
tones, as the chaining of the Elliptical dots at 40 percent and 60
percent may cause visible streaking in the skin tones under certain
printing conditions.

Heavy elliptical

Light elliptical

Line

Line1

Rhomboid

Sorry, this information is not yet available.

Round

This is a commonly used dot shape that gives a smooth appearance in
highlights and midtones. It is commonly used in imaging flesh tones
and images with high and medium key detail. Dot gain and tonal jumps
can be a problem in the shadow areas, because the white space at the
center of four adjoining circles can easily become filled with additional
ink as the dots grow and begin touching. However, with accurate and
stable imaging, shadow detail is preserved remarkably well on press.
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Roundsquare (euclidean)

Also known as Euclidean, this general purpose dot shape reduces dot
gain in the shadow areas, but creates a tonal jump at 50 percent where
the corners of the checkerboard touch and cause excess ink to bridge
between the dots. The RoundSquare dot shape is used for general
applications, where the midtone tints are not critical to the image. It is
particularly suited to high and low key images.

Square

Square1

About minimum dot size calculation

Here is the calculation for figuring out minimum dot size. The minimum
dot size control is found in the Calibration & Screening section of
output process templates.

Print tint patches of the screen at the screen frequency you will use,
concentrating the patches in even steps (for example, 0.5 percent or 1
percent) in the highlights and shadows, making sure to fully cover the
printing range of your press.

The average distance in pixels between adjacent dot centroids is:

device_resolution / screen_frequency = average_dot_spacing

For example, at 150 lpi and 2400 dpi, the average dot spacing is 16
pixels.

This means that each dot is, on average, 16*16 = 256 pixels in size. The
supercell screening in Prinergy will allow you to have more than 256
gray levels by distributing additional grays over a wider area, but this is
a good number for calculation.

So, a 16-pixel dot cluster at 150 lpi corresponds to a tint of 16/256 =
6.25 percent. Likewise, a 4-pixel dot cluster is 4/256 = 1.56 percent.
That is, if you see everything at 6 percent or lighter washing out at or
not printing reliably at 150 lpi, you should set the minimum dot size to
16 pixels.
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The full formula is:

Highlight minimum dot size = lowest_printing_tint *
(device_resolution / screen_frequency^2

You can do a similar calculation for the other end of the tone scale, in
the shadows. For example, if you can print as much as 85% at 150 lpi
before totally plugging, then:

(100% - 85%) * 256 = 38 device pixels

So the formula is:

Shadow minimum dot size = (100% - highest printing tint) *
(device_resolution / screen_frequency^2

The reason why the control specifies the minimum dot size in device
pixels rather than a tint value is because, for a given printing process,
the number of device pixels that can be reliably printed is usually
constant, while the same number of device pixels corresponds to
different actual tint values as you change the screen frequency. So, the
idea is that you set the minimum/maximum dot value once for your
press/plate combination, and leave this setting alone, even if you
change to some other screen frequency.

Screen types

Maxtone

Maxtone uses AM screening to create tonal values above the minimum
dot size. Once the minimum dot size is reached, Maxtone uses an FM-
like technique to progressively remove minimum-sized dots from the
AM grid. This technology allows flexo printing to achieve increased
highlight values, using the minimum printable dot size.

Maxtone CX

Maxtone CX hybrid AM screening feature enables printers to configure
the size of highlight and shadow dots to suit the resolution-rendering
capabilities of their output device, plate, and pressroom.

The dots in Maxtone CX are arranged on the same screen-ruling grid
as Maxtone screens, and tonality in the midtones is controlled by
adjusting the size of the dots. However, for Maxtone CX, tonality in the
highlights and shadows is controlled by fixing the dot width and
varying the number or frequency of dots placed on the grid.

Maxtone CX is particularly useful in resolution-limited applications in
which Maxtone highlight or shadow dots are not rendered reliably or
consistently. For example, Maxtone CX is useful in flexo packaging,
where highlight scum dots do not print reliably, in heatset web
applications, and where highlight dots do not have the same run-length
durability as the midtones.
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Maxtone CX can also be used for high-screen-ruling commercial offset
applications to avoid issues with single pixel dots on plate and on
press.

Maxtone IS and CX IS

Maxtone IS screen types are used for seamless sleeve and cylinder
output device applications. IS screen systems are predefined and
cannot be modified in the process template. For information about
defining IS screen sets, see the Prinergy System Administration Guide. To
see how items in the list of IS screen systems can be hidden, see Hiding
IS screen sets.

Maxtone CX IS screen types are also used for seamless sleeve and
cylinder output device applications, but you can configure the size of
highlight and shadow dots.

Maxtone NX

Maxtone NX refers to hybrid AM screening for Kodak Flexcel NX. In
Maxtone NX, most of the tonal range uses traditional Maxtone AM
screening in order to achieve mottle-free overprints in the midtones,
while extreme highlights and shadows are screened with FM patterns
to allow smooth highlight areas with larger dot sizes.

Maxtone NX gives you a choice of AM screening for the midtones, and
the ability to control the minimum highlight and shadow dot sizes. In
the midtones, it is identical to regular Maxtone AM screening. In the
extreme highlights and shadows, there is a transition between fully AM
behavior and fully FM behavior. The dot size is fixed at the minimum
size that you specify, and the distribution of dots becomes FM in
nature.

Staccato

Staccato screening is a stochastic, or frequency-modulated (FM),
screening solution that can be purchased as an option to Prinergy. The
combination of the Staccato screening software and the Kodak
SQUAREspot technology gives you a level of control in the printing
process that makes stochastic screening viable for routine presswork.

The demands that stochastic screening places on time and equipment
mean it is not usually a practical solution for everyday print production.
It is difficult for many printers to deliver stochastic screening with
conventional output devices, because these devices do not offer the
control required in the calibration, development, and platemaking
processes. Staccato, however, makes FM screening a practical option
for your routine presswork. You can also mix Staccato screens with
conventional screens.

For more detailed information about Staccato screening, see the
Staccato User Guide.
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Staccato NX

Staccato NX is a configurable second-order FM screening intended for
use with Flexcel NX media for packaging applications.

Staccato NX introduces FM screens for use with Flexcel NX media to
address the needs of the packaging sector. In particular, it lets you use
extended color sets (beyond CMYK), while avoiding AM screening
moiré in the overprints.

Staccato NX consists of a set of preconfigured FM screens that can be
selected in Prinergy. Staccato NX gives you a choice of minimum
highlight and shadow dot size or dot width, and a choice of midtone
frequencies. Screens are specified in terms of pixels for minimum
highlight and shadow dot size, and equivalent line screen ruling (lines
per inch) for midtone frequency.

See also:
Staccato Dot Size and Screen Ruling Equivalents on page 647

About screen systems

Screen systems contain an optimal set of screening characteristics for
a particular screening requirement. Predetermining the relationship
among screen angles, screen rulings, and the screens to which these
are assigned reduces the occurrence of screen artifacts.

Screen angles are calculated as in the above illustration.

Set the screen angle control in the Calibration & Screening section of
output process templates.

Maxtone

This screen system forms a rosette among black, magenta, and cyan by
screening these separations at equal rulings with nominal angles of
75°, 15°, and 135°. The yellow separation is screened at 0° with a ruling
slightly higher than the other separations to reduce moiré. In the
default angle assignment, black, as the most dominant color, is
screened at 135°.

This system is susceptible to moiré in smooth tints of two separation
pairs: cyan-yellow (greens) and magenta-yellow (peach tones). Angle
swapping allows moiré susceptibility to be shifted from one of these
separation pairs to the other. For applications with dominant peach
tones, set magenta to 135°.

This system has been formulated for best performance on output
devices to provide even, low-moiré flat tints, especially on large-format
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devices. Screens from this system are compatible with screens
generated from the Allegro workflow.

Ruling Ranges from 40 to 240 lpi (The available values
depend on the output device.)

Dot Shape EllipticalP, Heavy Elliptical, Light Elliptical, Line, Line1,
Round, Round-Square (Euclidean), Square, Square1

CMYK Default
Angles

165 105 0 45

Valid Color Swaps Cyan Magenta Black

Maxtone Y30°

This screen system is identical to HQS Classic in all but its yellow
screen. It forms a rosette among black, magenta, and cyan.

The yellow separation is screened at 30° with a ruling slightly higher
than the other separations. It avoids the 0° screen, which may cause
interference problems in some flexography and silkscreen applications.
In its default angle-to-color assignment, magenta-yellow moiré is
eliminated, leaving the cyan-yellow separation pairs susceptible to
moiré.

This system has been formulated for best performance on output
devices to provide even, low-moiré flat tints, especially on large-format
devices. Screens from this system are compatible with screens
generated from the Allegro workflow.

Ruling Ranges from 40 to 240 lpi (The available values
depend on the output device.)

Dot Shape EllipticalP, Heavy Elliptical, Light Elliptical, Line, Line1,
Round, RoundSquare (Euclidean), Square, Square1

CMYK Default
Angles

165 105 30 45

Valid Color Swaps Cyan Magenta Black

Maxtone Y60°

This screen system is identical to HQS Classic in all but its yellow
screen. It forms a rosette among black, magenta, and cyan.

The yellow separation is screened at 60° with a ruling slightly higher
than the other separations. It avoids the 0° screen, which may cause
interference problems in some flexography and silkscreen applications.
In its default angle-to-color assignment, cyan-yellow moiré is
eliminated, leaving the magenta-yellow separation pairs susceptible to
moiré.

This system has been formulated for best performance on output
devices to provide even, low-moiré flat tints, especially on large-format
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devices. Screens from this system are compatible with screens
generated from the Allegro system.

Ruling Ranges from 40 to 240 lpi (The available values depend
on the output device.)

Dot Shape EllipticalP, Heavy Elliptical, Light Elliptical, Line, Line1,
Round, RoundSquare (Euclidean), Square, Square1

CMYK Default
Angles

165 105 60 45

Valid Color Swaps Cyan Magenta Black

Maxtone Y-fine

This screen system is identical to HQS Classic in all but its yellow
screen. It forms a rosette among black, magenta, and cyan.

The yellow separation is screened at 0° with a ruling about 40% higher
than the other separations. This raises the moiré frequency of yellow
with all other separation pairs to the point where it is invisible at typical
screen rulings for offset lithography. The increased yellow screen
frequency may increase dot gain, requiring color-specific calibration to
avoid a yellow cast in color reproduction.

Ruling Ranges from 20 to 600 lpi (The available values depend
on the output device.)

Dot Shape Round, RoundSquare (Euclidean), LightElliptical,
Elliptical, Heavy Elliptical, Smooth Elliptical, Checker,
Line

CMYK Default
Angles

75 15 0 135

Valid Color Swaps Cyan Magenta Black

Maxtone RT01 Y0K45

This historical screen system forms a square rosette among black,
magenta, and cyan by screening these separations at slightly different
rulings and nominal rational-tangent angles of approximately 18°, 45°,
and 72°. The yellow separation is screened at 0° with a ruling slightly
higher than the black separation.

This system is susceptible to moiré in smooth tints of olive-green color.

Ruling Ranges from 20 to 600 lpi (The available values depend
on the output device.)

Dot Shape Round, RoundSquare (Euclidean), LightElliptical,
Elliptical, Heavy Elliptical, Smooth Elliptical, Checker, or
Line

CMYK Default
Angles

71.6 18.4 0 135
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Valid Color Swaps Cyan Magenta Black

Maxtone RT04 Y45K45

This screen system provides an alternative to rosette-forming HQS
screen systems. The rosette pattern is practically invisible at typical
screen rulings for offset lithography.

Cyan and magenta separations are screened at equal rulings, with
rational-tangent angles of approximately 18° and 72° respectively.
Yellow and black are screened at 45°. The yellow ruling is about 10%
below that of cyan and magenta, and the black ruling is about 33%
higher. The differing dot gains resulting from these varied rulings may
require color-specific calibration.

This screen system does not exhibit the moiré susceptibility of
separation pairs found in the other screen systems.

The key separation (45° fine) can be used as an additional color in
combination with the HQS screen systems.

Ruling Ranges from 20 to 600 lpi (The available values depend
on the output device.)

Dot Shape Round, RoundSquare (Euclidean), LightElliptical, Elliptical,
Heavy Elliptical, Smooth Elliptical, Checker, Line

CMYK Default
Angles

71.6 18.4 135 135-fine

Valid Color Swaps Cyan Magenta Yellow Black

Staccato

Staccato screening is a stochastic, or frequency-modulated (FM),
screening solution that can be purchased as an option to Prinergy. The
combination of the Staccato screening software and the SQUAREspot
technology gives you a level of control in the printing process that
makes stochastic screening viable for routine presswork.

The demands that stochastic screening places on time and equipment
mean it is not usually a practical solution for everyday print production.
It is difficult for many printers to deliver stochastic screening with
conventional output devices, because these devices do not offer the
control required in the calibration, development, and platemaking
processes. Staccato, however, makes FM screening a practical option
for your routine presswork. You can also mix Staccato screens with
conventional screens.

For more detailed information about Staccato screening, see the
Staccato User Guide.
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Staccato Extended Color Screens

Staccato screening is a stochastic, or FM, screening solution. Kodak
Staccato Extended Color Screens (ECS) is an add-on for the Staccato
10/20/25 series. Staccato ECS includes 10 unique patterns for each
screen to support extended process color printing.

For more detailed information about Staccato Extended Color Screens,
see the Staccato documentation.

See also:
Staccato Dot Size and Screen Ruling Equivalents on page 647

Staccato Dot Size and Screen Ruling Equivalents

Resolut
ion
(dpi)

Screen
system

Feature
size
(micron
s)

Midton
e ruling
(lpi)

Approx.
midtone
dot size
(microns
)

Highlight
dot
width
(microns
)

Approx
ruling
1&99%
(lpi)

Approx
ruling
2&98%
(lpi)

Requir
ed
license
s

Checkerb
oard test

300 Staccato 40 µm 146.6 86.6 84.7 30 42 Low
Res

1x1

300 Staccato 70 µm 74.4 170.8 84.7 30 42 Low
Res

2x2

360 Staccato 40 µm 175.9 72.2 70.6 36 51 Low
Res

1x1

360 Staccato 70 µm 89.2 142.3 70.6 36 51 Low
Res

2x2

600 Staccato 35 µm 293.2 43.3 42.3 60 85 Low
Res

1x1

600 Staccato 40 µm 148.7 85.4 42.3 60 85 Low
Res

2x2

600 Staccato 70 µm 146.6 86.6 84.7 30 42 Low
Res

2x2

720 Staccato 35 µm 351.9 36.1 35.3 72 102 Low
Res

1x1

720 Staccato 40 µm 178.5 71.2 35.3 72 102 Low
Res

2x2

720 Staccato 70 µm 175.9 72.2 70.6 36 51 Low
Res

2x2

1016 Staccato 30 µm 251.8 50.4 25.0 102 144 St25 2x2

1016 Staccato 40 µm 213.0 59.6 25.0 102 144 St25 3x3

1016 Staccato 50 µm 192.0 66.2 50.0 51 72 St25 3x3

1200 Staccato 25 µm 297.4 42.7 21.2 120 170 St25 2x2
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Resolut
ion
(dpi)

Screen
system

Feature
size
(micron
s)

Midton
e ruling
(lpi)

Approx.
midtone
dot size
(microns
)

Highlight
dot
width
(microns
)

Approx
ruling
1&99%
(lpi)

Approx
ruling
2&98%
(lpi)

Requir
ed
license
s

Checkerb
oard test

1200 Staccato 36 µm 251.6 50.5 21.2 120 170 St25 3x3

1200 Staccato 40 µm 226.7 56.0 42.3 60 85 St25 3x3

1200 Staccato 50 µm 148.7 85.4 42.3 60 85 St25 5x5

1200 Staccato 70 µm 149.8 84.8 63.5 40 57 St25 5x5

1270 Staccato 25 µm 314.8 40.3 20.0 127 180 St25 2x2

1270 Staccato 36 µm 266.3 47.7 20.0 127 180 St25 3x3

1270 Staccato 40 µm 240.0 52.9 40.0 64 90 St25 3x3

1270 Staccato 50 µm 157.4 80.7 40.0 64 90 St25 5x5

1270 Staccato 70 µm 158.6 80.1 60.0 42 60 St25 5x5

1500 Staccato 20 µm 371.8 34.2 16.9 150 212 St20 2x2

1500 Staccato 25 µm 314.5 40.4 16.9 150 212 St20 3x3

1500 Staccato 35 µm 283.4 44.8 33.9 75 106 St25 3x3

1500 Staccato 50 µm 187.3 67.8 33.9 75 106 St25 5x5

1600 Staccato 20 µm 396.6 32.0 15.9 160 226 St20 2x2

1600 Staccato 25 µm 335.4 37.9 15.9 160 226 St20 3x3

1600 Staccato 35 µm 302.3 42.0 31.8 80 113 St25 3x3

1600 Staccato 50 µm 199.8 63.6 31.8 80 113 St25 5x5

2400 Staccato 10 µm 594.9 21.3 10.6 240 339 St10 2x2

2400 Staccato 18 µm 503.2 25.2 10.6 240 339 St10 3x3

2400 Staccato 20 µm 453.5 28.0 21.2 120 170 St20 3x3

2400 Staccato 25 µm 297.4 42.7 21.2 120 170 St25 5x5

2400 Staccato 35 µm 299.6 42.4 31.8 80 113 St25 5x5

2400 Staccato 36 µm 251.6 50.5 31.8 80 113 St25 6x6

2400 Staccato 40 µm 226.7 56.0 42.3 60 85 St25 7x7

2400 Staccato 70 µm 149.8 84.8 63.5 40 57 St25 11x11

2400 Staccato 20.1 µm 586.5 21.7 21.2 120 170 St10 2x2

2400 Staccato 31.1 µm 391.0 32.5 31.8 80 113 St20 4x4

2400 Staccato 42.1 µm 293.2 43.3 42.3 60 85 St25 5x5

2400 Staccato 63.1 µm 195.5 65.0 63.5 40 57 St25 8x8

2540 Staccato 10 µm 629.6 20.2 10.0 254 359 St10 2x2
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Resolut
ion
(dpi)

Screen
system

Feature
size
(micron
s)

Midton
e ruling
(lpi)

Approx.
midtone
dot size
(microns
)

Highlight
dot
width
(microns
)

Approx
ruling
1&99%
(lpi)

Approx
ruling
2&98%
(lpi)

Requir
ed
license
s

Checkerb
oard test

2540 Staccato 18 µm 532.5 23.8 10.0 254 359 St10 3x3

2540 Staccato 20 µm 479.9 26.5 20.0 127 180 St20 3x3

2540 Staccato 25 µm 314.8 40.3 20.0 127 180 St25 5x5

2540 Staccato 35 µm 317.1 40.0 30.0 85 120 St25 5x5

2540 Staccato 36 µm 266.3 47.7 30.0 85 120 St25 6x6

2540 Staccato 40 µm 240.0 52.9 40.0 64 90 St25 7x7

2540 Staccato 70 µm 158.6 80.1 60.0 42 60 St25 11x11

2540 Staccato 20.1 µm 620.7 20.5 20.0 127 180 St10 2x2

2540 Staccato 31.1 µm 413.8 30.7 30.0 85 120 St20 4x4

2540 Staccato 42.1 µm 310.4 40.9 40.0 64 90 St25 5x5

2540 Staccato 63.1 µm 206.9 61.4 60.0 42 60 St25 8x8

3200 Staccato 10 µm 604.7 21.0 15.9 160 226 St10 3x3

3200 Staccato 20 µm 396.6 32.0 15.9 160 226 St20 5x5

3200 Staccato 25 µm 335.4 37.9 23.8 107 151 St25 6x6

3200 Staccato 35 µm 302.3 42.0 31.8 80 113 St25 7x7

3200 Staccato 50 µm 199.8 63.6 47.6 53 75 St25 11x11

About screen angles

You can specify screening angles for spot colors in the Calibration &
Screening section of output process templates and in the Color Editor.

Prinergy searches for spot color screening information in the following
order:

1. If the process template has a screening angle for the spot color,
Prinergy uses the specified angle.

2. If the process template does not have a screening angle, Prinergy
checks the job-specific color library. If the job-specific color library
has a screening angle for this spot color, Prinergy uses it.

3. If neither the process template nor the job-specific color library has
a screening angle, Prinergy checks the global color library. If the
global color library has a screening angle for this spot color, Prinergy
uses it.

4. If neither the process template, nor the job-specific, nor the global
color library has a screening angle, Prinergy uses the default angle
to screen this spot color.
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About seamless imaging

With seamless imaging, the screening pattern is continuous across the
boundaries of the artwork to be imaged "in the round" on a sleeve or
cylinder.

"In the round" means that the plate is wrapped around the cylinder and
imaged on the cylinder, as shown in the following image:

Seamless imaging is used for flexographic printing where the pattern is
continuous and there should be no noticeable transition or break where
the image repeats (for example, wallpaper or fabric printing).

To make an image seamless, select the Enable option in the Seamless
Screening area on the Calibration and Screening section of the output
process templates.

With Seamless Screening Without Seamless Screening

The pattern is continuous around the
cylinder.

The pattern is not continuous around
the cylinder.

About advanced TIFF tags

Select the Advanced TIFF Tags check box in output process templates,
Device section, to add advanced TIFF tags to the output file.

The advanced TIFF tags are:

Tag Name Description

TIFFTAG_CMYK_EQUIVALENT CMYK color recipes for each ink color in order of process
sequence

TIFFTAG_INKNAMES Name of each ink in the file (one ink name for each separation)
listed in order of process sequence

TIFFTAG_INKSET Indicates whether the set of inks are CMYK

TIFFTAG_NUMBEROFINKS Number of inks in the file
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Tag Name Description

TIFFTAG_TIFFIT_COLOR_SEQUENCE Sequence in which inks are processed

CREOTAG_RAST_COLOR_OPACITY Tag created by Kodak to indicate the opacity of each ink color,
listed in order of process sequence

CREO_PAGE_SOURCECLIP Tag created by Kodak to indicate the clipping path of the
assigned page

The benefits of including the advanced TIFF tags when outputting to
Virtual Proofing System 2.0 software are:

● You do not need to enter the color recipe of any spot colors for
Virtual Proofing System software to display them properly.

● Virtual Proofing System software reflects color opacity.

For more TIFF tag information, search http://www.adobe.com/
extranet documents for TIFF Specification.

About TIFF compression

You can control TIFF compression from the File Format section of
output process templates.

G4 is the recommended compression method for high-resolution, 1-bit
output in most cases. G3 and G4 compression options are not available
if either of the following conditions exists:

● The Always use Color Combiner to Convert Spots check box is
selected on the Render section of the output process template.

● A stochastic (FM) screening system is selected in the Screening
System box on the Calibration & Screening section of the output
process template.

Either of the above conditions may cause stochastic pattern data,
which can generate very large files when G4 compression is used.

G4 is a safe and recommended compression method when:

● You have CMYK data only and aren't using a stochastic (FM)
screening system.

● You have spot colors and are not using the Color Combiner.

When dealing with stochastic screening, ZIP is the recommended
compression method.
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What is PJTF?

Adobe's Portable Job Ticket Format (PJTF) does the following tasks:

● Contains descriptions of device-specific settings.
● Specifies the sequence of JTPs that will process PDF files.
● Describes the desired output style for one or more pages from PDF

files.

Since the PDF file does not contain these settings, the output device
uses PJTF files to set the unique output characteristics, such as
duplexing or two-up printing. Complex layouts like those required by a
commercial printing press and bindery operation can also be described
inside a PJTF file. Since the content of the pages is separate from the
content of the PJTF, changing device-specific settings requires only the
creation of a new PJTF that references the same PDF.

Prinergy extends the concept of Job Ticket files with features such as
archiving. In addition, Prinergy stores some data files such as
imposition plans and process templates as PJTF files. Although these
files are incomplete job tickets, they are stored using this standard
format. Then, when required, Prinergy constructs complete PJTF files
for submission to Extreme, by combining the necessary pieces (input
file content and layout information contained in templates) with
parameters set in process templates.

A job ticket containing loose page output settings is attached to a PDF
page to make a complete PJTF file ready for processing by Extreme.

A job ticket containing imposed page output settings is attached to
several PDF pages to make a complete PJTF file ready for processing
by Extreme.

See also:

What are JTPs? on page 184

Why PDF? on page 255
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Example: crop marks

The long blue arrow indicates the Locate crop mark of length
measurement. The short red arrow indicates the at Distance
measurement.

Example: add extra vertical space

Values selected in the Add Extra Vertical Space box in the Layout
section of the Loose Page Output process template yield the following
results:

Setting Result

Bottom margin
only

Evenly to both
margins

Evenly to all
gutters and
margins

Example: orientation

Pages are rotated as a unit not individually. If either Auto clockwise or
Auto counterclockwise is selected in the Orientation box in the Layout
section of all output process templates, pages are rotated as a unit if
rotating produces a better fit.

In this example the Orientation box is set to Auto clockwise.
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Example: add extra horizontal space

Values selected in the Add Extra Horizontal Space box in the Layout
section of the Loose Page Output process template yield the following
results:

Setting Result

Right margin only

Evenly to both margins

Evenly to all gutters and
margins

Example: shifting images horizontally and vertically

When generating imposition output or final output, you can shift the
imposition plan closer to or farther from the edge of the media using
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options in the Layout section of the imposition output process
template or the Layout section of the final output process template.

● Use the Shift Along Width box to shift the image from the left edge
of the media along the horizontal axis.

● Use the Shift Along Height box to shift the image from the bottom
edge of the media along the vertical axis.

A positive value moves the image away from the original edge. A
negative value moves the image closer to the original edge.

About tiling output

Tiling is normally used in proofing or when outputting an image to film.

Tiling must be handled in Prinergy because tiling is not part of the
Adobe job ticket specification. Also, Preps cannot output a tiled job
ticket (imposition plan).

To handle tiling in Prinergy, create a process template for each tile. In
the process template, specify the appropriate amount of offset for each
tile. The tiles should have enough overlap so they can be matched.

Example

For example, say you want to proof a 32-inch by 44-inch image on a
proofing device that can only output a 32-inch by 30-inch sheet.
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image size

proof size

In this case, two tiles are needed. To create the tiles create two
imposition output process templates, one for each tile. In the process
templates for both tiles, enter the following settings.

In the Layout section, under Media:

● Set Size to Cut Sheet.
● Enter the Max Width and Max Height values. (In our example, this

would be 30 inches and 32 inches.)

In the Layout section, under Placement, ensure that the Center Along
Width and Center Along Height check boxes are cleared.

For Tile 1, save the process template and output the tile. A tile output
with a process template with these settings will automatically be
clipped on the right because of the media size. See Tile 1, below.

For Tile 2, enter the same settings in the process template. In addition,
enter an appropriate amount of offset in the Shift Along Width box (in
the Layout section, under Placement). The Shift Along Width value
should not be greater than the width of the media because you want
some overlap so you can match the tiles. See Tile 2, below.

Tile 1

The image is automatically be
clipped on the right because
of the size of the proofer
media size (30 in.).
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Image is shifted to the left.

Tile 2

For the Tile 2 process
template, enter an
appropriate amount of offset
in the Shift Along Width box.

For this example, we entered -14 as the Shift Along Width value. The
negative sign indicates that the image is shifted to the left. So, the
image is shifted to the left along the width by 14 inches. In this case,
there will be a 16-inch overlap in the two images output from the
proofer.

Using the same technique you can also tile vertically to create a four-
tile imposition.

About custom file naming

You can set up Prinergy to create custom file names for output to help
you identify them. Custom file names can be based on specified file
attributes. For example, when outputting separations, you can create
file names that reflect the job name and the separation color.

Set up custom file names in the Processed File Options section of the
loose page output, imposition output, and final output process
templates.

File name template format

When setting custom file names in the Filename Template box in the
Processed File Options section of your output process template, use
the following format:

%tag1<n1>%.%tag2<n2>%...%tagN<nN>%

where:

tag1 is the name of the first tag, for example, Job or Color. For
supported tags, see below.

n1 is an optional element and represents the maximum number of
characters of the first tag that are displayed from left to right. This
optional element can also be represented as n-1 to display characters
for the tag from right to left.

For example, if the job name is "TestJob", the file name template
%JOB<5>%.Spot-%COLOR%.hello.pdf produces a file name such as
TestJ.Spot-3.hello.pdf. For the same example, if you specified
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%JOB<-5>%.Spot-%COLOR%.hello.pdf, the file name is
stJoB.Spot-3.hello.pdf.

The following truncation options are also available:

<n1,n2> Start at n1 and use n2 characters to the right of it.

<n1,-n2> Start at n1 and use n2 characters to the left of it.

<-n1,n2> Start at –n1 (n1 characters to the left from the end of the job name)
and use n2 characters to the right of it.

<-n1,-n2> Start at –n1 (n1 characters to the left from the end of the job name)
and use n2 characters to the left of it.

Note: The entire file name cannot exceed 128 characters.

Note: If the file or job name has % in it use %% in the tag to get % in the name.

Supported tags

The custom file naming feature supports the following tags:

Tag Name Description

Artworkname Name of the input page (same as Page)

Color Color of the separation.

If the separation is a spot color, see Full Color Spot Names check box
below this table.

See %LongColorName%.

Colorant Color of the separation (same as Color)

Custom Fields:

%CustomfieldJob%

%CustomfieldSubpage%

%CustomfieldPageset%

$[CustomFieldPagePosition]

%CustomfieldPage%

%CustomfieldImposition%

%CustomfieldSignature%

%CustomfieldSurface%

%CustomfieldSeparation%

In Prinergy you can create custom fields for jobs or for elements within a
job, so that you can track unique information about the job or element.

You can use custom fields to create variable marks and custom file
naming. For example, if you have created custom fields at the job level or
job element level (page, page set, imposition, signature, surface, and
separation), you can use them for variable marks and custom file
naming.

%ImpositionJDFName%

%SignatureJDFName%

%SheetJDFName%

If you want to name the PPF file with values taken from JDF file, delete
the variables that appear by default in the Filename Template box and
enter these custom fields.
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Tag Name Description

Extension Appropriate file name extension based on the output type.

For example, if the output is for the Virtual Proofing System, the
%JOB<6>%.%EXTENSION% template would generate the file name
TestJo.vps.

Imposition Name of the imposition

Job Name of the job

Jobname Name of the job (same as Job)

%% %% is replaced with %. If the file or job name has % in it, use %% in the
tag to get % in the name.

LongColorName Replaces the spot color name with the full length name for the spot
color, such as PANTONE 300C. This enables the PrintLink digital-ink
profiling software external file name to identify the spot color name.

OriginalPagename Name of the input page without the refiner.

For example, if the job name is TestJob and the page name is
front.p1.pdf, the %ORIGINALPAGENAME%.pdf template would
generate the file name front.pdf. In this example, 'p1' is the refiner.

OriginalArtwork Name of the input page without the refiner (same as
OriginalPagename)

For example, if the artwork name is front.p1.pdf, the
%ORIGINALARTWORK%.pdf template would generate the file name
front.pdf. In this example, 'p1' is the refiner.

PaddedSheet<n> Sheet number is padded with zeros to create a number with n digits.

For example, if the tag used is PaddedSheet<3>, sheet 1 is represented
as 001.

PaddedSignature<n> Signature number is padded with zeros to create a number with n digits.

For example, if the tag used is PaddedSignature<3>, signature 1 is
represented as 001.

This feature also works with the pageset position. For example, if the tag
used is PaddedSignature<3>, pageset position 1 is represented as 001.

Page Name of the input page.

Note: The input page name is not the same as the input file name.

Pagename Name of the input page (same as Page)

Pageset Name of the page set

Signature Signature number

Sheet Sheet number

Surface Letter corresponding to the surface (A = front, B = back)

Username Name of the current operator
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Tag Name Description

Version Number that is given to the output file. The system always sets the
version field to 0 for the most recently created file. The second most
recent file would be changed to 1 from 0. If there is a third output file, it
would be changed to 2 from 1 and so on.

Date/Time Tags

Date Date (DD-MM-YYYY) on which the file is created

Day Day (DD) in which the file is created

Month Month (MM) in which the file is created

Year Current year (YYYY) in which the file is created

Time Time (HH-mm-SS) at which the file is created

Hour Hour (HH) in which the file is created

Minute Minute (mm) in which the file is created

Second Second (SS) at which the file is created

Controlfile Filename Template box

All of the following output formats require a control (master) file. If you
are using one of these formats, you can specify the name of the control
file using the Controlfile Filename Template box:

● DCS Raster
● DCS (Vector output)
● Approval TIFF
● LQS TIFF

The file name template format and supported tags for the Controlfile
Filename Template box are the same as those for the Filename
Template box.

Full Spot Color Names check box

By default, custom file naming uses the numerical format to identify
spot colors. The numerical format is derived from the order in which
spot colors are listed. For example, if Pthalo Blue is the third spot color
listed, a file name template of %JOB,6%-%COLOR%.pdf would
generate the file name TestJo-3.pdf.

If you want to use the spot color names in the output file names, select
the Use Full Spot Color Names check box. To use this check box, you
must include the %COLOR% tag in the Filename Template.
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About outputting to a file

When you select the Overwrite Existing Files with Same Name check
box, in the Processed File Options section of output process templates,
the old file is overwritten in all cases.

When the Overwrite Existing Files with Same Name check box is
cleared, the file naming scheme described below is used.

When you output a file the second time, the older file is renamed with
the addition of a version number, and the new file takes on the original
name of the first file. Subsequent output causes the version numbers of
all old files to be incremented by one number (to a maximum of nine
old versions). The effect of this constant renaming is that, regardless of
the number of times you output the same information in the same way,
the most recent file is always named the same and the oldest file
contains the highest version number.

Examples

In the following examples:

● 1A is the signature and surface number (for loose page output this
is always 1A) .

● C is the color (CMYK for composite; GRAY for grayscale; and one of
C, M, Y, or K for a separation).

● <ext> is the appropriate three-character extension for the file type,
for example, .JPG, .VPS, .TIF.

● .1. is the version number (up to a maximum of .9).
● * indicates the oldest file.

Output # Loose Page Results

First <page name>.1A.C.<ext>

Second <page name>.1A.C.<ext>

<page name>.1A.1.C.<ext>*

Third <page name>.1A.C.<ext>

<page name>.1A.1.C.<ext>

<page name>.1A.2.C.<ext>*

Output # Imposition or Final Results

First <job name>.1A.C.<ext>

Second <job name>.1A.C.<ext>

<job name>.1A.1.C.<ext>*
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Output # Imposition or Final Results

Third <job name>.1A.C.<ext>

<job name>.1A.1.C.<ext>

<job name>.1A.2.C.<ext>*

Using the Altona Test Suite
Check for PDF/X-3 compliance and color accuracy of a workflow by
running the Altona Test Suite.

The documentation package bundled with the Altona Test Suite
provides a detailed explanation of the elements that you can use to
evaluate output—for example, sample images and typical errors. Use
the following settings for the refine and output process templates to
run the Altona Test Suite.

1. Go to http://www.eci.org.

2. Download the Altona Test Suite from the Downloads section of the
European Color Initiative Web site.

3. Create a job in Prinergy.

4. Add the Altona input files.

5. Create or open a refine process template, and in the Generate list,
select PDF.

6. In the Spot Color Handling section of the refine process template,
clear the Map All Spot Colors to Process check box.

7. In the ColorConvert section of the refine process template, perform
the following steps:

a. Clear all of the check boxes in the Overprint Conversion area.
For example, clear the Enable Gray Overprint check box.

b. Clear the Override Embedded Profiles check box.
c. Clear all of the check boxes in the Assign Source or DeviceLink

Profiles area.
For example, clear the CMYK Images, CMYK Graphics, RGB
Images, and RGB Graphics check boxes.

d. Select the Prefer embedded PDF/X-3 Output Intents for Final
Output Profile check box.

e. Set all the Rendering Intent lists to From PDF.

8. Set the Trap and Thumbnail sections of the refine process template
as desired.

9. Save the refine process template.

10. Refine the Altona input files.

11. Create or open an output process template, and in the Output To
list, select TIFF.

Note: You can choose any raster format that supports contone data.
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12. In the ColorConvert section of the selected output process
template, perform the following steps:

a. In the JTP list, select ColorMatch.
b. In the Match Colors area, select Match Colors in Page Content.
c. Set Assumed Source or DeviceLink Profile to Exactly as Applied

During Refining.
d. Select the Overprint Handling check box.
e. In the Method list, select Raster.

13. In the Render section of the selected output process template,
perform the following steps:

a. Set Shades to 256.
b. Clear the Do Separations check box.

Note: Spot colors will automatically convert to process colors.

14. Output the file.

This outputs the refined PDF file to an ink jet proofer.

15. Output the refined PDF file to a halftone proofer.

For example, output to a Spectrum device.

Assuming that the halftone donor materials match the press inks
colorimetrically, color matching and overprint handling is not
required—simply output to a halftone proofer as you normally
would. If the donors are different and you want to use color
matching, in the Match Colors area of the output process template,
in the Method list, select Vector.

Setting up Maxtone screens
Select the screen type, screen system, dot shape, and screen ruling.
Configure other optional settings, such as screen color and dot width.

1. In the Screen Type list, select one of the following screen types:

● Maxtone
● Maxtone CX
● Maxtone IS
● Maxtone IS CX
● Maxtone NX

Note: When you use IS screen types, the resolution in the Render section of
the process template must be identical to the value in the IS screen system. IS
screen systems are predefined and cannot be modified in Prinergy. For
information about defining IS screen sets, see the Prinergy System
Administration Guide.

2. In the Screen System list, select a set of screen angles.

3. In the Dot Shape list, select a dot shape.

4. In the Screen Ruling list, select a ruling.
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5. (Optional) Enter a Screen Color, select a Screen Angle option, and
select a screen system angle set in the at Angle list to reconfigure
the screen color separations.

6. Under Default Spot Color Handling, select Cycle Through Screen
Angles (for each successive spot color) or Screen as, and select a
color separation in the list.

7. To configure the size of highlights and shadow dots, perform one of
the following actions:

○ If you selected Maxtone CX or Maxtone IS CX in the Screen
Type list, select a value (in microns) for highlights and a value
(in microns) for highlights beside Dot Width Highlights and
Shadows.

○ If you selected Maxtone NX in the Screen Type list, select a
value (in microns) for highlights and a value (in microns) for
shadows beside Dot Size Highlights and Shadows.

Note: It is also possible to select the dot size for the highlights and
shadows using DotShop Composer. Maxtone NX works on the entire page,
so all objects defined with Maxtone NX must have dots of the same size. If
there are multiple dot sizes selected, the output process will fail.

Setting up Staccato screens
Choose the screen type, screen system, dot shape, and screen ruling.
Configure other optional settings, such as screen color and dot width.

1. In the Screen Type list, select one of the following screen types:

● Staccato
● Staccato NX

2. In the Screen System list, select a set of screen angles.

3. In the Dot Shape list, select a dot shape.

4. In the Screen Ruling list, select a ruling.

5. In the Feature Size list, select a feature size.

Note: This list is limited by resolution and Staccato licensing.

6. (Optional) Enter a Screen Color, select a Screen Angle option, and
in the at Angle list, select a screen system angle set to reconfigure
the screen color separations.

7. Under Default Spot Color Handling, select Cycle Through Screen
Angles (for each successive spot color) or Screen as, and select a
color separation in the list.

8. (Optional) If you selected Staccato NX in the Screen Type list, you
can configure the size of highlights and shadow dots. Type a value
(in microns) for highlights and shadows beside Dot Size
Highlights/Shadows.
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IS Screening

See:
Calibration and Screening section of the loose page output process
template on page 459
Calibration and Screening section of the imposition output process
template on page 513
Calibration and Screening section of the Final Output process
template on page 565

IS screening
Kodak IS screening (Irrational Tangent Screening) enables seamless, or
continuous, imaging of photopolymer sleeves and gravure cylinders.

This is a specialty screen that images much slower than conventional
screens. You can use this type of screen when outputting to devices
such as Kodak ThermoFlex Wide II digital flexo imagers or third-party
gravure imaging devices.

Kodak IS screening is a licensed feature. For a complete list of the
advantages and limitations of using IS screening, see the Prinergy
Connect Help.

Creating and editing IS screen sets
Use the IS Screen Set Editor to create and edit IS screen sets. You
cannot use the Process Template Editor to edit IS screen sets.

IS screen sets must be defined before you select them in the process
template. You cannot change most settings in the process template.
You must use the IS Screen Set Editor to set up specific frequency, dot
shape, and angle combinations before you can select them in the
process template. You can assign or change existing screen angles in
the Process Template Editor.

The IS Screen Set Editor is installed on the Prinergy primary server. It is
generally easier to use a remote connection to the server when you
want to use the IS Screen Set Editor.

○ On the Prinergy primary server, select Start > Programs > Prinergy
> Screen Set Editor.

○ The Screen Set Editor window lists all the screen sets with a
summary of their settings.

Field Description

Units Select mm or inch.

Name The name of the screen set when it was created
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Field Description

Owner Kodak refers to a factory screen set. User refers to a
customer-created screen set.

Filter You can apply a filter to view only the screen sets that
meet the filter parameters. You can filter by one or more
columns in the window. The filter is saved when you quit
the Screen Set Editor.

● Click in the Filter line, and type the words or numbers
that you want to search for. All columns are searched.

● To display all screen sets, delete the filter parameters.

Tip: To see the version of the Screen Set Editor, click the About button at the
lower-right corner of the Screen Set Editor window.

○ Use the Screen Set Editor to create, modify, or delete screen sets.

○ To create a new screen set, click New.
○ To edit a screen set, select a screen set, and click Modify.
○ To delete a screen set, select a screen set, and click Delete.

Field Description

Resolution Type the resolution for this screen set. The icons above
the resolutions show which resolution is around the
drum and which resolution is across the drum. Around
the drum corresponds to resolution <y> in Prinergy, and
across the drum corresponds to resolution <x>.

Changing this resolution in a Prinergy process template
changes the frequency of the line screen on output, with
one exception: in assymetrical resolutions, one
dimension can be changed by a factor of 2,4, or 8
without affecting the line frequency.

= For symmetrical imaging, click = so that resolution <y>
equals resolution <x>.

Comment (Optional) Type a comment for the screen set.

Adjust Screen
Frequency

Depending on the angle and resolution, select to adjust
the frequency and create better rosette quality for that
combination of angle and resolution.

Angle Select an angle combination.

Do not enter arbitrary angles in each color column.
Kodak recommends 30° or 60° separations between
cyan, magenta, and black.

Note: Some customers may use non-standard angles for
additional color separations. These angles may deviate
from the recommended angle separations.

Frequency The number of lines per inch or mm

Do not enter different frequencies in each color column.
If you do, the output may have moiré artifacts.
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Field Description

Dot Shape Select a dot shape.

D-Ratio Specify the depth ratio—the ratio of width to height of
the dot size. For example, 80 means the width of the dot
is 80% of its height.

For a symmetrical dot, use 100.

Noise You can apply noise globally over an entire range or only
to specific ranges. Click the Noise button on the left to
apply noise globally.

Seamless
Screening

Select this option to produce seamless imaging on
photopolymer sleeves, direct engraving, or gravure
devices.

Separations Lists the separations in the screen set. IS screen sets
support more than four angles.

Note: Avoid specifying different frequencies or dot shapes for different colors
in the same screen set. Avoid specifying color angles that are not 30° or 60°
separated from other colors.

Note: Many IS screen set parameters cannot be changed in the process
template—for example, dot shape, screen ruling, screen angle, and so on. Use
the IS screen set editor to modify these parameters.

○ To add a separation, click Add.
○ To delete a separation that you have added, select that separation,

and click Delete. You cannot delete process colors or the Others
separation.

Next:

Important: After adding, modifying, or deleting a screen set, you must restart all
Printer and Marks JTPs in Prinergy Administrator to update Prinergy with your
changes.

See also:
About dot shapes on page 638
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Using seamless imaging
Use seamless imaging to make seamless photopolymer sleeves and
gravure cylinders.

Requirements:

● In Prinergy Administrator in the JTP Properties dialog box, ensure
Seamless Screening is selected. See Adding JTPs in the
Administrator Guide.

● In Prinergy Administrator in Tools > Configure System > Screening
tab, select Display all IS Screens. See Displaying all IS screens in
Process Template Editor in the Administrator Guide.

● Ensure you use a high-resolution output JTP.
● Ensure you have set up an IS screen set, and that Continuous

Screening is selected for the IS screen set. You select an IS screen
set in the Calibration and Screening section of the output process
template.

Note: Many IS screen set parameters cannot be changed in the process template
—for example, dot shape, screen ruling, screen angle, and so on. Use the IS screen
set editor to modify these parameters.

At the time of output, set the following options in the output
process template:

Section Setting

Layout Set Size to Digital.

By default, Prinergy creates seamless output in the y direction.

If the seamless layout was created in a horizontal orientation,
then output Orientation must be set to 0° or 180°. Scaling
must be set to 100%.

If the seamless layout was created in a vertical orientation,
such as with the Kodak Pandora software, then the output
Orientation must be set to 90° or 270°.

Render The Resolution must be identical to the resolution in the IS
screen set.

See also:
Creating and editing IS screen sets on page 665

Hiding IS screen sets
You can hide IS screen sets that you don't use so that they do not
appear in the Screen System list in the process template.

The names of IS screen sets that are included with the Prinergy system
start with "Kodak_TF." You can hide screen sets that you don't use,
rather than delete them. Then if you need them in future, you don't
have to recreate them.
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1. In Windows Explorer, navigate to \%AraxiHome%
\AdobeExtreme\bin\TurboScreen\ScreenSets
\Screen2GoVecT.

2. Create a new subfolder and move all of the unused screen sets into
it. Screen sets inside a subfolder do not appear in the Screen
System list in the process template.

If you want to use these screen sets at a later time, move them out
of the subfolder back into the Screen2GoVecT folder.

3. Restart all Prinergy printer JTPs.

Digital printers

About using digital printers

Which digital printers you can use

Prinergy can send PDF and PostScript files directly to most digital
printers.

With the Prinergy Digital Print option, you can also send a JDF control
file to digital printers that accept JDF files, including the following
printers:

● NexPress front end version 8.4 and later with NexPress presses
● Creo PODS Spire color server with Xerox DocuColor presses
● Xerox DocuSP version 4.2 and later with DocuColor, Xerox

DocuTech, and Xerox DocuPrint presses
● HP Indigo Production Stream Server powered by Creo PODS with

HP Indigo presses
● HP SmartStream Production Pro Print Server or the HP SmartStream

Onboard Print Server with HP Indigo presses
● Creo PODS IC-301 with Konica Minolta bizhub PRO C500 press
● EFI Fiery front end with a range of Xerox, Konica Minolta, Canon,

and Ricoh presses

How to use digital printers

There are two main methods of submitting digital print jobs (also
called documents):

Managed connections method

This method involves using the Send to Digital Direct option
and sends documents to the Digital Direct software. Managed
connections enable the digital press operator to schedule
documents for printing and to view print status. For information
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about adding managed connections, see the Prinergy System
Administration Guide.

Legacy method

This method involves making selections, including the digital
front end, in the Include JDF for Digital Print section of the
Process Template Editor. Documents are not sent to the Digital
Direct software.

Important: Do not use this section of the process template if you are
using managed connections.

Pre-requisites

Before using a digital printer, you must perform the following tasks:

● Install and configure digital printing. See the Prinergy Digital Print
Installation and Configuration Guide.

● Create a process template for the digital printer.

In addition, with a NexPress digital press, you also must perform the
following tasks:

● Integrate the NexPress JDF Workflow Planner software with
Workshop. For background and instructions, see the topics about
Integrating Digital Print client software with Prinergy Workshop.

● Use JDF Workflow Planner to set up a JDF template file. For more
information, see the topic about JDF templates for NexPress front
end.

In addition, with a Xerox DocuSP controller, you need to install the
Xerox FreeFlow Print Manager software. For background, see About
Integrating Digital Print Client Software. For instructions, see
Integrating Digital Print Client Software With Prinergy Workshop.

Refining Files for Digital Printers

When you refine files for digital printers, consider these issues:

● Will the files be used on an offset printer, as well as a digital
printer?

● Do you need to extract reader spreads from an imposition?

If you plan to use the files only on a digital printer, you can let the
digital printer do the trapping, color matching, and spot color handling.
To prevent Prinergy from trapping, color matching, and spot color
handling, clear the Trap, ColorConvert, and Spot Color Handling
sections of the refine process template.

You may want to send files to both digital and offset printers—for
example, if you want to split the job among multiple printers or use the
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job at multiple locations. When you send files to both types of printers,
you may want the outputs to match as closely as possible. In this
situation, do trapping, color matching, and spot color handling in
Prinergy by selecting and configuring the Trap, ColorConvert, and Spot
Color Handling sections of the refine process template. On the digital
print controller, set up a job ticket to take the press-ready files and
match the offset press colors as closely as possible.

Choosing Between Vector and Raster PDF Output

When you send files to a digital printer using process templates, you
can choose any type of PDF output available in the Output To list of
the process template, including PDF (Vector output), PDF Raster,
PDF/X-1a:2000 (Vector output), and PDF/X-3 (Vector output).

For most situations, choose one of the vector outputs because vector
files are smaller in size, can store more color information, and are
compatible with the widest range of printers.

When you choose PDF Raster, Prinergy RIPs the entire input file into a
raster file before sending it to the printer. This takes additional
processing time on Prinergy and produces larger files. Use PDF Raster
under these circumstances:

● If the input files cannot be printed as vector PDF—for example,
DCS-2 files

● If the input files use operations that a digital print controller may not
support—for example, white or color overprints

● If you want to ensure that the output was RIPed by Prinergy and will
be interpreted exactly the same as the file that you see in Prinergy

See also:
Start Process for Digital Printing dialog box on page 177
Refine process template on page 201
Creating process templates for digital printers on page 673
About integrating digital print client software on page 1102
Integrating digital print client software with Workshop on page 1103

Sending files using the Managed Connections method
The Managed Connections method is the newest and easiest method
of sending files to a digital press from Prinergy.

Requirements:

You must have configured a managed connection to the digital press.
For instructions on configuring a managed connection to a digital press,
see the Prinergy Digital Print Installation and Configuration Guide.

This procedure uses a Publish File process template with default
settings. If you want to use different process template settings, see the
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topic about sending files using an alternate Managed Connections
method.

1. Select the pages, page set, or imposition that you want to send to
the digital printer.

2. Select File > Send to Digital Direct.

Tip: You can also right-click the selected element.

3. In the Submit to Digital Print dialog box, complete the boxes as
required, and click Submit.

The document (digital print order) is sent to the Digital Direct
software, where the digital press operator software schedules
documents for printing.

Next: For information about Digital Direct tasks, see the Prinergy Digital
Print User Guide.

Sending files using an alternate Managed Connections method
Use this procedure if you want to send files for digital printing using
managed connections, but with special process template settings.

Requirements:

You must have configured a managed connection to the digital press.
For instructions on configuring a managed connection to a digital press,
see the Prinergy Digital Print Installation and Configuration Guide.

1. Select the pages, page set, or imposition that you want to send to
the digital printer.

2. Drag the elements to a Publish File process template.

3. In the Start Process dialog box, click Edit Process Template.

4. Revise the Publish File process template, and click OK.

5. In the Start Process dialog box, click OK.

Note: The Send to Digital Direct option is selected by default.

Sending files using the legacy method
If you have an unmanaged connection to a digital press, use this
method of sending files to the press.

1. Creating process templates for digital printers
Set up a process template before you send files to a digital printer
using the legacy method.

2. Outputting to digital printers using the legacy method
This procedure describes an older method of sending files to
digital presses, and it has many limitations compared to the
Managed Connections method.
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Creating process templates for digital printers

Set up a process template before you send files to a digital printer
using the legacy method.

The digital printer must be set up to work with Prinergy according to
Prinergy Digital Print Installation and Configuration Guide.

1. Create a new process template using:

● Loose Page Output process template to send individual pages or
page sets to a digital printer

● Imposition Output process template to send signatures to a
digital printer

2. From the Output To list, select one of the PDF output types:

○ PDF (Vector output)
○ PDF Raster
○ PDF/X-1a:2000 (Vector output)
○ PDF/X-3 (Vector output)
○ TIFF

3. In the ColorConvert section, in the Proof Process (Destination)
profile box, type the name of or locate the ICC profile of the printer,
to ensure that colors are matched.

4. In the Layout section, in the Size list, select Digital.

5. In the Render section, set the resolution and other options, as
desired.

6. In the Device section, select Absolute File or Printer.

7. In the File Format section, in the Document Format list, select
Multi-Page, which creates a single PDF file of the selected pages.

Note: Selecting Single Page, which creates a separate PDF file for each page,
is not recommended for digital printers.

8. Select the Include JDF for Digital Printing section.

9. In the Job Settings area:

a. In the Number of Copies box, type the number of copies.
b. In the Job Name box, using standard Prinergy placeholders, type

the name of the job that is sent from Prinergy to the digital
printer.

The default, %job%, displays the job name as specified in
Prinergy.

10. In the Device Selection area:

a. In the Select a device type list, select a type of digital printer.
b. In the Send Files to Printer using area, select Network Copy or

HTTP Protocol.
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c. In the PDF Path box, type the path to the folder where Prinergy
creates the PDF files for the printer to output.

If you are sending these files to a hot folder, this path must not
be the one specified in the JDF Path box.

d. In the PDF File Name box, type the file name of the PDF files
that Prinergy generates.

Use standard Prinergy placeholders, such as %JOBNAME%.
%extension%.

e. In the JDF Path box, type the path to the folder where Prinergy
will create the JDF file.

If you are sending files to a hot folder, this path must be the hot
folder for the digital printer. It cannot be the same folder
specified in the PDF Path box.

f. In the JDF File Name box, type the file name of the JDF file that
Prinergy generates.

Use standard Prinergy placeholders, such as %JOBNAME%.jdf.

11. Complete the following settings, depending on which printer
controller you are using:

With This Printer
Controller

Do This

NexPress In the Select JDF Templates area, click Browse and
select the JDF template file that has been set up to
communicate between Prinergy and the printer.

Creo Spire Color
Server (Xerox)

Creo Production
Stream (HP)

Creo IC-301 (Konica
Minolta)

Set the options in the Media Selection area and the
Media Handling area as desired.

Note: The Creo Spire may have a default template.
Select the template to use the default media options.

Xerox FreeFlow
Print Manager

Set the options in the Media Selection area and the
Media Handling area as desired.

In the Device Specific Settings area, identify the
device name, queue, device type and protocol.

HP SmartStream
Print Server

In the Select JDF Templates area, click Browse and
select the JDF template file that has been set up to
communicate between Prinergy and the printer.

In the Device Specific Settings area, in the Job Spec
box, type the name of a pre-defined workflow.

12. From the File menu, select Save, and save the process template.

Now you can use this process template to start an output process that
prints to a digital printer.
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Outputting to digital printers using the legacy method

This procedure describes an older method of sending files to digital
presses, and it has many limitations compared to the Managed
Connections method.

Requirements:

● A process template that uses the Include JDF for Digital Print
section must be set up for the digital printer.

● If you are submitting a job that has JDF content, the correct JDF
template must be created for the digital device. See the Prinergy
Digital Print Installation and Configuration Guide.

1. Select the pages, page set, or imposition that you want to send to
the digital printer.

2. Start a process using the process template that is appropriate for
the items that you selected:

○ If you selected pages or page sets, use the loose page output
process template that you created for digital printing.

○ If you selected an imposition plan, use the imposition output
process template that you created for digital printing.

Submit to Digital Print dialog box
Use this dialog box to send input files for digital printing. You can send
the input files to the digital press operator's workflow software (Digital
Direct) or directly to a digital press.

Document Name

Type a name for the digital print order that you are creating.
This name appears in Digital Direct's document lists.

Order Quantity

Type or select the number of copies (of the input files) that you
want to print.

Press Settings tab

Digital Press

Select the digital press that you want the document to be
printed on, or select No Target Press to leave the document
untargeted.

Submit to Press Immediately

Select this check box to send the input files directly to a digital
press. The input files will not appear in Digital Direct.
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Note: For the HP SmartStream Production Pro Print Server and the HP
SmartStream Onboard Print Server front ends, you must select the HP
Rip and Print JDF template if you want to send a document to
directly to the active queue for the press (instead of the holding queue).
Alternatively, edit the selected JDF template so that the activation
attribute appears as JDF/@Activation="Active".

Order Info tab

Print By

The format is month/day/year/time. You can type the print-by
date and time or click the Calendar icon or Clock icon to select
the date and time.

Ship by

The format is month/day/year/time. You can type the ship-by
date and time or click the Calendar icon or Clock icon to select
the date and time.

Due By

The format is month/day/year/time. You can type the due-by
date and time or click the Calendar icon or Clock icon to select
the date and time.

Customer

Type the customer name.

Product Name

Type the product name. You may want to include the type of
print run, such as brochure or catalog, in the product
name.

Shipping Address

Type the address to which the job will be delivered. If you are
using a Mac computer, press the Option + Return keys to type
information on the next line.

Postal Code

Type the postal code to which the job will be delivered.

Shipping Country

Type the country to which the job will be delivered.

Shipping Method

Type the shipping method to indicate how the job will be
delivered.
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Publish File process template
Use the Publish File process template to configure files for submission
to digital printers using Managed Connections. At the top of the dialog
box is the Output To list, which you use to select the file format. The
file format selection determines the availability of some options in the
process template. For this reason, you should select an output format
before you set the other options in the process template.

ColorFlow section of the Publish File process template

The ColorFlow section of the publish file process template defines how
Prinergy applies ColorFlow settings during publishing.

When you configure the ColorFlow settings in an output process
template, you select the device, device condition, and plate line, but not
a color setup. The color setup used is the one that was assigned to the
pages when they were refined—that is, either the color setup specified
in the refine process template that was used or the job's default color
setup. The color setup that is used during output processing is the
color setup specified for each page in the Color Setup column in the
Pages pane.

WARNING: Output will fail if the color setup does not match the color setup
assigned during refine, unless the Allow undefined color setup or color setup
mismatch option is enabled.

Snapshot

A ColorFlow snapshot captures the state of the entire color
database, making its elements available to the workflow and
providing a convenient backup. The snapshot feature makes it
unnecessary for you to manually save and name multiple
versions of your color control elements after adjusting them. At
any time, you can easily roll back (revert) to the state of a
previous snapshot in the ColorFlow software. If you roll back to
a previous snapshot, ColorFlow behaves as if changes after that
snapshot never happened.

When you have completed your work in ColorFlow to a certain
level and you are satisfied with the elements in color setups,
you will mark a snapshot as approved. By default in Prinergy
Connect, the currently approved snapshot is used. Only one
snapshot can be in the approved state at any time.

Device Name

An individual occurrence of a physical device that captures or
produces an image. Devices have a type and customer-
specified properties, such as a name and location in the plant.
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Because the declaration of a device does not include its
operating conditions—such as ink selection, type of screening,
and paper—you cannot measure the color response of a device
on its own.

Device Condition

A combination of a device and the operating conditions in
which the device captures or produces an image. A device
condition has a known color response. Device conditions can be
divided into groups such as print conditions (press and proofer
devices), capture conditions (scanner and camera devices), and
reference print conditions (industry specifications). A device
condition can include more than one device. If all the devices
are the same device type, they use the same consumables and
operational settings, and they can be calibrated to yield the
same color response.

Plate Line

You establish the behavior of a particular plate, screening, and
plating line by plating a tint ramp, manually measuring the
resulting dot area on the plate, and entering the values in the
Plate Setups dialog box in the ColorFlow software.

A ColorFlow plate line is associated with only one plate setup.
In your shop, you may use a platesetter and chemistry to
process several different screenings. To model this, in
ColorFlow, create similar plate lines in the other plate setups.
You can name them to match the equipment in your plant. You
may want to create several plate lines to indicate when
chemistry changes occur. For example, if you routinely change
solutions on Mondays, you might create different ColorFlow
plate lines for Monday, Wednesday, and Friday.

ColorConvert section of the Publish File process template

This process template section defines how Prinergy handles color
converting during publishing.

JTP

Select the job ticket processor (JTP) to use for color conversion.

You set up JTPs using Prinergy Administrator.
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Match Colors

Match Colors in Page Content

Enables the Color Matcher to match hues in the page content
for proofing. In other words, it enables color matching as it was
done in Prinergy 1.1 (as opposed to using the Color Matcher to
affect the L*a*b* spot color recipes).

Select this check box to enable this feature; clear the check box
to disable this feature.

When you enable this feature, you can set the Assumed Source
or DeviceLink Profile option.

Assumed Source or DeviceLink Profile

Select Exactly as Applied During Refining to use the same
profile that was used during the refine process. If the file was
not color converted during refining, or the profile is missing, an
error is displayed.

Select As Defined Below, if Not Set in Refining to use the same
profile that was used during the refine process, if the file was
color converted during refining. If the file was not color
converted during refining, the profile defined in the Input
Device Conditions box will be used.

Select Exactly as Defined Below to use the profile selected in
the Input Device Conditions box.

Source or DeviceLink Profile

Available when Assumed Source or DeviceLink Profile is set to
As Defined Below, if not set in Refining or Exactly as Defined
Below.

From the list, select Browse to locate the appropriate profile file.

Rendering Intent

Select Relative Colorimetric if the proofing paper is similar to
the paper that will be used during final output.

Select Absolute Colorimetric to simulate the color of the paper
that will be used during final output.

Select PDF to use the rendering intent specified in the PDF file
when output by the creative software during final output.

Select Perceptual to use rendering that uses gamut
compression and produces less saturated colors during final
output.

Digital printers 679



Select Saturation to make sure colors are represented in a way
that preserves or emphasizes saturation during final output.

Retain CMYK Black

Preserves black in images and graphics that are defined in
CMYK or RGB color space. For ICC-based color matching
engines, CMYK images and graphics get transformed from
CMYK to L*a*b* and back to CMYK color in order to perform
color matching. In going from CMYK (four components) to
L*a*b* (three components) and back again, the black (K)
channel separation information (UCR/GCR) has in the past
been destroyed. Selecting this check box instructs the Color
Matcher to preserve the black generation information from the
source color space. As a result, the amount of black relative to
CMY in the images and graphics stays about the same. The
purpose of this feature is to help preserve the visual weight of
images and graphics.

Note: When you enable this feature, Color Matcher requires some
additional processing time because of the extra calculations involved.

Overprint Handling (CPU Intensive)

(See About overprint handling on page 257)

Select to prevent overprinting objects from generating
unintended knockouts.

If you are converting spots to process for a proof, or if you are
color-matching one CMYK space to another CMYK space for a
proof, you probably need to apply overprint handling, even if
you applied it during refine.

To use overprint handling, you must:

1. In the ColorConvert section, select:

● The Color Matcher JTP
● The Match Colors in Page Content check box
● The Overprint Handling check box

2. Choose between raster and vector overprint handling in the
Methods list.

Note: The raster option is available only when Shades=256 is
selected in the Render section of the process template.

Method

Choose to use vector or raster overprint handling for this output
process.
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Select Raster when outputting to low-resolution contone
proofers (for example, Veris digital proofer or Matchprint Inkjet
proofer).

Note: To use raster overprint handling, you must select, in the Render
section of the process template, Shades=256.

Additional factors to consider:

● Raster overprint handling can be applied only to continuous
tone data

● Raster overprint handling occurs after the RIP
● Raster processing time increases exponentially as the

resolution increases
● Raster overprint handling eliminates all overprints

Select Vector when outputting to halftone (screen) proofers
(for example, the Spectrum device), or to high-resolution
contone proofers.

Additional factors to consider:

● Vector overprint handling occurs before the RIP
● Depending on the complexity of the file, vector overprint

handling could take longer than raster overprint handling.
● Vector overprint handling does not eliminate all overprints.

In objects where overprinting does not have an effect on the
output, the objects retain an overprint status. For example, if
you set black to overprint, but one black object is not placed
on top of another object, this black object is, after overprint
handling, still an overprinting object.

Process CEPS Data

Select this check box to enable spot color mapping and color
matching of CEPS data.

For further information, see the CEPS Conversion Section and
the Normalize Section of the Refine Process Template.

Process Marks

Select this check box when you want to apply color
management to your marks file. Depending on the type of mark,
it may be necessary to enable Overprint Handling to
appropriately convert the mark and apply the necessary color
transformation.

Note: When Process Marks is checked, both sheet marks and page
marks are color managed.
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Color match 1-bit images

Select this check box to color match 1-bit images. One-bit
images are images that represent two tones, typically black and
white. The pixel is either a 0 or a 1 value. Examples are copydot
images.

Note: This feature will convert 1-bit images to 8-bit images. This causes
pages to become larger and to render more slowly. Turn off this feature if
you do not require color matching of 1-bit images, or if the feature causes
unacceptable performance degradation. (For example, copydot files take
a very long time to refine and render.)

This feature is available when Match Colors in Page Content is
selected.

Proof Process (Destination) Profile

Enables the ICC profile for a proofing device. The ICC profile
characterizes the way the proofing device prints.

Enable this feature by selecting a profile in the Process
(Destination) Profile box. Leave this box blank to disable the
feature.

Source of Color Recipes

Extract Recipe from the File

Select to use the color recipes embedded in the file.

Lookup Recipe in Color Database

Select to use the color libraries selected in this process
template.

Color Libraries

Selectable and Selected

From the Selectable list, select the color libraries that you want
Prinergy to search for color recipes, and click Add.

Arrange the color libraries in the Selected box in the order
(descending) that you want them to be searched. Use the Move
Up and Move Down buttons.

Note: Ensure that you select color libraries with color spaces that are
compatible with the Final Output Process Profile box of the Spot Color
Handling section of the refine process template.

682 Chapter 12—Outputs



Use Recipe from File if not found in Color Database

Select this check box to use color recipes embedded in the file if
Prinergy does not find the colors in the selected color libraries.

Render section of the Publish File process template

This process template section determines the output resolution and
how the system handles spot colors during publishing.

JTP

Select the job ticket processor (JTP) to use for rendering.

Note: You set up JTPs using Prinergy Administrator.

Device Resolutions

This list is available when an output device format is selected in
the Output To list.

Select a resolution for the selected device in the list.

Resolution X

Available when the Device Resolutions box is unavailable.

Type a resolution value.

Resolution Y

Available when the Device Resolutions box is unavailable and
mixed resolution values are allowed for the output format
selected in the Output To list.

Type a resolution value.

Do Separations

Available when the output format selected in the Output To list
supports separated output and DeviceCMYK is selected in the
Color Model options.

Select if you want Prinergy to output separations. Clear this
check box if you want Prinergy to output a single composite file.

Spot Color Handling

Determines how spot colors should be handled.

The list of values varies, depending on the output format
selected from the Output To list.

● Select Convert to process to convert spot colors to process
colors.

Render section of the Publish File process template 683



Note: When Convert to process is selected, Vector
Overprint Handling (in the ColorConvert section) is
automatically turned on to ensure the correct appearance of
any overprinting spot colors.

● Select Output separately to preserve spot colors on output.
● Select Don't output to suppress output of spot colors.

Always Use Color Combiner to Convert Spots

This check box is available when Output Separations Handling
is set to Convert separations to process.

If the input files contain overprinted spot colors, the Color
Combiner, which is a plug-in to the renderer, will combine the
layers and output the overprinted colors correctly.

When this check box is cleared, the renderer handles the
conversion of spot colors to process colors if the following
conditions exist:

● Input files are composite.
● All spot colors are set to opaque in the color database. (If a

spot color is not in the color database, opaque is assumed.)

If the above conditions are not met, the Color Combiner will be
used, even if the Always Use Color Combiner to Convert Spots
check box is cleared.

We recommend that you always select this check box.

See About Color Combiner on page 805.

Dielines Overprint Other Content

This check box is cleared and unavailable if the Do Separations
check box is cleared and unavailable.

Select this check box to specify whether die lines overprint
other content. Clear this check box if you do not want die lines
to overprint other content.

The Dielines Overprint Other Content check box is available for
the following outputs:

● DCS Raster
● Kodak Approval TIFF
● LQS TIFF
● VPS
● Windows Bitmap
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Anti-Aliasing

Select this check box to enable anti-aliasing, and then in the at
Ratio list, specify a ratio for anti-aliasing.

Anti-aliasing is a technique of improving the appearance of
output by minimizing the "stair step" effect on rasterized
output. It does so by rendering to a higher resolution than the
intended output, and then downsampling to the intended
output. This generates "averaged" pixels which softens the
"stair step" effect on low-resolution output. The ratio value for
anti-aliasing refers to the factor used to determine the
intermediate resolution. A higher ratio results in higher quality,
but can have an effect on output speed. For example, if the
output is a 300 DPI 8-bit TIFF, and the anti-alias ratio is 4,
Prinergy will render an intermediate output at 1200 DPI (4 x
300 DPI), and then downsample to the user-requested 300
DPI. Anti-aliasing is only available for 8-bit (256 shade) output.

Fail if font problems detected

Select this check box to fail the output process if a file has
missing fonts.

Note: This feature is not available for vector outputs (PDF, PS2, PS3, EPS,
DCS Vector, PDF/X-1a, PDF/X-3, CT/LW, and DELTA).

Ignore Embedded Fonts in Marks Files

Select this check box if you want Prinergy to ignore embedded
fonts in a marks file and to look for the fonts in the system
fonts folder.

Important: You must install the fonts in %ServerName%\%AraxiHome
%\AdobeExtreme\bin\fonts, or the output will fail.

Convert Text to Paths

This check box converts fonts to outlines before a file is RIPed.

This option was added in Prinergy 3.0 when the CPSI 3016 RIP
was included with Prinergy. This option helped situations where
the 3016 RIP failed to process the fonts on certain jobs.

This option has limited usefulness now, but is included as a
potential workaround in rare cases where fonts are not
rendered correctly by the RIP. It is not recommended that you
enable this on on a permanent basis. When using this option for
specific jobs, it is recommended that you ensure that both
proofs and plates are output with this option.
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Note that when you select the Convert Text to Paths check box,
you will have text appear fatter on low-resolution proof output.
You can overcome this appearance problem by either:

● Rendering to a higher resolution, if rendering to 1-bit output,
such as Virtual Proofing System

● Using anti-aliasing, if rendering to contone output

Note: This check box is only available for raster output formats
(.VPS, .TIFF, and so on).

Overlay Versioned Content

This check box applies to Layered PDF Versioning. For
information, see the Prinergy Layered PDF Versioning User Guide.

Versioning Proof Mapping Color

This box applies to Layered PDF Versioning. For information,
see the Prinergy Layered PDF Versioning User Guide.

File Format section of the Publish File process template

This process template section identifies the format and compression
settings of the output files.

Include Images as

If printing to PDF, select Original to output the original images
in the output file.

Select Low Resolution to output low-resolution versions of the
images in the output file.

Compression

(See About outputting to a file on page 661)

The compression options that are available vary depending on
the output format selected in the Output To list at the top of
the process template. The following compression options are
available:

● None—Select if you do not want to compress files
● CCITTG3—Not available if outputting to a non-screened

format
● CCITTG4—Not available if outputting to a non-screened

format
● LZW
● RLE
● ZIP—Select if you use Kodak Staccato screening software
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Note: Compression methods CCITTG3 and CCITTG4 are unavailable if
the Always use Color Combiner to Convert Spots check box is selected
in the Render section of the process template or if any Staccato
screening system is selected in the Screen System box in the Calibration
& Screening section.

Quality

The quality control option is available only if the Output To list
is set to JPEG.

Prinergy provides five JPEG compression quality options
ranging from maximum quality (the least compression and the
smallest loss of data) to minimum quality (the most
compression and the greatest loss of data).

● Maximum
● High
● Medium
● Low
● Minimum

The lower the quality of JPEG compression, the smaller the file
size, but the greater the chance of noticeable blockiness in
certain areas of the image. You should experiment with JPEG
compression levels to see what amount of image degradation is
acceptable for your purposes.

Vector Output Options

Render Shadings

Select to render PostScript 3 vector objects with Level 3 smooth
shades to produce rasterized contone objects in order to meet
the PostScript Level 2 standard. Target workflows may process
rasterized objects faster than vector ones, but there may be
some quality degradation for subtle shadings that extend over
long distances.

Specify a resolution for the rendered shadings in the at
Resolution box.

Available when DCS, PS2, PS3, or PDF is selected in the Output
To list.

Font Outlining

Select to replace all text objects with vector objects in output
pages.

This is available to DCS, PDF, and separated PostScript vector
output formats. It is useful for eliminating font formats that
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certain RIPs may not be able to process. Text output in this way
cannot be edited and when previewed in Adobe Acrobat, will
look bolder than the original text due to loss of font hinting for
low-resolution monitors.

Delete Traps

Select to remove any Prinergy-generated traps from PDF,
PostScript Level 2, and DCS-2 output files.

Trapping-generated overprints remain in the files.

Apply Geometry

Select to apply geometry settings to PDF, PostScript Level 2,
and DCS-2 output files.

You can set the geometry for a page (offset scale, orientation)
in the Set Page Geometry dialog box.

If this check box is selected, the geometry is applied to the
output file. To access the Set Page Geometry dialog box, from
the Edit menu, select Set Page Geometry.

Simulate overprints (CMYK only)

Select to replace overprint intersections with an opaque object.

This creates a page that maintains its integrity on output, even
if a downstream publisher or printer configures their workflow
to override overprints.

Preserve PDF Layers

Applies to the Layered PDF Versioning feature. For more
information, see the Layered PDF Versioning user guide.

Send PostScript duplexing commands

Select to print on both sides of the media. Assuming a portrait
sheet orientation, select Turn print pages side to side by
flipping on the long edge. Select Tumble to print both sides by
flipping on the short edge.

This option simply adds the duplex command to the PostScript
output. The consuming device may not support this command.

Output Intent

Use this area to specify an ICC profile or named print condition
in the Output Intents section of the PDF/X file that you are
generating.

A named print condition is a documented printing situation with
a defined relationship between input data and the colorimetry
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of the printed image. Typically, named print conditions are
registered with an organization such as the ICC.

Do one of the following:

● To specify an ICC profile, select the Profile check box and
specify the path of a profile.

● To specify a named print condition, select the Name check
box and select a print condition from the list.

This area is available only when a PDF/X format is selected in
the Output To list at the top of the process template.

Marks section of the Publish File process template

This process tempalte section determines how marks are handled.

Unit Used for Variable Marks

Select the unit you want to use to measure variable marks—
inch, cm (centimeter), mm (millimeter), or pts (points).

Default Marks Font

Here's an example of how you could use the feature:

1. Create a Preps imposition file that includes a variable mark,
such as $[PageName].

2. In Prinergy, in the Default Marks Font box in the Marks
section of the imposition output process template, type the
exact name of the double-byte font that can be used in case
the variable mark's original font was not a double-byte font.
The font must reside either in a Prinergy-aware font folder or
in the job's font search path.

3. Submit the imposition file to Prinergy.

If the imposition file contains a page name with double-byte
fonts, Prinergy outputs the file with these characters.

Marks

About marks
Marks are text or images that are printed in addition to page content,
on the press sheet and/or output media. A mark usually provides
information about the output. For example, a mark can be an exposure
bar or the job name. Marks are also often used for customer approval
tags.
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Page Marks and Sheet Marks

Any mark can be used as a page mark or a sheet mark. However a page
mark should relate to page-specific information because it is placed on
every page. A sheet mark should contain information relevant to the
whole sheet or media because it is placed on the media once. You can
place page marks on loose page output, and sheet marks on all output
types.

Figure 6: Example of a page mark

Figure 7: Example of a sheet mark

Adding marks in Prinergy

You can add marks to your Prinergy output in the following ways:

● Using an imposition marks file—Add marks to the imposition using
imposition software, and then import the imposition and its marks
file into Prinergy.

● Using the process template settings—Specify the positioning and
file path for a mark in the output process template.

Distilling marks for Prinergy

Marks files in Prinergy must be distilled using the recommended
settings. If using an imposition marks file, you can set Prinergy to distill
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(normalize) the marks file on import. If using the process template
settings, you must manually distill the marks file.

Methods of adding marks files

You can add marks to your Prinergy output by using an imposition
marks file or by using a process template.

Adding Marks Using an Imposition Marks File

An imposition marks file is a marks file created from imposition
software such as Preps. They are used to add marks to imposition
output and final output.

The benefit of this method is that you can place marks more precisely,
and the marks file can be automatically imported and distilled when
you import the imposition.

Adding marks using a process template

Use a process template to add marks to output when you want to
avoid using imposition software to add marks.

Create the marks in drawing software, then distill and import them into
the output process template. The output process templates allow you
to specify the position of the mark. Using this method you avoid having
to add the marks in the imposition software and reprocess the imposed
marks file.

If you want to place a mark on loose page output you must use this
method of adding a mark.

Important: When placing sheet marks on final output, be sure you account for the
tail and lead clamps and be sure you know where the press sheet contacts the
plate.

Sheet marks on final output

Adding a sheet marks file to the output process template should be
done with great care. Before placing a sheet mark, you must know:

● The press sheet size and plate size
● The distance between the plate edge and press sheet edge
● The size of the nonimageable area under the lead and tail clamps
● Where you want the sheet mark to appear

Do not position sheet marks under the plate clamps. If you position the
sheet mark under the clamps, some or all of the sheet mark will not be
imaged.

Sheet marks are set to overprint. If you position the sheet mark over an
object, the sheet mark will overprint the object.
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Use the Virtual Proofing System software to check the sheet mark
placement. Alternatively, you can output to a low-resolution TIFF file
and view the sheet mark placement in the Copydot Toolkit software.

Calculating the at distance value on final output

When placing sheet marks on final output, carefully calculate the value
in the at Distance box.

● If you want a sheet mark on the plate only, type the distance
between the edge of the plate and the sheet mark (shown as A in
the following diagram).

● If you want a sheet mark on the press sheet, first calculate the
distance between the edge of the plate and the press sheet (A) and
the distance between the press sheet and then calculate the sheet
mark (B). In the at Distance box, type the sum of A + B.

In either case, if you are placing a sheet mark on the top or bottom
edges, the distance (A) must include the size of the nonimageable area
under the lead or tail clamp.

Recommended Acrobat Distiller 8, 9, and X settings for marks

Use the following settings when distilling page marks sheet marks, and
Preps marks files to PDF files for Prinergy input:

General tab

File Options

Compatibility Acrobat 5.0 (PDF 1.4 and later)

Use this setting if you want
transparent objects to be handled
natively without flattening during the
refine process.

Object Level Compression Off

Auto-Rotate Pages Off

Binding Left

Resolution 2400 dpi
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All Pages Select

Embed thumbnails Select

Optimize for fast web view Clear

Default Page Size

Width 8.5
Height 11.0
Units Inches

Images tab

Color Images

Downsample Bicubic Downsampling to 300 pixels
per inch for images above 450 pixels
per inch

Compression ZIP

Image Quality High

Grayscale Images

Downsample Bicubic Downsampling to 300 pixels
per inch for images above 450 pixels
per inch

Compression ZIP

Image Quality High

Monochrome Images

Downsample Off

Compression CCITT Group 4

Anti-Alias to gray Off

Fonts tab

Embed all fonts Select

Subset embedded fonts when percent
of characters used is less than

0 (zero)

When embedding fails Cancel Job

Embedding: Always Embed Base 14 Fonts

Color tab

Adobe Color Settings
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Settings File None

Color Management Policies Leave Color Unchanged

Document Rendering Intent Preserve

Working Spaces: Gray, RGB, CMYK not applicable

Device-Dependent Data

Preserve under color removal and
black generation settings

Select

When transfer functions are found Preserve

Preserve halftone information Select

Advanced tab

Options

Allow PostScript file to override Adobe
PDF settings

Clear

Allow PostScript XObjects Clear

Convert gradients to smooth shades Select

Create Job Definition Format (JDF) file Clear

Preserve Level 2 copypage semantics Select

Preserve overprint settings Select

Overprint default is non zero
overprinting

Select

Save Adobe PDF settings inside PDF
file

Clear

Save original JPEG images in PDF if
possible

Clear

Save Portable Job Ticket inside PDF
file

Clear

Use Prologue.ps and Epilogue.ps Clear

Document Structuring Conventions (DSC)

Process DSC Comments Select

Log DSC Warnings Clear

Preserve EPS information from DSC Select

Preserve OPI comments Select

Preserve document information from
DSC

Select
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Resize page and center artwork for
EPS files

Select

Sheet marks options explained
This topic explains the three options in output process templates that
position sheet marks: Locate Sheet Marks Adjacent to list, at Distance
box, and Justified list.

Using these three options, you can place a sheet mark at various
positions on a press sheet or plate. Before making your selection, you
must know where you want the sheet mark to appear, the size of your
press sheet and plate, and the location of the lead and tail clamps. This
is particularly important when placing the sheet mark on a plate.

Important: Use the Virtual Proofing System software to check the sheet mark
placement. Alternatively, you can output to a low-resolution TIFF file and view the
sheet mark placement in the Copydot Toolkit software.

Locate Sheet Marks Adjacent to

The Locate Sheet Marks Adjacent to list allows you to place the sheet
mark on the left, right, bottom, or top edges of the plate. The sheet
mark rotates when positioned on the right and left edges, but not on
the top or bottom edges.

Right edge Left edge Top edge

at distance

The at Distance box determines how far to position the sheet mark
from the edge that you selected in the Locate Sheet Marks Adjacent to
list. The distance is shown as A in the following diagram.
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Bottom edge

Important: When placing the sheet mark on final output, carefully calculate the at
Distance value. Otherwise, the sheet mark may print beyond the edge of the press
sheet.

Justified

Selecting Right or Left in the Justified list places a sheet mark flush
against the edge of the plate, with no border or spacing. In some cases,
you may inadvertently place the sheet mark in the nonimageable area
under the lead or tail clamp.

Top edge, left justified Left edge, right justified

Putting it all together

These diagrams (not to scale) show possible combinations of the
Locate Sheet Marks Adjacent to and Justified options. Assume that
the at Distance value is 6.3 mm (0.25 inches) in all cases.

The following diagram shows sheet marks placed on a plate.

Note: In some combinations, part of the sheet mark is located in the nonimageable
area under the lead or tail clamp.
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The following diagram shows sheet marks placed on a press sheet.

Overview of adding marks

1. Create the source PostScript for the marks PDF files in any software
that allows registration color (for example, QuarkXPress,
PageMaker) so it appears on all separations.

2. Once you are satisfied with your file, create a fat, composite
PostScript file containing embedded fonts.

3. Perform the following as appropriate:

If you want
to add marks
using...

Then...

An
imposition
marks file

a. Add the marks to your imposition using imposition
software such as Preps and then import the imposition
(and marks file).

A process
template

a. Configure an Acrobat Distiller job option file to distill
PostScript files to PDF files for Prinergy. This task must
be performed only once after installing Prinergy
Workshop.

b. Use Acrobat Distiller to distill the PostScript to create
PDF files of the marks file.

c. Create an output process template specifying the marks
file and its positioning.

d. Apply the output process template to the PDF files in a
job. The system will add the marks file from the process
template to the job.
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Importing imposition marks files

1. Add the marks in an imposition plan using imposition software such
as Preps.
The imposition software creates a .pjtf file and a .eps file. The .eps
file is the marks file.

2. Ensure that both files are in the same folder before importing into
Prinergy.

3. Set the ImportAll process template for importing the imposition
plan and marks file.

The ImportAll process template is automatically used when
imposition plans and marks files are imported.

a. Complete the Normalize for PostScript Marks Files section of
the ImportAll process template.

If you want the import process not to fail if any images are
missing, in the Images area, clear the Fail on Missing Images
check box.

b. If you want to compress images to reduce the size of the marks
file, also complete the Optimize for PostScript Marks Files
section. In the Color Images area, in the Compression box,
select ZIP (lossless). In the Grayscale Images area, in the
Compression box, select ZIP (lossless).

4. Select both the imposition plan and the marks file, and import them
into Prinergy.

Configuring Distiller for marks

Create an Acrobat Distiller job option to distill PostScript files to PDF
for Prinergy. This configuration task must be performed only once after
installing Prinergy Workshop.

For more information, see the Acrobat Distiller documentation.

1. Open Acrobat Distiller.

2. Click Settings > Edit Adobe PDF Options.

3. In the dialog box, set the options as recommended for Acrobat
Distiller.

4. Click Save As, and in the File Name box, type an appropriate name
such as Prinergy Marks.

Distilling PostScript marks files

Ensure that you have configured a Acrobat Distiller job option file to
distill PostScript files to PDF files for Prinergy.
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Note: If your customers have Acrobat Distiller, you can give them the
recommended settings file to use on their own workstations. Distribute the
following file and have the customer place it in the same location: Adobe
Acrobat\Distiller\Settings\Prinergy Pages.joboptions.

For more information, see the Acrobat Distiller documentation.

1. Open Acrobat Distiller.

2. In the Default Settings box, select Prinergy Marks to use the
recommended Prinergy settings.

You can view the settings by selecting Edit Adobe PDF Setting
from the Settings menu. Click OK or Cancel to close the Adobe
PDF Settings dialog box.

3. Drag files to be distilled onto the Acrobat Distiller dialog box.

Setting a process template to use marks file

1. In any window, from the Tools menu, select Process Template
Editor.

2. Open an output process template (loose page output, imposition
output, or final output process template) .

3. Open the Marks section.

4. To place a sheet mark, click Browse beside the Sheet Marks box to
locate the sheet marks PDF file.

Tip: If you are typing the path name directly in the box, use the variable
%system% as part of the path name to denote the %AraxiHome%
\CreoAraxi folder on your Prinergy system.

Example:

Entered in
Sheet Mark
box

%system%\data\MarkSets\Sheet Marks\B&W
Proofers\Composite Proofs\SheetMark-BW-
Comp.pdf

Resulting
path name

%AraxiHome%\CreoAraxi\data\MarkSets\Sheet
Marks\B&W Proofers\Composite Proofs
\SheetMark-BW-Comp.pdf

5. Select the Calibrate check box to apply calibration curves to the
marks.
The calibration curve is set in the Calibration Curve list in the
Calibration and Screening section of the output process template.

6. From the Locate Sheet Marks Adjacent to box, select a location for
the sheet marks, and then specify the distance in the at Distance
box.

7. If you are setting the loose page process template and you want to
set a page mark, click Browse beside the Page Marks box to locate
the page marks PDF.
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8. Select the Calibrate check box to apply calibration curves to the
masks.

9. From the Locate Page Marks Adjacent to box, select a location for
the page marks, and then specify the distance.

10. Save and close the process template.

Marks options in the process template

For general information on the marks options, see the Layout section of
the output process template.

See also:
About recommended Acrobat Distiller 8, 9, and X settings for
content on page 165
Layout section of the Loose Page Output process template
on page 445
Layout section of the Imposition Output process template on page 501
Layout section of the Final Output process template on page 556
Calculating the at distance value on final output on page 692
Sheet marks options explained on page 695

Variable marks

About variable marks

When you send jobs to an output device, you may want to include
information identifying that output, such as the name of the color
separation, job name, and output date. Variable marks, also known as
marks or slug lines, allow this information to be gathered at the time of
output.

When an output process template is executed, variable marks are
replaced with the correct information.

You can add variable marks to your output either using an imposition
marks file or using the process template settings.

List of variable marks

Variable marks template format

Use the following format: $[tag,<n1, n2>]

where:

tag is the name of a variable mark, for example Job or Color.

n1 is an optional element and represents the index number, a number
that begins at 0 for the left-most character and increases sequentially
for each character to the right. For example, if your text reads,

700 Chapter 12—Outputs



"Prinergy" then "P" is index number 0, "r" is index number 1, "i" is index
number 2, and so on.

n2 is an optional element and represents the maximum number of
characters for the variable mark.

Examples: If the text is "TestJob", the variable mark $[Jobname<2,4>]
displays stJo. Alternatively, if you use $[Jobname<3,-3>] the variable
mark displays est.

If the file or job name has % in it, use %% in the tag to get % in the
name.

Notes:

● For variable marks that are based on the page closest to the PDF file containing
the variable mark, this is measured from the center of the page or sheet mark's
bounding box.

● You can also use text-file-based marks for impositions which retrieve text from
a text file.

Optional parameters

For some variable marks, you can add these parameters:

This
parameter

Can be used with these
variable marks

To do this

_block $[Angle]

$[Color]

$[Colour]

Use this parameter to print a swatch or block of color
before the color name.

For example, if you use $[color_block], a block of color is
printed before the color name. If the color name was
"black" a black swatch of color would appear before the
color name "black".
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This
parameter

Can be used with these
variable marks

To do this

_offset $[Angle]

$[CalCurve]

$[Color]

$[Colour]

$[FMPattern]

$[MappedPrintingColors]

$[PageColor]

$[PageColour]

$[PlateID]

$[PrintingOrder]

$[WebGrowthExpansionX]

$[WGEX]

$[WebGrowthExpansionY]

$[WGEY]

$[WebGrowthTowerID]

$[WGTID]

Use _offset to introduce space between printed
information.

For example, if you use $[color_offset], and your job
contains Cyan, Magenta, and Black, on your output you will
see "Cyan Magenta Black" in their own colors. If you do not
use _offset, "Cyan Magenta Black" would be printed on top
of each other (in their own colors).

_replace Any mark Use this parameter to allow you to shorten long color
names.

For example, to shorten the color mark "PANTONE-1234"
to "PMS-1234" the color mark is $
[color_replace(PANTONE,PMS)]. To shorten the color
mark "PANTONE-1234" to "1234" the color mark is $
[color_replace(PANTONE-,)].

List of variable marks

The following table lists, in alphabetical order, all valid variable marks
and the type of information they represent. Variable marks are not
case-sensitive.

Variable Mark Mark
Type

Information Represented

$[Angle] Page Sheet The screening angle (after color mapping) for each plate.
This mark applies to AM screening only.

You can also use the "offset" parameter with this mark to
print different text in each separation.

$[CalCurve] Sheet The name of the Harmony calibration curve used to
calibrate the output device.
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Variable Mark Mark
Type

Information Represented

$[Color]

$[Colour]

Page Sheet The proper color name of an individual color separation.
In making a composite proof, it is replaced by the word
composite.

You can also use the "offset" parameter with this mark to
print different text in each separation.

$[ColorSetupName] Page

Sheet

This variable mark shows the ColorFlow color setup that
was selected in the refine to PDF process template. For
more information, see the ColorFlow User Guide.

$[ColorsOnPage]

$[ColoursOnPage]

Page This page mark is replaced with a list of all colors that
were on a given page before any color mapping was
done.

It also indicates the layer to which the colors are
assigned if additional layers are present for the page.

The page for which colors are printed is the closest
placed object to the mark.

This page mark can be used for separated or composite
files.

The output is in the following format:

Layer 1: <color1>, <color2>, <color3> ... Layer 2:
<color1>, ...

The Layer 2 is optional; it prints only if additional layers
(versions) are present.

Note: Make sure the font used for the page mark is small
enough so that all colors will fit in the list.
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Variable Mark Mark
Type

Information Represented

$[ColorsOnSurface] Sheet This sheet mark is replaced on output with all of the color
names that are present on a surface.

If the Color Combiner is turned ON in the process
template, the colors that are listed on the surface are the
output colors supported on the device.

Example: If the proofing device is CMYK only and the
colors on the PDF pages contain spot colors, the Color
Combiner is automatically turned ON in the process
template to map the spots to CMYK. On output, the
"ColorsOnSurface" mark will list Cyan Magenta Yellow
Black.

If the Color Combiner is turned OFF in the process
template, the colors that are listed on the surface are all
colors for all the pages on the surface.

The output is in the following format:

Layer 1 <color1><color2><color3><color4> Layer 2
<color1><color2><color3><color4>

The Layer 2 is optional. It is printed only if additional
layers (versions) are present.

This mark can be used for separated or composite files.

$[Compound] Page Sheet This mark enables you to print more than one variable
mark on a single line for page or sheet marks.

If you want a mark that has the job name and color on
the same line, use the following text string:

$[compound_JobName:_%jobname%_color%color%].
For example, the output would be JobName:5762
color:Cyan.

If you want the colors to be offset, use the following text
string: $[compound_offset_%color%].

If you want to use the date sub-variables with this mark,
use this text string: $[compound_%date_\%b-\%d-\%Y
%].

When using this mark to separate the different marks
that you want printed on the same line, you must use
%mark% instead of $[mark], and an underscore instead
of a space.
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Variable Mark Mark
Type

Information Represented

Custom Field Marks:

$[CustomFieldJob]

$[CustomFieldPageset], $[CFPS]

$[CustomFieldPage], $[CFPG]

$[CustomFieldPagePosition], $
[CFPGPOS]

$[CustomFieldImposition], $
[CFIMPO]

$[CustomFieldSignature], $[CFSIG]

$[CustomFieldSurface], $[CFSRF]

$[CustomFieldSeparation], $[CFSEP]

Page You can create custom fields for jobs or for elements
within a job, so that you can track unique information.

You can use custom fields to create variable marks and
custom file naming. For example, if you have created
custom fields at the job level or job element level (page,
page set, imposition, signature, surface, and separation),
you can use them to create variable marks and custom
file naming.

To create a custom field mark, you need to specify the
name of the custom field that you created in the custom
field mark that you want to print. Custom field marks
take the name that you define for the custom field as a
parameter. See the following two examples:

● For the mark $[CustomFieldSurface_WebNumber],
"WebNumber" is the name that you defined for a
surface-level custom field, and the value of the field
would print on output, for example, 2.

● For the mark $[CustomFieldJob_Salesperson],
"Salesperson" is the name that you defined for a job-
level custom field, and the value of the field would
print on output, for example, Bob.

$[Datamatrix_A_#] Sheet This mark prints the Datamatrix barcode, which encodes
the job and signature names, where # specifies the size
of the barcode in points. The lower-left corner of the text
mark coincides with the lower-left corner of the barcode.
(The barcode is always square.)

$[Datamatrix_B_#] Sheet This mark prints the Datamatrix barcode which encodes
the front/back and separation information, where #
specifies the size of the barcode in points. The lower-left
corner of the text mark coincides with the lower-left
corner of the barcode. (The barcode is always square.)

$[Date] Sheet See $[OutputDate].

$[Device] Sheet For output to a proofer, this mark contains the name of
the proofer.

For output to a file, such as a virtual proof, this mark
contains the name of the file.

For final output to plate, this mark does not show the
device name. If you want to show the device name in the
final output, name the process template with the device
name and use $[ProcessPlanName], or use $
[DeviceSerialNumber].

$[DeviceConditionName] Page

Sheet

A ColorFlow device condition name is a combination of a
device and the operating conditions in which the device
captures or produces an image. For more information,
see the ColorFlow User Guide.
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Variable Mark Mark
Type

Information Represented

$[DeviceName] Page

Sheet

A ColorFlow device name is an individual occurrence of a
physical device that captures or produces an image. For
more information, see the ColorFlow User Guide.

$[DeviceSerialNumber] Sheet This mark is intended for GDAPI devices and allows you
to track which plate line a plate came from. If the device
supports serial numbers, this mark prints the serial
number on the plate.

$[DotShape] Sheet The name of the default or override dot shape used to
create the output.

$[FMPattern]

$[FMPattern_offset]

Sheet This mark is replaced on output with the Staccato
pattern number that is used to screen the separation. For
example, Cyan may be 1, Magenta may be 2 and so on.

You can also use the "offset" parameter with this mark to
print different text in each separation.

$[ICCProfile] Page Sheet The name of the ICC profile selected in the process
template, whether the ICC profile is actually used or not.

$[ImpBleedSizeX] Sheet The horizontal bleed size of the imposition.

$[ImpBleedSizeY] Sheet The vertical bleed size of the imposition.

$[ImpPlanName] Sheet The name of the imposition plan used to create the
output.

$[ImpTrimSizeX] Sheet The horizontal trim size of the page position closest to
the mark as defined in the imposition plan.

$[ImpTrimSizeY] Sheet The vertical trim size of the page position closes to the
mark as defined in the imposition plan.

InkEater mark Sheet See Ink eater mark on page 716

$[Jobcode] Sheet A user-assigned code for the job that is meaningful to
you or your customer.

$[Jobname] Sheet The name of the Prinergy job. When you create a job, you
indicate its name in the Create New Job dialog box.

$[LinkedPageNames] Page Sheet This mark is for Layered PDF Versioning (LPV) jobs and
can only be used for composite proofs. This mark lists all
of the names of the linked pages.

For the $[LinkedPageNames], $
[LinkedPageNames_Base], and $
[LinkedPageNames_NotBase] variable marks, you can
append the layer you want in the mark argument.

For example, the variable mark $
[LinkedPageNames_English] replaces the name of the
page contributing English. The variable mark $
[LinkedPageNames_Common] replaces the name of the
page contributing the common layers.
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Variable Mark Mark
Type

Information Represented

$[LinkedPageNames_Base] Page Sheet This mark is for Layered PDF Versioning (LPV) jobs and
can only be used for composite proofs.

This mark replaces only those layer/page name pairs
that are base layers. "Base" is a parameter that can only
be used with this mark. For more information, see the $
[LinkedPageNames] variable mark.

$[Linked Page names_NotBase] Page Sheet This mark replaces only those layer/page name pairs
that are not base layers. "Not Base" is a parameter that
can only be used with this mark. For more information,
see the $[LinkedPageNames] variable mark.

$[MappedPrintingColors]

$[MappedPrintingColours]

Sheet This mark displays the names of colors that were
mapped to other spot or process colors during output.

For example, if you map the spot color "MySpot1" to
black, the $[MappedPrintingColors] mark is replaced
with "MySpot1" on the black plate on output. Nothing
appears on the other plates.

$[MarksFileDate] Sheet Prints out the time of the marks PDF in %D:%M:%Y
format.

$[MarksFileTime] Sheet Prints out the time of the marks PDF in %H:%M:%S
format.

$[Medium] Sheet The Harmony tonal calibration software medium applied
to the output.

$[OutputComment] Page Sheet The value in the Output Comment box on the Start
Process dialog box.

$[OutputDate], $[Date] Sheet The date the output is created (yy-mm-dd). If you use
the $[OutputDate] mark, the format is yy-mm-dd. If you
use the $[Date] mark, the format can be adjusted using
these tags:

● %y for year (two digits)
● %Y for Year (four digits)
● %m for month
● %b for month (3 characters)
● %d date

For example, to create a mark that shows the month, day
and year, the tag could be $[date_%b-%d-%Y] for
Mar-11-2006. The tags are case sensitive and the
underscore after the date in the variable is required.
Separate the tags using colons or dashes. Spaces and
underscores are supported.

$[OutputMonthYear] Sheet Prints the date in %M-%Y format on output.
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Variable Mark Mark
Type

Information Represented

$[OutputTime], $[Time] Sheet The time the output is created (hh:mm:ss). If you use the
$[OutputTime] mark, the format is hh:mm:ss. If you use
the $[Time] mark, the format can be adjusted using
these tags:

● %H for hour
● %M for minute
● %S for second

For example, to create a mark that shows only the hour
and minutes, the tag could be $[time_%H:%M] for 4:15.
The tags are case sensitive and the underscore after the
time in the variable is required. Separate the tags using
colons or dashes. Spaces and underscores are supported.

$[PageColor]

$[PageColour]

Page Prints the colors that exist in the PDF page that is closest
to the variable mark.

For example, if a page contains Cyan, Magenta, and
Black, this mark will display Cyan (in cyan), Magenta (in
magenta), and Black (in black).

$[PageFileDate] Page The date that the PDF page was created. This mark prints
the date on each layer if additional layers are present.

$[PageFileName] Page The name of the PDF page that is closest to the PDF file
containing the variable mark

This mark prints out the page file name used for the top
layer.

$[PageFileTime] Page The time that the PDF page was created. This mark
prints the time on each layer if additional layers are
present.

$[PageName] Page The name of the PDF page that is closest to the PDF file
containing the variable mark.

This mark will print out the page file name used for each
layer if additional layers (versions) are present.

$[PageOffsetX], $[POX] Page The horizontal offset of the page closest to the PDF file
containing the variable mark.

$[PageOffsetY], $[POY] Page The vertical offset of the page closest to the PDF file
containing the variable mark.

$[PagePathName] Page The network path for the page associated with the mark.

For example, if you have a four-page layout and the mark
is closest to Page 3, the mark would show the path for
Page 3.

$[PageOrientation], $[PO] Page The orientation (0°, 90°, 180°, or 270°) of the page
closest to the PDF file containing the variable mark.
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Variable Mark Mark
Type

Information Represented

$[PagePositionName] Page The page position name for the PDF page closest to the
variable mark. Page position names are the identifiers
used to indicate position within a page set.

$[PagePositionNumber], $[PPN] Page The page position number for the PDF page closest to
the variable mark. Page position numbers are the
identifiers used to indicate position within a page set.

$[PageScaleX] Page The horizontal scale of the page closest to the PDF file
containing the variable mark.

$[PageScaleY] Page The vertical scale of the page closest to the PDF file
containing the variable mark.

$[PageSetName] Page The page set prefix followed by an underscore and then
the page set name

$[PageTrimSizeX], $[PageTrimX], $
[PTX]

Page The horizontal trim size of the page closest to the PDF
file containing the variable mark.

$[PageTrimSizeY], $[PageTrimY], $
[PTY]

Page The vertical trim size of the page closest to the PDF file
containing the variable mark.

$[PlateCalCurve] Sheet This mark indicates the plate curve used on output.

$[PlateID] Sheet A unique identification number that is printed on the
plate and can be used to remake the plate using the Plate
Remake tool. (For more information about remaking
plates, see Remaking plates on page 626.)

$[PlateLineName] Page

Sheet

When using ColorFlow, you establish the behavior of a
particular plate, screening, and plating line by plating a
tint ramp, manually measuring the resulting dot area on
the plate, and entering the values in the Plate Setups
dialog box in the ColorFlow software. For more
information, see the ColorFlow User Guide.

$[PositionName] Page See $[PagePositionName].

$[PositionNumber] Page See $[PagePositionNumber].

$[PrintingOrder] Sheet The plate's printing position in the job. For example, if the
printing order is C-M-Y-K, the $[PrintingOrder] mark on
the cyan plate is replaced on output with "1", the mark on
the magenta plate is replaced with "2", and so on.

$[ProcessPlanName]

$[ProcessTemplateName]

Sheet The name of the output process template used to create
the output.

$[ResolutionX], $[RX] Sheet The horizontal resolution of the output closest to the PDF
file containing the variable mark.

$[ResolutionY], $[RY] Sheet The vertical resolution of the output closest to the PDF
file containing the variable mark.

$[RIP] Sheet This mark prints the RIP that was used for output, either
Adobe PDF Print Engine (APPE) or Adobe CPSI.
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Variable Mark Mark
Type

Information Represented

Scaling Factor Marks Page Sheet These marks indicate what scaling factor has been used
on final impositions. These marks indicate what
distortion or scaling factor has been used so that you can
see what percent of flex has been used or if flex has not
been applied in a process template.

● $[ImpRasterScaleX] or $[IRSX]—The horizontal
raster scaling amount applied to the surface.

● $[ImpRasterScaleY] or $[IRSY]—The vertical raster
scaling amount applied to the surface.

● $[ImpVectorScaleX] or $[IVSX]—The horizontal
vector scaling amount applied to the surface.

● $[ImpVectorScaleY] or $[IVSY]—The vertical vector
scaling amount applied to the surface.

$[ScreenRuling], $[SR] Sheet The default or override line screen ruling used for the
output. For AM screening, this refers to the size of the
screen ruling in lines per inch (lpi). For FM screening, this
refers to feature size in microns.

$[ScreenSystem] Sheet The default or override screening system family name
used for the output.

$[Sheet] Sheet The sheet number.

$[Signature], $[SIG] Sheet The signature number.

$[SignatureID] Page Sheet This mark prints the signature ID code on a sheet to
identify which signature the sheet will be used for.

$[SignatureID_<n>] Page Sheet This mark prints the signature ID code specified when a
signature has more than one section assigned to it. The
number <n> after the underscore can be any number up
to the maximum number of sections on a signature.
Example: For $[SignatureID_2], this mark prints the
second code when a signature has two sections assigned
to it.

$[SnapshotNumber] Page

Sheet

A ColorFlow snapshot captures the state of the entire
color database, making its elements available to the
workflow, as well as providing a convenient backup.

$[I2of5Checksum] Page Sheet This mark prints the signature ID code as human
readable characters and appends the checksum digit for
the Interleaved 2 of 5 style of barcode. Kodak has also
developed an EPS mark that contains a custom font that
prints the Signature ID Code as an Interleaved 2 of 5
barcode. This EPS mark is in the Marks folder in the
AraxiPreps share. This EPS can be placed as a
SmartMark in Kodak Preps digital imposition software
and upon output from Prinergy prints a barcode on the
signature (see the Preps digital imposition software
documentation).
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Variable Mark Mark
Type

Information Represented

$[SurfaceID], $[SID] Sheet This mark prints the surface ID of the plate. If the plate is
the front side, "U" is printed. If the plate is the back side,
"L" is printed.

$[SurfaceLetter], $[SL] Sheet The letter identifier for the surface.

For example, a four-surface signature for a dual web
press would be labeled A through D.

$[SurfaceName], $[SN] Sheet The name of the surface-either Front or Back.

$[Time] Sheet See $[OutputTime].

$[UnmappedColorsOnSurface]

$[UnmappedColoursOnSurface]

Sheet Names of colors that were on the surface before the
color combiner was used.

If color combiner is turned on in the process template, $
[ColorsOnSurface] lists the output colors supported on
the device and $[UnmappedColorsOnSurface] lists the
names of all colors on the surface before the Color
Combiner was used.

$[Username] Sheet Identifies the user that ran the output process.

$[VMRResolution] Sheet Indicates the Variable Mainscan Imaging (VMI)
resolution that is added to the VMI dpi box. The dpi box
is located in the Device section of the final output
process template.

$[WebGrowthExpansionX], $[WGEX]

$[WebGrowthExpansionY], $[WGEY]

Sheet These marks indicate the actual web growth distortion
factor on the plate. Use these marks to show the
horizontal or vertical web growth expansion factor that
was used for the separation as specified by "expansion
xpercent" in the XML profile file (with suffix .wpg). Use
these marks to show the horizontal or vertical web
growth expansion factor that was used for the separation
as specified by "expansion xpercent" in the XML profile
file (with suffix .wpg).

$[WebGrowthProfile] Sheet Name of the web growth profile used, if a web growth
profile is selected in the process template.

$[WebGrowthTowerID], $[WGTID] Sheet Shows the tower ID for the separation as specified in the
color tower map file.

$[Workstyle] Sheet This mark is used to indicate an imposition's workstyle,
such as "sheetwise".

Using variable marks

You can add variable or regular marks by following the same process.

1. Type the variable marks in the marks file.

Note: Leave enough space between each variable mark to ensure that the
populated variable marks do not overlap each other, or use the $[compound]
variable mark to print more than one mark on a single line.
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2. Complete the procedures for adding marks as appropriate.

About signature ID codes

Signature ID codes are marks that identify—in alphanumeric or bar
code format—which signature the sheet will be used for. Signature ID
codes, which can include version and section information, are typically
printed on the spine area in bar code format so that automatic binding
machines can read the codes and put the signatures together in the
correct order.

You can set up and place signature ID codes in the following ways:

● Use imposition software, such as Preps, to create and place the
code as a Prinergy variable mark.

● Use the signature ID code in a Prinergy sheet mark or slug line mark.

The signature ID code is applied to an imposition when it is imported
into a Prinergy job. When you create the imposed output, Prinergy
replaces the variable mark, sheet mark, or slug line with the actual code
containing information about that job.

Note: Use naming conventions for your jobs, impositions, and versions so that
signature ID codes are meaningful.

Defining the code syntax

In Administrator, customize the signature ID code syntax to fit the
requirements of your bindery equipment.

You can override the default signature ID code syntax by editing the
import process template, saving it, and then importing the imposition
using the updated Import process template. These changes persist for
subsequent uses of the import process template.

After it has been imported, the only way to alter the syntax is to
reimport the imposition using different settings. In a future release, you
will be able to change the syntax from within Workshop.

For more details, see Signature ID code elements and syntax.

See also:
Signature ID Code Editor dialog box on page 716

712 Chapter 12—Outputs



Overriding default signature ID codes

You can use the Process Template Editor to override the settings in the
default signature ID code syntax that was created in Administrator.

1. In Job Finder or Job Manager, open the import process template
that you want to use to import impositions.

2. In the Signature ID Code area of the import process template, in
the Template box, type the ID code in one line in one of the
following formats:

○ %jobname<n>%%imposition<n>%%version<n>%
%signature<n>%%numsections%
Each tag must be enclosed with a percent sign (%). ID codes can
be a mix of letters and numbers.

n is the number of characters to include, starting from the
beginning (left side) of the name or number. To include
characters from the end (right side) of the name or number, add
a minus sign before the number of characters, for example
%jobname<-2>%.

○ %n+m%
This is a simple incrementing signature ID code that prints a
number (n) on the first signature version and increments it by a
specified number (m) for each subsequent version.

For example, %0000+1% prints 0000 on the first signature and
each subsequent signature version is incremented by 1.

3. In the Number of sections per signatures in one imposition box,
type the total number of sections for each signature.
For example, if you import an imposition with five signatures and
signatures 2 and 5 each contains two sections, enter 1,2,1,1,2.

4. Save the import process template and use this import process
template to override the default syntax that was created in
Administrator.

Examples:
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Description Context Signature ID codes

(type the signature ID
code in one line)

Number of
Sections per
Signature

Resulting codes

Simple incrementing
number code

(not available in
4.0.2.1 release)

Job name: 12345

# signatures: 2

# sections per
signature: 1

Versions: 01: English
02: French

%00001+1% 1 English signature 1:
00001

English signature 2:
00002

French signature 1:
00003

French signature 2:
00004

Versioned Job Job name: 12345

# signatures: 2

#sections per
signature: 1

Versions: 01 -
English and 02 -
French

%jobname<-2>%

%Version<2>%

%Signature<2>%

1 English signature 1:
450101

English signature 2:
450102

French signature 1:
450201

French signature 2:
450202

Multi-section job Job name: 0027

Text Section

# signatures: 5

(signature 3
contains 2 sections)

%jobname<-2>%

%signature<2>%

%numsections%

1,1,2,1,1 Signature 1: 27015

Signature 2: 27025

Signature 3: 27035

Signature 4: 27045

Signature 5: 27055

Pre-job (with
multiple
impositions)

%imposition<1>%

%version<-2>%

%signature<2>%

1 specific to the job
(unique)

Editing signature ID codes

Add, remove, and modify elements from signature ID codes.

Edit signature ID codes using either the import process template or the
Signature ID Codes Editor.
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1. Open the Signature ID Code Editor: in the Signatures view of Job
Manager, right-click the desired signature and select Change
Signature ID Code Template or select the desired job and, from the
Job menu, select Change Signature ID Code Template.

2. Select the desired elements under Create signature ID code
template from. See Signature ID code elements and syntax

3. To manually edit the ID code, under ID Code Template, click Edit.

4. Under Sections, view and edit the sections associated with each
signature. If you are using multiple sections for a signature, under
Create signature ID code template from, select Signature Number.

5. To view the ID codes before you commit your changes, click
Preview.

6. Click OK.

Examples:

Description Context Signature ID codes

(type the signature ID
code in one line)

Number of
Sections per
Signature

Resulting codes

Simple incrementing
number code

(not available in
4.0.2.1 release)

Job name: 12345

# signatures: 2

# sections per
signature: 1

Versions: 01: English
02: French

%00001+1% 1 English signature 1:
00001

English signature 2:
00002

French signature 1:
00003

French signature 2:
00004

Versioned Job Job name: 12345

# signatures: 2

#sections per
signature: 1

Versions: 01 -
English and 02 -
French

%jobname<-2>%

%Version<2>%

%Signature<2>%

1 English signature 1:
450101

English signature 2:
450102

French signature 1:
450201

French signature 2:
450202

Multi-section job Job name: 0027

Text Section

# signatures: 5

(signature 3
contains 2 sections)

%jobname<-2>%

%signature<2>%

%numsections%

1,1,2,1,1 Signature 1: 27015

Signature 2: 27025

Signature 3: 27035

Signature 4: 27045

Signature 5: 27055
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Description Context Signature ID codes

(type the signature ID
code in one line)

Number of
Sections per
Signature

Resulting codes

Pre-job (with
multiple
impositions)

%imposition<1>%

%version<-2>%

%signature<2>%

1 specific to the job
(unique)

See also:
About signature ID codes on page 712

Signature ID Code Editor dialog box

Use the Signature ID Code Editor dialog box to edit the elements of an
ID code.

The syntax for signature ID codes can use one or more of the following
tags. None of the tags are required. You can specify how many
characters in the name tags to include in the signature ID code.

To manually edit the ID code, under ID Code Template, click Edit....

ID Code element Description Syntax

Job Name Adds the specified number of characters from the beginning
or end of the job name.

%jobname<n>%

Job Code Adds the specified number of characters from the beginning
or end of the job code.

%jobcode<n>%

Imposition Name Adds the specified number of characters from the beginning
or end of the imposition name.

%imposition<n>%

Version Name Adds the specified number of characters from the beginning
or end of the version name—for example, the language.

%version<n>%

Signature Number Indicates the section number of the signature. %signature<n>%
Append the total
number of sections

Calculates the total number of sections in the signature. If
you use this option, you must also select Signature Number.

%numsections%

Incrementing ID Code Any number that is incremented by a value that you specify.
This element must be manually entered.

%000+n%

See also:
About signature ID codes on page 712
Editing signature ID codes on page 714

Ink eater mark

For presses that require a minimum ink coverage per separation, the
ink eater mark places a bar on the sheet to remove extra ink from the
rollers.

The bar is used to constitute the minimum ink coverage that is required
for each separation on a press. Prinergy determines the amount of ink
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used by content for each pixel column and adds an amount of ink that
fulfills the minimum requirement to the specified ink eater bar area.
Typically, ink eater bars are placed in the gutter along the width of the
sheet.

The Prinergy ink eater mark is calculated on the fly. It takes all other
marks into consideration to provide the most accurate calculation of
the ink coverage. Also, the Prinergy ink eater mark is smoothed, so that
hard edges are not visible between pixel columns.

The ink eater mark has the following format:

$
[InkEater_minX_minY_maxX_maxY_minDensity_maxSatur
ation_colors]
The first four arguments are mandatory and are defined in millimeters.
minX and minY together define the lower-left corner, and maxX and
maxY together define the upper-right corner of a rectangular ink eater
mark. These measurements are relative to the lower-left corner of the
plate media as defined in the imposition.

● minDensity is the minimum amount of ink that any color may
have per pixel column. The default value is 7%.

● maxSaturation is the maximum saturation that the ink eater
mark can have. This is of concern when multiple colors are included
in the same ink eater mark. The default value is 180%.

● colors is a list of the colors which are to be included in the ink
eater mark. The default is SeparationAll, which includes all
colors. MK2, for example, would included Magenta, Black, and the
second spot color.

Tip: You can place more than one ink eater bar. This is useful if you need to place
other marks in the gutter. Also, it may be useful to create one ink eater bar per
color.

For the mark $[InkEater_5_185_706.2_215_7_180_CMYK1],
see the following before and after figures.
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Limitations

Performance testing estimates additional processing time of
approximately 10 to 20 seconds per plate in cases where an ink eater
mark is included.

718 Chapter 12—Outputs



Output to composite output (example, contone TIFF) does not work
because the mark is designed to work on separated data. The Marks
JTP fails in this case. This limitation dictates that users of this mark
should take either of the following actions:

● Not do imposed contone proof outputs if the mark is in the
imposition mark PDF

● Build the mark into a PDF file and apply it as a sheet mark in the
plating process template, rather than defining the mark in the
imposition's mark file

Use of this feature with pre-separated PDF pages will cause processing
to fail.

Use of this feature with legacy versioning jobs will result in incorrect
output.

Text-file-based marks

About text-file-based marks

You can use an imposition application (for example, Preps or Pandora)
to add text-file-based marks to an imposition. Once the imposition is
processed, the mark will be replaced with text from a text file.

This feature allows you to quickly change specific text in an imposition
without repeatedly opening an imposition software application.

For example, you can place marks on each page within an imposition.
Once the imposition is processed, each mark is replaced with the
associated text from the text file.

When you need to change the text on the final output, simply modify
the text file.

List of text-file-based marks

Place text-file-based marks in the imposition plan.

Text-file-based marks

The supported marks are:

● Signatures: $[SignatureText] or $[SIGT]
● Sheets: $[SheetText] or $[SHTT]
● Surfaces: $[SurfaceText] or $[SRFT]
● Pages: $[PageText] or $[PT]
● Versions: $[VersionSignatureText] or $[VSIGT] (The syntax for

versions is version <version name> <text>.)

Note: You cannot place both page marks and version marks on the same surface,
sheet, or signature.
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Syntax

Text-file-based marks are of the form $[mark] or $[mark_n], where:

● mark is the type of text mark to be retrieved.
● n is an optional numeric parameter identifying the text string to be

used if more than one is defined for the object.

If the optional numeric parameter is omitted, 1 is assumed.

If the text string for the mark cannot be located in the imposition text
file the mark is replaced with an empty string.

See Example: text-file-based marks on page 721.

Text file syntax

The text file must be placed in the same directory as the imposition file,
and it must have the same name as the imposition file, except ending
with a .txt extension.

Syntax

The text strings must be arranged in a hierarchy by imposition object.
Configure one line per object.

Each line of the text file must be formatted as:

<Object> <ID> <String 1>; <String 2>; ... <String N>

where,

● <Object> is:

○ Signature or Sg
○ Sheet or Sh
○ Surface or Su
○ Page or Pg

Objects are case-insensitive.

● <ID> is a numeric identifier or a Preps-style alpha surface identifier.
The surface identifiers Front or Fr and Back or Ba are also
supported. Pages are identified by their run-list position.
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More syntax rules

● Strings must be separated by semicolons (and therefore cannot
contain semicolons).

● Objects should be listed in hierarchical order. In other words,
signature 1 should be listed before any of the objects in that
signature. The order of hierarchy is:

○ Signatures
○ Sheets
○ Surfaces
○ Pages

● If a higher level object is not listed, default values are assumed.
● The file must not contain duplicate objects, and objects must be

listed in their hierarchical order unless defaults are being assumed
for higher-level objects. If duplicates are found or objects are listed
out of order, the output task will fail with an error message listing
the problem line. The error must be corrected before the task is
resubmitted.

See Example: text-file-based marks on page 721.

Example: text-file-based marks

Eight-page imposition with Preps-like surface identifiers

Imposition with Text-File-Based Marks

Text File
Signature 1 <Sig1 text1 goes here>; <Sig1 text2 
goes here>
   Sheet 1 <Sheet1 text goes here>
      Surface A <SurfaceA text goes here>
         Page 1 <Page1 text goes here>
         Page 4 <Page4 text goes here>
         Page 5 <Page5 text goes here>
         Page 8 <Page8 text goes here>
         Page 25 <Page25 text goes here>
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         Page 28 <Page28 text goes here>
         Page 29 <Page29 text goes here>
         Page 32 <Page32 text goes here>
      Surface B <SurfaceB text goes here>
         Page 2 <Page2 text goes here>
         Page 3 <Page3 text goes here>
         Page 6 <Page6 text goes here>
         Page 7 <Page7 text goes here>
         Page 26 <Page26 text goes here>
         Page 27 <Page27 text goes here>
         Page 30 <Page30 text goes here>
         Page 31 <Page31 text goes here>
   Sheet 2 <Sheet2 text1 goes here>
      Surface C <SurfaceC text goes here>
      ...
      Surface D <SurfaceD text goes here>
      ...
Signature 2 <Sig2 text1 goes here>; <Sig2 text2 
goes here>
...
The Resulting Imposition

For signature 1, sheet 1, surface A:

Example: text-file-based marks for versions

Versioned Imposition with Text-File-Based Marks
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Text File
Signature 1 <Sig1 text1 goes here>; <Sig1 text2 
goes here>
   Sheet 1 <Sheet1 text goes here>
      Surface A <SurfaceA text goes here>
         Version En <English text goes here>
         Version Fr <French text goes here>
         Version De <German text goes here>
         Surface B <SurfaceB text goes here>
         Version Ja <Japanese text goes here>
         Version Zh <Chinese text goes here>
         Version Ko <Korean text goes here>
   Sheet 2 <Sheet2 text1 goes here>
      Surface C <SurfaceC text goes here>
      ...
      Surface D <SurfaceD text goes here>
      ...
Signature 2 <Sig2 text1 goes here>; <Sig2 text2 
goes here>
...

The Resulting Impositions

For signature 1, sheet 1, surface A, version En:

For signature 1, sheet 1, surface A, version Fr:

and so on...
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Using text-file-based marks

1. Using an imposition software application, type Prinergy text-file-
based marks in your imposition.

Use imposition software that supports Prinergy variable marks, and
use only text-file-based marks.

Note: For use in Pandora, you may have to create specific variable marks for
multiple strings, for example, $[AT_3]. For information on creating variable
marks, see the Creating Variable Text Marks for Pandora using Adobe Illustrator
CS technical bulletin.

2. Create a text file based on the syntax rules.

3. Give the text file the same name as the imposition file when it is
imported into the Prinergy job, but change the extension to .txt.
For example, if the imposition was imported with the name
DoubleWeb_2Sigs.JT.pjtf, the text file should be named
DoubleWeb_2Sigs.JT.txt.

4. Copy the text file to the same folder as the job imposition file: <job
folder>\System\ImpositionPlans.

Publish to PDF

About publishing PDF files

The publish PDF feature lets you select one or more PDF pages or a
page set, and then publish the files to a location on the network in PDF
file format. It lets you easily share PDF files with others. You can
publish an exact version of the PDF, or you can publish a downsampled
version, which is easier to transfer via a network.

When you publish a PDF file, you can choose to:

● Publish images in high resolution
● Publish images in low resolution

When you publish a high-resolution version of the selected files,
Prinergy maintains the resolution of the images contained in the
selected PDF pages or page set and publishes a PDF file to the location
you specify.

When you publish a low-resolution version of the selected files, low-
resolution PDF files will be produced only if alternate images were
generated during the refining process. (Alternate images can be
generated by selecting Color & Grayscale Alternate Images in the
Optimize section of a refine process template.) If no alternate images
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are present in the selected files the pages are published as high-
resolution.

When publishing PDF pages, you can select two or more PDF pages,
specify which resolution you want, and request that Prinergy combine
the selected PDF pages into one PDF file that contains multiple pages.
The result is published to the location you specify.

When publishing a page set, you can select a page set, specify which
resolution you want, specify a page order, and publish it to the location
you specify. When you're publishing a page set, the system always
generates a multi-file PDF file; it will not let you generate one PDF file
for each page in the page set. Also, when a position in a page set
contains two or more layers, the system only includes the bottom layer
in the published PDF file.

Note: If you have the Vector Output JTP, you can publish PDF files using the loose
page output and imposition output process templates. This method lets you
publish PDF files in a workflow template.

Publishing PDF files

1. In Job Manager, perform one of the following actions in Pages view:

○ In the Pages pane, select the PDFs you want to publish.
○ In the Page Sets pane, select the page set you want to publish.

2. From the File menu, select Publish to PDF File.

3. In the Publish PDF Files dialog box, set the options as desired.

4. Click Save.

The Publish PDF Files dialog box closes, and Prinergy publishes one or
more PDF files, depending on the choices you made.

Publish to PDF File dialog box

Save PDF Files to Folder

Lets you navigate to the location to which you want to save the
published PDF files.

Volumes

Displays all volumes in the Prinergy system.

Job Folder

Opens the job folder for the current job.
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Show Hidden Files

Select this check box to include hidden files, such as system
files, in the results.

You can set the default selection of this check box on the View
tab of the Workshop Preferences dialog box.

Images

This list lets you specify whether the system downsamples the
images in the selected PDF file or page set while publishing the
PDF file.

Select Original for the system to use the images in the selected
PDF files or page set as they are.

In other words, the system doesn't downsample the images.

Select Low-resolution proof for the system to downsample the
images in the selected PDF files or page set.

When downsampling images, the system uses the resolution
specified in the Color & Grayscale Alternate Images section of
the Optimize section of the refine process template.

Outline Fonts

Selecting this check box replaces all text objects with vector
objects in the output.

Font outlining is useful for eliminating font formats that certain
RIPs may not be able to process. Text formatted in this way
cannot be edited, and when previewed in Adobe Acrobat will
look bolder than the original due to loss of font hinting for low-
resolution monitors.

Output to

This list lets you generate files in PDF, PDF/X-1a:2001, or PDF/
X-3 format.

If you choose to output to PDF/X, the input files should
previously have been refined to that format using a refine
process template. At the output stage, files are only checked for
PDF/X conformance; some PDF/X issues cannot be resolved at
this stage.

Apply Geometry

Applies geometry settings to the published PDF output.

You can set the geometry for the page (offset, scale, rotate) in
the Set Page Geometry dialog box before publishing the PDF
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file. If the Apply Geometry check box is selected, the geometry
will be applied to the published PDF file.

Remove Traps

Removes any Prinergy-generated traps from the published PDF
file.

Trapping-generated overprints remain in the PDF files.

Trim Media

Sets the media box equal to the trim box-for example, removes
registration marks, and so on, outside of the trim box.

This is useful for PDF files that will be published to the Web.

Save Pages to Separate Files

Generates a PDF file for each PDF page you select.

Select this option to enable this feature.

Note: This feature is available only when you select PDF pages; it is
unavailable when you select a page set.

Save to Multipage PDF File

Generates a single PDF file with multiple pages for the selected
PDF pages or page set.

Select this option to enable this feature.

Note: This feature is automatically enabled and unavailable when you
select a page set.

File name

This box displays the name the system will use for the
published PDF files.

The file name must be 31 characters or less.

When you select a page set, the system uses the name of the
page set, unless you change this name by typing a new name in
the File name box.

When you select PDF pages and then select the Save Pages to
Separate Files option the system uses the name of each page.
You can't change the names. However when you select PDF
pages and then select the Save to Multi-Page PDF Files option
you can specify a name for the published PDF file by typing a
name in the File name box.

Note: If the system generates a PDF file name from the page name,
characters may be cut from the page name, so that the file name (page
name plus .pdf extension) is not more than 31 characters. Characters are
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cut from the left of the page name. For example, if the page name is
Thisisareallyreallylongpagename, the system-generated pdf file name
would be Thisisareallyreallylongpage.pdf.

Create Preflight report

Generates a Preflight report for the selected PDF pages or page
set.

The Preflight report will be located in same directory as you
specified for the published PDF files.

Report name

Type a name for the Preflight report you are generating for the
selected PDF pages or pageset.

Reader Order

This option is only available when you select a page set. It
determines the page order for the published PDF file.

Select this option to publish the page set in reader order-that is,
from the smallest page number to the largest page number.

Selected Order

This option is available only when you select a page set. It
determines the page order for the published PDF file.

Select the Selected Order option to publish the page set in the
order you currently have it sorted in Prinergy Workshop. In
other words, the system orders the pages based on the order
they currently appear on-screen in the page set.

Include Empty Page Positions

Select this check box to include blank pages in the published
PDF file. The blank pages represent unassigned page positions.

Clear this check box to omit blank pages from the PDF file. In
this case, blank, unassigned page positions are omitted from the
published PDF file.

This check box is available only when you select a page set.

Web growth
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Web growth profiles
The web growth feature lets the Prinergy software digitally
compensate for press distortion.

On a web press, the main direction of growth is across the web. On a
sheetfed press or flexo press, you may find more significant growth in
the direction of paper travel. The web growth compensation
mechanism in Prinergy can simultaneously compensate for growth
across and along the web or sheet.

You can compensate for linear, non-linear, and trapezoidal or pillow-
shaped scaling:

● Linear scaling—The expansion of the paper as a percentage is the
same all across the paper. The percentage growth on the left side is
the same in the center as on the right side. As a result, you need to
convert your measurements to a percentage expansion in the x
(across-web) and y (along-web) directions. See Example: web
growth profile on page 730.

● Non-linear scaling—The paper expands by varying amounts across
and along the paper. For more information, see Example: nonlinear
web growth profile on page 731.

● Trapezoidal or pillow-shaped scaling—The expansion of the paper
fans out in a trapezoidal or pillow shape. For more information, see 
Example: Trapezoidal/pillow sheet growth profile on page 734.

Which files does the feature use?

The web growth feature uses the following files:

● An XML (extensible markup language) DTD (document type
definition) file

● An XML profile file (<file name>.wgp)
● A tower-color file (ColorTowerMap.txt)

The DTD file contains the definitions and comments that describe the
XML tags in the profile file. The profile file uses the DTD file; you do
not use the DTD file. You can either store the profile file and the DTD
file in the same folder, or store the files in separate folders and include
the location of the DTD file in the profile file.

A profile file describes press distortions for a specific press, paper
stock, humidity, ink coverage, and/or other factors. You create one or
more profile files using a text editor after you measure your distortions
on press. You enter the measured distortions in the profile file. You can
then apply a profile file to each signature in a Prinergy job. Prinergy
uses the profile to alter the image for each plate for a specific press/
paper combination. A sample profile file is stored in the CreoAraxi
\data\WebGrowthProfiles folder on the home server.
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Consider these defaults when you set up your web growth profile:

● When you omit the distortion values for both surfaces of a given
press tower, the system does not apply compensation to either
surface.

● When you omit a distortion percentage (the x percentage or y
percentage), the system does not apply compensation in that
direction.

The tower-color file is a text file that specifies the names of the color
separations in a job and the number of the press color tower running
each color. A sample tower-color file (ColorTowerMap.txt) is
stored in the CreoAraxi\data\WebGrowthProfiles\ folder on
the home server. See Example: tower-color file on page 735.

Archiving

When you archive a job, Prinergy archives a reference to the profile file
that it used, but does not archive the profile file itself. If you have to
remake plates, you will want to use a current profile rather than the
one that was used when the plates were originally made.

Example: web growth profile

This page shows the text from a sample web growth profile file (<file
name>.wgp).

Tip: Copy and modify the sample file that is installed with Prinergy so that you
don't have to type the contents.

<?xml version=1.0 encoding=UTF-8?>

<!DOCTYPE profile SYSTEM WebGrowthProfile.dtd>

<profile>

<plate tower=1 side=U>

<expansion xpercent=1.0 ypercent=0.30 />

</plate>

<plate tower=2 side=U>

<expansion xpercent=0.8 ypercent=0.25 />

</plate>

<plate tower=3 side=U>

<expansion xpercent=0.6 ypercent=0.20 />

</plate>

<plate tower=4 side=U>

<expansion xpercent=0.3 ypercent=0.15 />
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</plate>

</profile>

Example: nonlinear web growth profile

In cases where it is not practical to assume that the web growth is
linear across the paper, a nonlinear web growth profile can be created
to capture the actual displacements from the base separation.

This topic provides nonlinear web growth profile examples for
distortions occurring either across the web or across and around the
drum.

Example 1: Nonlinear web growth profile-across the web

This web growth profile example uses the same displacement
measurements as in Table 1: Displacements from the yellow separation
across a grid. It uses plate tower 1 for the black separation, plate tower
2 for the cyan separation, and plate tower 3 for the magenta
separation.

<?xml version=1.0 encoding=UTF-8?>

<!DOCTYPE profile SYSTEM WebGrowthProfile.dtd>

<profile>

<measurePosition x = 1 y = 1 unit = mm />

<measureShift x = 1 y = 1 unit = mm />

<plate tower=1 side=U>

<xshift x= -886.8 dx= -1.38 />

<xshift x= -584.0 dx= -.82 />

<xshift x= -252.0 dx= -.36 />

<xshift x= -12.7 dx= .10 />

<xshift x= 12.7 dx= .13 />

<xshift x= 315.5 dx= .64 />

<xshift x= 584.0 dx= .95 />

<xshift x= 886.8 dx= 1.40 />

</plate>

<plate tower=2 side=U>

<xshift x= -886.8 dx= -1.04 />

<xshift x= -584.0 dx= -.66 />

<xshift x= -252.0 dx= -.36 />
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<xshift x= -12.7 dx= .10 />

<xshift x= 12.7 dx= .10 />

<xshift x= 315.5 dx= .30 />

<xshift x= 584.0 dx= .46 />

<xshift x= 886.8 dx= .78 />

</plate>

<plate tower=3 side=U>

<xshift x= -886.8 dx= -.52 />

<xshift x= -584.0 dx= -.30 />

<xshift x= -252.0 dx= -.08 />

<xshift x= -12.7 dx= .10 />

<xshift x= 12.7 dx= .08 />

<xshift x= 315.5 dx= .12 />

<xshift x= 584.0 dx= .23 />

<xshift x= 886.8 dx= .40 />

</plate>

</profile>

Note that the xshift element has two attributes: x, which is the
horizontal distance across the web; and dx, which is the displacement
from the base separation.

The profile also specifies how the measurements are spaced along the
plate with the measurePosition element, and the measureShift element
specifies the units used for the displacement measurements
themselves.

Example 2: Nonlinear web growth profile (across and
around the drum)

In this example, measurements are made across the drum (on the x
axis), and around the drum (on the y axis). Across the drum,
measurements are made every 8 inches and displacements are
measured in 1-millimeter increments:

<measurePosition x = 8 unit = inch />

<measureShift x = 1 unit = mm />

The x origin (the across-the-drum measurement) is at the centre of the
plate, and so the left-hand x coordinates are negative, and the right-
hand coordinates are positive. If the plate is 44 wide, and the first
measurement is 2 in from the left edge, this left-most x coordinate will
be (44/2 - 2) / 8 = -2.5. Because the measurements are spaced by
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measurePosition, they will have the x coordinates -2.5, -1.5, -0.5, 0.5,
1.5, and 2.5. The displacement, dx, is simply the measured difference
between a feature position in the base separation and the current
separation.

The y origin (the around-the-drum measurement) is at the plate's
leading edge, and so the y coordinates start from 0 and are always
positive, but otherwise, the concept is the same as the across-the-
drum measurements. The yshift element has two attributes, y and dy,
which specify the y offset and the displacement in the y direction
respectively. An example web growth profile with nonlinear web
growth in both the x and y directions is shown below:

<?xml version=1.0 encoding=UTF-8?>

<!DOCTYPE profile SYSTEM WebGrowthProfile.dtd>

<profile>

<measurePosition x = 8 y = 2 unit = inch />

<measureShift x = 1 y = 1 unit = mm />

<plate tower=1 side=U>

<xshift x= -2.5 dx= -1.584 />

<xshift x= -1.5 dx= -.720 />

<xshift x= -.5 dx= -1.544 />

<xshift x= .5 dx= .288 />

<xshift x= 1.5 dx= 1.288 />

<xshift x= 2.5 dx= 1.578 />

<yshift y= .5 dy= -3.288 />

<yshift y= 1.5 dy= 0 />

<yshift y= 2.5 dy= -2.578 />

<yshift y= 3.5 dy= -4 />

<yshift y= 4.5 dy= -2 />

<yshift y= 5.5 dy= 0 />

<yshift y= 6.5 dy= -2 />

<yshift y= 7.5 dy= 0 />

</plate>

</profile>
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Example: Trapezoidal/pillow sheet growth profile

With some of the newer sheetfed printing presses, the required sheet
growth compensation is not necessarily linear; it may be trapezoidal
(as pictured on the left) or pillow (the left and right black edges are
bowed out or in, creating a pillow-like shape, as pictured on the right).

In the examples shown, the red box is the desired size and shape of the
printed sheet. The black box is the size and shape that may result if no
sheetfed compensation is applied. The lower edge of the content
bounding box is the gripper edge of the printing press.

Both examples show non-parallel growth in the horizontal direction,
and parallel growth in vertical direction.

Notice that the top and the bottom sides of the bounding box remain
unrotated and parallel to each other. In other words, trapezoidal
sheetfed compensation cannot be performed in a vertical direction
(that is, parallel to the gripper edge). However, it is possible to apply
linear sheetfed growth or contraction in a vertical direction.

This topic provides an explanation of the required format and an
example of a trapezoidal growth profile.

Format

To specify trapezoidal sheetfed compensation in the web growth
profile, specify two or three points in the following format:

<fanout y="<#>" fanoutvalleft="<#>"
fanoutvalright="<#>" dy="<#>" />
● y is the vertical position of the point being sampled.
● fanoutvalleft is the amount of growth/shrinkage on the left

side.

○ Use positive values when the measured, uncompensated output
is expanding (growing) to the left.

○ Use negative values when the measured, uncompensated output
is contracting (shrinking) to the right.

● fanoutvalright is the amount of growth/shrinkage on the right
side.
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○ Use positive values when the measured, uncompensated output
is expanding (growing) to the left.

○ Use negative values when the measured, uncompensated output
is contracting (shrinking) to the right.

● dy is the amount of linear growth in the vertical direction at
position y. This is similar to linear web growth in Prinergy.

All the above <#> fields are numbers that can be specified in units of
measure (mm, pts, in.).

Example
 <?xml version="1.0"
encoding="UTF-8"?>
<!DOCTYPE profile SYSTEM
"WebGrowthProfile.dtd">
<profile>
   <measurePosition x = "1" y = "1" unit = "mm"
/>
   <measureShift x = "1" y = "1" unit = "mm"
/>
   <plate tower="1" side="U">
      <fanout y="0" fanoutvalleft="-1"
fanoutvalright="-1" dy="1" />
      <fanout y="500" fanoutvalleft="0"
fanoutvalright="0" dy="0.5" />
      <fanout y="1000" fanoutvalleft="-1"
fanoutvalright="-1" dy="0" />
   </plate>
</profile>
Note: The dy is always calculated from the bottom (gripper) edge of the sheet.

Example: tower-color file

The text from a sample tower-color file is shown below. The tower-
color file is always named ColorTowerMap.txt.

A wild card character (*) can be used to map any undefined color to a
specified color tower. In the example below, all spot colors except
SpottySpot will be mapped to tower 3.

Note: This is an example of a ColorTowerMap.txt file. You can copy and
modify the sample ColorTowerMap.txt file that is installed with Prinergy.

##### Sample tower-color file, for use with Prinergy Web Growth

#### Make entries of the form:ColorName TowerNumber

#### Make 1 entry per line

Black 1

Cyan 2
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Yellow 3

Magenta 4

SpottySpot 5

*3

Calculating web growth

This topic gives examples for calculating the percentage of web growth
from measurements on press sheets or traditional page-shifts.

The standard process for determining web growth compensation
parameters is to print press sheets with no compensation, and then
measure the discrepancies between the separations at different points
on the surface. The growth percentage for one separation relative to
another is then calculated by adding the discrepancy at the farthest left
pair of marks, to the discrepancy at the farthest right pair of marks, and
dividing by the distance between the pairs.

Once calculated, the percentages are entered into the web growth
profile file. Prinergy uses the percentages from the web growth profile
in an algorithm to compensate for web growth.

Example 1: Measuring the displacements from the yellow
separation across a grid

Table 1 is a table of measurements from a press sheet of grids printed
with the ink order KCMY. Each column of numbers corresponds to the
vertical grid line at a particular horizontal position. (This is only an
example. In reality, a grid would contain far more lines.) Yellow is the
last ink down, so it is the base separation against which other
separations are measured.

Table 1: Displacements from the yellow separation across a grid

Distance in mm

Negative numbers indicate distances to the left.

Non-negative numbers indicate distances to the right.

Page

Growth

X -886.
8

-584.
0

-252.0 -12.7 12.7 315.5 584.
0

886.8 N/A

K-Y -1.38 -.82 -.36 .1 .13 .64 .95 1.40 (1.38 + 1.40)/(2 x 886.8) = .
157%

C-Y -1.04 -.66 -.36 .10 .10 .30 .46 .78 (1.04 + .78)/(2 x 886.8) = .
103%

M-Y -.52 -.30 -.08 .10 .08 .12 .23 .40 (.52 + .40)/(2 x 886.8) = .
052%

X measures the horizontal distance (across the web) of the vertical
grid line from the horizontal center of the sheet. The first column
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corresponds to the left-most grid line, which is 886.8 mm to the left of
the center. The last column corresponds to the right-most grid line,
which is 886.8 mm to the right of the center.

The figures in row K-Y measure the displacement from the black
separation to the yellow separation for corresponding grid lines. C-Y
measures the displacement from the cyan separation to the yellow
separation. M-Y measures the displacement from the magenta
separation to the yellow separation.

Looking at the K-Y row in detail, the -1.38 in the column where X is
-886.8 indicates the black separation is 1.38 mm to the left of the
yellow separation at the left edge of the sheet. The 1.40 mm in the
column where X is 886.8 indicates the black separation is 1.40 mm to
the right of the yellow separation at the right edge of the sheet. Thus,
the black separation is larger than the yellow (by about 1.38 + 1.40 =
2.72 mm). This is expected because the black was printed before the
yellow, and the paper grew while traveling from the black ink unit to
the yellow ink unit. The growth of the black separation, relative to the
yellow, is (1.38 + 1.40) / (2 x 886.8) = .157%, as shown in the %age
Growth column at the right of the table.

Similarly, for the C-Y and M-Y rows, the growth of these separations
relative to yellow is calculated in the same way and shown at the right
of the table. The growth of the cyan is about twice that of the magenta,
while the growth of the black is about three times that of the magenta.
This is normal for equally spaced ink units.

Note: The only data used to compute the growth was the displacements at the
outer edges.

After you calculate web growth, you enter the percentages into the
web growth profile for the press and paper to which this growth
applies. You must enter values for both the upper and lower surfaces in
the same web growth profile. Prinergy takes the percentages from the
web growth profile and uses an algorithm to compensate for the web
growth. The numbers in the web growth profile should decrease from
the first ink tower (first down, so largest growth) to the last ink tower
(last down, so no growth).

Example: web growth profile on page 730

Example: tower-color file on page 735

Note: Only horizontal percentages appear in the file. If a percentage is missing, as
it is for all the y (along-the-web) parameters, it is assumed to be zero. The growth
for tower 4 (corresponding to yellow, according to the TowerColorMap.txt
file) could therefore be left out, given that it is zero. For true web growth, the
percentage growth values for the lower surface (side=L) are the same as for the
upper surface (side=U) to avoid the paper curling.
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Example 2: Measuring page shifts

In this example, the page shifts used to compensate for web growth are
specified instead of grid measurements, as might appear in a table in
the job jacket when traditional compensation methods are used. In this
example, the ink order is KCMY, measurements are in inches, the
imposition is four across, and pages are 12.5 inches wide.

Table 2: Page shifts to compensate for web growth

Page Left Outer Left Inner Right Inner Right Outer

K 0.005 0.002 -0.002 -0.005

C 0.003 0.001 -0.001 -0.003

M - - - -

Y -0.004 -0.002 0.002 0.004

The left outer black page is moved right by .005 in. towards the center.
The right outer page is moved left by .005 in. towards the center. The
yellow pages are moved out. The magenta separation is not adjusted.

While Table 1 specified the displacement on press, Table 2 specifies
the compensation to be applied. In Table 2, magenta is used as the
base separation. However, the web growth profile always uses the last
ink down as the base separation.

Table 3 below reexpresses the data of Table 2 in the format of Table 1.
Consider the left outer page: the black is shifted .005 inches to the
right, and the yellow .004 to the left. As a result, relative to the yellow,
the black page is shifted .009 inches to the right. Because Table 2
indicates how much to shift each page to align the centers of the
pages, and the pages are 12.5 inches wide, the page center of the left
outer page is at 1.5 x 12.5 inches = 18.75 inches left of the signature
center. The displacement of the black relative to the yellow at -18.75
inches from the center, then, is -.009 mm.

Table 3: Displacements from the yellow separation at page centers

Distance in inches

Negative numbers indicate distances to the left.

Non-negative numbers indicate distances to the right.

Page Growth

X -18.75 -6.25 6.25 18.75 N/A

K-Y -.009 -.004 .004 .009 (.009 + .009) / (2 x 18.75) = .048%

C-Y -.007 -.003 .003 .007 (.007 + .007) / (2 x 18.75) = .037%

M-Y -.004 -.002 .002 .004 (.004 + .004) / (2 x 18.75) = .021%

To compute the growth, we again use only data for the outer pages.
The displacements are accurate to only one significant figure, so
there's no need to use more than two figures for the growth
percentage.
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Creating a web growth profile

1. Using a text editor, open the sample profile file located in the
following folder on the home server: CreoAraxi\data
\WebGrowthProfiles.

2. Add the stretch percentages to the sample profile.

3. Save the profile file with a .wgp extension—<file name>.wgp.

Setting up a tower-color profile

1. Using a text editor, open the sample tower-color file
(ColorTowerMap.txt).

2. Type the names of the color separations in the job files, as well as
the number of the color tower running each color, for example,
Yellow 1.

Don't use the following characters in the color names:

● Leading or trailing tabs or spaces
● Tabs embedded in the file name
● Wide characters, for example, CJK (Chinese, Japanese, Korean)

characters

If a color separation is missing from the tower-color file, or if
Prinergy can't find a tower-color file, Prinergy will fail the process
(when you apply a web-growth-enabled process template to an
imposition that has a profile associated with it).

3. Save the tower-color file as ColorTowerMap.txt.

The tower-color file must have this name for Prinergy to be able to
find it.

You can save the tower-color file stored in the same folder as the
profile file. This will be the default tower-color file. You can also
create a custom tower-color file for a job, and place it in the <Job
Folder>\Control folder.

Prinergy first searches the <Job Folder>\Control folder for a
tower-color file. If it can't find a tower-color file in the job folder, it
will use the default tower-color file from the same folder as the
profile file.

Applying and removing a web growth profile

You can apply a web growth profile to a signature, sheet, or surface.
When you apply this process template to the signature/sheet/surface,
the system uses the web growth profile you registered with each
signature/sheet/surface and a tower-color file. If you haven't
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registered a web growth profile with a signature/sheet/surface, the
system cannot use one.

Note: if you select a web growth profile for surface A (upper), surface B (lower)
automatically takes this profile as well. You can then clear or change the web
growth profile for surface B (lower) independently.

The color tower map file does not need to be specified. The system
uses the color tower map file that is in the same folder as the web
growth profile.

Note: Only use a web growth profile for imposition output when it has the same
rotation (usually 270 degrees) as final output. It is recommended to use this
option for final output, but not for imposition output.

Note: The process template does not let you select flat rotation and web growth at
the same time. However, when web growth is applied, flat rotation can be
specified in the web growth profile.

If you use web growth with a TIFF workflow, see About Web Growth
Profiles.

1. Set up a process template:
a. Edit an imposition process template or final output process

template.
b. Expand the Layout section.
c. Select the Scale Raster check box.
d. Select the Assign Web Growth Profile, if Available option to

apply a web growth profile. If you select a different scaling
option, it will override any web growth profile already assigned
to the imposition (in Job Manager). Select one of the following:

● Select Use profiles assigned in Job Manager only. If a profile
is not assigned in Job Manager, no web growth profile will be
applied.

● To assign a specific web growth profile to this specific
process template (for example, if certain plate sizes always
have web growth applied to them), select Use Default
Profile, and type or locate the .wgp file you want to use as
your web growth profile.

Note: If a web growth profile is specified for a job in Job Manager, this
overrides any web growth profile that is assigned here, unless you also
select the Override profiles assigned in Job Manager check box.

● To assign a specific web growth profile to each sheet
separately, select Assign Profile to Sheet. In the Web
Growth Profile column, type or locate the .wgp file you want
to use as your web growth profile for each sheet. This feature
is useful when, for example, you need different profiles for
the left and right webs of a multi-web run. A "sheet" in the
Assign Profile to Sheet list box refers to two surfaces printed
on two sides of the same substrate. For example, a multi-web
layout consisting of a single signature with two webs would
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map Sheet 1 to Signature 1 sides A and B, and map Sheet 2 to
Signature 1 sides C and D. If there were a second signature,
then Sheet 3 would map to Signature 2 sides A and B, and
Sheet 4 would map to Signature 2 sides C and D.

Note: If a web growth profile is specified for a job in Job Manager, this
overrides any web growth profiles that are assigned here, unless you
also select the Override profiles assigned in Job Manager check box.

e. Save the process template.

2. (Optional) Apply or remove a web growth profile for specific
signatures, sheets, or surfaces:

a. In the Signatures or Separations view, select one or more
signatures.

b. To select a specific web growth profile, select Edit > Set Web
Growth Profile, select the web growth profile you want to use,
and click OK.

c. To remove a web growth profile, select Edit > Clear Web
Growth Profile.

3. Start an output process on the signatures, sheets, or surfaces using
the process template that you set up.

Set Web Growth Profile dialog box

Unlabeled list and results area

Selecting an item in the list at the top left of the dialog box
displays that item's contents in the box below.

When you select:

● Volumes, the volumes in your system appear
● A volume name, folders at the root of the selected volume

appear
● A folder name, files within the folder appear

The path of the displayed item in the list appears in reverse
order, for example, folder name followed by volume name.

Show Hidden Files

Select this check box to include hidden files, such as system
files, in the results.

You can set the default selection of this check box on the View
tab of the Workshop Preferences dialog box.

Volumes

Displays all volumes in the Prinergy system.
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Job Folder

Opens the job folder for the current job.

PrintLink

About PrintLink
PrintLink digital ink-profiling software can generate JDF (Job Definition
Format) and PPF (Print Production Format) files that specify ink
coverage information for digital ink key preset systems. This feature
reduces misprints and makeready times.

PrintLink controls are found in the PrintLink section of the final output
process template.

Note: PrintLink is not associated with PrintLink Graphic Arts Placement Services.

PrintLink uses three computers in your printing process:

● Prinergy Workshop workstation (a Prinergy server and a Prinergy
secondary server running a RIP)

● PPF file reader workstation
● Press console

Benefits of using PrintLink

Traditionally, a plate scanner is used to produce ink key presets.
PrintLink is a digital replacement for a plate scanner and provides more
accurate coverage information. Instead of scanning an imaged plate to
estimate ink coverage, PrintLink uses the same digital source data that
Prinergy uses to image the plate.

PrintLink computes the ink key settings while your output device
images the plate. PrintLink stores the ink key coverage data and
identification information in the PPF file. Thus, you can achieve a level
of accuracy and repeatability not found with traditional plate scanners.
In addition, you eliminate plate scanning time and risk of plate damage.

For presses without CIP3 or CIP4 ink readers, Prinergy can create user-
readable ink key settings, which you can manually enter in the press
console. This feature reduces makeready time by ensuring that ink
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keys are accurately set without the costly investment of purchasing a
press with a CIP3 or CIP4 ink reader.

How PrintLink works in a Prinergy workflow

1. Your imposed PDF files are sent to the RIP on a secondary server.
2. The RIP on the secondary server receives the imposed files, RIPs the

data, and delivers the high-resolution raster to your output device.
3. While the RIP delivers the raster for plate imaging, PrintLink

generates a PPF file, one file per separation.
4. The resulting separated PPF file is sent to the PPF file reader

workstation.
5. The PPF file reader workstation interprets the ink coverage data.
6. The digital ink key settings are transmitted to the press console,

which controls the ink keys based on the PPF information it
receives.

Ink reports

You can generate an ink report from the PPF files produced by
PrintLink. The ink report is a text-based report that describes the area
of ink coverage (in square centimeters and inches) and the percentage
of the plate covered.

Custom PPF file

PrintLink produces PPF files that comply with the International
Cooperation for Integration of Prepress, Press, and Postpress (CIP3)
PPF file specification. CIP3 has established an open standard for
exchanging information among print production devices from multiple
vendors, including platesetters, presses, and finishing equipment.
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The standard specifies the Print Production Format for communicating
ink coverage information, printing form geometries, and other
information for digital ink key presets. Although PrintLink adheres to
this standard, some press interfaces require additional information
from the PPF file. To support these requirements, certain CIP3 tags in
the PPF file can be customized.

Creating a process template to generate a PPF file
Configure a final output process template to generate a PPF file (or a
text file if you will manually enter the ink key settings) for each
separation. When you use this final output process template, PrintLink
automatically generates PPF files from the secondary server and then
outputs the files to the designated directory on the PPF file reader
workstation.

Note: When you require user-readable ink key settings because you will manually
enter the ink key settings in the press console, the resulting ink key settings files
are text (.txt) files, not PPF files.

For more information, see Creating a process template for an ink
report on page 751 and Setting up the ink report
daemon on page 752 (to monitor the hot folder).

1. In Process Template Editor, create a new final output process
template.

2. In the Output To box of the process template, select a raster output
type.
For example, select TIFF.
The PrintLink section becomes available.

3. Select the PrintLink check box, and click the triangle to expand the
section.

4. In the Preview Resolution list, select one of the following
resolutions for the PPF file preview image:

○ Low (default)
○ Medium
○ High
○ Very High

Note: A higher resolution improves the preview image quality and may
improve the ink key print accuracy. However, a higher resolution may also
increase the processing time and file sizes.
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5. Choose where to put the PPF files:

Location Do This

Inside the job
folder

a. Click Browse and select a location inside a job.

The Put Files in Directory box lists an absolute file
path.

b. Select Job-Relative File.

This converts the absolute file path to a job-relative
path.

Outside the
job folder

Click Browse and select the location.

The Put Files in Directory box lists the file path.

Important: Ensure that the directory you select has enough space to receive
the PPF files generated by PrintLink.

6. (Optional) Select the Use JDF Name check box to preserve the
names of the sheet, the imposition, and the signature from the JDF.
These names will be used in the PPF.

7. (Optional) Customize the tags in the PrintLink configuration file,
click Browse next to Press Interface Configuration File, and locate
the PrintLink configuration file (named PrintLinkConfig.txt

8. In the Press Interface box, select a press interface in the list.

The active tags in the PrintLink configuration file override the
defaults of the selected press interface. Note the number of
divisions for the following manual Press Interface options:

Press Interface Option Number of Divisions

Manual 100 divisions (0 to 99)

ManualHeidelberg 16 divisions, each with 16 subdivisions (0 to 16 :
0 to 15)

ManualHeidelberg1 24 divisions, each with 20 subdivisions (0 to
23 : 0 to 19)

ManualManroland 254 divisions (0 to 253)

ManualManRoland1 24 divisions (0 to 23)

9. Configure other PrintLink parameters as required.

10. Save the final output process template.
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Customizing tags in the PrintLink configuration file
Customize the PrintLink configuration file by activating and modifying
the tags as desired.

1. Open a blank text file in a plain text text editor, such as Notepad or
UltraEdit. Do not use Wordpad.

2. Copy the sample PrintLink configuration file and paste it into the
text file.

3. Edit the configuration file to activate the tags and modify them as
required:

● To activate a tag, remove the crosshatch (#) in front of the tag.
● To modify a customizable tag, activate the tag and change the

variable. See the list of PrintLink-specific variables in About
Customizing Tags in the PrintLink PPF File.

● To modify a default press interface setting, activate the tag and
change the value—for example, from =false to =true.

4. Save the text file to a volume mounted on the Prinergy server.
Name it PrintLinkConfig.txt.
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Sample PrintLink configuration file
The sample PrintLink configuration file has no tags activated. To make
a tag active, remove the crosshatch (#) in front of a tag.

################################

# PrintLink Configuration File #

# (Created February 2005) #

################################

#Custom template for /CIP3AdmJobName

#AdmJobName=%job%

#Custom Template for /CIP3AdmSheetName

#AdmSheetName=%signature%/%sheet%%side%

#Custom template for /PageSection (only written for GenericNewspaper

#PageSection=%signatureletter%

#Less common settings - these override the settings in the press interface

#ReplaceUnderscoresFromJobName=false

#RotateWithPreviewMatrix=false

#OutputJDF=false

#UseImpoNameForAdmJobName=true

#UseSigNumInSheetNum=false

#UseImpoNameInFilename=true

#OutputLowPageNumber=false

Customizable tags in the PrintLink PPF file
Since some press interfaces require additional details in the PrintLink
PPF file that are not included in the CIP3 specification, you can
customize the CIP3 tags with variables and change the default press
interface settings in the PrintLink configuration file.

Customizable tags

In the PrintLink configuration file, you can customize the following tags
with Prinergy custom file naming variables:

/CIP3AdmJobName

/CIP3AdmJobCode

/CIP3AdmSheetName (explained below)

/PageSection (explained below)
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For example, if your Prinergy job name is Docket12345, and the
PrintLink configuration file says AdmJobName=%job%, the CIP3 tag in
the PPF file prints /CIP3AdmJobname (Docket12345).

Variables specific to PrintLink

You can customize the CIP tags with any valid custom file naming
variables, but the following are specific to PrintLink.

Variable Description

%jobcode% This variable takes the job code value as defined in the
Prinergy job attributes. You can use this variable in
the /CIP3AdmJobName and /CIP3AdmJobCode tags.

%Side% The variable prints F for front or B for back. Use this
variable with the /CIP3AdmSheetName tag.

%SideJapanese% This variable prints O for Omote (front) and U for Ura
(back). Use this variable with the /
CIP3AdmSheetName tag for Japanese output.

%Lowpagenumber% This variable prints the low page folio on any given
surface. It is the default variable for the /PageNumber
tag, however, some newspaper press consoles require
the low page folio in the /CIP3AdmJobName tag.

%SignatureLetter% This variable replaces the Prinergy signature number
with a letter. For example, signature 1 is replaced with
an A, signature 2 is replaced with a B, and so on.

Use this variable with the /PageSection tag.

Changing default press interface settings

You can edit the PrintLink configuration file to override the following
press interface defaults. You activate the tag by removing the
crosshatch (#) and then changing the default value (for example, from
=false to =true).

#AdmInkColors=true (to add spot colors in L*a*b*. This is useful for
Brisque customers who are migrating to Prinergy and use Heidelberg
Reader Stations.)

#AlwaysFront=true (to output backs to fronts.)

#SwapFrontswithBacks = true (to output so that back data appears
before front data)

#ReplaceUnderscoresFromJobName=false

#RotateWithPreviewMatrix=false

#OutputJDF=false

#OutputLowPageNumber=false

#UseImpoNameForAdmJobName=true
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#UseSigNumInSheetNum=false

#UseImpoNameInFilename=true

#MirrorWithPreviewMatrix=false

#AdmJobName=%job%

#AdmSheetName=%signature%/%sheet%%side%

#PageSection=%signatureletter%

#OutputLowPageNumber=false (to output special newspaper tags in
the PPF file)

#AdmInkColors=false (to output the AdmInkColors tag in the PPF file)

#OutputKBATags=false (to output special KBA tags in the PPF file)

#KBAPlateType=Broadsheet

#KBAPageType=Broadsheet

/CIP3AdmSheetName tag

Some ink key reader stations need the /CIP3AdmSheetName tag to
define the web and sheet numbers in a web.sheet format. For multiweb
impositions to work with PrintLink and Prinergy you must first create
each web as its own signature in Preps.

Then edit the PrintLink configuration file to read:

/CIP3AdmSheetName=%signature%.%sheet%

The PPF File prints the following values.

For web/signature 1:

/CIP3AdmSheetName (1.1)

where

1.1 = web 1, sheet 1

For web/signature 2:

/CIP3AdmSheetName (2.1)

where

2.1 = web 2, sheet 1

For more information about how to set up the multiweb impositions
see the technical bulletin Configurable PrintLink.

/PageSection tag

The /PageSection tag is populated when you activate it in the PrintLink
configuration file and select Generic Newspaper Press Interface in the
Press Interface list in the PrintLink section of the process template.

PrintLink 749



Because Prinergy does not use sections, substitute signatures instead.
Create each section as a signature in Preps. Then use the variable
%SignatureLetter% to change the signature number to a letter—for
example, signature 1 to pagesection A, signature 2 to pagesection B,
and so on.

For example,

When you edit the PrintLink configuration file to read:

/PageSection=%SignatureLetter%

The PPF file prints:

/PageSection (A)

where

A = signature 1

Alternatively, you can set up sheets or surfaces as sections, and use
the %sheet% or %surface% variables.

Ink reports

About ink reports

An ink report is a text file that describes the amount of ink coverage on
a plate, allowing you to better estimate ink consumption for a job.

The ink report analyzes the CIP3 PPF file generated by PrintLink digital
ink-profiling software to calculate the number of pixels turned on for
one or more separations, and creates a report of the area of ink
coverage (in square inches and centimeters) and the percentage of the
plate covered.

You can automate the running of the ink report by using a final output
process template that outputs the CIP3 PPF file to a hot folder. The ink
report monitors this hot folder and outputs a text-based report. This
feature can be used once the pages have been assigned to an
imposition.

You must set up the ink report feature on the primary server before
you can use the feature. After the initial setup, you can create a final
output process template, and use that process template whenever you
want to create an ink report for your job.

Dealing with RIP error files

Occasionally an error may occur when PostScript or PDF files are
submitted to the RIP. When an error occurs, PPF files are not
generated. You must resubmit the PDF or PostScript file to the RIP to
generate PPF files.
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PPF file naming conventions for Prinergy

Prinergy creates a name for each PPF file generated. The names are
composed of the following elements:

● The first nine characters of the job name
● The Virtual Proofing System naming convention: signature/

separation/surface/color convention
● The imposition name
● The PPF file name extension

For example, PPF file names might be:

● testjob.1A.Y.StoryworksLayering.ppf
● testjob.2A.C.StoryworksLayering.ppf
● testjob.2A.K.StoryworksLayering.ppf
● testjob.2A.M.StoryworksLayering.ppf
● longtestj.2A.Y.StoryworksLayering.ppf

Creating a process template for an ink report

1. In Process Template Editor, create a new final output process
template.

2. In the Output To box of the process template, select an output
type.
For example, select TIFF.
The PrintLink section becomes selectable.

3. Select the PrintLink check box and expand the section.

4. In the PrintLink section, select the options as follows:

a. For Output Type, select Absolute File.
b. In the Put Files in Directory box, browse to the ink report hot

folder—for example, J:\Ink\In—and select it.

c. For File Generation Mode, you may want to select One File per
Sheet.

This will put all ink-coverage values for all separations and both
surfaces into one text file.

5. Clear the check box beside the Device section, because you may
not want to produce output that would waste disk space.
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Setting up the ink report daemon

1. On the primary server, search the %AraxiHome%\CreoAraxi
\bin\Ink directory to find the shortcut file named Ink Reporting,
and drag this file onto the desktop.

2. Right-click the shortcut, and select Properties.

3. If desired, edit the paths in the Target box.

In the Target box is the command to run the ink report, and two
parameters. The first parameter is the path to the hot folder where
the CIP3 .ppf files are placed. The second parameter is the directory
where ink reports will be generated.

The default path for the hot folder is J:\Ink\in and the default
path for the reports is J:\Ink\reports.

4. Double-click the shortcut.
This action will launch the Ink Report daemon that will begin
monitoring the hot folder. If any directories for the hot folder or
report output do not exist, the Ink Report daemon will create them.
This process will run in a minimized window.

Previewing loose pages

About previewing loose page output

While you're setting options in the loose page output process template
you can preview the position of PDF pages on media.

The purpose of this feature is to save you time and media. It lets you
preview before you process the files.

Imposition Preview dialog box on page 753

Previewing loose page output on page 752

Previewing loose page output

1. Open a new or existing process template:

a. From the Tools menu, select Process Template Editor.
b. In the Process Template Editor window, expand Loose Page

Output and then expand the group that you want to use.
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c. Double-click a process template to edit it or right-click a process
template and select New Process Template to create a new
process template.

2. In the loose page output process template, click the Layout
horizontal bar.

3. In the Layout section, set the options as desired.

4. Click Preview.

5. In the Imposition Preview dialog box, in the Assumed Page Size list,
select a size.

6. Change the options in the Layout section and view the changes as
desired.

7. Click Close.

8. Save and/or close the process template.

9. Close Process Template Editor.

Imposition Preview dialog box

graphic

Graphically displays how the PDF pages will fit on the selected
media based on the settings in the Layout section of the loose
page output process template and the page size you specify in
the Assumed Page Size list.

Assumed Page Size

Lets you specify the size of the PDF pages to which you will
apply the loose page output process template. Select a page
size, and then select a unit of measure.

You can choose one of three sizes: US Letter, A4, or Custom.

When you select US Letter, the Width and Height options
automatically display the US letter dimensions. You can then
select a unit of measure.

When you select A4, the Width and Height options
automatically display the A4 dimensions. You can then select a
unit of measure.

When you select Custom, the Width and Height options are set
to zero. You can then specify custom dimensions and select a
unit of measure.

Media

Displays a graphic of the media size. You cannot hide the
graphic; it is permanently displayed.
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Crop

Graphically displays a crop box on the graphic based on the
settings in the loose page output process template.

Select the Crop check box to display the crop box; clear the
check box to hide the crop box.

Bleed

Graphically displays a bleed box on the graphic based on the
settings in the loose page output process template.

Select the Bleed check box to display the bleed box; clear the
check box to hide the bleed box.

Trim

Graphically displays a trim box on the graphic based on the
settings in the loose page output process template.

Select the Trim check box to display the trim box; clear the
check box to hide the trim box.

Sheet Marks

Graphically displays an icon for sheet marks on the graphic in
the location specified by the settings in the loose page output
process template.

Select the Sheet Marks check box to display the icon; clear the
check box to hide the icon.

Page Marks

Graphically displays an icon for page marks on the graphic in
the location specified by the settings in the loose page output
process template.

Select the Page Marks check box to display the icon; clear the
check box to hide the icon.

Special output

Creating PDF/X output

Use this procedure if your input files do not contain transparent
objects. If your files have complex transparency effects, use the
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Creating PDF/X output from complex transparency files procedure to
avoid transparency problems with the flattener.

1. Refine input files to PDF/X.

Select PDF/X-1a:2001 in the Generate box at the top of the refine
process template.

2. Output to PDF/X. Perform one of the following steps:

○ Start a loose page output process template and select PDF/
X-1a:2001 in the Output To list at the top of the process
template.

○ Publish a PDF file and select PDFX1a in the Output To list in the
Publish PDF Files dialog box.

Creating a process template for DCS vector output

DCS vector output is separated; it uses the DCS file format standard
and meets the PostScript Level 2 standard. It is intended to support
iMPact and other workflows that require PostScript Level 2 input.
Because it is vector-based, screening can be handled by the target
workflow.

DCS vector output is different from DCS raster output, another
Prinergy output format. DCS raster output contains already RIPed,
screened bitmap data that can be used with any raster-based proofer.
DCS vector output contains data that is not RIPed or screened; it is
intended to be further processed in another workflow or RIP.

1. Open a new or existing process template:

a. From the Tools menu, select Process Template Editor.
b. In the Process Template Editor window, expand Loose Page

Output and then expand the group that you want to use.
c. Double-click a process template to edit it or right-click a process

template and select New Process Template to create a new
process template.

2. In the loose page output process template, from the Output To list,
select DCS (Vector output).

3. In the Render section, in the JTP list, select the JTP for DCS vector
processing.

4. In the File Format section, set the options as desired.

The following options are specific to generating DCS vector files:

● DCS File Format
● Add TIFF Preview to DCS Master File
● Render Shadings
● Font Outlining
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5. From the File menu, select Save As, and then name and save the
process template.

6. Start an output process on your PDF files, using this process
template, to create DCS vector files.

Creating a process template for thermal bluelines

To create thermal bluelines, you must first create an imposition output
process template for thermal bluelines. Then, select the front and the
back of the signature in Job Manager, and start an imposition output
process using the thermal blueline process template that you created.

Note: Before starting the output process, ensure that you select an entire signature
from the imposition—that is, the front and back of the signature. For work-and-
turn impositions, select the single side.

Prinergy always generates a TIFF file for each side of the imposition
plan, and it generates the files in the correct orientation for the thermal
blueline media, regardless of the imposition style used in the job. As a
result, when you turn the media on the device, the images always back
up.

1. Open a new or existing process template:

a. From the Tools menu, select Process Template Editor.
b. In the Process Template Editor window, expand Loose Page

Output or Imposition Output and then expand the group that
you want to use.

c. Double-click a process template to edit it or right-click a process
template and select New Process Template to create a new
process template.

2. In the imposition output process template, in the Output To list,
select TIFF.

3. In the Layout section, set the following options:

Options Setting

Size Select Cut Sheet.

Duplexing Select Tumble.

Max Width Type the height (not the width, as the label implies)
of the thermal blueline media—for example,
30.3125.

Note: This is the Around the drum measurement in
the Print Console software.

Max Height Type the width (not the height, as the label implies)
of the imageable area of the thermal blueline media
—for example, 40.5.

Note: This is the Along the drum measurement in
Print Console.
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Options Setting

Orientation Select 90°.

Note: This option specifies the image placement in
the TIFF file.

Center Along Width Select the check box.

Center Along Height Select the check box.

4. In the Render section, set the following options:

Options Setting

JTP Select a TIFF output pool (for example, Proof).

Resolution X and Y Type 2400.

Color Model Select DeviceGray.

Shades Select 1.

Spot Color Handling Select Convert to process.

5. In the Calibration & Screening section, set the following options:

Options Setting

Calibration Curve Select %%NONE%%.

Screen Ruling Select 175.

at Angle Select 45.

Rotate Screens With Pages Select the check box.

Note: The system screens all separations at the same angle, and it always
uses Euclidean dot shape. As a result, you don't need to select a screen
system from the Screen System box or a dot shape from the Dot Shape box.
Prinergy sets the screen ruling to 175 lpi and screen angle to 45, regardless of
how you set the Screen Ruling and at Angle options.

6. In the Processed File Options section, clear the Overwrite Existing
Files with Same Name check box.

7. In the File Format section, in the Compression list, select RLE.

8. In the Device section, set the following options:

Options Setting

Output Type Select Absolute File or Printer.

Device Path Specify the path to the thermal blueline hot folder for
Print Console.

9. From the File menu, select Save As, and then name and save the
process template.
You are now ready to start an output process, using this process
template, to create a thermal blueline.
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Creating a process template for Veris

You can output loose page output and imposition output to the Kodak
Veris digital proofer. To output Veris proofs, create a process template
for the Veris digital proofer and use that process template when
outputting to the proofer.

You can generate imposition output only if the imposition fits in the
imageable area of the Veris digital proofer. The imageable area is 533
mm by 724 mm (21 inches by 28.5 inches)—or you can tile in Prinergy.

Before creating a process template for the Veris digital proofer, you
must first export the current Veris ICC profiles from the Proofer
Controller to a volume mounted on the Prinergy server. The profiles are
stored on the Proofer Controller and can be exported using the export
utility. For information on how to export ICC profiles, see the Kodak
Veris proofer documentation.

Note: You can use your own custom ICC profiles. If you use custom ICC profiles,
you must calibrate your proofer and tag all profiles before creating proofs, using
the Kodak Certified Process. Contact a service representative to get a profile
tagged as a certified profile.

1. Open a new or existing process template:

a. From the Tools menu, select Process Template Editor.
b. In the Process Template Editor window, expand Loose Page

Output or Imposition Output and then expand the group that
you want to use.

c. Double-click a process template to edit it or right-click a process
template and select New Process Template to create a new
process template.

2. In the Output To list, select Veris/Matchprint Inkjet.

3. In the Device section, in the Proofer Name list, select the proofer
that you want to print to.
The proofer's model appears in the Proofer Model box.

4. In the ColorConvert section, set the following options:

a. Select Match Colors in Page Content.
b. For Assumed Final Output Profile, select the Exactly As Defined

Below check box.
c. For Source or DeviceLink Profile, click Browse and locate where

you stored the Veris ICC profiles that you exported from the
Kodak digital proofer.
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5. In the Layout section, set the following options:

a. In the Media Configuration list, select the Veris media type.
b. In the VerisSheetTemplates list, select the applicable template

for your proofing job.

For information on the template settings, see the Kodak digital
proofer documentation.

6. If you are generating loose page output, in the Layout section, set
the following options:

a. For Style, select N-up to print more than one PDF page on a
sheet of media.

b. In the Number of Pages Across and Down boxes, type the
number of pages.
The pages must fit in the imagable area, which is 533 mm by
724 mm (21 inches by 28.5 inches). For example, you can fit
four 8.5-by-11-inch pages, with two pages across and two pages
down.

c. In the Vertical Gutter Width and Horizontal Gutter Height
boxes, type the gutter amounts and select the unit of measure
from the list.

7. From the File menu, select Save As, and then name and save the
process template.

Creating PDF 1.3 output from complex transparency files
If you require output containing no transparent objects, and the
flattener causes output problems due to complex transparency effects
in your input file, use this procedure to ensure that the file prints
correctly regardless of the downstream RIP.

If you require output that does not contain transparent objects (for
example, PDF/X-1, PDF/X-3, or PDF 1.3 output), process the file as
PDF 1.4 through Prinergy. Otherwise, the flattener in the CPSI RIP can
cause output problems (either on refine or rendering) because of
complex transparency effects in your file. Once the files are ready to
send out, use APPE to output the files to PDF raster.
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1. Refine the input files without flattening, including the following
options:

a. In the Normalize section of the refine process template, in the
PDF 1.4-1.6 (Acrobat 5-7) box, select Leave as is.

b. Perform all operations such as trapping and Color Matching on
the unflattened file.

2. Once the pages are ready to send out, set the job to use APPE.

a. In the Edit menu of Job Manager, select Edit Job Attributes.
b. In the Edit Job Attributes dialog box, in the RIP Name box,

select Adobe PDF Print Engine.

3. Output to PDF raster.

a. Start an output process.
b. In the Output To box at the top of the process template, select

PDF Raster .
c. Set options in the Render section as desired.

For example, output to 600 dpi, 256 shades with antialiasing set
to 2.

The result is a raster PDF that you use as the exchange file. The file will
contain contone data, and will be large and uneditable. Nevertheless,
the file will print correctly regardless of the downstream RIP.

Page set booklets

About page set booklets

Page set booklets are two-sided proofs of pages in reader order that
can be printed on a duplexing laser printer.

You generate this type of proof after assigning pages to page positions.
The purpose of the page set booklet is to ensure that the pages are
correctly assigned.

The order in which you select the pages is the order Prinergy uses
when creating a saddle-stitched imposition. You can either sort the
pages in the desired order then select them, or press the command key
(Mac) or CTRL key (PC) while selecting individual pages in the order
you want.

Note: If you selected pages then changed the sort order, the sort order of the
selected pages changes to match the new sort order. To maintain the selected sort
order while you sort pages (for example, if you're looking for another page to
select), press the Shift key while you're sorting.

Page set booklets are also called saddle-stiched imposition output or
feel-good books.
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Creating a process template for page set booklets

1. Open a new or existing loose page output process template:

a. From the Tools menu, select Process Template Editor.
b. In the Process Template Editor window, expand Loose Page

Output and then expand the group that you want to use.
c. Double-click a process template to edit it or right-click a process

template and select New Process Template to create a new
process template.

2. In the Output To box, select the file type supported by the laser
printer you will use to print page set booklets.
For example, select EPS Raster.

3. In the Render section, set the following options:

a. In the Resolution X box, type the resolution of the laser printer
you will use to print page set booklets.

b. Clear the Do Separations check box.

Note: If you select the Do Separations check box, you cannot select a
duplexing option in the Layout section.

4. In the Layout section, set the following options:

a. In the Media area, in the Size box, select Cut sheet, and then set
the Max Width and Max Height boxes to the paper size for the
printer you will use.

b. In the Duplexing box, select Turn or Tumble, whichever
matches the print queue setting for the printer.

c. Use the Front Shift Along Width, Along Height, Back Shift
Along Width, and Along Height options to compensate for any
backup registration errors exhibited by your printer.
For example, paper may change size as it goes through a laser
printer.

d. In the Placement area, beside Type, select Page Set Booklet.
e. Beside Style, select 2 x 1.
f. Set the Vertical Gutter Width box to 1 inch.
g. In the Scaling area, set the Non-Printable Margin boxes to

match the settings of the printer.
h. If the pages are too big for the paper, select the Reduce to Fit

Media check box.
i. In the Spacing area, select the Reduce Gutters If Required check

box, and then specify a minimum gutter size in the Min Vertical
Gutter Width box.

5. Set the options in the Marks section as desired.
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6. In the Device section, set the following options:

a. Beside Output Type, select Absolute File or Printer.
b. In the Device Path box, type the network path to the printer.

When you specify a printer, some of the settings in this section
are automatically updated to match that printer.

7. Set other settings in the Device, File Format, and Processed File
Options sections as required by your printer, or use the default
settings.

8. From the File menu, select Save As, and then name and save the
process template.

Generating a page set booklet

1. After adding and refining input file, create a page set and assign
pages to the page set.

2. In the Page Sets pane of the Pages view, select the pages you want
to print.

Note: Ensure that you select the pages in the order in which you want them
printed. The order in which you select the pages determines the order of the
pages in the booklet.

3. Start a loose page output process template that is created
specifically for page set booklets.

Signature booklets

About signature booklets

Signature Booklet (digital blueline proofing) is a feature in Prinergy for
creating 1-up or 2-up reader-order proofs of the page set positions
from an imposition plan layout. You can create a signature booklet
simply by starting a process template.

Signature Booklet offers similar functionality as iMPact Digital Blueline.
The output proof is the same reader-order booklet, but the method to
achieve it is different. Prinergy creates the signature booklet by
deimposing the imposition plan layout into individual pages, RIPing the
pages, and then outputting them-in reader order-to a duplexing laser
printer or file. If outputting to a PDF raster or vector file, you can
choose to output in a multipage format where the complete signature
booklet is in one file, or you can output in a single-file format where
each 1-up or 2-up page is saved to its own file.

You can output a signature booklet to any file type listed in the Output
To list in the imposition output process template.
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Diagram: Creating a 1-up signature booklet

Diagram: Creating a 2-up, folded signature booklet

Preparing to generate a signature booklet

Before configuring the imposition output process template, determine
the signature booklet output format and connect the printers.

1. Determine the signature booklet format, and collect the necessary
information, using the following table as a guide.

If Outputting To Determine

A printer ● The name and location of the printer
● The paper orientation: portrait or landscape?
● The duplexing style: turn or tumble?
● The signature booklet format: 1-up or folded 2-up?

A file ● The paper orientation: portrait or landscape?
● The signature booklet format: 1-up or 2-up?

A PDF file ● All pages output to one file?
● Each pages output to its own file?

2. If outputting to a duplexing laser printer, determine the correct
name of the printer, and connect the printer in one of the following
ways:

○ Mount the laser printer on the Prinergy server using Prinergy
Administrator.
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For more information, see the Prinergy System Administration
guide.

○ Configure the printer in a Windows print queue.

Creating a process template for signature booklets

If you are printing signature booklets on more than one duplexing laser
printer, create an imposition output process template for each printer.
The settings in the process template are device-specific, so you cannot
share imposition output process templates among several printers.

Because there is only one Windows Print Manager document for each
signature booklet, you cannot load-balance the printing of signature
booklet among several printers.

Note: Be sure to test each process template on its specified printer.

1. Plan the signature booklet format and connect the printers.

2. In any window, from the Tools menu, select Process Template
Editor.

3. In the Process Template Editor dialog box, right-click the
Imposition Output group and select New Process Template Group.

4. Name the new imposition output group Signature Booklets.

5. Open an existing imposition output process template from within
the Mockup group.

6. From the File menu, select Save As and save it in the new
Signature Booklets group.

You may want to name it according to the output format or output
device—for example, 1-up_8.5x11_Turn_HP5Si or 2-
up_Digital_PDFRaster_100dpi.

7. In the Output To list, select the output format of the signature
booklet.

8. If you are outputting to a black-and-white printer, expand the
ColorConvert section and set the following options:

Options Instructions

Match Colors in Page
Content

Clear the check box. No input profiles are required.

Proof Process
(Destination) profile

Select the output ICC profile as follows:

a. Click Browse.
b. In the File Browser dialog box, browse to the ICC profile: %ServerName%\

%AraxiHome%\CreoAraxi\data\ICC-Profiles\gray
\GenericGray.icm
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9. Expand the Layout section and set the following options:

a. In the Media area:

Options Instructions

Size Select the paper size:

● If outputting to a printer, select Cut Sheet.
● If outputting to a file, select Digital.

Max Width and
Max Height

These options apply only if you are outputting directly to a printer.

a. In the Max Width box, type the width of the paper and select the unit of
measure from the list.

b. In the Max Height box, type the length of the paper and select the unit of
measure from the list.

The values you type in these boxes must match the laser printer's paper
orientation (portrait or landscape).

Portrait: Landscape:

 

● For example, for a 1-up portrait orientation, you would type 210 mm (8.5
inches) in Max Width and 297 mm (11 inches) in Max Height.

● For example, for a 2-up landscape orientation, you would type 420 mm (17
inches) in Max Width and 297 mm (11 inches) in Max Height.
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Options Instructions

Duplexing This option applies only if you are outputting to a printer.

Match the laser printer's duplexing style as follows:

● If the paper orientation is set to portrait and the duplex style is set to flip on the
long edge, select Turn.

● If the paper orientation is set to landscape and the duplex style is set to flip on
the long edge, select Tumble.

b. In the Placement area:

Options Instructions

Orientation Select 0º.

Center Along Width Select this check box to center the page horizontally. This check box must be
selected for the signature booklet to output correctly.

Center Along Height Select this check box to center the page vertically. This check box must be
selected for the signature booklet to output correctly.

c. In the Scaling area:

Options Instructions

All options Clear all options in this area.

d. In the Signature Booklet area:

Options Instructions

Enable Signature
Booklet

Select the check box to make the signature booklet options available.
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Options Instructions

Type Select how many pages will output on the sheet:

● To output two PDF pages per sheet (one front and one back) in reader
order by signature, select 1-up.

● To output four PDF pages per sheet (two front and two back) in reader
order by signature, select 2-up.

Document Folding
Style

This list becomes available when you select 2-up from the Type list.

Select how the signature booklet will be folded:

● If you want a vertical fold, select Book-fashion.
● If you want a horizontal fold, select Calendar-fashion.

Use and with Offset Select Bleed Box or Trim Box.

Determines how much of the area around the page's bleed or trim box to
include when printing. You can increase the offset amount to see the bleed
area, gutters, imposition and page marks, and parts of neighboring imposed
pages. Be sure the output sheet is large enough to accommodate both the
pages and the bleed or trim offset amount.

● To print with only the final bleed or trim, type 0.0.
● To image content outside the page's bleed or trim box, type a positive

value and select a measurement from the list. The offset amount you
choose depends on the size of the gutter. Typically 6 to 13 mm (0.25 to 0.5
inches) is sufficient.

Duplex Offsets This option applies only if you are outputting to a duplexing printer.

Adjust for the mechanical misalignment in the laser printer's unit. There are
alignment test targets that you can run that measure how far off the front and
back are from center. Use the Front X and Y and Back X and Y values to
compensate for any misalignments. Select the units of measure in the list.

Page Marks Identify the name and location of a PDF file containing the page marks. Click
Browse to locate and select the marks file.

The variable mark $[PagePositionNumber] or $[PPN] can be used to verify
that the pages are in the correct page set positions in the imposition.

Calibrate Select this check box to apply calibration curves to the marks. The calibration
curve is set in the Calibration Curve list in the Calibration and Screening
section.

Locate Page Marks
Adjacent To

Select where to place the page marks in relation to the page's trim box.

When you select Right or Left, the page marks rotate as follows:

● Left—rotates the mark 90º counterclockwise
● Right—rotates the mark 90º clockwise
● Bottom—no rotation
● Top—no rotation
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Options Instructions

at Distance Place the page marks just outside the bleed box. Otherwise, the page mark
may get associated with an adjoining page, or it may overprint onto another
page.

You may need to increase the Use Trim Box with offset amount to see the
page marks.

10. Expand the Render section and set the following options:

Options Instructions

JTP Select a proofing job ticket processor (JTP).

Resolution X and Y Select the output resolution for both the X (horizontal) and Y (vertical) axes.

11. Complete any remaining options in the Render section according to
the output device.

12. Configure the Calibration and Screening section according to your
output device.

13. Expand the Device section and set the following options:

Options Instructions

Output Type Select the output type and specify its location:

● If outputting to a printer, select Absolute File or Printer and either type the printer
name or click Browse and browse to the printer location.

● If outputting to a file that will be stored on a mounted volume, select Absolute File
or Printer, click Browse and browse to the location.

● If outputting to a file that will be stored in the job folder, select Job-Relative File
and type the folder name.

Important: Do not select Submit as Multiple Print Job. If this check box is selected,
the signature booklet will output one page at a time.

14. Expand the Processed File Options section and set the following
options:

Options Instructions

Prinergy-define File
Naming

If outputting to a printer, select Use Prinergy-defined File Naming and leave the
remaining options at their default settings.

Custom File Naming If outputting to a file, do one of the following:

● Select Use Prinergy-defined File Naming and leave the remaining options at
their default settings.

● Select Use Custom File Naming and in the Filename Template box, type the
file name tags.

Exception: If you are outputting to single-page PDF files, you must select Use
Custom File Naming and include the variable tag %outputsheetnum% as part of
file name template. Otherwise, the pages will overwrite each other.
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15. Expand the Marks section and set the following options:

Options Instructions

Draw Trim and Bleed Marks Select the On Content option.

Locate Crop Mark of Length Type the length of the crop mark, and select the unit of measure from the
list.

at Distance Type the distance of the crop mark from the trim box.

16. If you selected a PDF file format in the Output To list (for example,
PDF Raster or PDF Vector), expand the File Format section and set
the following options:

Options Instructions

Document
Format

Select how you want the PDF files saved:

● If you want all pages of the signature booklet in one file, select Multi Page.
● If you want each page in the signature booklet saved as a separate file, select Single

Page.

Important: If you select Single Page, include the variable tag %outputsheetnum% in the
Filename Template box. (See the exception above.) Otherwise, each page will overwrite
the previously saved page.

17. Complete the remaining options in the Device section according to
the requirements of the output type selected in the Output To list.

Note: The available options in the File Format section change depending on
what you select in the Output To list.

18. From the File menu, select Save.

19. From the File menu, select Close.

Generating a signature booklet

If you are outputting the signature booklet to a networked printer,
before you print the signature booklet, be sure to verify the printer's
default settings against the process template you configured for that
printer. For example, check the default paper tray, the paper
orientation, and the duplexing style (turn or tumble).

The following table summarizes the critical settings that must match
between the printer and the Layout section (Media area) of the
imposition output process template.

Output Printer Settings Process Template Settings

1-up Portrait orientation, flip
on the long edge (turn)

Max Width: 210 mm (8.5 inches)

Max Height: 297 mm (11 inches)

Duplex: Turn
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Output Printer Settings Process Template Settings

2-up Landscape orientation,
flip on the long edge
(tumble)

Max Width: 420 mm (17 inches)

Max Height: 297 mm (11 inches)

Duplex: Tumble

1. In the Imposition Plans pane in the Signatures view, select the
imposition or signatures you want to generate as a signature
booklet.

2. Start the imposition output process template you configured for
signature booklets.

3. Wait while Prinergy processes the signature booklet.

While it may appear that Prinergy has stopped responding between
the color match and render processes, it has not. This is part of the
process where the system is deimposing the imposition plan.
Depending on the size and number of signatures being processed,
this step may take some time. (You can view the processing time in
the job's History view.)

Current, iMPact Digital Blueline users who make the switch to
Signature Booklet might experience different performance results
between the two products due to their different technologies and
integration with Prinergy Workshop.

770 Chapter 12—Outputs



13 Approvals

About approvals
Use approvals to indicate whether elements are ready to move to the
next step in the workflow. Prinergy provides two types of approvals:

● Customer approval of pages
● Proof approvals

Customer Approval of Pages

Each page can have a customer approval status. This status helps you
work with customers using Prepress Portal. It can also help reduce
errors in your workflow by preventing further refining or output based
on status.

If a job is web-enabled customers can set approval status of each page
using Prepress Portal.

You can also set approval status in Prinergy. However, it is better to use
Prepress Portal, because changes in Prepress Portal trigger automatic
e-mail notifications from Prepress Portal.

Depending on how Prinergy Administrator is configured, Customer
Approval status may affect whether you can run certain processes:

● You may not be able to refine a page again if it has a Customer
Approval status set to Approved.

● You may not be able to output using imposed proof process
templates or the final output process templates if any pages used in
the surface or signature are set to Rejected.

● You may not be able to output using imposed proof process
templates or the final output process templates unless all of the
pages used in the surface or signature are set to Approved or
Approval Not Required.

You can see the Customer Approval status in Prinergy by:

● Getting information about an element on page 31
● Displaying and hiding columns on page 1034 to make the Customer

Approval column appear in the Pages pane of either the Pages view
or the Signatures view



Proof Approvals

You can record approval or rejection of every proof that you create. For
example, if you print a content proof for a customer, you can indicate
its approval before doing a contract proof. To use this approval
method, you must first create a proof.

Proof approvals are for internal information only. They are not visible to
customers using Prepress Portal, and have no effect on what you can
do in Prinergy.

After you set the approval status, an approved icon  or a rejected icon
 appears in the column for the proof process, if you are in list view.

Changing the approval status of pages
This procedure explains how to change approval status of a page in
Prinergy. For information on changing approval status through Prepress
Portal, see the Prepress Portal documentation.

1. In Job Manager, switch to the Pages view or the Signatures view.

2. In the Pages pane, select one or more pages.

3. From the Edit menu, point to Customer Approval and then select a
specific status or select Clear to remove any status.

4. In the approval dialog box, enter a comment and click OK.

Changing the approval status of proofs

1. Generate the proof.

A new column dynamically appears with the same name as the
proof process template that you used. For example, if you used a
Virtual Proof process template, a Virtual Proof column appears.
This column contains status icons, such as , indicating whether the
process was successful.

2. Select the status icon in the proof column next to the element that
you generated a proof of, and select Approve or Reject to set the
status or select Clear to remove a status.

For example, if you want to approve a virtual proof of a surface,
select  in the Virtual Proof column next to the name of the surface
that you used, and select Approve.

3. In the approval dialog box, enter a comment and click OK.

Depending on your choice, an approved icon  or a rejected icon 
appears in the column for the proof process, if you are in list view.
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Approval Comment dialog box
This name of this dialog box reflects the approval status that you
selected. For example, it is called Approval Requested dialog box when
you select Approval Requested status.

Comment

Enter a comment that explains why you assigned the status of
the page.
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14 Color

Color spaces

About color spaces

Each color library must be associated with a color space. Each color
space must be associated with an ICC profile, which is used to populate
the colorants list. We recommend that you name color libraries and
color spaces according to the associated ICC profile.

With the Color Space Editor, you can create new color spaces or change
a color space by editing the component (colorant) names. Changes to
the colorant names are written to the associated ICC profile.

The following color spaces are provided with Prinergy, and are not
editable or removable:

● CMYK—Adobe SWOP sheetfed
● RGB—Adobe RGB 1998
● L*a*b*—CIELAB 1976 (the Prinergy default)

You are responsible for creating color recipes for the colors in your
color space.

About converting color spaces

Using the Color Matcher with ICC profiles (Prinergy-provided or
custom), you can convert:

● RGB to CMYK: RGB graphics and images can be automatically
converted to CMYK.

● CMYK to CMYK: The Color Matcher can convert the color space of
a PDF file to a color space appropriate for a specific output device.

● Device-independent color spaces to a device color space: The Color
Matcher can convert a device-independent color space such as
L*a*b* to a final color space according to the ICC profile used.

The Color Matcher also enables you to:

● Map spot colors
● Perform overprint conversions
● Match colors



● Handle CMYK black
● Support extra colors such as L*a*b* color recipes

These features are available in various combinations in the refine, loose
page output, and imposition output process templates.

Managing color spaces

1. From the Tools menu, select Color Space Editor.

2. In the Color Space Editor, perform one of the following actions:

To Do This

Add a color
space

a. Click Add.
b. In the Color Space Name box, type the name of the color

space.
c. Click Browse. In the Select File dialog box, navigate to the

location of the ICC profile, click
Select"<ICCprofilename.icc>", and then click Apply.

Rename a
component

a. In the Color Spaces box, select a custom color space.
b. In the Components list, select a component, and click

Edit.
c. In the Rename Color Component dialog box, type the new

name, click OK, and then click Apply.

Remove a
color space

a. In the Color Spaces list, select a color space, and then
click Remove.

b. When the confirmation dialog box appears, click OK.

Color Space Editor window

Color Spaces

Lists the color spaces defined in Prinergy.

Color Space Name

Displays the color space name. If you are adding a new color
space, type the new name here.

ICC Profile

Displays the ICC profile associated with the color space. If you
are adding a new color space click the Browse button to browse
to an ICC profile.

Components

Lists the color space components.
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Add

Adds a new color to the Color Spaces area. When you click this
button, you need to enter a name and associated ICC profile in
the Color Space Name box before the Apply button can be
activated.

Remove

Removes the selected color space file from the Color Spaces
area.

Edit

Lets you edit the name of the selected component.

Apply

Click Apply to save the changes you've made and to apply them
to your current selection.

Revert

Click Revert to cancel the changes you've made and to revert
the options to the settings you last saved.

Rename Color Component dialog box

Rename color component <color> to

Type a new name for the color space component.

Select File dialog box

Unlabeled list and results area

Selecting an item in the list at the top left of the dialog box
displays that item's contents in the box below.

When you select:

● Volumes, the volumes in your system appear
● A volume name, folders at the root of the selected volume

appear
● A folder name, files within the folder appear

The path of the displayed item in the list appears in reverse
order, for example, folder name followed by volume name.

Volumes

Displays all volumes in the Prinergy system.
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Show Hidden Files

Select this check box to include hidden files, such as system
files, in the results.

You can set the default selection of this check box on the View
tab of the Workshop Preferences dialog box.

Select <file>

This button displays Select followed by the name of the file that
is selected in the lists above. Click it to select the specified file
and close the dialog box.

Menus in Color Space Editor
Note: The Edit menu is unavailable.

Workshop menu in Color Space Editor

Note: This menu is available only when running Prinergy Workshop on a
Macintosh client.

About Prinergy Workshop

Displays information about Prinergy Workshop, including the
version number, a list of licensed features, and the server name.

Preferences

Use to view and modify Prinergy Workshop preferences. When
you select this menu item, the Workshop Preferences dialog
box appears.

Note: On a Windows client, this menu item appears under the Edit menu.
On a Macintosh client, it appears under the Workshop menu.

Quit / Quit Prinergy Workshop

Quits Prinergy Workshop. Any open Prinergy Workshop
windows are closed.

File menu in Color Space Editor

Close Window

Closes the current window, but does not quit Prinergy
Workshop.

Quit / Quit Prinergy Workshop

Quits Prinergy Workshop. Any open Prinergy Workshop
windows are closed.
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View menu in Color Space Editor

Refresh

Updates the contents of the current window.

Tools menu in Color Space Editor

Change User

Displays the Connect to Server dialog box where you can log in
as another user without quitting Prinergy Workshop.

This menu item appears only if you have Kodak Prinergy
Business Link software connected to the Prinergy system.

Job Finder

Opens Job Finder.

If you are already in Job Finder, this menu item is unavailable.

Destroy History Entries

In the History view, select one or more history entries and then
use Destroy History Entries to delete the selected entries.

Process Template Editor

Launches Process Template Editor, where you can create and
modify process templates.

Automated Page Assignment Editor

Starts the Automated Page Assignment Editor, which you use
to create and check APA files.

Queue Manager

Launches Queue Manager, where you can view the Job Ticket
Processors (JTPs) and process types.

Media Manager

Launches Media Manager, where you can manage your archive
tapes and disk volumes.

System History

Launches System History, which displays the detailed history of
all the activity occurring outside of job context (such as jobs
and groups that were created or destroyed), as well as job
archive, purge, and retrieve history.
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Smart Hot Folder Manager

Launches the Smart Hot Folder Manager dialog box, where you
can add, edit and delete smart hot folders.

Configure Imposition Application

Displays the Configure Imposition Applications dialog box,
where you can identify the location of imposition software that
you want to integrate with Prinergy Workshop.

Start Imposition Application

Displays the Start Imposition Application dialog box, where you
choose which imposition software to start. You create this list
of imposition applications with the Configure Imposition
Application tool from the Tools menu. If an application requires
a license and is licensed, it appears in bold.

Color Editor

Launches Color Editor, where you can create color recipes for
all jobs.

Color Space Editor

Launches Color Space Editor, where you can create and edit
color spaces.

Font Converter

Launches Font Converter, where you can convert font files into
PFA (Printer Font ASCII) format, which Prinergy requires to
correctly process fonts.

Preflight Profile Manager

Launches Preflight Profile Manager, where you can, during the
refine process, evaluate PDFs to detect problems that may
affect processing in a publishing or prepress workflow.

Digital Print Administration Console

Launches the Digital Print Administrator, where you can add
and configure a digital print application that Prinergy can launch
to print PDFs.

Rule Set Manager

Opens the Rule Set Manager, where you can create and edit
rule sets. The Rule Set Manager also lets you organize rule sets
into groups.
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Activate Rule Set in Selected Jobs

Opens the Select Rule Set dialog box, where you can activate
rule sets for one or more jobs.

Help menu in Color Space Editor

Online help

Starts your Web browser and displays the Prinergy online help.

On <current window or view>

Starts your Web browser and displays the Prinergy Workshop
user guide, open to the topic for the currently selected window
or view.

Quick Start Guide

Starts Adobe Acrobat and displays a PDF file of the Prinergy
Connect Quick Start Guide

eCentral Online Support

Starts your Web browser and displays the eCentral portal at 
https://ecentral.kodak.com/.

Visit graphics.kodak.com

Starts your Web browser and displays the Kodak Web site at 
http://graphics.kodak.com/default.htm.

About Prinergy Workshop

Displays information about Prinergy Workshop, including the
version number, a list of licensed features, and the Prinergy
server name.

Note: This menu item appears on the Help menu only when you are
running Prinergy Workshop on a Windows-based client computer. On a
Macintosh client computer, the menu item About Workshop appears on
the Workshop menu.

Color libraries and definitions

About color libraries and definitions

Use the Color Editor to manage color libraries and color definitions in
Prinergy.

Color definitions can improve job color accuracy and consistency by
replacing color definitions that are defined in the input file with color
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recipes that are specific to the final printing condition (device, media,
inks, and so on).

For example, in composite PostScript or PDF files, override inconsistent
color recipes in a job with a standard recipe so a spot color can be
converted to process or simulated on a proof in the same way
throughout a job.

You can also use the Color Editor to store ink parameters necessary for
trapping. When trapping, the trapper looks to the color definition
(found according to the library search order specified in the refine
process template) for a color's opacity and neutral density values. If
the color is not found, the Trapper assumes an opacity value of Normal
and determines the neutral density value from the CMYK values in the
input file.

Color libraries and alternate color spaces

Color definitions are grouped into libraries. Each color library is
associated with an alternate color space. Each alternate color space
(ACS) is associated with an ICC profile, which is used to populate the
list of colorants. We recommend that you name color libraries
according to the associated ICC profile.

The Color Editor uses the following types of color libraries:

● Factory libraries—are populated from named spot color systems—
for example, PANTONE. Factory libraries are preloaded into
Prinergy, and are available to all jobs.

● User libraries—are libraries that you populate

○ Global tab—contains color definitions that are available to all
jobs in the system.

○ Job tab—contains color definitions that are available only to the
job for which they are defined. Job-specific color definitions
override global color definitions of the same name.

Important: When you remove a user library, all color definitions in its global and
job-specific libraries will be deleted. You will be prompted to confirm.

Within a user library, you can copy colors between the Global tab and
the Job tab. By copying a color to the Global tab, you make the color
available to all jobs. By copying a color to the Job tab, you can
customize the color definition for the job without affecting the color
definition for other jobs.

You cannot copy colors between user libraries. But you can import and
export user libraries between Prinergy systems.
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When you export an entire job in Prinergy, the export includes job-
specific color definitions and their ACS and ICC profiles but does not
include global color definitions.

See also:
About neutral density on page 256
About how Prinergy searches for color definitions on page 783
About the PANTONE library on page 784

About how Prinergy searches for color definitions

When Prinergy looks for a color definition, it uses the color library
search order as specified in the Spot Color Handling section of the
job's refine process template.

PANTONE colors and related suffixes

Because a PANTONE color may have different suffixes, yet still have
the same recipe, Prinergy will search for the different permutations of a
PANTONE color name if it cannot find an exact match. For the list of
related suffixes, see the Auto-Resolve Spot Color Naming Conflicts
check box description in Spot Color Handling Section of the Refine
Process Template.

Color search order

Prinergy performs the search by:

1. First searching (for the exact color name) in the Job tabs of the
libraries in the listed order

2. Then searching (for the exact color name) in the Global tabs of the
user libraries and factory libraries in the listed order

3. Then, if a PANTONE color, searching for permutations of the
PANTONE color name in the Job tabs of the libraries in the listed
order

4. Then, if a PANTONE color, searching for permutations of the
PANTONE color name in the Global tabs of the user libraries and
factory libraries in the listed order

For example, if the libraries are listed in the following order:
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Listed Order Search Order

userlib1

factorylib1

userlib2

Job tab of userlib1 (exact match)

Job tab of userlib2 (exact match)

Global tab of userlib1 (exact match)

factorylib1 (exact match)

Global tab of userlib2 (exact match)

Job tab of userlib1 (loose match)

Job tab of userlib2 (loose match)

Global tab of userlib1 (loose match)

factorylib1 (loose match)

Global tab of userlib2 (loose match)

About the PANTONE library

The PANTONE library of color definitions is a standard feature of
Prinergy. It is loaded into the global color database. You access the
global color database when you're using the Color Editor.

The PANTONE library consists of color definitions for 15,751 different
PANTONE color names. Most of the colors are defined in the L*a*b*
color space; some are defined in the CMYK color space. Each
PANTONE color name has only one color definition, also known as a
color recipe.

Note: When you install the PANTONE library using Prinergy Administrator, you
can choose whether to load the CMYK or L*a*b* color systems. See the Prinergy
System Administration guide for more information.

Because Prinergy uses the PANTONE library, it lets you create proofs
that are even closer to the color produced by presses.

PANTONE library with QuarkXPress, Illustrator, and
Photoshop

The PANTONE library is intended for use with files produced by
QuarkXPress, Adobe Illustrator, and/or Adobe Photoshop, which all
contain the PANTONE library. In these desktop applications, when you
use a color from the PANTONE library, the color name is captured in
the file. QuarkXPress, Illustrator, and Photoshop all add characters to
the end of PANTONE color names. Prinergy knows the rules by which
each of these desktop applications change PANTONE color names.
When you add the file to Prinergy and refine it, Prinergy recognizes the
PANTONE color name, matches it to the PANTONE color in the
PANTONE library, and uses the color recipe from the PANTONE
library.
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You have the option of changing the color recipe for the PANTONE
color for the job. The modified color recipe is stored with the job and
does not override the color recipe in the PANTONE library.

PANTONE library with other desktop applications

Prinergy recognizes PANTONE color names in files generated by
QuarkXPress, Illustrator, and Photoshop, because Prinergy knows the
rules these applications use to specify PANTONE color names. If you
are processing a file in Prinergy that is produced by any other desktop
application, such as CorelDRAW, you will need to know the rules the
applications use to name the PANTONE colors in their files to
successfully use the PANTONE library in Prinergy.

PANTONE library presence in Prinergy

The PANTONE library is invisible to you until you've refined files that
contain PANTONE spot colors or you have manually added separations
with PANTONE color names to a job. When a PANTONE color exists in
a job, you can see its color recipe when you display the Color
Separations dialog box or the Color Mapping dialog box.

The refining process and Color Combiner both use the PANTONE
library.

Adding or changing colors in separations

Use this procedure when generating imposition output or final output.

1. Open the Color Separations dialog box.

a. Select a signature in the Signatures view.
b. From the Edit menu, select Color Separations.

2. Select the color.

3. Identify whether the colors are defined in the color database by
selecting each one in the Color Information area and reading its
description.

Prinergy identifies a color as undefined if it is not in any color
library.

4. Perform one of the following actions:

To Do This

Add a new
color

a. Click Add Separation.
b. In the Add Separation dialog box, type a name for the

color separation.
c. Click Add.
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To Do This

Edit an existing
color

a. In the Page Color column, click a color that is defined.
b. In the Color Information area, click the Page Color tab,

and click Edit.
c. Click Edit Color Recipe Globally or Edit Color Recipe

For This Job Only as appropriate.
d. In the Color Editor dialog box, edit the color attributes.

Adding or changing color definitions while refining

Use this procedure when you want to add a color definition or change a
color definition while you are refining. For example, you can use this
procedure to adjust the screen angle of a color while refining.

1. Start a second refine, which is a refine process on refined files.

You cannot add or change color definitions when you refine input
files.

2. In the Start Process dialog box, click Color Mapping.

3. In the Color Mappings dialog box, identify whether the colors are
defined in the color database.

● A colored square indicates a color is defined. If the color is in a
user library, you can change its definition. If the color is in a
factory library, you can make a copy of it in a user library and
change the copy.

● An  icon indicates a color that is not defined in any of the
factory color libraries or in the user libraries selected in the
Color Libraries area of the Spot Color Handling section of the
refine process template that you are using.

Tip: You can also select the color and read its description in the Color
Information area.

4. Select a color in the Page Color column.

5. Perform any of the following actions:

To Do This

Add an
undefined
color to the
color
database

a. Click Add.
b. In the Select a Color Library dialog box, in the Add the

color recipe <color> to the library list, select a library.

The libraries in the list are the user libraries selected in
the Color Libraries area of the Spot Color Handling
section of the refine process template that you are
using.

c. Select either Global or Job <job name> to determine
whether the color is available to all jobs or only to the
current job.

d. Click OK.
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To Do This

Edit an
existing color

a. Click Edit.
b. When prompted, click either Edit Color Recipe Globally

to edit add a copy of the color definition to a global user
library, or Edit Color Recipe For This Job Only to add a
copy of the color definition to a job-specific user library.

6. In the Color Editor, set the options for the selected color, and click
OK.

If you added a color, the icon next to it changes from  to a colored
square. If you changed a color, the description in the Color
Information area changes.

Adding or changing color definitions while generating loose proofs

1. Start a loose page output process.

2. In the Start Process dialog box, click Color Mapping.

3. In the Color Output dialog box, identify whether the colors are
defined in the color database.

● A colored square indicates a color is defined. If the color is in a
user library, you can change its definition. If the color is in a
factory library, you can make a copy of it in a user library and
change the copy.

● An  icon indicates a color that is not defined in any of the
factory color libraries or in the user libraries selected in the
Color Libraries area of the Spot Color Handling section of the
refine process template that you are using.

Tip: You can also select the color and read its description in the Color
Information area.

4. In the Page Color column, perform any of the following actions:

To Do This

Add a new
color

a. Click a color that is not defined.
b. Click Add.
c. In the Select a Color Library dialog box, in the Add the

color recipe <color> to the library list, select a library.

The libraries available in the list are the user libraries
selected in the Color Libraries area of the ColorConvert
section of the process template that you are using.

d. Select either Global or Job <job name> to determine
whether the color is available to all jobs or only to the
current job.

e. Click OK.
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To Do This

Edit an
existing color

a. Click a color that is defined.
b. In the Color Information area, click the Page Color tab

and click Edit.

5. In the Color Editor, set the options for the selected color, and click
OK.

Color Editor window

Color Libraries

(Visible when you open Color Editor directly from the Tools
menu, not from another dialog box)

Lists the color libraries defined in Prinergy.

Use the Add and Remove buttons to add or remove a user
library.

Use the Import and Export buttons to copy color libraries
between Prinergy systems.

Colors

(Visible when you open Color Editor directly from the Tools
menu, not from another dialog box)

Lists the colors defined in the selected color library.

The Global tab lists colors that are available to all jobs. The Job
tab lists colors that are available only to the current job. The Job
tab is shown only when you open Color Editor from Job
Manager.

Type the color recipe name in the Search box to locate the color
recipe in the list.

Use the Add, Copy, Edit, and Remove buttons to manage color
recipes.

Color Editor

Displays the color definition (recipe), which includes the name,
trapping information, alternative color space, and screening
information.

For more details, see the remainder of this table.

Name

Displays the name of the color.
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Opacity

Select one of the following opacity options:

Not Specified: Opacity is not specified.

Normal: The color is treated as translucent. Normal colors, or
objects covered by or placed on top of Normal colors, may be
trapped.

Transparent: Transparent colors are not trapped.

Opaque: Opaque colors, or objects covered by Opaque colors,
are not spread. Other colors may trap to Opaque colors, and
objects covered by Opaque colors may be choked back.

Opaque Ignored: Opaque Ignored colors are not spread. Other
colors do not trap to Opaque Ignored colors.

die line-The color is not trapped. For composite proofs, the
color knocks out. When outputting separations, the system
treats the color as an overprint ink.

Neutral Density

(Also see About neutral density on page 256)

Specifies the neutral density for the color.

Note: Unless you need to specify a special neutral density for trapping
purposes, we recommend that you leave this blank. The neutral density
values are determined from the process color recipe.

Treat Color As Black

This check box is available only for the PDF Trap Editor.

You can specify that a colorant (usually only a spot color) be
treated as though it was black. The settings in the Black area of
the Trap section of the refine process template determine how
Prinergy handles black objects.

Notes:

● Normal inks can be trapped as black if set to Treat as Black.
● Other colors trap to Opaque inks because Opaque inks are always

treated as black.
● Transparent or Opaque Ignored inks are never treated as black.

Alternate Color Space Name

Specifies an alternate color space for the color, for example,
RGB, CMYK, or L*a*b*.

The components below the Name box specify the percentage
(or quantity) of each component forming the color recipe. For
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example, PANTONE 159-6 is composed of: Cyan=15%,
Magenta=50%, Yellow=0%, Black=25%.

Screening Angle

Specifies the screening angle for the color.

Revert

Click Revert to cancel the changes you've made and to revert
the options to the settings you last saved.

Apply

Click Apply to save the changes you've made and to apply them
to your current selection.

Managing color definitions
This procedure explains how to add, edit, copy, and delete colors in a
color library by accessing the Color Editor directly. You can also access
the Color Editor from other dialog boxes while you are working on
specific tasks.

1. From the Tools menu, select Color Editor.

2. In the Color Editor, in the Color Libraries section, click a library.

3. In the Colors section, click the Global tab or the Job tab.

The Job tab is visible only if you open the Color Editor from an open
job in Job Manager.

4. Perform any of the following actions:

To Do This

Add a color a. Click Add.
b. In the Name box, type a name for the new color.
c. Set the options, and click Apply.

Edit a color a. In the Colors box, select a color, and then click Edit.
b. Change the options, and click Apply.

Copy a color a. In the Colors box, select a color, and then click
Copy.

b. In the Name box, type a name for the new color, and
click Apply.

Delete a color a. In the Colors box, select a color, and then click
Remove.

b. Click OK to confirm.
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Job Color Picker dialog box

Color Recipes

Displays the job-specific colors in the selected color library.

Create Copy

Select the check box next to one or more color recipes that you
want to copy.

Global Color Picker dialog box

Color Recipes

Displays the global colors in the selected color library.

Create Copy

Select the check box next to one or more color recipes that you
want to copy.

Managing color libraries

1. From the Tools menu, select Color Editor.

2. In the Color Editor, in the Color Libraries section, perform any of
the following actions:

To Do This

Add a library a. Click Add.
b. In the Add New Color Library dialog box, type a name

for the new library in the Library Name box.
c. Either select an existing color space and click OK, or

create a color space.

Import a
library

a. Click Import.
b. In the Import Color Library dialog box, navigate to and

select the color library (.dat) file.
c. If you want to rename the color library file, change the

file name but do not change the file extension, and then
click OK.

Note: When importing a color library, ensure that the color
space associated with the color library exists in the Prinergy
system. If the color space name or colorants don't match,
the import fails.

Edit a library See Managing Color Definitions.
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To Do This

Remove a
library

Click a library, click Remove, and then click Yes to confirm.

Important: Removing a user library deletes color definitions
in both Global and Job tabs.

Export a
library

a. In the Color Libraries section, click a library, and then
click Export.

b. In the Export Color Library dialog box, navigate to and
select the destination directory.

c. If you want to rename the color library file, change the
file name but do not change the file extension. Then
click OK.

See also:
Managing color spaces on page 776
Color Editor window on page 788
Managing color definitions on page 790
Add New Color Library dialog box on page 792
Import Color Library dialog box on page 792
Export Color Library dialog box on page 793

Add New Color Library dialog box

Library Name

Type a name for the new library.

Select Alternate Color Space

Select an existing color space or select Define new colorspace
to create a new color space.

Import Color Library dialog box

Volumes

Displays all volumes in the Prinergy system.

Job Folder

Opens the job folder for the current job.

Show Hidden Files

Select this check box to include hidden files, such as system
files, in the results.

You can set the default selection of this check box on the View
tab of the Workshop Preferences dialog box.
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Name the imported library as

Displays the name for the library as it will appear in the Color
Libraries area in the User Libraries group. You can edit the
name if you want to.

Export Color Library dialog box

Volumes

Displays all volumes in the Prinergy system.

Job Folder

Opens the job folder for the current job.

Show Hidden Files

Select this check box to include hidden files, such as system
files, in the results.

You can set the default selection of this check box on the View
tab of the Workshop Preferences dialog box.

Export the selected color library to file

Displays the file name for the exported color library. You can
change the filename, but ensure it ends in the .dat extension.

Copying a color between the Job and Global tabs

1. From the Tools menu, select Color Editor.

2. In the Color Libraries list, select a library under User Libraries.

3. In the Color Editor, from the File menu, select one of the following:

● Copy to Job Tab to copy colors from the Global tab to the Job
tab

● Copy to Global Tab to copy colors from the Job tab to the
Global tab

4. In the Job Color Picker dialog box or Global Color Picker dialog box,
click the colors you want to copy, and click OK.

Select a Color Library dialog box

Add the color recipe <color> to the library

Select the color library that you want to add the color to.
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The libraries that appear in the list depend on what you are
doing:

● If you are refining the list includes the user libraries selected
in the Color Libraries area of the Spot Color Handling
section of the refine process template that you are using.

● If you are generating loose page output the list includes the
user libraries selected in the Color Libraries area of the
ColorConvert section of the process template that you are
using.

● If you are working with separations the list includes all of the
user libraries in the color database. In addition, you can
select Add new color library, which opens the Add New
Color Library dialog box where you can define the name and
alternate color space of a new user library.

Global

Select this option to store the color in a library that is available
in all jobs.

Job <job name>

Select this option to store the color in a library that is available
only in the current job.

Menus in Color Editor

Workshop menu in Color Editor

Note: This menu is available only when running Prinergy Workshop on a
Macintosh client.

About Prinergy Workshop

Displays information about Prinergy Workshop, including the
version number, a list of licensed features, and the server name.

Preferences

Use to view and modify Prinergy Workshop preferences. When
you select this menu item, the Workshop Preferences dialog
box appears.

Note: On a Windows client, this menu item appears under the Edit menu.
On a Macintosh client, it appears under the Workshop menu.

Quit / Quit Prinergy Workshop

Quits Prinergy Workshop. Any open Prinergy Workshop
windows are closed.
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File menu in Color Editor

Close Window

Closes the current window, but does not quit Prinergy
Workshop.

Copy to Job Tab

Displays the Global Color Picker which allows you to copy color
definitions from the Global tab to the Job tab of a library.

This menu item is visible only when you open Color Editor from
Job Manager. It is available only when you select a user library
and then select a color on the Global tab.

Copy to Global Tab

Displays the Job Color Picker which allows you to copy color
definitions from the Job tab to the Global tab of a library.

This menu item is visible only when you open Color Editor from
Job Manager. It is available only when you select a user library
and then select a color on the Job tab.

Quit / Quit Prinergy Workshop

Quits Prinergy Workshop. Any open Prinergy Workshop
windows are closed.

Edit menu in Color Editor

Cut, Copy, Paste (unavailable)

Select All Colors

Selects all the colors listed in the Colors box in the Color Editor
window.

View menu in Color Editor

Refresh

Updates the contents of the current window.

Tools menu in Color Editor

Change User

Displays the Connect to Server dialog box where you can log in
as another user without quitting Prinergy Workshop.
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This menu item appears only if you have Kodak Prinergy
Business Link software connected to the Prinergy system.

Job Finder

Opens Job Finder.

If you are already in Job Finder, this menu item is unavailable.

Destroy History Entries

In the History view, select one or more history entries and then
use Destroy History Entries to delete the selected entries.

Process Template Editor

Launches Process Template Editor, where you can create and
modify process templates.

Automated Page Assignment Editor

Starts the Automated Page Assignment Editor, which you use
to create and check APA files.

Queue Manager

Launches Queue Manager, where you can view the Job Ticket
Processors (JTPs) and process types.

Media Manager

Launches Media Manager, where you can manage your archive
tapes and disk volumes.

System History

Launches System History, which displays the detailed history of
all the activity occurring outside of job context (such as jobs
and groups that were created or destroyed), as well as job
archive, purge, and retrieve history.

Smart Hot Folder Manager

Launches the Smart Hot Folder Manager dialog box, where you
can add, edit and delete smart hot folders.

Configure Imposition Application

Displays the Configure Imposition Applications dialog box,
where you can identify the location of imposition software that
you want to integrate with Prinergy Workshop.

Start Imposition Application

Displays the Start Imposition Application dialog box, where you
choose which imposition software to start. You create this list
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of imposition applications with the Configure Imposition
Application tool from the Tools menu. If an application requires
a license and is licensed, it appears in bold.

Color Editor

Launches Color Editor, where you can create color recipes for
all jobs.

Color Space Editor

Launches Color Space Editor, where you can create and edit
color spaces.

Font Converter

Launches Font Converter, where you can convert font files into
PFA (Printer Font ASCII) format, which Prinergy requires to
correctly process fonts.

Preflight Profile Manager

Launches Preflight Profile Manager, where you can, during the
refine process, evaluate PDFs to detect problems that may
affect processing in a publishing or prepress workflow.

Digital Print Administration Console

Launches the Digital Print Administrator, where you can add
and configure a digital print application that Prinergy can launch
to print PDFs.

Rule Set Manager

Opens the Rule Set Manager, where you can create and edit
rule sets. The Rule Set Manager also lets you organize rule sets
into groups.

Activate Rule Set in Selected Jobs

Opens the Select Rule Set dialog box, where you can activate
rule sets for one or more jobs.

Help menu in Color Editor

Online help

Starts your Web browser and displays the Prinergy online help.

On <current window or view>

Starts your Web browser and displays the Prinergy Workshop
user guide, open to the topic for the currently selected window
or view.
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Quick Start Guide

Starts Adobe Acrobat and displays a PDF file of the Prinergy
Connect Quick Start Guide

eCentral Online Support

Starts your Web browser and displays the eCentral portal at 
https://ecentral.kodak.com/.

Visit graphics.kodak.com

Starts your Web browser and displays the Kodak Web site at 
http://graphics.kodak.com/default.htm.

About Prinergy Workshop

Displays information about Prinergy Workshop, including the
version number, a list of licensed features, and the Prinergy
server name.

Note: This menu item appears on the Help menu only when you are
running Prinergy Workshop on a Windows-based client computer. On a
Macintosh client computer, the menu item About Workshop appears on
the Workshop menu.

Separations

About color separations

You can work with color separations in the Color Separations dialog
box to:

● View the pages that a color is on
● Specify whether or not a color is output
● Specify how to handle spot colors

Spot color mapping set through the Color Separations dialog box
applies to:

● Imposition proofs and final output only
● Raster output and separated vector output (composite vector

output is not supported)

Note: In general, the Color Matcher has better control of spot color mapping/
conversion than the RIP does. Therefore, to ensure proofs match plates with
respect to spot color handling, it is advisable to do as much processing of spot
colors (mapping one spot color to another, conversion of spot color to process) in
the refine stage, not during final output.
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Resetting initial separations

You can reset the separations in theSeparations view to the page
colors defined in the pages assigned to the page sets. This is useful:

● After you add an imposition plan to a job that contains an existing
page set causing the Separations view not to display any
separations.

● To reset the separations in a job after you've created color
mappings.

Common separations

When you have used a versioning imposition with layering you can
identify separations as base, common, or unique. The labels appears in
the Common column in the Separations view on page 46 of Job
Manager.

Color print order

Color print order is the order in which the system handles color
separations. It is useful in two situations:

● Imposition proofs and final output-Color print order controls the
order in which Prinergy outputs color separations from a signature
for a job. The order you specify displays in the Separations view.

● Color mapping-Color print order controls the order in which
Prinergy traps the colors from a signature for a job. Since the first-
down ink on the substrate must pull the second-down ink from the
plate or cylinder, knowing which colors these are can help you avoid
unsightly trap colors.

Identifying common separations

This procedure applies only when you have used a versioning
imposition with layering.

In the Separations view of Job Manager, perform one of the
following actions:

To Display On the Job Menu, Select This

A label for the separation in the
Common column

Identify Common Separations

A typical view of separations Don't Identify Common Separations
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Seeing which pages contain a color

1. Open the Color Separations dialog box:

a. Switch to the Separations or Signatures view.
b. Select a signature.
c. On the Edit menu, select Color Separations.

2. Select a color in the Page Color column.

The Pages containing selected color area indicates which pages
contain the color you selected.

3. Click OK.

Adding a color separation

1. Open the Color Separations dialog box:

a. Switch to the Separations or Signatures view.
b. Select a signature.
c. On the Edit menu select Color Separations.

2. Click Add Separation.

3. In the Add Separations dialog box, type a name in the Name box
and click Add.

The new separation is listed in the Page Color column.

4. If you want to map a color to this new color:

● In the Page Color column, click the color you want to map.
● In the Output Selected as list, select the new color you created.

For example, if you have three different PANTONE Blue separations
listed in the Page Color box, and each one is spelled differently, you
can create a new, correctly spelled color name, then map each
incorrectly spelled spot color to the new color name.

5. Click OK.

Add Separation dialog box

Name

Type the name of the new separation.
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Setting initial separations
1. Switch to the Separations or Signatures view.
2. Select an imposition plan which selects all of the signatures in that

imposition plan.
3. From the File menu, select Set Initial Separations.
4. In the Set Initial Separations dialog box, click OK.

Color Separations dialog box

Page Color

Lists the colors in the pages in the selected signature.

One color swatch appears in the Color Information section for
every color name match found in the color libraries.

When you select multiple colors in this column, the Output
Selected As menu lists all choices that apply to the selection.

Note: If any of the elements selected can be converted to process, then
the Convert to Process selection will appear.

Output

Lists the color output treatment you have specified for each
color in the Page Color list.

Output Selected as

Specifies how you want the system to interpret colors in the
selected signatures:

● Separately

Outputs the color. For final output, Prinergy outputs the spot
color as a separation.

● Do Not Output

Suppresses output of the color
● Convert to Process

Converts a spot color to process color using the color recipe
from the color database.

● All the colors in the signature

Outputs the spot color with the selected color.

The last two options are available only for spot colors in
composite PDF pages.

Note: This feature is not supported when outputting to a composite
vector file.
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Note: Impositions usually have marks with colors: CMYK colors, as well
as generic spots. The generic spots usually follow a specific naming
convention (example, "Spot1", "Spot2", and so on). When you import an
imposition, all the imposition colors are set to Do not output to avoid
unnecessary and wasted plates. When you assign a page to an
imposition, Prinergy automatically turns on the necessary colors in the
imposition as well. This enables the imposition marks to reflect the colors
on the pages. Prinergy also automatically maps the imposition mark spot
colors to the page spot colors. For example, it will automatically map
imposition mark "Spot1" to page color "PANTONE Reflex Blue C". If
necessary, you can override this the automatic mapping by using the
Separations view of Workshop.

Add Separation

This button is available only for spot colors in composite pages.

This button enables you to add a color to the Output Selected
as list. You can then map spot colors in composite pages to the
new color.

For example, if you had three different PANTONE Blue
separations listed in the Page Color box, each spelled
differently, you could create a new, correctly spelled color, and
map the three incorrectly spelled spot colors to it. The spot
color is output with the new separation color.

If the new color is not found in the color libraries, a warning icon
( ) is displayed to the left of the color name in the Output
Selected as list.

Color Information

Displays the color definition information for the color you
selected in the Page Color column.

Add

Select this button to add a copy of the color definition.

This button is available only when you select an undefined
color.

Note: Factory spot colors cannot be edited.

Edit

Select this button to edit the color definition.

This button appears when you select a color defined in the Job
tab.

Note: Factory spot colors cannot be edited.
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Edit Copy

Select to edit a copy of the color definition. This button creates
a copy of a global color in the Job tab of the color library.

This button appears when you select a color defined in the
Global tab.

Note: Factory spot colors cannot be edited.

Pages containing selected color

When you select a color in the Page Color column, this panel
displays the pages that contain the color you selected.

Specifying a color print order

1. Open the Print Order dialog box in one of these ways:

To Specify Print
Order For

Do This

Trapping a. Start a refine process.
b. In the Start Process dialog box, click Color

Mapping.
c. In the Color Mapping dialog box, click Print

Order.

Imposition proof
output and final
output

a. In the Signatures or Separations view, select one
or more signatures.

b. From the Edit menu, select Color Printing Order.

2. Select a color in the list, and then click Print Sooner or Print Later
to move the selected to the desired position.

When Prinergy handles the color separations, it starts from the top
of the list and works down the list.

3. Repeat step 2 for other colors until the list displays a satisfactory
color printing order.

4. Click OK.

Print Order dialog box

list

Use this list to determine the lay down order for trapping colors.
Select a color, and raise or lower its order in the list by using the
Print Sooner and Print Later buttons.
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Print Sooner

Select a color in the list to trap into other Opaque colors and
then click this button to raise the color before the other colors
displayed lower in the list.

Print Later

Select a color in the list to trap into other Opaque colors and to
define the shape. (An object that is printed later usually holds
the shape, that is, the dominant color in the tone should define
the shape of the object.) Click this button to lower the color
after the other colors displayed higher in the list.

Spot colors

About reducing and preserving spot colors (overview)

When job files contain spot colors, you need to figure out whether to
reduce them.

You can handle a spot color in several ways:

● Preserve it so that it remains in the job files, appears in a proof, or
appears in final output.

● Convert it to process color.
● Map it to another spot color.
● Omit it from proofs or final output.

You can handle spot colors at several stages in the workflow:

● Refine: See About Reducing and Preserving Spot Colors During
Refine.

● Proof: See About Reducing and Preserving Spot Colors in Proofs.
● Final output: See About Reducing and Preserving Spot Colors in

Final Output.

To determine whether to reduce or preserve spot colors, evaluate the
spot colors in your input files and compare that to the spot colors
expected in the output. Use the table below to select the procedure
that best suits your job.

If the Answer to This Question Is This See This Procedure

Will the colors in your final output
be the same as the colors in your
input files?

Yes Preserving Spot Colors During Refine

No Reducing All Spot Colors During Refine

Reducing Individual Spot Colors During Refine

804 Chapter 14—Color



If the Answer to This Question Is This See This Procedure

When you generate loose page
output does the proofer support
the spot colors in the pages?

Yes Preserving Spot Colors in Loose Page Output

No Reducing All Spot Colors in Loose Page Output

Reducing Individual Spot Colors in Loose Page Output

When you generate imposition
output does the proofer support
the spot colors in the signatures?

Yes Preserving Spot Colors in Imposition Output

No Reducing All Spot Colors in Imposition Output

Reducing Individual Spot Colors in Imposition Output

Do the signatures have spot colors
that you do not want in the final
output?

Yes Preserving Spot Colors in Final Output

No Reducing All Spot Colors in Final Output

Reducing Individual Spot Colors in Final Output

About Color Combiner

Color Combiner is a Prinergy feature that lets you simulate the hue of
spot colors in output-including traps, knockouts, and overprints, using
only the standard four process colors: cyan, magenta, yellow, and
black. Color Combiner works equally well on all types of jobs—
composite, separated, vector, or copydot.

When used with the Kodak Trendsetter Spectrum digital halftone
proofer, Color Combiner lets you simulate the hue and halftone dot
structure of spot colors— for example to help you predict moiré in
duotones. The Trendsetter Spectrum proofer provides a proof using
the same number of donors as a regular four-color job.

Because Color Combiner works with copydot data as well as CT/
vector data, you may proof spot color copydot work using standard
process colors and be assured the proof accurately reflects the printed
piece.

How does Color Combiner work?

Color Combiner uses combinations of CMYK to simulate spot colors in
a job. Each spot color (for example, Bright Red #10), must have a single
combination of CMYK associated with it —for example, C = 2, M = 85,
Y = 96, and K = 0. You can specify the color association using the
Color Editor.

When you enable Color Combiner, it uses the CMYK combinations
associated with spot color names. If Color Combiner cannot find a
CMYK entry in the color database for a spot color, it outputs the spot
color in an easily identifiable bright green color. The bright green color
warns you that the CMYK combination for the spot color is not in the
color database. A yellow warning triangle also appears beside the spot
color in the Color Editor dialog box.
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Enabling Color Combiner

You can enable Color Combiner in any one of the following process
templates:

● Loose page output
● Imposition output
● Final output

To enable Color Combiner in these process templates, in the Render
section, select the Do Separations check box and select the Always
Use Color Combiner to Convert Spots check box.

Finding the right color combination

Each CMYK proofing device requires a slightly different combination of
CMYK to simulate a particular spot color because the individual
colorants used for CMYK differ for each proofer. To get a quicker
match to spot colors within the gamut of the proofer, use an ICC profile
for the proofer. To do this, measure the L*a*b* absolute color value of
the spot color that you want to match. Then, use stand-alone software
such as Kodak Profile Wizard, X-Rite ColorShop or Praxisoft VectorPro
to achieve the closest CMYK combination for the L*a*b* color space.

Limitations of Color Combiner

Color Combiner has the following limitations:

● It can exactly simulate only spot colors that are within the color
gamut of the proofer. For example, it cannot arbitrarily produce a
brighter red spot color.

● It can produce only a best approximation of colors that are outside
the color gamut of the proofer.

● For best quality, use Color Combiner for AM spot color screens up
to and including 175 lpi on the Trendsetter Spectrum proofer.

● If there are many overprints in the same area, the donor pigment
may run out. For example, if a solid CMYK 10-60-80-10 spot color
simulation overprints a solid CMYK 10-80-10-5 spot, there will be
an area where magenta is maximized at 100, instead of 140. This is
the tradeoff for using only one set of media.

● For best results, use Color Combiner only with Staccato-qualified
halftone proofing media.

When not to use Color Combiner

There are a few instances where you should not use Color Combiner. In
that case, clear the Always Use Color Combiner to Convert Spots
check box.
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For example, do not use Color Combiner if all of the following
conditions are true:

● You are outputting to a 1-bit screened format and sending it to a
device that is incapable of imaging the Staccato dots that Color
Combiner uses in this situation.

● Input files are composite.
● All spot colors are set to Opaque in the color database, or a spot

color is not in the color database and the default value is Opaque.

In this case, the Adobe renderer can extract color recipes from the
refined PDF file.

Note: If input files are separated, or if spot colors are not set to Opaque, the Color
Combiner is used even if the Always Use Color Combiner to Convert Spots check
box is cleared.

About reducing and preserving spot colors during refine

When you refine input files or pages you can reduce spot colors by
converting them to process color or mapping them to other spot colors.

If you preserve or reduce spot colors during refine, it permanently
affects the resulting PDF, which is often called the digital master. If you
reduce spot colors, they are no longer present when you generate
proofs or final output. The original input files remain unchanged.

Preserving spot
colors during refine

Reducing spot
colors during refine

When to preserve or reduce spot colors during refine

Preserve a spot color during refine in these situations:

● The spot color will be used in the final output. For example, if a
customer expects the logo on marketing materials to be displayed
in a specific PANTONE color.

● You use a late-binding workflow. Some printers prefer to preserve
color information as long as possible. This means that they delay
color conversion and color reduction until the proofing or final
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output stages. This is called a late-binding workflow, because the
job files are not tied to a specific output device until necessary.

CAUTION: It is better to reduce spot colors during refine—not during proofing
and final output—because it ensures consistency between proofs and final
output and because color conversion is better in the refine process than in the
proofing and final output processes.

Reduce a spot color during refine if the spot color will not be used in
final output—for example if a customer mistakenly added a spot color
to the files.

How to preserve spot colors during refine

To preserve all spot colors during refine, change a setting in the Spot
Color Handling section of the refine process template.

If you preserve spot colors, you also need to manage the definitions of
the spot colors:

● Make sure the spot colors in the files are defined in the Prinergy
color database. You can do this while refining or separately. For
instructions on adding colors independent of any process, see
Managing Color Definitions.

● Make sure the spot colors in the files have the same name that the
color has in Prinergy. If a customer uses a different spelling or name
for a color, you can point the customer's color to the Prinergy color
during the refine process.

How to reduce spot colors during refine

You can reduce spot colors during two types of refine processes:

● By refining the input files. If you know in advance that the input files
have unnecessary spot colors, you can eliminate them immediately
when you refine the input files.

● By refining the pages. If you do not know what the files contain, you
run two refine processes. This is the most common situation. You
refine the input files without handling color in any way. After looking
at the resulting pages, you then refine the pages and handle any
color issues in them. Typically, you create a refine process template
specifically for this purpose with a name such as 2ndRefine-
MapColors.

You can reduce spot colors during refine in two ways:
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To Reduce Use This Method Consider This

All spot colors
during refine

Change a setting in the
refine process
template (in the Spot
Color Handling
section).

This is possible during any refine whether you are refining input files
or pages.

With this method, you have to convert all spot colors to process
color. You cannot omit or map spot colors.

This method works only with composite file, not with separated
files.

Individual spot
colors during
refine

Use the Color Mapping
dialog box when
running the refine
process.

This is possible only when refining pages not when refining input
files.

With this method, you have can convert, omit, or map spot colors.

If the file is separated, you cannot convert spot colors to process
color. You can map a spot color to another spot color, but only using
existing separations.

If you use the Color Mapping dialog box and edit the process
template during the same refine process, the most recently applied
settings take precedence.

See also:
Managing color definitions on page 790
Aliasing spot colors to different names on page 815
Preserving spot colors during refine on page 816
Reducing all spot colors during refine on page 816
Reducing individual spot colors during refine on page 817

About reducing and preserving spot colors in proofs

When you generate proofs, you can reduce spot colors by converting
them to process color, mapping them to other spot colors, or omitting
them entirely.

When you preserve or reduce spot colors in a proof, the changes that
you make affect only the proof. The PDF digital master remains
unchanged.

Preserving spot
colors in proofs

Reducing spot colors
in proofs
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If you convert spot colors to process color, the Color Combiner can
simulate the hue of spot colors in a proof-including traps, knockouts,
and overprints-using the standard four process colors.

When to preserve or reduce spot colors in a proof

Preserve spot colors in proofs if you want to see the spot colors in the
proof and the printer supports the spot colors.

Reduce spot colors in proofs in these situations:

● The proofer supports only process color. Most proofers handle
only process color. When generating a proof on these proofers,
convert all spot colors to process color.

● The spot color requires special handling. Certain spot colors can be
challenging to proof. Here are a few special spot colors and how to
handle them:

With This Spot Color Handle It This Way

Metallic and other
colors that are hard to
convert to process
color

Omit the spot color or output it separately.

For example, if the proofer uses donor sheets, omit the spot color when you
generate donors for the process colors and then generate the metallic spot color
as a separate donor sheet.

Varnish Output the spot color separately as an overlay.

This is useful because varnish spot colors usually have an arbitrary color value,
such as 2 percent magenta, that makes the varnish visible in the job files. If you
leave the spot color in the proof, it may cover objects that you want to check. If
you convert the spot color to process color, its color value changes the value of the
process color.

Die line Omit the die spot color from the proof.

White background on
clear plastic

Omit the white spot color or output it separately.

For example, with a proofer that uses donor sheets, use a white or yellow donor to
make a separate separation that is not laminated together with the process colors.

This is useful because the white spot color usually has an arbitrary color value,
such as 10 percent magenta, that makes the spot color visible in the job files. If you
leave the spot color in the proof, it may cover objects that you want to check. If
you convert the spot color to process color, its color value changes the value of the
process color.

● Spot colors were introduced in marks. If the marks (for example,
the color bar) from the imposition plan contain spot colors that you
do not want in the proof, do not output the spot colors.

● You use a late-binding workflow. Some printers prefer to preserve
color information as long as possible. This means that they delay
color conversion and color reduction until the proofing or final
output stages. This is called a late-binding workflow because the job
files are not tied to a specific output device until necessary.

Caution: It is better to reduce spot colors during refine—not during
proofing and final output—because it ensures consistency between
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proofs and final output and because color conversion is better in the
refine process than in the proofing and final output processes.

How to preserve or reduce spot colors in proofs

To preserve all spot colors in proofs, change a setting in the process
template. See Preserving Spot Colors in Loose Page Output and
Preserving Spot Colors in Imposition Output.

To reduce spot colors in loose page output choose one of these two
methods:

To Reduce Use This Method Consider This

All spot colors in
loose page output

Change a setting in the loose
page output process template.
See Reducing All Spot Colors in
Loose Page Output.

With this method, you have to convert all spot colors to
process color. You cannot omit or map spot colors.

Individual spot
colors in loose page
output

Use the Color Output dialog
box when you start the proof
process.

See Reducing Individual Spot
Colors in Loose Page Output.

With this method, you can convert or omit spot colors.

This method works only with raster files, not with vector
files.

If you use the Color Output dialog box and edit the
process template during the same proof process, the
most recently applied settings take precedence.

To reduce spot colors in imposition output choose one of these two
methods:

To Reduce Use This Method Consider This

All spot colors in
imposition output

Change a setting in the
Imposition Output process
template. See Reducing All
Spot Colors in Imposition
Output.

With this method, you have to convert spot colors to
process color. You cannot omit or map spot colors.
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To Reduce Use This Method Consider This

Individual spot
colors in imposition
output

Use the Color Separations
dialog box before you
generate the proof.

See Reducing Individual Spot
Colors in Imposition Output.

With this method, you can convert, omit, or map spot
colors.

When you use this method, it affects all subsequent
proofs, final output, and exports.

The Color Separations dialog box does not work with PDF
files that are composite. Also, with vector files, you can do
spot-to-spot mapping, but you cannot omit spot colors or
convert them to process color.

If you use the Color Separations dialog box and edit the
process template during the same proof process, the most
recently applied settings take precedence.

See also:
Preserving spot colors in loose page output on page 818
Reducing all spot colors in loose page output on page 818
Reducing individual spot colors in loose page output on page 819
Preserving spot colors in imposition output on page 821
Reducing all spot colors in imposition output on page 821
Reducing individual spot colors in imposition output on page 822

About reducing and preserving spot colors in final output

When you generate final output, you can reduce spot colors by
converting them to process color, by mapping them to other spot
colors, or by omitting them entirely.

When you preserve or reduce spot colors in final output, the changes
that you make affect only the output. The PDF digital master remains
unchanged.

Preserving spot
colors in final
output

Reducing spot
colors in final
output

If you convert spot colors to process color, the Color Combiner can
simulate the hue of spot colors in a proof-including traps, knockouts,
and overprints-using the standard four process colors. See About Color
Combiner.
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When to preserve or reduce spot colors in final output

Preserve spot colors in final output if the job files contain only the spot
colors that you want in the final output.

Reduce spot colors in final output in these situations:

● Spot colors were introduced in marks. If the marks (for example,
the color bar) from the imposition plan contain spot colors that you
do not want in the proof, do not output the spot colors.

● The output device changed. If the output device is different from
the one that you anticipated during refine, you may need to reduce
spot colors during final output.

● You use a late-binding workflow. Some printers prefer to preserve
color information as long as possible. This means that they delay
color conversion and color reduction until the proofing or final
output stages. This is called a late-binding workflow because the job
files are not tied to a specific output device until necessary.

CAUTION: It is better to reduce spot colors during refine-not proofing and final
output-because it ensures consistency between proofs and final output and
because color conversion is better in the refine process than the proofing and
final output processes. For example, color conversion during final output may
fail or may generate blank areas. Also, overprints and knockouts may be
incorrect because the colors are converted by Adobe Extreme which paints
over existing raster in an opaque manner.

How to preserve or reduce spot colors in final output

To preserve all spot colors in final output, change a setting in the
process template. See Preserving Spot Colors in Final Output.

To reduce spot colors, choose one of these two methods:

To Reduce Use This Method Consider This

All spot colors in
final output

Change a setting in the
final output proof process
template.

See Reducing All Spot
Colors in Final Output.

With this method, you have to convert all spot colors to
process color. You cannot omit or map spot colors.
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To Reduce Use This Method Consider This

Individual spot
colors in final
output

Use the Color Separations
dialog box before you
generate the proof.

See Reducing Individual
Spot Colors in Final
Output.

With this method, you can convert, omit, or map spot colors.

When you use this method, it affects all subsequent proofs,
final output, and exports.

The Color Separations dialog box does not work with
composite PDF files.

If you use the Color Separations dialog box and edit the
process template during the same proof process, the most
recently applied settings take precedence.

See also:
About Color Combiner on page 805
Preserving spot colors in final output on page 823
Reducing all spot colors in final output on page 824
Reducing individual spot colors in final output on page 825

Reducing spot colors (workflow)

Requirements: Start with a job that already has input files.

This procedure summarizes how and when you can reduce spot colors
in a job.

1. (Optional) If you know the definitions of the spot colors, add the
colors to the color database, including color names that you want to
alias other colors to.

Alternatively, you can add colors later, when you refine.

2. Refine the input files, preserving the spot colors.

3. Review the spot colors in the pages.

4. Refine the pages to handle spot colors:

a. If the pages contain spot colors that will not be plated, reduce all
spot colors during a refine of the pages, or reduce specific spot
colors during a refine of the pages.

b. If a spot color is in the Prinergy color database under a different
name, add an alias for the color.

5. Generate loose page output:

● If the proofer supports all of the spot colors, preserve the spot
colors in the final output.

● If the proofer does not support all of the spot colors, reduce all
spot colors in the proof, or reduce specific spot colors in the
proof.

6. Impose the job as required.
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7. Generate imposition output:

● If the proofer supports all of the spot colors, preserve the spot
colors in the proof.

● If the proofer does not support all of the spot colors, reduce all
spot colors in the proof, or reduce specific spot colors in the
proof.

8. General final output.

a. If the proofer supports all of the spot colors, preserve the spot
colors in the final output.

b. If you want to reduce spot colors, such as spot colors that were
introduced when you imported marks, reduce all spot colors in
the final output, or reduce specific spot colors in the final output.

Aliasing spot colors to different names

Use this procedure when a spot color in a file is spelled or named
differently from a spot color in Prinergy.

1. Select the input files or pages with the spot colors that you want to
affect.

2. Start a refine process on the selected files by dragging the files to
the refine process template.

3. In the Start Process dialog box, click Color Mapping.
This opens the Color Mapping dialog box.

4. Click Add Alias.

5. Type a name for the alias color in the Enter a new color alias box,
and then click OK.

Prinergy searches for the name in the color libraries selected in the
refine process template.

6. If Prinergy does not find the color and a warning message appears,
define the color. Then, click Add Color and follow the procedure in
Adding or Changing Colors.

You can leave the color undefined by clicking Continue. But the PDF
digital master will not be complete, and you will not be able to
convert to process downstream—for example, during proofing.

7. In the Page Color column, select the name of the spot color that is
spelled incorrectly.

8. In the Output Selected as list, select the alias color name you
added.

9. Click OK.

The refine process starts.
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Preserving spot colors during refine

1. Select the input files.

2. Start a refine process on the selected files by dragging the files to
the refine process template.

3. Preserve all spot colors by clearing an option in the process
template:

a. In the Start Process dialog box, click Edit Process Template.
b. Expand the Spot Color Handling section.
c. In the Map Spot Colors area, clear the Enable Spot Color

Mapping check box.
d. Close the process template.

4. Click OK to close the Start Process dialog box.

The refine process occurs. Refined pages are generated.

Tip: You can modify and save the process template before you start. Start the
process using the modified process template and do not click Edit Process
Template in the Start Process dialog box.

Reducing all spot colors during refine

1. Select the input files or pages with the spot colors that you want to
affect.

2. Start a refine process on the selected files by dragging the files and
dropping them on the refine process template.

3. Reduce all spot colors by selecting two options in the process
template:

a. In the Start Process dialog box, click Edit Process Template.
b. Select and expand the Spot Color Handling section.
c. In the Map Spot Colors area, select the Enable Spot Color

Mapping check box and select the Map All Spot Colors to
Process check box.

4. Click OK to close the Start Process dialog box.
The refine process occurs. Refined pages are generated.

Tip:

● This procedure works only with composite files, not with separated files.
● You can also handle spot colors during the initial refine of the input files. You

start by select the input files instead of pages.
● You can modify and save the process template before you start. Start the

process using the modified process template, and do not click Edit Process
Template in the Start Process dialog box.
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Reducing individual spot colors during refine

1. Select the input files or pages with the spot colors that you want to
affect.

2. Start a refine process on the selected files by dragging the files to
the refine process template.

3. Enable some but not all spot-color reduction by setting two options
in the process template:

a. In the Start Process dialog box, click Edit Process Template.
b. Select and expand the Spot Color Handling section.
c. In the Map Spot Colors area, select the Enable Spot Color

Mapping check box and clear the Map All Spot Colors to
Process check box.

d. Close the process template.

4. Reduce individual spot colors using the Color Mapping dialog box:

a. In the Start Process dialog box, click Color Mapping.

The Color Mapping dialog box appears.
b. If you want to add or change a color in the Page Color column,

see Adding or Changing Colors.
c. Select the spot color that you want to reduce.
d. In the Output Selected as list, indicate how to reduce the spot

color:

To Do This Do This in the Output Selected
As List

Convert a spot color to process
color

Select a process color.

Map a spot color to another spot
color

Select another spot color.

e. Click OK.

5. Click OK to close the Start Process dialog box.

The refine process occurs applying the settings from both the refine
process template and the Color Mappings dialog box. Refined
pages are generated.

Tip:

● If the file is separated, you cannot convert spot colors to process color. You
can map a spot color to another spot color, but only using existing separations.

● You can also handle spot colors during the initial refine of the input files. You
start by select the input files instead of pages.

● You can modify and save the process template before you start. Start the
process using the modified process template, and do not click Edit Process
Template in the Start Process dialog box.
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● The Color Mapping dialog box has no effect unless Enable Spot Color Mapping
is selected in the process template.

● If you edit the process template from the Start Process dialog box and use the
Color Mapping dialog box, the most recently applied settings take precedence.

Preserving spot colors in loose page output

Use this procedure if your proofer supports the spot colors in the
pages.

1. Select the pages that you want to proof.

2. Start a loose page output process on the selected files by dragging
the pages and dropping them on the loose page output process
template.

3. Preserve spot colors by selecting a specific option in the process
template:

a. In the Start Process dialog box, click Edit Process Template.
b. Expand the Render section.
c. In the Spot Color Handling list, select Output Separately.

The options available in the Spot Color Handling list depend on
the output type.

d. Close the process template.

4. Click OK to close the Start Process dialog box.

The proof process occurs, applying the settings of both the process
template and the Color Output dialog box. The proof is generated.

Tip: You can modify and save the process template before you start. Start the
process using the modified process template, and do not click Edit Process
Template in the Start Process dialog box.

Reducing all spot colors in loose page output

Use this procedure if your proofer does not support spot colors.

CAUTION: If the spot colors will never be plated, reduce them during refine
whenever possible. Color conversion is more predictable during refine than during
other processes.

1. Select the pages that you want to proof.

2. Start a loose page output process on the selected files by dragging
the pages to the loose page output process template.

3. Reduce spot colors by selecting specific options in the process
template:

a. In the Start Process dialog box, click Edit Process Template.
b. Expand the Render section.
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c. Determine how you want to reduce the spot colors:

To Do This

Convert all spot
colors to process
color

a. In the Spot Color Handling list, select Convert
to Process.

b. Select the Always Use Color Combiner to
Convert Spots check box.

Omit all spot
colors from the
proof

In the Spot Color Handling list, select Don't
Output.

The options available in the Spot Color Handling list depend on
the output type.

d. Close the process template.

4. Click OK to close the Start Process dialog box.
The proof process occurs, applying the settings of both the loose
page output process template and the Color Output dialog box. The
proof is generated.

Tip:

● You can modify and save the process template before you start. Start the
process using the modified process template, and do not click Edit Process
Template in the Start Process dialog box.

● You can also use this procedure to omit a process color from a proof. Instead
of selecting a spot color in the Color Output dialog box, select a process color
and set the Output Selected as list to Do Not Output.

● To quickly set several colors to the same setting in the Color Output dialog
box, select them all and then select an option in the Output Selected as list.

● If you edit the process template from the Start Process dialog box and use the
Color Output dialog box, the most recently applied settings take precedence.

Reducing individual spot colors in loose page output

Use this procedure for spot colors that are difficult to proof.

CAUTION: If the spot colors will never be plated, reduce them during refine
whenever possible. Color conversion is more predictable during refine than during
other processes.

1. Select the pages that you want to proof.

2. Start a loose page output process on the selected files by dragging
the pages to the loose page output process template.

3. Preserve most spot colors by setting options in the process
template:

a. In the Start Process dialog box, click Edit Process Template.
b. Expand the Render section.
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c. In the Spot Color Handling list, select Output Separately.

The options available in the Spot Color Handling list depend on
the output type.

d. Select the Always Use Color Combiner to Convert Spots check
box, if it is available.

e. Close the process template.

4. If you want to reduce individual spot colors, use the Color Output
dialog box:

a. In the Start Process dialog box, click Color Mapping.
The Color Output dialog box appears.

b. If you want to add or change a color in the Page Color column,
see Adding or Changing Colors.

c. Select the spot color that you want to affect and then set the
Output Selected as list:

To Do This in the Color Output Dialog Box

Convert a spot color
to process color

In the Output Selected as list, select Convert to
Process.

Omit a spot color
from the proof

In the Output Selected as list, select Do Not
Output.

d. If necessary, repeat steps b and c for other spot colors that you
want to reduce.

e. Click OK.

5. Click OK to close the Start Process dialog box.

The proof process occurs, applying the settings of both the loose
page output process template and the Color Output dialog box. The
proof is generated.

Tip:

● This procedure works only with raster files, not with vector files.
● You can modify and save the process template before you start. Start the

process using the modified process template, and do not click Edit Process
Template in the Start Process dialog box.

● You can also use this procedure to omit a process color from a proof. Instead
of selecting a spot color in the Color Output dialog box, select a process color
and set the Output Selected as list to Do Not Output.

● To quickly set several colors to the same setting in the Color Output dialog
box, select them all and then select an option in the Output Selected as list.

● If you edit the process template from the Start Process dialog box and use the
Color Output dialog box, the most recently applied settings take precedence.
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Preserving spot colors in imposition output

1. Switch to the Signatures view, and select the surfaces or signatures
that you want to proof.

2. Start an imposition output process on the selected surfaces or
signatures by dragging the surfaces or signatures to the imposition
output process template.

3. Preserve spot colors by setting a specific option in the process
template:

a. In the Start Process dialog box, click Edit Process Template.
b. Expand the Render section.
c. In the Output Separation Handling list, select Output all

separately.
d. Close the process template.

4. Click OK to close the Start Process dialog box.

The proof process occurs. The proof is generated.

Tip:

● You can also use the Color Separations dialog box to print separations. You
select the spot color, and set the Output Selected As to Separately.

● You can modify and save the process template before you start. Start the
process using the modified process template, and do not click Edit Process
Template in the Start Process dialog box.

Reducing all spot colors in imposition output

Use this procedure to reduce spot colors in impositions proofs—for
example, when pages have spot colors that will be plated but are
difficult to proof.

CAUTION: If the spot colors will never be plated, reduce them during refine
whenever possible. Color conversion is more predictable during refine than during
other processes.

1. Switch to the Signatures view, and select the surfaces or signatures
that you want to proof.

2. Start an imposition output process on the selected surfaces or
signatures by dragging the surfaces or signatures to the imposition
output process template.

3. Reduce all spot color by selecting two options in the process
template:

a. In the Start Process dialog box, click Edit Process Template.
b. Expand the Render section.
c. In the Output Separation Handling list, select Convert

Separations to Process.
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d. Select the Always Use Color Combiner to Convert Spots check
box.

e. Close the process template.

4. Click OK to close the Start Process dialog box.

The proof process occurs. The proof is generated.

Tip:

● You can modify and save the process template before you start. Start the
process using the modified process template, and do not click Edit Process
Template in the Start Process dialog box.

● If you used the Color Separations dialog box to reduce or map spot colors at
any time before generating final output, the settings in that dialog box will
apply to the final output.

Reducing individual spot colors in imposition output

Use this procedure to reduce spot colors in impositions proofs—for
example, when pages have spot colors that will be plated but are
difficult to proof.

CAUTION: If the spot colors will never be plated, reduce them during refine
whenever possible. Color conversion is more predictable during refine than during
other processes.

1. Switch to the Signatures view, and select the surfaces or signatures
that you want to proof.

2. Reduce individual spot colors using the Color Separations dialog
box:

a. From the Edit menu, select Color Separations.

The Color Separations dialog box appears.
b. Select the spot color, and then select an option in the Output

Selected As list:

To Select This

Convert a spot color
to process color

Either Convert to Process or a process color

Map a spot color to
another color

A spot or process color

(If the color doesn't already exist, first add a color
separation.)

Preserve a spot
color

Separately

(The separation is output separately only if the
Do Separations check box is selected in the
Render section of the process template.)

Omit a color from
the proof

Do Not Output

c. Click OK.
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3. Start an imposition output process on the selected surfaces or
signatures by dragging the surfaces or signatures to the imposition
output process template.

4. Preserve any other spot colors by setting an option in the process
template:

a. In the Start Process dialog box, click Edit Process Template.
b. Expand the Render section.
c. In the Output Separation Handling list, select Output all

separately.
d. Close the process template.

5. Click OK to close the Start Process dialog box.

The proof process occurs, applying the settings of both the
Imposition Output process template and the Color Separations
dialog box. The proof is generated.

Tip:

● The Color Separations dialog box does not work with PDF files that are
composite. Also, with vector files, you can do spot-to-spot mapping, but you
cannot omit spot colors or convert them to process color.

● Changes made in the Color Separations dialog box affect all future imposition
output and final output.

● You can also use the Color Separations dialog box to print separations. Select
the spot color, and select Separately in the Output Selected As list.

● You can modify and save the process template before you start. Start the
process using the modified process template, and do not click Edit Process
Template in the Start Process dialog box.

Preserving spot colors in final output

1. Switch to the Signatures view, and select the surfaces or signatures
that you want to use for final output.

2. Start a final output process on the selected surfaces or signatures
by dragging the surfaces or signatures to the imposition output
process template.

3. Preserve spot colors by clearing an option in the process template:

a. In the Start Process dialog box, click Edit Process Template.
b. Expand either the Render section or the ColorConvert section.
c. In the Color Libraries area, clear the Always Use Color

Combiner to Convert Spots check box.
d. Close the process template.

4. Click OK to close the Start Process dialog box.

The final output process occurs. The bitmaps are generated.

Preserving spot colors in final output 823



Tip:

● You can modify and save the process template before you start. Start the
process using the modified process template, and do not click Edit Process
Template in the Start Process dialog box.

● If you used the Color Separations dialog box to reduce or map spot colors at
any time before generating final output, the settings in that dialog box will
apply to the final output.

Reducing all spot colors in final output
CAUTION: Reduce spot colors during refine whenever possible. Color conversion
is more predictable during refine than during other processes.

1. Switch to the Signatures view, and select the surfaces or signatures
that you want to use for final output.

2. Start a final output process on the selected surfaces or signatures
by dragging the surfaces or signatures to the imposition output
process template.

3. Reduce all spot colors by selecting an option in the process
template:

a. In the Start Process dialog box, click Edit Process Template.
b. Expand either the Render section or the ColorConvert section.
c. In the Color Libraries area, select the Always Use Color

Combiner to Convert Spots check box.
d. Close the process template.

4. Click OK to close the Start Process dialog box.

The final output process occurs. The bitmaps are generated.

Tip:

● You can modify and save the process template before you start. Start the
process using the modified process template, and do not click Edit Process
Template in the Start Process dialog box.

● If you used the Color Separations dialog box to reduce or map spot colors at
any time before generating final output, the settings in that dialog box will
apply to the final output.

824 Chapter 14—Color



Reducing individual spot colors in final output
CAUTION: Reduce spot colors during refine whenever possible. Color conversion
is more predictable during refine than during other processes.

1. Switch to the Signatures view, and select the surfaces or signatures
that you want to use for final output.

2. Reduce individual spot colors from the final output using the Color
Separations dialog box:

a. From the Edit menu, select Color Separations.

The Color Separations dialog box appears.
b. Select the spot color and then select an option in the Output

Selected As list:

To Do This Select This

Convert a spot color to
process color

Either Convert to Process or a process color

Map a spot color to
another color

A spot or process color

(If the color doesn't already exist, first add a
color separation.)

Preserve a color Separately

(The separation is output separately only if the
Do Separations check box is selected in the
Render section of the process template.)

Omit the color from
final output

Do Not Output

c. Click OK.

3. Start a final output process on the selected surfaces or signatures
by dragging the surfaces or signatures to the imposition output
process template.

4. Preserve any other spot colors by clearing an option in the process
template:

a. In the Start Process dialog box, click Edit Process Template.
b. Expand either the Render section or the ColorConvert section.
c. In the Color Libraries area, clear the Always Use Color

Combiner to Convert Spots check box.
d. Close the process template.

5. Click OK to close the Start Process dialog box.

The final output process occurs, applying the settings of both the
final output proof process template and the Color Separations
dialog box. The bitmaps are generated.
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Tip:

● The Color Separations dialog box does not work with PDF files that are
composite.

● You can modify and save the process template before you start. Start the
process using the modified process template, and do not click Edit Process
Template in the Start Process dialog box.

● Changes made in the Color Separations dialog box affect all future imposition
output and final output.

Note: Impositions usually have marks with colors: CMYK colors, as well as generic
spots. The generic spots usually follow a specific naming convention (example,
"Spot1", "Spot2", and so on). When you import an imposition, all the imposition
colors are set to Do not output to avoid unnecessary and wasted plates. When
you assign a page to an imposition, Prinergy automatically turns on the necessary
colors in the imposition as well. This enables the imposition marks to reflect the
colors on the pages. Prinergy also automatically maps the imposition mark spot
colors to the page spot colors. For example, it will automatically map imposition
mark "Spot1" to page color "PANTONE Reflex Blue C". If necessary, you can
override this the automatic mapping by using the Separations view of Workshop.

Color Mappings dialog box
Note: The Color Mappings dialog box is a color mapping/color renaming tool. It is
not a color removal or extractor tool. This tool is only available for the first refine;
the Process Template Editor does not have any knowledge of what colors are in
the file. Use this tool to display the available colors to be mapped. You can add
more colors from the color database in order to map them on the first refine.
When you remove a specified color, this color is not actually removed. Instead,
removal means that you don't wish to map the specified color to anything. Objects
with this color are still painted.

Page Color

Lists all the colors found in the selected pages.

When a spot color is found in the selected color libraries, a
sample color swatch appears to the left of the color name. If the
spot color is an exception, it is named Otherwise and a warning

icon ( ) appears to the left of the color name.

After your first refine, you can redefine the Otherwise entries as
spot colors in your color database, or redefine them as Convert
to Process. After you perform the second refine, all the previous
exceptions noted as Otherwise should be eliminated.

Output

Lists the color output treatment you have specified for each
color in the Page Color list.
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Output Selected as

Specifies how you want Prinergy to output each color. After you
select one or more colors in the Page Colorcolumn, the list
displays the following options:

● Separately

Outputs the spot color. For final output, Prinergy outputs the
spot color as a separation. For imposition output, Prinergy
outputs the spot color as a separation if Output all
Separations is selected in the Output Separation Handling
box.

● Convert to Process

Converts a spot color to process color using the color recipe
from the color database.

● All the colors in the PDF pages

Outputs the spot color with the selected color.

The last two options are available only for spot colors in
composite PDF pages.

Add Page Color

Displays the Add Page Color dialog box where you can add a
new color mapping to your color database.

Remove Page Color

Select this button to remove a color mapping from your color
database.

Note: The Remove Page Color button does not remove or extract colors.
It only removes colors from the color database that are used to map
colors on the first refine.

Print Order

Displays the Print Order dialog box where you can specify the
lay down order for trapping colors.

Add Alias

Displays the Add Alias dialog box where you can create an alias
color name which displays in the Result column. You can use
the alias color name for color mapping.

When you type an alias color name into the Add Alias dialog
box and click OK, Prinergy searches the color database to see if
the color name exists. When the color name exists in the color
database, the alias color name appears in the Result column.
When the color name doesn't exist in the color database, you
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can choose whether to create an alias color name without a
color definition or create an alias color name with a color
definition and add it to the job.

Color Information

Displays the color definition information for the color you
selected in the Page Color column.

Add

Select this button to add a copy of the color definition.

This button is available only when you select an undefined
color.

Note: Factory spot colors cannot be edited.

Edit

Select this button to edit the color definition.

This button appears when you select a color defined in the Job
tab.

Note: Factory spot colors cannot be edited.

Edit Copy

Select to edit a copy of the color definition. This button creates
a copy of a global color in the Job tab of the color library.

This button appears when you select a color defined in the
Global tab.

Note: Factory spot colors cannot be edited.

Color Output dialog box

Page Color

Lists all the colors found in the selected pages.

When a spot color is found in the selected color libraries, a
sample color swatch appears to the left of the color name. If the
spot color is an exception, it is named Otherwise and a warning

icon ( ) appears to the left of the color name.

After your first refine, you can redefine the Otherwise entries as
spot colors in your color database, or redefine them as Convert
to Process. After you perform the second refine, all the previous
exceptions noted as Otherwise should be eliminated.

828 Chapter 14—Color



Output

Lists the color output treatment you have specified for each
color in the Page Color list.

Output

This column specifies how you want Prinergy to output each
color. After you select one or more colors in the Page Color
column, the list displays the following options:

● Output-Outputs the color as specified.
● Do Not Output-Suppresses output of the color.
● Convert to Process-Converts a spot color to process color

on output using the color recipe found in the selected color
libraries. This option is available only for spot colors in
composite PDF pages.

Color Information

Displays the color definition information for the color you
selected in the Page Color column.

Add

Select this button to add a copy of the color definition.

This button is available only when you select an undefined
color.

Note: Factory spot colors cannot be edited.

Edit

Select this button to edit the color definition.

This button appears when you select a color defined in the Job
tab.

Note: Factory spot colors cannot be edited.

Edit Copy

Select to edit a copy of the color definition. This button creates
a copy of a global color in the Job tab of the color library.

This button appears when you select a color defined in the
Global tab.

Note: Factory spot colors cannot be edited.
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About Spotless Extended Color Management
Spotless Extended Color Management expands the functionality of
Prinergy beyond CMYK to allow extended process color sets to
enhance quality and increase the number of spot colors that can be
replaced with process colors.

In Prinergy, spot color recipes are replaced with process color recipes
(also known as color builds) for a specific ink set. On press, spot color
inks are replaced with process color inks, giving spot color
performance on a process color budget.

For example, an extended process color set could consist of six process
colors: cyan, magenta, yellow, black, orange, and green (CMYKOG).
For this process color set, the recipes for all the colors are comprised of
combinations of CMYKOG. You store the color recipes in the Color
Editor in Prinergy Workshop and use them to convert spot colors to
process color.

For more information, see the Spotless Extended Color Management
documentation.

Die line and varnishes

About die line and varnish colors

A die is a series of knives used to cut shapes from a press sheet, and a
die line is a line that represents the position of the various knives and is
used to guide the die in cutting a press sheet. Die lines are usually
created using a Computer Assisted Design (CAD) program and
included in the original input files added to Prinergy.

A varnish or overprint coating is created to protect or improve the
visual appeal of a printed page, and is used to protect the print, for
decoration, adhesion, or for resistance to oil or moisture.

Die lines and varnishes need specific opacity attributes to ensure the
file prints correctly. For example, die lines cannot be trapped; they need
to be set to knockout on composite proofs and as an overprint ink
when outputting separations. Varnishes shouldn't display on
composite proofs.

Note: The die line or varnish color must have exactly the same name in Prinergy as
it has in the input file. For example, if the native application file includes the colors
Die and Varn, the color database in Prinergy must include a color Die or Varn.

If a die line or varnish color is not defined in the color database,
Prinergy treats it as a separate spot color and the color may print with
incorrect attributes.
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Setting die line and varnish colors

1. (Optional) Add a color for the die line or varnish to the Global tab
of the Color Editor with a name such as Die or Varn.

a. Set the Opacity of a die line color to die line.
b. Set the Opacity of a varnish color to Transparent.

This step is optional because you can also add the color while you
refine in Step 4.

2. Refine the pages where you want to use the die line or varnish by
starting a refine process template on the pages.

3. In the Start Process dialog box, click Color Mapping.

4. In the Color Mappings dialog box, perform one of the following
actions:

If the Die or Varn
Color

Do This

Is listed as a color Use the color as a die line or varnish.

Is not listed as a
color

a. Add a color for the die line or varnish to the Global
tab of the Color Editor with a name such as Die or
Varn.

b. Set the Opacity of a die line color to die line.
c. Set the Opacity of a varnish color to Transparent.

Using ColorFlow software
The ColorFlow 1.2 software is integrated with Prinergy.

The ColorFlow software delivers color relationship management that
unifies color control elements—such as ICC profiles, DeviceLink
profiles, and calibration curves—and manages the relationships
between color control elements and device print conditions.
Specifically, ColorFlow simplifies the process of setting up color and
ensuring that Prinergy jobs are processed using the correct color
settings.
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Getting started with ColorFlow

Complete these steps, in this
order

Notes

Install the ColorFlow software on
client computers.

As part of Prinergy, the ColorFlow Workflow Edition software and
colorstore database are automatically installed on the Prinergy primary
server. The ColorFlow server runs as a process on the Prinergy primary
server.

You must install the ColorFlow software on one or more client computers
that connect to a Prinergy server.

Note: Only one user can modify the colorstore database at one time.
Therefore, only one ColorFlow client computer can be running at a time.

For instructions on installing the ColorFlow software on client computers,
see the ColorFlow User Guide.

Consider whether you will import
Harmony tonal calibration curves.

Decide whether you'll use the ColorFlow software to create and manage
color control elements, or import existing Harmony tonal calibration
software curves. If you use Harmony, you can delay using some
capabilities of ColorFlow until you have time to print and measure charts
with your device conditions.

Note: When using ColorFlow with Prinergy, we recommend building new
curves rather than importing existing Harmony tonal calibration curves.

For more information about importing Harmony curves, see the ColorFlow
User Guide.

Configure ColorFlow. a. Create a color setup. A color setup is the virtual structure that you
build to define the color relationships among the devices in your
printing task. It includes devices, device conditions, a simulation
target, and color control elements, such as DeviceLink profiles and
curves.

A color setup manages how its device conditions simulate the primary
color output (PCO). If you edit the color response of a device
condition, ColorFlow ensures that related color control elements in the
color setup are updated to reflect the edit.

b. Add device conditions. A device condition is the combination of a
device and the operating conditions in which the device captures or
produces an image. It has a measurable color response.

A device condition can include more than one device. If it does, all
devices must have the same device type and must use the same
consumables and operational settings. The devices must be able to be
calibrated to yield a similar color response. Note that this applies to
curve-controlled devices only.

For more information about configuring ColorFlow, see the ColorFlow User
Guide.
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Complete these steps, in this
order

Notes

Measure or import the color
response of your device.

Perform either of the following actions:

● Create and measure a ColorFlow characterization chart.
● Import an existing measurement set.

The attributes of the chart must be suited to the inks you are using on the
output device, your measuring device, and the size of your press.

For more information about measuring color response, see the ColorFlow
User Guide.

Define simulation and conversion
settings.

Use the Simulation Definition dialog box in ColorFlow to control how a
primary color output (PCO) simulates the color target. ColorFlow can
perform the simulation using tonal curves or DeviceLinks or a
combination.

a. In the Target list, select the color response whose colors the PCO will
attempt to simulate. Often this will be an industry reference.

b. Using the Curves slider (for offset presses and halftone proofers only),
select how you want to use tonal curves. For an explanation of each
option, see the ColorFlow User Guide.

c. Using the DeviceLinks slider, select how you want to use DeviceLinks.
For some types of devices, not all values are available. Because the
DeviceLink is used in the context of a simulation, the DeviceLink
source is the color space selected in the Target list; the destination is
the device condition inside the PCO. For an explanation of each
option, see the ColorFlow User Guide.

For more information about simulation and conversion, and the options in
the Simulation Definition dialog box, see the ColorFlow User Guide.

Using ColorFlow in Prinergy

After you have configured the ColorFlow software, you can use the
ColorFlow settings in the refine, loose page output, imposition output,
and final output process templates to apply color control elements
during processing.

In the refine process template, you select a color setup. The available
color setups are in the ColorFlow colorstore database on the primary
server. When a page is refined using the refine process template, the
color setup specified in the process template is assigned to the page.

In each output process template, you select the Color Setup, Device,
Device Condition, Plate Setup, and Plate Line color control elements.
During output processing, the color setup assigned to each page during
refining defines the specific color control elements that are applied on
output, unless you choose override the color setup tagged to the file
during refine.

In addition, when you create a new job, you must enable ColorFlow in
the job and select a default color setup for the job. You do this in the
job's attributes. To successfully process job files with ColorFlow
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enabled, you must configure the process templates to use ColorFlow
and enable ColorFlow in the job.

When a job's pages are refined using a refine process template in
which you have enabled ColorFlow, the color setup that is assigned
depends on the ColorFlow settings in the refine process template:

● If the refine process template indicates to use the default color
setup selected for the job, the job's color setup is assigned during
refining.

● If a color setup is specified in the refine process template, the
settings in the template override the default color setup selected for
the job, and the color setup specified in the refine process template
is assigned.

● If a color setup is specified in the refine process template but
ColorFlow is not enabled for the job, refining will fail. For a job to be
processed using ColorFlow, the job must be ColorFlow-enabled and
a default color setup must be selected for the job, even if the default
color setup is not assigned during refining.

In Job Manager, the Color Setup column in the Pages pane indicates
the color setup assigned to each page.

Note: If the refine process template is not ColorFlow-enabled but the job has a
default color setup selected, what happens during refining depends on whether
the Match Colors option is selected in the process template. If Match Colors is not
selected, the job's default color setup is registered with the refined files, but no
color conversion is applied. If Match Colors is selected, refining will fail.

It is also possible to change a refine process template's ColorFlow
settings when you refine specific pages, to change the selected color
setup. This is useful when you plan to print parts of a job differently,
such as on different presses or with different ink sets. For example, for
a book that consists of a cover and body pages, you might want to print
the cover CMYK but print the body pages in black only.

Note: After you run a job with ColorFlow enabled, you cannot rerun the job
without ColorFlow enabled, unless you re-create the job.

Setting the halftone output modes

You can select one of four modes for output to halftone devices or files,
in the output process template. These modes control the curves that
are applied upon output, corresponding to your output goals.

Print Production

Reflects the standard operation of Prinergy and ColorFlow for
production. When this option is selected, a print calibration curve
and a plate calibration curve are applied to each output
separation.

834 Chapter 14—Color



Print Characterization

Is used to print and measure the response of a print device.
When this option is selected, a device curve and plate calibration
curve are applied to each output separation.

Plate Verification

Is used to verify the linear response of plates produced by a
particular plate line (consisting of the computer-to-plate device,
plate processor setup, and chemistry), with a selected
screening system. When this option is selected, only the plate
calibration curve is applied to input tints of all separations.

Plate Characterization

Supports imaging and measuring the uncalibrated (or intrinsic)
response of a plating line, such that a plate linearization curve
can be computed. When this option is selected, no calibration
curves are applied to input tints of any separations.

Applying ColorFlow curves and making tonal adjustments

If a printing plate has imaged and run on press, but the press is not
printing with the desired response, you may need to recreate the plate
using a different ColorFlow curve channel for one or more separations.
You can also make tonal adjustments to the assigned ColorFlow curve
channel. These adjustments, made on-the-fly from the Start Process
dialog box, are appended to the ColorFlow calibration curves and have
no effect on ColorFlow colorstores.

ColorFlow and archiving

If you retrieve an archived job for which ColorFlow is enabled, the
ColorFlow server will request the name of the color setup and the
number of the Snapshot that was used to initially process files within
that job. If you have modified any of the elements within the color
setup from the initial time of output, these modified elements will be
used to output the archived job.

In addition, if the initial color setup was deleted or renamed, the job will
fail processing. If you want to change a color setup, duplicate the
original one and make changes to the duplicated and newly named
color setup. You can use the Allow undefined color setup or color
setup mismatch check box to output the archived job when the
selected color setup differs from the color setup assigned by the refine
process.

ColorStore database and backups

If you are running the Windows 2003 Server operating system on your
Prinergy primary server, the Windows NT Backup utility automatically
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backs up your colorstore database. If you are running the Windows
2008 Server operating system on your Prinergy primary server, the
System Configuration Backup Utility performs the backup process of
the colorstore database. If you are using Prinergy with Hot Standby
(Hot Standby combines the basic functionality of failover, allowing a
Prinergy secondary server or render station to take over primary server
functions if the primary server fails), the colorstore database is also
automatically backed up.

Issues to consider when using ColorFlow

● Sharing ColorFlow-enabled work between plants or servers is not
possible unless the Prinergy Job Color Setup defaults are changed
to an available color setup and the Allow undefined color setup or
color setup mismatch check box is selected in the ColorFlow
section in the output process template. Note that output could be
significantly different.

● If you refine a file with ColorFlow selected, ensure that you select
ColorConvert and Enable ColorFlow if you refine the file again.
Otherwise, an error message appears.

● If you want to change the tagged color setup of a PDF file that has
been refined, you must refine the PDF file again with a new color
setup specified in the process template.

● You may encounter a situation in which you have two objects with
the same CMYK input in a single PDF file. One object is tagged with
an ICC-based CMYK profile; the other object is untagged using
Device CMYK. Conversion of the ICC-based CMYK content will
happen via embedded profiles for one object. In contrast, the
untagged content will be converted via a DeviceLink from
ColorFlow, if a DeviceLink is present in the selected color setup. To
avoid complication, override the embedded profile in the refine
process template, which will ensure that all content is managed via
DeviceLink.

● If you refine a file with the Prinergy Bypass Refine feature, ensure
you refine the file again to tag a color setup in the PDF file.

● When using ColorFlow, you can assign one color setup per page in
the refine process template. When using the imposition output
process template with ColorFlow, you can output an imposition file
that has different color setups for each page. When outputting in
this situation, ensure that you select a device condition that is
contained in all of the color setups assigned to all pages.

See also:
Tell me more about the ColorFlow and Prinergy
integration on page 837
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Tell me more about the ColorFlow and Prinergy
integration

ColorFlow 1.2 is integrated with Prinergy . ColorFlow 1.2 supports RGB
devices and RGB color inputs, as well as CMYK devices and CMYK
color inputs. You can select default CMYK or RGB source color spaces,
and ColorFlow can provide CMYK and RGB device profiles in the
Process Template Editor.

Background
● An ICC profile is a color space description that acts as a standard

for accurate reproduction of colors across different platforms,
devices, and applications, according to the standards of the
International Color Consortium (ICC). For example—an ICC profile
that describes a specific RGB device, such as a Kodak EasyShare
camera, provides a mapping of the camera's red, green, and blue
color space to device-independent L*a*b* coordinates (or CIE
L*a*b* color space).

● A PDF file is composed of many objects, and each object may have
come from a different source—for example, an RGB image captured
from a digital scanner or digital camera, CMYK graphics from
Illustrator, and so on. Each of these objects may be tagged with an
ICC profile.

Prinergy refine process template setup

You can set up color conversion either with or without ColorFlow.

● When you are setting up a refine process template without
ColorFlow, the ColorConvert section allows you to select ICC
profiles for color converting RGB and CMYK images and graphics.
These ICC profiles are only used by the Color Matcher JTP when an
object in the PDF file is not tagged with an ICC profile. In the case of
tagged PDF content, the ICC profile settings in the process template
are ignored by the Color Matcher JTP, and the tagged profile is
used.

Note: You can also use a DeviceLink profile that includes both the source and
the destination ICC profiles.

● In a ColorFlow-integrated environment, the color conversion that
takes place is to the primary color output (PCO) profile. In Prinergy,
a ColorFlow device condition is a named instance of a CMYK device
color response with an ICC device profile. For example, FOGRA 39
is a built-in device condition for which ColorFlow can provide a
CMYK device profile to Prinergy.

The following table summarizes how to configure the two options:
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For this option Do this

To use ColorFlow device conditions
for color conversion

a. In the ColorConvert section of the refine process template, in the
Match Colors section, select the Enable ColorFlow check box.

b. From the Snapshot list, select the desired snapshot from ColorFlow.
c. From the Color Setup list, select the ColorFlow color setup from those

available in the selected snapshot.
d. Select each image type for which you want to enable ColorFlow color

conversion, by selecting the relevant check boxes—CMYK Images,
CMYK Graphics, RGB Images and RGB Graphics.

e. From the lists next to the image type check boxes, select a ColorFlow
device condition.

The device conditions are the conditions that have been configured in
ColorFlow, which then supplies the DeviceLinks or profiles for the
CMYK-to-CMYK or RGB-to-CMYK conversion.

To use ICC profiles or DeviceLink
profiles for color conversion

a. In the ColorConvert section of the refine process template, clear the
Enable ColorFlow check box.

b. Select each image type for which you want to enable color conversion,
by selecting the relevant check boxes—CMYK Images, CMYK
Graphics, RGB Images and RGB Graphics.

c. From the lists next to the image type check boxes, select the relevant
ICC profile or DeviceLink profile.

If an object in the input file does not have an embedded profile, the ICC
profile selected for that object type is applied.
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15 Monitoring

Processes

About monitoring processes in Job Manager

You can get information about active processes for a job via dynamic
columns, the Processes Pane, and the Process Info dialog box.

Dynamic columns

When you start each process, a dynamic column automatically appears
in Job Manager.

The column has the same name as the process template being
executed, and it displays icons indicating the status of the process.

The icons in dynamic columns become grayed out  if their processes
are invalidated.

Process Info dialog box

The Process Info dialog box appears automatically if Show Process Info
Window When Process Is Created is selected in user preferences. If the
Process Info dialog box does not appear automatically, you can display
it manually. If more than one process is running, many Process Info
dialog boxes can appear.

Processes pane

When you start processing on an element, the active process appears in
the Processes pane. This pane, which is visible in every view of Job
Manager, lists all of the active and completed processes initiated from
within Job Manager for a specific job.

The Processes pane consists of two tabs:

● Active—displays any processes in progress.
● Completed—displays any processes that completed successfully,

completed with warnings or errors, failed, or were stopped before
they could be completed.

When a process is completed or stopped, it moves from the Active
tab to the Completed tab. (However, when an archive, purge, or
retrieve process fails or is stopped, it may appear in the Active



Processes pane for up to 30 minutes, even if subsequent attempts
at running the process are successful.)

About completed processes

If a process is completed successfully, it remains on the Completed tab
of the Processes Pane for a few minutes and then disappears.

If a process fails or stops, it remains on the Completed tab until one of
the following occurs:

● You delete the process.
● A certain amount of time passes, after which the process is

automatically deleted.
● You reselect the same elements and the same process template,

and start the process again. If the process is completed
successfully, it replaces the original failed or stopped process.

About process status icons

When you initiate a process from Job Manager, icons indicating the
status of the process appear in the Processes pane, in a dynamic
column next to the elements being processed, and in the Process Info
dialog box for the process.

Two kinds of status icons may appear—Activity icons and Condition
icons.

Activity icons

Activity icons indicate what stage the processing is at. They appear
only while a process is running, not after it is complete.

Icon The process is

Queued

In progress

Paused

Waiting for a user action

Condition icons

Condition icons indicate whether any errors or warnings occur.

Icon What occurred

No warnings or errors

No warnings or errors, and process is complete

A warning
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Icon What occurred

An error

Activity icons always appear in conjunction with a Condition icon. For
example, you may see  and  together, which means that the process
encountered a warning but is continuing. Or you may see  and 
together, which means that the process has been paused but has so far
encountered no warnings or errors.

The icons in dynamic columns become grayed out  if their processes
are invalidated.

Viewing detailed information about a process

1. In the Processes pane of Job Manager, double-click the process.

Tip: You can also right-click the process and select Get Info.

The Process Info dialog box appears, displaying details about the
process.

2. When you are finished reviewing the information, click Close.

Deleting completed processes

1. Click the Completed tab of the Processes pane in Job Manager.

2. Perform one of the following actions:

○ Select the process. Then, from the File menu, select Delete
Process.

○ Right-click the process, and select Delete Process.

Processes pane

While each process runs, the Active tab displays the following:

● Icons indicating the status of the process.
● A description of the process in the following format:

server :
process
template group

:
process
template

:
number of
elements

type of
elements

For example, Atreus:Templates:Refine:10 Input
Files
If you changed the name of the process template in the Start
Process dialog box, the Processes pane displays the revised name.

● A progress bar indicating the overall progress of the process. (The
same progress bar appears in the Process Info dialog box for the
active process.) Once the process is completed or stopped, the
progress bar disappears.
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Process Info dialog box

Icon (See About process status icons on page 840)

progress bar (unlabeled)

Indicates the overall percentage of the process that is complete.

If a process template executes more than one JTP, each JTP has
its own progress bar.

The same progress bar appears under the process in the
Processes pane of Job Manager while the process is active.

Stop

Click this button to stop a running process.

After the process ends, this button changes to a Close button.

Close

Click this button to close the Process Info dialog box.

This button appears only after the process ends. While the
process is running, the button is a Stop button that you can use
to stop the process.

Process Details

Process Template

The name of the process template used to initiate the process.

If you modified the process template when you initiated the
process by clicking the Edit Process Template button in the
Start Process dialog box, the process template name will appear
as Process Template:<name> (Modified).

Process Template Group

The group to which the process template used to initiate the
process belongs.

Submitted by

The user who initiated the process.

Job

The job from within which the process was initiated.
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Comment

Any comments that the user entered in the Output Comment
box of the Start Process dialog box when they initiated the
process.

These comments are also stored in the History view for the job.

Status / Process Status

The status of the process, for example, Queued, Active, or
Ended.

Submitted (at)

The date and time that the process was initiated.

Started (at)

The date and time that the JTP (job ticket processor) began
executing the process.

Ended at

The date and time that the JTP (job ticket processor) finished
the process.

system messages box (unlabeled)

Displays details about the progress of the process. The
following types of messages may appear:

●  Information—the action completed successfully.
●  Warning—the action encountered a problem but carried

on to completion.
●  Error—the action failed.

After the process is complete, these details can also available in
the History view.

Process Elements

Lists the element or elements being processed, by file name and
file kind.

Queue Manager
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About Queue Manager

A Queue Manager lists all of the processes being executed by the
server. You can use Queue Manager to stop, hold, or resume a process,
and to change the priority of a queued process.

The Queue Manager consists of two views—JTP Queues and Process
Types.

JTP Queues

The JTP Queues view displays all active processes for a specific JTP
(job ticket processor) in your system.

JTPs are software components that process job files according to
instructions in the process templates that you apply to the job files. For
example, the Archive-Retrieve JTP processes files according to the
instructions in an archive or retrieve process template.

Process Types

The Process Types view displays all active processes for a specific
process type in your system.

Choosing a view

A process may execute multiple JTPs—one JTP for each step. For
example, a refine process could include the Normalize, ColorConvert,
and Trap JTP.

If a process includes multiple JTPs:

● The Process Types view displays the entire process, and indicates
the priority of the entire process.

● The JTP Queues view displays the process multiple times as it
moves through each JTP, and indicates the order of each step within
each JTP queue.

More than one process may use the same JTP. For example, both a
refine process and an output process may use the ColorConvert JTP.
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Opening Queue Manager

From the Tools menu, select Queue Manager.

Stopping, pausing, and resuming processes in Queue Manager

1. Open Queue Manager.

2. View the specific process in one of these ways:

○ To select a JTP process, click the JTP Queues tab, and select a
JTP in the list.

○ To select a process by type, click the Process Types tab, and
select a process type in the list.

3. In the View pane, select the process that you want to change.

4. From the Edit menu, select Process, and then select the desired
activity state:

● Pause: pauses the process, setting its status to Suspended. Note
that the process pauses at the next logical point—not
necessarily immediately.

● Resume: resumes a paused process, setting its status to Active.
● Stop: ends the process, removing it from Queue Manager. You

cannot restart a stopped process.

Tip: To stop a process, you can also right-click it and select Stop.

● Force Destroy: forcibly destroys the process, removing it from
Queue Manager. This menu item is available only if you have
already tried to end the process using the Stop menu item at
least once, and the process did not end.

The new activity state appears in the Status column of the View pane.

Changing processing priority

You set processing priority in the Start Process dialog box when you
initiate a process, but you can change the priority of the process in
Queue Manager.

1. Open Queue Manager.

2. View the specific process in one of these ways:

○ To select a JTP process, click the JTP Queues tab, and select a
JTP in the list.

○ To select a process by type, click the Process Types tab, and
select a process type in the list.

3. In the View pane, select the process that you want to change.
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4. From the Edit menu, select Process > Select Task Priority.

5. In the Select Task Priority dialog box, select the desired priority and
click Select.

The new priority appears in the Priority column of the View pane.

A new history detail is also created to record the change in priority.
History details for a job can be viewed in the History view of Job
Manager.

Viewing information about processes in Queue Manager

You can view detailed information about a single process from within
Queue Manager.

1. View the specific process in one of these ways:

○ To select a JTP process, click the JTP Queues tab, and select a
JTP in the list.

○ To select a process by type, click the Process Types tab, and
select a process type in the list.

2. In the View pane, select the process that you want information
about.

3. Perform one of the following actions:

○ Double-click the process.
○ Right-click the process and select Get Info.
○ From the File menu, select Get Info.

The Process Info dialog box appears, displaying details about the
selected process.

Queue Manager window

The Queue Manager window consists of two views, each with their
own columns:

JTP Queues View

Displays all active processes for a specific JTP (job ticket processor) in
your system.

The left-hand pane of the JTP Queues view (known as the Filter
palette) lists the JTPs that reside on the server. This list may vary
depending on the configuration of your system. Click a JTP to display
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all active processes for that JTP in the right-hand pane (the View
pane).

Name

Displays the name of the process, the status of the process
using status icons, and the icon for the process template group
to which the process belongs.

Queue Position

A number representing the position of the process in the queue.
When processes include multiple files, a range of position
numbers is shown, representing the position of the first and last
files.

Priority

See Select Task Priority dialob box.

Job

The name of the job with which the process is associated.

User

The logon ID of the user who initiated the process.

Submitted (at)

The date and time that the process was initiated.

Process Template

The name of the process template used to initiate the process.

Process Template Group

The group to which the process template used to initiate the
process belongs.

Type

The process template type for this process, for example,
Archive, Retrieve, or Purge.

Status / Process Status

The status of the process, for example, Queued, Active, or
Ended.

Elements

The number and type of elements that are inputs to the
process.

Queue Manager 847



Process Types View

Displays all active processes for a specific process type in your system.

The left-hand pane of the Process Types view (known as the Filter
palette) lists the process types that reside on the server.

This list may vary depending on the configuration of your system. Click
a process type to display all active processes for that process type in
the right-hand pane (the View pane).

Name

Displays the name of the process, the status of the process
using status icons, and the icon for the process template group
to which the process belongs.

Priority

See Select Task Priority dialob box.

Job

The name of the job with which the process is associated.

User

The logon ID of the user who initiated the process.

Submitted (at)

The date and time that the process was initiated.

Started (at)

The date and time that the JTP (job ticket processor) began
executing the process.

Process Template

The name of the process template used to initiate the process.

Process Template Group

The group to which the process template used to initiate the
process belongs.

Status / Process Status

The status of the process, for example, Queued, Active, or
Ended.

Elements

The number and type of elements that are inputs to the
process.
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The columns you see depend on which columns you are displaying or
hiding.

See also:
Select Task Priority dialog box on page 849
Menus in Queue Manager on page 849
Displaying and hiding columns on page 1034

Select Task Priority dialog box

Use this dialog box to change the priority of the active process you
have selected in Queue Manager. Options are:

● Urgent
● High
● Normal
● Low

Note: The following applies to GDAPI devices only.

● A task with High priority will be sent by the server to the JTP after
the device control software queue has processed all the surfaces
that have separations. For example, if the device queue has two
separations in its queue (Surface1 C and Surface1 M), and Prinergy
has two separations in its queue (Surface1 Y and Surface1 K), then a
high priority plate will be made after Surface1 K is finished; that is,
after all Surface1 is done.

● A task with Urgent priority will be sent right away and queued at
the end of the device control software queue, even if the currently-
imaging surface still has separations in the Prinergy queue. For
example, if the device queue has two separations in its queue
(Surface1 C and Surface1 M), and Prinergy has two separations in its
queue (Surface1 Y and Surface1 K), then an urgent priority plate will
be made after Surface1 M; that is, after the queued separations in
the device queue, and before the separations still queued in
Prinergy.

Menus in Queue Manager

Workshop menu in Queue Manager

Note: This menu is available only when running Prinergy Workshop on a
Macintosh client.

About Prinergy Workshop

Displays information about Prinergy Workshop, including the
version number, a list of licensed features, and the server name.
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Preferences

Use to view and modify Prinergy Workshop preferences. When
you select this menu item, the Workshop Preferences dialog
box appears.

Note: On a Windows client, this menu item appears under the Edit menu.
On a Macintosh client, it appears under the Workshop menu.

Quit / Quit Prinergy Workshop

Quits Prinergy Workshop. Any open Prinergy Workshop
windows are closed.

File menu in Queue Manager

Get Info

Displays information about the selected process. When this
menu item is selected, the Process Info dialog box appears.

Close Window

Closes the current window, but does not quit Prinergy
Workshop.

Quit / Quit Prinergy Workshop

Quits Prinergy Workshop. Any open Prinergy Workshop
windows are closed.

Edit menu in Queue Manager

Select All Processes

Selects all of the active processes in the current view.

Process

Enables you to modify the state and priority of the selected
process. When you select Process, a submenu appears.
Options are:

● Set Process Priority: Select this menu item to change the
priority of the process. (You set the priority in the Start
Process dialog box when you initiate a process, but you can
change the priority in Queue Manager.) When you select
this menu item, the Select Task Priority dialog box appears.

● Pause: Pauses the process, setting its status to Suspended.
Note that when you select Pause, the process is not
necessarily paused immediately—it is paused at the next
logical point.
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● Resume: Resumes a paused process, setting its status to
Active.

● Stop: Ends the process, removing it from Queue Manager.
You cannot restart a stopped process.

● Force Destroy: Forcibly destroys the process, removing it
from Queue Manager. This menu item is available only if you
have already tried to end the process using the Stop menu
item at least once, and the process did not end.

Preferences

Use to view and modify Prinergy Workshop preferences. When
you select this menu item, the Workshop Preferences dialog
box appears.

Note: On a Windows client, this menu item appears under the Edit menu.
On a Macintosh client, it appears under the Workshop menu.

Cut, Copy, and Paste appear on the Edit menu, but they do not apply.

View menu in Queue Manager

Refresh

Updates the contents of the current window.

JTP Queues

Displays the JTP Queues view in the Queue Manager window.

Process Types

Displays the Process Types view in the Queue Manager
window.

Visible Columns

Use to display and hide columns in the current window or pane.
When you select this menu item, the Visible Columns dialog
box appears. From there, you select the columns that you want
to display, and clear the columns that you want to hide.

The columns that can be displayed vary from window to
window.

Tools menu in Queue Manager

Change User

Displays the Connect to Server dialog box where you can log in
as another user without quitting Prinergy Workshop.
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This menu item appears only if you have Kodak Prinergy
Business Link software connected to the Prinergy system.

Job Finder

Opens Job Finder.

If you are already in Job Finder, this menu item is unavailable.

Destroy History Entries

In the History view, select one or more history entries and then
use Destroy History Entries to delete the selected entries.

Process Template Editor

Launches Process Template Editor, where you can create and
modify process templates.

Automated Page Assignment Editor

Starts the Automated Page Assignment Editor, which you use
to create and check APA files.

Queue Manager

Launches Queue Manager, where you can view the Job Ticket
Processors (JTPs) and process types.

Media Manager

Launches Media Manager, where you can manage your archive
tapes and disk volumes.

System History

Launches System History, which displays the detailed history of
all the activity occurring outside of job context (such as jobs
and groups that were created or destroyed), as well as job
archive, purge, and retrieve history.

Smart Hot Folder Manager

Launches the Smart Hot Folder Manager dialog box, where you
can add, edit and delete smart hot folders.

Configure Imposition Application

Displays the Configure Imposition Applications dialog box,
where you can identify the location of imposition software that
you want to integrate with Prinergy Workshop.

Start Imposition Application

Displays the Start Imposition Application dialog box, where you
choose which imposition software to start. You create this list
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of imposition applications with the Configure Imposition
Application tool from the Tools menu. If an application requires
a license and is licensed, it appears in bold.

Color Editor

Launches Color Editor, where you can create color recipes for
all jobs.

Color Space Editor

Launches Color Space Editor, where you can create and edit
color spaces.

Font Converter

Launches Font Converter, where you can convert font files into
PFA (Printer Font ASCII) format, which Prinergy requires to
correctly process fonts.

Preflight Profile Manager

Launches Preflight Profile Manager, where you can, during the
refine process, evaluate PDFs to detect problems that may
affect processing in a publishing or prepress workflow.

Digital Print Administration Console

Launches the Digital Print Administrator, where you can add
and configure a digital print application that Prinergy can launch
to print PDFs.

Rule Set Manager

Opens the Rule Set Manager, where you can create and edit
rule sets. The Rule Set Manager also lets you organize rule sets
into groups.

Activate Rule Set in Selected Jobs

Opens the Select Rule Set dialog box, where you can activate
rule sets for one or more jobs.

Help menu in Queue Manager

Online help

Starts your Web browser and displays the Prinergy online help.

On <current window or view>

Starts your Web browser and displays the Prinergy Workshop
user guide, open to the topic for the currently selected window
or view.
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Quick Start Guide

Starts Adobe Acrobat and displays a PDF file of the Prinergy
Connect Quick Start Guide

eCentral Online Support

Starts your Web browser and displays the eCentral portal at 
https://ecentral.kodak.com/.

Visit graphics.kodak.com

Starts your Web browser and displays the Kodak Web site at 
http://graphics.kodak.com/default.htm.

About Prinergy Workshop

Displays information about Prinergy Workshop, including the
version number, a list of licensed features, and the Prinergy
server name.

Note: This menu item appears on the Help menu only when you are
running Prinergy Workshop on a Windows-based client computer. On a
Macintosh client computer, the menu item About Workshop appears on
the Workshop menu.

Keyboard shortcuts in Queue Manager

Macintosh
Keyboard
Shortcut

Windows
Keyboard
Shortcut

Description

 + A Ctrl + A Selects all processes in the active View pane

 + H Ctrl + H Displays the Select Task Priority dialog box, which
you use to change the priority of the selected
process

 + I Ctrl + I Displays the Process Info dialog box for the
selected active process

 + Q Ctrl + Q Quits Prinergy Workshop

 + R Ctrl + R Refreshes the selected view

 + W Ctrl + W Closes Queue Manager

 + 1 Ctrl + 1 Displays the JTP Queues view in the Queue
Manager window

 + 2 Ctrl + 2 Displays the Process Types view in the Queue
Manager window

System History
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About System History

System History displays detailed records of all activity occurring
outside of job context (such as jobs and groups that were created or
destroyed) as well as job archive, purge, and retrieve history.

(For information about processes that occur within a specific job, see
the History view of Job Manager.)

Using System History, you can check the results of multiple processes
without having to open individual jobs. This is helpful, for example, if
several jobs were archived overnight and you want to see the results in
the morning—without having to open each job.

Each message in System History is accompanied by an icon
representing the severity of the message. Severity levels are:

●  Information—the action completed successfully
●  Warning—the action encountered a problem but carried on to

completion
●  Error—the action failed

You can change the display in System History window by:

● Expanding a message about an action to view details about that
action

● Displaying different time periods
● Grouping messages into categories, such as Job Settings and

Storage, depending on the messages currently in System History

Note: You cannot destroy history messages in System History; you can destroy
history messages only in the History view of Job Manager.

About viewing screening information of completed jobs

System History records the screening information that was applied to
an output.

This information helps you confirm that the correct screening was
applied to an output. Also, if you need to regenerate an output (for
example, remake a plate or reprint a job), this information helps ensure
that the same screening was applied to the regenerated output that
was applied to the original output.

Only one history message is generated for each screening setting. For
example, if 100 objects are identically screened, only one history
message is created to record screening information.

The following screening information is captured in system history:

● Screen system
● Dot shape
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● Screen angle
● Ruling
● Maxtone settings

Displaying System History

1. From the Tools menu, select System History.

2. Perform any of the following actions:

To Do This

View messages from a different time
period.

Select the time period from the
History Starting list.

Group messages into categories. Click Group by Category .

Change the columns that are
displayed.

See Displaying and Hiding Columns.

Copying system history messages

1. Display System History.

2. Select the history messages (actions and details) that you want to
copy.

3. From the Edit menu, select Copy.

4. Paste the history messages into the desired text editor.

System History window

Group by Category 

Groups history messages into categories. The available
categories depend on the messages currently in System
History, but can include Job Settings, Storage, and so on.

History Starting

Use this list to filter the date range of history messages shown
in the System History window.

Description

A short description of the action taken. For each action, the
description includes a number at the end of the text indicating
the number of detail items listed for that action. You can
expand an action to view its details.

User Name

The logon name of the user who initiated the action.
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Time

The date and time that the action or process was initiated.

Severity

Indicates whether the message is for information only, or is an
error or warning.

The columns you see depend on the columns you display or hide.

Menus in System History

Workshop menu in System History

Note: This menu is available only when running Prinergy Workshop on a
Macintosh client.

About Prinergy Workshop

Displays information about Prinergy Workshop, including the
version number, a list of licensed features, and the server name.

Preferences

Use to view and modify Prinergy Workshop preferences. When
you select this menu item, the Workshop Preferences dialog
box appears.

Note: On a Windows client, this menu item appears under the Edit menu.
On a Macintosh client, it appears under the Workshop menu.

Quit / Quit Prinergy Workshop

Quits Prinergy Workshop. Any open Prinergy Workshop
windows are closed.

File menu in System History

Close Window

Closes the current window, but does not quit Prinergy
Workshop.

Quit / Quit Prinergy Workshop

Quits Prinergy Workshop. Any open Prinergy Workshop
windows are closed.

Edit menu in System History

Cut (unavailable)
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Copy

Select one or more history messages and select Copy. You can
then paste the history messages into a separate text editor.

Paste (unavailable)

View menu in System History

Refresh

Updates the contents of the current window.

Visible Columns

Use to display and hide columns in the current window or pane.
When you select this menu item, the Visible Columns dialog
box appears. From there, you select the columns that you want
to display, and clear the columns that you want to hide.

The columns that can be displayed vary from window to
window.

Tools menu in System History

Change User

Displays the Connect to Server dialog box where you can log in
as another user without quitting Prinergy Workshop.

This menu item appears only if you have Kodak Prinergy
Business Link software connected to the Prinergy system.

Job Finder

Opens Job Finder.

If you are already in Job Finder, this menu item is unavailable.

Destroy History Entries

In the History view, select one or more history entries and then
use Destroy History Entries to delete the selected entries.

Process Template Editor

Launches Process Template Editor, where you can create and
modify process templates.

Automated Page Assignment Editor

Starts the Automated Page Assignment Editor, which you use
to create and check APA files.
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Queue Manager

Launches Queue Manager, where you can view the Job Ticket
Processors (JTPs) and process types.

Media Manager

Launches Media Manager, where you can manage your archive
tapes and disk volumes.

System History

Launches System History, which displays the detailed history of
all the activity occurring outside of job context (such as jobs
and groups that were created or destroyed), as well as job
archive, purge, and retrieve history.

Smart Hot Folder Manager

Launches the Smart Hot Folder Manager dialog box, where you
can add, edit and delete smart hot folders.

Configure Imposition Application

Displays the Configure Imposition Applications dialog box,
where you can identify the location of imposition software that
you want to integrate with Prinergy Workshop.

Start Imposition Application

Displays the Start Imposition Application dialog box, where you
choose which imposition software to start. You create this list
of imposition applications with the Configure Imposition
Application tool from the Tools menu. If an application requires
a license and is licensed, it appears in bold.

Color Editor

Launches Color Editor, where you can create color recipes for
all jobs.

Color Space Editor

Launches Color Space Editor, where you can create and edit
color spaces.

Font Converter

Launches Font Converter, where you can convert font files into
PFA (Printer Font ASCII) format, which Prinergy requires to
correctly process fonts.
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Preflight Profile Manager

Launches Preflight Profile Manager, where you can, during the
refine process, evaluate PDFs to detect problems that may
affect processing in a publishing or prepress workflow.

Digital Print Administration Console

Launches the Digital Print Administrator, where you can add
and configure a digital print application that Prinergy can launch
to print PDFs.

Rule Set Manager

Opens the Rule Set Manager, where you can create and edit
rule sets. The Rule Set Manager also lets you organize rule sets
into groups.

Activate Rule Set in Selected Jobs

Opens the Select Rule Set dialog box, where you can activate
rule sets for one or more jobs.

Help menu in System History

Online help

Starts your Web browser and displays the Prinergy online help.

On <current window or view>

Starts your Web browser and displays the Prinergy Workshop
user guide, open to the topic for the currently selected window
or view.

Quick Start Guide

Starts Adobe Acrobat and displays a PDF file of the Prinergy
Connect Quick Start Guide

eCentral Online Support

Starts your Web browser and displays the eCentral portal at 
https://ecentral.kodak.com/.

Visit graphics.kodak.com

Starts your Web browser and displays the Kodak Web site at 
http://graphics.kodak.com/default.htm.

About Prinergy Workshop

Displays information about Prinergy Workshop, including the
version number, a list of licensed features, and the Prinergy
server name.
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Note: This menu item appears on the Help menu only when you are
running Prinergy Workshop on a Windows-based client computer. On a
Macintosh client computer, the menu item About Workshop appears on
the Workshop menu.

Keyboard shortcuts in System History

Macintosh
Keyboard
Shortcut

Windows
Keyboard
Shortcut

Description

 + C Ctrl + C Copies the selected history messages so that they
can be pasted into a separate text editor

 + Q Ctrl + Q Quits Prinergy Workshop

 + R Ctrl + R Refreshes the selected view

 + W Ctrl + W Closes the System History window

Job history

About viewing job history

The History view of Job Manager displays the detailed history of all the
activity for a particular job. For each job, the History view displays:

● A description of each action taken on the job. (You can expand each
description to display additional details, and double-click each
additional detail to display more information and copy the text.)

● Individual messages for each action. (The same messages appear in
the Process Info dialog box when the process is active.)

● The date and time the action was taken
● The severity of the message

If the History view gets cluttered, you can destroy the messages if you
have permission to do so.

About destroying job history

You may want to destroy entries in the History view of Job Manager
to:

● Reduce clutter in the History view.
● Increase the performance of Prinergy Workshop.

Destroying entries also deletes the history log items from the database.

Only certain users have the right to destroy history entries. If a user
does not have the right, the Tools > Delete History Entries menu item
is unavailable and has an [x] to the right of it.
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You set user rights in Administrator. For more information about
setting user rights, see the System Administration Guide.

Viewing job history

In Job Manager, from the View menu, select History.

Destroying history entries

1. In Job Manager, select the History view.

2. Select the history entries you want to destroy.

Tip: Click  to switch between grouping and ungrouping entries by type.

3. From the Tools menu, select Destroy History Entries.

4. Click OK.
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16 Job export/import

Job export

About exporting jobs

You can transfer a job from one Prinergy system to another by
exporting all or part of the job using the export process template, and
then importing it into the other system.

There are two types of exports:

● Complete exports, which exports the whole job.

For an export to be successful, the job must contain refined PDF
pages.

● Incremental or partial exports, which exports portions of a job.

For an incremental export to be successful, the job must contain
refined PDF pages and an imposition plan.

The exported file has the same name as the job, plus an extension
of .zip, such as jobname.zip. If you export more than once, you can
choose to either overwrite an existing export file name or create a new
export file name if the job name is the same.

All aspects of exports are controlled by export process template
options.

An exported job contains most, but not all aspects of the job, as
explained in the following table:

Included Not Included

Imposition plans

PDF files for the job, also known as digital
masters

Page sets

Page assignments

Page geometry

Final color separations and color mappings

Color database from the Job tab of the Color
Editor

Job notes

Input files
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About incremental exports

Incremental exports are exports of certain parts of a job, based on
signatures.

Incremental exports are useful to:

● Break up a large job for printing at multiple sites
● Break up a large job into files that are small enough to transfer to a

remote site, which gradually reassembles the job
● Send jobs to sites with Prinergy Direct software, which requires only

signatures, not all aspects of the job. This is called a hub-and-spoke
operation, where the Prinergy Connect or Prinergy Powerpack
operator creates partial exports for sites with Prinergy Direct.

● Update a previous export

For an incremental export to be successful, the job must contain
refined PDF pages and an imposition plan.

When a site receives an incremental export, it must do an incremental
import to bring the file into Prinergy.

Hot folders with incremental exports

To import incremental exports, remote sites can create a pre-job and
link it to an import process template.

When you drop an incremental export into a pre-job hot folder, the file
name determines whether Prinergy creates a new job. If the
incremental export file name:

● Matches the name of an existing job, Prinergy adds the export to an
existing job

● Does not match the name of an existing job, Prinergy creates a new
job using the export file name

If you want to create more than one incremental export from the same
job for use by a remote site with a pre-job hot folder, you need to
rename the files. When you first create the incremental exports, give
the files different names so that they do not overwrite each other. But
before you send the files to the remote site, be sure to rename the file
names with the same name so that Prinergy imports the files into the
same job.
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Exporting a job or partial job

1. Select what you want to export by doing one of the following
actions:

To Do This

Export a job from the Job
Finder

a. Select the job.
b. From the File menu, select Export Job.

Export a job from Job
Manager

From the File menu, select Export Job.

Export signatures a. In the Signatures view of Job Manager,
select one or more signatures.

b. From the File menu, select Export Job
(Incremental).

2. In the Choose Process Template dialog box, choose an export
process template, and click OK.

3. In the Start Process dialog box, click Edit Process Template.

4. In the process template, click  next to the Export section, set the
Export options, and click OK.

5. If you want to change the name, type the new name in the Zip
Filename box, ensuring it ends in the .zip extension.

6. Set any other options the Start Process dialog box, and click OK.

7. Click OK.

Export process template

The export process template contains one section called Export.

Click  to expand this collapsible section and see the options in
it.

Select this check box to enable the Export section of the export
process template.

JTP

Select the JTP you want to use to export job files.

Include Pages in Job Exports

Select to include the PDF pages in the compressed file that
Prinergy creates when it exports a job.
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Create Export Backwards Compatible with Prinergy 2.0.7

Select when you want the exported job to successfully import
into a Prinergy 2.0.7 (or earlier) system.

Export Type

The selection in this box affects the default value displayed in
the Export Path box. Select an export type and then provide
additional information in the Export Path box.

Select Absolute File to enter the path for a specific network
device or file location.

Select Job-Relative File to enter a path that is relative to the
location of the job folder.

Note: If you enter a path for a network device in the Export Path box,
Prinergy automatically changes the Export Type option to Absolute File,
if it is not selected.

Overwrite Existing Files with Same Name

Select to enable Prinergy to overwrite an existing exported job
file (<job name>.zip) with a new exported job file when the files
have the same name.

When you enable this feature and export the same job a second
time, Prinergy overwrites the first exported job file with the
second exported job file.

When you disable this feature and export the same job a
second time, Prinergy gives the second exported job file a
unique name by giving it version number, for example, job1.zip
as opposed to job.zip. Because the two files have unique names,
they do not overwrite each other. The result is two exported job
files.

Export Path

Specifies the folder to which the system exports a job. Click
Browse to locate and select the folder.

Maximum File Size

Specify the size of the compressed file in kilobytes (KB) to be
able to fit the file onto a medium such as a compact disk. (The
default is 3145728 KB or about 3 GB.)

Job import
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About importing jobs

Importing is the process of creating a job based on a previously
exported job. Export files have a .zip extension.

Use any of these methods to import jobs:

● Import a job in the Job Finder using the Import Job menu item
● Import a job while creating a new job
● Import a job using a hot folder
● Import a partial job using the Import Job (Incremental) menu item
● Import a partial job using a hot folder

Someone must export a job or a partial job before you can import it.

When you import an exported job, Prinergy decompresses the
exported job file, and populates the new job with the content from the
exported job.

If the exported job has an APA file, Prinergy looks for the APA file with
the latest date and time, and then copies the information from it into a
new APA file. The filename of the new APA includes a version number,
such as Job.v1.apa, to indicate it is a different version than the original
Job.apa file.

All aspects of imports are controlled by an import process template.

Importing an entire job using the menus

1. In Job Finder, from the File menu, select Import Job.

2. In the Import Job dialog box, navigate through the volumes and
folders to choose an export job to import.

Ensure that the job is an export file by reviewing the information in
the Selected Job Info list.

3. Under Options, read the name of the process template that
controls the import process.

If you want to change the template, click Select. In the Choose
Process Template dialog box, select an ImportAll process template,
and click OK.

4. Click OK.

5. In the Create New Job dialog box, set the options.

6. Specify the group name and job name you want.

If you are importing to the same Prinergy system as the one from
which you exported the job, you must use a different job name.

7. Click Create.
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8. If you want to change any processing options:

a. In the Start Process dialog box, under Options, click Edit Process
Template.

b. In the Import Process Template, change any settings, and click
OK.

9. Click OK.

The import process starts, and the new job opens in Job Manager.

Importing an entire job using hot folders

1. Create a pre-job.

2. Create a hot folder for the pre-job, and link it to an ImportAll type of
import process template.

3. Using a file browser, drop the export .zip file into the hot folder.
Prinergy creates a job on the server where the pre-job is located.

Importing a partial job using the menus

1. Open an existing job.

2. In Job Manager, from the File menu, select Import Job
(Incremental).

3. In the Import Job dialog box, navigate through the volumes and
folders to choose an export job to import.

Ensure that the file is an export file by reviewing the information in
the Selected Job Info list.

4. Under Options, read the name of the process template that
controls the import process.

If you want to change the template, click Select. In the Choose
Process Template dialog box, select an ImportJobIncremental
process template, and click OK.

By default, the ImportJobIncremental process template keeps the
existing page set and imposition.

5. Click OK to start the import process.

6. If you want to change any processing options:

a. In the Start Process dialog box, under Options, click Edit Process
Template.

b. In the Import Process Template, change any settings, and click
OK.

7. Click OK.

8. Click OK.
The ImportJobIncremental process starts.
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Importing a partial job using hot folders

1. Start with an existing job.

2. Create a hot folder for the job, and link it to an ImportIncremental
type of import process template.

3. Using a file browser, drop the partial export .zip file into the hot
folder.

Prinergy imports the partial job into the existing job. If an imported
signature has the same name as an existing signature, Prinergy
adds a suffix of "01" to the imported signature.

Import Job dialog box

Unlabeled list and results area

Selecting an item in the list at the top left of the dialog box
displays that item's contents in the box below.

When you select:

● Volumes, the volumes in your system appear
● A volume name, folders at the root of the selected volume

appear
● A folder name, files within the folder appear

The path of the displayed item in the list appears in reverse
order, for example, folder name followed by volume name.

Volumes

Displays all volumes in the Prinergy system.

Job Folder

(Visible only when you reach this dialog box by clicking Import
Job in Job Finder, not Import Job (Incremental) in the Job
Manager)

Opens the job folder for the current job.

Selected Job Info

Displays information about the job that is selected in the
Choose Job lists. It displays either the job name or a warning
that the job is not an export file.

Show Hidden Files

Select this check box to include hidden files, such as system
files, in the results.
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You can set the default selection of this check box on the View
tab of the Workshop Preferences dialog box.

Select

Click this button to open the Choose Process Template dialog
box, where you can change the import process template that
controls the current import.

Import process template (jobs)

This topic applies only if you are importing jobs, not importing
impositions.

To import entire jobs, use the ImportAll process template. To import
partial jobs, use the ImportJobIncremental process template.

Import section

Select this check box to enable the Import section of the import
process template.

It determines how Prinergy imports impositions, exported jobs,
and exported job files.

If Page Set Already Exists

Determines what happens if a page set with the same name
already exists.

Note: When importing an imposition plan via a hot folder, choose any
option except Keep existing page set and imposition.

The options are:

● Fail import: Stops the import process.
● Delete existing page set and imposition: Replaces the

existing page set and imposition with the page set and
imposition being imported.

● Create alternate page set and imposition: Creates a new
page set and links it to the imposition plan, without affecting
the existing page set or its assignments. This is the default in
the ImportAll process template.

● Keep existing page set and create new imposition: Retains
the original page set and links it to the new imposition. The
imported and existing sets must have the same number of
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positions. Selecting this option enables the check boxes in
the Page Sets Options area of the import process template.

● Keep existing page set and imposition: Retains the existing
page set and imposition. The imported and existing sets
must have the same number of positions. This is the default
in the ImportJobIncremental process template. Selecting
this option enables the check boxes in the Page Sets
Options area of the import process template.

Page Set Options

A set of check boxes that specify how to handle page
assignments in an existing page set when the new imposition is
linked to that page set. The check boxes are:

● Existing assignments replaced by new assignments:
Prinergy replaces the old page assignments with the new
page assignments in the imported file. In the
ImportIncremental process template, this check box is
selected by default.

● Existing assignments replaced by new unassignments:
Prinergy removes page assignments from pages that are not
assigned (blank) in the imported file. When this check box is
selected, the other two check boxes in Page Set Options are
automatically selected.

● Existing unassigned replaced by new assignment: Prinergy
retains existing assignments and applies any new
assignments from the imported job or populated PJTF to any
unassigned positions in the existing page set. This check box
is always selected.

The check boxes are available only if the If Page Set Already
Exists list is set to either Keep existing page set and create new
imposition or Keep existing page set and imposition .

These check boxes are especially important when you want to
manually assign pages to a page set and then link the page set
to multiple imposition plans.

Set Initial Separations After Imposition Import

In the imposition software, you may inadvertently add marks
that contain separations that are not present in the content of
the refined pages.

● Select this check box when you want Prinergy to ignore the
additional separations in the marks.

● Clear this check box when you want Prinergy to show the
additional colors in the marks.
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Important: Clear this check box if you are doing color mapping in the
imposition software. Otherwise, Prinergy may ignore your color
mapping changes.

Overwrite Existing Automated Page Assignment File

Select this check box if you want Prinergy to overwrite the
existing APA file and use the assignments specified in the job
you are importing.

Continue Job Import if CRC Error Found

Select this check box when you want Prinergy to skip any files
with CRC errors without failing the import. The names of the
files with errors are logged in the History view, so you can
correct and reimport these files into the job.

Do Auto Page Assignment After Unpopulated Imposition Import

Select this check box when you want Prinergy to perform APA
assignment and allow pages to be automatically assigned
whether they have been refined before or after an imposition
import.

Important: Do not select this check box unless you have an APA file with
the assignments that you want applied to the selected page set. Any
existing assignments are deleted if you have an empty or invalid APA file
and this check box is selected.

If you clear this check box, pages can NOT be automatically
assigned if they have been processed before an unpopulated
imposition import (or before a page set is created).

Center Pages in Imposition

(For imposition imports only)

Specify the placement of each PDF page trim box (or media
box) within its assigned imposition trim box during the job
import.

The options are:

● Honor Existing—Preserves the existing placement of each
PDF page (centered or not centered) when the job is
imported.

● Centered— Each PDF page trim box is centered within its
imposition trim box. You can then reassign pages to different
positions without worrying about the image shifts caused by
different trim box sizes on different PDF pages.

● Not Centered-Each PDF page trim box is positioned in the
lower-left corner of its imposition trim box.
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Signature ID Code

Use these settings to override the default signature ID code
syntax that is specified in Administrator.

Template—Type the code syntax. For example, %jobname<7>
%%signature<2>%

Number of sections per signatures in one imposition---Type
the total number of sections for each signature. For example, if
you import an imposition with five signatures and signatures 2
and 5 each contains two sections, enter 1,2,1,1,2.

See Overriding default signature ID codes .

Normalize for PDF Marks File section

This section does not apply when you are importing jobs or partial jobs.

Normalize for PostScript Marks Files section

This section does not apply when you are importing jobs or partial jobs.

Optimize for PostScript Marks Files section

This section does not apply when you are importing jobs or partial jobs.

Import Raw Imposition Files section

This section does not apply when you are importing jobs or partial jobs.

Import Metadata section

Select XSLT File

If you use Business Link software, you can use this panel to
import a defined XSLT file that you can use to create custom
fields automatically. After you import the XSLT file, select the
file in the Custom Fields Manager dialog box.

Instead of creating custom fields by typing information into the
Custom Fields Manager dialog box, you can select an XSLT file
and import pre defined custom fields. Currently, only JDF-type
imposition files can be imported.
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17 Archives

Archive, purge, and retrieve

About archiving, purging, and retrieving jobs

After you finish a job, archive the job files and then purge them to save
disk space. If you need the files later, you can retrieve them.

Alternatively, you can copy a job to retrieve an archived job.

The archive, purge, and retrieve process templates control archiving,
purging, and retrieving job files.

Generally, you archive and purge job files after the job is printed,
although you can archive and purge job files at any time.

The window that you use to archive, purge, and retrieve depends on the
scope you want. To affect an entire job or multiple jobs, use Job Finder.
(You can archive, purge, and retrieve up to 30 jobs at one time.) To
affect selected files in a single job, use Job Manager.

About archiving

Archiving job files saves the files to separate tapes or disks. The files
are saved in context and information about the job is retained in the
database.

You can archive at two levels:

● Archiving the whole job archives all of the files in the job folder and
any files that you added to the job that reside on another input
volume. When you later purge the job, the whole job folder is
removed from its original volume, but any input files that reside on
another input volume are not purged; they remain in their current
location.

● Archiving selected files within a job archives only those files. Files
that you added to the job from another input volume and files that
you copied to the job folder are only archived if you specifically
select those files in Job Manager.

When you archive a signature or separation, all of the files linked to
that signature or separation are also archived.

To archive, you must specify in the archive process template the media
pools or disks to which you want to archive. You should always archive



to more than one media pool or disk, so that you always have a spare
copy.

Note: You cannot perform incremental archiving. Complete archiving removes the
need for Prinergy to check each file for changes before archiving. When archiving
to tape, complete archiving removes the need to switch tapes before archiving—
for example—if changed job files are on a different tape than the original job.

About purging

Purging job files removes archived files from the volume on which you
created the job. This frees up active disk space but retains a record of
the purged files so that they can be retrieved later. You can purge job
files only if they are already archived.

When you purge a whole job, the whole job folder is removed from its
original volume, but any input files that reside on another input volume
are not purged; they remain in their current location.

When you use a purge process template, be sure to specify the same
media pools or disk volumes to which you archived the files. Prior to
purging the files, Archiver verifies that the files were successfully
archived to the specified pools or disks. If you do not specify all of the
same pools or disks to which you archived the files, Archiver will check
only that each file has been archived to one pool or disk and you may
accidentally purge job files before duplicate copies of the archive are
made.

Purging versus destroying

Destroying a job completely removes it from the system, and removes
all information about the job from the database.

Destroying is different from purging a job; job data is retained in the
database. Destroying a job removes the job folder and all of its
contents from the volume on which the job was created. (Any files that
you added to the job that reside on another input volume are not
destroyed.)

After a job is destroyed, you cannot retrieve it. Therefore, you should
destroy a job only if you will never need it again. If you think you may
need to print the job again, archive and purge it instead.

About retrieving

You can retrieve files if you need to access job files after you archive
and purge them. For example, you may want to remake a plate for the
job.

Retrieving job files restores them back to the volume on which the job
was originally created. You can retrieve job files only if they were
previously archived.
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When you retrieve a separation, all of the files linked to that separation
are also retrieved. When you retrieve a signature, all of the files linked
to that signature are also retrieved.

When you attempt to retrieve a file that is already on the volume,
Prinergy checks to see if the file to be retrieved matches the file that is
online. If the modification dates and times of the two files match, the
stored file is not retrieved unless Overwrite Existing Files is selected in
the retrieve process template.

About status and state changes after archiving, purging, and
retrieving

For information about the result of archiving, purging, or retrieving
processes, review the archive state of job files or the archive status of
the job.

Use the Visible Columns dialog box in Job Manager and Job Finder to
display archive columns.

Archive State

The archive state of the file. Possible states are:

● Online and Never Archived: The file has never been
archived, purged, or retrieved.

● Online and Currently Archived: The file has been archived,
but has not been purged or retrieved.

● Offline: The file has been purged. (It also had to be archived
before the purge, or the purging would not occur.)

● Online and Previously Archived: The file has been changed
since it was archived, and has not been archived since it was
changed.

● Missing: The file is not on the file system, and it has not
been archived. It also has not been purged because purging
deletes files only if they have been archived. Therefore, an
action other than purging deleted the file.

A job's Stale Archive Status is connected to the Archive State
of its files.

● If the Archive State of all files in a job is Online and Never
Archived or Online and Currently Archived, the job's Stale
Archive Status is None Stale.

● If the Archive State of some files is Online and Previously
Archived, the job's Stale Archive Status is Some Stale.

A file's archive status changes as follows:
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After The File's Archive State Is

Archiving Online and Currently Archived

Purging Offline, if the file is in the job folder. Purging affects
files only if they are in the job folder.

Missing if Archiver doesn't find the file and file isn't
archived.

Retrieving Online and Previously Archived

Archive Status

The quantity of files in the job that you have archived at any
time. Possible statuses are:

● None: The job has not been archived.
● Some: Some but not all files in the job were archived. This

can occur when you:

○ Archive only selected files, not the whole job
○ Archive the job, and then add one or more files to the job,

for example, by adding input or processing an input file
that had not been processed before the archive

○ Change one or more of the archived files, for example by
processing it again

● All: The job was archived and no changes have been made to
any files in the job.

A job's archive status changes as follows:

After The Job's Archive Status Is

Archiving All if the job was archived.

Some if selected files were archived.

Purging Unchanged

Retrieving Unchanged

Archiving

1. Using the Process Template Editor, set up the archive process
template.

For settings available in the process template, see Archive Process
Template.
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2. Select the jobs or files that you want to archive. Perform any of the
following actions, depending on what you want to archive:

To Do This Perform These Steps

Archive an entire job ● If you are in Job Manager, under Process Templates in the right pane, select
either the Global tab or the Job tab.

● If you are in Job Finder, select one or more jobs.

Archive only the files that
are in the job folder

a. Open the job in Job Manager. (You can't use Job Finder to work with
specific files in a job.)

b. Click the Storage view.
c. Click Group File by Kind.
d. Select View > Visible Columns, select the Location check box, and click OK.
e. Select all of the files, except the files in the Input Files group that have an

external location.

Archive specific files a. Open the job in Job Manager.

(You can't use Job Finder to work with specific files in a job.)
b. Select the files.

Archive only the files that
have changed since the
last archive

Not possible. Archive the entire job again.

Tip:

● To archive an imposition plan, select all signatures.
● To archive a page set, select the whole page set, not just individual pages.

3. Start the Archive process template by selecting Process > Storage
> Archive > Archive > ArchiveSelected.

After the process ends, you can check the archive status of the job
or the archive state of individual files. See About Status and State
Changes after Archiving, Purging, and Retrieving.

See also:
Selecting items in Job Manager on page 30
About monitoring processes in Job Manager on page 839
About status and state changes after archiving, purging, and
retrieving on page 877
Archive process template on page 879

Archive process template

This process template contains only one section, represented by the
archive icon:
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Verify Archive

Enables the system to verify that what is written to the medium
can be retrieved. To do this, the system archives the files, and
then verifies the retrievability of the files by reading them and
comparing them to the files that it archived. If the files differ,
the system fails the archive process and places an error
message in the History view of Job Manager. You should
rearchive files when the system detects an error during the
verification step.

We recommend that you enable the Verify Archive feature.

Note: When you enable this feature, the archive process takes twice as
long because the system reads back all of the files that it archived to
ensure that the files can be retrieved.

Fault Tolerance

Specifies whether the process will stop if a warning or error is
encountered. Options are:

● Continue on File Warning or Error: The process continues
even if a file warning or error is encountered.

● Continue on File Warning / Abort on first File Error: The
process continues if a file warning is encountered, but stops
if a file error is encountered. Files that have been archived/
purged before the error remain archived/purged.

● Abort on first File Warning or Error: The process stops if a
file warning or error is encountered. Files that have been
archived/purged before the warning or error remain
archived/purged.

You can view warning and error details in the History view of
Job Manager.

Archive Media Pools and Disk Volumes

Specifies the media pools or disk volumes that receive the
archived job files. If you specify multiple media pools or disk
volumes, each media pool or disk volume receives a copy of the
archived files.

Select at least two media pools or disk volumes to create
duplicate copies of your archives. With two copies, you have a
backup in case a tape is lost or a tape or disk is damaged or
destroyed.

Remember to create a purge process template with the same
media pools or disk volumes as the archive process template.
Before purging, Archiver checks that each file has been archived
to each specified media pool or disk volume. If you do not
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specify all of the media pools or disk volumes, you may purge a
job before making duplicate copies of the archive.

Available Pools and Disk Volumes

Lists the media pools and disk volumes available to archive job
files. You add media pools or disk volumes from the Available
Pools and Disk Volumes box to the Archive Media Pools and
Disk Volumes box.

Note: For the Available Pools and Disk Volumes list to display media
pools and disk volumes, the Archive/Retrieve JTP must be running. For
information about JTPs, see the System Administration guide.

Add

In the Available Pools and Disk Volumes list, select the media
pools or disk volumes to which you want to archive and then
click Add to move the selected pools or disk volumes to the
Archive Media Pools and Disk Volumes list.

Delete

Removes selected media pools or disk volumes from the
Archive Media Pools and Disk Volumes list.

Reset

Resets the list of media pools and disk volumes in the Archive
Media Pools and Disk Volumes box to the list that you last
saved.

Purging

1. Using the Process Template Editor, set up the purge process
template.

For settings available in the process template, see Purge Process
Template.

2. Perform any of the following actions, depending on what you want
to purge:

To Do This Perform These Steps

Purge an entire job ● If you are in Job Manager, under Process Templates in the right pane, select
either the Global tab or the Job tab.

● If you are in Job Finder, select one or more jobs.
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To Do This Perform These Steps

Purge only the files that
are in the job folder

a. Open the job in Job Manager.

(You can't use Job Finder to work with specific files in a job.)
b. Click Storage view.
c. Click Group by File Kind.
d. Select View > Visible Columns, select the Location check box, and click OK.
e. Select all of the files, except the files in the Input Files group that have an

external location.

Purge specific files a. Open the job in Job Manager.
b. Click Storage view.
c. Click Group by File Kind.
d. Select the files.

Tip:

● To purge anything, it must have been previously archived.
● To purge specific files, the files must be in the job folder.
● To purge an imposition plan, select all signatures.
● To purge a page set, select the whole page set, not just individual pages.

3. Start the purge process template by selecting Process > Storage >
Purge > Purge > PurgeSelected.

After the process ends, you can check the archive status of the job
or the archive state of individual files. See About Status and State
Changes after Archiving, Purging, and Retrieving.

See also:
Selecting items in Job Manager on page 30
About monitoring processes in Job Manager on page 839
About status and state changes after archiving, purging, and
retrieving on page 877
Purge process template on page 882

Purge process template

Mark Job as Completed After Successful Purge

Sets the status of purged jobs to Completed.

When a job is set to Completed, it becomes inactive. Prinergy
does not process files that you drop into the job's hot folders
and does not display the job in Prepress Portal.

When you disable this feature, the status of the job does not
change after you have purged it.
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Fault Tolerance

Specifies whether the process will stop if a warning or error is
encountered. Options are:

● Continue on File Warning or Error: The process continues
even if a file warning or error is encountered.

● Continue on File Warning / Abort on first File Error: The
process continues if a file warning is encountered, but stops
if a file error is encountered. Files that have been archived/
purged before the error remain archived/purged.

● Abort on first File Warning or Error: The process stops if a
file warning or error is encountered. Files that have been
archived/purged before the warning or error remain
archived/purged.

You can view warning and error details in the History view of
Job Manager.

Available Pools and Disk Volumes

Before Archiver purges a file, it checks that the file was
successfully archived to each of the media pools or disk
volumes listed in the Archive Media Pools and Disk Volumes
list. The Available Pools and Disk Volumes list lists the media
pools and disk volumes available to be checked. You add media
pools or disk volumes from the Available Pools and Disk
Volumes list to the Archive Media Pools and Disk Volumes list.

Archive Media Pools and Disk Volumes

Before Archiver purges a file, it checks that the file was
successfully archived to each of the media pools or disk
volumes listed in the Archive Media Pools and Disk Volumes
list. If Archiver cannot find a file in one of the specified media
pools or disk volumes, the purge will fail and it will not delete
the file from disk.

When you purge files, the media pools or disk volumes that you
specify in the Archive Media Pools and Disk Volumes list of the
purge process template should match the media pools or disk
volumes to which you archived the files (as specified in the
archive process template that you used).

If you do not specify any media pools or disk volumes, Archiver
checks only that each file has been archived to one media pool
or disk volume and you may accidentally purge a file before
duplicate copies of the archive are made.

For information about setting up media pools or disk volumes,
see the Prinergy administration documentation.
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Add

Before Archiver purges a file, it checks that the file was
successfully archived to each of the media pools or disk
volumes listed in the Archive Media Pools and Disk Volumes
list.

In the Available Media Pools and Disk Volumes list, select the
media pools or disk volumes that you want Archiver to check,
and then click Add to move the selected pools or disk volumes
to the Archive Media Pools and Disk Volumes list.

Delete

Removes selected media pools or disk volumes from the
Archive Media Pools and Disk Volumes list.

Reset

Resets the list of media pools and disk volumes in the Archive
Media Pools and Disk Volumes box to the list that you last
saved.

Retrieving

1. Using the Process Template Editor, set up the retrieve process
template.

For settings available in the process template, see Retrieve Process
Template.

2. Perform any of the following actions, depending on what you want
to retrieve:

To Do This Perform These Steps

Retrieve an entire job ● If you are in Job Manager, under Process Templates in the right pane, select
either the Global tab or the Job tab.

● If you are in Job Finder, select one or more jobs.

Retrieve only the files
that are in the job folder

a. Open the job in Job Manager.

(You can't use Job Finder to work with specific files in a job.)
b. Click Storage view.
c. Click Group by File Kind.
d. Select View > Visible Columns, select the Location check box and click OK.
e. Select all of the files except the files in the Input Files group that have an

external location.
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To Do This Perform These Steps

Retrieve specific files a. Open the job in Job Manager.

(You can't use Job Finder to work with specific files in a job.)
b. Click Storage view.
c. Click Group by File Kind.
d. Select the files.

Tip:

● To retrieve anything, it must have been previously purged.
● To retrieve specific files, the files must be in the job folder.
● To retrieve an imposition plan, select all signatures.
● To retrieve a page set, select the whole page set, not just individual pages.

3. Start the Retrieve process template by selecting Process > Storage
> Retrieve > Retrieve > RetrieveSelected.

After the process ends, you can check the archive status of the job
or the archive state of individual files. See About Status and State
Changes after Archiving, Purging, and Retrieving.

See also:
Selecting items in Job Manager on page 30
About monitoring processes in Job Manager on page 839
About status and state changes after archiving, purging, and
retrieving on page 877
Retrieve process template on page 885

Retrieve process template

Overwrite Existing Files

Overwrites files even if the archived files are older than those
being overwritten.

Available Pools and Disk Volumes

Lists the media pools or disk volumes available to be searched
during the retrieval process. You add media pools or disk
volumes from the Available Pools and Disk Volumes list to the
Archive Media Pools and Disk Volumes list.

When you retrieve archived files, the media pools or disk
volumes that you specify in the retrieve process template
should match the media pools or disk volumes to which you
archived the files (as specified in the archive process template
that you used).
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Note: For the Available Pools and Disk Volumes list to display media
pools or disk volumes, the Archive/Retrieve JTP must be running. For
information about JTPs, see the System Administration guide.

Archive Media Pools and Disk Volumes

When retrieving files, Archiver searches the media in the
archiving devices and disk volumes. If it cannot find the files, it
searches the media pools and disk volumes specified in the
Archive Media Pools and Disk Volumes list.

If you do not specify any media pools or disk volumes and
Archiver cannot find the files on any media in the archiving
devices, Archiver arbitrarily chooses a medium that contains
the file.

When you retrieve archived files, the media pools and disk
volumes that you specify in the retrieve process template
should match the media pools and disk volumes to which you
archived the files (as specified in the archive process template
that you used).

For information about setting up media pools, see the System
Administration guide.

Add

In the Available Pools and Disk Volumes list, select the media
pools or disk volumes that you want Archiver to search for files
to retrieve, and then click Add to move the selected pools or
disk volumes to the Archive Media Pools and Disk Volumes
list.

Delete

Removes selected media pools or disk volumes from the
Archive Media Pools and Disk Volumes list.

Move Up

In the Archive Media Pools and Disk Volumes list, select a
media pool or disk volume and then click Move Up to move the
medium up the list. The order in which media pools and disk
volumes are listed specifies the order in which Archiver
searches the pools for files to retrieve.

Move Down

In the Archive Media Pools and Disk Volumes list, select a
media pool or disk volume and then click Move Down to move
the medium down the list. The order in which media pools and
disk volumes are listed specifies the order in which Archiver
searches the pools and disk volumes for files to retrieve.
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Reset

Resets the list of media pools and disk volumes in the Archive
Media Pools and Disk Volumes box to the list that you last
saved.

Moving from Archive-to-tape to Archive-to-disk

Users who want to migrate away from Archive-to-tape and start to use
Archive-to-disk sometimes look for guidelines on migrating existing
archives. Kodak does not want to recommend strategies that put
excessive strain on the tape media or tape device, which could cause
lost data for critical jobs.

Therefore, the Kodak recommendation is to only retrieve the jobs that
you need, using either of the following two approaches:

● Use a Prinergy Tape Retrieval (PTR) software configuration, which
is a standalone Prinergy server that only retrieves jobs from tape.

● Retrieve jobs from tape piecemeal as you need them for reprints,
and then archive to disk when you're done.

Use a Prinergy Tape Retrieval (PTR) software
configuration

1. Retrieve jobs from tape piecemeal as you need them for reprints.

Note: For more information, see the Prinergy Tape Retrieval Software User
Guide.

2. Do a job export.

3. Import the job export on the main production Prinergy system.

4. Archive the job to disk when you've finished reprinting the job.

The drawback is that folders (such as UserDefined and so on) need
to be manually moved to the production system, and job history is not
included.

Retrieve jobs from tape as needed and then archive to disk

1. Retrieve jobs from tape piecemeal as you need them for reprints.

2. Archive the job to disk when you've finished reprinting the job.

The drawback is that this approach will be impossible in Prinergy 6,
where Windows 2008 will be required, and therefore Prinergy will no
longer support tape devices. Customers who are using this approach
by the time Prinergy 6 is available will need to either:

● Abandon any tape-based jobs that haven't yet been retrieved and
re-archived to disk, or

● Adopt Prinergy Tape Retrieval software
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Media Manager

About managing storage media

Media Manager helps you manage your archive tapes and disks. It
displays information about the removable storage media and archive
disks in your Archiver system, and enables you to:

● Verify that a tape or disk is readable using the Medium Verify menu
item

● Copy all jobs on a given tape or disk to other media, using the
Medium Logical Copy menu item, which runs the Archive Medium
Logical Copy process template

● Set a tape to read-only using the Medium Complete menu item

About Removable Storage media pools

All the tapes in the Removable Storage media pools appear in Media
Manager, not just the tapes that Archiver uses.

Note: Removable Storage is a tool in Microsoft Management Console, which is a
feature of the Windows operating system. For information about Removable
Storage, see the Windows online help.

Archiver supports the following tape formats: AIT (Advanced
Intelligent Tape) and LTO (Linear Tape-Open).

For each tape type, Removable Storage creates three default media
pools:

● Free media pools
● Import media pools
● Unrecognized media pools

Any other media pools that appear in Removable Storage are software
pools created for Media Manager or other software.

Use Archiver only with qualified devices. For information about
qualified devices, contact your sales representative.

About verifying a medium

Use the Medium Verify operation to verify that:

● A tape or disk is readable.
● A tape or disk has no errors on it.
● The format of a medium's contents is correct.

This operation can take several hours, depending on how much data is
on the medium. If there are errors on the medium, it will take longer.
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If errors are found:

● You may want to cancel the Medium Verify operation if you have
other tasks that use the drive.

● You can copy the data to another tape or disk using the Medium
Logical Copy option.

About copying a medium

Use the Medium Logical Copy operation to copy all jobs on a given
tape or disk to other tapes or disks in one or more media pools.

Copying is useful to:

● Replace a damaged disk
● Replace a lost or damaged tape
● Make a second copy of data for which only a single copy was

originally made
● Copy data from one type of media to another (for example, from an

AIT tape to disk)

This operation is called a "logical" copy because it makes another copy
of the data on the source tape or disk, but may retrieve the data from
other media and may write the data to more than one destination
media pool or disk.

How copying works

The Archive Medium Logical Copy process template controls the
destination and other aspects of the copying process. Files are copied
first to the location specified in the Temporary Location for Retrieved
Files box of the process template, and then to the destination tape or
disk.

Note: The temporary disk location for retrieved files must be on a configured file
share.

Data included

Medium Logical Copy makes one copy of all unique data on a given
tape or disk.

It does not copy:

● More than one copy of a file on the source medium
● Files that already exist in a destination pool or disk
● Files from a destroyed job
● Files that are no longer registered to a job

If Media Manager finds an error when reading the source medium, it
tries to use other copies of the file that are in your system to build a
complete new copy of the affected medium.
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Resources and time required

Copying requires temporary disk space. It will execute much more
slowly if the amount of data stored on the tape or disk is greater than:

● The available free disk space
● The disk space limit specified in the Working Disk Space to

Allocate for Retrieved Files box in the Archive Medium Logical
Copy process template

Copying tasks typically block any other Archiver tasks from executing
and can take several hours to complete for large or full media.

Note: If you cancel a copy task, you can restart it. Once restarted, it copies the
remaining portion of the data on the media pool or disk.

About completing a tape

Use the Medium Complete operation to set a tape to read-only.

This is useful when:

● You have encountered errors reading from or writing to the tape
● You have written particular archives to the tape and do not wish to

use it anymore
● The tape is almost full

Note: Media Manager automatically completes tapes when the remaining free
space drops below 2.5 percent of the native capacity.

A completed tape can no longer be used for new archive tasks,
although it is still available for retrieve tasks.

Performing a Medium Complete operation sets the state of the tape to
Complete in Removable Storage. Removable Storage Manager uses the
same icon for the Complete state as for the Disabled state: . You
can tell the difference between the two states by looking at the State
column in Removable Storage Manager or the Partition State column
in the Media Manager Media pane.

Viewing information about media pools and disk volumes

1. From the Tools menu, select Media Manager.

2. In the Pools pane, select one or more media pool or disk volume.
Information about all of the media in the selected media pools and
disk volumes appears in the Media pane. The exact information
that appears depends on the columns that are visible.

Note: Use Workshop > Media Manager to monitor the used and free space of
the disk volumes you're using. A disk volume with less than 15% free space
might have degraded system performance. Consider expanding the disk
volume or adding a new disk volume.
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Verifying that a media pool or disk volume is readable

1. From the Tools menu, select Media Manager.

2. In the Pools pane, select the media pool or disk volume in which the
desired medium resides.
All of the media in the selected media pool or disk volume appear in
the Media pane.

3. In the Media pane, select the medium that you want to verify.

4. From the Medium menu, select Medium Verify, or right-click the
medium and select Medium Verify.

Medium Verify is not available if you select a media pool that is
allocated to software other than Prinergy in Removable Storage
Manager.

The Process Info dialog box appears, displaying messages about
the status of the process. Messages also appear indicating whether
the media pool or disk volume is readable. To see these messages
later, display System History.

Copying an entire medium

1. Set up a process template for copying tapes or disks:

a. From the Tools menu, select Process Template Editor.
b. In the Process Template Editor window, expand Archive

Medium Logical Copy type, and then expand the
ArchiveMediumLogicalCopy group.

c. Double-click the MediumLogicalCopy process template to edit
it, or right-click it and select New Process Template to create a
new process template.

d. In the Archive Medium Logical Copy process template, expand
the Archive Medium Logical Copy section.

e. Define the destination pools or disks, the location for retrieved
files, and other options as desired.

Tip: The tape or disk that you are copying must be in a different pool than
the tape or disk that you are copying to.

f. Save and close the process template.

2. From the Tools menu, select Media Manager.

3. In the Pools pane, select the tape or disk that you want to copy.
All of the media in the selected media pool appear in the Media
pane.

4. In the Media pane, right-click the tape or disk that you want to copy
and select Medium Logical Copy.

Tip: You can also select the tape or disk, and select Medium Logical Copy
from the Medium menu.
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Note: The Medium Logical Copy menu item is not available if you select a
media pool that is allocated to software other than Prinergy in Removable
Storage Manager.

5. In the Choose Process Template dialog box, select the
MediumLogicalCopy process template that you created in step 1,
and click OK.

6. In the Start Process dialog box, click OK.

Copying begins as soon as the disks or tapes become available. The
Process Info dialog box appears, displaying messages about the
status of the process. To see the messages later, display System
History.

Making a tape read only

1. From the Tools menu, select Media Manager.

2. In the Pools pane, select the media pool in which the desired
medium resides.
All of the media in the selected media pool appear in the Media
pane.

3. In the Media pane, perform one of the following actions:

○ Select the medium that you want to complete. From the
Medium menu, select Medium Complete.

○ Right-click the medium and select Medium Complete.

Medium Complete is not available if you select a media pool that is
allocated to software other than Prinergy in Removable Storage
Manager.

The medium is now listed as Complete in the Partition State column of
the Media pane. To see these messages later, display System History.

Archive Medium Logical Copy process template

Available Pools and Disk Volumes

Lists the media pools and disk volumes that can be added to the
Destination Pools and Disk Volumes list or the Prompt for
Tapes From These Pools First list.

Destination Pools and Disk Volumes

Specifies the media pools and disk volumes to which copies of
the jobs will be written. You add media pools and disk volumes
to the Destination Pools and Disk Volumes list from the
Available Pools and Disk Volumes list. When you specify a
media pool or disk volume, Archiver selects one or more tapes
or disk volumes in that media pool to which to copy the data.
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We strongly recommend that you archive to two media pools or
disk volumes. Similarly, if you are copying a damaged tape or
disk volume, we recommend that you create multiple copies by
selecting more than one destination pool or disk volume.

Prompt for Tapes From These Pools First

Prinergy may be unable to access a file from a medium in a
library, for example, because the file cannot be found on the
medium or the file has a read error. In this case, Prinergy may
need to retrieve the file from an offline medium and will begin
searching other media pools for a medium that contains the
desired file. Use the Prompt for Tapes from These Pools First
list to specify the media pools that you want Prinergy to search
first.

For example, you would likely want to prompt for a medium
from an onsite pool, rather than an offsite pool. If multiple pools
are listed, Prinergy prompts for a medium from the first pool in
the list if a medium is available in the pool that contains the
desired file. If the file is not available on any medium in the first
pool, Prinergy tries to locate the file on a medium in the second
pool, and so on.

Add

In the Available Pools and Disk Volumes list, select the media
pools or disk volumes that you want to add to the Destination
Pools and Disk Volumes list or the Prompt for Tapes From
These Pools First list and then click the Add button that is next
to the desired list.

Delete

Click Delete next to the Destination Pools and Disk Volumes
list to remove the selected media pools and disk volumes from
that list.

Click Delete next to the Prompt for Tapes From These Pools
First list to remove the selected media pools from that list.

Move Up

In the Prompt for Tapes From These Pools First list, select a
media pool and then click Move Up to move the media pool up
the list. The order in which media pools are listed specifies the
order in which Archiver searches the pools for files to copy,
when the files cannot be accessed from the medium specified in
Media Manager.
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Move Down

In the Prompt for Tapes From These Pools First list, select a
media pool and then click Move Down to move the media pool
down the list. The order in which media pools are listed
specifies the order in which Archiver will search the pools for
files to copy, when the files cannot be accessed from the
medium specified in Media Manager.

Reset

Resets the list of media pools and disk volumes in the
Destination Pools and Disk Volumes list or the Prompt for
Tapes From These Pools First list to the list that you last saved.

Temporary Location for Retrieved Files

Medium Logical Copy retrieves each file to disk as it copies the
source medium. Once files are copied back to a destination
medium, the temporary disk file is deleted. Use the Temporary
Location for Retrieved Files list to specify a location where the
retrieved files will be temporarily stored.

Important: The temporary location for retrieved files must not be inside a
folder that is shared using Services For Macintosh (SFM).

Note: The temporary disk location for retrieved files must be on a
configured file share.

Working Disk Space to Allocate for Retrieved Files

Specifies the maximum amount of disk space in GB that the
system should use for temporarily storing retrieved files. The
default is 20 GB.

The more space you allocate, the more efficient the Medium
Logical Copy process will be. Allocating enough space prevents
excessive tape swapping.

Note: If you cancel and restart a copy task, recovery takes less time if
your working space allocation is smaller.

You can look in Media Manager to see how much data is on a
tape or disk volume when considering how much space to
allocate for temporary storage of retrieved files. The value in the
Used Space column is roughly the amount of space you will
need to be able to store all of the data on the tape or disk
volume.

Verify Archive

Select this option to have the system read every new archive
that the Medium Logical Copy task creates, to verify that no
hard read errors exist on the destination media.
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The purpose of this feature is to ensure that the new tape or
disk volume is readable and that the information is retrievable.
We recommend that you always enable this option.

If the verification of any new archive fails, the system fails the
process and displays an error message in the History view of
Job Manager and in System History.

Note: When you enable this option, the write phase of the Medium
Logical Copy process will take about twice as long.

Skip Remainder of Saveset After First File Read Error

Prevents Archiver from trying to copy the rest of the job after
receiving a file read error.

When this feature is enabled and Archiver encounters a file
read error, it tries to copy the job from another tape or disk
volume (if you archived the job to at least two media pools or
disk volumes). Copying the job from another tape or disk
volume will likely be much faster than trying to copy from a
tape or disk volume with errors.

If the feature is disabled, Archiver tries to copy each file in the
job. The time it takes depends largely on the number of files. If
some files are barely readable, the process can be extremely
slow.

Disable this feature only if all of the following are true:

● The first Medium Logical Copy attempt failed.
● No other copy of the job exists.
● You really need the data.

For tape archives, if you try to perform a medium logical copy
with the feature disabled, cleaning the tape drive first gives you
the best chance of reading the data.

Media Manager window

The Media Manager window consists of two panes:

Pools

Displays the media pools set up in Removable Storage Manager
in the Microsoft Management Console and any archive disks
set up by your Prinergy Administrator. When you select a pool
or disk volume in the Pools pane of Media Manager, the media
in that pool or disk volume appear in the Media pane.
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Media

Displays the media in the media pool or disk volume that is
selected in the Pools pane.

The columns in the Media Manager window, which depend on which
columns you are displaying or hiding, can include:

Columns in the Pools Pane

Name

Lists all of the media pools and disk volumes in your system.
These include the media pools that appear in the Removable
Storage Manager and any disk volumes that your Prinergy
administrator has set up.

Number of Media

The number of media in the media pool—for example, a media
pool may contain five tapes.

Media Type

The type of media in the media pool. Archiver supports the
following media types:

● AIT (Advanced Intelligent Tape) tapes
● LTO (Linear Tape-Open) tapes
● Disk (archive disk volumes)

Columns in the Media Pane

Name

The name of the physical medium. This name will be the same
as the name of the medium in Removable Storage Manager or
wiill be the name of the archive disk volume.

Location

Where the medium is located. This can be a tape library, a
stand-alone tape drive, or an offline location.

Pool

The name of the media pool to which the medium belongs.

Type

The type of media in the media pool. Archiver supports the
following media types:
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● AIT (Advanced Intelligent Tape) tapes
● LTO (Linear Tape-Open) tapes
● Disk (archive disk volumes)

Created

The date that Archiver first wrote to the medium.

Last Modified

The date and time that Archiver last wrote to the medium.

Free Space

The estimated amount of unused space in the partition.

Used Space

The sum of all the archives on this medium. The used space is
calculated based on the original size of the files on disk. The
Used Space amount can be more than the Partition Capacity if
the files have been compressed. This value does not account for
the space consumed to format the data onto tape—that is, it
will underestimate the amount of data actually on tape.

Partition Capacity

The total size of the partition (uncompressed or native).

Partition State

The logical state of the partition on the medium. Possible states
are:

● Allocated
● Available
● Complete
● Import
● New

For more information about partition and media states, see the
Prinergy System Administration guide or the Removable
Storage Manager guide.

Media State

The physical state of the medium. Possible states are:

● Idle
● In Use
● Loaded
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● Mounted
● Waiting for an Operator Request

Format

The format of the tape medium. This information comes
directly from Removable Storage Manager. Formats include:

● Creo (MTF)
● Creo (Prinergy)
● RSM Free Label
● WindowsBackup (MTF)

See also:
Displaying and hiding columns on page 1034

Menus in Media Manager

Workshop menu in Media Manager

Note: This menu is available only when running Prinergy Workshop on a
Macintosh client.

About Prinergy Workshop

Displays information about Prinergy Workshop, including the
version number, a list of licensed features, and the server name.

Preferences

Use to view and modify Prinergy Workshop preferences. When
you select this menu item, the Workshop Preferences dialog
box appears.

Note: On a Windows client, this menu item appears under the Edit menu.
On a Macintosh client, it appears under the Workshop menu.

Quit / Quit Prinergy Workshop

Quits Prinergy Workshop. Any open Prinergy Workshop
windows are closed.

Medium menu in Media Manager

Medium Verify

Verifies that the selected medium can be read, that there are no
errors on it, and that the format of the contents is correct.
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This menu item is not available when you select a medium that
is allocated to software other than Prinergy in Removable
Storage Manager.

Medium Logical Copy

Copies all jobs on the selected medium to other media in one or
more media pools. Use the operation to replace a damaged
medium or to make a second copy of data for which only a
single copy was originally made. You can also use the operation
to copy data for one media type to another (for example, from a
DLT tape to an AIT tape, or from an AIT tape to a disk volume).

If a read error is encountered on the source medium, Media
Manager attempts to use other copies of the file that are in your
system to build a complete new copy of the affected medium.

This menu item is not available when you select a medium that
is allocated to software other than Prinergy in Removable
Storage Manager.

Medium Complete

Sets the selected tape to read-only. You may want to set a tape
to read-only if:

● You have encountered errors reading from or writing to the
tape.

● You have written particular archives to the tape and do not
wish to use it anymore.

● The tape is almost full.

The tape is set to Complete in Removable Storage Manager as
well as in Media Manager.

This menu item is not available when you select a tape that is
allocated to software other than Prinergy in Removable Storage
Manager.

Close Window

Closes the current window, but does not quit Prinergy
Workshop.

Quit / Quit Prinergy Workshop

Quits Prinergy Workshop. Any open Prinergy Workshop
windows are closed.

Edit menu in Media Manager

Cut, Copy, and Paste appear on the Edit menu, but they do not apply.
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View menu in Media Manager

Refresh

Updates the contents of the current window.

Visible Columns

Use to display and hide columns in the current window or pane.
When you select this menu item, the Visible Columns dialog
box appears. From there, you select the columns that you want
to display, and clear the columns that you want to hide.

The columns that can be displayed vary from window to
window.

Tools menu in Media Manager

Change User

Displays the Connect to Server dialog box where you can log in
as another user without quitting Prinergy Workshop.

This menu item appears only if you have Kodak Prinergy
Business Link software connected to the Prinergy system.

Job Finder

Opens Job Finder.

If you are already in Job Finder, this menu item is unavailable.

Destroy History Entries

In the History view, select one or more history entries and then
use Destroy History Entries to delete the selected entries.

Process Template Editor

Launches Process Template Editor, where you can create and
modify process templates.

Automated Page Assignment Editor

Starts the Automated Page Assignment Editor, which you use
to create and check APA files.

Queue Manager

Launches Queue Manager, where you can view the Job Ticket
Processors (JTPs) and process types.
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Media Manager

Launches Media Manager, where you can manage your archive
tapes and disk volumes.

System History

Launches System History, which displays the detailed history of
all the activity occurring outside of job context (such as jobs
and groups that were created or destroyed), as well as job
archive, purge, and retrieve history.

Smart Hot Folder Manager

Launches the Smart Hot Folder Manager dialog box, where you
can add, edit and delete smart hot folders.

Configure Imposition Application

Displays the Configure Imposition Applications dialog box,
where you can identify the location of imposition software that
you want to integrate with Prinergy Workshop.

Start Imposition Application

Displays the Start Imposition Application dialog box, where you
choose which imposition software to start. You create this list
of imposition applications with the Configure Imposition
Application tool from the Tools menu. If an application requires
a license and is licensed, it appears in bold.

Color Editor

Launches Color Editor, where you can create color recipes for
all jobs.

Color Space Editor

Launches Color Space Editor, where you can create and edit
color spaces.

Font Converter

Launches Font Converter, where you can convert font files into
PFA (Printer Font ASCII) format, which Prinergy requires to
correctly process fonts.

Preflight Profile Manager

Launches Preflight Profile Manager, where you can, during the
refine process, evaluate PDFs to detect problems that may
affect processing in a publishing or prepress workflow.
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Digital Print Administration Console

Launches the Digital Print Administrator, where you can add
and configure a digital print application that Prinergy can launch
to print PDFs.

Rule Set Manager

Opens the Rule Set Manager, where you can create and edit
rule sets. The Rule Set Manager also lets you organize rule sets
into groups.

Activate Rule Set in Selected Jobs

Opens the Select Rule Set dialog box, where you can activate
rule sets for one or more jobs.

Help menu in Media Manager

Online help

Starts your Web browser and displays the Prinergy online help.

On <current window or view>

Starts your Web browser and displays the Prinergy Workshop
user guide, open to the topic for the currently selected window
or view.

Quick Start Guide

Starts Adobe Acrobat and displays a PDF file of the Prinergy
Connect Quick Start Guide

eCentral Online Support

Starts your Web browser and displays the eCentral portal at 
https://ecentral.kodak.com/.

Visit graphics.kodak.com

Starts your Web browser and displays the Kodak Web site at 
http://graphics.kodak.com/default.htm.

About Prinergy Workshop

Displays information about Prinergy Workshop, including the
version number, a list of licensed features, and the Prinergy
server name.

Note: This menu item appears on the Help menu only when you are
running Prinergy Workshop on a Windows-based client computer. On a
Macintosh client computer, the menu item About Workshop appears on
the Workshop menu.
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Keyboard shortcuts in Media Manager

Macintosh
Keyboard
Shortcut

Windows
Keyboard
Shortcut

Description

 + Q Ctrl + Q Quits Prinergy Workshop

 + R Ctrl + R Refreshes the selected view

 + W Ctrl + W Closes the Media Manager window

Cut, Copy, and Paste appear on the Edit menu, but they do not apply to
Media Manager.
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18 Automation

For rules-based automation (RBA), see the Rules-Based Automation
guide.

Hot folders

About hot folders

A hot folder is a job-specific folder that automatically performs a
process when you drop a source file in it.

Note: This topic is about job hot folders. If you want to work with smart hot folders,
see Using Smart Hot Folders.

You can create hot folders to automate the process of:

● Adding input files to a job
● Refining input files while adding them
● Importing imposition plans

You must use Prinergy Workshop to create a hot folder for a job. You
cannot create a hot folder in a file browser. After you create a hot
folder, you cannot change its name or location.

You can create a hot folder in a location that is outside of the job folder
but within the confines of the network. This is called a custom location.
Even though the hot folder is outside of the job folder, it is still
associated with the job. When you add files to a hot folder in a custom
location, the files are moved to the job folder and placed in the <Job>
\HotFolders\Processed folder. If you archive the job, any files in
the Processed folder are archived with the job.

After creating a hot folder, you can add files to it in either of these ways:

● Using a file browser to browse to it and drop files into the hot folder
● Printing files directly from other software (for example, QuarkXPress

for input files or Preps for imposition plans) to the hot folder

Hot folders are specific to each job or pre-job. You can reuse hot folders
by creating a template job as the basis for new jobs.

Some hot folder parameters can be configured using Administrator. For
example, you can set the number of files that will be processed together



when files are dropped into a hot folder. For information about
configuring hot folders, see the Prinergy System Administration guide.

See also:
About adding files to a hot folder on page 906
About hot folders functions on page 907
Reusing hot folders with a template job on page 909
Smart hot folders on page 912

About adding files to a hot folder
Note: This topic is about job hot folders. If you want to work with smart hot
folders, see Using Smart Hot Folders.

When you add files to a hot folder, the result depends on the type of
files and the type of hot folder:

● Adding input files to an add-only hot folder:

Input files appear in the Input Files pane.

If you drop a file a second time, the new file overwrites the existing
file if both files have the same name.

● Adding files to a hot folder linked to a Refine process template:

Input files appear in the Input Files pane.

Prinergy processes the input files into PDF pages, which appear in
the Pages pane.

If you drop a file a second time, the new file overwrites the existing
file if both files have the same name. The new file is processed again
if the number of pages in the old and new file are the same.

● Adding an export to a hot folder linked to a ImportAll process
template attached to a pre-job:

Prinergy creates a job with the same name as the zip file, and adds
files from the export to the job.

● Adding a partial export to a hot folder linked to a ImportIncremental
process template:

Prinergy adds the files from the partial export to the job. If the name
of an imported signature matches the name of an existing signature,
Prinergy adds an "01" suffix to the imported signature.

● Adding an imposition plan to a hot folder linked to an Import
process template:

The imposition plan appears in the Imposition Plans pane.
● Adding files to a hot folder linked to a workflow template:

The results of the import and refine processes are identical to those
listed above.
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For the output process template, the files are sent to the specified
output device.

Supported file formats

You can add the following types of files to hot folders:

● Single-file format: PostScript, EPS, PDF
● Multi-file format: DCS 1, DCS 2, TIFF/IT
● Job and imposition: JT, ZIP

Re-dropping a file into a hot folder

You can re-drop a file into a hot folder; the new file overwrites the
existing file if they have the same name. You can also successfully re-
refine the new file as long as the number of pages in the old and new
files are the same. If the number of pages differ, Prinergy stops the
refine process and reports an error.

About hot folders functions
Note: This topic is about job hot folders. If you want to work with smart hot
folders, see Using Smart Hot Folders.

You can create two types of hot folders—ones that only add files and
ones that also process files.

Add input files only

An Add input files only hot folder is used to add input files to a job
without processing them. Added files automatically appear in the Input
Files pane in Job Manager. For example, if you drop a PostScript file
into the hot folder, the file is automatically added to the job to which
the hot folder is attached.

Add and process files

This type of hot folder has a process template or workflow template
linked to it. When you drop files into the hot folder, the files are
automatically processed as specified in the process template or
workflow template.

For example, if you drop a PostScript file into a hot folder that is linked
to a refine process template, the file is automatically added to the job's
hot folder and refined. The PostScript file appears in the Input Files
pane.

Adding files to a hot folder

Requirements: Before adding files to a hot folder, you must create the
hot folder.
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Note: This topic is about job hot folders. If you want to work with smart hot
folders, see Using Smart Hot Folders.

1. Identify the location of the hot folder.

Most hot folders are inside the job folder at \Jobs\<job name>
\HotFolders\<hot folder>, but they can also use a custom
location on the network.

2. Perform any of the following actions:

● Using a file browser, drag-and-drop or copy the files from their
original location (for example, a file server) into the hot folder.

● If applicable, print the files directly from the software to the hot
folder.

Creating hot folders
Note: This topic is about job hot folders. If you want to work with smart hot
folders, see Using Smart Hot Folders.

1. Open the job or pre-job.

2. From the Job menu, select Manage Hot Folders.

3. In the Manage Hot Folders for Job dialog box, click Add.

4. In the Create Hot Folder for Job dialog box, indicate what you want
the hot folder to do by selecting either Add Input Files Only or Add
and Process Files.

5. If you are creating a hot folder to process files:

● Browse to and select the process template or workflow template
that you want to link to the hot folder.

● If you want the source files to be deleted after they are
processed, click the Delete dropped files if processing is
successful check box.

Important: Do not select this check box if you are uncertain of source file
integrity, for example, if files may be using incorrect search paths.

6. If you want a different name for the hot folder, change it in the
Name box.

7. If you want the hot folder to be located somewhere other than in
the job folder:

a. Expand the Options section and select Use Custom Location.
b. When the Select Folder dialog box appears, select the desired

location and click Select "<folder>".

8. Click OK, and then click Close.
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Deleting hot folders

Requirements:

Make sure that the hot folder is not processing files. If you delete a hot
folder that is still processing files, any unfinished processes end with an
error.

Note: This topic is about job hot folders. If you want to work with smart hot
folders, see Using Smart Hot Folders.

1. Open the job or pre-job.

2. From the Job menu, select Manage Hot Folders.

3. In the Manage Hot Folders for Job dialog box, select the hot folder
that you want to delete, and click Delete.

4. When the Confirm Hot Folder Delete dialog box appears, click OK,
and then click Close.

Editing hot folders
Note: This topic is about job hot folders. If you want to work with smart hot
folders, see Using Smart Hot Folders.

1. Open the job or pre-job.

2. From the Job menu, select Manage Hot Folders.

3. In the Manage Hot Folders for Job dialog box, select the hot folder
that you want to edit and click Edit.

4. In the Edit Hot Folder for Job dialog box, edit the options as desired.

Note: You cannot change the name or location of a hot folder once it has been
created.

5. Click OK, and then click Close.

Reusing hot folders with a template job
Note: This topic is about job hot folders. If you want to work with smart hot
folders, see Using Smart Hot Folders.

If you expect to create the same hot folders for several jobs, you can
reuse the same hot folders by creating them in a template job on which
you base new jobs.

1. Create a job with the hot folders that you expect to reuse in other
jobs.

Consider this job your template job.

2. When you create a new job, click  beside Options, and select
Template Job.

3. In the Select Template Job dialog box, select your template job.

4. Under Copy From Selected Job, select Hot Folders.
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5. Click OK, and click Create.

Disabling hot folders
Use this procedure if you want to disable a hot folder, but you do not
want to delete it in order that it may be used at a later date.

Requirements:

Make sure that the hot folder is not processing files. If you disable a hot
folder that is still processing files, any unfinished processes end with an
error.

Note: This topic is about job hot folders. If you want to work with smart hot
folders, see Using Smart Hot Folders.

1. Open the job or pre-job.

2. From the Job menu, select Manage Hot Folders.

3. In the Manage Hot Folders for Job dialog box, select the hot folder
that you want to delete, and click Disable.

If you are using Windows Explorer or Mac Finder with SMB file-sharing
protocol, the hot folder status is represented by the following icons:

Status Windows Explorer Mac Finder

Enabled hot folder

Disabled hot folder

Create/Edit Hot Folder for Job dialog box

This dialog is called Create Hot Folder for Job when you are adding a
new hot folder, and it is called Edit Hot Folder for Job when you are
changing an existing hot folder.

Add Input Files Only

Select this option to create an add-input-files-only hot folder.

Use this type of hot folder to add input files to a job without
processing them.

Add and Process Files

Select this option if you want the hot folder to process files.
When you drop files into the hot folder, the files are
automatically processed.

This type of hot folder links to process templates and workflow
templates.
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Select a template from the list

Displays the process templates, workflow templates, and rule
sets that you can link to the hot folder.

This box is available only when you select the Add and Process
Files option.

<information>

Provides information on the selected object.

Delete dropped files if processing is successful

Select this check box if you want the source files to be deleted
after they are processed.

Important: Do not select this check box if you are uncertain of source file
integrity, for example, if files may be using incorrect search paths.

Name

The name of the hot folder. The default name of a hot folder is:

● Add Input Files Only when you select the Add Input Files
Only option

● The name of the process template when you select the Add
and Process Files option and select a process template

In either case, you can modify the hot folder name if desired.

This box is available only when creating a hot folder. You
cannot change the name of an existing hot folder.

Use Custom Location

(appears only in the Create Hot Folder for Job dialog box)

Select this option to change the location of the hot folder from
the default location, which is the job folder.

When you select this option, the Select Folder dialog box
appears.

This option is available only when you are creating a hot folder.
You cannot change the location of an existing hot folder.

Change Custom Location

(appears only in the Create Hot Folder for Job dialog box)

Use this button to change the custom location of the hot folder.
When you click this button, the Select Folder dialog box
appears.
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This button is available only after you specify a custom location
using the Use Custom Location option and before the hot folder
is created. You cannot change the location of an existing hot
folder.

Manage Hot Folders for Job dialog box

list

Lists all of the hot folders for the job. Each entry includes the
hot folder name, process templates linked to the hot folder (if
any), and the hot folder location.

When you select a hot folder in the list, the Edit and Delete
buttons become available.

Add

Click this button to create a new hot folder. When you click this
button, the Create Hot Folder for Job dialog box appears.

Edit

Click this button to edit the selected hot folder. When you click
this button, the Edit Hot Folder for Job dialog box appears.

Note that this button is available only when a hot folder is
selected.

Delete

Click this button to delete the selected hot folder. When you
click this button, the Confirm Hot Folder Delete dialog box
appears.

Note that this button is available only when a hot folder is
selected.

Smart hot folders

Smart hot folders

A smart hot folder is a global hot folder that automatically performs a
wide range of processes when you drop a source file into it, including
creating new jobs and moving files.
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Smart hot folders can perform the following tasks:

● Create a new job based on a template job and name the new job
according to the name of the source file (see Diagram: create jobs
using smart hot folders on page 926)

● Move the source file to the following locations:

○ An existing job's hot folder for processing (see Diagram: process
files using smart hot folders on page 927)

○ A job-relative location (such as UserDefinedFolders)
○ Any location on a mounted server or volume (see Diagram:

move files using smart hot folders on page 926)

● Rename the source file—at the same time as moving it—for any of
the following reasons (see Diagram: rename files using smart hot
folders on page 927):

○ To change a customer's file names to conform to your file-
naming conventions

○ To conform to another smart hot folder's file naming patterns
○ To move a file to more than one job hot folder

● Move a source file to one or more locations on any mounted volume
(see Diagram: move files using smart hot folders on page 926)

You can also combine any—or all—of these actions within one smart
hot folder. For example, you can create smart hot folders that will do
the following combined actions:

● Create a job based on the source file name and process the file
immediately within the new job's hot folders (see Diagram: create
jobs and process files using smart hot folders on page 924)

● Create a job based on the source file name, process the file, and
move it to another location (see Diagram: create jobs, process, and
move files using smart hot folders on page 925)

● Create a job based on the source file name, process the file, rename
the file, and move it to another location (see Diagram: create jobs
and process, move, and rename files using smart hot
folders on page 923)

For more background, see the topic that describes the options for hot
folder types.

Smart hot folders are job-independent, so you can use them for any
job.
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Supported file formats

Smart hot folders can accept and process any of the following source
files:

● Input files (.ps, .pdf, .eps, .tif, and so on)
● Non-incremental Prinergy exported job files (.zip)
● Imposition plans (.pjtf and .jdf from Preps 4.2.3 and later) and

marks files (.ps and .pdf)
● Preps .job files
● JDF-MIS stripping parameters

Note: While you can import impositions that were created in earlier versions of
Preps, you can only edit them in Preps 6. The Preps DLL on the Prinergy server
(which is used to convert Preps jobs, JDFs, and so on to impositions) only works in
Preps 6 mode. This means that sites with Preps 5 clients must migrate these
clients to Preps 6 in order to edit Prinergy impositions. Preps version 5 and earlier
are no longer tested or supported. Preps 5 templates can be migrated by opening
and saving them in the Preps 6.2 standalone application. The Preps 6.2 application
and DLL have been modified to translate Preps 5 templates to Preps 6 mode at the
moment they're opened.

How smart hot folders work

A smart hot folder matches the source file name with the naming
patterns configured in the smart hot folder. See the topic on naming
patterns in smart hot folders.

For more information about how smart hot folders work, see the case
study about smart hot folders.

Note: Smart hot folders are not the same as job-specific hot folders. For
information about job-specific hot folders, see the topic about hot folders.

See also:
Hot folders on page 905
Examples: invalid naming patterns on page 914
About the hot folder type options on page 916
Examples: valid naming patterns on page 917
About naming patterns in smart hot folders on page 919
Case study: smart hot folder on page 921

Examples: invalid naming patterns

This topic includes examples of naming patterns that don't work and
the reasons why.

Example 1: Incorrect file naming syntax

In the following example, the source file is accepted by the smart hot
folder, but a job is not created because the back reference is incorrect.

914 Chapter 18—Automation



Dropped file names Time_200404_p1.eps

Time_200404_p2.eps

File naming patterns Source: Time_[#Date:6]_[$Page].[$Ext]

Target: TimeMagazine_[#Date:6]

The reason: You cannot include a character delimiter (for example, :6)
in the target job naming pattern.

Example 2: Incorrect file naming syntax

In the following example, the source file is accepted and a job is
created, but with the wrong name. The job name is named eps_pages
because the second [$] wild card (that is not back-referenced)
overwrites the first [$] wild card (that is not back referenced).

Dropped file names Job_2234.eps

Job2234_Covers.eps

Job2234_Inserts.eps

File naming patterns Source: [$].[$]

Target: [$]_pages

New job name or existing job
found

eps_pages

The reason: You cannot use a wild card more than once without a
named back reference. The created job is named whatever is
referenced by the last wild card.

Example 3: Insufficient back references

In the following example, a new job is created for every source file.

Dropped file names Job_1234_042004_001.ps

Job_1234_042004_002.ps

File naming patterns Source: [$].[%]

Target: [$]

The reason: The target job naming pattern is too generic; there are
insufficient back references. All source files match the [$] target job
file naming pattern.

Note: A generic source file naming pattern is valid only when moving or renaming
files, as shown in the following example.
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Dropped file names Job_1234_042004_001.ps

Job_1234_042004_002.ps

Job1234_Covers.ps

1234_042004_010.eps

File naming patterns Source: [$].[%]

Target: Not required

Example 4: Excessive back references

In the following example, a new job is created for every source file.

Dropped file names Catalog_200404_001.eps

Catalog_200404_002.eps

File naming patterns Source: [%]_[#Date:6]_[$].ps

Target: [%]_[#Date]_[$].ps

The reason: The target job naming pattern is too specific with the [$]
wild card and will match anything in the source file name.

Recommendation: Remove [$].ps in the target job name and change
the target job name to [%]_[#Date]_pages.

Example 5: Incorrect wild card

In the following example, the source files are not moved, because some
of the characters in the file name do not match the wild card.

Dropped file names Job_1234_042004.001

Job_1234_042004.p1

File naming patterns Source: [$].[%]

Target: Not required

The reason: The [%] wild card matches letters only, and there are
numbers in the file name extension.

About the hot folder type options

In the General view, under Hot Folder Type, the File Mover/Renamer
and Job Creator options control which options are enabled in the Add
Smart Hot Folder dialog box.

● If you select File Mover/Renamer, only the options required to
move and/or rename files are enabled. The options for creating jobs
and selecting a template job are disabled.

● If you select Job Creator, all options are enabled. You can create
jobs, start workflow processing, move files, and rename files.
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Job Creator option

When you select the Job Creator option, the first source file dropped
into a smart hot folder will create a job if the following two conditions
are met:

● The source file name matches the target job naming pattern.
● There is no existing job that matches the target job naming pattern.

Under these conditions, the smart hot folder names the new job
according to the target job naming pattern and processes the first
source file.

Source files that are subsequently dropped into the same smart hot
folder will be treated as follows:

● Source files that match both the source file naming pattern and the
target job naming pattern are accepted, moved to the now-existing
job, and processed.

● Files that match the source file naming pattern but not the target
job naming pattern are accepted but create new jobs (as the
existing job will not be found).

For an example of how this works, see Case study: smart hot folder.

Examples: valid naming patterns

This topic includes examples of valid source file naming and target job
naming patterns.

Example 1: Input files

Dropped file names Time_200404_p1.ps

Time_200404_p2.eps

File naming patterns Source: Time_[#Date:6]_[$Page].[$Ext]

Target: TimeMagazine_[#Date]

New job name or existing job found TimeMagazine_200404

Example 2: Input files

Dropped file names Job2234_CatPages.ps

Job2234_Covers.eps

Job2234_Inserts.ps

File naming patterns Source: [$JobID]_[$]

Target: [$JobID]_Catalog

New job name or existing job found Job2234_Catalog
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Example 3: Input files

Dropped file names XYZ_VA_YP1_0001A_V1.eps

XYZ_VA_YP2_0001A_V1.eps

File naming patterns Source: [$Customer]_[$City]_[$Section]_[$].
[%Ext]

Target: [$Customer]_[$City]_[$Section]

New job names or existing
jobs found

XYZ_VA_YP1

XYZ_VA_YP2

Example 4: Input files

Dropped file name Magazine_092004.ps

File naming patterns Source: Magazine_[#Date:6].[$]

Target: Magazine_[#Date]

New job name or existing job found Magazine_092004

Example 5: Input files

Dropped file names 1234_042004_001.ps

1234_042004_002.ps

File naming patterns Source: [$ID]_[#Date:6]_[$]

Target: Job[$ID]_[#Date]_Pages

New job name or existing job found Job1234_042004_Pages

Example 6: Exported job files

Dropped file names JobExportName.zip

File naming patterns Source: [$].zip

Target: [$]

New job name or existing job found JobExportName

Example 7: Exported job files

Dropped file names Job1234_HubExport.zip

File naming patterns Source: [$ID:7]_[$].zip

Target: [$ID]_Output

New job name or existing job found Job1234_Output
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Example 8: Imposition and Marks Files

Dropped file names MyImpositionName.pjtf

MyImpositionName.ps

File naming patterns Source: [$].[%Ext]

Target: [$]

New job name or existing job found MyImpositionName

Example 9: Preps .Job Files

Dropped file name PrepsJobName.job

File naming patterns Source: [$].job

Target: [$]

New job name or existing job
found

PrepsJobName

Example 10: JDF-MIS Stripping Parameter Files

Dropped file name JDF-MISStrippingParams.jdf

File naming patterns Source: [$].jdf

Target: [$]

New job name or existing job
found

JDF-MISStrippingParams

About naming patterns in smart hot folders

Smart hot folders use three naming patterns: source file name
(source), target job name (target job), and target file name (target
file).

● The source file name pattern determines which source files will be
accepted by a smart hot folder.

If the source file name does not match the source file name pattern,
the source file is rejected and placed in the Jobs
\SmartHotFolders\<Smart Hot Folder Name>
\Processed\Rejected folder.

● The target job name pattern determines the job name by back-
referencing the source file naming pattern.

If an existing job is not found that matches the target job name, the
smart hot folder creates a job.

Note: No target job name pattern is required for smart hot folders that only
move or rename files.

● The target file name pattern determines the name of the source file
once it has been moved.
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If the source file is moved to more than one hot folder in a job, its
file name in each of the hot folders must be different.

Note: Naming patterns are not available for target group name.

Building valid naming patterns

Each naming pattern must be constructed with valid syntax, or a smart
hot folder will not behave as expected.

The following diagram shows the components of a valid naming
pattern. These apply to all three naming patterns in a smart hot folder
(source, target job, and target file).

● Wild cards must be enclosed in square brackets.
● The following wild cards are accepted:

○ [%] to match letters (A-Z, a-z)
○ [#] to match numbers (0-9)
○ [$] to match letters or numbers (A-Z, a-z, 0-9)

● Adding a descriptor after the wild card (with no space) creates a
back reference. Choose a descriptor that clearly identifies the
information that is being referenced.

Important: You must add a descriptor to use the same wild card more than
once within a naming pattern. For example, the naming pattern [%].[%] is not
valid because it repeats the same wild card more than once. To make it valid,
add a descriptor after each wild card, such as [%Name].[%Ext].

● Adding a character delimiter (a colon and number after the
descriptor) to a wild card in the file naming patterns limits the
number of characters that are matched. For example, [$Name:6]
matches the first six letters or numbers of the source file name.

Important: Do not use a character delimiter in the target job naming pattern. A
job will not be found or created.

● Non-variable words and characters in the naming pattern must
exactly match the source file name. For example, to match the
source file naming pattern Job[#ID].[%Ext], all source files must
start with Job.
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Balancing generic and specific naming patterns

● A source file naming pattern that is very specific (contains many
back references) may cause the smart hot folder to reject many of
the source files or to create a new job for every source file dropped.

● A source file naming pattern that is very generic (contains few back
references or few wild cards) may cause the smart hot folder to
create too many jobs.

● More specific target job name patterns (many back references)
create more jobs. For example, in the following smart hot folder, a
new job is created for every source file; the target job naming
pattern is too specific and will match anything.

Dropped file names Catalog_200404_001.eps

Catalog_200404_002.eps

File naming patterns Source: [%]_[#Date:6]_[$].ps

Target job: [%]_[#Date]_[$].ps

Recommended Target job: [%]_[#Date]_pages

Case study: smart hot folder

The following case study summarizes how a smart hot folder behaves
when input files are dropped into it.

Background

Company ABC has a contract to publish magazines. Input files
submitted to the prepress department for these publications follow this
naming pattern: Publication_Date_PubPart.extension (for
example, TeenZone_040404_InCovers.eps).

The prepress operator has determined that creating a smart hot folder
to automatically create a new job and process the input files will save
time and effort.

The smart hot folder

When creating the smart hot folder, the operator considers two
factors: which input files to accept (the source file naming pattern) and
what to name the job (the target job naming pattern).

● Source File Naming Pattern: To ensure that the magazine input files
are accepted, the operator writes the following source file naming
pattern in the smart hot folder:

[%Name]_[#Date:6]_[$PubPart].[%Ext]
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According to this source file naming pattern, only input files that
include the name of the publication, a six-digit date, the publication
part, and the file extension will be accepted by the smart hot folder.

● Target Job Naming Pattern: The operator wants the job named
according to the publication name and date. The operator writes the
following target job naming pattern in the smart hot folder:

[%Name]_[#Date]
Although the input file includes the publication part and the
extension, these do not become part of the job name, and all parts
of the publication are processed in the same job
[%Name]_[#Date].

The input files

The operator is given the following three input files:

● YouthZone_040404_InCovers.eps
● YouthZone_040404_OutCovers.ps
● YouthZone_040404_Pages.pdf

What happens

The operator drops the first input file
(YouthZone_040404_InCovers.eps ) into the smart hot folder.
Since the input file name matches the source file naming pattern, the
smart hot folder accepts the input file.

The smart hot folder then searches for the job YouthZone_040404.
Because this is the first input file dropped for this edition, there is no
existing job. The smart hot folder automatically creates a new job
called YouthZone_040404 and processes the input file.

The next two input files (YouthZone_040404_OutCovers.ps
and YouthZone_0404004_Pages.pdf) match the source file
naming pattern and are accepted. The smart hot folder then searches
for—and finds—a job named YouthZone_040404. The smart hot
folder moves the input files into this job and automatically processes
them.

Dropping additional input files

The operator drops an input file named YouthZone_Insert.pdf
into the smart hot folder. Because the input file name does not match
the source file naming pattern (it is missing the date), the smart hot
folder rejects the input file and moves it to the Rejected folder.

The operator drops an input file named
YouthZone_040418_Pages.pdf into the same smart hot folder.
The input file name matches the source file naming pattern, but it does
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not match the existing job name YouthZone_040404 (the date is
different). The smart hot folder, therefore, creates a new job called
YouthZone_040418 and automatically processes the input file.

Diagram: create jobs and process, move, and rename files using
smart hot folders

Smart hot folders that create a new job and process, move, and rename
files:

1. Accept the source file
2. Create a job with the target job name from the template job
3. Save it in the same group as the template job
4. Simultaneously copy, rename, and move the source file to any of the

following locations:

● A job-relative location
● A folder on a mounted volume (including another smart hot

folder)
● Any job's hot folder
● Multiple hot folders in the new job
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Diagram: create jobs and process files using smart hot folders

Smart hot folders that create jobs and process files:

1. Accept the source file
2. Determine the target job name (based on back-references to the

source file name)
3. Create a job with the target job name from the template job
4. Save it in the same group as the template job
5. Move the source file to the new job's hot folder
6. Start processing according to the process templates attached to the

job hot folder
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Diagram: create jobs, process, and move files using smart hot
folders

Smart hot folders that create jobs and process and move files:

1. Accept the source file
2. Create a job with the target job name from the template job
3. Save it in the same group as the template job
4. Simultaneously copy and move the source file to any of the

following locations:

● The new job's hot folder (initiates processing)
● A job-relative location
● A folder on a mounted volume (including another smart hot

folder)
● An existing job's hot folder (initiates processing)
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Diagram: create jobs using smart hot folders

Smart hot folders that create jobs:

1. Accept the source file
2. Create a job with the target job name from the template job
3. Save it in the same group as the template job

Diagram: move files using smart hot folders

Smart hot folders that move files:

1. Accept the source file
2. Copy and move the source file to another location for storage,

backup, or additional processing. All moves happen at the same
time.
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Diagram: process files using smart hot folders

Smart hot folders that start processing in an existing job:

1. Accept the source file
2. Determine the target job name (based on back-references to the

source file name) and search for an existing job that matches the
target job name

3. Move the source file to the job's hot folder
4. Start processing according to the process templates attached to the

job hot folder

Diagram: rename files using smart hot folders
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Smart hot folders that rename files:

1. Accept the source file
2. Copy, rename, and move the source file. All moves happen at the

same time.

Working with smart hot folders

1. In Job Finder, from the Tools menu, select Smart Hot Folder
Manager.

2. In the Smart Hot Folder Manager dialog box:

To Do this

Add a smart hot
folder

a. Click Add.
b. In the Add Smart Hot Folder dialog box, type a

name in the Smart Hot Folder Name box and
configure the smart hot folder.

c. Click OK.

Copy a smart hot
folder

Select the hot folder that you want to copy and click
Copy.

Edit a smart hot
folder

a. Select the hot folder that you want to edit and click
Edit.

b. In the Edit Smart Hot Folder dialog box, configure
the smart hot folder.

c. Click OK.

Delete a smart hot
folder

a. Select the smart hot folder that you want to delete,
and click Delete.

b. When the Confirm Smart Hot Folder Delete dialog
box appears, click OK.

3. Click Close.

Smart Hot Folder Manager dialog box

Add

Click to add a new smart hot folder. The Add Smart Hot Folder
dialog box appears.

Edit

Click to edit the selected smart hot folder. The Edit Smart Hot
Folder dialog box appears.

Note: This button is available only when a smart hot folder is selected.
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Delete

Click to delete the selected smart hot folder. The Confirm Smart
Hot Folder Delete dialog box appears.

Note: This button is available only when a smart hot folder is selected.

Copy

Click to copy the selected smart hot folder. The new smart hot
folder is named Copy of <Smart Hot Folder> and is configured
the same as the original smart hot folder.

Note: This button is available only when a smart hot folder is selected.

Close

Click to close the Smart Hot Folder Manager.

Configuring smart hot folders

Requirements:

Do the following prerequisite tasks, depending on what you want the
smart hot folder to do.

If It will Do this

Create jobs Create a job to be used as a template job. It can be a pre-
job, existing job, or template job.

Create jobs and
process the
source file

a. Create a job as a template job. It can be a pre-job,
existing job, or template job.

b. Include hot folders (not smart hot folders) in the
template job. The hot folders must be associated with
process templates or workflow templates.

Move the source
file

Create folders for storage or other purposes.

Create the folders using Microsoft Internet Explorer or
Macintosh Finder. If the storage folders are on another
volume, mount the volume using the Prinergy
Administrator software. For more information about
mounting volumes, see the Prinergy System Administration
guide.
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1. Add or edit a smart hot folder.

2. Under Smart Hot Folder Location, select the location of the smart
hot folder:

To locate it Do this

In the Jobs
\SmartHotFolders folder

Select the Use Default Location check
box.

Outside the Jobs
\SmartHotFolders folder

Click Browse. In the Select Folder dialog
box, select a location.

3. If the smart hot folder will be used to process files or create jobs,
and you want the files to be deleted after they are processed, select
the Automatically Remove Processed Files from Smart Hot Folder
check box.

4. Under Hot Folder Type, select the smart hot folder function (see
About the Hot Folder Type Options):

To Do this

● Create jobs
● Process the source files
● Move or rename the source files

(optional)

Select Job Creator.

Move or rename the source files (not
create jobs or process files)

Select File Mover/Renamer.

5. If you chose Job Creator, under Create new jobs based on the Job
Template, click Browse.

a. In the Select Template Job dialog box, select the template job
(and any aspects that you want to copy into new jobs).

b. If the job will process files, select Hot Folders.
c. Click OK.

6. In the left pane, click Source and Target Patterns.

7. In the Source File Name Pattern box, type the naming pattern for
the source file name.
For example, type [$Name]_[#Date:6]_[$PubPart].
[%Ext].

8. If you chose Job Creator, in the Target Job Name Pattern box, type
the naming pattern for the target job.

You can type a specific job name, such as TeenZone_040404, or
a variable job name using a naming pattern that back-references
the source-file naming pattern, such as [%Name]_[#Date].

Note: If you want to locate the target job in a specific group, click Browse next
to the Target Group box and select a group. By default, jobs are located in the
same group as the template job. Note that you can't use naming patterns for
Target Group.
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9. If the smart hot folder will only create jobs (and not process, move,
or rename source files), click OK.

10. In the left pane, click File Move Rules.

11. Create one or more move rules for the source file.

Note: The text in the table is red until you finish creating a valid rule.

a. Click Add.
b. Under Source File Name Pattern, specify the pattern for the

source files name:

To Use This Do This

The same file naming pattern as the
one in the Source File Name Pattern
box in the Source and Target Pattern
view

Select Use Smart Hot Folder's
Source Pattern.

A different pattern from the one in
the Source File Name Pattern box in
the Source and Target Pattern view

In the Source File Name Pattern
box, type the file naming
pattern of the source file.

c. Under Target Filename Pattern, determine whether to rename
the source files:

To Do this

Move without
renaming

Clear the Rename files check box. The target file
naming pattern will be the same as the source file
naming pattern.

Rename and
move

Select the Rename files check box, and type the file
name of the target file in the Target Filename
Pattern box. The file name can be completely
different, or it can have a prefix or suffix.

d. Identify the destination of the file:

To move the file to Do this

A job hot folder

Note: This option is available
only if you chose Job Creator in
the General view.

a. Select Move to Job Hot Folder.
b. From the list, select a hot folder.

To the job's
UserDefinedFolders
folder

Note: This option is available
only if you chose Job Creator in
the General view.

Select Move to Job Relative Location.
When <%Job%>
\UserDefinedFolders appears in
the box, you can choose to add a
subfolder by typing a backslash and
the folder name. (Prinergy creates the
folder if it does not already exist.)

Any location on a mounted
volume

Select Move to Location, click
Browse, and indicate where to move
the file.

12. Click OK.
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Navigating the Add/Edit Smart Hot Folder dialog box

The Add/Edit Smart Hot Folder dialog box is divided into two panes:

● The left pane is the navigation pane and includes three views:
General, Source and Target Patterns, and File Move Rules.

● The right pane includes the options for each view.

You can determine which options appear in the right pane by clicking a
view in the left pane. You can also go directly to an option by clicking
the option name under the view in the left pane. For example, to go
directly to the smart hot folder name, click Name under the General
view in the left pane.

In addition, choosing the type of smart hot folder in the General view
further modifies which options you see in the right pane.

● If you choose File Mover/Renamer, only the options required to
move and rename files are available. The options for creating jobs
and selecting a template job are unavailable.

● If you choose Job Creator, all options are available. You can create
jobs and process, move, and rename files.

Add/Edit Smart Hot Folder dialog box

General

Smart Hot Folder Name

Type a meaningful name for the smart hot folder.

Smart Hot Folder Location

Determines where to save the smart hot folder. You must do
one of the following:

● Click Browse and select a volume mounted on the Prinergy
server. If the volume you want does not appear, use Prinergy
Administrator to add it.

● Select the Use Default Location check box

On installation, the default location is the Jobs
\SmartHotFolders folder on the Prinergy server.

Use Default Location

Click to select the default location in the Smart Hot Folder
Location box. On installation, the default location is the Jobs
\SmartHotFolders folder on the Prinergy server.
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Automatically Remove Processed Files from Smart Hot Folder

Select this check box if you want files to be deleted from the
smart hot folder after they are processed.

If you do not select this check box, files remain in the smart hot
folder until someone manually moves or deletes them.

This check box does not apply to smart hot folders that move
files, because the files are already moved out of the folder by
the move rule.

Hot Folder Type

File Mover/Renamer

Select to configure the smart hot folder to move and rename
files. It does not create jobs.

Job Creator

Select to configure the smart hot folder to create jobs and
process, move, and rename files.

Create a new job based on the job template

Click the Browse button and select the template job or an
existing job that you want to use as a template job.

In the Select Template Job dialog box, select a template job and
select the Hot Folder check box.

Note: The selected template job must have job hot folders that are
associated with process templates.

Source and Target Patterns

Source File Name Pattern

Using smart hot folder syntax, type the file naming pattern of
the source file. The smart hot folder will accept all files that
match this source file naming pattern.

You can make the source file naming pattern as generic or as
specific as you want. It can contain named patterns as back-
references to the target job name.

See About naming patterns in smart hot folders.

Target Group

Click Browse and navigate to the group that you want the target
jobs created in.
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The default target group is the one that holds the template job
that you selected in General view.

Note: You cannot use naming patterns in the target group.

Target Job Name Pattern

In the Source Filename Pattern box, type the file naming
pattern for the target job using back references to the source
file naming pattern.

If the smart hot folder cannot locate an existing job that
matches this target job naming pattern, it creates a new job
(based on the job template).

This box is available when Job Creator is selected in the
General view.

File Move Rules

In the File Move Rules view, specify what the smart hot folder does to
the source file (when it matches the source file naming pattern).

Each row in the table defines one smart hot folder action. These
actions are called rules. You can make any number of valid rules using
any combination of valid file names and move destinations. Because
the smart hot folder executes all rules at the same time, the order of
the rules is not important.

Source Pattern

Type the source file naming pattern or, to use the source file
naming pattern you configured in the Source and Target
Patterns view, select the Use Smart Hot Folder's Source
Pattern check box.

For a source file to be accepted by the smart hot folder, it must
match this file naming pattern.

Target Pattern

Type the target file naming pattern.

Move To

Indicate where to move the source file. The file can be moved to
the new job's hot folder, a job-relative location, or another
location (such as another job hot folder or a storage folder). The
location must be on a volume mounted on the Prinergy server.

Add

Click to add a new blank row to the table.
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Remove

Removes the currently selected row from the table.

Source File Name Pattern

Type the source file naming pattern, or select the Use Smart
Hot Folder's Source Pattern check box to use the source file
naming pattern from the Source and Target Patterns view.

Use Smart Hot Folder's Source Pattern

Select to use the source file naming pattern that you configured
in the Source and Target Patterns view.

Target File Name Pattern

Select the Rename files check box and type the target file
naming pattern.

If moving a dropped file to more than one hot folder in a new
job, add a prefix or suffix to the target file naming pattern.

Rename files

Clear to use the target file naming pattern that you configured
in the Source and Target Patterns view.

Select to rename the target file name.

If you are sending the source file to more than one hot folder in
a job, you must rename the target file name. The text in the
table remains red until you rename the target file name.

Move to Job Hot Folder

Select to move source files to the new job's hot folder. Select a
job hot folder from the list.

Only hot folders configured in the template job specified in the
General view appears in this list.

Move to Job Relative Location

Select to move files to the Jobs\UserDefinedFolders
folder. To move files to a subfolder, type a backslash and the
subfolder name.

Move to Location

Select to move files to another location. Click Browse and select
the location.

You can move files to any location on any volume that is
mounted on your server. This could be a hot folder in an existing
job, another smart hot folder, or a storage location.
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Browse

Click to select where you want to move the source file. If the
volume you want does not appear, use Prinergy Administrator
to add it.

Select Target Group dialog box

lists

The drop-down and the list work together to navigate groups.

When the drop-down displays:

● Groups on <server name>, the list displays the groups on
the specified server

● A group name, the list displays the contents of the specified
group, including jobs and groups

When you click the drop-down, you see the path of the
displayed item in reverse order. For example, if the drop-down
displays a subgroup, when you click the drop-down, you see the
name of the group that the subgroup is in, followed by Groups
on <server name>.

Open

Opens the selected item.

Select "<group name>"

Click this button when you are ready to select the group that
you want the job created in.

Checking whether the smart hot folder worked

○ Perform any of the following steps:

To determine whether Do this in Prinergy

The source file was
processed

Display the system history and click Group by
Category.

If there are errors, the system history displays
the hot folder error and the location where the
failed file was moved.

The source file was
moved to a job's hot
folder

View the job history.

The source file name
matches the source file
naming pattern

If file naming patterns do not match, the file is
moved to <Smart Hot Folder Name>
\Processed\Rejected.
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Workflow templates

About workflow templates

Workflow templates link two or three process templates together to
offer you more automation.

Each workflow template can contain up to three process templates of
the following types:

● An import process template
● A refine process template
● An output process template:

○ loose page output
○ imposition output
○ final output

You can create or modify workflow templates in the workflow template
editor, where you choose:

● Whether to enable or disable each of the three types of process
templates available.

For example, you can disable the import process template in the
import, refine, and final output workflow template.

● Which specific process template to use for each process template
type that you enabled.

For example, you can choose the 2ndRefine process template as the
Refine process template used by the Import, Refine, and Final
Output workflow template.

Prinergy offers these types of workflow templates, which are named
after the process templates they contain:

● Import, refine, and loose page output workflow template
● Import, refine, and imposition output workflow template
● Import, refine, and final output workflow template

In workflow templates with loose page output, you can output to
multiple proofing devices in parallel. For example, you can configure a
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single workflow plan to refine and output the following loose page
output at the same time:

● Loose page proof to Virtual Proofing System
● Loose page proof to one or more hard copy proofing devices
● Loose page proof to vector PDF

See also:
Refine process template on page 201
Loose Page Output process template on page 433
Imposition Output process template on page 489
Final Output process template on page 544
Import process template (jobs) on page 870
Workflow Template Editor on page 939

Using a workflow template

○ You can use a process template in the following ways:

● Select one or more files in Job Manager, start a process, and
select a workflow template instead of a process template.

● Create a hot folder, and link it to a workflow template. Using a
file browser, drop the files into the hot folder.

Creating and modifying workflow templates

1. In the Process Templates pane, expand Workflow.

2. Open the Workflow Template Editor to modify or create a workflow
template as follows:

To Do This

Modify an existing workflow
template

Double-click it.

Create a new workflow
template

Right-click any workflow template and
click New.

3. In the Type column, select the check boxes next to each type of
process template you want the workflow template to include.

4. If you selected Import, perform the following actions:

a. In the Group column, select the process template group that
contains the process template you want to use.

b. In the Process Template column, select the process template
that you want to use for the import process.

c. If you want to edit the process template, click Edit.
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5. If you selected Refine, perform the following actions:

a. In the Group column, select the process template group that
contains the process template you want to use.

b. In the Process Template column, select the process template
that you want to use for the refine process.

c. If you want to edit the process template, click Edit.

6. If you selected Loose Page Output, perform the following actions:

a. In the Group column, expand the process template group that
contains the process template you want to use.

b. Select the process template that you want to use for the loose
page output process and click Add.

c. If desired, add more Loose Page Output process templates.
d. If you want to edit a process template, select the item in the

Process Template column and click Edit.

7. Save the workflow template as follows:

To Do This

Save an existing workflow
template

From the File menu, click Save.

Save a new workflow
template

From the File menu, click Save as. In the
Save Workflow Template dialog box, save
the template.

Workflow Template Editor
Note: The window title lists the processes that are included in the workflow
template.

Type

Select a check box for each type of process templates that you
want to include in the workflow template.

Group

Select the process template group that you want for each
process template Type check box that you selected.

For loose page output, expand the group and select the required
process template. Click Add to add it to the Process Template
list. Repeat as many times as required. (Each process template
runs in parallel, so there is no need to order the loose page
output process templates.)

Process Template

Select the process template that you want in this workflow
template. The list displays the available process templates in
the group selected in the Group list.

Workflow Template Editor 939



For loose page output, you can choose multiple process
templates. In the Group list, expand the loose page output
process template group and select the required process
template. Click Add to add it to the Process Template list.
Repeat as many times as required. (Each process template runs
in parallel, so there is no need to order the process templates.)

To remove a loose page output process template from the
Process Template list, select it and click Remove.

Edit

Click this button to edit the process template selected in the
Process Template list.

Important: When you edit the settings in a process template, the changes
affect all workflow templates that reference the process template. The
workflow template contains references to the process templates, not
copies of the process templates.

Add

This button only appears in workflow templates with loose page
output process templates.

Adds the selected loose page process template to the workflow
template. Expand the Group list, select the loose page output
process template, and click Add. The process template appears
in the Process Template list.

You can add as many loose page output process templates as
you want. Each process template runs in parallel, so there is no
need to order the process templates.

Remove

This button only appears in workflow templates with loose page
output process templates.

Removes the selected loose page output process template from
the workflow template. In the Process Template list, select the
loose page output process template and click Remove.
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19 Versions

About versioning
Versioning is used in a job to provide multiple variations of a
publication. On each page that requires versioning, some content stays
the same (base content) and some content differs (version content).

For example, a publication shipped to several different countries may
contain the same content except the language (text) differs for each
country.

Prinergy has two versioning systems:

● Legacy Versioning: Use this versioning workflow for Prinergy
versioning jobs that were created using the legacy versioning system

● Layered PDF Versioning (LPV): Use this versioning workflow if you
are creating a new versioning job

Note: You cannot process Prinergy legacy versioning jobs using Layered PDF
Versioning.

Layered PDF Versioning

About Layered PDF Versioning

Layered PDF Versioning (LPV) is a versioning system that is flexible in
its input file requirements and efficient in its ability to output multiple
versions without manual workarounds. LPV is a system that extracts
content from refined pages by colorant and merges them as necessary
to output multiple versions (or editions).

LPV benefits

Prinergy LPV provides:

● Support for several different input file models and a similar workflow
for all supported input file models

● Simplified and reduced operator steps, including:

○ The ability to output plates for all versions from one process
○ A simplified plate output process that eliminates the need for
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○ A simplified output process that eliminates possible errors
caused by turning on and off separations for output

○ The ability to output proofs for all versions from one process as
well as the ability to output proofs for individual versions

○ No need to import imposition plans more than once

● Proofs that match the plates
● The ability to output proofs in which all or selected versions can be

overlaid: this allows you to merge separations across version files
● Viewing of multiple versions in a layered PDF 1.5 file in Adobe

Acrobat 6 or later
● Support for automation-different levels of automation are

supported

Introduction

Required software and licenses

In order to run the Layered PDF Versioning software, your system must
be upgraded to Prinergy 3.0.3 or later, and must include the Prinergy
Regional Versioning license.

The Prinergy Regional Versioning license enables two versioning
systems: the Prinergy legacy versioning system and the Layered PDF
Versioning system.

Layered PDF Versioning is not available on Mac OS 9 operating system
software.

Optional licenses

The following are optional licenses for the Prinergy versioning systems:

● For the Prinergy Layered PDF Versioning system:

○ To automate assignment of pages in Prinergy, you need the
license: Advanced Production Automation (APA) (part number,
22-0174).

Note: You can autolink refined pages to build versioned pages using the
same APA syntax; however, the APA license is not required.

○ To automate generation of versioned pages in Prinergy, you need
the license: Rules-Based Automation (part number,
632-00289A).

● For the Prinergy legacy versioning system, to merge separations
across version files for proofing, you need the license: Color
Proofing System (CPS) software (part number, 20-0065)

For more information about licenses, please contact your sales
representative.
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Layered PDF Versioning

Layered PDF Versioning (LPV) is a prepress versioning system that is
flexible in its input file requirements, and efficient in its ability to output
multiple versions without manual workarounds. LPV is a system that
extracts content from refined pages by color, and merges them as
necessary to output multiple versions (or editions). Content can be
extracted from pages by layer if you are using layered input files.

LPV advantages

Prinergy LPV provides:

● Support for several different input file models, including models that
support layered input files

● A similar workflow for all supported input file models
● Versioning plans that manage versions and layers
● A new type of Prinergy layer for isolating change content, and the

ability to extract change content:

○ From a refined page by color (for non-layered input files)
○ From an input file by layer (for layered input files)

● Simplified and reduced operator steps, including:

○ The ability to output plates for all versions from one process
○ A simplified plate output process that eliminates the need for

physical or digital double burns
○ A simplified output process that eliminates possible errors

caused by turning on and off separations for output
○ The ability to output proofs for all versions from one process as

well as the ability to output proofs for individual versions
○ No need to import imposition plans multiple times

● Proofs that match the plates
● The ability to output proofs in which all or selected versions can be

overlaid. This allows you to merge separations across version files.
(Proofing no longer requires Color Proofing System (CPS) to merge
separations across version files.)

● Approval of individual versions of a versioned page. In addition, the
flexibility of being able to correct unapproved versions of a page
while protecting approved version content.

● The ability to output multiple versions per surface
● Viewing of multiple versions of a page in a single layered PDF 1.5 file

in Adobe Acrobat 6 or later
● Support for automation—Different levels of automation are

supported.
● The ability to override color extraction on selected versions of

versioned pages. This essentially enables you to use a different
version plan for selected versions of a page.
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Legacy versioning vs. LPV

Prinergy Regional Versioning includes two versioning systems:

● Prinergy legacy versioning (introduced in Prinergy 2.1), which uses
layers, multiple imposition plans, and color separations to manage
and output versions

Note: For more information on Prinergy legacy regional versioning, see the
Prinergy Regional Versioning Workflow User Guide.

● Prinergy Layered PDF Versioning (LPV), the versioning solution
introduced in Prinergy 3.0.

Use the Prinergy legacy regional versioning workflow for Prinergy
versioning jobs created in Prinergy 2.1 or later. Prinergy LPV cannot
process Prinergy legacy versioning jobs. If you do not have any Prinergy
legacy versioning jobs or are creating new versioning jobs, we
recommend that you create new versioning jobs using LPV.

For more information

Visit the Kodak eCentral Internet portal for documentation, training
courses, downloads, and service and support contacts at https://
ecentral.creo.com/

LPV terms and concepts

Versioning terms

Review the following terms in order that you can fully understand the
information provided in this guide.

Version

One variation of a publication that has some content in common with
another variation of the same publication and some content that is unique.

For example, a publication that has common images, but one variation has
English text and the other has Spanish text, can be said to have an English
version and a Spanish version.

Base content

Content that is the same in (common to) all versions.

For example, if two versions of a publication have the same images, the
base content is the common images.

In a job with editions, each edition can have a different set of base content.

Change content

Content that is unique to a version.
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For example, if a publication has common images, but one variation has
English text and the other has Spanish text, the change content is the
English text and the Spanish text.

In a job with editions, change content is content that is unique to a version,
or an edition, or both.

Layer

A single thickness of a page that contains page content. Each layer of a
page has the same page specifications as other layers of that page, but
different content. A page usually consists of two or more layers.

Base layer

A layer that contains base content.

Change layer

A layer that contains change content.

ENG ESP

English version Spanish version

Base layer

Change layers

Figure 8: Versions and layers

Versioned page

A collection of refined pages that make up all versions of a single page,
including the required layers for each version.

Edition

An edition is a set of versions, which has different base content from
another set of versions of the same publication. Essentially, editions occur
when you have versions within a version. Each edition includes multiple
versions.
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ESP

ESP

ESP

W$

ESP

E$

ENG

W$

ENG

E$

Common base layer

English edition Spanish edition

Spanish East versionEnglish East version

Spanish West versionEnglish West version

Language change 
layers

Price change layers

Common base layer
Language change 

layers

Price change layers

Figure 9: Editions with versions—the English and Spanish editions each have two
versions for East and West pricing

Understanding LPV

To understand the LPV workflow, you must understand several new
Prinergy tasks:

● Creating a version plan.
● Linking refined pages to versioned pages.
● Generating versioned pages.

You must also understand how layers are related to plates.

Retail catalog scenario

To describe what happens in an LPV job, we need to consider a sample
versioning job.

Important: The following scenario is used throughout this guide.

A retailer wants to publish a catalog in two editions: English and
Spanish, and each edition has two versions based on eastern prices and
western prices. Prices do not change between languages; therefore,
only one west price layer is required and one east price layer is
required in the job. All versions use the same base images.

Version plan creation

The version plan is a table in each LPV job that you must set up to
reflect the layers required for each version. A version plan is similar to
the production plan.
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To create a version plan:

You must:

● Identify the versions required for the job.
● Identify the layers required for each version.
● Define the contents for each layer by:

○ Listing the colors to be extracted from refined pages in order to
identify the contents for each layer (if using non-layered input
files).

Note: If using layered input files, content for each version plan layer is
already defined by the content in each input file layer.

○ Specifying the final output (plate) color of each layer.

For the retail catalog scenario, you must create in the version plan:

● Four versions (EngEast, EngWest, EspEast, EspWest)
● Five layers (common for images, Eng for English text, Esp for Spanish

text, East for eastern pricing, and West for western pricing)

Pre-requisite information

● How each color relates to content layers:

Important: In order to define the contents for each layer, you must know what
colors are in each refined page, the content that the color represents, and the
final color (plate) to which the content must be mapped.

In this scenario, you must know or have already determined that:

Refined Page Color Is Used to Indicate

CMYK common content

SpotEng English text

SpotEsp Spanish text

SpotEast Eastern pricing

SpotWest Western pricing

● How each content layer relates to plates:

You must also know to which color (plate) the content must be
mapped.

In this scenario, all change content must be printed to the black
plate; and the base content must print as is: as CMYK. In this
scenario, there is only one base layer because the images are
common to all versions.

The following diagram shows the version plan for the retail catalog
scenario.
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Define the number of versions and the layers required for each version.

Note: The use of page name patterns is discussed in Chapter 5, Automating LPV Jobs.

Define the contributing layers for each version by selecting 
the required layers.

Define for each layer content:  
•  The colors to extract from the refined pages. This identifies the base and the      
    change content in the refined pages. 
 •  The mapping of each color-to-extract to the ink colors used for final output. 
 •  The page name pattern and back references if using automatic linking of refined      
    pages to versioned pages.

1

2

3

Figure 10: Version plan

See also:
Creating the version plan on page 965

Refined page linking

Linking is performed after the version plan is created. Linking
associates a refined page to the appropriate layer of a versioned page.
This is how Prinergy knows from which file to extract content for a
layer.

LPV jobs can have a mix of versioned pages and non-versioned pages.

The following table shows how refined pages must be linked to
different layers of versioned page 1 in the retail catalog scenario:
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Table 1: Linking for versioned page 1

The Refined Page Is Linked to the
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CMYK Kwp K

KwpCMYK

CMYK

CMYK

CMYK+Keng CMYK+Kwp
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Note: The refined pages in this example represent input file Model One. 
For information on input file models, see Input File Models Supported.

English 
West 
Version

Note: The refined pages in this example represent input file model 1.

Figure 11: Example of versioned page one, containing all required layers and
contributing pages for all versions of page 1
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Versioned page generation

Generation is performed after refined page linking to produce a layered
PDF file for each versioned page. You must use a generate process
template to perform this task. After you perform the generate process,
you can use an output process template to output content and view the
versioned pages in Acrobat.

Virtual versioned pages Layered PDF versioned pages

GENERATE

Figure 12: Generate process converts metadata to layered PDF files

Layers vs. plates

In Prinergy LPV, base and change content are grouped differently in the
following:

● Version plan layers—are virtual layers that are defined in the
version plan and that are associated with content after linking
refined pages

● PDF layers—are layers in a PDF 1.5 file that is created after
versioned page generation. PDF layers can be viewed in Adobe
Acrobat 6.0 or later.

● Separated output—Proofs or plates that are created after starting
an output process for final output or for separated proofs)

Using the retail catalog scenario, the following figure illustrates how
base and change content appear in version plan layers, PDF layers, and
plates.
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Version Plan Layers
(virtual layers 

for versioned page 1)

PDF Layers
(for versioned page 1)

Plates  
(separated output 

for versioned page 1)

Eng East

Eng West

Esp East

Common

One layered PDF file

RIP CYANGENERATE

MAGENTA

YELLOW

BLACK

BLACK

BLACK

BLACK

+ KeneKc

+ KeseKc

+ KeseKc

+ KeseKc

Esp West

Common

Eng East

Eng West

Esp East

Esp West

Refined pages 
linked to layers

Refined page CMYK Common

Refined page Spot East East

Refined page Spot Eng Eng

Refined page Spot Esp Esp

Refined page Spot West West

Colors to 
extract

Layer

Base and change 
content are extracted 
from refined files

Each base and change 
content is defined on a 
different version plan 
layer. You can have 
more than one change 
layer in a version.

You generate the virtual 
versioned page to create a 
layered PDF file. All 
change content for a 
version appear together on 
one PDF layer.

When a layered PDF file is 
output as separated proofs 
or output to plate, each 
version’s base and change 
content that have the 
same color are merged.

Figure 13: Content on version plan layers, PDF layers, and plates for versioned
page 1

Multiple bases

If necessary, you can use multiple bases in your job.

For example, consider the retail catalog scenario, but with different
images for the English and the Spanish editions. This would require two
bases.

Different base layer
Language change layers

Price change layers

Different base layer
Language change layers

Price change layers

Spanish edition

Spanish East version

Spanish West version

English edition

English East version

English West version

Figure 14: A job with two bases
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The version plan would be set to the following:

Figure 15: Version plan with two bases

Input file requirements

Ensure that your input files are of the supported types and comply with
one of the supported models.

Input file types supported

Prinergy LPV supports the following types of input files:

● Composite PostScript files
● Composite PDF files (layered and non-layered)
● Pre-separated PostScript files
● Separated PDF files

Prinergy LPV offers limited support for contone/line work (CT/LW)
and CEPS files.

Note: Once a PostScript input file has been added into Prinergy and refined, it
becomes a PDF page (composite, or separated).

Layered PDF input files

When possible, use layered PDF input files instead of non-layered PDF
input files for LPV jobs. Using layered PDF input files generally reduces
the number of steps involved in setting up an LPV job:

● Reducing the number of files reduces the potential errors made
during the adding and linking steps.

● When you refine layered PDF input files, Prinergy automatically
adds and defines the layers in the version plan according to the
contents of the input files.
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Layered PDF input file requirements

Layer names and content in input files should reflect how you want
them in the version plan; however, layers can be mapped to other
layers during refine.

See also:
Mapping input file layers on page 964

Input file models supported

Input files can be created in a variety of ways. LPV supports different
input file models based on how the files are created. The models can
be divided into the following categories:

● Category One—Input files of category one models:

○ Are non-layered files
○ Each contain the entire contents (base and change content) for a

version.

● Category Two—Input files of category two models:

○ Are non-layered files
○ Each contain either base or change content; not both.

● Category Three—Input files of category three models include
layered input files.

Input file models affect how you build versioned pages. After versioned
pages are generated, workflows are the same.

Conventions

This chapter explains input file models using the following conventions:

● Change content is represented as Kspot, K,or S.

○ K represents change content in a file that does not contain
content for other versions. K can be any process or spot color.

○ S represents change content in a file that also contains content
for other versions. S can be any spot color.

● [ ]n represents additional files of the same format. The number of
additional files varies by model and depends on the number of
versions required and/or the number of layers in input files.

● [Sn] represents multiple spot colors in a file.
● CcMcYcKc represents common content in single base scenarios. In

multiple base scenarios, CbMbYbKb and CcMcYcKc represent
different base content.

See also:
Working with input file models on page 1014
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Category 1

Input files of category 1 models are non-layered input files, and each
contains the entire contents (base and change content) for one or
more versions.

The following illustrations assume that you have one base.

Model 1: [Cc, Mc, Yc, Kc, S]n

For each version, provide a single input file that contains a mix of base
and change content, where the change content is defined as a spot
color.

CcMcYcKc
+S1

version 1 version 2 version 3

CcMcYcKc
+S2

CcMcYcKc
+S3

Model 2: [C, M, Y, K]n

For each version, provide a single input file that contains a mix of base
and change content, where all content is in process color. The change
content is not identified by color. However, the operator must know
which colors contain change content.

C1M1Y1K1 C2M2Y2K2

version 1 version 2 version 3

C3M3Y3K3

Model 3: [Cc, Mc, Yc, Kc + Sn]

For all versions, provide a single input file that contains base and
change content, where each version’s content is defined with a
different spot color.

CcMcYcKc
+S1S1S1

versions 1, 2, 3

Category 2

Input files of category 2 models are non-layered files, and each
contains either base or change content; not both.

The following illustrations assume that you have one base.
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Model 4: [Cc, Mc, Yc, Kc], [K]n

Provide the following files:

● One file with the base content for all editions and versions
● One file for each version, where the change content is identified

using process or spot colors

CcMcYcKc

base

K

change 1 change 2 change 3

K K

Model 5: [Cc, Mc, Yc, Kc], [Sn]

Provide two files:

● One file with the base content for all editions and versions
● One file with all change content, where the content for each version

is identified using a different spot color

CcMcYcKc

base changes 1, 2, 3

S1+S2+S3

Category 3

Input files of category 3 models include layered files.

The following illustrations assume that you have one base.

Note: When refining layered input files, multiple layers can be mapped together to
simplify the file if necessary.

Model 6: [all layers]

Provide a single layered input file in which each layer in the file
represents a layer in the version plan.

CMYK

layer 1

layer 2

baseK

K
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Model 7: [some layers]n

Provide two or more layered files in which each file contains two or
more layers. Each layer must represent a layer in the version plan and
contain either base or version content.

CMYK

layer 1

layer 2

baseK

K

layer 4

layer 5

layer 6K

K

K

Model 8: [1 base layer+ 1 version layer], [1 layer]n

Provide two or more layered files:

● One file containing two or more layers: one layer with base content
and other layers with version content

● One or more files each containing content for only one layer (base
or version content).

CMYK

layer 1 layer 2

baseK K

layer 3

K

Models with two bases

If you require two bases in your job, simply allow for another set of files
in each model. For example:
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CbMbYbKb+
S1Model 1

version 1 version 2 version 3

CbMbYbKb+
S2

CbMbYbKb+
S3

CbMbYbKb
+S1+S2+S3

CcMcYcKc+
S4+S5+S6

C1M1Y1K1 C2M2Y2K2Model 2

version 1 version 2 version 3

CcMcYcKc+
S4

version 4 version 5 version 6

CcMcYcKc+
S5

CcMcYcKc+
S6

C3M3Y3K3

Model 3

versions 1, 2, 3 versions 4, 5, 6

CbMbYbKb KModel 4

base b change 1

K

change 2

K

change 3

CbMbYbKb K

base c change 4

K

change 5

K

change 6

CbMbYbKb S1+S2+S3Model 5

base b base c

CcMcYcKc S4+S5+S6

changes 1, 2, 3 changes 4, 5, 6
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CMYK

CMYK

layer 1

Model 6

layer 2

base 1

base 2

K

K

CMYK
Model 8

layer 1

base 1 CMYK

base 2

K

layer 3

K

CMYK

layer 1

Model 7
layer 2

base 1K

K

CMYK

layer 3

layer 4

base 2K

K Note: Each input file 
can contain more 
than one base.

Setting up an LPV job

Introduction

This chapter describes the core tasks required to set up all Layered
PDF Versioning (LPV) jobs, and provides requirements and limitations
information. Please read this chapter before reading subsequent
chapters.

Tip: The procedures in this guide describe how to perform tasks using the menu
bar. However, you can also quickly access many menu items using the context
menu by right-clicking inside the Workshop window.

Overview of core tasks

To set up and output Prinergy LPV publications, perform the following
tasks:

1. Create an LPV job.
2. Add and refine input files.
3. Create the version plan.
4. Add versioned pages.
5. Link refined pages.
6. Generate versioned pages.
7. Assign versioned pages to a page set or imposition plan.
8. Output proofs and final output.
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The following figure is a graphic representation of the core LPV tasks.

Illustrated overview of core tasks

1 Create an LPV job. 5 Link for refined pages.

6 Generate versioned pages.

3 Create the version plan.

4 Add versioned pages.

Note: The thumbnails represent 
dialog boxesthat are new or 
updated for LPV tasks.

2 Add and refine input files.

7 Add and refine input files.

8 Add and refine input files.

Figure 16: Illustrated overview of core tasks
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Creating an LPV job

1. Perform the following as appropriate:

To Do this

Create a job In Job Finder, in the Jobs view,
select File > New Job.

Create a pre-job In Job Finder, in the Pre-jobs view,
select File > New Pre-job.

2. In the Create New Job dialog box, navigate to the group in which
you want to create a new versioning job.

3. In the Create new Job as box, type the name of the versioning job.

4. Click the triangle beside the Options heading to expand the
options.

5. In the Options section, select the Job Attributes check box.

6. In the Set Job Attributes dialog box, select the Layered PDF
Versioning Job radio button, and then click OK.

7. In the Create New Job dialog box, select other options as required,
and then click Create.

The Job Manager appears as in the following figure.

new views new menu new process template

Note: The Import 
Versioning 
Imposition option 
in the File menu 
is disabled, 
because it 
applies only to 
legacy 
versioning jobs.

Figure 17: New UI elements in LPV jobs
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Creating an LPV job from a template job

Create an LPV job from a template job when you have already
produced a very similar job, for example, if you are producing a
versioned weekly flyer. This enables you to reuse version plans.

● Supported template job types:

○ When creating an LPV job from a template job, you can use
either a non-versioning job or an LPV job as the template.

Note: You cannot use a legacy versioning job as the template.

● LPV job attributes in the template:

If the template job is an LPV job, you can use LPV job attributes
from a template job.

The new job can adopt the entire versioning plan from the template
job. The LPV job attributes are all elements that are viewable from
the Version Plan view, including the:

○ Versions and layers
○ Colors to extract (from the refined page)
○ Plate mapping
○ Page name patterns

Attention Elements in the Versioned Pages view are not adopted in the template
job.

1. Perform the following as appropriate:

To Do this

Create a job In the Job Finder, in the Jobs view,
from the File menu, select New
Job.

Create a pre-job In the Job Finder, in the Pre-jobs
view, from the File menu, select
New Pre-job.

2. In the Create New Job dialog box, navigate to the group in which
you want to create a new versioning job.

3. In the Create new Job as box, type the name of the versioning job.

4. Click the triangle beside the Options heading to expand the
options.

5. In the Options section, select the Template Job check box.

6. In the Select Template Job dialog box, ensure the Layered PDF
Versioning (LPV) Version Plan check box is selected.

7. Navigate to the job you want to use as the template, and click OK.
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8. In the Create New Job dialog box, select other options as required,
and then click Create.

Creating an LPV job using a smart hot folder

You can set up a smart hot folder to automatically create LPV jobs.
This enables you to drag and drop input files into a smart hot folder (in
your file management software), and if the input file names match the
name of the source file name pattern, the smart hot folder
automatically:

1. Creates a job with the target job name from the template job, and
saves it in the same group as the template job

2. Adds the input files to the job

For more information about smart hot folders, see the Prinergy
Workshop online help.

Switching between job types

You cannot switch LPV jobs to regular or to legacy versioning jobs. For
example, you must recreate the entire job if you want to switch your
LPV job to a regular job.

LPV job Regular job

You can switch jobs from:

● Regular to LPV or to legacy versioning
● Legacy to a regular or to LPV

1. In Job Finder, select the job that you want to change.

2. From the Edit menu, select Edit Job Attributes.

3. In the Edit Job Attributes dialog box, perform the following as
appropriate:

If you want to switch Then

Regular job to LPV job ● In the Edit Job Attributes dialog
box, select the Layered PDF
Versioning (LPV) Job option or
the Legacy Versioning Job
option.

LPV job to Regular job a. ClickEdit > Edit Job Attributes.
b. In the Max Layers box, type 1,

replacing the existing number,
and click OK.
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Adding and refining input files

Add input files to Prinergy in order that Prinergy can access the
source content. Refine the files to prepare pages for LPV job use,
and to determine what colors are in the input files.

For general information on how to add and refine input pages, see
Processing Input Files in the Prinergy Workshop online help.

LPV requirements for refined pages

Refined pages must have spot color naming differences resolved.

Tip: The only colors that should be in refined pages are those that will be mapped
in the version plan to an output color.

File name best practices

For each refined page, use file names that identify the associated page
position or folio number, and the associated layer. This helps make the
linking task faster and easier.

Trim box best practices

All refined pages for a versioned page should have the same geometry
settings, such as the trim box settings.

If you have differences between the trim box sizes (of the refined
pages of one versioned page), you can remove these differences by
editing the geometry on the pages, and refining a second time. If you
do not remove the differences, you will receive a warning in the
Generate process information.

For information on modifying your trim box settings, see the Prinergy
Workshop online help.

Alternate workflow

If you do not have the input files ready, but you know what colors will
be in the files, and to what inks the layer colors are to be mapped on
output, you can perform the next task (creating the version plan)
before you add and refine the input pages.

Adding and refining layered input files

If you are using layered PDF input files:

● Ensure that you set the PDF 1.4-1.6 (Acrobat 5-7) box in the
Normalize section of the refine process template to Leave as is.
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Layered input files should be trapped at the time of generating
instead of refining.

● Version layers and colors are automatically determined and
populated in the version plan. In order to have the correct layers and
colors populated:

○ Ensure that the colors in the refined files are the correct
separation colors to be used in final output.

○ Map input layers to other layers using the PDF Layer Selection
button on the Start Process dialog box.

○ Ensure that versioned pages are not used as input files. Pages
that were previously refined as versioned pages are not yet
supported as input files.

Tip: You can determine the layers in a refined PDF by selecting the refined PDF in
the Pages view, and clicking File > Get Info. You can also go to the View menu and
select Visible Columns to obtain the same information.

Mapping input file layers

You can map layers from one layer to another. However, you will want
to map all input layers to a version plan layer.

For example, if a layer was spelled correctly in the first layered input
file, but spelled incorrectly in a second input file, you could map the
incorrectly spelled layer to the correct one.

This icon indicates 
that this layer 
already exists in the 
version plan.

Figure 18: PDF Layer Selection dialog box: mapping input layers

Another reason to map input file layers is if the input file contains
multiple layers that contain base content. During refine, you can map
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all base content layers to the base version layer to simplify the input
files.

1. Start a refine process on a layered input file.

2. In the Start Process dialog box, click PDF Layer Selection.

3. In the PDF Layer Selection dialog box, click the layer that you want
to map, and in the Map selected layer to box, select the target
layer.

Note: When you rerefine input files or refined files, remapping input layers
does not remove any unwanted layers from the version plan. You must
remove any layers from a version plan manually. In addition, any colors that
were mapped or converted to process during a rerefine may still appear in the
Colors to Extract column of the version plan. If you need to make any changes,
they must be done manually.

Creating the version plan

You must create a version plan to configure versions, layers, and color
mappings. This task is critical to publishing the correct content in each
version.

Two version plan creation methods

You can create a version plan in two ways, using:

● Version Plan Quick Builder—is fast and easy to use, but assumes
that:

○ You want to give the layers the same name as the versions
○ You want only one change layer for each version.
○ You want all bases to have CMYK extracted, and to be output

separately.
○ You want all layers to have black extracted, and to be output as

black.

If any of these assumptions are not true for your job, you can modify
the version plan accordingly using manual procedures.

● Manual procedures—allows you to control all aspects of the
version plan, such as removing layers, adding change layers, and
editing layer and version names.

If you are using non-layered input files, we recommend that you create
a version plan using the Version Plan Quick Builder, and then modify it
accordingly with manual procedures.

If you are using layered input files and each version corresponds
directly to a layer, we recommend that you use the Version Plan Quick
Builder to complete the version plan. Otherwise, complete the version
plan manually.
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Tip: The procedures in this guide describe how to perform tasks using the menu
bar. However, you can also quickly perform many tasks using the context menu by
right-clicking inside the Workshop window.

Exception pages to the version plan

If you have a job in which there are some pages that cannot use the
same color extractions as the rest of the job, you can use a color
extraction override to output those pages within the same versioning
job.

For example, consider a job in which the bulk of the pages requires only
a black plate change between versions, but one signature of one
version requires a four-color change. You can set up those pages for a
4-color change within the same job—essentially using a different
version plan for those pages.

See also:
Version plan creation on page 946

Requirements for version plans

● You can have only one version plan per LPV job, and only one job
can be associated with a version plan. (When using template jobs, a
copy of the version plan is created.)

● Every version plan must have at least one base layer; however, the
base layer for a versioned page can be empty, which means that
each version of that page is unique.

● If you are using non-layered input files, you must know what colors
are in each refined page, the content that the color represents, and
the final color (plate) to which the content must be mapped.

Note: If some colors in a refined page are not assigned to a layer in the version
plan, these unassigned colors will be placed on an error layer in Acrobat for the
versioned page after it has been generated.

If you are using layered input files, colors are automatically determined
and populated in the version plan. Ensure that the colors in the refined
files are the correct separation colors to be used.

Version name best practices

The length of each version name is limited to 64 characters. However,
we strongly recommend that the length of version names be
minimized, especially if you are using Apple Filing Protocol (AFP).

Version name best practices for AFP

If you are using AFP, and you plan to output proofs to file, the version
name is only one of several components that make up the output file
name. This means that the output file name can very easily exceed 31
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characters. We recommend that version names be as short as possible,
especially if you have many versions in your job. .

Creating a version plan using Quick Builder

Use the Version Plan Quick Builder to help you quickly set up versions
and layers. Use the Tab key to quickly access successive boxes in the
Version Plan Quick Builder.

1. In Job Manager, click the Version Plan view.

2. In the Version Plan view, from the Versioning menu, select Version
Plan Quick Builder.

3. In the Version Plan Quick Builder dialog box, click Replace existing
Version Plan.

4. In the Base Layer box, type the name of the base layer.

5. In the Number of Versions box, type the number of versions that
require the base layer that you named in the previous step.

6. In the Version Names box, type a version name. Repeat to name
the remaining versions, and click Create Versions.

7. Perform the following as appropriate:

If your job requires Then

Only one base Click Close. Go to step 8.

More than one base Click Add to Version Plan, and
repeat steps 4 to 6 for each
additional base, and then click
Close. Then, go to step 8.

8. If any assumptions that the Version Plan Quick Builder makes is
wrong, in particular, the one change layer assumption, modify the
version plan using manual procedures.

Modifying the version plan

1. To add versions

2. To add and define layers:

3. To copy a layer

4. To add change layer columns

5. To apply layers to versions
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To add versions

1. In Job Manager, click the Version Plan view.

2. In the Version Plan view, click in the Versions (top) section to
make it active, and then from the Versioning menu, select Add
Version.

Tip: You can also right-click the Versions pane to open the context menu,
which allows you to add versions.

3. Double-click in the new version row under the Version column to
type the name of the version.

4. Repeat this procedure for each additional version you want to add.

To add and define layers:

1. In the Version Plan view, click in the Layer (bottom) section, and
then from the Versioning menu, select Add Layer.

Tip: You can also right-click the Versions section to open the context menu,
which allows you to add layers.

2. Double-click in the new layer under the Layer column to type the
name of the layer. The layer name is limited to 64 characters.

3. Under the Layer Type column, select either Base or Change to
define the layer type.

4. Under the Colors To Extract column, select the cell to open the
Select Colors To Extract dialog box.

5. In the Select Colors To Extract dialog box, select the colors that are
representing the content for this layer.

Alternate workflow: If you are building the version plan before your
input files are refined, you can add color names to the list by
clicking the Add button, and completing the Add New Colorant
dialog box.

Important: The color name in the refined pages must match the color name
specified in the Colors to extract column. Color names are case-sensitive.

6. Under the Output Plate column, select the ink in which the layer
content should print.

Select Output Separately if you do not want the colors to be
mapped, for example, when a base layer requires CMYK to be
extracted, or when you want to output content to a unique
separation.

Note: You cannot extract more than one color to the same separation on one
version plan layer.

7. If you want to use automatic linking, see the next chapter for
information on the Page Name Patterns, Page Name Back
Reference, and Page Number Back Reference boxes.

8. Repeat this procedure for the remaining layers.
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To copy a layer

In the Version Plan view, click in the layer that you want to copy,
and then from the Versioning menu, select Duplicate Layer.

Tip: You can also right-click the layer to open the context menu, which allows
you to duplicate layers.

To add change layer columns

From the Versioning menu, select Add Change Layer.

If you require more than one change layer column, repeat for each
additional change layer column required. For example, if each
version is made up of two change layers and a base layer, you need
to add two change layer columns to the version plan.

To apply layers to versions

1. In the Version Plan view, in the Versions section, on a version row
and under the Base Layer column, select the base layer for the
version from the list.

Note: Only layers that you have defined as a base layer appear in the list.

2. In column Change Layer 1, select the required change layer for each
version.

3. If required, select additional change layers for each version in
columns Change Layer 2, Change Layer 3, and so on.

Deleting versions and layers

You can delete a version at any time. However, before you can delete a
layer, you must disassociate the layer from all versions and unlink all
refined pages from that layer.

1. In the Version Plan view, select the version or layer that you want
to delete.

2. From the Versioning menu, select Delete Version or Delete Layer
as appropriate.

Extracting two colors to one separation on one version plan layer

When you are extracting more than one color, the system does not
allow you to output two colors to the same separation using one
change layer. You must output the colors separately if using one
change layer.

For example, you cannot extract black and spot red to the black
separation using the same version plan layer. If you extract two colors
on one version plan layer, Prinergy automatically sets the output to
Output Separately. For example:
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Layer Colors To Extract Output Plate

English Black, SpotRed Output Separately

Espanol Black Black

To work around this restriction, create another layer for the second
color in the English layer. For example:

Layer Colors To Extract Output Plate

EnglishBlack Black Black

EnglishSpotRed SpotRed Black

Espanol Black Black

Adding versioned pages

Important: In the procedure,Linking refined pages, you can also create versioned
pages if using the Link to Layers dialog box.

Note: If using automatic linking, you can define the versioned page name prefix
using a back reference.

1. In the Versioned Pages view, on the Link tab, from the Versioning
menu, select Add Versioned Pages.

2. In the Add Versioned Pages dialog box, in the Prefix box, type the
prefix for the versioned pages if you want to define a prefix.

Note: All versioned page names are composed of a prefix and a number, which
are separated by an underscore (_).

Do not type the underscore. Prinergy automatically adds the
underscore character between the prefix and the body of the file
name.

Tip: Use a prefix which sorts versioned pages to the top of the Pages pane of
the Pages view, for example, 1VP, in order to make versioned pages easily
accessible during a subsequent task.

WARNING: If you use more than one prefix for your versioned pages, only
link, at one time, versioned pages of one prefix.

3. In the Add Versioned Pages dialog box, in the Range box, type the
range of versioned pages that you want to add.
For example, 1-5, 9, 15-20.

Linking refined pages

Link the refined pages to versioned pages in order specify the content
file for each layer of each versioned page. Linking is performed on the
Link tab of the Versioned Pages view.

Note: You must first add versioned pages before you can link refined pages
manually.
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The linking task can be performed in a variety of ways. This section
describes the different ways you can perform the subtasks:

● Selecting refined pages.
● Linking refined pages to the linking table.

Selecting refined pages

Select refined pages in the list of refined pages (left-hand pane) of the
Versioned Pages view.

To select Then

A continuous range Click the first page you want to link,
and then press Shift and click the last
page you want to link.

A noncontiguous range Press Ctrl on your Windows computer
(or Cmd on your Macintosh
computer) and click the pages you
want to link.

Filtering tools
Selection status bar

List of refined pages

Linking table

Figure 19: Versioned Pages view

Selection status bar

Use the selection status bar to quickly see the number of total refined
pages in the job, the number of pages that match the criteria set in the
filtering tools (see below), and the number of currently selected pages.

Selecting refined pages 971



Filtering the refined pages

Because you can link multiple pages (pages for a row or column) at one
time, use the filtering tools to reduce the number of pages in the list
and to help you quickly select the appropriate pages.

The image above identifies the filtering tools, which are the:

● Search box
● Unlinked Only check box

Search box

Use the Search box to show only those pages that have matching
characters in their names. Because the filter is based on the refine page
file names, you should have given refined files names that identify the
associated page number and layer.

Type the common portion of the file name in the Search box, for
example, p1 or common. Once you filter for a layer or for a versioned
page, click Edit > Select All to select them for linking.

For example, if all of your refined pages for the English layer are named
with the letters Eng, then you can type Eng in the Search box, to see
only those refined pages in the list.

Unlinked only check box

Use the Unlinked Only check box to display those refined pages that
are not yet linked to a versioned page.

Linking refined pages to the linking table

This section illustrates the different parts of the linking table, and
describes the different ways of linking:

Linking table

On the Link tab of the Versioned Pages view, linking of refined pages
to layers and versioned pages is represented in a table. Each layer is a
column in the linking table, and each versioned page is a row in the
linking table.

The following figure shows the parts of the table:
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Versioned Page

Row label

VP_1.pdf

VP_2.pdf

VP_3.pdf

VP_4.pdf

Eng Esp East West

Row Column label Column Cell

Figure 20: Parts of the linking table

When this guide refers to parts of the table, it is helpful to keep in mind
that:

● Row = versioned page
● Column = layer
● Cell = one layer of a versioned page

Drag-and-drop

You can drag the selected refined pages and drop them in the
appropriate cells on the Versioned Pages tab. You can drop pages into:

● A cell—Drag one refined page to one cell.
● A column or a row—A continuous range of cells. To drop into a row,

press the Ctrl key on a Windows computer (or Cmd on your
Macintosh computer) while dropping.

Note: If you drag a set of pages to an area that is too small to hold all of the
selected pages, the extra pages are not linked.

● A column label—Opens the Link to Layer dialog box, allowing you to
select a noncontiguous range of cells within a column.

● A row label—Opens the Link to Versioned Pages dialog box,
allowing you to select a noncontiguous range of cells within a row.

Dropping onto row labels or column labels

Dragging-and-dropping onto a row or column label opens a dialog box,
which allows you to link pages to a noncontiguous range and allows
you to correctly drop pages into columns that have not been sorted
alphabetically.

For example, if your layer columns are not in alphabetical order, refined
pages that must be linked to different layers of a versioned page
cannot be linked correctly using drag-and-drop because the pages are
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placed in alphabetical order. See the following table for an example of
incorrect results when pages are dropped into a row.

Versioned Page EspWest EngEast EspEast

EngEast.p1.pdf VP_1.pdf EngEast.p1.pdf EspEast.p1.pdf EspWest.p1.pdf

EngEast.p2.pdf VP_2.pdf

EngEast.p3.pdf VP_3.pdf

EspEast.p1.pdf

EspEast.p2.pdf

EspEast.p3.pdf

EspWest.p1.pdf

EspWest.p2.pdf

EspWest.p3.pdf

Context menus

Instead of using drag-and-drop, you can use context menus, which are
accessed by right-clicking in specific areas of the window. After
selecting one or more refined pages, open a context menu by right-
clicking in:

● A cell—With one page selected, allows you to Link (to a cell). With
more than one page selected, allows you to Link Right (to a row), or
Link Down (to a column).

● A column label—Allows you to Link to <column>, and opens the
Link to Layer dialog box.

● A row label—Allows you to Link to <versioned page>, and opens
the Link to Versioned Page dialog box. See the Link pages dialog box
section below.

● A refined page—Allows you to Link... (to a column or a row), and
opens the Link Pages dialog box.

Versioning menu

After selecting one or more refined pages, instead of dragging-and-
dropping or using context menus, you can use the Versioning menu,
which is located on the menu bar.

Link pages dialog box

When using the Versioning menu to link, the Link Pages dialog box
appears. In the Link Pages dialog box, you must choose to link selected
pages to one of the following:

● One or more layers of a versioned page—linking to a row
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Versioned Page Layer Layer Layer

VP_1

VP_2

VP_3

VP_4

● The same layer of one or more versioned pages—linking to a
column

Versioned Page Layer Layer Layer

VP_1

VP_2

VP_3

VP_4

Linking refined pages using the Versioning menu or the Context menu

1. On the Link tab of the Versioned Pages view, select refined pages
in left-hand pane.

2. Select Link either in the Versioning menu or in the context menu.
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3. In the Link Pages dialog box, perform the following as appropriate:

If you want to Then, click the

Link to a row

(Linking from one versioned page to
many layers)

One versioned page button, click
the versioned page to which to link
the pages, and then click Link.

The Link to Versioned Page dialog
box appears.

a. In the Link to Versioned Page
dialog box, in the left table,
select a refined page, and click
the arrow button  beside the
layers to which it must be
associated.

Tip: If you select the wrong
arrow button, select the back
button  to unlink the refined
page.

b. Repeat for the remaining
refined pages required for the
selected versioned page.

Link to a column

(Linking many versioned pages to
one layer)

One or more layers button, click
the layer to which to link the
pages, and then click Link.

a. The Link to Layer dialog box
appears. In the Link to Layer
dialog box, in the Range box,
type the range of versioned
pages to which you want to link
the refined pages.

b. If you want to link also to other
layers, click the Also link to
check box, and select the layers
from the list.

c. Click Link.

The refined pages appear in the
table of linked pages.

Link to all columns One versioned page button, and
then Select All. Click OK.

The Link to Layer dialog box
appears.

a. The Link to Layer dialog box
appears. In the Link to Layer
dialog box, in the Range box,
type the range of versioned
pages to which you want to link
the refined pages.
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If you want to Then, click the

(Applicable to model 3; link to all
layers of more than one versioned
page)

b. If you want to link also to other
layers, click the Also link to
check box, and select the layers
from the list.

c. Click Link.

Note: If you have finished linking all
the refined pages, your next step is
generating.

Linking refined pages by dragging

1. On the Link tab of the Versioned Pages view, select refined pages
in left-hand pane.

2. Perform the following as appropriate:

If you want to Drag to

Link one refined page A cell

A continuous range of versioned
pages

A column (a layer)

An alphabetically ordered range of
layers

A row (a versioned page)

A noncontiguous range of versioned
pages

A column label.

Opens the link to the Layer dialog
box

A noncontiguous range of layers A row label.

Opens the Link to versioned pages
dialog box

Range box in the Link to Layers dialog box

When using the Link to Layers dialog box, note that you can use the
Range box to link:

● Each contributing page to a single versioned page—specifying
each versioned page

For example: 1, 3, 6

This links the first selected contributing page to versioned page 1,
the second selected contributing page to versioned page 3, and the
third selected contributing page to versioned page 6.

● Each contributing page to a single versioned page—identifying the
versioned pages as a range

For example 1-3, 6

This links the first selected contributing page to versioned page 1,
the second selected contributing page to versioned page 2, the third
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selected contributing page to versioned page 3, and the fourth
selected contributing page to versioned page 6.

Note: This syntax does not create versioned pages. For example, if versioned
page 2 does not exist, it is not created. If versioned page 2 does not exist, then,
the example would link the first contributing page to versioned page 1, the
second contributing page to versioned page 3, and the third contributing page
to versioned page 6.

● Each contributing page to multiple versioned pages—using
parentheses

For example (1,3), 6

This links the first contributing page to versioned pages 1 and 3; and
links the second contributing page to versioned page 6.

For example (1-3), 6

This links the first contributing page to versioned pages 1, 2, and 3;
and links the second contributing page to versioned page 6.

Unlinking refined pages

1. On the Link tab of the Versioned Pages view, in the right-hand
table, select the refined pages that you want to unlink.

Note: To select a non-contiguous range, hold down the ctrl key while selecting
the refined pages.

2. From the Versioning menu, select Unlink.

Tip: You can also right-click to open the context menu, which allows you to
unlink refined pages.

Viewing associated contributing pages and versioned pages

1. To view a list of the contributing pages to a versioned page

a. Select the versioned page in the Pages pane of the Pages view.
b. Click File > Get Info.

In the Get Info dialog box, the Linked Pages heading is followed by
a list of contributing pages.

2. To view a list of the versioned pages using a contributing page

a. Select the contributing page in the Pages pane of the Pages
view.

b. Click File > Get Info.

In the Get Info dialog box, the Linked To Versioned Pages heading
is followed by a list of versioned pages.
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Overriding color extractions

If you have a job in which there are some pages that cannot use the
same color extractions as the rest of the job, you can set a color
extraction override for those pages.

Use multiple bases when all versioned pages require two different
bases. When only some versioned pages require a different base, use
color extraction override.

Note: If you set a color extraction override to a generated versioned page, you
must re-generate.

1. In the Versioned Pages view, on the Link tab, select the versioned
pages that require color extraction override.

2. Right-click (over the selected versioned page) to open the context
menu and click Override Colors to Extract.

3. In the Override Colors to Extract for <versionpagename> dialog
box, click the cell, under the Colors To Extract column, that you
want to change.

4. In the Edit Colors To Extract dialog box, select the colors that you
want to extract for the selected version of the versioned page, and
click OK.

The selected version of the versioned page in the Link tab changes
to a gold color. This color indicates a color extraction override.

5. If you do not want the base layer to appear in the output for the
selected version, select Base in the Layer Type column. This action
changes the selected layer to a base layer.

6. Repeat the above steps for any additional versioned pages that
require color extraction override.

Example

In the retail catalog scenario, if the base for page 1 of the
Spanish versions were modified to be different from the
base used for the English versions, you need to use color
extraction override to set the Spanish layer to have CMYK
extracted instead of Black. Also, you must change the
Spanish layer type to Base.
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Layers for page 1

Common

English, 
East and 
West

Spanish (base 
objects are 
different from 
common)

CMYK Base

Black Change

CMYK Base

Colors To Extract Layer Type

When setting the color extraction override, note that you
must right-click under the Versioned Page column in the
Link tab of the Versioned Pages view. See the figure
below.

Versioned Page

Right-click to 
open the 
context 
menu

VP_1.pdf EngEast.p1.pdf

EngEast.p2.pdf

EngEast.p3.pdf

EngEast.p4.pdf

EspEast.p1.pdf

EspEast.p2.pdf

EspEast.p3.pdf

EspEast.p4.pdf

EspEast.p1.pdf

EspEast.p2.pdf

EspEast.p3.pdf

EspEast.p4.pdf

EspWest.p1.pdf

EspWest.p2.pdf

EspWest.p3.pdf

EspWest.p4.pdf

VP_2.pdf

VP_3.pdf

VP_4.pdf

Eng Esp East West

Then, you must left-click under the Colors To Extract
column in the Override Colors to Extract dialog box to
open the Edit Colors to Extract dialog box.

Layer

Override Colors to Extract For VP_2.pdf

Left-click to 
open the Edit 
Colors to 
Extract dialog 
box.

Click to 
change the 
Layer Type to 
Base.

Eng Black

Black

Black

Black

BlackBase

Black

Black

Black

C,M,Y,K

Esp

East

West

Common Output Separately

Layer Type Colors To Extract Output Plate

Change

Base Change

Base Change

Base Change

Base Change
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Tip: To reset color extractions:

1. In the Versioned Pages view, on the Link tab,
select the versioned pages for which you want
to reset color extraction.

2. Right-click (over the selected versioned page)
to open the context menu and click Reset
Colors to Extract.

The Generate process

You must perform the Generate process on versioned pages in order to
convert the versioned page metadata into layered PDF pages. After you
perform the Generate process, you can output content and view the
versioned pages in Acrobat.

The Generate process performs the following for each versioned page:

● According to the colors mapped in the version plan:

○ Compares each contributing page to identify base content (for
input file models 1 and 2 only)

○ Extracts base objects onto a PDF layer named according to the
base layers in the version plan

○ Extracts unique objects onto a PDF layer named according to the
versions specified in the version plan

● For input file models 1 and 2, tries to match the objects on change
layer contributing pages that are meant to be identical to base
content. If objects do not match within the tolerances set, both the
base layer object and the corresponding unmatched change layer
object are extracted onto a PDF layer, which is, by default, named
Error.

● Finds any objects with colors that are not specified in any layer of
the version plan, and extracts them onto the error layer.

● Saves the layered PDF versioned page in the \Job\Subpage
directory

Generate process template

The generate task requires you to use a Generate process template.

Option Description

JTP list Select the job ticket processor (JTP)
you want to use for generating version
pages.
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Option Description

Version Layer Options

● Force Overprint check box
● Blend Layers check box

Use these options to quickly correct
knockout/overprint problems.

Force Overprint check box—Select
this check box when an object on a
change layer creates a knockout in the
base layer, and where the knockout is
not the same on each version. This
check box sets all change objects to
overprint, where change objects are
objects on pages that are linked to
layers other than the base layer.

For example, if you have English and
French text printing in black over a
CMYK image on the base layer, the
text in each language must overprint;
otherwise, the base CMY plates will
have knockouts in both languages and
the black text will not fit.

Note: One hundred percent (100%)
white objects are treated differently
and may still create knockouts in some
separations.

Blend Layers check box—Select this
check box when an “invisible” object
(an object colored with 0% ink sitting
on a blank area of the page) on a
change layer obscures or creates a
knockout in one or more of the base
layer's separations. This check box
uses the PDF Transparency feature to
blend layers and to simulate the
double burn technique of imaging data
on a plate by exposing it multiple
times. The check box makes the white
or clear areas of versioned objects
transparent, and ensures that the
colored/tinted versioned objects can
only make the area darker.

Note: If a page has text that is only
partially over an image, you may
notice, after selecting the Blend Layers
check box, differences between
characters that are on the image and
those that are not on the image at low
resolutions such as 300 dpi. These
differences should not appear at
higher resolutions such as 1200 dpi or
if you choose the Adobe PDF Print
Engine as the RIP in the RIP Options
section of the Edit Jobs Attributes
dialog box.
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Option Description

Object Comparison Tolerances

● Position Resolution box
● Tint Resolution box

If you are using input file models 1 or 2,
in the Position Resolution box, enter
the maximum distance between two
identical objects (on different pages)
at which the objects are considered
the same.

If you are using input file models 1 or 2,
in the Tint Resolution box, enter the
maximum percentage tint difference
between two identical objects (on
different pages) at which the objects
are considered the same.

Name of Error Layer box Type the name that you want for the
PDF layer containing all objects (in the
contributing pages) that are not
mapped in the version plan.

Verify that all layers are linked list Select Warn to receive messages
when a versioned page has at least
one empty layer. The messages
appear in the Process Info dialog box,
and in the History view.

Select Ignore if you do not want to
receive these messages.
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Option Description

Detect common object differences list This feature is relevant for models 1
and 2 only. (In model 1, for each
version, a single input file contains a
mix of base and change content, and
change content is defined as a spot
color. In model 2, for each version, a
single input file contains a mix of base
and change content, all content is in
process color, and the change content
is not identified by color).

The options in this list determine how
the system will react to differences
between ‘common’ objects—objects
that appear on all version pages, and
thus belong on the base layer. An
object may be visually identical, but
have differences in construction,
perhaps due to different versions of
creative applications in which it was
created.

Select Warn to receive messages
when differences occur between
common objects. The messages
appear in the Process Info dialog box,
and in the History view. The different
object will be mapped to the error
layer and will not be included on the
base layer.

Select Fail if you want the generate
process to fail with an error icon when
common object differences occur. The
operation will fail, but a layered PDF is
still generated so that the operator can
see the problems. The different object
will be mapped to the error layer and
will not be included on the base layer.

Select Ignore to print, despite the
object differences. The software that
checks the fit of common objects is
disabled. Prinergy will map objects to
base according to the Colors to
Extract column (in the Version Plan
view), and will not look for common
objects. It is not recommended to
select Ignore unless you have already
run the generate process with Warn or
Fail and you are aware of any errors
due to object differences.

This option may be appropriate when
you are dealing with files with
problematic objects that cannot be
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Option Description

fixed by adjusting the pages in a
creative application. It is
recommended to manually proof the
versioned pages to ensure that all
change layer objects are in register
with the base layer.

For descriptions of the remaining sections, see the Prinergy Workshop
Online Help descriptions of the refine process template, which has the
same sections.

Note: If trapping or color matching are enabled during the Generate process, only
objects on the common or base layers will be trapped or color matched.

Generating versioned pages

1. In the Pages view or Versioned Pages view, select the versioned
pages that you want to generate.

2. From the Process menu, select Generate, and then select the
generate process template that you want.

3. In the Start Process dialog box, modify the options as desired.

If desired, modify the process template before starting the process
by clicking Edit Process Template, modifying the process template,
and clicking OK.

4. Click OK to begin processing.

Monitoring generation status

Once a versioned page is generated, it may need to be generated again
if you make changes to any related data such as removing a link.
Prinergy LPV helps you track which versioned pages need to be
generated by displaying a status icon beside each versioned page.

Changes that require regeneration

The following actions require you to regenerate the affected versioned
pages:

● Changing the version plan (for example, if you add or remove a
layer or a version; or if you change the color mappings)

● Changing links (for example, if you link or unlink a refined page)
● Refining a contributing page after the associated versioned page has

been generated
● Changing the geometry using the Set Page Geometry dialog box

Important: If you change a contributing page in Acrobat, you must refine the page
again and generate the associated versioned page again.

Prinergy does not alert you when a contributing page modified in
Acrobat needs to be refined again.
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Viewing generation status

Once you start to generate versioned pages, view generation status in
the Pages view or in the Versioned Pages view. Versioned pages that
require generation cannot be output.

Pages view

The Pages view shows two types of generation information for each
versioned page:

● Generation requirement—Whether or not you must generate
● Generate process result—Whether or not the last generate process

was successful

Generation requirement

The following columns show whether or not you must generate the
versioned page:

● Page and Page Position columns—with icons as shown in the
following figure.

● Versioned Page Status column—with one of the following phrases:
‘Requires Generation’ or ‘Generated’.

Legend

Requires generation

Generated

Figure 21: Generate status icons on Page view

Generate process result

The Generate column identifies the success or failure of the last
generate process. This means that if you make a change that requires
regeneration, the icon in this column does not change. This icon would
only be affected by a generate process.

The icons used in this column are standard for other process snap-in
columns.

Note: The column name is taken from the process template group name. For
example, if you use a generate process template in the Dave group of process
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templates, the column identifying the versioned page generation status is named
Dave.

Recommended visible columns in the Pages view

In many jobs, it is important to note the differences in certain file
attributes between pages. Thus, we recommend that you make the
following columns visible in the Pages pane of the Pages view:

● Versioned Page Status
● Page Colors
● Trim Size
● Media Size
● Offset

Note: In LPV jobs, in the Pages pane of the Page view, the Group by Input File
button is no longer available. The Group by Assignment button continues to be
available.

Versioned Pages view

In the Versioned Pages view, the icons indicate both generation
requirement and the generate process result. The icons appear as in
the following figure.

Legend

Requires generation

Error in generation

Successfuly generated

Figure 22: Generate status icons on Versioned Pages view

Viewing generated pages in Acrobat

Once versioned pages have been successfully generated with Acrobat
6.0 or later, you can view the layered PDF files. Layered PDF files allow
you to view all versions of a versioned page in one window.
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The layers in layered PDF files do not correspond to layers in the
version plan. The following types of layers are available in layered PDF
files (Acrobat):

● Base layers—contain base content (This is the same as the base
layers that are used in the version plan.)

● Version change layers—contains the content for each version
excluding the base content. In other words, a version change layer is
a combination of all change layers for a version.

For example, you would see the following layers for the retail catalog
scenario.

EngEast

EngWest

EspEast

EspWest

Common

Figure 23: PDF layers in Acrobat

By default, the layered PDF page opens in Acrobat showing only the
error layer (if any) and the base layer. To see the version change layers,
select the check boxes beside the corresponding version change layer.

Multiple base layers in Acrobat

When you have more than one base layer in a job, each base layer
appears as a separate layer in Acrobat. For example, you are able
select the following layers in a layered PDF file (in Acrobat).

EngEast

EngWest

EspEast

EspWest

Base2

Base1

Base1

Base2

Figure 24: Multiple base layers in Acrobat

Important: Often, you will not be able to see two or more base layers at a time
because one will entirely cover the others. Ensure that you have selected only one
base layer. If you select two base layers to view, the base layer that is listed first in
the layers tab appears on top.

In Acrobat, version change layers are grouped according to their
associated base layer.
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By default, the versioned page opens with only the first base layer
visible. To see the other base layers and change layers, select the check
boxes beside the corresponding layers.

Investigating generate warnings

Your generate process can be successful yet still have warnings
regarding contributing pages with errors. If you have contributing
pages with errors, Prinergy reports the name of the page in the Process
Information dialog box and in the History view.

Problem file affecting others in the process

For input file models 1 and 2, when Prinergy finds a problem in a
contributing page during generation, Prinergy also finds errors in all
subsequent pages of the same process. These files may not have
errors.

To confirm whether or not the files have errors, remove the problem
file and regenerate the remaining files. The files will process
successfully if they do not have errors.

The reason why Prinergy finds errors in all files after the first problem
file is because it compares each file to the ones previously processed.
Thus, when one file contains problems, all remaining files in the
process are compared to it, and will, therefore, not match even when
they do not have errors.

Objects on the error layer

Prinergy LPV extracts the following objects onto a PDF layer, which is,
by default, named Error:

● Objects that have been defined with colors that are not specified in
the version plan. For example, if no version plan layer is set to
extract the color Spot5, then any objects colored with Spot5 are
placed on the error layer.

● For input file models 1 and 2, objects from different contributing
pages that are meant to be common, but that do not exactly match.
For example, if an object in a change layer contributing page has
been incorrectly positioned, sized, or colored, but is otherwise the
same as the base layer object, both objects (control and test
objects) are extracted to the error layer. These objects are
extracted to the error layer in order to prevent potential
misregistration on press.

To view errors, in the Pages view, in the Pages pane, open the problem
layered PDF page (VP_xxx.pdf) in Acrobat. View the error layer in
the problem page, remembering to clear the display of all other PDF
layers to isolate the objects in error.
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When trying to determine why an object does not match the first set of
base objects, remember to compare the following attributes:

● Position
● Font
● Color
● Associated ICC profile
● Clipping path
● The order in which an object is stacked in relation to other objects

on the page (z-order)

If you are unable to determine why objects are appearing on the ‘error’
layer, use Prinergy PDF Compare, a licensed Acrobat plug-in, to help
you find the differences between objects.

Note: If you do not want the objects in the error layer to print, you do not need to
take any action. Simply leave the objects in the error layer.

Fixing a contributing refined page

If a contributing page has errors, you may want to fix the problem at a
later time if the problem is not obvious, and you want to continue
generating other pages. To continue generating other pages, you must
unlink the problem versioned page.

If the reason for the error is obvious and easy to fix, you may want to
fix the error immediately.

1. Perform the following as appropriate:

If you want to fix the contributing
page

Then

Immediately Go to the next step.

Later Unlink the contributing page from
the versioned page.

Continue to generate other
contributing pages. When you are
ready to fix the problem file, go to
the next step.
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2. Perform the following as appropriate:

If Then

You can fix the error in Acrobat Open the contributing page by
double-clicking the page, and fix
the object.

You must fix the error in the original
creative application such as
QuarkXPress or Adobe Illustrator

Open the original file in the
creative application, and fix the
object.

Add the corrected file to the
Prinergy job.

3. Refine the corrected contributing page (not the versioned page)
again.

4. Perform the following as appropriate:

If Then

You have not unlinked the problem
page in step 1

Go to the next step.

You have unlinked the problem page
in step 1

Link the corrected and refined
page to the appropriate versioned
page.

5. Regenerate the versioned page.

Prinergy lists the versioned pages that require generation.

Assigning versioned pages to a page set or imposition plan

After you have created a versioned page, assign the versioned pages to
a position in a page set or an imposition plan.

In LPV, you assign versioned pages in the same way as you assign non-
versioned pages

Important: Note that you must assign the versioned page—not the contributing
pages of the versioned page—to the page position. 

Tip: Versioned pages that have not been generated can be assigned to a page set
or an imposition plan. However, the page cannot be output until it has been
generated.

As in a regular job, there are four ways in which you can assign
versioned pages to a page set:

● Create page sets and assign versioned pages independent of an
imposition plan and then import an imposition plan with the Use
existing page set option selected

● Import an imposition plan which creates the page sets, and then
assign the versioned pages to the page positions in the imposition
plan

● In the Job Manager, from the File menu, select Create New
Imposition to create a new imposition plan using Preps software, or
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other qualified imposition software, and assign the versioned pages
to the page positions in the imposition plan page set

● Import a new imposition plan and use Prinergy APA to
automatically assign the versioned pages to the page set.

Once you have refined a page, you can output a loose page proof. Once
all page positions in your imposition plan have been assigned, you can
output the imposition. For information about outputting from LPV jobs,
see the next chapter.

For information about how to add page sets, use Prinergy APA, import
imposition plans, and configure integrated imposition software, see the
Prinergy Workshop online help.

Versioned white objects

When versioned white objects are designed to be seen on top of
another colored object, the colors that make up the colored object
must be extracted in the version plan. (Versioned white objects are
white objects that do not appear on all versions.)

For example, with the following objects (white text on cyan boxes) in
your files, you must extract cyan for each affected version in the
version plan.

100000 100000955725
Version 1 Version 2

Figure 25: Versioned white objects

Version Colors To Extract Map To Plate

Common CMYK Output Separately

Version 1 CK Output Separately

Version 2 CK Output Separately

Background object color not extracted

If you do not extract the colors that make up the background object in
the version layers, your output may not appear as intended. See the
following examples.

● Force Overprint OFF

When cyan is not extracted in the version layers, you receive the
following results when the Force Overprint check box is OFF
(cleared):
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100000 100000955725955725
Version 1 Version 2

100000

Figure 26: Versioned white objects: Force Overprint OFF

The white objects are included on the ‘common’ layer in Acrobat so
that you can see them.

● Force Overprint ON

When cyan is not extracted in the version layers, you receive the
following results when the Force Overprint check box is ON
(selected):

100000
Version 1 Version 2

Figure 27: Versioned White objects: Force Overprint ON

Outputting from an LPV job

Introduction

This chapter describes the options and considerations for outputting
Layered PDF Versioning (LPV) jobs that are in addition to those
options and considerations for outputting non-LPV jobs:

Tip: The procedures in this guide describe how to perform tasks using the menu
bar. However, you can also quickly access many menu items using the context
menu by right-clicking inside the Workshop window.

For general information about how to create proofs and final output,
and how to start a process, see the Prinergy Workshop online help.

Outputting all or selected versions

Note: In the example below, versions are represented as: EE = EnglishEast, EW =
EnglishWest, SE = SpanishEast, and SW = SpanishWest

By default, all versions are output. However, when creating proofs, you
can select individual versions to output. For example:
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All versions OR Selected versions

EE EW SE SW SE SW

1. Perform the following as appropriate:

If outputting Then

Loose page proofs Select the desired versioned pages
in the Pages pane of the Pages
view.

Imposition proofs Select the desired surfaces in the
Imposition Plans pane of the
Signatures view.

2. Start the output process.

3. In the Start Process dialog box, expand the Options area, click
Output Selected Versions, and select the desired versions.

Outputting all versions overlaid

Note: In the examples below, versions are represented as: EE = EnglishEast, EW =
EnglishWest, SE = SpanishEast, and SW = SpanishWest

When creating proof output, you can choose to overlay all versions of a
page together. This creates proofs in which all versions are printed over
one another. For example:

All versions printed over one anotherEEEWSESWSESW

1. Open the output process template that you want to use to proof the
overlaid versions.

2. In the output process template, in the Render section, select the
Overlay Versioned Content check box.

3. Start the output process using the process template that you have
just modified.

Outputting multiple versions per surface

Note: In the examples below, versions are represented as: EE = EnglishEast, EW =
EnglishWest, SE = SpanishEast, and SW = SpanishWest

When outputting surfaces (imposition proofs and final output), you
can output pages of different versions on a single surface. By default,
all pages of a surface are output with the same version.
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All versions OR
Multiple versions on 
one imposition

EE EE EE EE

EE EE EE EE

EW EW EW EW

EW EW EW EW

SE SE SE SE

SE SE SE SE

EE EW SE SW

EE EW SE SW

SW SW SW SW

SW SW SW SW

Conditions of this feature are:

● For each surface, all pages must be either:

○ All versions—This provides one imposition for each version in
the version plan. Each imposition is output with the same version
in each page position.

OR
○ One specific version—This provides a single imposition in which

the content in each page position can be a different version.

Tip: Use the LPV marks for separations to identify the different versions on an
imposition. These marks are replaced with the version(s) associated with the page
position that is closest to it.

Important: If you try to output a surface in which the pages are a mix of ‘all
versions’ and specific versions, an error message appears:

● Output versions on page positions can be set only in the Signatures
view.

● If all page positions on a surface are set to All versions, you can
choose to output selected versions.

● If you change an imposition plan and reimport it using the same
name (as the imposition plan already in the job) and you selected
the Keep existing page set and imposition setting in the import
process template, the output version settings are retained.
Conversely, if you change the name of the imposition plan and/or
select Create alternate page set and imposition in the import
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process template, the associated output version settings are
changed to All versions.

● Imposition plans using the same page set are not restricted to
outputting the same versions. For example, if imposition plans A
and B are using the same page set, imposition plan A can output all
versions, while imposition plan B outputs a mix of English and
Spanish versions.

1. In the Imposition Plans pane of the Signatures view, ensure that
you can see the:

○ Output Version column
○ Individual page positions of the surface

2. Select the page positions for which you want to change the output
version to one version, and click the Versioning menu, Set Output
Version, and then the desired version.

3. Repeat step 2 for those page positions which you want to output as
another version.

4. Start the imposition proof or final output process.

Tip: You can also right-click within the Imposition Plans pane (after selecting
page positions) to open the context menu, which allows you to set the output
version.

Outputting proofs to distinguish change content

Note: In the examples below, versions are represented as: EE = EnglishEast, EW =
EnglishWest, SE = SpanishEast, and SW = SpanishWest

When outputting proofs, you can select a color to output change
content to distinguish them from common content.

For example, if both the EngWest version and the common layer
extracted CMYK in the version plan, you could distinguish the change
black from the common black by outputting all the change content in a
special color such as hot pink.

The color name that you choose must have a recipe in the color library.
If Prinergy cannot find the color recipe, the change content will be
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output in green color. To add a recipe to the color library, see the
Prinergy Workshop online help.

1. Open the proof process template that you want to use.

2. In the Render section, in the Versioning Proof Mapping Color box,
type the color name that you want the change content to appear in.

3. Save the process template.

Use this process template when you want to create proof output in
which the change content paints in the specified color.

Outputting PDF vector files

For information about PDF vector files, see About Supported Output
Formats in the Prinergy Workshop online help.

When outputting to PDF vector files, ensure that:

● You select the Preserve PDF Layers check box in the File Format
section of the process template if you want to preserve PDF 1.5
layers. This prevents the file from writing as a PDF 1.3 file, in which
the layers are flattened.

● You select the required Document Format option (Multipage or
Single Page) in the File Format section.

● Output file names will be unique.

Note: Prinergy does not support vector PDF imposition proofs with preserved PDF
layers on surfaces with multiple versions.

Outputting Virtual Proofing files

The Kodak Prinergy Virtual Proofing software, which allows you to soft
proof (preview) pages, has been updated to support LPV files.

When outputting LPV pages to the Prinergy Virtual Proofing software,
ensure that you select the Advanced TIFF Tags check box in the File
Format section of the proof process template. This enables the
Prinergy Virtual Proofing software to automatically sort the separations
into versions.

In Prinergy Virtual Proofing software, you can preview each separation,
or any combination of separations. The Prinergy Virtual Proofing
software also provides a grid showing the separations required for each
version. To view the seps per version grid, click the information button
on the Separations palette.
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Click the information
button to open the
seps per version grid

Figure 28: Prinergy Virtual Proofing software separations palette

The following figure shows the seps per version grid.

Figure 29: The seps per version grid in the Prinergy Virtual Proofing software

For more information on using Prinergy Virtual Proofing software with
LPV jobs, see the Prinergy Virtual Proofing Online Help.

Approving versions

Use approvals to indicate whether or not elements are ready to move
to the next step in the workflow.

You can approve all or individual versions of a generated versioned
page. For example, you can approve the English versions of a generated
page, but leave the Spanish versions of the page unapproved.

Versioned elements approved through InSite Prepress Portal are also
reflected in Prinergy Workshop.

1. In the Versioned Pages view, click the Approvals tab.

2. Select the version(s) that you want to approve, and right-click to
open the context menu.

3. Click Approve.

Once you approve a version of a versioned page, re-generation of the
versioned page no longer affects the approved version. Also, once you
approve a version of a versioned page, the content is “locked.” You are
prevented from making any changes to the job that would affect the
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approved page. For example, if you approve the English West version
of page 1, you are prevented from:

● Linking, or unlinking the common, English or West layers of page 1
● Changing the colors to extract on the common, English, or West

layers in the version plan
● Re-assigning the change layers for the English West version in the

version plan

If your system administrator has restricted operators from overwriting
approved pages in the System Administrator, you are also prevented
from re-refining approved component pages.

However, to ensure the integrity of version approvals, even if an
operator is allowed to re-refine approved pages, and proceeds to re-
refine and re-generate an approved version of a page, there is no
impact on the approved version.

Approved versions lock related layers

If you have a mixture of approved and unapproved versions of a
versioned page, you may not modify any layers used in the approved
versions. Conversely, you can modify any layers that are not used in
the approved versions.

For example, if the EnglishWest and EnglishEast versions are approved,
you may not modify the English layer, the West layer, the East layer, or
the common layer.

You would be allowed to modify only the Spanish layer. The approved
versions always use the layers that it was approved with.

Note: Previous to Prinergy 4.1.2.3, you were not able to approve individual versions
of a versioned page; you were only able to approve all versions of a versioned
page. Also, previous to Prinergy 4.1.2.3, you were able to approve versioned pages
in the Pages view, which you are no longer able to do.

Allowing re-refine of approved pages

In Prinergy Administrator, you can allow approved pages on all jobs or
only on web-enabled jobs to be re-refined.
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Note: Web-enabled jobs are jobs that can be viewed by InSite Prepress Portal
users and Storefront users.

1. In Prinergy Administrator, click Tools > Configure System >
Customer Approval.

2. In the Customer Approval dialog box, select Allow overwrite of
approved pages.

3. Select Apply to web-enabled jobs only or Apply to all jobs as
appropriate.

Final output and plate mapping

When producing final output for LPV jobs, separations that are
common to different versions are output only once. Also, base and
change content of the same color are merged.

Example

In the nationwide catalog example, because all change
content is mapped to black, the C, M, and Y plates are
common to all versions.

Also, the black separation for each version contains both
base black content and change content. For example, for
the English East version, the black final output separation
contains the English content, the East pricing content, and
any base black content. See the following figure for an
illustration of how separations are handled.

Common

One Layered PDF File

Common plates 
for all versions

Plate for English 
East version

Eng East
Eng West
Esp East
Esp West

Cc

C
M

Y
Mc Yc Kc

Kene

Kene KKc + =

Generated Versioned Page One

Figure 30: Separations for English East versioned page one
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Figure 31: Output separations for nationwide catalog

Variable marks

As with other variable marks with potentially long values, ensure that
you leave plenty of space for the value that replaces the mark.

Variable marks for LPV

Additional variable marks are available in LPV jobs. They are:

Mark Description

$[BaseLayer] This mark is replaced with the name of the base layer
associated with the version.

You can use this mark on composite and separated
output. If outputting to separations, the corresponding
base layer name appears on all separations.

This mark is not useful for output of multiple versions
per surface. This mark prints nothing if used on
multiple version surfaces.

$[SurfaceVersion] This mark is replaced with the name of the version that
is output. On output of multiple versions per surface,
this mark is replaced with the version name of the
page position that is closest to the mark.

Use this mark for composite proofs only; do not use
this mark for separated output.

Marks for separations: Use the following LPV variable marks for
separations only.

Note: When placed on output of multiple versions per surface, each of the
following marks is replaced with the version(s) associated with the page position
that is closest to the mark.
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Mark Description

$[SeparationVersion] On all separations, this mark is replaced with the
names of the versions to which the separation
contributes. For example, if a separation applies to the
English and French versions, but not the Spanish
version, the file name component would be
English_French.

Note: This mark may be replaced with different text on
different separations. This means that once a printed
page is produced from the separations, the text will
overprint each other, for example, . To avoid this,
use $[SeparationVersion_Offset].

$[SeparationVersion_Offset] This mark is the same as $[SeparationVersion] except
that it is offset on different separations so that the
marks do not overprint each other once a printed page
is produced.

$[SeparationVersionUnique] This mark is replaced with the name of the version to
which it contributes if the separation is unique to only
one version. For example, if a separation contributes to
only one version, this mark is replaced with the version
name. If a separation contributes to two versions, this
mark is replaced with an empty space.

$[SeparationVersionCommon] On common separations (separations used in all
versions), this mark is replaced with the word
‘common’. On separations that are not used in all
versions, this mark is replaced with an empty space.

$[SeparationVersionNoCommon] On non-common separations, this mark is replaced
with the names of the versions to which it applies. For
example, if a separation contributes to the English and
French versions, but not the Spanish version, the file
name component would be English_French. On
common separations, this mark is replaced with an
empty space.

Note: This mark may be replaced with different text on
different separations. This means that once a printed
page is produced from the separations, the text will
overprint each other, for example, . To avoid this,
use $[SeparationVersionNoCommon_Offset].

$[SeparationVersionNoCommon_Offset] This mark is the same as $
[SeparationVersionNoCommon] except that it is
offset on different separations so that the marks do
not overprint each other once a printed page is
produced.

Prinergy-defined output file names

When you output to file, for example, when creating soft proofs, ensure
that the output file names are unique and meaningful. In LPV jobs, the
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default (Prinergy-defined) file names for output use the following
patterns:

For loose page proofs

%page%.%SeparationVersion<20>%.%signature%%surface%.%color%%dotversion%
%extension%
For imposition proofs and final output

%imposition%.%SeparationVersion<20>%.%signature%%surface%.%color%%dotversion%
%extension%

where,

%SeparationVersion% is composed of the names of the versions
to which the separation applies.

For example, if a separation applies to the English and French versions,
but not the Spanish version, the file name component would be
English_French. Thus, a possible output file name would be
1VP_1.English_French.1A.K.1.pdf, which is exactly 31
characters long.

%dotversion% is a number that indicates the instance of the file
among files of the same name. The most recent file does not have a
dotversion component, for example, 1VP_1.common.1A.K.pdf.

A higher dotversion number indicates an older instance. For example,
1VP_1.common.1A.K.2.pdf is older than 1VP_1.common.
1A.K.1.pdf.

For definitions of other components in the file name, see the Prinergy
Workshop online help.

Output file name best practices

If you are using Prinergy-defined file naming when outputting to file,
ensure that the 20 character limit on the %SeparationVersion%
tag is sufficient for your output.

If you are using custom file naming when outputting to file, we
recommend that you use the %dotversion% tag to ensure that
output files are not accidently overwritten.

Note: If you rename a version, ensure that you regenerate all versioned pages that
have already been linked and generated.

Output file name best practices for AFP

If you use Apple Filing Protocol (AFP) and are outputting to file, you
must use custom file naming to ensure that filenames are 31 characters
or less.
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Important: The default (Prinergy-defined) file name pattern does not ensure that
file names are 31 characters or fewer.

However, you must minimize the length of the following output file
name components if you want to output file names to be unique,
meaningful, and 31 characters or fewer:

● For loose page proof output names, make the combined %page%
and %SeparationVersion% portions of the file names 20
characters or fewer

● For imposition proof output names, make the combined
%imposition% and %SeparationVersion% portions of the
file names 20 characters or fewer

For example,

1VP_1.common.1A.K.1.pdf

< 20 characters 11 characters or more

Minimizing the %SeparationVersion% tag

Because the %SeparationVersion% tag is composed of names of
the versions to which it applies, this file name component can be very
long. Thus, we recommended that version names be as short as
possible, especially if you have many versions in your job. See the
example below.

Imposition separation output file name example
for AFP

Before shortening file names:

You have four versions for which you use the following
version names: Vancouver, Toronto, Montreal, and
Calgary.

If you have a separation that applies to the Vancouver,
Toronto, and Montreal versions, the separation name
becomes Vancouver_Toronto_Montreal. The output file
name would be the following if you are using the Prinergy-
defined file naming:

Impo_8pg_W&T.Vancouver_Toronto_Mo.1A.K.1.pdf
(44 characters)

After using custom file naming to limit the imposition and
SeparationVersion components each to 9 characters,

%imposition<9>%.%SeparationVersion<9>%.
%signature%%surface%.%color%.%dotversion
%.%extension%
the file name is:

Impo_8pg_.Vancouver.1A.K.1.pdf (30 characters)
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However, this name does not indicate that the separation
also applies to the Toronto and Montreal versions.

After shortening version names:

If you use the version names: Va, To, Mn, and Ca, the
imposition separation output file name would be:

Impo_8pg_.Va_To_Mt.1A.K.1.pdf (29 characters)

This output file name now indicates all the versions to
which it applies.

Importing and exporting LPV jobs

Prinergy supports the import and export of entire LPV jobs.
Incremental LPV jobs are not yet supported.

Note: LPV jobs cannot be supported with backward compatibility. Because
Prinergy versions lower than 3.0.3.0 cannot read the versioning attributes of an
LPV job, you will receive an error if the Backward Compatibility check box is
selected during export of an LPV job.

Hub and spoke workflows

In hub and spoke workflows, if a spoke is not licensed for LPV, it can
output LPV jobs, but is not able to modify them.

If a spoke is licensed for LPV and has the required software, it has the
same abilities to modify an LPV job as the hub.

Spokes without an LPV license

Without a license, the spoke:

Can Cannot

● Import jobs
● Import impositions
● Assign/unassign versioned pages

to page sets
● Output proofs and plates

● View or modify the version plan
● Link/unlink contributing pages
● Generate versioned pages
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Can Cannot

CAUTION: Although the spoke is able
to refine pages without a license, doing
so results in versioned pages that need
to be regenerated. Because generation
is not available to spokes without a
Regional Versioning license, the spoke
will consequently be unable to output
any versioned pages that it has
refined.

If a spoke accidentally incurs a
Requires Generation state on a
versioned page, the spoke must
reimport the LPV job and avoid
changing the generate status to
“Requires generation.”

If the spoke is not licensed, use one of the following methods of
delivering an LPV job to the spoke:

● Sending an exported LPV job—Exporting a job generally takes less
time than outputting imposed vector files.

● Sending imposed vector output—Generally, imposed vector output
files are large and take longer to output than an exported job.

Working with related products

This section describes how related products work with Layered PDF
Versioning.

PrintLink

LPV supports PrintLink by enabling PrintLink to provide reports on ink
usage for each surface, each separation, and each sheet.

PrintLink uses the %SurfaceVersion% tag for file naming.

For information on PrintLink, see the PrintLink topics in Prinergy
Workshop online help.

Automating LPV jobs

You can automate LPV jobs in the following ways:

Linking refined pages automatically

About linking refined pages automatically

In Prinergy LPV, you can link refined pages to versioned pages
automatically if the refined pages have consistent file naming patterns.
You can define a page name pattern in each layer, and then start a
refine process on the input files. Prinergy refines the pages and
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automatically links them to versioned pages. Prinergy also
automatically creates version pages if they do not already exist.

Consistent refined page names

If your refined page names are not consistent, you can make them
consistent by renaming your refined pages using smart hot folders.

For information on using smart hot folders, see the Prinergy Workshop
online help.

General tasks required to link refined pages automatically

The general tasks required to link refined pages automatically are:

● Define page name patterns—Define a page name pattern that
matches the refined page names for each layer.

● Build the versioned page—After setting the page name pattern in
the version plan, refine the files using the Build Versioned Page
check box in the refine process template. This check box tells
Prinergy to use page name patterns to link refined pages to
versioned pages, and to create versioned pages if necessary.

When you refine input files in a LPV job that uses automatic linking,
Prinergy:

● Compares all refined pages against the page name pattern for the
first layer

● Based on the wild card value, creates a versioned page for each
refined page that matches the pattern—if one has not already been
created.

● Links each refined page to the layer of the corresponding versioned
page

● Repeats the above actions for the remaining layers

Page name patterns

Construct the page name pattern carefully to ensure that the
automatic linking results are as you intended. After defining a page
name pattern, it is important to check that it links refined pages to
versioned pages correctly.

Tip: If you create a version plan with page name patterns that you can use for
other jobs, the job can become a template for other jobs.

What is a page name pattern?

A page name pattern is a set of characters that matches the refined
page names for a layer, where wild cards are used to represent the
characters that change between each refined page name.
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Important: Use page name patterns to match refined page names; not to match
input file names. For example, the single page input file, RC_English.pdf
becomes RC_English.p1.pdf after refining.

Wild cards

The following wild cards are supported:

● #—match numbers
● %—match letters
● $—match letters and/or numbers

Wild card rules

● All wild cards must be enclosed in square brackets. For example,
[#]

● You can use one or more wild cards in a page name pattern.

Important: Although the pattern matching wild cards are very similar to that used
in APA (Advanced Production Automation), you cannot use the APA Editor in
Prinergy to create the pattern matching expressions for LPV. You must use the
version plan.

Page name pattern errors

If no refined pages match the page name pattern, the refine process
completes, the refined pages are added to the Pages view, but
versioned pages are not created, and the refined pages are not linked.

After a failed auto-linking process, do one of the following to link your
refined pages:

● Fix the page name pattern—After correcting the page name
pattern, perform a minimal rerefine to apply automatic linking.
Ensure that the Build Versioned Pages check box (Normalize pane)
is selected in the refine process template.

● Link refined pages to versioned pages manually

Names of automatically created versioned pages

When using page name patterns without back references, versioned
pages that are automatically created are named with the ‘VP’ prefix.
For example, versioned page one is named VP_1.pdf.

If you use back references, you can define the versioned page name
prefix.

Page name pattern examples

The following examples illustrate the results of different page name
patterns.
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Single page input files Example 1: Correct

Refined page names Page name pattern Linked to version page

1_RC_Eng.p1.pdf [#]_RC_Eng.p1.pdf VP_1.pdf

3_RC_Eng.p1.pdf VP_3.pdf

5_RC_Eng.p1.pdf VP_5.pdf

Single page input files Example 2: Incorrect

Refined page names Page name pattern Linked to version page

1_RC_Eng.p1.pdf 1_RC_Eng.p[#].pdf VP_1.pdf

3_RC_Eng.p1.pdf A versioned page is not created for
these pages (3_RC_Eng.p1.pdf and
5_RC_Eng.p1.pdf) because the refined
page name does not match the
pattern.

5_RC_Eng.p1.pdf

Multi-page input files Example 1: Correct

Refined page names Page name pattern Linked to version page

1-3_RC_Eng.p1.pdf 1-3_RC_Eng.p[#].pdf VP_1.pdf

1-3_RC_Eng.p2.pdf VP_2.pdf

1-3_RC_Eng.p3.pdf VP_3.pdf

Multi-page input files Example 2: Incorrect

Refined page names Page name pattern Linked to version page

1-3_RC_Eng.p1.pdf [#]_RC_Eng.p1.pdf Versioned pages are not created
because the refined page name does
not match the pattern. That is, the
[#] tag does not accept hyphens.

1-3_RC_Eng.p2.pdf

1-3_RC_Eng.p3.pdf

Multi-page input files Example 3: Incorrect

Refined page names Page name pattern Linked to version page

1-3_RC_Eng.p1.pdf [$]_RC_Eng.p1.pdf Versioned pages are not created
because no integer is provided for the
number portion of the versioned page
name. That is, VP_1-3.pdf is not a
valid name.

1-3_RC_Eng.p2.pdf

1-3_RC_Eng.p3.pdf

Padded digits for wild card values

If you use padded numbers such as 001 to represent numbers in your
refined page names, you can specify the pattern to read padded digits
and the versioned pages to be named with padded digits.
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Indicate padded digits with a colon and a number after the # sign, such
as [#:3].

CAUTION: Refined page names with fewer digits than specified are not matched.
Refined page names with more digits than specified are read, but only the number
of digits as specified is read. See example 2 below.

Padded digits Example 1: Correct

Refined page names Use page name pattern Linked to version page

MyFile_0001.p1.pdf MyFile_[#:4].p1.pdf VP_0001.pdf

MyFile_0002.p1.pdf VP_0002.pdf

MyFile_0003.p1.pdf VP_0003.pdf

Padded digits Example 2: Incorrect

Refined page names Use page name pattern Linked to version page

MyFile_01.p1.pdf MyFile_[#:4].p1.pdf This refined page is not matched to
the pattern because it does not have
four folio digits in the name. A
versioned page is not created at this
time.

MyFile_0002.p1.pdf VP_0002.pdf

MyFile_0003.p1.pdf VP_0003.pdf

MyFile_00011.p1.pdf VP_0001.pdf

Important: This refined page is linked
to the VP_0001.pdf versioned page,
and not VP_00011.pdf because the
pattern reads only the first four digits
in the folio number.

Using back references

Back references are optional elements in a page name pattern. Back
references help you with linking and naming versioned pages. There
are two types of back references:

● Page name back reference—This affects the versioned page prefix.
This back reference allows you to set the versioned page name
prefix to reflect part of the page name.

● Page number back reference—This affects the versioned page
number. This back reference allows you to use two or more wild
cards for numbers ([#]) in a page name pattern. This back
reference also allows you to add to or subtract from numbers in
your contributing page names that are used to define the versioned
page number.
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If your refined pages have two or more sets of numbers in the
pattern, and you do not use the page number back reference,
Prinergy uses the last [#] wild card as the versioned page number.

VP_1.pdf

Use the Page Number Back 
Reference to define this part 
of the name, which must be 
a number.

Use the Page Name Back Reference 
to define this part of the name, which 
can be numbers and/or letters. The 
default prefix is VP.

Important: Ensure that your versioned page names are not specific to a version.
For example, do not create versioned page names such as English_1.pdf and
French_1.pdf for refined pages that must be assigned to the same versioned
page.

Back reference syntax

A back reference is a wild card with a text descriptor inside the square
brackets. You can use addition or subtraction to alter the number, if
applicable. For example:

[#page] + 3

wild card math operator and number 
- these are optional

descriptor - this is 
user-defined text

To create a back reference, type the back reference in the appropriate
column of the version plan. For example, to create a page number back
reference, type the back reference under the Page Number Back
Reference column.

Use the addition and subtraction math operators when required.

The following examples show some back reference scenarios and the
versioned page names they produce.

Back reference example 1: Page name back reference
(correct)

Refined Page
Names

Page Name Pattern Page Name Back
Reference

Page Number Back
Reference

Linked to Version
Page

1-3_RC_Eng.p1.pdf [$range]_RC_Eng.p[
#].pdf

[$range] Not required 1-3_1.pdf

1-3_RC_Eng.p2.pdf 1-3_2.pdf

1-3_RC_Eng.p3.pdf 1-3_3.pdf

4-6_RC_Eng.p1.pdf 4-6_1.pdf
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Refined Page
Names

Page Name Pattern Page Name Back
Reference

Page Number Back
Reference

Linked to Version
Page

4-6_RC_Eng.p2.pdf 4-6_2.pdf

4-6_RC_Eng.p3.pdf 4-6_3.pdf

Note: Prinergy LPV automatically uses the [#] wild card as the page number. The
result is the same as the following example.

Back reference example 2: Page name and page number
back reference (correct)

Refined Page
Names

Page Name Pattern Page Name Back
Reference

Page Number Back
Reference

Linked to Version
Page

RC_Eng1-3.p1.pdf RC_Eng[$range].p[
#page].pdf

[$range] [#page] 1-3_1.pdf

RC_Eng1-3.p2.pdf 1-3_2.pdf

RC_Eng1-3.p3.pdf 1-3_3.pdf

RC_Eng4-6.p1.pdf 4-6_1.pdf

RC_Eng4-6.p2.pdf 4-6_2.pdf

RC_Eng4-6.p3.pdf 4-6_3.pdf

Back reference example 3: No back references (incorrect)

Refined Page
Names

Page Name Pattern Page Name Back
Reference

Page Number Back
Reference

Linked to Version
Page

1_1234.p1.pdf [#]_[#].p1.pdf Not required Not required VP_1234.pdf

2_5678.p1.pdf VP_5678.pdf

3_5678.p1.pdf System message:

Some
versioned
pages already
have pages
linked to the
selected
layer. Do you
want to link
these pages
anyways?
If you continue to
link to layer, the
new page link
overwrites the
previous link.
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Setting refined pages to automatically link to versioned pages

1. Create an LPV job.

2. Add and refine input files with consistent file names.

3. Create the version plan.

4. Defining the page name pattern.

a. In the Version Plan view, in the Layers area, double-click the
appropriate box to enter the page name pattern for a layer. Type
the page name pattern for the layer. The page name pattern is
limited to 100 characters.

b. If required, double-click the appropriate box to enter the page
name back reference for a layer. Type the page name back
reference for the layer. The page name back reference is limited
to 100 characters.

c. If required, double-click the appropriate box to enter the page
number back reference for a layer. Type the page number back
reference for the layer. The page number back reference is
limited to 50 characters.

5. Click OK.

6. Repeat steps 4 to 7 for the remaining layers.

7. Building versioned pages.

a. Click the Pages view.
b. In the Pages view, select all input files, and then from the

Process menu, select Process > Refine, and navigate to a refine
process template.

c. In the Start Process dialog box, click Edit Process Template.
d. In the process template, click the triangle beside Normalize to

expand the section.
e. In the Normalize section, ensure that the Build Versioned Pages

check box is selected, and click OK.

8. In the Start Process dialog box, click OK.

The refined pages are automatically linked to the associated versioned
pages.

Assigning versioned pages to a page set automatically

You can use Advanced Production Automation (APA) to assign
versioned pages to a page set automatically, in the same way as you
would use APA to assign non-versioned pages.

For information, see the topics about APA.

Using Rules-Based Automation

You can use Rules-Based Automation to automatically generate
versioned pages after pages have been refined and linked to versioned
pages. See the following figure for an example of the rule.
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Tip: The refine process should be set up to automatically link pages to versioned
pages. If the Build Versioned Pages check box is not selected in the refine process
template, no files will be available for the generate process.

Figure 32: Rule to Generate After Refine

For information on using Rules-Based Automation, see the Prinergy
Rules-Based Automation User Guide.

Working with input file models

This appendix provides detailed scenarios for linking refined pages in
each input file model. Using the retail catalog scenario described
throughout the guide, the following examples show how refined pages
are linked to a versioned page.

Model 1 scenario

A detailed description of how to link refined pages in a model input file
model.

In model 1, the version plan would be:

Using input file model 1, your refined pages for versioned page one of
the nationwide catalog would be:

CcMcYcKc+
Keast

RC_East.p1.pdf

CcMcYcKc+
Keng

RC_Eng.p1.pdf

CcMcYcKc+
Kesp

RC_Esp.p1.pdf

CcMcYcKc+
Kwest

RC_West.p1.pdf
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Building versioned pages in model 1

First, link refined pages to the common layer. Because all files contain
base content, designate one set of refined pages (one refined page for
every versioned page) to provide the base content. This means that
these refined pages will be linked to two layers. Thus, link the pages to
the common layer and before closing the Link to Layer dialog box, link
the refined pages again to the appropriate change layer.

For the remaining versioned content, you can link the refined files by
layer or versioned pages. After linking, generate the versioned pages,
and the versioned pages are ready to proof.

The following figure shows the refined pages to link to versioned page
one.

Virtual Versioned Page One as defined 
in Version Plan

One layered PDF file

GENERATE
Common

Eng East

Eng West

Esp East

Esp West

RC_East.p1.pdf

RC_East.p2.pdf

RC_East.p3.pdf

RC_Eng.p1.pdf

RC_Eng.p2.pdf

RC_Eng.p3.pdf

RC_Esp.p1.pdf

RC_Esp.p2.pdf

RC_Esp.p3.pdf

RC_West.p1.pdf

RC_West.p2.pdf

RC_West.p3.pdf

Refined pages 
linked to layers

Colors to 
extract Layer

RC_East.p1.pdf

RC_East.p1.pdf

RC_Eng.p1.pdf

RC_Esp.p1.pdf

RC_West.p1.pdf

CMYK

Spot East

Spot Eng

Spot Esp

Spot West

Common

East

Eng

Esp

West

Generated 
Versioned Page 

One

Model 2 scenario

In model 2, the version plan would be:
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In this example, the black color in all files contains change content.
Thus, all files have been set in the version plan to have the black color
extracted.

Using input file model 2, your refined pages for versioned page 1 of the
nationwide catalog would be:

C1M1Y1K1

RC_EngEast.p1.pdf

C2M2Y2K2

RC_EngWest.p1.pdf

C3M3Y3K3

RC_EspEast.p1.pdf

C4M4Y4K4

RC_EspWest.p1.pdf

Building versioned pages in model 2

First, link refined pages to the common layer. Because all files
potentially contain base content, designate one set of refined pages
(one refined page for every versioned page) to provide the base
content. This means that these refined pages will be linked to two
layers. Thus, link the pages to the common layer and before closing the
Link to Layer dialog box, link the refined pages again to the appropriate
change layer.

For the remaining refined files, link each set to the appropriate layer.
After linking, generate the versioned pages. and the versioned pages
are ready to proof.

The following figure shows the refined pages to link to versioned page
one.
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Virtual Versioned Page One 
as defined in Version Plan

Generated 
Versioned 
Page One

One layered PDF file

GENERATE
Common

Eng East

Eng West

Esp East

Esp West

RC_EngEast.p1.pdf

RC_EngEast.p2.pdf

RC_EngEast.p3.pdf

RC_EngWest.p1.pdf

RC_EngWest.p2.pdf

RC_EngWest.p3.pdf

RC_EspEast.p1.pdf

RC_EspEast.p2.pdf

RC_EspEast.p3.pdf

RC_EspWest.p1.pdf

RC_EspWest.p2.pdf

RC_EspWest.p3.pdf

Refined pages 
linked to layers

Colors to 
extract Layer

RC_EngEast.p1.pdf

RC_EngEast.p1.pdf

RC_EngWest.p1.pdf

RC_EspEast.p1.pdf

RC_EspWest.p1.pdf

CMYK

K

K

K

K

Common

EngEast

EngWest

EspEast

EspWest

Model 3 scenario

In this model 3 example, your version plan is the same as in model 1.

Using input file model 3, your refined pages for versioned page one of
the nationwide catalog would be:

CcMcYcKc
+S1S1S1

versions 1, 2, 3

Building versioned pages in model 3

Using model 3, all base and change content for a versioned page are in
one refined page. Therefore, link the refined pages to all layers
including the common layer because a refined page contributes to all
layers.

Tip: To link to all layers at one time, use the Link to Layers dialog box, and select
the All layers option to link a set of refined pages to all layers.

The following figure shows the refined pages to link to versioned page
one.
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Virtual Versioned Page One as 
defined in Version Plan

Generated 
Versioned Page 
One

One layered PDF file

GENERATE
Common

Eng East

Eng West

Esp East

Esp West

RC_Allversions.p1.pdf

RC_Allversions.p2.pdf

RC_Allversions.p3.pdf

Refined pages 
linked to layers

Colors to 
extract Layer

RC_Allversions.p1.pdf

RC_Allversions.p1.pdf

RC_Allversions.p1.pdf

RC_Allversions.p1.pdf

RC_Allversions.p1.pdf

CMYK

Spot East

Spot Eng

Spot Esp

Spot West

Common

East

Eng

Esp

West

Model 4 scenario

In this model 4 example, your version plan is the same as in model 1.

Building versioned pages in model 4

Link all contributing refined pages to the appropriate layer. You can link
the refined files by layer or versioned pages. After linking, generate the
versioned pages. and the versioned pages are ready to proof.

The following figure shows the refined pages to link to versioned page
one.
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Virtual Versioned Page One 
as defined in Version Plan

Generated 
Versioned Page 
One

One layered PDF file

GENERATE
Common

Eng East

Eng West

Esp East

Esp West

RC_Common.p1.pdf

RC_Common.p2.pdf

RC_Common.p3.pdf

RC_East.p1.pdf

RC_East.p2.pdf

RC_East.p3.pdf

RC_Eng.p1.pdf

RC_Eng.p2.pdf

RC_Eng.p3.pdf

RC_Esp.p1.pdf

RC_Esp.p2.pdf

RC_Esp.p3.pdf

RC_West.p1.pdf

RC_West.p2.pdf

RC_West.p3.pdf

Refined pages 
linked to layers

Colors to 
extract Layer

RC_Common.p1.pdf

RC_East.p1.pdf

RC_Eng.p1.pdf

RC_Esp.p1.pdf

RC_West.p1.pdf

CMYK

Spot East

Spot Eng

Spot Esp

Spot West

Common

East

Eng

Esp

West

Model 5 scenario

In this model 5 example, your version plan is the same as in model 1.

Using input file model 5, your refined pages for versioned page one of
the nationwide catalog would be:

CcMcYcKc

RC_common.p1.pdf

Keast+
Keng+
Kesp+
Kwest

RC_versiondata.p1.pdf

Building versioned pages in model 5

Link all contributing refined pages to the appropriate layer. You can link
the refined files by layer or versioned pages. After linking, generate the
versioned pages. and the versioned pages are ready to proof.

Tip: You can link refined pages more quickly if you:

1. Select the refined pages with change content, and in the Link to
Layers dialog box, link to all layers using the All layers option.

2. Select all refined pages in the common layer and unlink them.
3. Select the refined pages with base content, and link to the common

layer.
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The following figure shows the refined pages to link to versioned page
one.

Virtual Versioned Page One as 
defined in Version Plan

Generated 
Versioned 
Page One

One layered PDF file

GENERATE
Common

Eng East

Eng West

Esp East

Esp West

RC_Common.p1.pdf

RC_Common.p2.pdf

RC_Common.p3.pdf

RC_Versiondata.p1.pdf

RC_Versiondata.p2.pdf

RC_Versiondata.p3.pdf

Refined pages linked 
to layers

Colors to 
extract Layer

RC_Common.p1.pdf

RC_Versiondata.p1.pdf

RC_Versiondata.p1.pdf

RC_Versiondata.p1.pdf

RC_Versiondata.p1.pdf

CMYK

Spot East

Spot Eng

Spot Esp

Spot West

Common

East

Eng

Esp

West

Model 6 scenario

In this model 6 example, your version plan is the same as in model 1.

Using input file model 6, your refined page for versioned page one of
the nationwide catalog would be:

One layered PDF file

RC_m6.p1.pdf

base

Keast

Keng

Kesp

Kwest

K

CMYK

K
K
K

Building versioned pages in model 6

Link all contributing refined pages to the appropriate layer. You can link
the refined files by layer or versioned pages. After linking, generate the
versioned pages. and the versioned pages are ready to proof.

Generated 
Versioned 
Page One

One layered PDF file

One layered PDF file

GENERATE
Common

Eng East

Eng West

Esp East

Esp West

RC_m6.p1.pdf

RC_m6.p2.pdf

RC_m6.p3.pdf

Refined pages linked 
to layers

Colors to 
extract Layer

RC_m6.p1.pdf

RC_m6.p1.pdf

RC_m6.p1.pdf

RC_m6.p1.pdf

RC_m6.p1.pdf

CMYK

K

K

K

K

Common

East

Eng

Esp

West

Virtual Versioned Page One as 
defined inVersion Plan
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Model 7 scenario

In this model 7 example, your version plan is the same as in model 1.

Using input file model 7, your refined pages for versioned page one of
the nationwide catalog would be:

One layered PDF file

RC_m7_A_.p1.pdf

base

Keast

KengK

CMYK

K

One layered PDF file

RC_m7_B_.p1.pdf

Kesp

KwestK
K

Building versioned pages in model 7

Link all contributing refined pages to the appropriate layer. You can link
the refined files by layer or versioned pages. After linking, generate the
versioned pages. and the versioned pages are ready to proof.

Virtual Versioned Page One 
as defined in Version Plan

Generated 
Versioned 
Page One

One layered PDF file

One layered PDF file

GENERATE
Common

Eng East

Eng West

Esp East

Esp West

RC_m7_B.p1.pdf

RC_m7_B.p2.pdf

RC_m7_B.p3.pdf

RC_m7_A.p1.pdf

RC_m7_A.p2.pdf

RC_m7_A.p3.pdf

Refined pages 
linked to layers

Colors to 
extract Layer

RC_m7_A.p1.pdf

RC_m7_A.p1.pdf

RC_m7_A.p1.pdf

RC_m7_B.p1.pdf

RC_m7_B.p1.pdf

CMYK

K

K

K

K

Common

East

Eng

Esp

West

Model 8 Scenario

In this model 8 example, your version plan is the same as in model 1.

Using input file model 8, your refined pages for versioned page one of
the nationwide catalog would be:

One layered PDF file

RC_m8_A_.p1.pdf

base

Keast

KengK

CMYK

K

One PDF file

RC_m8_B_.p1.pdf

Kesp

K

One PDF file

RC_m8_C_.p1.pdf

Kwest

K
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Building versioned pages in model 8

Link all contributing refined pages to the appropriate layer. You can link
the refined files by layer or versioned pages. After linking, generate the
versioned pages. and the versioned pages are ready to proof.

Virtual Versioned Page One as 
defined in Version Plan

Generated 
Versioned 
Page One

One layered PDF file

One layered PDF file

GENERATE
Common

Eng East

Eng West

Esp East

Esp West

RC_m8_C.p1.pdf

RC_m8_C.p2.pdf

RC_m8_C.p3.pdf

RC_m8_B.p1.pdf

RC_m8_B.p2.pdf

RC_m8_B.p3.pdf

RC_m8_A.p1.pdf

RC_m8_A.p2.pdf

RC_m8_A.p3.pdf

Refined pages 
linked to layers

Colors to 
extract Layer

RC_m8_A.p1.pdf

RC_m8_A.p1.pdf

RC_m8_A.p1.pdf

RC_m8_B.p1.pdf

RC_m8_C.p1.pdf

CMYK

K

K

K

K

Common

East

Eng

Esp

West

Legacy versioning

About legacy versioning

With legacy versioning, you can layer the base and version pages in
Prinergy Workshop, provided the base and the version information are
separate input files.

Limitations

Legacy versioning has these limitations:

● It cannot trap between layers. It can only overprint layers.
● You must set the separations to overprint before you output the job.

Versioning Imposition Plans

In legacy versioning, separations for a versioning imposition have three
labels: base, common, and unique. You can view the separation labels
in the Common column in the Separations view in Job Manager. For a
description of these labels, see Common in Visible Columns Dialog Box
in Separations View.
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The first versioning imposition plan you import into the job contains
the separations labelled as base. The system compares all separations
in a versioning job against the base separations. You can change this
label as you import a versioning imposition plan.

You can also select a page set from the existing page sets for the job
for a particular import.

Note: If you try to import a new versioning imposition in which the number of
pages does not match the number of pages in the existing page set, the Import
Imposition list is unavailable. To correct this error, regenerate the imposition plan
with the same number of pages as the existing page set.

For more information about legacy versioning, see the Prinergy
Regional Versioning Workflow User Guide.

 Open the Prinergy Regional Versioning Workflow User Guide

For information about the newer system, see About Layered PDF
Versioning.

Note about legacy versioning

During final output for a legacy versioning job, if the version input file
contains spot elements with 0% spot tint and these are placed over
color elements in the input base file, they may incorrectly knock out
underlying colors when the spot is converted to process.

Solutions:

● If the 0% tint spot elements are not required for the final output,
consider removing them from the file before outputting it to a plate.

● If the 0% tint spot elements are required for the final output, use
the imposition output process template to output this file to a Tiff.

● Use the Color Combiner to perform the color mapping. However,
since the Color Combiner cannot be enabled on final output, create
VPS proofs using a final output process template to ensure that the
VPS matches the plate output. If unwanted knockouts appear in the
VPS proofs, either edit the file to remove the objects causing the
knockout or make plates from a Tiff file that was generated using an
imposed proof process template and expose them using Tiff
Downloader.
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Overview of legacy versioning steps

The following steps summarize the sequence for creating and
outputting a legacy versioning job.

1. Create a job.

2. In Job Finder, select the job, and from the Edit menu, select Edit Job
Attributes.

3. Click Legacy Versioning.

4. Set the Max Layers option to the desired number of layers for the
job.

See Edit/Set Job Attributes Dialog Box.

5. Prepare the base and version input files.

6. Open the job in Job Manager, and add the base and version input
files.

7. Process the base and version input files using a refine process
template that generates thumbnails.

8. Import a versioning imposition plan and specify the number of
versions.

● To use an existing page set, see Importing Versioning
Impositions and Use Existing Page Sets

● To also import an existing page set at the same time, see Import
a Versioning Imposition

9. Select the pages you want as the base layer and assign these pages
to page set positions.

These first pages are assigned to the bottommost layer.

10. Select the pages you want as overlay pages and assign these pages
to page set positions.

(If assigning pages using a menu item, choose the Print Over
Previous Assignments option.) The overlay page is layered on the
base.

While assigning pages to page set positions, you can add layers
over and under the base layer using different options. See Assign
Pages to Page Set Position Dialog Box.

View the assigned layers in the Page column in either the:

● Page Sets pane in Pages view
● Imposition Plans pane in Signatures view

11. If required, reorder page assignments or unassign pages.

12. If required, copy these page assignments to other imposition plans.
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13. Output the versioned separations:

● without the Common separations
● with or without the Common separations
● with the Common separations

The system outputs the layered pages as one surface.

Preparing the base and version input files

○ Save the input files for the base and version (overlay) layers of a
legacy versioning job in separate PostScript files.

○ To prepare a varnish layer, use a layering plug-in such as ALAP
Xpert Layers to place the varnish objects in a separate PostScript
file. You should have two PostScript files: the base file and the
varnish file.

○ To add text to a copydot scan, create the required text in
QuarkXPress, then output the text to a PostScript file. You should
have two PostScript files: the copydot file and the text file.

Importing versioning impositions

Use this procedure when you have not yet created page sets in your
legacy versioning job.

1. From the File menu, select Import Versioning Imposition.

2. In the Import Versioning Imposition dialog box, in the Select a file
to use for the imposition box, navigate to and select the versioning
imposition plan you want to import.

Information about the selected file appears in the box on the right
side of the dialog box.

3. Click Auto Name.

4. In the Enter Number of Version dialog box, in the Please enter the
base name for these versions box, type in the base name.

5. In the Please enter the number of versions to create box, type the
number of versions, then click OK.

6. You can rename any of the new versioning imposition names if you
desire by selecting a name, then clicking Rename.

7. Click Import.

8. In the Start Process dialog box, click OK.

Prinergy imports the versioning imposition plan into the job. After the
import processing is completed, the Page Sets pane displays the
versions.
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Importing versioning impositions and use existing page sets

Use this procedure when page sets already exist and pages have been
assigned in your legacy versioning job.

1. Delete the imposition plans for all versions.

Leave the pages assigned to the page sets.

2. From the File menu, select Import Versioning Imposition.

3. In the Import Versioning Imposition dialog box, in the Select a file
to use for the imposition box, navigate to and select the versioning
imposition plan you want to import.

The new imposition plan must have the same number of pages as
the replaced versioning imposition plan.

4. To use existing page sets, click Existing Page Sets.

5. In the Select Page Set dialog box, select the existing page sets you
want to use.

You can choose some or all.

6. (Optional) In Imposition suffix, enter a suffix that will help identify
that this is the new imposition plan for an existing page set.

7. Click Import.

8. If you want to rename any of the new version names:

a. In the Import Versioning Imposition dialog box, select a name,
and click Rename.

b. In the Enter New Version Name dialog box, enter the new name,
and click OK.

The page set name cannot be changed because the page set
already exists.

9. Click Import.

Prinergy imports the versioning imposition plan into the job. In the
Signatures view, the new imposition plan for each version appears.
The existing page sets and page assignments are retained.

10. Select the signature.

11. From the Edit menu, click Set Initial Separations.

This populates the separations information for the impositions. Any
previous color mappings from the original imposition made using
the Color Separations dialog box are not retained.
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Copying source page assignments to other imposition plans

Once you have built up the layers needed in version 1 of the legacy
versioning job, copy these layers to the other versions.

1. In the Page Sets pane of the Pages view, select the page positions
you wish to copy.

2. From the Edit menu, select Copy Page Assignments.

3. In the Copy Assignments Positions box, select the layer you wish
to copy from the source page set.

You can select some or all layers at once. Examples of layers
include: Base Page, Overlay Page 1, and so on.

4. In the To Page Sets box, select the version page set to copy the
page assignments to.

Tip: Ctrl-click to select more than one destination page set.

For each source page set selected, the page assignments are copied
over to the corresponding page positions in the destination page
set. If there is an existing page assignment for that page and layer
in the destination page set, the existing page assignment will be
overwritten. If a particular source page does not have an
assignment for a selected layer, then the corresponding assignment
in the destination page will be removed.

When seen in Thumbnail view, the layered page positions display a
large, black V.

5. Assign the overlay files to their page positions.

6. If required, reorder page assignments or unassign pages.

Reordering page layers

This feature lets you determine the printing order of the versioned PDF
pages in the page set position of a legacy versioning job.

1. In the Pages Sets pane of the Pages view in Job Manager, select a
versioned position.

2. From the Edit menu, select Reorder Page Assignments.

3. In the Reorder Page Assignment dialog box, select a PDF page.

4. Click Move Up or Move Down to change the PDF to the desired
position.

Note: The PDFs at the top of the list print first.

Enter Number of Versions dialog box

Use this dialog box to specify the number of versions in a legacy
versioning job.
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Please enter the base name for these versions

Type the base name for the imposition plan.

Please enter the number of versions to create

Type the number of versions you want to create for this
imposition plan.

Import Versioning Imposition dialog box

Use this dialog box to import impositions into a legacy versioning job.

Select a file to use for the imposition

Use this box to locate and select the imposition plan that you
want to import.

Information about the selected imposition plan appears in the
right pane of the dialog box.

Files of Type

Select an option to filter the files that are displayed in the Select
a file to use for the imposition section by a specific file type.
Only files of the selected type are displayed.

Options are:

● All Eligible Files
● All Files
● Portable Job Ticket File (JT or PJTF)
● Job Definition File (JDF or XML)

By default, All Eligible Files is selected. An eligible file is any file
of the .pjtf, .icf, or .job type.

Show Hidden Files

Select this option to display hidden files such as system files, in
the Select a file to use for the imposition section.

The default selection of this option can be set in the View tab of
the Workshop Preferences dialog box.

Volumes

Displays accessible input volumes as defined in Administration
Console. If the input volume that you want does not appear, you
must add it to Administrator.

Job Folder

Opens the job folder for the current job.

1028 Chapter 19—Versions



Import

This button appears as Open when an input volume or folder is
selected. Click this button to open the selected volume or
folder.

This button appears as Import once an eligible imposition plan
has been selected. Click this button to import the selected
imposition plan.

Versions

Select

Click this button to open the Choose Process Template dialog
box, where you can change the import process template that
controls the current import.

Page set starting page #

Specifies the number at which you want the page set to begin.

Imposition name and Page set name

Lists the names of the versioning imposition plans and page
sets that you are importing. This list is empty until you either:

● Click Auto Name and enter the base name and the number
of versions

● Under New Version Names, type a version name and click
Add Name.

Once this list populates, you can rename any of the imposition
plans and page sets by selecting the item and clicking Rename.
Enter the new names in the Enter New Version Name dialog
box.

To remove a versioning imposition plan and page set from the
list, select the item and click Remove.

Auto Name

Click the Auto Name button to open the Enter Number of
Versions dialog. Type the base name and the number of
versions to create. The list of imposition plan names appears in
the box.

Existing page sets

Click the Existing Page Sets button to display the Select Page
Set dialog. Select one or more page sets for the job and add an
imposition name suffix.
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Rename

Opens the Enter New Version Name dialog, enabling you to
rename either the imposition plan name or the page set name,
or both.

Remove Version

Enables you to remove an imposition plan and page set from
the list. Select an imposition plan, and click Remove Version.

New Version Names

Lets you manually name the imposition plan and page sets
(both will have the same name). In the New Version Names
box, type a name, then click Add Names.

Add Names

Adds the name you typed in the New Version Namesbox to the
list of imposition plans and page sets.

Reorder Page Assignments dialog box

Use this dialog box to reorder page assignments in a legacy versioning
job.

list

Lists the pages assigned to the selected position, and their
order determine the order in which they will be printed. This
feature is designed for versioning.

Pages at the top of the list print over pages at the bottom.

Move Up

Moves the selected page higher in the list.

The pages at the top of the list print over pages at the bottom.

The button is available only when the list contains more than
one page.

Move Down

Moves the selected page lower in the list.

The pages at the top of the list print over pages at the bottom.

The button is available only when the list contains more than
one page.
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Select Page Set dialog box

Use this dialog box to select a page set in a legacy versioning job.

list

Lists the job's existing page sets. Select a page set from the list
and add a suffix to distinguish it from the original page set.

Imposition suffix

Type a suffix to distinguish the new page set from the existing
page set.

Outputting versioned separations

In a legacy versioning job, the separations for a versioned imposition
have three labels: Base, Common, and Unique.

For a description of these labels, see Common in the Visible Columns
dialog box in Separations View topic. You can view these labels in the
Common column in the Separations view in Job Manager. See
Displaying and Hiding Columns.

1. In the Separations view in Job Manager, select a signature.

2. From the Job menu, select Identify Common Separations.

3. In the Common column, perform one of the following actions:

To Output This Do This

Without common
separations

Select the separations labelled Base and
Unique, and clear the separations labelled
Common.

Only common
separations

Select the separations labelled Common that
you want to output.

Note: The separations labelled Common are grayed-out to help you locate
them.

You are ready to generate output.

Tip: You can also control whether output has common separations while you
generate the output. When you start an output process template, a warning
dialog box asks you to confirm that you want to output the common
separations.

Select Page Set dialog box 1031



1032 Chapter 19—Versions



20Customization

About customizing Workshop
You can customize the display of Prinergy Workshop windows and
panes by doing any of the following:

● Displaying and Hiding Columns

Most windows and panes have several columns, such as file size and
type. You control which columns to display for a particular pane
using the Visible Columns dialog box. The columns available vary
among windows, panes, and views.

● Sorting by Column

You can sort the items in a window or pane by a column by clicking a
column header. A cone symbol indicates the currently selected
column and whether items are sorted in  ascending order (1 to 10)

 descending order (10 to 1).
● Displaying Thumbnails

You can view thumbnails of pages and pages sets in the Pages view
and of imposition plans and the pages assigned to those imposition
plans in the Signatures view.

Note: If a thumbnail with a ? mark appears, the volume where the job is stored
is not mounted or the job has been purged from disk. If the volume is not
mounted, you must close the job, mount the volume, and reopen the job. If the
job has been purged, you must retrieve it.

● Expanding and Collapsing All Items

Some Prinergy Workshop views and panes enable you to expand or
collapse all of their content at once. For example, you can expand all
of the actions in the History view of Job Manager to display all of the
details for all actions. Or you can expand or collapse the content of
the Process Templates in Job Manager to hide or display all of the
process templates.

● Setting Workshop Preferences

You can customize how information is displayed whenever you are
logged in by setting preferences. Preferences files are saved by logon
ID on the client computer, so your individual preferences are
preserved even if you share a client computer with other operators.
If you use more than one client computer, a unique preferences file
is saved on each computer.



Displaying and hiding columns

1. Select the window or pane that you want to change.

2. Select View > Visible Columns.

Tip: You can also right-click a blank area of the window or pane and select
Visible Columns.

3. In the Visible Columns dialog box, select the check boxes for the
columns that you want to display and clear the check boxes for the
columns that you want to hide.

Note: The columns that are unavailable are always displayed.

Tip: Use the Select All and Deselect All buttons if you must select or clear a
large number of check boxes.

4. Click OK.

5. If you are in thumbnail view, you must display list view to see
columns.

The window or pane is updated to display and hide the columns that
you indicated. Newly displayed columns appear at the right side of the
window or pane. You can move columns and sort items by column.

Moving columns

1. If you are in Thumbnail view, you need to display List view to see
columns.

2. Click the heading of a column and drag it to a new position.

Sorting items by column
You can sort the items listed in most windows and panes.

1. If you are in Thumbnail view, you need to display List view to see
columns.

2. Click the heading of the column that you want to sort by.

A cone symbol appears in the column heading indicating that the
list is now being sorted by that column, in either:

● Ascending order (1 to 10) 
● Descending order (10 to 1) 

If the cone symbol does not appear, you cannot sort by that
column.
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3. To switch between ascending and descending order, click the
column heading again.

Displaying lists or thumbnails
You can also control thumbnail display by setting Prinergy Workshop
preferences.

To alternate between List and Thumbnail view, perform one of the
following actions:

○ From the View menu, select as Thumbnails or as List.
○ Right-click a blank area of the window and select as List or as

Thumbnails.

Expanding and collapsing all items in a view or pane
Many views and panes have items that are grouped. In these views and
panes, you can expand the groups to see all items, or collapse the
items to see only the groups.

1. Select the view or pane.

2. From the View menu, select Expand All or Collapse All as desired.

Tip: You can also right-click the view or pane, and select Expand All or
Collapse All.

Setting Workshop preferences

1.
On a Windows-based client: In Job Finder or Job Manager, select
Edit > Preferences.

On a Macintosh client: Select Workshop > Preferences.

2. In the Prinergy Workshop Preferences dialog box, set the options.

3. Click OK.

Prinergy Workshop settings are changed as indicated. If you changed
options in the Workshop Preferences dialog box that were marked with
an asterisk (*), you must restart Prinergy Workshop to activate your
selections.
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Overriding the default mode (Connect or Powerpack)
on a client

By default, new Prinergy systems are shipped as Prinergy Connect
systems. If you want to run a Workshop client computer in Powerpack
mode—for example, because your Prinergy server was modified to run
in Powerpack mode, or your site does a mix of commercial and
packaging work—you must complete the following steps to override
the default Workshop mode on the client.

1.
On a Windows-based client: In Job Finder or Job Manager, select
Edit > Preferences.

On a Macintosh client: Select Workshop > Preferences.

2. Click the General tab.

3. In the Product list, select Connect or Powerpack, and click OK.

4. Restart Workshop.

After setting this preference, if you want Workshop to match the mode
of the Prinergy server, in the Preferences dialog box, click Set to
Defaults.

Workshop Preferences dialog box
Note: Options marked with an asterisk (*) in the dialog box require you to restart
Prinergy Workshop before they take effect.

Startup Tab

Go to Separations View When Opening Job Manager

Displays the Separations view when a job is opened in Job
Manager. If this option is cleared, the Pages view displays by
default.

Displaying the Separations view is recommended if you spend
most of your time working in the Separations view (for
example, if your primary activity is plate or film making).

Restore Last Group Expansion in Job Finder at Login

Select this option to open all groups in Job Finder that were
open when you last quit Prinergy Workshop.

Clear this option to close all groups in Job Finder when you start
Prinergy Workshop.
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This preference does not take effect until after you restart
Prinergy Workshop.

General Tab

Workshop Language

Indicates the language in which Prinergy Workshop runs. You
can choose to run Prinergy Workshop in the same language as
your operating system, or in one of the other languages offered.

This preference does not take effect until after you restart
Prinergy Workshop.

Product

If you want Workshop to override the default mode—Connect
versus Powerpack—of the server, select an option in this list.
The setting affects terminology in the Workshop user interface
and user guide. In Connect mode, you see terms for commercial
printing, such as "page" and "signature". In Powerpack mode,
you see terms for packaging printing, such as "1-up artwork"
and "step and repeat".

PDF Color Name Encoding

Select the encoding for displaying color names. Options are ISO
Latin 1, UTF-8, and Local System Default. The default is ISO
Latin 1.

The color names are displayed using the selected encoding as
soon as you close the dialog box. Color names that you
manually add to the color database by typing a color name are
encoded using the selected encoding.

This feature was added to improve support for Japanese and
Asian languages.

Refresh Queue Manager Every

Determines how often the display is refreshed in the Active
Processes pane in Job Manager, and in the View pane in the
Queue Manager. The default refresh rate is every 10 seconds.

A less frequent setting reduces network traffic, but decreases
the currency of the information displayed.

Maximum Number of Info Windows Displayed

Restricts the number of items for which you can display info
windows. Opening a large number of info windows at the same
time may have a negative impact on performance.
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Show Process Info Window When Process Is Created

Displays the Process Info dialog box when you initiate a process
from Job Manager.

If cleared, you can still display the Process Info dialog box for an
active process by double-clicking the process in the Processes
pane.

Use Job Favorites As Default

In the Process Templates pane, displays the Job tab by default
when a job is opened.

Automatically Add Templates Used for Processing to Job Favorites

Select this option to make the Add Process Template to Job
Favorites check box selected by default each time you open the
Start Process dialog box. Selecting the Add Process Template
to Job Favorites check box adds the process template the Job
tab of the Process Templates pane after you start the process.

Save Window, Column, and View Options

Saves Prinergy Workshop customizations when Prinergy
Workshop is closed. Customizations may include size and
position of windows, size and order of columns, which columns
are displayed, viewing as list or thumbnails, and use of grouping
buttons.

Show Not Licensed Dialogs

Displays dialog boxes for unlicensed features even though you
cannot use the features. You must purchase a license key to
unlock features that you do not have.

Show Confirmation Dialogs for All Deletes

Displays a warning dialog box when you delete an element, with
the options to Continue or Cancel the delete menu item.

View tab

Display Processing Panel on the Left

Select this check box to display the Process Templates pane
and the Processes pane on the left side of the Job Manager
window. Clear this check box to display these panes on the right
side of the Job Manager window.

This preference does not take effect until after you restart
Prinergy Workshop.
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Display Page Sets in Reader Spreads

Joins facing page positions in pairs to emulate reader spreads
(for example 1, 2-3, 4-5, and so on).

Applies only when displaying as thumbnails.

If cleared, all positions are displayed individually rather than as
pairs.

This preference does not take effect until after you restart
Prinergy Workshop.

Show Hidden Files in File Browser

Displays hidden files such as system files in lists, for example, in
the Add Input Files dialog box.

Use Large Icons for View Selection Buttons

Select this option to display the buttons across the top of Job
Finder and Job Manager as large icons instead of small ones.

In Job Finder, the buttons are Jobs and Pre-Jobs.

In Job Manager, the buttons are:

● Pages
● Signatures
● Separations
● Storage
● History

This preference does not take effect until after you restart
Prinergy Workshop.

Automatically Add Dynamic Columns to Table Views

Select this check box to automatically add dynamic columns to
list views in a pane when an element is being processed. If this
check box is cleared, dynamic columns are not automatically
added. You can add to the information that is displayed in a
pane by selecting an option from the Visible Columns dialog
box.

By default, this preference is enabled when Prinergy Workshop
is installed. If you change this preference, it does not take effect
until after you restart Prinergy Workshop.

Measurement Unit

Indicates the unit used to display measurement information in
windows and dialog boxes. Options are:
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● Point (pt)
● Millimeter (mm)
● Centimeter (cm)
● Inch (in)

If you change this setting, the new measurement unit appears
the next time you display a dialog box or refresh a window.

Application Font

Indicates the font and font size used to display information.

This preference does not take effect until after you restart
Prinergy Workshop.

Display Large Thumbnails

Displays thumbnails that are larger than the default size.

This preference does not take effect until after you restart
Prinergy Workshop.

Use Default (Blank) Thumbnails

Displays generic thumbnails for pages and page positions.

With this option selected, you can drag-and-drop pages to page
positions without the potential performance impact of real
thumbnail images.

Use this option only in the following situations:

● Large jobs in which displaying all generated thumbnails may
decrease performance

● Jobs where the page content is similar and thumbnails don't
help to distinguish pages, such as textual pages.

This preference does not take effect until after you restart
Prinergy Workshop.

Show an Even Number of Thumbnails Per Row in All Page Views

Displays thumbnails in rows containing an even number of
thumbnails.

This option works in conjunction with Display Page Sets in
Reader Spreads Display. If reader spreads are displayed,
thumbnails are displayed in even numbers of reader spreads,
rather than as individual pages.

This preference does not take effect until after you restart
Prinergy Workshop.
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Set to Defaults

Returns settings for all preferences to the system defaults. Does
not apply to the Configure Digital Print Application tab.

Visible Columns dialog box in History view

Description

A short description of the action taken. For each action, the
description includes a number at the end of the text indicating
the number of detail items listed for that action. You can
expand an action to view its details.

User Name

The logon name of the user who initiated the action.

Time

The date and time that the action or process was initiated.

Severity

Indicates whether the message is for information only, or is an
error or warning.

Visible Columns dialog box in Imposition Plans pane

Name

The name of the element.

For a page, the name is in the form of <input file
name>.<page #>.p.

Page

When the hierarchy is opened to display individual positions,
this column displays the file name that is assigned to each
position.

On the rows that contain information other than positions, this
column indicates the number of positions in the surface that
have files assigned to them—for example, 4 of 4 Assigned.

Assignment Count

Displays the number of pages assigned to the page position
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Workstyle

The workstyle as specified by the imposition plan—for example,
Sheetwise.

Page Set

The name of the page set to which the imposition plan is linked.

Web Growth Profile Name

Any web growth profile associated with the signature, sheet, or
surface.

A web growth profile is an XML file used to digitally
compensate for press distortion.

Web Growth Profile Path

The location of any web growth profile associated with the
signature, sheet, or surface.

Note: If a web growth profile is specified in Job Manager, this overrides
any web growth profile that is defined for the process template.

Center Page

Indicates whether the page is centered.

Offset

The horizontal and vertical adjustments made to the page from
the lower-left corner.

This column appears in the Signatures pane and the Pages
pane.

If the page is not centered, the value is the same in both panes.

If the page is centered, the value in the Signatures pane is the
difference between the Media Size and the Trim Size.

The unit of measure is specified in the Workshop Preferences
dialog box.

Trim Size

The horizontal and vertical measurements to which the page
will be cut. The trim size is determined by the page position to
which the page is assigned.

If the file is not a PDF file, the value is N/A.

The unit of measure is specified in the Workshop Preferences
dialog box.
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<process template>

The name of the process template group that was used to
process the file and the processing status.

This column automatically appears in these panes:

● Input Files pane when an input file is processed
● Pages pane when a page is processed
● Imposition Plans pane when a surface is processed

This is known as a dynamic column. More than one dynamic
column may appear if more than one process template is used.

<custom field> (more than one may be visible)

Any custom fields that were created for this job element with
the Show in Workshop check box selected

Visible Columns dialog box in Input Files pane

Primary File

The name of the input file

# Files

The number of input files in the row

Size

The size of the file.

The file size is listed in KB if the file is less than 1 MB, or in MB if
the file is 1 MB or more.

If it is not a PDF file, the value is N/A.

Modified

The date and time that the file was last modified

Created

The date and time that the file was created

Kind

The file type—for example, Layered PDF, PostScript or PDF

Location

The path to the file
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<process template>

The name of the process template group that was used to
process the file and the processing status.

This column automatically appears in these panes:

● Input Files pane when an input file is processed
● Pages pane when a page is processed
● Imposition Plans pane when a surface is processed

This is known as a dynamic column. More than one dynamic
column may appear if more than one process template is used.

Visible Columns dialog box in Job Finder
Note: Displaying more columns reduces Job Finder performance.

Name

The name of the job, pre-job, or group. This column cannot be
hidden.

Custom fields that you create for a job or job element can also be
displayed. See Custom Fields Manager.

Fastest Columns

Job Alias

The alias of jobs in your system. For systems where the job
name is a number, the job alias provides the meaningful job
name. Job Alias corresponds to Job Description in InSite
Prepress Portal. If you change the job alias in Prinergy, the job
description in InSite Prepress Portal is changed.

Kind

Indicates whether the item is a job, pre-job, or group.

Job Status

The status of the job. When a job is created, its status is set to
In Prepress.

You can change a job's status in the Edit Job Attributes dialog
box. The following statuses are available:

● Created
● In Prepress
● On Press
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● Shipped
● Completed
● Ready for Final Output
● Completed Final Output

If the job is enabled for Web access through Prepress Portal,
the following additional statuses are available:

● In Cart
● Pending Order Approval
● Order Requested
● Order Accepted
● Order Rejected

Select Enable Press Side Proofing if the workflow includes the
Kodak PressProof software.

Job Home

The full path name for the job folder location.

Created

The date and time when you created the job or pre-job.

Job Code

A job code that you specify. The job code can be anything that
is meaningful to you or to your customer.

The job code is:

● Available to an imposition job ticket
● Available as a variable mark on the job's output
● Exported with a job
● Included in CIP3 files when Prinergy generates CIP3 files

during final output

The job code also appears in Prepress Portal, if the job is
enabled for Web access through Prepress Portal. If you change
the job code in Prinergy, the job code in PrePress Portal is
changed.

Proof Due

The date and time that the proofs for the job are due. This
information is set in the Edit Job Attributes dialog box.

Final Output Due

The date and time that the final output for the job is due. This
information is set in the Edit Job Attributes dialog box.
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Web Access Customer

The name of the customer for whom you have enabled web
access. This information is set in the Edit Job Attributes dialog
box.

Less Fast Columns

Online

Indicates whether a job is fully or partially Offline or Online.

Offline indicates that no files in the job's job folder exist on the
job home server. Files from outside the job folder may still be
online. When you fully purge a job, its status is Offline since
purging removes all files in the job folder from the job home
server.

Online indicates that at least one file for the job is on the job
home server.

If this column is blank, the status of the job is not known.

Max Layers

The maximum number of pages that you can assign to one page
position. This information is set in the Edit Job Attributes dialog
box and only applies to legacy versioning jobs.

Pages Approved

The number of approved pages, over the total number of pages
in the job.

Errors/Warnings

Displays the most important error or warning status from the
most recent processes in the Processes pane of Job Manager.

Full Surfaces

The number of surfaces for which all positions have pages
assigned, over the total number of surfaces in the job.

Final Output Count

The number of separations you have output using a final output
process template, over the total number of separations in the
job.

Last Final Output

Date and time the last separation was output using a final
output process template.
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Last Archived

The date and time that someone last archived the job.

Slowest Columns

Archive Status

The quantity of files in the job that you have archived at any
time. Possible statuses are:

● None: The job has not been archived.
● Some: Some but not all files in the job were archived. This

can occur when you:

○ Archive only selected files, not the whole job
○ Archive the job, and then add one or more files to the job,

for example, by adding input or processing an input file
that had not been processed before the archive

○ Change one or more of the archived files, for example by
processing it again

● All: The job was archived and no changes have been made to
any files in the job.

Stale Archive Status

The quantity (All Some, or None) of files in the job that have
changed since the last archive.

Columns marked with an asterisk (*) will not refresh automatically.
You must manually refresh the Job Finder to update these fields.

The columns available for display are the same in both the Jobs and
Pre-Jobs views.

Visible Columns dialog box in Media Manager
The options in this dialog box depend on which pane you selected
before displaying the dialog box.

In the Pools Pane

Name

Lists all of the media pools and disk volumes in your system.
These include the media pools that appear in the Removable
Storage Manager and any disk volumes that your Prinergy
administrator has set up.
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Number of Media

The number of media in the media pool—for example, a media
pool may contain five tapes.

Media Type

The type of media in the media pool. Archiver supports the
following media types:

● AIT (Advanced Intelligent Tape) tapes
● LTO (Linear Tape-Open) tapes
● Disk (archive disk volumes)

In the Media Pane

Name

The name of the physical medium. This name will be the same
as the name of the medium in Removable Storage Manager or
wiill be the name of the archive disk volume.

Location

Where the medium is located. This can be a tape library, a
stand-alone tape drive, or an offline location.

Pool

The name of the media pool to which the medium belongs.

Type

The type of media in the media pool. Archiver supports the
following media types:

● AIT (Advanced Intelligent Tape) tapes
● LTO (Linear Tape-Open) tapes
● Disk (archive disk volumes)

Created

The date that Archiver first wrote to the medium.

Last Modified

The date and time that Archiver last wrote to the medium.

Free Space

The estimated amount of unused space in the partition.
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Used Space

The sum of all the archives on this medium. The used space is
calculated based on the original size of the files on disk. The
Used Space amount can be more than the Partition Capacity if
the files have been compressed. This value does not account for
the space consumed to format the data onto tape—that is, it
will underestimate the amount of data actually on tape.

Partition Capacity

The total size of the partition (uncompressed or native).

Partition State

The logical state of the partition on the medium. Possible states
are:

● Allocated
● Available
● Complete
● Import
● New

For more information about partition and media states, see the
Prinergy System Administration guide or the Removable
Storage Manager guide.

Media State

The physical state of the medium. Possible states are:

● Idle
● In Use
● Loaded
● Mounted
● Waiting for an Operator Request

Format

The format of the tape medium. This information comes
directly from Removable Storage Manager. Formats include:

● Creo (MTF)
● Creo (Prinergy)
● RSM Free Label
● WindowsBackup (MTF)
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Visible Columns dialog box in Page Sets pane

Page Position

The page position number is a combination of the page set
prefix and the position number (both user-definable).

You define the prefix when you create a page set or add an
imposition plan to a job.

A value appears only if the page has been assigned to a page
position on a page set.

Page

When the hierarchy is opened to display individual positions,
this column displays the file name that is assigned to each
position.

On the rows that contain information other than positions, this
column indicates the number of positions in the surface that
have files assigned to them—for example, 4 of 4 Assigned.

Assignment Count

Displays the number of pages assigned to the page position

Layered Page Number

Applies to the Layered PDF Versioning feature, which is
currently under development. For more information, contact
your sales representative.

<custom field> (more than one may be visible)

Any custom fields that were created for this job element with
the Show in Workshop check box selected

Visible Columns dialog box in Pages pane

Page

The page name in the form of <input file name>.<page #>.p.

Page Position

The page position number is a combination of the page set
prefix and the position number (both user-definable).

You define the prefix when you create a page set or add an
imposition plan to a job.
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A value appears only if the page has been assigned to a page
position on a page set.

Surface

The name of the surface and signature to which the page is
assigned. For example, if the page is assigned to the front
surface of Signature 1, the Surface column displays A Front 1.

This column is available only in the Pages pane of the
Signatures view.

Input File

The name of the input file from which the page was created

Date Refined

The date and time that the page was created

Page File Location

The path to the page file

Size

The size of the file.

The file size is listed in KB if the file is less than 1 MB, or in MB if
the file is 1 MB or more.

If it is not a PDF file, the value is N/A.

Preflight Report

Indicates whether a PDF Preflight report has been generated for
the PDF page, or whether it is not available.

Ordinal Number

The page number in a multi-page file that this page represents

Versioned Page Status

This is part of Layered PDF Versioning. For information about it,
see the Prinergy Layered PDF Versioning User Guide.

Page Colors

The process and spot colors in the page

Composite

Indicates whether the page is composite.

A composite file is not divided into color separations.
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Customer Approval

The approval status of the page. These are the possible
approval statuses:

● Approval not Required
● Approval Requested
● Approval in Progress
● Waiting for Correction
● Approved
● Rejected

Media Size

The width and height of the media box of the PDF file.

The unit of measure is specified in the Workshop Preferences
dialog box.

Trim Size

The horizontal and vertical measurements to which the page
will be cut. The trim size is determined by the page position to
which the page is assigned.

If the file is not a PDF file, the value is N/A.

The unit of measure is specified in the Workshop Preferences
dialog box.

Offset

The horizontal and vertical adjustments made to the page from
the lower-left corner.

This column appears in the Signatures pane and the Pages
pane.

If the page is not centered, the value is the same in both panes.

If the page is centered, the value in the Signatures pane is the
difference between the Media Size and the Trim Size.

The unit of measure is specified in the Workshop Preferences
dialog box.

Scale (%)

The horizontal and vertical scale measurement of the page, as a
percentage of the page's original size.

If the file is not a PDF file, the scale appears as N/A.
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Orientation (°)

The number of degrees that the page is rotated.

Select from 0, 90 CW (clockwise), 180, and 90 CCW (counter-
clockwise).

If the file is not a PDF file, the orientation appears as N/A.

<process template>

The name of the process template group that was used to
process the file and the processing status.

This column automatically appears in these panes:

● Input Files pane when an input file is processed
● Pages pane when a page is processed
● Imposition Plans pane when a surface is processed

This is known as a dynamic column. More than one dynamic
column may appear if more than one process template is used.

<custom field> (more than one may be visible)

Any custom fields that were created for this job element with
the Show in Workshop check box selected

Visible Columns dialog box in Queue Manager
The options in this dialog box depend on which view you were in before
displaying the dialog box:

In the JTP Queues View

Name

Displays the name of the process, the status of the process
using status icons, and the icon for the process template group
to which the process belongs.

Queue Position

A number representing the position of the process in the queue.
When processes include multiple files, a range of position
numbers is shown, representing the position of the first and last
files.

Priority

See Select Task Priority dialob box.
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Job

The name of the job with which the process is associated.

User

The logon ID of the user who initiated the process.

Submitted (at)

The date and time that the process was initiated.

Process Template

The name of the process template used to initiate the process.

Process Template Group

The group to which the process template used to initiate the
process belongs.

Type

The process template type for this process, for example,
Archive, Retrieve, or Purge.

Status / Process Status

The status of the process, for example, Queued, Active, or
Ended.

Elements

The number and type of elements that are inputs to the
process.

In the Process Types View

Name

Displays the name of the process, the status of the process
using status icons, and the icon for the process template group
to which the process belongs.

Priority

See Select Task Priority dialob box.

Job

The name of the job with which the process is associated.

User

The logon ID of the user who initiated the process.
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Submitted (at)

The date and time that the process was initiated.

Started (at)

The date and time that the JTP (job ticket processor) began
executing the process.

Process Template

The name of the process template used to initiate the process.

Process Template Group

The group to which the process template used to initiate the
process belongs.

Status / Process Status

The status of the process, for example, Queued, Active, or
Ended.

Elements

The number and type of elements that are inputs to the
process.

Visible Columns dialog box in Separations view

Name

The name of the element.

For a page, the name is in the form of <input file
name>.<page #>.p.

Page Assignments

Indicates the number of page positions in the signature or
surface that have pages assigned to them—for example, 4 of 4
Assigned.

Workstyle

The workstyle as specified by the imposition plan—for example,
Sheetwise.

Page Set

The name of the page set to which the imposition plan is linked.
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Common

Labels a separation in a versioning job as Base, Common,
Unique, or Not Identified.

● Base identifies the separations in the first imposition plan
you imported into the job.

● Common identifies the separations you use in each of the
versioning impositions. These are the separations that stay
the same for each version. Common separations are
duplicates of the base separations. For this reason, common
separations are grayed-out, indicating you don't need to
output them, because you will output the base separations.

● Unique identifies the separations for which you have more
than one version-that is, the separations that differ for each
version.

● Not Identified indicates the Common column is
unpopulated. To populate the column, from the Job menu,
select Identify Common Separations.

Note: When outputting separations for a versioning job, you output the
bold separations (the base and unique separations); you don't output the
grayed-out separations (the common separations).

Web Growth Profile Name

Displays the name of the web growth profile, if one is selected.

Web Growth Profile Path

Displays the path to the web growth profile, if one is selected.

Content

Displays the kind of content a separation contains:

● Has Page Content indicates the separation contains page
information.

● Mark Content Only indicates the separation has marks only.
● Empty indicates the separation has no page information and

no marks.

<process template>

The name of the process template group that was used to
process the file and the processing status.

This column automatically appears in these panes:

● Input Files pane when an input file is processed
● Pages pane when a page is processed
● Imposition Plans pane when a surface is processed
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This is known as a dynamic column. More than one dynamic
column may appear if more than one process template is used.

<custom field> (more than one may be visible)

Any custom fields that were created for this job element with
the Show in Workshop check box selected

The columns you see depend on the columns you display or hide.

Visible Columns dialog box in Storage view

Primary File

The name of the element.

# Files

The number of files associated with the primary file.

Size

The size of the file.

The file size is listed in KB if the file is less than 1 MB, or in MB if
the file is 1 MB or more.

If it is not a PDF file, the value is N/A.

Modified

The date and time that the file was last modified

Created

The date and time that the file was created

Description

The file type and how it is used in Prinergy. For example, PDF
Input File, PostScript Input File, PDF Page, or Imposition Plan.

Last Archived

The date and time that someone last archived the job.

Location

The path to the file
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Archive State

The archive state of the file. Possible states are:

● Online and Never Archived: The file has never been
archived, purged, or retrieved.

● Online and Currently Archived: The file has been archived,
but has not been purged or retrieved.

● Offline: The file has been purged. (It also had to be archived
before the purge, or the purging would not occur.)

● Online and Previously Archived: The file has been changed
since it was archived, and has not been archived since it was
changed.

● Missing: The file is not on the file system, and it has not
been archived. It also has not been purged because purging
deletes files only if they have been archived. Therefore, an
action other than purging deleted the file.

A job's Stale Archive Status is connected to the Archive State
of its files.

● If the Archive State of all files in a job is Online and Never
Archived or Online and Currently Archived, the job's Stale
Archive Status is None Stale.

● If the Archive State of some files is Online and Previously
Archived, the job's Stale Archive Status is Some Stale.

Visible Columns dialog box in System History

Description

A short description of the action taken. For each action, the
description includes a number at the end of the text indicating
the number of detail items listed for that action. You can
expand an action to view its details.

User Name

The logon name of the user who initiated the action.

Time

The date and time that the action or process was initiated.

Severity

Indicates whether the message is for information only, or is an
error or warning.
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21 Integrated products

Preps

Preps integration options
Prinergy offers two options for integrating the Preps imposition
software: Full Access and Automated Imposition.

Full access Preps integration option

The full access option enables you to start Preps from within Prinergy
Workshop, and to have the full functionality of your licensed Preps
(Preps Pro or Preps Plus, floating license or dongle).

With this option, you can create, edit, and export impositions from
Preps and import them into Prinergy for use in Prinergy jobs. You can
also create and edit a Preps template. You can import the following files
into a Prinergy job:

● Preps 5.1 and later job files
● PJTF and JDF files
● PostScript and PDF marks files

The following overview describes the imposition creation workflow for
the full access Preps integration option.

1. You add and process the input files and create a page set.
2. You open Preps from within Prinergy and create an imposition.

Preps adds a run list of blank pages based on the page set in
Prinergy.

3. You create or edit templates, and then add signatures and define a
media (device).

4. You print the imposition as an Adobe Job Ticket or a JDF file.

When saving mixed-file jobs, Preps saves the imposition as a job
ticket file (.pjtf or .jdf). The marks are saved as a PostScript file (.ps).
When saving as a PDF job, the Preps JDF has .pdf mark flats, and the
marks are embedded into the PJTF file.

Prinergy automatically imports the imposition and assigns the pages
to the imposition.



Automated Imposition option

With the Automated Imposition option, you can:

● Create impositions in Prinergy from existing Preps templates
(without starting Preps). You cannot create or edit templates.

Note: Because the Automated Imposition feature does not allow you to edit
the template before creating the imposition, only the Prinergy Signature
Selection button (not the Use External Imposition Application button) is
available to you in the New Imposition dialog box.

● Import the following raw imposition files into a Prinergy job, without
having to first convert the files into a Prinergy-usable format:

○ Preps .job files from the Preps or UpFront software
○ Preps jobs or JDF-MIS (job definition format-management

information system) stripping parameters created by the
UpFront software

○ Preps JDF or other JDF (job definition format) stripping
parameters from Prinergy-compatible software

Setting up integrated Preps
With either of the Preps integration options, the Prinergy Client
Installer automatically identifies the Preps software location. However,
some procedures are required to set up integrated Preps.

Set up tasks

● Create and set the default import process template. See the topic
about creating an import process template for impositions.

● Copy all Preps templates, marks, and printer files to the Prinergy
folder, ...\CreoAraxi\AraxiPreps. See the topic about
saving Preps resource files to a Prinergy folder.

● On a Windows-based client computer, set an exception in the
firewall settings to allow Preps62.exe, so that the Prinergy
server can authorize a floating license for each session.

● On a Mac client computer, you must set Others to Read/Write for
the AraxiPreps folder (Go to Applications\Creo
\Prinergy\AraxiPreps, press Command+I, and change the
user rights at the bottom).

If you are using a Preps dongle, you must also manually add Preps to
the Prinergy imposition application list. See the topic about setting the
imposition software location.

Note: For systems licensed for Preps 6, the Prinergy Workshop installer installs
Preps 6.2. Additionally, the Preps DLL on the Prinergy server (which is used to
convert Preps jobs, JDFs, and so on to impositions) will only work in Preps 6 mode.
This means that sites with Preps 5 clients must migrate these clients to Preps 6, in

1060 Chapter 21—Integrated products



order to edit Prinergy impositions. Please check My Kodak Services for online
training resources, or contact your Kodak representative for training options.
Preps 5 and earlier are no longer tested or supported. Functions that previously
used Preps 5 (for example, creation of impositions from within Prinergy jobs,
creation of impositions outside of Prinergy jobs, editing of impositions, and so on)
may still work, but if problems are discovered, customer support will recommend
upgrading to Preps 6.

Import profiles for Integrated Preps

With either of the Preps integration options, the Import raw imposition
files section of the import process template contains two profiles:

● PrepsPrinergy is the profile that is used when creating or editing an
imposition, and the imposition is automatically imported. Prinergy
automatically selects this profile during the automatic import
process.

● Default is the default profile used when importing either a
Preps .job or a JDF file from a management information system
(MIS). If you require a different profile, select a profile in the Import
raw imposition files section of the process template.

Editing Prinergy Impositions in Preps
Depending on how an imposition was created in Prinergy, it may not be
editable in Preps.

Any imposition created using an integrated Preps workflow is editable
in Preps.

However, if you import any of the following types of imposition files
into Prinergy, the imposition will not editable in Preps:

● PJTF from a stand-alone version of Preps
● MIS JDF with layout
● JDF and PJTF from other imposition applications (for example,

Signa Station)

Saving Preps resource files to Prinergy folder
The first time that you set up to use a Preps integration option, move
your preexisting folders of Preps templates, marks, and printer files to a
special folder on the Prinergy server so that you can use them with
integrated Preps.

Alternatively, if you create and edit all impositions from one Prinergy
client computer, you can keep the Templates, Marks, and Printers
folders on the Prinergy Workshop client computer and confirm that
Preps preferences point to these local templates and marks folders.

These files will be available to all Prinergy Workshop clients using
Preps.
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1. Manually copy all Preps templates, marks, and printer files into the
Templates, Marks, and Printers folders in the ...\CreoAraxi
\AraxiPreps folder on the Prinergy server.

2. Ensure that the shared ...\CreoAraxi\AraxiPreps folder is
mounted to the client computers

3. Configure Preps preferences to point to the Templates, Marks, and
Printers folders.

Importing a raw imposition file manually

1. In Prinergy Workshop, from the File menu, select Import
Imposition.

2. In the Import Imposition dialog box, browse to find the Preps .job
file, Preps JDF file, or the JDF-MIS stripping parameters file to use
for the imposition.

3. Select the Preps .job file that you want to import.

4. Open the Options section.

5. In the Imposition Name box, type a new name or leave the Preps
job name as the default.

6. Take one of the following actions:

○ Select Create New Page Set, enter a name for the page set,
change the page set prefix (if required), and enter the number of
pages in the new page set.

○ Select Use Existing Page Set and select a matching page set
from the list of existing page sets.

Important: These settings in the Import Imposition dialog box override similar
settings in the import process template.

7. Click Import.

8. In the Start Process dialog box, click Edit Process Template.

9. Select settings in the import process template for the results you
want.

For example, if you are using an existing page set when importing
the imposition, you may also want to select Set Initial Separations
after Imposition Import to automatically create separations by
resetting the output separations to the colors that are defined in the
assigned pages.

10. In the Import Raw Imposition Files section in the import process
template, for Profile, select Default.

The PrepsPrinergy profile is used only by Preps integrated with
Prinergy Workshop.

11. In the Device list, select an available device that supports your
imposition plan.

12. For Output Signatures, click All.
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13. Click OK.

When a Preps job file is imported, the integrated Preps software
creates the PJTF and marks files and Prinergy automatically starts the
import imposition task. The PJTF is imported and the imposition plan
and page set are added to the job. The Preps job is saved in the <job
folder>\System\ImpositionPlans folder.

When importing a JDF-MIS stripping parameters file, Preps attempts
to associate a matching signature to the job, based on signature
information contained in the JDF-MIS stripping parameter file. When a
JDF-MIS stripping parameters file is imported, the Preps JDF software
creates the Preps job, finds a matching signature, and outputs PJTF and
marks files that are automatically imported into the Prinergy job. If a
matching signature is found, the PJTF and marks file is created and an
imposition plan is imported. The page set is created and the Preps job
is saved in the <job folder>\System\ImpositionPlans
folder.

If no suitable signature can be found due to insufficient information
contained in the job file, no imposition plan will be imported into the
Prinergy job: the Preps job is created and a page set is created from the
JDF-MIS stripping parameter file but no imposition is created. To
assign the correct signatures to the Preps job, you must then use the
Create New Imposition menu item and the Use Existing Page Set
option to assign the required signatures manually.

Importing a raw imposition file with hot folders

You can import a raw imposition file using a job hot folder. You may
need different hot folders with different process template options
attached, depending on the import settings required by the job. For
example, different device plate sizes require different process
templates.

1. Create a job hot folder.

2. Create an import process template to attach to the hot folder.

3. In the Import section of the import process template, select one of:

○ Create Alternate Page Set and Imposition (if you want to create
a new page set and imposition).

○ Keep Existing Page Set and Create New Imposition

4. If you selected Keep Existing Page Set and Create New Imposition,
select one of the available Page Set Options.

○ Existing assignments replaced by new assignments
○ Existing assignments replaced by new unassignments

5. In the Profile list in the Import Raw Imposition Files section, select
Default.

Importing a raw imposition file with hot folders 1063



6. In the Device list, select an available device that supports your plan.

7. For Output Signatures, select All.

8. Click OK.

9. Drop the Preps .job file, Preps JDF file, or the JDF-MIS stripping
parameters file into the job hot folder.

When you drop a Preps .job from UpFront software into the job hot
folder, the integrated Preps software finds the UpFront software-
created template in the Templates folder and outputs PJTF and
marks files. If the UpFront software-created template referenced in the
Preps job is not found, the integrated Preps software will not create the
PJTF and the import fails. There will be a message in the History view.

After the hot folder accepts the Preps job file, the integrated Preps
software creates the PJTF and marks files that are automatically
imported into the job. The imposition plan is added to the job. The
Preps .job file is saved in the <job folder>\System
\ImpositionPlans folder.

When a JDF-MIS stripping parameters file is dropped into an existing
job hot folder, the integrated Preps software creates the Preps job,
finds a matching signature, and outputs PJTF and marks files that are
automatically imported into the Prinergy job. The page set is created
and the Preps job is saved in the <job folder>\System
\ImpositionPlans folder. If a matching signature is not found, the
PJTF and marks files are not created and an imposition plan is not
imported.

Importing a raw imposition file with smart hot folders
You can use a smart hot folder to create a job based on a template job
and then move a Preps job file to one or more job hot folders for
processing. You can use the smart hot folder to rename the imposition
PJTF and marks files.

1. Create a smart hot folder to create a new job, or find an existing job
based on the back reference in the Preps .job file name.

See Smart hot folders on page 912.

2. Create a Prinergy template job to be used when the smart hot
folder is creating a new job.

3. In the template job, create job hot folders with an import process
template attached.

See Hot folders on page 905.

4. Configure the smart hot folder to move the incoming raw
imposition file to the job hot folder for processing.

5. Drop the Preps .job file, Preps JDF file, or the JDF-MIS stripping
parameters file into the smart hot folder.
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When the smart hot folder moves a Preps .job file into the job hot
folder, the integrated Preps software creates the PJTF and marks files.
The imposition plan is added to the Prinergy job. The Preps .job file is
saved in the <job folder>\System\ImpositionPlans folder.

When the smart hot folder moves a Preps .job file from UpFront
software into the job hot folder, the integrated Preps software finds the
UpFront software-created template in the Template folder and
outputs PJTF and marks files. If the UpFront software-created template
referenced in the Preps .job is not found, Preps will not create the PJTF
and the import fails.

When the smart hot folder moves a stripping parameter file into the
job import hot folder, the page set is created and the Preps job is saved
in the <job folder>\System\ImpositionPlans folder. If a
matching signature is not found, the PJTF and marks file is not created
and an imposition plan is not imported.

Creating a Preps imposition plan

If you have a full access Preps integration license or a Prinergy
Workshop Edition Preps Integration license, you can create a Preps
imposition through Prinergy Workshop. The license allows for the
automatic transfer of files between the imposition software and a
Prinergy Workshop job.

1. In Job Manager, from the File menu, select Create New Imposition.

2. In the New Imposition dialog box, in the Imposition Name box,
enter an imposition name.

Otherwise, the box is read-only.

3. Perform the following as appropriate:

If you are creating an imposition
from a template...

Then...

That needs to be modified using an
external imposition application, such
as Preps.

Select Use External Imposition
Application. Then, in the Select an
imposition application box, select
the software you want to use.

Note: If no applications appear on
the list, this means that none have
been set up. This is done using the
Configure Imposition Applications
option from the Tools menu.

Note: If the application requires a
license and is licensed, the
application name appears in bold
text.
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If you are creating an imposition
from a template...

Then...

That does not need to be modified
using an external imposition
application and if you have the Preps
Integration option Automated
Imposition.

Select Prinergy Signature
Selection.

Notes: Signature Selection works in Preps 5 mode, while the rest of Prinergy
works in Preps 6 mode. This means that:

● It is not possible to edit Preps 6 jobs that use come-and-go, cut-and-stack,
or multi-binding styles with Signature Selection. If you try to edit an
imposition that uses one of these binding styles, the Use Prinergy
Signature Selection option will not be available in the Edit Imposition
dialog. Instead, you will be able to select Use External Layout Imposition
Applications to launch Preps 6.

● There is a difference in the way that Preps 5 and 6 display cut-and-stack
and come-and-go jobs. In Preps 6, cut-and-stack jobs are shown as
multiple webs, and come-and-go jobs are shown as multiple sections. In
Prinergy Workshop, such jobs are displayed in the Preps 6 format, while in
Signature Selection, they are displayed in the Preps 5 format. This is just a
difference in display: the page assignment is correct and the imposition
will print correctly.

4. If you do not want to use the default import or export process
template, click Select and choose the process template that you
want.

5. In the Import Type list, select one of the following options:

○ Automatic Import to start the import process automatically.
With automatic import of imposition information, the
recommended import template option is Keep existing page set
and imposition.

○ Manual Import to open a Start Process dialog box where you
can edit the import process template, choosing import options
appropriate to your Prinergy job.

6. Click OK.

7. In the New Imposition Details dialog box, in Imposition Name, type
the imposition name.

8. Perform the following as appropriate:

If you want to Then

Create a new page set Click Create New Page Set and specify the name, prefix, and number of
pages for the imposition.

Use an existing page set Click Use Existing Page Set, and select a page set from the box below.
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9. Perform the following as appropriate:

If you selected Then

Prinergy Signature Selection
in step 3

Specify the desired templates, arrange them accordingly, set the desired
final output device, and set any shingling and bleed margin default. Click
OK.

Your imposition is now created and this task is complete.

Use External Imposition
Application in step 3

Click OK. The Preps software starts. Continue to the next step and
complete the remainder of this procedure.

10. In Preps, modify the imposition as needed.

For more information on Preps procedures, see the Preps
documentation.

11. In the Preps Signature List pane, click Signatures.

12. Select and add a signature or signatures that conform to the run list
count.

13. Select Preps Layout Details and set shingling amounts and bleed
margins, if required.

14. Click OK.

The signatures are added to the signature list in Preps.

15. From the Preps File menu, select Print.

16. In the Send to list, select from the following options:

● To output a PPF file, select PPF to generate a file that contains
only PPF data.

● To output a PJTF file, select Adobe Job Ticket and select Embed
CIP3 cutting data. From Preps Pro, you can generate a PJTF file
that includes the PPF tags for cutter/folders. When you import
the imposition into Prinergy, you can output PPF from the
Prinergy job.

● To output a JDF file, select JDF as the output type.

17. In the Device list, select an output device.

18. Specify a Print Range, if required.

19. Click Print.

For a new imposition, the Preps software creates the PJTF and marks
files and Prinergy automatically starts the import imposition process.
The PJTF and PostScript marks files are imported into Prinergy and the
imposition is added to the Prinergy job.

The imported Preps PJTF and marks files are saved in the <job
folder>\System\ImpositionPlans folder. The Preps job, PJTF,
and marks files are saved in the <job>\TransientLayouts
\<clientmachinename> folder.

To open Preps outside of a job context, see Opening Preps outside of
job context on page 1070.
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Editing a Preps imposition

If you have a full access Preps integration license, you can create and
edit Preps impositions through Prinergy Workshop. You can also
automatically transfer files between the imposition software and a
Prinergy Workshop job.

This topic includes a few typical use cases for editing a Preps
imposition with integrated Preps.

1. In Job Manager, switch to the Signatures view.

2. In the Imposition Plans pane, double-click the imposition you want
to edit, or select Edit Imposition in the Edit menu.

3. In the Edit Imposition dialog box, if more than one imposition
software is configured, in the Select an imposition application box,
select the software you want to use.

4. If you do not want to use the default import or export process
template, click Select and choose the process template that you
want.

5. In the Import Type list, select one of these options:

○ Automatic Import—Starts the import process automatically.
The only import template option allowed is Keep existing page
set and imposition.

○ Manual Import—Opens a Start Process dialog box where you
can edit the import process template, choosing any import
options appropriate for your job.

○ Versioned Import

6. Click OK.
The Preps software starts.

7. In Preps, perform either of these actions:

○ Increase or decrease the number of blank pages in the run list.
○ Change the signature assignment to keep the same number of

signatures, to increase the number of signatures, or decrease
the number of signatures. The number of blank pages in the run
list must be kept the same.

For more information about Preps procedures, see the Preps
documentation.

8. From the Preps File menu, select Print and perform these actions:

a. In the Send to list, select Adobe Job Ticket or JDF.

To output a PJTF file, select Adobe Job Ticket and select Embed
CIP3 cutting data. From Preps Pro, you can generate a PJTF file
that includes the PPF tags for cutter/folders. When you import
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the imposition into Prinergy, you can output PPF from the
Prinergy job.

b. In the Device list, select an output device.
c. Specify a Print Range, if required.
d. Click Print.

9. If you selected the manual import option, perform these actions:

a. Click Import.
b. In the Start Process dialog box, click Edit Process Template.
c. Select Create alternate page set and imposition to create a new

page set and imposition, or select Keep existing page set and
create new imposition to create a new imposition plan with the
existing page set.

Note: If you increased or decreased the number of blank pages in the Preps
run list, you must select Create alternate page set and imposition. This is
the only page set option that can be used; other options will make the
import fail.

d. Click OK.

The results depend on the options you selected:

● If you selected the automatic import option, the edited imposition
plan is imported, keeping the existing page set and imposition. The
new signatures show in Signatures view. The edited imposition plan
has the same name as the original plan.

● If you selected the manual import option and selected Create
alternate page set and imposition, the edited imposition plan is
imported. A new page set and imposition plan is created. If you
changed the number of blank pages, the new page set has the new
number of page position. The imposition plan name is the same as
the original with .1 appended. Each time the imposition plan is
edited, the .1 is increased by one. There are two imposition plans,
the original and the edited, and two page sets.

Note: (Optional) If there were pages assigned in the original imposition plan,
copy and paste page assignments into the new, edited plan.

● If you selected the manual import option and selected Keep existing
page set and create new imposition, the edited imposition plan is
imported. A new imposition plan is created with the existing page
set. The imposition plan name is the same as the original with .1
appended. Each time the imposition plan is edited, the .1 is
increased by one. There are two imposition plans, the original and
the edited, and one page set.

Note: (Optional) If there were pages assigned in the original imposition plan,
copy and paste page assignments into the new, edited plan.

To open Preps outside of a job context, see Opening Preps outside of
job context on page 1070.
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Opening Preps outside of job context

This procedure describes how to open Preps from the Prinergy Tools
menu, outside of a job. This means that Preps does not open with a run
list that matches the Prinergy job's page set, and the imposition you
create in Preps will not be automatically imported into Prinergy. The
benefit of opening Preps outside of job context is that you can work
extensively in the Preps software without tying up a Prinergy job.

If you have a Preps (integration or stand-alone, floating license or a
dongle), you can open Preps outside of job context (from the Prinergy
Tools menu).

Note: Before opening Preps outside of job context for the first time, you must
install and configure Preps so that Prinergy knows where to locate the software.
See Overview of tasks for integrating imposition software on page 1088

1. In Job Finder, from the Tools menu, select Start Imposition
Application.

2. In the Start Imposition Application dialog box, choose a software
from the list and click OK.

Setting Integrated Preps preferences

Edit the PrepsPrinergy.cfg.template file on the Prinergy
server in order to set preferences for Preps on all clients.

Tip: You can determine what attributes the lines in the file control by
experimenting on the PrepsPrinergy.cfg that is on the client. Once you
determine exactly how to make the desired changes, modify the
PrepsPrinergy.cfg.template on the server to affect Preps on all clients.

1. On the Prinergy server, navigate to the file AraxiPreps
\Profiles\PrepsPrinergy
\PrepsPrinergy.cfg.template.

Tip: Before you modify the file, you may want to make a copy of the original,
naming it PrepsPrinergy.cfg.template.original.

Location of the client PrepsPrinergy.cfg:

● Macintosh: Applications\Kodak\Prinergy
\AraxiPreps\Profiles\PrepsPrinergy

● Windows: Program Files\Kodak\Prinergy
\AraxiPreps\Profiles\PrepsPrinergy
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2. Edit the file as appropriate:

If you want to Then

Set the default unit of
measurement to millimetres

Search for the string -UNITS: and replace the number after the colon (:)
with 3.

For example: -UNITS:3

Set the default job to be PDF
> PDF

Search for the string -DEFAULT_JOB_KIND: and replace the number after
the colon (:) with 2.

For example: -DEFAULT_JOB_KIND:2

Set the punch mark on by
default

Search for the string -PUNCHMARK: and replace the number after the
colon (:) with YES.

For example: -PUNCHMARK:YES

Edit Imposition dialog box

Imposition Name

Displays the name of the imposition you selected. Read-only.

Select an imposition application

If you are creating an imposition
from a template...

Then...

That needs to be modified using an
external imposition application,
such as Preps.

Select Use External Imposition
Application. Then, in the Select
an imposition application box,
select the software you want to
use.

Note: If no applications appear
on the list, this means that
none have been set up. This is
done using the Configure
Imposition Applications option
from the Tools menu.

Note: If the application
requires a license and is
licensed, the application name
appears in bold text.

That does not need to be modified
using an external imposition
application and if you have the
Preps Integration option
Automated Imposition.

Select Prinergy Signature
Selection.

Notes: Signature Selection works in Preps 5 mode, while the rest of
Prinergy works in Preps 6 mode. This means that:

● It is not possible to edit Preps 6 jobs that use come-and-go, cut-and-
stack, or multi-binding styles with Signature Selection. If you try to
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edit an imposition that uses one of these binding styles, the Use
Prinergy Signature Selection option will not be available in the Edit
Imposition dialog. Instead, you will be able to select Use External
Layout Imposition Applications to launch Preps 6.

● There is a difference in the way that Preps 5 and 6 display cut-and-
stack and come-and-go jobs. In Preps 6, cut-and-stack jobs are
shown as multiple webs, and come-and-go jobs are shown as
multiple sections. In Prinergy Workshop, such jobs are displayed in
the Preps 6 format, while in Signature Selection, they are displayed in
the Preps 5 format. This is just a difference in display: the page
assignment is correct and the imposition will print correctly.

Import Imposition Using Process Template

Displays the default process template for importing the
imposition from the imposition software to Prinergy Workshop.

If you want to change the process template for importing, click
Select.

Export Imposition Using Process Template

Displays the default process template for exporting the
imposition from Prinergy Workshop to the imposition software.
When you create or edit an imposition, you can change this
process template in the New Imposition or Edit Imposition
dialog boxes.

If you want to change the process template for exporting, click
Select.

Import Type

When you print and send an imposition in Preps, or save an
imposition in Pandora, the imposition is brought into Prinergy
using the import process template. You can choose the type of
import:

● Automatic Import—Starts the import process automatically.
With automatic import of imposition information, the only
import template option allowed is Keep existing page set
and imposition.

● Manual Import—Opens a Start Process dialog box where
you can edit the import process template, choosing any
import options appropriate for your job.

● Versioned Import
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New Imposition dialog box

Imposition Name

Type the name for the imposition.

Select an imposition application

If you are creating an imposition
from a template...

Then...

That needs to be modified using an
external imposition application,
such as Preps.

Select Use External Imposition
Application. Then, in the Select
an imposition application box,
select the software you want to
use.

Note: If no applications appear
on the list, this means that
none have been set up. This is
done using the Configure
Imposition Applications option
from the Tools menu.

Note: If the application
requires a license and is
licensed, the application name
appears in bold text.

That does not need to be modified
using an external imposition
application and if you have the
Preps Integration option
Automated Imposition.

Select Prinergy Signature
Selection.

Notes: Signature Selection works in Preps 5 mode, while the rest of
Prinergy works in Preps 6 mode. This means that:

● It is not possible to edit Preps 6 jobs that use come-and-go, cut-and-
stack, or multi-binding styles with Signature Selection. If you try to
edit an imposition that uses one of these binding styles, the Use
Prinergy Signature Selection option will not be available in the Edit
Imposition dialog. Instead, you will be able to select Use External
Layout Imposition Applications to launch Preps 6.

● There is a difference in the way that Preps 5 and 6 display cut-and-
stack and come-and-go jobs. In Preps 6, cut-and-stack jobs are
shown as multiple webs, and come-and-go jobs are shown as
multiple sections. In Prinergy Workshop, such jobs are displayed in
the Preps 6 format, while in Signature Selection, they are displayed in
the Preps 5 format. This is just a difference in display: the page
assignment is correct and the imposition will print correctly.
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Import Imposition Using Process Template

Displays the default process template for importing the
imposition from the imposition software to Prinergy Workshop.

If you want to change the process template for importing, click
Select.

Export Imposition Using Process Template

Displays the default process template for exporting the
imposition from Prinergy Workshop to the imposition software.
When you create or edit an imposition, you can change this
process template in the New Imposition or Edit Imposition
dialog boxes.

If you want to change the process template for exporting, click
Select.

Import Type

When you print and send an imposition in Preps, or save an
imposition in Pandora, the imposition is brought into Prinergy
using the import process template. You can choose the type of
import:

● Automatic Import—Starts the import process automatically.
With automatic import of imposition information, the only
import template option allowed is Keep existing page set
and imposition.

● Manual Import—Opens a Start Process dialog box where
you can edit the import process template, choosing any
import options appropriate for your job.

● Versioned Import

New Imposition Details dialog box

Imposition Name

Populates with the imposition name you typed in the New
Imposition dialog box.

Create New Page Set

Select this option to create a new page set in Prinergy
Workshop that is based on the new imposition plan.

By default, the page set is given the same name as the
imposition plan, although you can change its name in the Name
box.
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Name

Displays the name of the page set. You can change the name as
desired.

This option is available only when you select Create New Page
Set.

Prefix

Displays the letter that will be used to identify the page
positions in the new page set. You can change the prefix by
typing up to five alphanumeric characters. The prefix must not
end with a number.

This option is available only when you select Create New Page
Set.

Number of Pages

The number of pages in the page set. Type the number of pages
in this box and the system will dynamically update the From
box. Alternatively, you can let the system automatically
calculate the number of pages based on the To and From boxes.

This option is available only when you select Create New Page
Set.

From

The first page set position number. You can change the number
as desired.

This option is available only when you select Create New Page
Set.

To

The last page set position number. You can change the number
as desired. The system dynamically updates the Number of
Pages box.

This option is available only when you select Create New Page
Set.

Use Existing Page Set

Links the new imposition plan to an existing page set in the job.
Select this option and, from the list, select an existing page set
to which the imposition plan will be linked. Select a page set
with the same number of page set positions as the new
imposition plan.
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This option is available only when the job contains an existing
page set. If there is an existing page set, this option is selected
automatically and the first page set in the list is selected.

Note: When you select this option, the page assignments in the new
imposition plan will overwrite the page assignments in the existing page
set. If you do not want to overwrite the page set assignments, select
Create New Page Set instead.

Options area

Use existing Preps Job

Select to import an existing Preps job. Browse to and select
the .job file.

Note: Signature Selection does not support import of Preps 6 jobs with
come-and-go or cut-and-stack binding styles. When creating a new
imposition , if you select Use existing Preps job and select a Preps 6 jobs
with a come-and-go or cut-and-stack binding style, an error message
appears. You have the choice of selecting a different job file or using an
external imposition application to create the imposition.

Binding Style

Select the binding style to show in the Available Templates
area, only those imposition templates with the same binding
style.

Available Signatures

Navigate to and select the imposition that you want from this
area. Once you have clicked the desired imposition, click Add.

Alternatively, click Auto Select to have Prinergy select
impositions that provide the correct number of pages. With
Auto Select, Prinergy first selects the largest full signature in
the template that can accommodate the number of pages in the
job. The job pages automatically flow through that signature as
many times as needed, and then any remaining pages flow
through a partial signature in the template, if available and
depending on its position in the selected signatures list. If not,
the remaining pages flow through the full signature and blank
pages are automatically added, as needed.

Trim Size

Displays the trim size of the selected signature.

Sheet Size

Displays the sheet size of the selected signature.
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Device

Select the final output device on which this output is eventually
to be printed.

First Page Number in Next Signature

Type the first page number that you want the next signature to
start at.

Target Device

Select the device to which you want to associate all selected
signatures.

When you associate a signature with a device, you are setting
various configuration output attributes for the signature. For
information about configuration output attributes that you can
set for each device, see the Preps Guide.

Selected Signatures

Displays the signatures that you have selected. You can also
edit the Signature Number column and the Page column.

Use the following buttons to modify the selected signature
order and delete selected signatures: Move Up Move Down,
and Delete.

Use the Renumber button to automatically renumber the
signatures after you rearrange them and reset the starting page.
This button overrides any locked numbers.

Shingling (Creep)

Type the amount of shingling that you want to apply in order to
compensate for page creep. Positive values move the image
area toward the binding edge of the page; negative values move
the image away from the binding edge of the page. You can
specify either an Inner amount or an Outer amount, or both.

Inner amount

● For perfect-bound or come-and-go template, the Inner
amount is applied to the innermost pages of each signature.
The specified amounts are applied to the largest signatures
of the job, and shingling on any smaller signatures is scaled
back so that all signatures match each other after binding.

● For saddle-stitched template, the Inner amount is applied to
the innermost pages of the book.

Outer amount
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● Corresponding to the Inner amount rules, the Outer amount
is applied to the outermost pages.

The shingling amounts are distributed evenly to the remaining
pages (based on the total number of pages and the template
binding style).

Background: Page creep occurs when a signature is folded and
the image area of the inside pages of a signature extend slightly
beyond the image area of the outside pages. The amount of
creep is affected by the number of folds and by paper thickness.
In perfect-bound jobs, creep is limited to the pages in each
individual signature. In saddle-stitched jobs, each folded
signature is placed inside another folded signature, causing the
inside signature to extend a bit farther than the signature inside
which it is placed.

Calculating Shingling Amounts

Calculate the amount of shingling to compensate for creep in a
job. There are two methods of calculating shingling amounts:
using an approximate formula, and using the exact method.

Approximate formula: (number of sheets / 4 ) x stock
thickness

Notes: The value you use for the number of sheets depends on the
binding type:

● If perfect bound, this refers to pages per signature
● If saddle-stitched, this is pages per entire book

The value of stock thickness is measured in microns. You can
use a micrometer to determine this or use the measurement
value provided by the paper supplier.

Exact method:

1. Make a folding dummy using the same kind of paper and the
same folding equipment you plan to use for the job.

2. Measure the amount of creep with a precise instrument.
3. Measure the difference between the outer edge (face) of the

outermost page and the outer edge of the innermost page.

Next, apply the shingling amounts

1. In the New Imposition dialog box, select Prinergy Signature
Selection and select OK.

2. In the New Imposition Details dialog box, type the inner
and/or outer shingling amounts.
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Bleed Margin Default

Type the default size of bleed margins which is the distance you
want the bleed to extend on all sides beyond the page trim box
for all pages. Prinergy will not apply a bleed margin if no bleed
margin is specified.

Note: Bleeds are automatically cut off at the gutter fold lines.

You may want to decrease the bleed margin default if the actual
press sheet is physically shorter than its defined size in order to
prevent bleeding off the back edge of the sheet. Also, it is a
good idea to increase bleed margins if a job has severe creep
due to thick stock, in order to compensate for any shingling that
moves the image area of the inner signature towards the
binding.

Note: The unit of measurement is specified in the Preferences dialog box.

Start Imposition Application dialog box

Imposition Name

This list includes the imposition applications you configured
using the Configure Imposition Application Tool, except
Pandora. Choose an imposition application from the list and
click OK.

If you added Pandora in the Configure Imposition Application
dialog box, you can start Pandora by performing either of the
following actions:

● From the File menu, select Create New Imposition .
● Switch to the Signatures view of Job Manager. In the

Imposition Plans pane, double-click an imposition.
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Preps Ganging

Preps Ganging and Prinergy
The Preps Ganging software creates ganged layouts of different-sized
pages to optimize press sheet usage. You can use Preps Ganging
integrated with Prinergy or as stand-alone software.

Using Preps Ganging integrated with Prinergy has these benefits:

● Users can view the same resources (templates, marks, profiles, and
printers) on all client computers.

● Prinergy can automatically import the imposition file after you print
it to JDF in Preps Ganging.

Using stand-alone Preps Ganging, you must manually import the
imposition into Prinergy after you print it to JDF or PJTF.

Licenses

To use Preps Ganging integrated with Prinergy, for best results, use
Preps 6.0 or later. Preps 5 and earlier are no longer tested or
supported.

To use stand-alone Preps Ganging, you need a Preps Pro license.

To import the ganged layout (populated PJTF or JDF) into Prinergy, you
need an Import Populated Job Ticket license in Prinergy.

Using Preps Ganging integrated with Prinergy

Before you can use Preps Ganging integrated with Prinergy, you must
set the Preps Ganging software location for Prinergy. After the Preps
Ganging location is set, you can perform the following tasks:

● Create a Preps Ganging layout (integrated with Prinergy)
● Edit a Preps Ganging layout (integrated with Prinergy)

Note: When using Preps Ganging integrated with Prinergy, printing to JDF is
preferred. Printing to JDF preserves the ability to edit your imposition in Preps
after it has been imported into Prinergy.

Tip: If you run Preps Pro 5.3.2 or later on a Mac, you can use the AutoGang feature
to configure Preps Ganging and Prinergy to automatically create a ganged job. See
the topic about automating creation of a ganged job.

Using stand-alone Preps Ganging

If you want to use stand-alone Preps Ganging, you create a populated
or unpopulated PJTF or JDF imposition file in Preps Ganging, and then
import the file into your Prinergy job. If you are creating an
unpopulated layout file, you use placeholders in Preps Ganging.
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Note: If you create a populated layout file in Preps Ganging and the imposed PDF
files are on the Prinergy server, (and for Mac computers, if your shares are
mounted as SMB), Prinergy automatically adds your PDF files to the Input Files list
when you import the PJTF or JDF into your Prinergy job.

Tip: Using Rules-Based Automation, you can create a rule to refine pages when
input files are added.

Setting the Preps Ganging software location
Before you can use Preps Ganging integrated with Prinergy, you must
add the Preps Ganging software to Prinergy.

Requirements:

In a Mac environment, for best results, mount your network shares
using the SMB file service.

1. In Prinergy Administrator, check your Import JTP to ensure that
Import Populated Job Ticket is selected.

2. Add Preps Ganging to your Workshop Imposition Application list:

a. Click Tools > Configure Imposition Applications.
b. Click Add and browse to the Preps application folder and select

PrepsGanging.exe in Windows or Preps Ganging.app
on a Mac.

c. Under the Application Type column, click Preps Ganging.
d. Click Done.

Creating a layout with integrated Preps Ganging
Create a layout using Preps Ganging integrated with Prinergy in order
to have Prinergy automatically import the layout.

1. Refine your files and create a populated page set in your Prinergy
job.

2. In Job Manager, click File > Create New Imposition.

3. In the New Imposition dialog box, in the Imposition Name box, type
an imposition name.

4. Click Use External Imposition Application.

5. In the Select an imposition application box, select Preps Ganging,
and click OK.

6. In the New Imposition Details dialog box, in the Use Existing Page
Set box, select your populated page set, and click OK.

7. In the Preps Ganging software, assign your media, stock, and marks
and arrange your pages as needed on your press sheet.

The number of pages on your layout must match the total number
of pages in your populated page set. For more information about
Preps Ganging procedures, see the Preps Ganging documentation.
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8. From Preps Ganging, select File > Print.

9. In the Send to list, select JDF.

Note: You can output a PJTF file that includes the Print Production Format
(PPF) tags for a cutter. However, outputting to PJTF prevents you from editing
the imposition in Preps after it has been imported into Prinergy. See the Preps
documentation.

10. In the Device list, select an output device if you didn't select a
media earlier.

11. Specify a Print Range, if required.

12. Click Print. You can now close Preps Ganging and save the
Preps .job file if required.
For a new imposition, Preps creates the imposition file (PJTF or
JDF) and marks files, and Prinergy automatically imports the
imposition file and PDF marks files.

The imported Preps Ganging imposition files are saved in the <job
folder>\System\ImpositionPlans folder. The Preps job,
PJTF/JDF, and marks files are saved in the <job folder>
\TransientLayouts\<client computer name> folder.

Editing a layout with integrated Preps Ganging
Edit a layout using Preps Ganging integrated with Prinergy in order to
have Prinergy automatically import the layout.

Note: You can edit Preps Ganging layouts using this procedure with Preps Classic
or Preps Ganging.

1. In Job Manager, go to the Signatures view.

2. In the Imposition Plans pane, double-click the imposition that you
want to edit, or click Edit > Edit Imposition.

3. In the Edit Imposition dialog box, if more than one installation of the
Preps software is configured, in the Select an imposition
application box, select the Preps software that you want to use.

4. In the Import Type list, select Manual Import, and click OK.
The Preps software opens.

5. Make the necessary changes to your layout. The number of pages
must be kept the same as in your page set.

6. In Preps/Preps Ganging, select File > Print.

7. In the Send to list, select JDF.

Note: You can output a PJTF file that includes the PPF tags for a cutter.
However, outputting to PJTF prevents you from editing the imposition in Preps
after it has been imported into Prinergy. For more information, see the Preps
documentation.

8. In the Device list, select an output device if you didn't select a
media earlier.

9. Specify a Print Range, if required.

1082 Chapter 21—Integrated products



10. Click Print. You can now close Preps Ganging and save the
Preps .job file if required.

11. In the Start Process dialog box, click Edit Process Template.

12. In the Import section of the process template, in the If Page Set
Already Exists box, select Delete existing page set and imposition,
because the page set may have changed after ganging.
The edited imposition plan is imported. A new page set with the
new number of page positions and the imposition plan is created,
replacing the previous one.

Automating creation of a ganged job
Configure an automated workflow in which you add PDF input files to a
quantity-based subfolder within an AutoGang hot folder, and the files
are automatically ganged to a new layout and imported into a new
Prinergy job.

Requirements:

You require the following:

● Prinergy client computer running the Mac OS (to use the AutoGang
feature in Preps)

● Preps Pro 5.3.2 or later floating license (to use the AutoGang
feature in Preps)

● Prinergy Import Populated Job Ticket license (to import the ganged
layout)

● Prinergy Rules-Based Automation license (optional; to
automatically refine files)

Note: A quantity-based subfolder is folder that groups content by run-length. For
example, if a customer typically orders 500 copies, then you need to create a
quantity folder called 500 to collect the input files.

The Prinergy job is created with same name as the ganged output file.
The ganged output file is named after the date and time that the file
was created, and the name of the AutoGang hot folder used to create
the file: <YYMMDDHHmm_nn_HotFolderName>, where <nn>
represents the incremented file ID number.

Important: After the layout is created in Prinergy, ensure that you open the Preps
Ganging software from Prinergy Workshop and check the generated layouts
before saving and printing the Prinergy job.

This procedure provides summarized steps. For more details, see the
Preps Ganging Guide and the Prinergy Workshop User Guide.

1. Creating an import process template with APA enabled
Create an import process template that will automatically assign
pages on import.

2. Creating a template job with hot folders
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Create a template job with hot folders that will import and assign
pages.

3. Creating a smart hot folder to create Prinergy jobs
Create a smart hot folder to create Prinergy jobs.

4. Creating an RBA rule to refine input files
Create an RBA rule to automatically refine input files and enable it
for the template job.

5. Creating a Preps Ganging hot folder
Create a hot folder in Preps Ganging to output a ganged layout to
the Prinergy smart hot folder.

Creating an import process template with APA enabled

Create an import process template that will automatically assign pages
on import.

1. In Prinergy Workshop, create a new import process template.

2. On the Import tab, click Set Initial Separations After Imposition
Import and Do Auto Page Assignment After Unpopulated
Imposition Import.

3. Save this process template with a name such as ImportAll-APA.

Creating a template job with hot folders

Create a template job with hot folders that will import and assign
pages.

1. In Prinergy Workshop, in Job Finder, create a new job (or find an
existing job) to use as a template job.

Important: You should select a job or create one in a location that will not be
removed or destroyed.

2. With the template job open in Job Manager, select Job > Manage
Hot Folders and follow these steps:

a. In the Manage Hot Folders dialog box, click Add.
b. In the Create Hot folder for Job dialog box, click Add and

Process Files.
c. In the Workflow Processors list, navigate to and select the

ImportAll-APA process template, and click OK.
d. In the Manage Hot folders dialog box, click Close.
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Creating a smart hot folder to create Prinergy jobs

Create a smart hot folder to create Prinergy jobs.

1. In Prinergy Workshop, select Tools > Smart Hot Folder Manager.

2. In the Smart Hot Folder Manager, click Add.

3. In the Add Smart Hot Folder dialog box, in the Smart Hot Folder
Name box, type a name for the smart hot folder, for example,
Preps Ganging Import.

4. In the Smart Hot Folder Location box, perform one of the following
steps:

○ Click Browse and navigate to a location that is a convenient
place for you to drop the Preps Ganging output file.

○ Click Use Default Location.

Note: On installation, the default location is the Jobs
\SmartHotFolders folder on the Prinergy server.

5. Under Hot Folder Type, click Job Creator.

6. In the Create a new job based on the job template box, click
Browse. In the Select Template Job dialog box, perform the
following steps:

a. Navigate to and select the template job with hot folders that you
created in Creating a template job with hot
folders on page 1084.

b. Under Copy from Selected Job, ensure that the Hot Folders
check box is selected, and click OK.

7. In the left-hand pane, click Source and Target Patterns.

8. In the Source File Name Pattern box, type [$GangJob].[%ext]
9. In Target Group, click Browse, and select the location to which the

newly created jobs should go.

10. In the Target Job Name Pattern box, type [$GangJob]
11. In the left-hand pane, click File Move Rules, and follow these steps:

a. Under the table, click Add.
b. Under Source File Name Pattern, click Use Smart Hot Folders

Source Pattern.
c. Under Target File Name Pattern, clear the Rename files check

box.
d. Click the Move to Job Hot Folder option. From the list, select the

import process template that was created in the job hot folder in 
Creating an import process template with APA
enabled on page 1084, and click OK.
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Creating an RBA rule to refine input files

Create an RBA rule to automatically refine input files and enable it for
the template job.

This procedure is part of automating the creation of a ganged job using
Preps Ganging.

1. In Prinergy Workshop, select Tools > Rule Set Manager.

2. Click the New Rule Set button.

3. In Rule Builder, under Events, drag Input File Added to the right
pane.

4. Under Actions, drag Refine Input File to the box following Input
File Added.

5. Edit the Rule Parameters to define the Process Template Path to
your refine processing.

6. Save this rule with a name such as
InputFileAdded_RefinePages.

7. Enable this rule for the template job you previously created in 
Creating a template job with hot folders on page 1084.

Creating a Preps Ganging hot folder

Create a hot folder in Preps Ganging to output a ganged layout to the
Prinergy smart hot folder.

For more information and details about automatic ganging, see the
Preps 5.3.2 AutoGang technical bulletin.

1. In Preps Ganging, click Preps Ganging > Preferences > AutoGang
tab, and set the Root Hot Folder to a location on your Prinergy
server.

Note: You can define only one root hot folder path for use by all profiles. The
default and custom profiles derive your AutoGang presets, hot folder settings,
and a single root folder path from a special configuration file called
AutoGanging.cfg.

2. Complete the Preps Ganging Hot Folder set up dialog box, selecting
the output type and location:

○ Output Type: JDF (or PJTF if required)
○ Output ganged layouts to <Smart hot folder path> as set in 

Creating a smart hot folder to create Prinergy jobs on page 1085.

3. In the Finder, add PDF files to the hot folder.

4. If you set the hot folder to print manually, you can start Preps
Ganging and review the layouts before clicking Print. Otherwise, if
the hot folder is set to print automatically, your files will be moved
to the Prinergy smart hot folder.
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Imposition software

About integrating imposition software

Prinergy supports the integration of the following imposition software:

● Preps—Prinergy offers four Preps integration options. See Preps
integration options on page 1059.

Preps is Kodak imposition software for double-sided commercial
products such as books, magazines, flyers, trading cards, business
cards, and so on.

● Pandora—Full, round-trip access to Pandora is supported in
Prinergy. This means you can start Pandora from within Prinergy,
and use Pandora features. It also enables Prinergy to automatically
import Pandora files after you save and close the Pandora
imposition. If you created a new imposition, Prinergy automatically
creates a new page set and assigns the pages to the page set and
imposition. For more information, see the Pandora with Prinergy User
Guide.

Pandora is signature software for single-sided packaging products
such as folding cartons and labels.

● Heidelberg Prinect Signa Station—You can import impositions
from Prinect Signa Station using the PJTF and JDF file formats. Note
that Kodak does not test this integration, so testing is encouraged
prior to upgrading.

Prinect Signa Station is Heidelberg's imposition software for
commercial products.

Accessing the imposition software

After you integrate the imposition software, you can access it in the
following ways:

● Select File > Create New Imposition.
● Select Edit > Edit Imposition.
● Double-click the imposition in the Signatures view
● Select Tools > Start Imposition Application (Not available with

automatic Preps integration option.) See Opening Preps outside of
job context on page 1070.
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Overview of tasks for integrating imposition software

Perform the following tasks as appropriate to the imposition
software that you are integrating.

If you are integrating Use the Configure Imposition Applications dialog box to

Preps—Any integration option
(see Preps Integration Options)

For full details, see Setting up integrated Preps.

● Create and set the default import process template.

Note: Prinergy automatically searches a default location for Preps
software licenses.

Preps start-only option (see
About Preps Integration Options)

● Set the imposition software location.

Note: With this option, you must import Preps files manually.

Pandora For full details, see the Pandora with Prinergy User Guide.

a. Set the imposition software location.
b. Create and set the default import process template.
c. Create and set the default export process template.

Heidelberg Prinect Signa Station ● Set the imposition software location.

Note: Not all versions of Signa Station are qualified. For the most
current information, contact a service representative.

See also:
Preps integration options on page 1059
Setting the imposition software location on page 1088
Create an Export process template for impositions on page 1089
Create an Import process template for impositions on page 1089

Setting the imposition software location

Use this procedure to integrate imposition software into Prinergy. For
background information, see Overview of Procedures for Integrating
Imposition Software.

1. From the Tools menu, select Configure Imposition Applications.

2. In the Configure Imposition Applications dialog box, click Add.

Note: If you are configuring Pandora on a Windows operating system, select
RunPandora.exe (not Pandora.exe).

3. Locate and select the executable file for the software, and then click
Open.

4. Click Application Type, and then in the list, select the software.

Tip: To delete the integrated software, in the Application Name area of the
Configure Imposition Applications dialog box, select the software, and click
Delete.
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Create an Export process template for impositions

The export process exports pages and imposition files from Prinergy
Workshop into the configured imposition application.

By default, the export process creates a new version of a file if the
destination location already has a file with the same name. For editing
impositions, we recommend that you overwrite existing files so that
there is only one version of them in the configured imposition
application.

1. Follow the steps in creating a process template, making sure that
you:

● Choose an Export process template as a base.
● (Recommended) Select Overwrite Existing Files With Same

Name.

2. From the Tools menu, select Configure Imposition Applications.
3. Click Select next to Export Imposition Using Process Template and

select the process template from Step 1.

Create an Import process template for impositions

The import process imports new or edited impositions back into
Prinergy.

1. Follow the steps in creating a process template, making sure that
you:

● Choose an Import process template as a base.
● In the Import section, in the If Page Set Already Exists list,

choose whether to overwrite previous versions of the same
imposition in Prinergy Workshop:

To Do This

Overwrite previous versions
(Recommended)

Select Delete existing page set and
imposition

Create separate versions Select Create alternate page set and
imposition

2. From the Tools menu, select Configure Imposition Applications.
3. Click Select next to Import Imposition Using Process Template

and select the process template from Step 1.

Creating or editing Pandora impositions

Requirements:

Before using the imposition software for the first time, configure the
imposition software.
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If you have a Pandora integration license, you can create and edit
Pandora impositions through Prinergy Workshop. The license allows
for the automatic transfer of files between the imposition software and
a Prinergy Workshop job.

For more information, see the Pandora with Prinergy User Guide.

1. In Job Manager, perform the following as appropriate:

To Do this

Create a new
imposition

From the File menu, select Create New Imposition.

The New Imposition dialog box appears.

Edit an existing
imposition

a. Switch to the Signatures view.
b. In the Imposition Plans pane, double-click the

imposition you want to edit, or click Edit > Edit
Imposition.

The Edit Imposition dialog box appears.

2. If you are creating an imposition, in the Imposition Name box, enter
an imposition name.

Otherwise, the box is read-only.

3. If more than one imposition software is configured, in the Select an
imposition application box, select the software you want to use.

4. If you do not want to use the default import or export process
template, click Select accordingly, and select the process template
that you want.

5. In the Import Type list, leave the default at Automatic.

Select Manual only if you want to edit the import process template.

6. Click OK.

7. Perform the following as appropriate:

If you are Do this

Creating a new
imposition

In the New Imposition Details dialog box, in
Imposition Name, type the imposition name.

Editing an existing
imposition

Go to step 9.

8. Perform the following as appropriate:

If you want to Then

Use an existing
page set

Select Use Existing Page Set and select the page set
from the list.

Click OK.

Create a new
page set

Select Create New Page Set and specify the name,
prefix, and number of pages for the imposition.

Click OK.

1090 Chapter 21—Integrated products



9. In Pandora, modify the imposition as needed.

For more information, see the Pandora documentation.

10. Save and close the imposition.
Prinergy automatically imports the imposition into the Prinergy
Workshop job.

11. If your imposition fails to import automatically because of a system
failure, manually import the job ticket from Pandora.

Configure Imposition Applications dialog box

Add

Select to browse to the file that will launch the software.

The software name will appear in the Application Name area,
along with the job ticket versions supported.

Reload

Select to update the dialog box with changes.

Delete

Select this to remove the file that will launch the software.

Auto Detect

Select to find all Preps imposition software licenses at the
default installation location.

Any Preps software licenses that are found appear in the
Application Name area.

If any previously configured imposition software is moved from
the default installation location, the previously configured
software appears in red in the Application Name area when you
click the Auto Detect button. Reconfigure Prinergy to point to
the imposition application in the new location.

Default Export Process Template

Select a default process template used to export the imposition
from Prinergy Workshop into the imposition software.

When you create or edit an imposition, the process template
that you select here appears in the New Imposition or Edit
Imposition dialog boxes. In those dialog boxes, you can accept
the default process template or change it.

Default Import Process Template

Select a default process template used to import the imposition
from the imposition software into Prinergy Workshop.
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When you create or edit an imposition, the process template
that you select here appears in the New Imposition or Edit
Imposition dialog boxes. In those dialog boxes, you can accept
the default process template or change it.

Prepress Portal

About integrating with Prepress Portal

Prepress Portal software is a web portal that lets printers and their
customers work with print jobs over the Internet. Prepress Portal helps
manage reviews and approvals of each page in a job.

You make jobs available for customers to review by setting
AutoProcess rules in Prepress Portal, creating the job in Prepress Portal
and uploading files to it. The processed pages are immediately
available to the customer for review and approval, and an e-mail
notification goes to the customer.

Important: You can make a job available to Prepress Portal customers by web-
enabling it in Prinergy Workshop (see Enabling Web Access), but the customer
will not receive automatic e-mail notification. You must find another way to
contact them.

Customers can use Prepress Portal to:

● Create and delete jobs. See About Creating and Controlling Jobs in
Prepress Portal.

● Exchange files. See About the Location of Files from Prepress Portal.
● View page sets and signatures in Job Manager.
● Review and annotate pages using Smart Review.
● Review the color conformance of pages.
● Approve, reject, or request corrections to pages. See About

Approvals.
● View the status and history of jobs, and enter job codes.

Both you and your customers automatically receive e-mail messages
when actions take place, such as when you request a review. These e-
mail messages are configured in Prepress Portal.

See also:
Job management on page 96
About approvals on page 771
About approval statuses and Prepress Portal on page 1093
About the location of files from Prepress Portal on page 1093
About creating and controlling jobs in Prepress Portal on page 1094
Job workflow with Prepress Portal on page 1095
Enabling web access for customers with Prepress Portal on page 1096
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About approval statuses and Prepress Portal

Here is a summary of the approval statuses and their meaning:

Status Meaning

No status (Prinergy) /
Work In Progress
(Prepress Portal)

No status has been set, or a Prinergy cleared the
status.

Approval Not Required A Prinergy user selected this setting to indicate the
page will not be reviewed.

Approval Requested
(Prinergy) / Approval
Required (Prepress
Portal)

A Prinergy user selected this setting to enable
Prepress Portal users to review and approve the
page.

Approval in Progress A Prepress Portal user has reviewed the page, but
not approved it.

Waiting for Correction A Prinergy user selects this setting to indicate that
corrections are in progress.

Approved A Prepress Portal user has approved the page.

Rejected A Prepress Portal user has rejected the page.

About the location of files from Prepress Portal

Files that are uploaded to Prepress Portal are stored in three folders
inside each job folder.

WebAnnotatedProofs

The WebAnnotatedProofs folder contains files that users of
Prepress Portal have reviewed and annotated. Users of Prepress Portal
do not need to place the files there; the files appear automatically in
the folder.

This folder is a core part of the review process. You need to get files
from this folder any time a customer annotates a file and requests
corrections.

WebDownloads

The WebDownloads folder contains files for users of Prepress Portal
to download. When you place files in this folder, they display in
Prepress Portal and users can retrieve them.

This folder is optional. You should upload pages for review and
approval in Prepress Portal to ensure that customers receive e-mail
notification.
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WebUploads

When customers use the upload feature of Prepress Portal, the files
appear in the WebUploads folder. Each upload in Prepress Portal
creates a separate subfolder inside the WebUploads folder.

This folder is optional. You do not need it to receive input files from a
customer. Users of Prepress Portal automatically add input files when
they create a job in Prepress Portal.

The files in this folder are automatically processed in Prinergy, based
on the AutoProcess rules set in Prepress Portal.

About creating and controlling jobs in Prepress Portal

Users of Prepress Portal can add, delete, and change jobs and pre-jobs.

Adding jobs or pre-jobs

Customers can create new jobs from Prepress Portal. The result has
different names in Prepress Portal than in Prinergy:

● It is called a Pre-Production job in Prepress Portal.
● It is called pre-job in Prinergy, which is visible only in the Pre-Jobs

view of Job Manager and has a status of Created

Changing jobs or pre-jobs

Customers can use Prepress Portal to make jobs into pre-jobs and vice
versa:

● When customers make a Pre-Production job into a Production job
in Prepress Portal, they make a pre-job into a job in Prinergy.

● When customers make a Production job into a Pre-Production job
in Prepress Portal, they make a job into a pre-job in Prinergy.

Deleting jobs or pre-jobs

Customers can use Prepress Portal to delete jobs. They can delete only
a Pre-Production job in Prepress Portal, which is a pre-job in Prinergy.
They cannot delete a Production job in Prepress Portal, which is a job
in Prinergy.
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Job workflow with Prepress Portal

1. In Prepress Portal software, the customer creates a job, which
appears as a Pre-Production job in Prepress Portal and as a pre-job
with a status of Created in Prinergy Workshop.

2. In Prepress Portal, the customer adds input files using any one of
many methods available.

For information, see the Prepress Portal documentation.

3. In Prepress Portal, the customer promotes the Pre-Production job
(which is a pre-job in Prinergy) to a Production job (which is a job in
Prinergy).

4. In Prinergy Workshop, you process the input files into pages.

Tip: You can increase the display speed of PDFs in Prepress Portal by
generating alternate low-resolution images which are used when customers
open the PDFs in Prepress Portal. To do this, in the Optimize section of the
refine process template, under Color & Grayscale Alternate Images, select
Generate.

5. To review files, perform these action:

a. In Prepress Portal, upload the processed input files and set the
status of each page to Request Approval.

Note: You can set the customer approval status of each page to Approval
Requested in Prinergy Workshop, but the customer will not receive an
InSite email notification unless you have set up a rule in Prinergy Rules-
Based Automation.

b. In Prepress Portal, the customer reviews the pages, annotates,
approves, or rejects them, and requests correction of annotated
pages.

c. Make the corrections as needed.
d. In Prinergy Workshop, reprocess the files.
e. Repeat steps 5a to 5d above until all the customer approves all

of the pages.

From this point, you complete the job as usual.
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Enabling web access for customers with Prepress Portal
Note: Before enabling web access for any job, you must set up InSite
Administration.

1. Either create a new job or change an existing job by doing one of
the following:

○ To enable web access while creating a new job, follow the steps
in Creating Jobs and Pre-Jobs. While you are in the Create New
Job dialog box, select the Job Attributes check box.

○ To enable web access for existing jobs or pre-jobs, select one or
more jobs or pre-jobs in Job Finder. Then, from the Edit menu,
select Edit Job Attributes.

2. In the Edit Job Attributes dialog box, select the Enable Web Access
check box.

3. In the Select Web Access Customer dialog box, select the
customer in the list.

4. Click OK, and then OK.

The jobs or pre-jobs are now visible to the customer in Prepress Portal.

Select Web Access Customer dialog box

The list displays customers that have been set up in Prepress Portal.
Select a customer and click OK.

Prinergy Business Link

About integrating with Prinergy Business Link

If you have Business Link software set up to work with Prinergy, you
can track processes by work type. You can also switch users without
logging off of Prinergy Workshop.

Work types

If you have Business Link software set up to work with Prinergy, the
Start Process dialog box displays a Work Type list. Users can select a
work type from the list for each process that they run.

Work types capture the reason why work is being done, such as regular
work, alterations, or rework.

You typically select a predefined work type, but you can also customize
work types on a per-job basis. For each custom work type, you can
type the name of the person who approved the work type and a
description, such as a why, when, and how the change request was
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made. For example, "customer sent new image" or "based on customer
e-mail March 23".

Prinergy automatically sends this processing information to Business
Link, where it is used in Business Link reports or forwarded to a MIS
(management information system).

Switching users

If you have Business Link software set up to work with Prinergy, the
Connect to Server dialog box displays an Enable User Switching check
box when you log on.

Selecting this check box enables the Tools > Change User menu item
that allows you to change the current user identity without restarting
Prinergy Workshop. This is called switching users.

Use this option when multiple people use the same workstation to
access Prinergy Workshop throughout a day, and they don't need their
individual user properties. If users want to load their own user
properties, such as user favorites or Prinergy Workshop preferences,
they must restart Prinergy Workshop and log on with their user name.

Sending information to Business Link

Only use this procedure if you have Business Link software connected
to the Prinergy system.

1. Start a process as usual.

2. When the Start Process dialog box appears, in the Work Type list,
select the work type that best describes the type of work being
performed.

Note: Work Type is available only when you start a process from Job
Manager.

If you want to add or change a work type, see Customizing Work
Types.

3. After you set other dialog box options, click OK to begin
processing.

Customizing work types

Only use this procedure if you have Business Link software connected
to the Prinergy system.

1. In the Start Process dialog box, click Edit.

Note: Edit is available only when you start a process from Job Manager, not
from Job Finder.
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2. In the Manage Work Types dialog box, in the Category list, select
Alteration Chargeable, Alteration Non Chargeable, Rework
Chargeable, or Rework Non Chargeable.

(You cannot customize the Regular or Original Work categories.)

3. Perform any of the following actions:

To Do This

Add a new item to the
category

a. Click Add.
b. In the Edit Work Type dialog box, type a

Description and the First Name and Last
Name of the person who has approved the
addition of the item.

c. Click OK.

Change an existing
item in the category

a. Select the item in the Items list, and click
Modify.

b. In the Edit Work Type dialog box, make your
changes, and click OK.

Note: Some items cannot be modified.

Remove an item from a
category

Select the item in the Items box, and click Delete.

Tip: Use the Description box to provide more information about why a change
is being made. This could include the reason for the alteration or rework and
when and how the change request was made. For example, an operator might
type "Customer sent new image" or "Based on customer e-mail March 23".

4. Click Close.

The changes you make affect the Work Type list in the Start
Process dialog box.

Manage Work Types dialog box

Category

Lists groups or categories of work types, such as Non
chargeable re-work. The categories can be system defined or
custom. You can add, edit, and delete the items in some
categories, but not in all categories. For example, you cannot
alter the Regular or Original Work category.

Items

Displays all of the work types in the category selected in the
Category list. The items can be system defined or custom. You
cannot modify or delete system-defined items. You can add,
modify, or delete custom items.
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Add

Click to add a custom item to the category selected in the
Category list. This button is available only for some categories.

Modify

Click to modify a custom item selected in the Items list. This
button is not available when you select a built-in item.

Delete

Click to delete a custom item selected in the Items list. This
button is not available when you select a built-in item.

Edit Work Type dialog box

This dialog box applies only if you have Business Link software
connected to the Prinergy system.

Description

Type a descriptive name for the work type that you are adding
or changing.

Approved By

Type the first and last names of the person who authorized you
to add or change the custom work type.

Switching users

Requirements:

This procedure is only available if you have Kodak Prinergy Business
Link connected to the Prinergy system, and you have selected Enable
User Switching in the Connect to Server dialog box.

1. From the Tools menu of any window, select Change User.

The Connect to Server dialog box appears.

2. In the User name box, type the new user name.

3. In the Password box, type the password for the new user name.

4. Click Login.

Tip: After you select Change User, you cannot cancel the operation. If you
selected Change User and want to cancel it, enter your current user name and
password again.

Connect to Server dialog box

This dialog box applies only if you have Business Link software
connected to the Prinergy system and you are switching users.
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User name

Enter the user name associated with your Prinergy Workshop
account.

Password

Enter the password associated with your Prinergy Workshop
account.

Creative software

About opening files in other software

You can open and edit files in other software from within Prinergy
Workshop. You can open and edit:

● Input files
● Refined PDF pages that are not assigned to a page set or imposition
● Refined PDF pages that are assigned to a page set or imposition

You first need to configure the list of other software so that Prinergy
knows where the software is located.

Configuring the list of other software

1. From the File menu, select Open File With and then select Edit List.

Tip: You can also right-click the input file to select these menu items.

2. In the Configure Applications dialog box, perform one of the
following actions:

To Do This

Add software a. Click Add.
b. In the Windows Explorer or Macintosh Finder dialog

box, browse to and select the software's executable
file.

The software name appears in the Applications box
and the path to the software appears in the Location
box.

c. (Optional) To rename the software's executable file
name, double-click the software in the Applications
box and type a new name.

d. Click OK.

Remove
software

In the Applications box, select the software, and click
Remove.
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Tip: To change software, remove the existing software and add the new one.
This is useful if you change versions, move the software to another location, or
change software.

3. Click OK.

Opening a file with other software

You can open files in other software from within Prinergy Workshop.

1. In Job Manager, select the file you want to open.

2. From the File menu, select Open File With.

Tip: You can also right-click the input file to select these menu items.

3. Perform one of the following actions:

To Open With Do This

Default
software

Select (default application)

Default software is the software your operating system
uses when you double-click this type of file in Windows
Explorer or Macintosh Finder.

Other software Select the software from the list.

If the software you want is not in the list, configure the
list of other software.

Configure Applications dialog box

Applications

Lists the software that Prinergy Workshop has been configured
to locate.

To rename the software's executable file name, double-click the
software and type a new name.

Add

Opens a Windows Explorer or a Macintosh Finder dialog box.
Locate and select the software's executable file.

The software's executable file name appears in the
Applications box and the path to the software appears in the
Location box.

Remove

Select a software name in the Applications box and click
Remove to remove the software from the list.

Opening a file with other software 1101



Location

Displays the path to the software you selected in the
Applications box.

Digital print software

About integrating digital print client software

You can integrate digital print client software with Prinergy Workshop.

Why you should integrate digital print client software

Integrate digital print client software if you want to:

● Use Prinergy Workshop and the digital print client software on the
same computer. With integrated software, you do not need to
prepare files in Prinergy Workshop and then change computers to
use the software that controls the digital printer.

● Run the digital print client software from the Tools menu of Prinergy
Workshop.

When you should not integrate digital print client software

You do not need to integrate digital print client software if you want to
send files to digital printers using only process templates. For
information about this method of sending files to digital printers, see
About Using Digital Printers.

Where and how to integrate digital print client software

Each client computer is integrated with digital print client software
separately. Therefore, if you integrate digital print client software, you
need to do it on each computer that is running Prinergy Workshop.

For instructions on integrating digital print client software, see
Integrating Digital Print Client Software With Prinergy Workshop.

For information about installing and configuring digital print client
software, see the Prinergy Digital Print Installation and Configuration
Guide.

How Prinergy Workshop changes when you integrate
digital print client software

After you integrate digital print client software, it appears in Prinergy
Workshop on the Tools menu, next to Digital Print Administration
Console. With this new menu item, you can start the software from
within Prinergy Workshop.
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If the digital print client software is from Xerox, the software can also
appear in the Submit to Digital Print dialog box that appears when you
select File > Send to Digital Direct in Job Manager.

If you want to run more than one digital print client, you can integrate
more than one client with Prinergy Workshop. When you submit files
for digital printing, you select the specific software client that you want
in the Digital Press list in the Submit to Digital Print dialog box.

The ability to run the Digital Submit and Digital Direct applications is
licensed by the Digital Print license in Prinergy Administrator.

See also:
About using digital printers on page 669
Integrating digital print client software with Workshop on page 1103

Integrating digital print client software with Workshop

This procedure explains how to integrate digital print client software
with Prinergy Workshop.

1. Install the software on the client computer.

See the documentation provided with the software or the Prinergy
Digital Print Installation and Configuration Guide.

2. Add the software to the Tools menu in Prinergy Workshop:

a. From the Tools menu, select Digital Print Administration
Console > Configure.

b. In the Configure Digital Print Application dialog box, click Add.
c. In the Add Digital Print Application dialog box, in the

Application Name box, type the name of the software as you
want it to appear in Prinergy Workshop on the Tools menu, next
to Digital Print Administration Console.

d. In the Executable Location box, click Browse to locate and
select the executable file.

e. Select or clear the Allow element submission check box to
determine whether you can use the software to send files to a
digital printer using the Job > Submit for Digital Printing menu
item in Job Manager.

Digital Print Client
Software

Setting

Xerox FreeFlow Print
Manager

Select the Allow element submission
check box.

NexPress JDF Workflow
Planner

Clear the Allow element submission
check box.

f. Click Add, and then click Done.
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3. Configure the software:

a. From the Tools menu, select Digital Print Administration
Console > Configure, and then select the name you gave the
software.

b. When the software opens, configure it as desired.

See the documentation provided with the software or the
Prinergy Digital Print Installation and Configuration Guide.

4. Repeat this procedure on each Prinergy Workshop client from
which you want to launch the digital print software.

Add Digital Print Application dialog box

Use this dialog box to identify the name and location of digital print
software. You open this dialog box from the Configure Digital Print
Application dialog box. For background, see About Integrating Digital
Print Client Software. For instructions, see Integrating Digital Print Client
Software with Prinergy Workshop.

Application Name

Enter a meaningful name for the software, such as XDS, as you
want it to appear on the Tools menu, next to Digital Print
Administration Console.

Executable Location

Either type the path of the executable file for the digital print
software in this box or click Browse to locate and select the file.

Allow element submission

Determines whether you can use the software to send files to a
digital printer using the File > Send to Digital Direct menu item
in Job Manager.

● For Xerox FreeFlow Print Manager, select the check box.
● For Kodak JDF Workflow Planner, do not select the check

box.

Configure Digital Print Application dialog box

Use this dialog box to identify the name and location of digital print
software.

For background, see About integrating digital print client
software on page 1102. For instructions, see Integrating digital print
client software with Workshop on page 1103.
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Application Name

The names of any digital print software that has been added to
Prinergy. You determine the names that will appear on the
Tools menu, next to Digital Print Administrator.

Location

The paths of the digital print software that has been added to
Prinergy.

Submit

Indicates whether you can use the software to send files to a
digital printer using the File > Send to Digital Direct menu item
in Job Manager.

Add

Displays the Add Digital Print Application dialog box, where you
can enter the name and location of a digital print software.

Remove

Click this button to remove digital print software that you select
under Application Name or Location.

UpFront integration
Use UpFront to automatically export Preps jobs and MIS JDF files to
Prinergy.

UpFront, Preps, and Prinergy

If you use Preps files in UpFront software, you can export Preps jobs
from UpFront software into Prinergy with the Automatic Imposition
feature.

For more information, see Preps integration options on page 1059.

What is Kodak UpFront software?

UpFront software is a production planning tool that centrally stores
your company's press and bindery equipment specifications. This
information is then used to customize or create a library of impositions.

These impositions, or press layouts, can be reused in all UpFront
software jobs. For each job, UpFront software produces perfect, scaled
imposition diagrams, and also exports completed Preps templates and
jobs as well as CIP3 PPF cutting data files, binding data files, and
folding data files.
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Connecting UpFront to Prinergy
Use smart hot folders to automate the export of Preps jobs and MIS
JDF files from the UpFront software to Prinergy.

Requirements:

The following software must be installed:

● Prinergy 3.0 or later with a Prinergy Automated Imposition license
● UpFront 4.x
● UpFront JDF MIS Export Site License (for JDF only)

Note: If you are running Prinergy 3.1 or later or UpFront 4.0.4 or earlier, you may
need to edit the UpFront40.ini file to add the proper file-naming convention
for smart hot folders. For details, contact a service representative.

You can use smart hot folders to automate the following workflows:

● Export a Preps job or MIS JDF file from UpFront and automatically
create a Prinergy job and imposition, based on the exported job's
file name.

● Export multiple Preps jobs or MIS JDF files from UpFront and
automatically create a single Prinergy job with multiple impositions,
based on the exported job's file name.

● Re-export an altered Preps job or MIS JDF file from UpFront and
automatically create a new imposition in an existing job, rather than
create a new job.

1. Customizing an import process template
Create a custom import process template for importing jobs from
UpFront.

2. Creating a template job with hot folders
Create a template job that contains one hot folder for each
customized import process template.

3. Creating a smart hot folder
Use a smart hot folder to create a new job (or find an existing job)
and for automatic import of the impositions.

4. Exporting Preps templates and jobs and MIS JDF files from
UpFront
Use smart hot folders to export Preps templates and jobs and MIS
JDF files from UpFront to Prinergy.
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Customizing an import process template

Create a custom import process template for importing jobs from
UpFront.

Requirements:

● If you are using UpFront 4.0.3 or earlier, and have different plate
sizes in your shop, you must create an import process template for
each size.

● If you are using UpFront 4.0.4 or later, you can create only one
import process template for all plate sizes, but you must define the
Target Device setting on the Preps tab of the press library in
UpFront. For more information, see the UpFront 4.0.4 Release Notes.

● If you are exporting a JDF file from UpFront, you must create an
import process template for each media size.

● Ensure that all Preps templates, marks, and printer files are located
on the Prinergy server in the Prinergy\CreoAraxi
\AraxiPreps folder.

This procedure applies to an UpFront-to-Prinergy workflow.

1. In Workshop, from the Tools menu, select Process Template
Editor.

2. In Process Template Editor, expand Import and locate the
ImportAll process template.

3. Right-click and select New Process Template.

4. In the new import process template, open the Import raw
imposition files section and perform the following steps:

a. In Profile, select Default.
b. In Device, select the media size or output device.

For example, select 18x25Portrait.

Note: Media size is the Preps term for plates or press sheets. The media
sizes available in Prinergy are derived from the Preps printer files located
on the Prinergy server.

Note: If you are using UpFront 4.0.4 or later, select Generic PostScript
Printer.

c. Under Output Signatures, select the All option.
d. Open the Import section, and from the If Page Set Already

Exists list, select the Keep existing page set and create new
imposition option.

5. From the File menu, select Save As, and type a name for the
process template.

For example, type Import-UpFront.

6. Click Create Process Template.

7. Repeat steps 2 through 6 for each media size required.
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8. From the File menu, click Close.

Creating a template job with hot folders

Create a template job that contains one hot folder for each customized
import process template.

This procedure applies to an UpFront-to-Prinergy workflow.

1. In Workshop, in Job Finder, create a new job (or find an existing
job) to use as a template job.

Important: Select a job or create one in a location that will NOT be removed or
destroyed.

2. With the template job open in Job Manager, from the Job menu,
select Manage Hot Folders, and perform the following steps:

a. In the Manage Hot Folders dialog box, click Add.
b. In the Create Hot Folder dialog box, select the Add and Process

Files option.
c. In the Workflow Processors list, locate and select an import

process template that you created for importing UpFront jobs.

For example, select the Import-UpFront process template.
d. Click OK.

3. Perform one of the following actions:

○ If you are using UpFront 4.0.4 or later, create only one hot folder
if you are exporting only Preps jobs (not JDF files).

○ If you are using an earlier version of UpFront, repeat step 2 until
you have one hot folder for each customized import process
template.

4. In the Manage Hot Folders dialog box, click Close.

Creating a smart hot folder

Use a smart hot folder to create a new job (or find an existing job) and
for automatic import of the impositions.

This procedure applies to an UpFront-to-Prinergy workflow.

1. In Workshop, in Job Manager, from the Tools menu, select Smart
Hot Folder Manager.

2. In the Smart Hot Folder Manager dialog box, click Add.

Note: For MIS JDF files, you can set up a separate smart hot folder with
different source and target patterns to accommodate multiple media sizes.

The Add Smart Hot Folder dialog box appears.

3. In the Add Smart Hot Folder dialog box, in the Smart Hot Folder
Name box, type a name for the smart hot folder.

For example, type UpFront Import.
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4. In the Smart Hot Folder Location box, perform one of the following
actions:

○ Click Browse and select the folder where you want to drop
UpFront Preps job files.

○ Click Use Default Location.

The default location is the Jobs\SmartHotFolders folder
on the Prinergy server.

5. Under Hot Folder Type, select the Job Creator option.

6. In Create a new job based on the job template, click Browse.

7. In the Select Template Job dialog box, locate and select the
template job that you created earlier.

8. Under Copy from Selected Job, select the Hot Folders check box.

9. Click OK.

10. In the left pane, click Source and Target Patterns.

11. In Source File Name Pattern, type [$JOBID].[%EXT].

This tells the smart hot folder which source files to accept. The
wildcard [$] references the text and numbers in the source file
name, and the [%] wildcard references the letters in the extension.
This pattern assumes a file-naming convention of numbers and
letters with an extension—for example, 123Filename.job.
Source files that do not fit this file-naming convention are rejected.
Rejected source files are stored in the smart hot folder's
Rejected folder.

Note: If you change the file-naming convention, you must change the source
file-naming pattern. For information about source file-naming patterns, see
the Smart hot folders topic in the Prinergy Workshop user guide. If you are
using UpFront 4.0.4 or earlier, you must identify a file-naming convention,
source file-naming pattern, and target file-naming pattern to accommodate
multi-part jobs.

12. In Target Group, click Browse, and select the location where new
jobs should go.

13. In Target Job Name Pattern, type [$JOBID].

This tells Prinergy what to name the job or which job this source file
belongs to. The [$] wildcard references the text and numbers in the
source file name. In this example, Prinergy searches for a job named
123Filename. If Prinergy cannot find a job with the name
123Filename, it creates one.

14. In the left pane, click File Move Rules.

15. Under the table, click Add.

16. Under Source File Name Pattern, select the Use Smart Hot Folders
Source Pattern check box.
The Source File Name Pattern box is automatically populated.
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17. Under Target File Name Pattern, select the Rename files check
box.

18. In the Target File Name Pattern box, type [$JOBID].

19. Click the Move to Job Hot Folder option.

20. In the list, select the import process template that you created in
the job hot folder.

21. Click OK.

Note: If you're using UpFront 4.0.3 or earlier or importing UpFront MIS JDF
files, you must have a smart hot folder for each media size that uses the same
source and target file-naming pattern. Each smart hot folder must access a
different job hot folder in the template job.

The file-move rule created in this example moves source files to the
job hot folder. Because the files are not renamed during the move,
the impositions retain the source file name 123Filename.

22. In the Smart Hot Folder Manager dialog box, click Close.

Exporting Preps templates and jobs and MIS JDF files from
UpFront

Use smart hot folders to export Preps templates and jobs and MIS JDF
files from UpFront to Prinergy.

This procedure applies to an UpFront-to-Prinergy workflow.

1. In UpFront, write the Preps template files to the Prinergy
\CreoAraxi\AraxiPreps\Templates folder on the Prinergy
server.

Note: If the template and signatures referenced in the UpFront Preps job are
not in this folder, the import will fail.

2. In UpFront, write the Preps job files to the smart hot folders created
in the previous topic.

3. If you are exporting MIS JDF files, in UpFront, write the JDF Intent
file to the smart hot folders created in the previous topic.

Note: If the Include Stripping Process check box is not selected, the import
process will fail.

Use the following table to determine whether the smart hot folder
worked.

To determine whether Do this in Prinergy

The source file was
processed

Display the system history and click Group by
Category.

If there are errors, the system history displays the
hot folder error and the location where the failed
file was moved.
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To determine whether Do this in Prinergy

The source file was moved
to a job's hot folder

View the job history.

The source file name
matches the source file
naming pattern

If file naming patterns do not match, the file is
moved to <Smart Hot Folder Name>
\Processed\Rejected.
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Create Preflight report check box 725
Create Preflight Report, If Available check box 471, 526
Create Process Template button 186
Create Process Template Group button 186
Create Report on Error option 218
Create Soft Masks from Photoshop TIFF Alpha Channels

check box 202
Created column 33, 39, 48, 1043, 1044, 1057
Created field 53, 103
Created job status 89, 1094
creating

process template groups 197
process templates 185, 186

creating imposition plans 1089
creating jobs 81–83, 85, 923–926, 929, 1095

about 81
copying template jobs 83
manually 85
using InSite 1095

Creator check box 278
Creo PODS IC-301 669
Creo PODS Spire color server 669
Creo PODS with HP Indigo presses 669
Creo Proofing System software 943
crop box 272
Crop check box 753
Crop Distance Beyond Bleed for Pages list 483, 614
crop marks 653
cropping images 309
ct files 307
CT Resolution box 452, 606

CT Type list 452, 606
CT/LW

generating proofs 593
CT/LW (CEPS) output format 620
CT/LW area 452, 606
CT/LW files 126, 153, 157, 160, 201, 625

converting to PDF 201
input 126
processing 153

CTLW Karat output process templates
description 594, 596, 600, 606, 613

CTLW output
generating 593

custom fields 118–120
Custom Fields Manager 120
custom file naming 1002
Custom File Naming area 469, 524, 578
custom file naming variables 657, 747
Custom halftone curve is used check box 289
custom locations, hot folders 905
Custom transfer curve is used check box 289
customer access to jobs 1092
customer approval 771, 1095
Customer Approval column 33, 39, 1050
Customer Approval Comment field 53
Customer Approval field 53
Customer Approval menu item 63
Customer field 91
customizing

Job Finder 119
Job Manager 119

customizing CIP3 tags, PrintLink 746
customizing work types 1097
customizing Workshop 1033, 1035, 1036
Cut Media check box 476, 531, 580, 613
Cut menu item 850, 857
Cycle Through Screen Angles option 459, 513, 565
cylinder 650
cylinder, imaging on 650

D
daemon 752
Date Processed column 33, 1050
Date Processed field 53
Date Refined column 33, 39, 1050
Date Refined field 53
DCS (Vector Output) output format 620
DCS Compression list 471, 526, 583
DCS Data list 471, 526, 583
DCS File Format list 471, 526, 583
DCS files 126, 127, 129, 625, 906

about 129
adding 129
adding using hot folders 906
Adobe Illustrator 127
Adobe Photoshop 129
Macromedia FreeHand 126, 127

Default Export process template 1091
Default Font box 202
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Default Page Size area 209
default press interface, PrintLink 746, 747
Default Profile box 501, 556
Default Spot Color Handling area 459, 513, 565
Default Value 120
definitions of terms 944
Delete existing page set and imposition option 1089
Delete Files After FTP Completes check box 575
Delete Group menu item 20
Delete History Entries menu item 861, 862
Delete menu item 20
Delete source elements at the end of workflow check box

910
Delete Traps check box 471, 526, 583
Delete Version menu option 969
deleting

process template groups 197
process templates 188

deleting completed processes 841
deleting files 147
deleting integrated imposition software 1088
deleting page sets 345, 349
deleting traps 327
Delta area 452, 562, 606
Delta Cache State column 33, 39
Delta Cache State field 53
Delta Calibration box 459, 513, 565
Densities boxes 452, 510, 606
density limit, common 256
density, neutral 256
Descreen check box 433, 490, 544
Description box 1099
Description column 48, 51, 856, 1041, 1057, 1058
design software 1100, 1101

configuring 1101
integrating 1100

Desktop button 181
Destination Pools list 892
Destroy Entire Job menu item 20
Destroy Entire Pre-Job menu item 20
Destroy Imposition dialog box 368
Destroy Imposition menu item 60
Destroy Job dialog box 102
Destroy menu item 67
destroying 102, 354, 357, 855, 861, 862

history, job 861, 862
pre-jobs 102

Details area 53, 103
Detect column, Preflight Profile Editor 276
Detect Device Independent check box 209, 245
Detect if Halftone phase is used 289
Detect RGB check box 209, 245
Detect Unknown Objects check box 302
Device box 1074
Device Condition box 434, 440, 491, 497, 545, 594, 596,

677
Device list 358
Device Name box 434, 479, 491, 534, 545, 594, 677
Device Path area 479, 534

Device Path box 476, 531, 580, 613
Device Resolutions box 452, 510, 562, 606
Device Resolutions list 459, 513, 565
Device section, process templates 476, 531, 580, 613
Device tab 177
Device Type box 479, 534
device-specific settings 652
die lines 127, 168, 257, 830, 831

about 830
Illustrator 127
naming 830
overprint 257

Dielines Overprint Other Content check box 452, 510,
606

differences
object 981

DigiCap area 459, 513, 565
Digital Device Queue info 177
Digital Master Control list 245
digital masters 75, 255
Digital Print folder, job folders 84
digital printing 479, 534, 669, 673, 675, 1102–1104

about 669
integrating digital print client software 1104
options 479, 534
output types 669
refining 669
software 1102, 1103
Submit for Digital Printing menu item 669
submitting files 675

digits 1009
padded 1009

Direction list 233
direction, trap 265
directory

Subpage 981
directory structure 75
Display Large Thumbnails check box 1036
Display Page Sets in Reader Spreads check box 1036
displaying columns 1034, 1041
displaying history messages 856
displaying items as list or thumbnails 1035
displaying views 16, 30, 107
Distance

Start/End boxes 459, 513, 565
Distiller Assistant plug-in 325
distilling content files 165
distilling marks files 692, 698
Do Auto Page Assignment After Unpopulated Imposition

Import check box 358, 870
Do OPI Image Replacement check box 358
Do Separations check box 452, 510, 562, 606
Do Trapping check box 452, 510, 562, 606
Document contains actions check box 278
Document contains annotation lies inside printable area

(except TrapNet) check box 302
Document contains article threads check box 278
Document contains bookmarks check box 278
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Document contains embedded PostScript fragments
check box 302

Document contains form fields check box 278
Document contains JavaScript check box 278
Document contains Layers check box 278
Document contains thumbnails check box 278
Document contains unused destinations check box 278
Document does not conform to check box 302
Document does not conform to tagged PDF conventions

check box 278
Document Folding Style list 501
Document Format list 471, 526, 583
Document Format option 997
Document is ASCII encoded check box 278
Document is damaged check box 278
document screening 637
document settings, PDF Preflight 278
Document structure is compressed check box 278
documents, locating translated 13
Don't Map Spot Colors option 221
Don't Use Delta-List Cache check box 452, 562, 606
Dot Shape box 459
Dot Shape list 459, 513, 565
dot shapes 638, 643, 855
dot size, calculating minimum 640
dotversion file name tag 1002
double burn 943, 981
Double byte font is completely embedded check box 286
Down box 445, 600
Down to box 358
downloading files from InSite 84
downsampling 309, 724, 725
drag-and-drop linking 972
Draw Trim and Bleed Marks list 483, 538, 614
Draw Trim and Bleed Marks option 483, 614
Draw Trim and Bleed Marks options 538
drop shadows 267, 269
DSC vector output 755
dtd file, web growth 729
Due Date Time area 91
due dates 90
duotones 130
Duplex Offsets area 501
Duplexing list 445, 479, 501, 534, 556, 600
Dynagram DynaStrip 352
dynamic columns 39, 46, 839, 1043, 1050, 1055

E
e-mail notifications 1092
eCentral 13
Edit Hot Folder for Job dialog box 910
Edit Imposition dialog box 1071
Edit Imposition menu item 63
Edit Job Attributes dialog box 91
Edit Job Attributes menu item 22
Edit Pre-Job Attributes menu item 22
Edit Process Template button 174, 184, 985
Edit Smart Hot Folder dialog box 932
Edit Work Type Dialog Box 1099

editing
process templates 183, 187

editing imposition plans 1089
editing process templates 183, 184
edition

defined 944
electronic filing system 75
elements

from template 961
Elements column 846, 1053
elements, getting information 31
Eliminate TrimBox and BleedBox check box 209
Embedded font is OpenType check box 286
Empty Pages check box 283
Enable CEPS Detection check box 209
Enable CMYK Overprint check box 225
Enable ColorFlow check box 225
Enable Gray Overprint check box 225
Enable Rule Set in Selected Jobs menu item 22
Enable Signature Booklet check box 501
Enable Spot Color Mapping check box 221
Enable User Switching check box 5, 1096
Enable Variable Mainscan Imaging check box 580
Enable Web Access check box 91
enabling Color Combiner 805
enabling web access 90, 1092, 1096
Encryption check box 278
Ended at field 842
ending processes 845
Enfocus PitStop 153, 325
Enter Number of Versions dialog box 1027
EPS (Vector Output) output format 620
EPS Compression list 471, 526, 583
EPS Data list 471, 526, 583
eps files 307, 625, 912
EPS input 126
eps raster output format 620
Epson 5000 output 625
Epson 5000 output format 620
Epson 9000 output 625
Epson 9000 output format 620
error layer 966, 981, 989
Error Message icon 51
errors 840, 855, 989, 1007

multiple 989
page name pattern 1007

Errors/Warnings column 16, 1044
Errors/Warnings field 103
even pages, selecting 30
Evenly to all gutters and margins 653, 654
Evenly to both margins 653, 654
example scenario 946
examples 265, 375, 377, 382, 385, 394, 401, 412, 653,

654, 661, 730, 731, 734–736
Add Extra Horizontal Space 654
Add Extra Vertical Space 653
at Distance 653
Automatic Production Automation (APA) 385, 394,

401, 412
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crop marks 653
Locate crop mark of length 653
Orientation 653
page geometry order of operations 375
page offset 375
page orientation 377
traps 265

exchanging files, InSite 1092
Executable Location box 1104
Existing Page Sets button 1028
Existing Page Sets list 347
Expand All menu item 66, 1035
expanding items 31, 1035
Export Color Library dialog box 793
Export Imposition Using Process Template area 1071,

1073
Export Job (Incremental) menu item 60
Export Job menu item 20, 60
Export Path box 865
Export process template 865
export process templates 865, 1089
Export the selected color library to file box 793
Export Type box 865
ExportAll process template 78
ExportIncremental process template 77
exporting color libraries 781, 791
exporting jobs 1005
exporting jobs and job files 863–865
Extra Margin for Marks and Bleed boxes 483, 614
Extract Recipe from the File option 221, 440, 497, 551,

596
extracting objects from refined pages 981, 989

F
Facilis 352
factory libraries 781
Factory Templates 189
Fail if font problems detected check box 452, 510, 562
Fail on Missing Fonts check box 202, 606
Fail on Missing Images check box 202, 358
Fault Tolerance list 879, 882
Feature Size box 459, 513, 565
fields, custom 118
File Browser dialog box 181, 190
File contain CEPS data check box 296
File Format section 997
File Generation Mode list 575
File Move Rules view 932
File Mover/Renamer option 932
File name box 725
file names 657, 661, 963, 1002, 1007

best practices 963
components 1002
custom 657
input 1007
output 1002
tags 1002
version numbers 661

File Naming area 469, 524, 578

file naming patterns, smart hot folders 914, 917, 919
file types 126, 352, 625, 952

imposition 352
input 126
output 625

Filename Template box 469, 524, 575, 578
files 382, 952, 1093

APA 382
Files to Add list 147
film, tiling 655
filtering

Versioned Pages view 970
filtering refined pages 971
final output 544, 626, 691, 812, 823–825, 1000

generating 626
producing 1000

Final Output Count column 16, 1044
Final Output Count field 103
Final Output Due column 16, 1044
Final Output Due field 103
Final Output field 91
final output process templates

Calibration and Screening section 565
Copydot section 544
description 545, 551
Device section 580
Layout section 556
PrintLink section 575
Processed File section 578
Render section 562

Find Job dialog box 98
Find Job menu item 22
Find Job Results dialog box 98
Find Pre-Job menu item 22
finding jobs 98
Finish Installation button 5
finished processes 840
First Page Number in Next Signature box 1074
fixing generate errors 990
Flat Rotation box 445, 501, 556, 600
flat-based workflow

procedure 79
Flatness tolerance is different than Points check box 300
Flattener list 209
flattening files, transparency 161–163
flexible packaging 401
flexo press, web growth 729
flexographic printing 650
folding carton 401
font 989
Font Converter 320
Font Installation dialog box 320
Font is not embedded check box 286
Font Name check box 286
Font Outlining check box 471, 526, 583
font search path 127
Font Search Path dialog box 322
Font Search Path menu item 67
font search paths
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about 314
options 322
template jobs 83

fonts
Asian 316
embedding 125, 202
installation dialog box 320
installing and converting 320
settings in PDF Preflight 286

Fonts and Images section, refine process template 202
Fonts area 202
Fonts folder, job folders 84
Force LW Vignette to CT check box 452, 606
Force Overprint check box 981
Force Vignette to CT check box 452, 606
Format area, Preflight Editor 278
formats, imposition 352
formats, input 126
formats, output 625
formula, multiplicative blend 257
From box 1074
From Imposition Plan Name box 578
Front Shift and Back Shift boxes 445, 501, 556, 600
Front X and Y boxes 501
FTP Address box 575
FTP Logon Name box 575
FTP Password box 575
full access, Preps integration 1059
Full Surfaces column 16, 1044
Full Surfaces field 103

G
G3 compression 651
G4 compression 651
General tab 1036
General view 932
generate 981, 986, 989, 990

column 986
errors 990
process 981
process result 986
process template 981
required status 986
status icons 986
viewing status 986
warnings 989

Generate Alternate Images check box 220
Generate check box 245
Generate menu option 985
Generated status 986
generating 275, 593, 620, 626, 669, 673, 675, 744, 950,

981, 1013
about 950, 981
automating 1013
final output 626
outputs 620
proofs 626
to digital printers 669, 673, 675

geometry 985

Geometry area 233
Geometry Assignment tab 417
geometry assignments, automatic 382, 392
Geometry Editor 371
Get Info dialog box 53
Get Info menu item 20, 31, 60, 850
getting started with ColorFlow software 831
Global Color Picker dialog box 791
Global tab, Color Editor window 781, 783, 793
Global tab, Font Installation dialog box 320
Global tab, Process Templates pane 52
Go to Separations View When Opening Job Manager

check box 1036
Graphic element lies completely outside of the media box

check box 283
gravure 650
gray overprint 225
grayscale images 307
Group by Assignment button 33, 39, 986
Group by Category button 51, 856
Group by File Kind button 48
Group by Input File button 33, 39, 986
Group by Online Status button 48
Group by Page Set button 33
Group field 103
group icons, changing process template 198
Group list 939
groups

elements 1035
jobs 108, 109

H

Harmony Medium list 459, 513, 565
Heidelberg PrePress Signa Station 352
Height box 209, 534
Helios image references 307
hiding columns 1034
High-resolution image in OPI path is missing check box

299
high-resolution PDF files 724, 725
Highlights box 459, 513, 565
history 51, 855, 856, 861, 862

job history 51, 862
system history 855, 856

History Logging list 202
History menu item 66
History Starting list 856
History view 51, 861, 862, 989, 1034, 1035, 1041

about 51
collapsing groups 1035
columns 1041
description 51
destroying entries 861, 862
displaying columns 1034
expanding groups 1035
hiding columns 1034
moving columns 1034
options 51
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sorting 1034
viewing 862

Home area 86
Home button 311, 320, 368, 423
Horizontal Gutter Height box 445, 600
Hot Folder Type area 916
hot folder, import imposition 1063
hot folders 83, 84, 143, 147, 864, 868, 869, 905–909,

912, 938
about 905
adding files 906, 907
adding input files 143, 147
custom locations 905
incremental exports 864
job folders 84
re-dropping files 906
supported file formats 906
template jobs 83
types 906

Hot Folders check box 88
HotFolders folder, job folders 84
HP Indigo presses 669
HP Indigo Production Stream Server 669
HP Production Flow 669
HPRTL Device list 476, 531, 580
HPRTL files 620
HPRTL output 625
hub and spoke 1005
hub-and-spoke 77, 78
hub-and-spoke setup 76
HyperFlex Advanced check box 459, 513, 565
HyperFlex area 459, 513, 565
HyperFlex Classic check box 459, 513, 565

I
ICC Profile box 776
ICC profiles 209, 758, 775, 781, 805

alternate color spaces 781
apply embedded 209
color spaces 775
proofing device 805

icf files 906, 912
icons 840, 986

generate status Pages view 986
generate status Versioned Pages view 986

Identify Common Separations menu item 67
identifying common separations 799
if Above box 358
If EyeMedia Image Not Found list 202
If Page Set Already Exists list 358, 870, 1089
Ignore common object differences check box 981
Ignore Embedded Fonts in Marks Files check box 452,

510, 562, 606
ignore option

all layers linked 981
Ignore option 981
Image at option 580
Image at rendered resolution option 580
image formats supported 307

Image has alternates defined 296
Image is flipped horizontally check box 296
Image is not scaled proportionally check box 296
Image is rotated at an angle that is not a multiple of 90

degrees check box 296
Image is skewed check box 296
image references 307
Image Search Path menu item 67
image search paths 83, 199, 304, 307, 310

about 199, 304
about OPI 307
template jobs 83

Image Search Paths check box 88
Image Search Paths dialog box 310
image settings, PDF Preflight 296
Image Transparency area 202
Image uses 16 bits per channel check box 296
images 267–270

clipping paths 270
drop shadows 267, 269
masks 267

Images area 202
Images Attributes area 202
Images list 725
images, embedding 202
images, optimizing 309
iMPAct Digital Blueline 762
Import button 1028
Import Color Library dialog box 792
Import Imposition dialog box 368
Import Imposition menu item 60
Import Imposition Using Process Template area 1071,

1073
Import Imposition, import raw imposition 1062
Import Job (Incremental) menu item 60
Import Job check box 86
Import Job dialog box 869
Import Job menu item 20
Import metadata from Business Link JDFs 120
import process template options (impositions) 358, 1089
import process template options (job) 870
import raw imposition file 1062
Import Type list 1071, 1073
Import Versioning imposition dialog box 1028
Import Versioning imposition menu item 60
importing 342, 353, 355, 356, 368, 698, 781, 791, 867,

869
color libraries 781, 791
dialog box 368, 869
impositions 355
jobs 867
populated job tickets 342

importing jobs 1005
Impose options, refine process template 251
imposed flats 76
imposed flats, Prinergy Direct 79
imposition file name component 1002
imposition file types 352
Imposition Marks Calibration list 538, 588
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Imposition Name box 368, 1071, 1073, 1074
Imposition Name list 1079
Imposition Name table 1028
imposition output 620, 636, 760–764, 769, 821, 822

output formats 620
page set booklets 760–762
signature booklet 762–764, 769
soft 636

imposition output process templates 489, 491, 497, 501,
510, 513, 531, 534, 756, 758, 760–764, 769

description 489, 491
options 497, 501, 510, 513, 531, 534
page set booklets 760–762
signature booklets 762–764, 769
Veris 758

imposition plans 30, 346, 351, 352, 354, 355, 357, 368,
652, 756, 762–764, 769, 1022, 1025–1027,
1034, 1065, 1068, 1071, 1073, 1087, 1089

about 351
and PJTF files 652
copying 1027
creating 1073, 1089
destroying 354, 357
editing 1071, 1089
exporting 1089
file types supported 352
importing 355, 368, 1089
integrating imposition software 351
marks 354
removing 354
renaming 354
selecting 30
signature booklets 762–764, 769
sorting 1034
thermal bluelines 756
versioning 1022

Imposition Plans pane
columns 1041
displaying columns 1034
hiding columns 1034
moving columns 1034
Signatures View 39
sorting 1034

Imposition Preview dialog box 753
imposition proofs

output names 1002
imposition software

configuring 1087, 1091
deleting integrated 1088
integrating 351, 1087, 1088, 1091
setting the location 1088

Imposition suffix box 1031
ImpoStrip 352
improving performance

columns, Job Finder 1044
destroying job history 861

In Prepress job status 89
In Progress icon 840
Include Empty Page Positions check box 725

Include Images as list 471, 526, 583
Include JDF for Digital Print section 534
Include Pages in Job Exports check box 865
Include Spot Channels in Photoshop TIFFs check box 202
incremental jobs

import/export 1005
InDesign 79, 128, 161
individual versions

outputting 993
information line 910
Information Message icon 51
information on elements, getting 31
initial separations 801
Ink coverage is higher than check box 289
Ink coverage is lower than check box 289
ink reports 742, 744, 750–752
Ink Set list 233
ink, neutral density 256, 781
Input Device Conditions box 440, 497, 551, 596
input file

names 1007
Input File column 33, 39, 1050
Input File Control list 209
Input File field 53
input files 125, 126, 143, 147, 157, 161, 200, 382, 907, 952,

963, 981, 1034, 1100
adding and refining 963
archiving 143
geometry 382
hot folders 907
models See models 981
not ready 963
opening 1100
PDF 161
preparing 125, 143
removing 147
requirements 952
sorting 1034
storing 143
supported 126
types 952

Input Files pane
columns 1043
displaying columns 1034
hiding columns 1034
moving columns 1034
Pages View 33
Signatures View 39
sorting 1034

input volume 143
Insert Wild Cards area 417
InSite 82, 245, 771, 1092–1096

enabling web access 1092, 1096
file locations 1093
integrating 1092, 1096
page approval status 1093
pre-jobs 82
setting approvals 771
workflow 1095
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working with jobs 1094
Install button 320
integrating 1059, 1087–1089, 1091, 1092, 1095, 1096,

1099–1104
Business Link 1096
digital print client software 1102–1104
Heidelberg PrePress Signa Station 1088, 1091
imposition software 1088, 1091
InSite 1092, 1095
other software 1100, 1101
Pandora 1087–1089
Preps 1059, 1087, 1088

invisible objects 981
Items button 1098
Items to Submit tab 177
items, collapsing and expanding in Process Templates

pane 31
items, selecting in Job Manager 30

J

Japanese fonts 316
JDF File Name box 479, 534
JDF files, smart hot folders 352, 912
JDF Path box 479, 534
JDF-MIS stripping parameter files, smart hot folders 912
job attributes 90, 961, 1092, 1096

about 90
from template 961
web access 1092, 1096

Job Attributes check box 86, 960
Job button 32, 33, 39, 46, 48, 51
job code 90
Job Code box 91
Job Code column 16, 1044
Job Code field 103
Job Color Picker dialog box 791
Job column 846, 1053
job context, opening Preps 1070
Job Creator option 932
job favorites 29, 31, 58, 83

about 29
options 58
template jobs 83

Job Favorites check box 88
Job Favorites tab 58
Job field 842
Job Finder

displaying columns 1034
hiding columns 1034

Job Finder window 15, 16, 26, 85, 107, 1044
about 15
changing views 16, 107
columns 1044
jobs and pre-jobs 85
options 16

Job Folder field 103
job folders

about 84

input files 143
subfolders 84, 1093

job groups 83, 107–111
about 108, 109

job history 51, 862
Job Home column 16, 1044
Job Home field 103
Job Info dialog box 103
job information 97, 102, 103
Job Manager window 29, 30, 32, 73, 839, 840

about 29
changing views 30
description 32
monitoring processes 839
opening multiple windows 29
process status icons 840
selecting items 30
User and Job favorites 29
window title 29

Job Name box 98
Job Notes 100
Job Notes dialog box 101
job status

about 89, 90
InSite 1094
setting 90

Job Status column 16, 1044
Job Status field 103
Job Status list 91
Job tab, Color Editor window 781, 783, 793
Job tab, Font Installation dialog box 320
Job tab, Process Template pane 52
job tickets, importing populated 356
Job.apa 382
jobs 29, 51, 81–83, 85, 96–100, 102, 103, 107, 108, 112,

114, 118, 863, 865, 867–869, 906, 912,
923–926, 929, 1092, 1094, 1096

adding using hot folders 906
changing to pre-jobs in InSite 1094
copying 112
Copying Jobs and Pre-Jobs 114
copying settings from template jobs 83
creating manually 85
creating using pre-jobs 81, 82
creating with smart hot folders 912, 923–926, 929
creating with template jobs 83
custom fields 96, 118
destroying 102
enabling web access 1092, 1096
exporting 863, 865
finding 98
getting information about jobs 97, 102, 103
history 51
importing 868, 869
job notes 96
managing 96
moving between groups 107, 108
name 29
naming 83
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notes 100
server 29
template jobs 83

Jobs menu item 22
Jobs view

about 16
displaying columns 1034
hiding columns 1034
moving columns 1034
sorting 1034

jpeg
images 307
outputs 620

JPEG 2000 images 126
JPEG compression ratio check box 296
JPEG output 625
jpg files 307
jpg tiff files 307
jt files 352, 906
JTP list 358, 433, 440, 452, 490, 497, 510, 544, 551,

562, 596, 606, 865
JTP Queues menu item 851
JTP Queues view 844
JTPs 184
just-in-time impositions 341
Justified list 483, 538, 588, 614

K

Karat digital press 593
Keep Even Pages Selected menu item 30, 63
Keep Odd Pages Selected menu item 30, 63
Keepaway Mode check box 233
keyboard shortcuts 26, 73, 195, 429, 854, 861, 903
Keyword check box 278
Kind column 16, 33, 39, 1043, 1044
Kind field 53, 103
knockouts 257, 805, 812, 981

correcting 981
Kodak alternate defined for images check box 296
Kodak Approval area 452, 510, 606
Kodak Approval files 620
Kodak Approval output 625
Kodak NexStation 669
Kodak Proofers 620, 625
Kodak Proofers, layout 445
Kodak Proofing Software 620, 625
Konica Minolta bizhub PRO C500 press 669
Korean fonts 316
KPS 620, 625
Kspot

defined 953

L

L*a*b* 307, 775, 805
large format thumbnails 251
Last Archived column 16, 48, 1044, 1057
Last Archived field 103

Last Final Output column 16, 1044
Last Final Output field 103
lay files 307
Layer column 417
Layer Type column 968
layered input 126
layered PDF files 950
Layered PDF Flattening Warning message 174, 177
layered PDF input 952, 955, 963–965

advantages 952
creating version plan 965
mapping input layers 964
models supported 955
refining 952, 963
requirements 952
rerefining 964

layered PDF versioning 941
Layered PDF Versioning

See LPV 943
Layered PDF Versioning (LPV) check box 91
layering pages 345, 348
layers 944, 950, 961, 966, 968, 969, 981, 987, 1022,

1027
base 966, 968, 987
change 968
column 968
defined 944
deleting 969
error 966, 981
from template job 961
name 968
PDF 950, 987
version change 987
version plan 950
vs. plates 950

layout
shifting vertically 654

Layout is 90° Different Than Media check box 445, 600
Layout section, process templates 445, 501, 556, 600
legacy versioning 961
Legacy versioning 345, 348, 620, 941, 1022, 1024–1028,

1031
about 1022
copying source page assignments 1027
importing impositions 1025, 1026
layering pages 345, 348
options 1028
outputting 620
outputting separations 1031
preparing input files 1025
reordering page layers 1027

Legacy Versioning check box 91
Library Name box 792
licensed Preps integration options 1059
licenses, color management 775
Limit box 459, 513, 565
limitations with ColorFlow 837
line art settings, Preflight Editor 300
Line Joins options 233
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Line Splits box 233
Line width less than Points check box 300
linear scaling 729
Link to Layers dialog box 977
linking 948, 970, 972, 977, 978, 985, 1006, 1014

about 948
automating 1006
changes 985
figure 948
methods 972
multiple versioned pages 977
scenarios 1014
tools 970
unlinking 978

List view 1035
lists, displaying items in 1035
Load Media check box 476, 531, 580, 613
Locate Crop Mark of Length box 483, 538, 614, 653
Locate Page Marks Adjacent to list 445, 483, 501, 600,

614
Locate Sheet Marks Adjacent to list 483, 538, 588, 614
Location column 33, 39, 48, 1043, 1057, 1104
Location field 53
logging in, Workshop 4
logging on 1096, 1099
Lookup Recipe in Color Database option 221, 440, 497,

551, 596
loose page 636, 752–754, 758, 1095

annotations in InSite 1095
previewing 753
proofing with Acrobat 636
reviewing 1095
Veris proofs 758

loose page output 433, 755, 758, 809, 818, 819, 937, 938
DCS vector 755
outputting multiple 937
process templates 433
Veris 758

loose page output process templates
DCS vector 755
description 433, 434, 440, 445, 452, 459, 476, 479
output formats 620
Veris 758

loose page proofs
output names 1002

Low Resolution Image Handling list 202, 358
low-resolution PDF files 724, 725
LPV 941, 961, 1001

jobs creating 961
variable marks 1001

LQS TIFF output 625
LQS TIFF output format 620
LW Resolution box 452, 606
LW Type list 452, 606

M
Macromedia FreeHand 126
Make CT same size as Lifework file check box 606
Make CT same size as Linework file check box 452

Make Drop Shadow Images Transparent check box 202
making a tape read only 892
Manage Hot Folders for Job dialog box 912
Manage Hot Folders menu item 67
Manage Job Favorites dialog box 58
Manage Job/User Templates menu item 67
Manage User Favorites dialog box 58
Manage Work Types dialog box 1098
management information system, integrating with 1096
manual procedures

creating version plan 965
Manual Trigger Rules menu item 23, 68
Manually check box 476, 531, 580, 613
Map All Spot Colors to Process option 221
Map selected layer to box 964
mapping input layers 964
Mark Job as Completed After Successful Purge check

box 882
marks 445, 501, 600, 689, 691, 692, 697–700, 711,

719–722, 724, 1001
about 689
Acrobat Distiller settings 692
calculating at distance 692
distilling 698
importing 698
page 445, 501, 600
placement in final output 691
process templates 700
syntax 721, 722
text-file-based 719–722
variable 1001

Marks area 445, 501, 556, 600
Marks section, imposition output process template 538
masks 267, 268
Match Colors area 225, 440, 497, 551, 596
Match Colors in Page Content check box 440, 497, 551,

596
Match Digits button 417
Match Either button 417
Match Letters button 417
matching objects 989
math operators 1010
Max Height box 445, 501, 556, 600
Max Layers box 91
Max Layers column 16, 1044
Max Layers field 103
Max Width box 445, 501, 556, 600
Maximum Characters for File Name box 469
Maximum Characters from Job Name box 524, 578
Maximum File Size box 865
maximum layers 90
Maximum miter limit is above check box 300
Maximum Number of Info Windows Displayed box 1036
Maxtone area 459, 513, 565
Maxtone history 855
Measurement Unit list 1036
Measurement units check box 283
measurements, checking 636
Media area 445, 501, 556, 600
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media box 272, 379
Media check box 753
Media Handling area 479, 534
Media Manager 888–892, 895, 899, 900, 903, 1047

about 888
copying entire tape 891, 892
keyboard shortcuts 903
making a tape read only 890, 892

Media pane, Media Manager 895, 1047
media pools 888
Media Selection area 479, 534
Media Size column 33, 39, 986, 1050
Media Size field 53
Media State column 895
Media Unload Mode list 476, 531, 580, 613
Medium Complete menu option 898
Medium Logical Copy menu option 898
Medium Verify menu option 898
menus 19, 24, 26, 60, 70, 72, 190, 192, 193, 195,

424–426, 428, 778, 779, 781, 794, 795, 797,
849, 851, 853, 857, 858, 860, 898–900, 902

APA Editor 425, 426
Media Manager 899, 900

Merge Distance box 459, 513, 565
merged content 1000
messages 861
metadata, PDF Preflight settings 278
Method list 440, 497, 551, 596
Min Height box 445, 501, 556, 600
Min Horizontal Gutter Height box 445
Min Vertical Gutter Width box 445
Min Width box 445, 501, 556, 600
minimizing SeparationVersion tag 1004
Minimum Absolute Step Limit box 233
Minimum Dot Size box 459, 513, 565
minimum dot size, calculation 640
Minimum Line Weight box 209
Mirror Print check box 476, 531, 580, 613
Mirror Screens with Output check box 459, 513, 565
MIS, integrating with 1096
Miscellaneous area 91
Miter Limit box 233
miter trap 265
mitered corner trap 265
mixed geometry pages 372
mode, Connect vs Powerpack 1036
models 953–956, 981, 989, 1014, 1015, 1017–1021

input files about 953
input files Model 1 954, 981, 989, 1014
input files Model 2 954, 981, 989, 1015
input files Model 3 954, 1017
input files Model 4 954, 1018
input files Model 5 954, 1019
input files Model 6 955, 1020
input files Model 7 955, 1021
input files Model 8 955, 1021
input files multiple bases 956

Modification and create date are not set check box 278
Modified column 33, 39, 48, 1043, 1057

Modified field 53
Modify button 1098
modifying

process templates 183, 187
modifying process templates 183
moire 643
monitoring processes 53, 839, 841
monotone images 307
Move Group dialog box 110
Move Job dialog box 107
Move Job from Remote Server menu item 20
Move Job from Remove Server dialog box 117
Move menu item 20
Move Rows area 417
Move Rules view 932
Move to button 110
Move To column 932
Move to Job Hot Folder option 932
Move to Job menu item 20
Move to Job Relative Location options 932
Move to Location option 932
Move to Pre-Job menu item 20
moving columns 1034
moving files with smart hot folders 912, 923, 925, 926,

929
moving job groups 110
moving jobs 112, 113, 116
moving jobs between groups 107, 108
moving pre-jobs between groups 107, 108
moving process templates between groups 198
moving separators, Process Templates pane 31
Multi-Master check box 286
Multipage option 997
multiple bases 951, 956, 987
multiple generate errors 989
multiple imposition plans 346
multiple loose page output 937, 938
Multiple Pages check box 283
multiple servers 113
multiple users 1096, 1099
multiplicative blend formula, overprint 257

N
Name box 1074
Name of Error Layer box 981
Name the imported library as box 792
named patterns 385, 392, 412
names 963, 966, 968, 970, 1002, 1007

color 968
layer 968
output 1002
patterns 1007
spot color 963
versioned pages 970, 1007
versions 966

names, of jobs and job groups 83
names, patterns in smart hot folders 914, 917, 919
NChannel color space is used 289
Negative Print check box 476, 531, 580, 613
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neutral density 256, 781
Neutral Density box 233, 788
new

process template groups 197
process templates 185, 186

New Group button 86
New Group menu item 20
New Group Name box 109
New Imposition Details dialog box 1074
New Imposition dialog box 1073
New Job menu item 20
New Name box 100, 111
New Page Set name box 347
New Pre-Job menu item 20
new Prinergy tasks 946
New Process Template Group menu option 191
New Process Template menu option 191
new UI elements 960
New Version Names box 1028
New Workflow Template Group menu option 191
New Workflow Template menu option 191
NexStation 669
no warnings or errors icon 840
Non-Printable Margin box 445, 501
noncommon separations 1001
noncontiguous range of page set positions 392, 401
nonlinear scaling 729
nonlinear web growth profile 731
Nonoptimal compression check box 278
Normalize section 963
Normalize section, refine process template 209
Normalizer Input Configuration File box 209
Notes 100
Number of Copies box 479, 534
Number of Pages Across box 445, 600
Number of Pages box 1074
Number of Proofs box 476, 531
Number of separations check box 289
Number of Versions box 967
numbers 1009, 1010

padded 1009
versioned page 1010

O
object comparison tolerances 981
object differences 981
object matching 981, 989
OCF fonts 316
odd pages, selecting 30
Of Bitmap Resolution Below list 202, 358
Of Contone Resolution Below list 202, 358
Offset column 33, 39, 986, 1041, 1050
Offset field 53
Offset X/Y columns 417
offsets, page geometry 372, 375, 378, 382
On Press job status 89
Online column 16, 1044
Online field 103
Opacity list 788

opacity, die lines and varnishes 830, 831
Open APA File dialog box 423
Open button 86, 99, 107, 109, 110
Open Folder button 181
Open in Adobe Acrobat menu item 60
Open Job dialog box 99
Open Job Folder in File Browser menu item 60
Open Job menu item 20
Open Jobs in Group menu item 20
Open menu item 20
Open Pre-Job menu item 20
Open Type fonts 126
opening Preps outside of job context 1070
OPI

about 307
Adobe Photoshop 129
clipping paths 270
drop shadows 267, 269
image search paths 304
Macromedia FreeHand 126
options 202
PDF Preflight 299
search method 304
soft masks 267, 268
spot color channels 270

OPI is used check box 299
OPI version is incompatible with check box 299
Optimize section, refine process template 245
optimizing images 309
Options area 86
order of processing tasks 845
Ordinal Number column 33, 39, 1050
Ordinal Number field 53
Orientation box 653
Orientation column 33, 39, 417, 1050
Orientation field 53
Orientation list 445, 501, 556, 600
Orientation settings 378
orientation, page 377
Original Composite Format fonts 316
Other Files field 103
other software

configuring 1100, 1101
integrating 1100
starting 1101

Outline Fonts check box 725
output 950

separated 950
Output column 801, 826, 828
Output Comment box 174
output devices, reading PJTF files 652
output file names 1002, 1004

best practices 1002
customizing 1002
minimizing example 1004
Prinergy-defined 1002

output file types 625
Output Format list 471, 526, 583
Output Intent area 471

1128 Prinergy Connect Workflow System Workshop User Guide



Output intent does not conform to requirements check
box 302

Output Intents area 526
Output Kind list 452, 606
Output list 828
output names 1002, 1004

imposition proof 1002
loose page proof 1002
separations 1004

Output Plate column 968
output plates 1000
output process templates

final output 544
Imposition Output 489
loose page output 433

Output Selected as list 801, 826
Output Separately option 968
output separations 1000
Output Separations Handling list 510
Output to list 620, 725
Output Type options 476, 531, 575, 580, 613
outputs

final output process template 544
formats available 620
Imposition Output process template 489
loose page output process template 433
PDF/X 754
plates, remaking 626, 627, 629
plates, remaking with tonal adjustments 628

outputting 626, 669, 1031, 1102, 1104
digital printers 669, 1102, 1104
outputting versioned separations 1031

outside of job context 1070
Overlay Versioned Content check box 452, 510, 606,

994
overprint 981
Overprint Black Bitmaps check box 233
Overprint Black Graphics check box 233
Overprint Black Strokes Up To check box 233
Overprint Black Text Limit box 233
Overprint Handling (CPU Intensive) check box 440, 497,

551, 596
Overprint Handling check box 225
overprints 225, 257, 805, 812, 830

overprint conversion 257
overprint conversion settings 225
preventing unintended knockouts 257
varnishes 830

Override Embedded Profiles check box 225
Override Increased Yellow Ruling check box 459, 513,

565
Override Page Size box 209
Override Resolution at 1200 dpi check box 202
overview 958

procedures 958
Overwrite Existing Automated Page Assignment File

check box 358, 870
Overwrite Existing Files check box 885

Overwrite Existing Files with Same Name check box 469,
524, 578, 661, 865, 1089

P

padded numbers 1009
page approval status 771, 772
page assignments 341, 342, 345, 349–351, 385, 1027

assigning 342
copying between page sets 345, 350
copying versioning source to other impositions 1027
examples, APA 385
manually 341, 349

Page Assignments column 46, 1055
Page Assignments tab 417
page box layout 272
Page box layout does not conform with check box 283
Page Color column 801, 826, 828
Page Colors column 33, 986, 1050
Page Colors field 53
Page column 33, 39, 349, 986, 1041, 1050
Page Count box 347
Page End box 347
Page field 53
Page File Location column 33, 39, 1050
Page File Location field 53
page file name component 1002
page geometry 323, 371, 372, 375, 377, 378

about 371
Adobe Acrobat 323
dialog options 378
examples 375, 377
using addition and subtraction 372

Page Marks box 483, 614
Page Marks check box 445, 600, 753
page name back reference 1010
Page Name Back Reference box 968
page name patterns

character limit 1013
errors 1007
from template job 961
using 1006

Page Name Patterns box 968
page number back reference 1010
Page Number Back Reference box 968
Page Open for Edit field 53
Page orientation is not equal for all pages check box 283
Page Position column 33, 39, 986, 1050
Page Position field 53
page position, APA 392, 394
Page scaling factor is used check box 283
page set booklets 760–762
Page Set column 39, 46, 1041, 1055
Page Set list 349
Page Set Name/Prefix column 417
Page Set Options check boxes 358, 870
Page Set Prefix field 53
Page set starting page # box 1028
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page sets 30, 341, 346, 347, 349, 351, 724, 725, 1026,
1034

about 341
deleting 349
existing 1026
multiple impositions 346
options 347, 349, 351
publishing PDF files 724, 725
selecting 30
sorting 1034

Page Sets pane
collapsing groups 1035
columns 1050
displaying columns 1034
expanding groups 1035
hiding columns 1034
moving columns 1034
Pages View 33
sorting 1034

Page size is not check box 283
Page Start box 347
Page Type list 86
pages 147, 262, 283, 323, 326, 345, 348, 375, 377, 379,

380, 724, 725, 771, 772, 800, 1027, 1034, 1093
approving 771, 772, 1093
centering 379, 380
colors contained 800
deleting 147
layering 345, 348, 1027
offset, example 375
orientation, example 377
publishing PDF files 724, 725
settings in PDF Preflight 283
sorting 1034
thumbnails 262
viewing and editing in Acrobat 323

Pages Approved column 16, 1044
Pages Approved field 103
Pages containing selected color area 801
Pages menu item 66
Pages pane

collapsing groups 1035
columns 1050
displaying columns 1034
expanding groups 1035
hiding columns 1034
moving columns 1034
Pages View 33
Signatures View 39
sorting 1034

Pages View 986
Pages view, Job Manager

columns 1034
description 33
displaying columns 1034
hiding columns 1034
List view 1035
Thumbnails view 1035

pageset 341–343, 345–351

Pandora 79, 351, 352, 354, 355, 1087–1089
creating imposition plans 1089
imposed flats for Prinergy Direct 79
impositions 351, 354, 355, 1089
integrating with Prinergy 1087, 1088

panes, customizing
collapsing items 1035
displaying columns 1034
expanding items 1035
hiding columns 1034
moving columns 1034

panes, Job Manager 53, 841
PANTONE

color search order 783
library 781, 784

Paper list 445, 556, 600
partial job import/export 1005
partial jobs

about 863, 864, 867
exporting 865
importing 868, 869

Partition Capacity column 895
Partition State column 895
Password box 102, 368, 1099
Paste menu item 850, 857
paths, clipping 270
pattern matching, Automatic Production Automation

(APA) 382, 385, 398
Pattern or indexed color is used check box 289
patterns 98, 1006, 1007

page name 1006, 1007
Paused icon 840
pausing processes 845
PDF 126, 161, 162, 252, 255, 620, 625, 652, 724, 725,

754, 1100
and PJTF files 652
digital master 255
high resolution 724, 725
input files 161, 162, 1100
low resolution 724, 725
output 620
pages 724, 725
PDF/X 754
publishing 724, 725
specifications 162
supported file types 126, 625
why used in Prinergy 255

PDF 1.4/1.5 box 963
PDF Box to Use list 445, 600
PDF Color Name Encoding list 1036
PDF Compare plug-in 325, 327
PDF File Name box 469, 534
PDF input files 952
PDF Layer Selection option 964
PDF layers 950, 987
PDF Merge plug-in 325, 327
PDF Path box 479, 534
PDF Preflight 199, 218, 271, 274–276

about 199, 271
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generating reports for distribution 275
process Template 218
settings 276

PDF Trap Editor plug-in 323, 325
PDF Trap Viewer plug-in 323, 325
PDF Trapper JTP 323
PDF vector files 997
PDF version is incompatible with check box 278
PDF/X

about 630
output 620, 754
PDF Preflight 302
support for 126, 625

PDF2Go Files check box 278
PDFX version key is not set to check box 302
performance, improving

columns in Job Finder 1044
destroying job history 861

pinging servers 12
Pixels box 459, 513, 565
pjtf files 184, 352, 652

about 652
and JTPs 184
and Prinergy 652

Placement area 445, 501, 556, 600
placement order in Pandora 401
placing sheet marks 691
Plate Characterization 545
Plate Line box 434, 491, 545, 594, 677
plate mapping 961, 1000

from template job 961
plate output 1000
Plate Remake dialog box 626, 627, 629
plate scanner, replacement 742
Plate Verification 545
plates vs. layers 950
plates, remaking 626, 627, 629
plates, remaking with tonal adjustments 628
plug-ins

for Adobe Acrobat 325, 327
PageMaker 323
QuarkXPress 323

Pools pane 895, 1047
populated job ticket, importing 353
position 989
Position column 349, 417
Position list 349
Position Resolution box 981
PostScript

smart hot folders 912
specifications 162
support for 126, 625

PostScript input files 952
Powerpack mode 1036
PPF files 742, 744, 750–752
pre-job 960
pre-jobs

about 82
changing to jobs in InSite 1094

copying 96, 112
creating 81, 85, 86
destroying 102
groups 108, 109
InSite 1095
managing 96
moving between groups 107, 108
naming 83
opening 99
renaming 100

Pre-Jobs menu item 22
Pre-jobs view

about 16
displaying columns 1034
hiding columns 1034
moving columns 1034
sorting 1034

Pre-Production job, InSite 1094
pre-requisite information 946
Prefer embedded Output Intents for Final Output Profile

check box 225
preferences 1035, 1070

Preps 1070
Preferences menu item 22, 63, 850
prefix 970, 1007, 1010

versioned page name 970
Prefix box 347, 368, 970, 1074
Preflight Handling list 218
Preflight Profile Editor dialog box 276
Preflight Profile Manager dialog box 276
Preflight Report column 33, 39, 1050
Preflight Report Location box 218
Preflight Report Viewer menu item 67
preflighting PDF 274
Prepare 161
preparing files

about 125
CT/LW 153
duotones 130
FreeHand 126
Illustrator 127
InDesign 128
input files 143
PageMaker 128
Photoshop 129
versioning 1025

Preps 79, 351–355, 912, 917, 1070, 1087, 1088, 1105
files from UpFront 1105
files in smart hot folders 912, 917
importing imposition plans 353–355
integrating with Prinergy 1087, 1088
opening outside of job context 1070
with Prinergy Direct 79

Preps 5.1.1 or earlier 1070
Preps in Workshop, create Preps imposition 1065
Preps in Workshop, edit Preps imposition 1068
Preps Integration 1059
Preps software 991
PrepsPrinergy.cfg 1070
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Preserve PDF Layers check box 997
Press console 742
Press Interface list 575
press sheet 401
press web growth 729
press-ready PDFs 252
Preview button 445, 600
Preview Resolution list 575
previewing

loose page output 752, 753
Primary Color Output box 221, 225
Primary File column 33, 39, 48, 1043, 1057
Prinergy 10
Prinergy Client Install Wizard 6
Prinergy Connect

using with ColorFlow 831
RGB limitations with ColorFlow 837

Prinergy Direct 9, 76
Prinergy DotShop plug-in 325
Prinergy Geometry Editor plug-in 325
Prinergy PDF Compare 989
Prinergy release 942
Prinergy releases

previous 1005
Prinergy Separation Repair plug-in 325
Prinergy Separation Viewer plug-in 325
Prinergy Signature Selection 1065
Prinergy View Accelerator plug-in 325
Prinergy-Defined File Naming area 469, 524, 578
Prinergy-defined output file names 1002
Print Characterization 545
Print Later button 803
Print Order button 826
Print Order dialog box 803
print order, color 803
Print Production 545
Print Settings tab 177
Print Sooner button 803
printer drivers 128
Printing check box 278
PrintLink

about 742
CIP3 compliance 742, 747
configuration file 746, 747
customizing CIP3 tags 746, 747
generating PPF files 744
hot folders 752
how it works 742
ink reports 750, 752
PPF files 750–752
process templates 744, 751
sample configuration file 747
section in process template 575
setting up 744, 751, 752

PrintLink section, process templates 575
prioritizing tasks 845
Priority column 846, 1053
Priority list 174, 177
problem file 989

procedures 958, 978, 990
about 958
fixing contributing page 990
unlinking 978

Process (Destination) Profile box 551
Process CEPS Data check box 221, 225, 440, 497, 551,

596
Process Details area 842
Process Elements area 842
Process Files option 910
Process Info dialog box 839, 842
Process Information dialog box 989
Process Marks check box 440, 497, 551, 596
Process menu item 850
Process Name box 174, 177
Process Selected Files Using Process Template check box

147
Process Status field 842
process status icons 840
process template

generate 981
group name 986

Process Template column 33, 846, 1043, 1050, 1053
Process Template Editor

about 185
keyboard shortcuts 195
menus 192

Process Template field 174, 842
Process Template Group column 39, 46, 846, 1041, 1053,

1055
Process Template Group field 842
process template groups

about 196
changing icons 198
moving templates between 198

Process Template list 939
process template menu item 23, 68
process templates 7, 29, 117, 183–188, 197, 198, 744, 907

about 29, 183
and hot folders 907
Copy Job 117
creating 185, 186, 197
deleting 188, 197
editing 183, 187
moving between groups 198
ppf files 744
protecting 184
renaming 187, 197
user rights 184

Process Templates pane 52
Process Tools menu item 68
Process Types menu item 851
Process Types view 844
Processed Filename column 417
Processed folder, job folders 84
processes 53, 171, 173, 839–841, 844–846

changing task priority 845
completed 840, 841
deleting 841
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deleting completed 173
monitoring 53, 839, 841, 844
pausing 845
queue 844
resuming 845
stopping 845

Processes pane
about 53, 841
completed processes 840
monitoring 839, 841

Processing Info area 53
processing input files 7, 153, 199–201, 907, 912, 923–925,

927, 929
about 199
CT/LW files 153
how to 200
how to start 7
refine process template 201
TIFF/IT files 153
using hot folders 907, 929
using smart hot folders 912, 923–925, 929

Producer check box 278
Production job, InSite 1094
production plan 946
profile files, tower color 739
profile files, web growth 729
Profile list 358
progress bar 842
Prompt for Tapes From These Pools First list 892
proof approval status 771, 1093
Proof Due column 16, 1044
Proof Due field 103
Proof field 91
Proofer Layout list 445, 600
Proofer Model 531
Proofer Model box 476
Proofer Name list 476, 531
proofing

generating proofs 626
soft 636
tiling 655
with Adobe Acrobat 636

proofs 997
Protocol box 479, 534
PS2 (Vector Output) output format 620
PS3 (Vector Output) output format 620
publish file process templates

description 677
Publish to PDF File dialog box 725
Publish to PDF menu item 60
publishing PDF files 724, 725, 754

options 725
PDF/X 754

Punch Setting list 445, 501, 556
Purge process Template 882
purging 875, 877, 881, 882

about 875
compared to destroying 875
limit 875

options 882
status and state changes 877

Put Files in Directory box 575

Q

Quality list 245, 358, 471, 526, 583
QuarkXpress 990
QuarkXPress 323, 784
Queue box 479, 534
Queue Manager

about 844
choosing views 844
JTP Queues view 844
keyboard shortcuts 854
menus 850
options 846, 1053
pausing processes 845
Process Types view 844
resuming processes 845
stopping processes 845
View menu 851
workflow processors 844, 845

Queue Position column 846, 1053
Queued icon 840
Quick Builder 965

about 965
limitations 965

quitting Workshop 12

R

Range box 349, 358, 970, 977
Add Versioned Pages dialog box 970
Link to Layers dialog box 977

raster output 625
raster output files 620
raster separated data 167
Re-combine check box 209
re-dropping files into hot folders 906
Reader Order button 725
reader spreads, splitting 260
reader-order proofs from imposition 762
Ready for Final Output job status 89
Reduce Gutters if Required check box 445, 600
Reduce to Fit Media (On Vector) check box 445, 501
refine process template

all sections 201
CEPS Conversion section 201
ColorConvert section 225
Copydot section 220
Fonts and Images section 202
Impose section 251
Normalize section 209
Optimize section 245
PDF Preflight section 218
Spot Color Handling section 221
Thumbnail section 251, 262
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Trap section 233
Refined Filename column 417
refined pages 948, 963, 970, 978, 981, 1006, 1014

automating linking 1006
linking 948, 970, 1014
naming 1006
object extraction 981
requirements 963
unlinking 978

refining 199–201, 255, 669, 786, 807, 816, 817, 907
about 199
digital printing 669
options 201
procedure 200
refining process 255
using hot folders 907

Refresh menu item 22, 66, 795, 851, 858
Refresh Queue Manager Every box 1036
regenerating 985, 1002
registration marks 128
Reject menu item 68
Rejected page approval status 771, 1093
rejecting pages, InSite 1092
Relative check box 311
relative ink dot percentage 262
remote access 7
remote servers 12, 113, 116
Remove Font XUIDs check box 202, 358
Remove Traps check box 725
Remove Version button 1028
removing

color libraries 791
imposition plans 354
input files 147
jobs 102
pages 147

Rename button 1028
Rename Color Component box 777
Rename Color Component dialog box 777
Rename files check box 932
Rename Group dialog box 111
Rename Group menu item 20
Rename Job dialog box 100
Rename Job menu item 20
Rename menu item 20
Rename Pre-Job menu item 20
renaming 100, 110, 111, 187, 197, 815, 912, 923, 927

files with smart hot folders 912, 923
job groups 110, 111
jobs 100
process template groups 197
process templates 187
spot colors 815

Render Mode options 452, 510, 562, 606
Render section, process templates 452, 510, 562, 606
Render Shadings check box 471, 526, 583
Rendering Intent area 225
Rendering intent for images is not check box 289

Rendering intent for text and line art are not check box
289

Rendering Intent list 440, 497, 551, 596
Reorder Page Assignments dialog box 1030
Reorder Page Assignments menu item 63
reordering page layers, versioning 1027
reordering process templates on Job or User tabs 31
Report column, Preflight Profile Editor 276
Report name box 725
Report transparent element check box 283
reports, ink 750–752
reports, preflight 275
requesting corrections 1092
requirements

version plans 966
Requires Generation status 986
Resample check box 220, 245, 358, 433, 490, 544
Resample LW check box 201
Reset to Default button 225
Resolution column 33, 39, 1050
Resolution of B&W images is above check box 296
Resolution of B&W images is below check box 296
Resolution of color or grayscale image is above check box

296
Resolution of color or grayscale image is below check box

296
Resolution X box 452, 510, 562, 606
Resolution Y box 452, 510, 562, 606
Resolve Ambiguous Spot Color Definitions check box 221
Respect Mac Filenames check box 469, 524, 578
Restore Last Group Expansion in Job Finder at Login

check box 1036
resuming processes 172, 845
retail catalog scenario 946
Retain CMYK Black check box 440, 497, 551, 596
Retain CMYK Black In area 225
Retrap Trapped Pages check box 233
Retrieve process Template 885
retrieving archives 875, 877, 884, 885

about 875
limit 875
options 885
status and state changes 877

returning centred pages to original offsets 380
reusing hot folders 909
reusing job settings with pre-jobs 82
reusing job settings with template jobs 83
reviewing pages, InSite 1092
RGB 307, 775
RGB Black or CMYK Black is used check box 289
RGB Gray or CMYK Gray is used check box 289
RGB limitations with ColorFlow 837
Right margin only 654
right-click

context menu 958, 965, 968, 969, 972, 978, 993,
994

RIP 10, 91
rosette 643
Rotate Screens With Pages check box 459, 513, 565
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Rotation from CTP to Press list 575
rotation, Acrobat 209
rotation, order of operations 375
round trap 265
Rules-Based Automation 942, 1013
ruling, system history 855
RunPandora.exe 1088

S
Safe Protect Box check box 483, 538, 614
samp files 307
Save APA File As dialog box 423
Save Pages to Separate Files option 725
Save PDF Files to Folder lists 725
Save Process Template dialog box 186
Save to Multipage PDF File option 725
Save Window, Column, and View Options check box

1036
saving duotones 130
Scale (%) column 33, 39, 1050
Scale (%) field 53
Scale (on Raster) check box 445, 501, 556, 600
Scale (on Vector) check box 445, 501, 556, 600
Scale settings 378
Scale X column 417
Scale Y column 417
scaling

black width 265
small text 265
trap color 265

Scaling area 445, 501, 556, 600
Scaling box 201
Scaling Type options 556
scaling, examples 265
scaling, page geometry 372, 375
scaling, web growth 729
scenario example 946
Scitex CT 620
Scitex CT output 625
Scitex images 307
screen angles

about 649
and document screening 637
calculating 643
checking 636
history 855
soft proofs 636

Screen as option 459, 513, 565
Screen Color area 459, 565
Screen Color box 513
Screen Grabs list 452, 606
Screen Ruling box 459, 565
Screen Ruling list 513
Screen Solids check box 459, 513, 565
Screen System box 459
Screen System list 513, 565, 651
screen systems 643
Screening Angle box 788
Screening Mode options 459, 513, 565

screening, document 637
screening, seamless 650
seamless screening 650
Seamless Screening options 459, 565
Search box 971
Search EyeMedia for Hi-resolution Images check box 202
Search for High-Resolution Images in Image Search Paths

check box 202
Search Subfolders check box 202
Secure PDF Password box 209
Security area 278
Select button 777
Select a Color Library dialog box 793
Select a template from the list list 910
Select All Colors menu item 795
Select All Includes Subfolders check box 147
Select All menu item 30, 63
Select All Processes menu item 850
Select Alternate Color Space list 792
Select an imposition application list 1071, 1073
Select button 869
Select Colorants To Extract dialog box 968
Select File dialog box 777
Select Files to Add lists 147
Select Folder dialog box 311
Select group name button 936
Select JDF Templates area 479, 534
Select Named Features box 479, 534
Select Page Set dialog box 1031
Select Target Group dialog box 936
Select Task Priority dialog box 849
Select Template Job dialog box 88
Select Web Access Customer dialog box 1096
Select XSLT File 870
Selectable list 562
Selected Items list 174
Selected Job Info list 869
Selected list 562
Selected Order button 725
Selected Signatures area 1074
selecting items, Job Manager 30
selection status bar 971
Send Files Using FTP check box 575
Separated File Control area 209
Separated File Control lists 245
separated files 125
separated input files 952
separated output 950
Separated Pages check box 283
separations 636, 1000, 1001, 1004, 1031

common 1001
file names 1004
noncommon 1001
outputting versioned 1031
proofing 636

Separations menu item 66
Separations view 46, 1000, 1034, 1055

columns 1055
description 46
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displaying columns 1034
hiding columns 1034
moving columns 1034
options 46
sorting 1034

SeparationVersion
file name component 1004
file name tag 1002
variable mark 1001

SeparationVersion file name component 1002
SeparationVersion_Offset

variable mark 1001
SeparationVersionCommon variable mark 1001
SeparationVersionNoCommon variable mark 1001
SeparationVersionNoCommon_Offset variable mark

1001
SeparationVersionUnique variable mark 1001
separators, Process Templates pane 31
server and client

starting Workshop 4
versions 4

Server list 5, 86
Server Version field 5
Servers 6

render stations 6
Set Black to Overprint check box 225
Set Colors to Knockout check box 225
Set Halftone Phase for each Page check box 459, 513,

565
Set Initial Separations After Imposition Import check box

358, 870
Set Initial Separations menu item 63
Set Job Attributes dialog box 91
Set Job to Completed menu item 22
Set Job to In Prepress menu item 22
Set Overprint CMYK White to Knockout check box 225
Set Page Geometry dialog box 378
Set Page Geometry menu item 63
Set Rich Black to Overprint check box 225
Set to Defaults button 1036
Set Web Growth Profile dialog box 741
Set Web Growth Profile menu item 63
setting imposition software location 1088
setting initial separations 801
setting job attributes 90, 91
setting job status 90
setting page geometry 377
Severity column 51, 856, 1041, 1058
Shades box 459, 513, 565
Shades options 452, 510, 562, 606
Shadows box 459, 513, 565
shadows, drop 267, 269
Sheet Marks box 483, 538, 588, 614
Sheet Marks check box 753
Sheet Size box 1074
sheet-fed press, web growth 729
sheetfed web growth profile 734
Shift Along Height box 501, 556, 654
Shift Along Width box 501, 556, 654

Shingling (Creep) area 1074
Shipped job status 89
shortcuts, keyboard 26, 73, 195, 429, 854, 861, 903
Show an Even Number of Thumbnails Per Row in All Page

Views check box 1036
Show Confirmation Dialogs for All Deletes check box

1036
Show Files of Type list 147, 368, 1028
Show Hidden Files in File Browser check box 1036
Show in Workshop 120
Show Not Licensed Dialogs check box 1036
Show Press Sheet and Plate Edge check box 538
Show Process Info Window When Process Is Created

check box 1036
Sides list 358
Signa Station 352, 1087, 1088

integrating with Prinergy 1087, 1088
signature booklet 762–764, 769
Signature Booklet area 501
Signature ID codes 712
Signature ID Codes 713
Signatures menu item 66
Signatures view, Job Manager

displaying columns 1034
hiding columns 1034
List view 1035
options 39
Thumbnails view 1035

signatures, thermal bluelines 756
Simplify Duplicate Rows menu option 425
Simulate overprints (CMYK only) check box 471, 526,

583
simulating spot colors 805
Size box 459, 513, 565
Size column 33, 39, 48, 1043, 1050, 1057
Size field 53
Size list 445, 479, 501, 534, 556, 600
Sizes area 103
Skip Images With These Suffixes box 202
Skip Remainder of Saveset After First File Read Error

check box 892
sleeve, imaging on 650
small text scaling 265
Small Text Size Limit box 233
Small Text Width Scaling box 233
Smart Hot Folder Location box 932
Smart Hot Folder Manager dialog box 928
Smart Hot Folder Name box 932
smart hot folders 912, 914, 917, 921, 923–929, 932, 936,

962, 1006
about 912
adding 928
case study 921
checking 936
configuring 929
copying 928
creating 928
deleting 928
diagrams 923–927
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dialog box, navigating 932
dropping additional input files 921
editing 928
getting started 928
naming patterns, examples 914, 917

Snapshot box 225, 434, 491, 545, 594, 677
soft masks 267, 268
soft proofs 636
software

digital print 1102
other 1100

sorting items by column 1034
Source and Target Patterns view 932
Source File Name Pattern box 932
source file name patterns, smart hot folders

about 919
case study 921
examples 914, 917

Source of Color Recipes area 440, 497, 551, 596
Source Pattern column 932
Spacing area 445, 600
special characters 83
specific naming patterns, smart hot folders 919
Spectrum output device 805
Split Reader's Spread Pages check box 209
splitting 2-up reader spreads 260
spoke and hub 1005
Spot color definition is ambiguous check box 289
spot color handling 201
Spot Color Handling list 452, 606
Spot color has an alternative color space other than

CMYK or Gray check box 289
Spot color is used check box 289
spot color names 963
Spot color suffix is not check box 289
spot colors 221, 256, 270, 781, 804, 805, 807, 809, 812,

814–819, 821–825
final output 812, 823–825
imposition output 809, 821, 822
loose page output 809, 818, 819
neutral density 256, 781
OPI 270
preserving 807, 809, 812, 816, 818, 821, 823
reducing 807, 809, 812, 816–819, 821, 822, 824, 825
refine 221, 807, 816, 817
renaming 815
simulating with process colors 805
workflow 814

Spotless Extended Color Management 830
Spread Splitting area 209
square brackets 1007
Stale Archive Status column 16, 1044
Stale Archive Status field 103, 1044
standard corner trap 265
Start Imposition Application dialog box 1079
Start Process dialog box 174, 183, 964, 985
Start Process dialog box, bypassing 172
Start Process for Digital Printing dialog box 177
Started at field 842

Started column 846, 1053
Starting at box 349
starting other software 1101
starting Pandora 1087
starting Preps 1087
starting Preps outside of job context 1070
starting processes 171, 172, 174, 177, 1097

about 171
bypassing Start Process dialog 172
digital printing options 177
options 174
work types 1097

starting Signa Station 1087
starting Workshop 4
Startup tab 1036
status

generate 986
status bar

selection 971
Status column 846, 1053
status, jobs in InSite 1094
status, processes 839, 846
step limit 262
Step Limit box 233
stochastic screening 651
Stop button 842
stopping processes

any process 845
job-specific process 172

storage
about 875
status and state changes 877

Storage menu item 66
Storage view

collapsing groups 1035
columns 1057
description 48
displaying columns 1034
expanding groups 1035
hiding columns 1034
moving columns 1034
options 48
sorting 1034

storing input files 143
Style area 286
Style list 445, 600
Subject check box 278
Submit as Multiple Print Jobs check box 476, 531, 580,

613
Submit column 1104
Submit for Digital Printing menu item 67
Submit Input File to Digital Printer dialog box 675
Submitted at field 842
Submitted by field 842
Submitted column 846, 1053
Subpage directory 981
subtraction 1010
subtraction, page geometry 372, 394
supported file types
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imposition 352
input 126
output 625
smart hot folders 912

Suppress Generation of Failed SubPages check box 209
Surface column 33, 39, 1050
surfaces, viewing soft proofs 636
SurfaceVersion variable mark 1001
suspending processes 845
switching users 4, 1096, 1099
syntax

APA 409
back references 1010
Link to Layer dialog box 977

syntax, file and job names in Smart Hot Folders 914, 919
syntax, marks files 719, 720
System folder, job folders 84
System History

about 855
keyboard shortcuts 861
options 856
screening 855
window 856

system messages 855, 856

T
tag and label printers 401
tags

custom file names 657
file name 1002
PrintLink 746, 747

Target Device box 1074
target file and job names, smart hot folders

about 919
case study 921
examples 914, 917
target file name patterns 919

Target File Name Pattern box 932
Target Job Name Pattern box 932
Target Pattern column 932
Target Queue list 452, 510, 562, 606
Target Resolution box and list 220
task priority 845
Template Job check box 86
template jobs 83, 909, 961, 1007

LPV job attributes 961
page name patterns 1007

Temporary Location for Retrieved Files box 892
terms and definitions 944
testing connections to servers 12
Text and line art images tagged with ICC profile check

box 289
Text area 233
text files

APA files 416
marks files 719–721, 724

Text Grouping list 233
Text is smaller than and is colored with or more

separations check box 300

Text is smaller than points and white check box 300
Text is smaller than Points check box 300
text settings, Preflight Editor 300
thermal bluelines 756
Thicken Thin Lines check box 209
Thickness box 445, 501, 556, 600
Thin Line Handling list 209
This Page Set button 417
This Position button 417
Thumbnail section, refine process template 262
thumbnails 251, 262, 326, 1035

displaying 1035
options 251
viewing and editing 326

Thumbnails view 1035
TIFF 157, 170, 307, 620, 636, 650, 729

files, creating 636
images 307
output format 620
tags, advanced 650
web growth 729

TIFF/IT CT box 452, 606
TIFF/IT files 307, 625
TIFF/IT FP box 452, 606
TIFF/IT HC box 452, 606
TIFF/IT LW box 452, 606
TIFF/IT Suffix area 452, 606
TIFF/IT-P1

adding using hot folders 906
converting to PDF 201
processing 153

tiling output 655
Time column 51, 856, 1041, 1058
tint patches 640
Tint Resolution box 981
Title check box 278
To box 1074
tolerances

object comparison 981
tonal adjustments 628
Tonal Control dialog box 628
tower color file 729, 735, 739
tracking processes, Business Link 1096
Translate hot folder 341
translated documents, locating 13
transparency 163, 267–269
transparency, PDF 1.4 (or later) 161, 163
Transparent Drop Shadow Image Name Suffix check box

202
transparent objects 981
transparent overprint 257
Trap area 233
trap color scaling 265
Trap Color Scaling box 233
trap direction 265
Trap Editor plug-in 325
Trap flag check box 278
Trap Resolution box 233
Trap Tiling Pattern check box 233
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Trap Time-out box 233
Trap to check boxes 233
Trap Trimming list 233
Trap Viewer plug-in 325
trapezoidal web growth profile 734
Trapnet annotation does not conform to requirements

check box 302
trapping tools 323
traps 201, 233, 256, 262, 265, 323, 326, 327, 803, 805

Color Combiner 805
common density limit 256
deleting 327
examples 265
neutral density 256
options 233
order 803
process template 201
step limit 262
tools and methods 323

Treat Color As Black check box 788
Treat Input Files as Flats option 251
Treat pure gray RGB as gray check box 225
Treat shading as option 225
Trendsetter Spectrum 805
Trim Adjustment boxes 483, 538, 614
trim box 169, 272, 379, 963

best practices 963
Trim check box 753
trim lines, viewing 636
Trim Media check box 725
Trim Offset boxes 501
trim size 372, 382
Trim Size area 378
Trim Size box 1074
Trim Size column 33, 39, 986, 1041, 1050
Trim Size field 53
Trim Size X column 417
Trim Size Y column 417
True Type check box 286
Try Emulation First check box 202
Type 120
Type 1 check box 286
Type 3 check box 286
Type check box 939
Type column 846, 1053
Type field 53
Type list 445, 501, 600
types

input files 952

U
UI elements

new 960
Ultimate Technologies ImpoStrip 352
Unassign menu item 63
unassigning pages 351
undefined colors 785
Under Color Removal function is used check box 289
underscore 970

unintended knockouts 257
Unique separation 1031
unique separations

variable mark 1001
Unit Used for Variable Marks options 483, 538, 588, 614,

689
Unlinked Only check box 971
unlinking 969, 978
Unload Media check box 476, 531, 580, 613
Unnamed list 209
unsupported CT/LW and TIFF/IT files 153
updating Workshop 6
UpFront 1105
uploading files for InSite 84
Use Custom File Naming check box 469, 524, 575, 578
Use Custom Location check box 910
Use Custom TIFF Title Tag check box 471, 526, 583
Use Default (Blank) Thumbnails check box 1036
Use Default Location check box 932
Use document's screening, if present option 637
Use existing page set option 991
Use Existing Page Set option 368, 1074
Use existing Preps job check box 1074
Use Full Spot Color Names check box 469, 524, 578
Use Job Favorites As Default check box 1036
Use Large Icons in Tab Button Panel check box 1036
Use Page Offsets menu item 63
Use Prinergy-Defined File Naming check box 469, 524,

578
Use Recipe from File if not found in Color Database check

box 221, 440, 497, 551, 596
Use Smart Hot Folder's Source Pattern check box 932
Use System Fonts check box 202
Use Web Growth Profile, if available box 501, 556
Use Xerox FreeFlow Print Manager check box 479, 534
User column 846, 1053
User Comment box 174, 177
user favorites

about 29
adding process templates 31
options 58
switching users 1096

User Favorites tab 58
User Name box 5, 102, 368
User Name column 51, 856, 1041, 1058
user name, in title bar 29
user switching 1096
User tab, Color Editor window 788
User tab, Font Installation dialog box 320
User tab, Process Template pane 52
user-defined

color library 781, 793
folders 84
Workshop preferences 1033, 1035

UserDefinedFolders folder, job folders 84
users, switching 1096, 1099

V
Variable Mainscan Imaging area 580
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variable marks 1001
variables

custom file names 657
PrintLink 746, 747

varnishes
about 830
Illustrator 127
layering pages 345, 348
naming 830
preparing input files 1025
QuarkXPress issue 257
using 831

vector output 625
vector output files 620
Vector Output Options area 471, 526, 583
vector PDF files 997
Verify Archive check box 892
Verify that all layers are linked list 981
verifying a disk is readable 891
verifying a tape is readable 891
Veris

ICC profiles 758
output format 620
process template 758

Veris/Matchprint output 625
version change layers 987
Version Names box 967
version number, file name 661
Version Plan view 1013
version plans 946, 950, 965, 966, 985

changing 985
creating 946, 965
defined 946
example 946
layers 950
Quick Builder 965
requirements 966

versioned page 991, 1010
number 1010
prefix 1010

Versioned Page Status column 986
versioned pages 944, 950, 970, 977, 981, 1007

adding 970
defined 944
names 970, 1007
numbers 977
virtual 950, 981

Versioned Pages view
filtering 970

versioning 941
Versioning menu for linking 972
Versioning Proof Mapping Color box 452, 510, 606
versioning, layered PDF 941
versioning, legacy

about 1022
about steps 1024
copying source page assignments 1027
importing impositions 1025, 1026
layering pages 345, 348

options 1028
outputting 620
outputting separations 1031
preparing input files 1025
reordering page layers 1027

versions
column 968
defined 944
deleting 969
from template job 961
names best practices 966

Vertical Gutter Width box 445, 600
View tab, Workshop Preferences dialog box 1036
viewing

pages 326
PDF Preflight reports 275
PDFs 323
soft proofs 636
traps 326

viewing information about
disk volumes 890
job history 51, 862
jobs 97, 102
processes 839, 841, 846
tapes 890

viewing PDF layers 987
views, customizing

changing 16, 30, 107
displaying columns 1034
hiding columns 1034

views, Job Manager
History 51
Pages 33
Separations 46
Signatures 39
Storage 48

Virtual Proofing software 997
Virtual Proofing System 84, 620, 636, 650
Virtual Proofing System output 625
visible columns

recommended 986
Visible Columns dialog box, Job Finder 1044
Visible Columns dialog box, Job Manager

History view 1041
Imposition Plans pane 1041
Input Files pane 1043
Page Sets pane 1050
Pages pane 1050
Separations view 1055
Storage view 1057

Visible Columns dialog box, Media Manager 1047
Visible Columns dialog box, Queue Manager 1053
Visible Columns dialog box, System History 1058
Visible Columns menu item 22, 66, 851, 858
VP prefix 1007

W

Waiting for a user action icon 840
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warn option
all layers linked 981

Warn option 981
warning icon 840
Warning Message icon 51
warning messages 855
Web Access area 91
Web Access Customer column 16, 1044
Web Access Customer field 103
web access to jobs 1092, 1096
web growth 729–731, 734, 736, 739

about profile 729
calculating 736
nonlinear 731
profile file 730, 736
removing 739
sheetfed 734
trapezoidal 734
unapplying 739

Web Growth Profile Name column 39, 46, 1041
Web Growth Profile Name field 53
Web Growth Profile Path column 39, 46, 1041
Web Growth Profile Path field 53
WebAnnotatedProofs folder 1093
WebAnnotatedProofs folder, job folders 84
WebDownloads folder 1093
WebDownloads folder, job folders 84
Webs options 358
WebUploads folder 1093
WebUploads folder, job folders 84
Weight box 479, 534
wgp files 729, 739
White objects do not knock out check box 300
White text does not knock out check box 300
Width box 209, 534
Width/Height boxes 233
wild cards

page name patterns 1007
wild cards, Automatic Production Automation (APA)

385, 398, 401, 412
wild cards, smart hot folders 914, 919
Windows bitmap output 625
Windows Bitmap output format 620
Work in Progress page approval status 1093
Work Type list 174, 177
work types

about 1096
customizing 1097
entering 1097
options 1098, 1099

workflow 76, 814, 963, 968
alternate 963, 968
spot colors 814

workflow template menu item 23, 68
workflow templates

about 937
and hot folders 907
creating 938
modifying 938

settings 939
using 938

workflows 75–79, 905, 1095
diagram 76
flat-based 79
InSite 1095
summary 76

workflows/Direct 76
Working Disk Space to Allocate for Retrieved Files box

892
Workshop 4, 6, 12, 325, 1035

plug-ins to Adobe Acrobat 325
preferences 1035
Prinergy Client Install Wizard 6
quitting 12
starting 4
updating 6
versions 4

Workshop Language list 1036
Workshop Preferences dialog box 1036
Workshop Version field 5
Workstyle column 39, 46, 1041, 1055
Workstyle field 53
wpg files 739

X

Xerox DocuColor 669
Xerox DocuPrint 669
Xerox DocuSP 669
Xerox DocuTech 669
Xerox FreeFlow Print Manager 669
Xerox FreeFlow Print Manager Controls area 479, 534
XSLT file 120

Y

yellow ruling, limit 459, 513, 565

Z

z-order 989
Zip Filename box 174
zip files 906, 912
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